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Welcome to Bryce 6 
Welcome to Bryce® 6, the leading 3D program for desktop artists, animators, Web 
designers, and multimedia producers. Bryce is ideal for creating 3D graphics for 
magazines, ads, or virtually any illustration that would benefit from the powerful 3D 
impact of realistic perspective and shading. 
Bryce animation features let you create great animations for video and multimedia 
easily. Bryce key-event and timeline-based animation lets you create incredibly realistic, 
fully animated, 3D worlds where rivers rush through gorges, the sun sets over the 
ocean, or mist evaporates to reveal flocks of birds soaring between mountain peaks. 
Bryce is also an invaluable tool for interactive multimedia. 

What is Bryce? 
Bryce is a stand-alone application that allows you to create and animate three-
dimensional virtual environments. 
With Bryce you can create any type of environment you can envision, from the ivory 
beaches of Tahiti to the silvery rings of Saturn. The Bryce user interface contains all the 
tools you'll need to create your environments. 
For example, Bryce includes controls for managing infinite skies that let you set 
everything from time of day to the color and frequency of clouds. Using the sky controls, 
you can also set light direction, sun/moonlight, atmospheric depth haze (with intensity 
and color), height fog (with height, intensity, and color), and multiple sky color 
components. 
You can also use Bryce controls to create a wide variety of objects you can use to 
populate your environment. You can use the Terrain Editor to create an infinite number 
of custom terrains, which you, in turn, use to create landscapes. 
The realism of a Bryce environment largely depends on the materials applied to the 
objects in the scene. Materials are complex combinations of textures and values. The 
Materials Lab lets you combine textures and channel values that simulate any material 
found in the real world (and a few that aren't!). 
When you have set up your environment just the way you want it, you can add a fourth 
dimension - time. You can use Bryce's animation tools to set up landscapes that move 
and materials that change over time. 
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What's New in Bryce 6? 
Bryce 6 introduces the following new features: 

• Random Replicate  
• Image-Based Lighting added in Sky Lab  
• Tool Tips added in main working window  
• Ability to apply a texture to the moon  
• Sky Library updated to allow multiple categories  
• Ability to add and delete library categories from within the libraries 
• Scroll bar added in libraries allowing more than 14 categories 
• Thumbnail preview in libraries increased so more presets can be viewed 
• New Brush Library added in Texture Editor 
• Import of animations from DAZ Studio 
• Convert Boolean Group to Mesh 
• Ability to import and export 16-Bit Terrain images to take advantage of the 

internal 16-Bit storage 
• Main Working Window color scheme changed from blue to green 

Other items updated/fixed: 
• Proximity bug with metaballs and trees fixed for Bryce 6 metaballs (Bryce 5 

metaballs cannot inherit the fix)  
• Top file menu no longer permanently hidden  
• Grouped trees added to the Objects Library no longer crash Bryce when 

imported into the library or loaded into the scene 
• Macintosh permissions problems fixed  
• Multi-Processor support completed  
• Increased stability in OpenGL mode when opening files or moving objects  
• Increased stability when importing DXF meshes  
• Improved stability when importing via DAZ Studio  
• Improved memory management when importing Poser/DAZ Studio figures with 

textures 
Bryce 6.1 updated/fixed: 

• Introduced a new IBL algorithm, added a Roller Ball to rotate the HDRI, and 
added Linear and Squared falloff options 

• Improved performance of the Network Renderer 
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• Stability increased 
• Mac Intel compatibility added 
• Nano-Preview reflects IBL settings 
• Mac now imports textures from DAZ Studio correctly and imports in general 

improved 
• Can now keyframe Materials 
• Collision Detection added in the Multi-Replicate feature 
• Library titles and descriptions now allow additional text to be added to 

accommodate the larger library preview size 
• Added a render priority option for systems with multiple processors. 

How this Manual is Set Up 
Introduction to Bryce 
A quick introduction to the main Bryce interface starts off this manual with an overview 
of the different palettes, labs, and, tools. 
Reference Section 
The next part of the manual is a reference section that goes through every menu, 
palette, lab, and dialog to show how to use each function. Plenty of examples are 
provided as well. 
Commands, shortcut, and modifier keys are in bold text so they can be easily located on 
each page. 
The Mac command is always shown first, followed by a slash. When the command is 
the same, only one is shown. 
For example: Cmd/Ctrl+N, Cmd/Ctrl+Shift+A, Ctrl+Opt/Alt+M 
Commands are also given in all capital letters. 
For example: I, not i; L, not l 
Practical Application 
The third part of the manual provides some practical applications for some of the basic 
functions discussed in the reference section. 
Appendices 
The appendices provide quick access to a listing of all shortcut keys and modifiers, an 
acronym listing, glossary, known issues, and a few troubleshooting items. 
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System Requirements 
Windows® 

Pentium® Processor or Compatible 
Windows NT® 4 (Service Pack 6) 
Windows 2000® (Service Pack 2) 
Windows XP 
700 MHz (1 GHz or faster recommended) 
512 MB RAM min (1 GB recommended) 
OpenGL compatible graphics card with at least 128 MB of onboard 
  (Drivers supporting OpenGL 1.1 recommended)- - 
100MB free hard drive space for installation (500 recommended) 
32-bit graphics color depth 
CD-ROM drive 

Macintosh® 
Power Macintosh® 
700 MHz (1 GHz or faster recommended) 
Mac® OS X 10.3.9 or above 
512 MB RAM min (1 GB recommended) 
OpenGL compatible graphics card with at least 128 MB of onboard 
  (Drivers supporting OpenGL 1.1 recommended) 
100MB free hard drive space for installation (500 recommended) 
32-bit graphics color depth 
CD-ROM drive 

Macintosh® Intel 
Macintosh® Pro, MacBook® Pro, or current iMac® 
1.8 GHz Core Duo or faster 
Mac® OS X 10.4.8 or above 
512 MB RAM min (1 GB recommended) 
OpenGL compatible graphics card with at least 128 MB of onboard 
  (Drivers supporting OpenGL 1.1 recommended) 
100MB free hard drive space for installation (500 recommended) 
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32-bit graphics color depth 
CD-ROM drive 

• Note: Bryce 6.0 will not function installed on a UNIX partition under Mac OS X. 

Installing Bryce 
Macintosh®  

1. For the disk version, insert the Application CD into your CD-ROM drive and when 
the directory comes up, click on the Bryce Setup icon. 

2. For the electronic version, double-click the Bryce 6.1 Installer icon to install Bryce 
6.1 (installer filename: br_ap006_Br6_App.sit)  

3. When the splash screen appears, click Continue.  
4. Read the Software License Agreement. Read the terms then scroll all the way to 

the bottom of the agreement to activate the Accept button. Click the Accept 
button to accept the terms of the agreement and continue.  

5. At this point, If you are want to uninstall Bryce, change the Easy Install located in 
the upper right corner of the current dialog to "Uninstall" then click on the 
Uninstall button to remove that version of Bryce. After uninstalling, you can 
switch back to Easy Install to reinstall Bryce. 

6. To finish the install process, select a new install location from the drop-down 
dialog at the bottom left of the window. Once you've verified the install location, 
click the Install button.  

7. You may have a dialog  pop up telling you that you need to install the current 
version of DAZ Studio. If you know you have Studio already installed, you can 
skip this step, otherwise click Yes to install DAZ Studio. 

8. When the installers were compiled, the most current version of DAZ Studio 
available was included. If you have a newer version already installed on your 
computer, you should select No. 

9. When the installer has finished, you will need to restart your operating system in 
order to use the DAZ Studio integration.  

10. For the download version only, next, install the preset files: 
br_ap006_Br6_Presets1.sit, br_ap006_Br6_Presets2.sit, 
br_ap006_Br6_Presets3.sit, and br_ap006_Br6_Presets4.sit. Bryce 6 will not 
work correctly without these presets and will crash when you attempt to access 
any of the libraries. 

11. For the disk version, insert the Content CD and install the Bryce Content files to 
your Bryce 6 installation folder. 

12. For the download version, install the Content files: br_ap006_Br6_Content1.sit, 
br_ap006_Br6_Content2.sit, and br_ap006_Br6_Content3.sit and the Sample 
Scenes: br_ap006_Br6_SmpScn.sit. 
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13. For users who intend to use Bryce with multiple user accounts. Locate the file 
"CopyLibFiles.command" in your Bryce 6 folder and run it. The system password 
will be required. (This will copy needed system files to a hidden folder making 
them accessible to all users so that Bryce will run and function correctly for all 
users.) 

Windows® 
1. For the disk version, insert the Application CD into your CD-ROM drive and when 

the directory comes up, click on the Bryce Setup icon. 
2. For the download version, double-click the Bryce 6.1 Installer icon to install Bryce 

6.0 (installer filename: br_ap006_Br6_App.exe). 
3. If you have a previous version of Bryce installed, you will get a "Previous 

Installation Detected" message. If you wish to keep the previous version 
installed, click on Yes. It is highly recommended that if the previous version is 
Bryce 6.0 or 6.0.1, that you choose No so that the Bryce 6.0/6.0.1 version is 
uninstalled and the Bryce 6.1 installation installed. Just make sure you backup 
your Preset folders before uninstalling the previous version. 

4. When the splash screen appears, click Next.  
5. Read the welcome screen, then click the Next button to continue.  
6. Read the Software License Agreement. Then click the Yes button to accept the 

terms of the agreement and continue.  
7. Select the install Destination Directory, then click Next to continue.  
8. Select the Program Folder, then click Next to continue.  
9. Click the Next button to begin installing the Application.  
10. Choose whether to add the Bryce 6.0 icon to your Desktop and click Yes or No. 
11. Click on OK to install the DAZ Studio character plug-in software (required for 

Bryce 6.0 to run). If you already have the latest version of DS installed, cancel 
the DS installation and skip to step 18. 

12. When the sub-installer splash screen appears, click Next. 
13. Read the welcome screen, then click the Next button to continue.  
14. Read the Software License Agreement. Then click the Yes button to accept the 

terms of the agreement and continue.  
15. Select the install Destination Directory, then click Next to continue.  
16. Select the Program Folder, then click Next to continue.  
17. Click the Next button to begin installing the Application.  
18. Read the Last Minute Notes, then click Next to continue. 
19. Choose whether or not to view the DAZ Studio ReadMe, then click Close to finish 

the sub-installer routine. 
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20. Read the Bryce 6.0 Last Minute Notes, then click Next to continue. 
21. Once the installation has completed select the Close button. 
22. For the download version only, install the preset files: 

br_ap006_Br6_Presets1.exe, br_ap006_Br6_Presets2.exe, 
br_ap006_Br6_Presets3.exe, and br_ap006_Br6_Presets4.exe. Bryce 6 will not 
work correctly without these presets and will crash when you attempt to access 
any of the libraries. 

23. For the disk version, insert the Content CD and install the Bryce Content files to 
your Bryce 6 installation folder. 

24. For the download version, install the Content files: br_ap006_Br6_Content1.exe, 
br_ap006_Br6_Content2.exe, and br_ap006_Br6_Content3.exe and the Sample 
Scenes: br_ap006_Br6_SmpScn.exe. 

Managing Content 
Managing Bryce content is quite easy to do. All content that you want to access from 
within the Bryce libraries must be located in the Presets folder while extra content can 
be stored anywhere on your computer or on compact/DVD disk. 
To add, delete, import, or export presets to the libraries or to add new categories to the 
libraries, refer to "Using the Preset Libraries." 
Once you've acquired presets for Bryce you need to decide whether to load them 
immediately into Bryce, store them somewhere for later use, or archive them to disc. 
Unless you've downloaded your presets directly from DAZ, they probably will not be in 
any specific folder structure. You'll need to unzip them into a folder and either import 
them into Bryce or organize them into storage folders. 
Below is the folder structure used for Bryce packages at DAZ: 

Light Gels PackageName   

Materials* 

Models* 

Objects* 

Scene Files* 

Templates 

Content 

VendorName PackageName 

Textures 

Presets Trees Vendor or PackageName 

Scene Files VendorName PackageName* 

Skies VendorName PackageName* 
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* These folders may be eliminated in a package if only one type of item is provided.  
You can use this same structure to store files you downloaded from other sites or come 
up with your own. 

DAZ Support & Services 
DAZ is committed to providing quality customer service and support that is easy to 
access and convenient to use, while fostering one-to-one customer relationships. 
If you have a question about the features and functions of DAZ applications or operating 
systems, see the user manual or online Help for the product you are using. Updates and 
technical information are also available in the Release Notes. 

Registering DAZ Products 
Registering DAZ products is important. Registration provides you with timely access to 
the latest product updates, valuable information about product releases and access to 
free downloads, articles, tips and tricks, and special offers. 
For more information about registering a DAZ product see the online Help for the 
product or see http://www.daz3d.com on the Internet. 

Technical Support 
DAZ provides the following support options for Bryce: 

• FAQs: http://www.daz3d.com/i.x/faq/0/-/? 
• Online Forums: http://forums.daz3d.com 

Customer Service 
DAZ Customer Service can provide you with prompt and accurate information about 
DAZ product features, specifications, pricing, availability, and services. DAZ Customer 
Service does not provide technical support. You can access Customer Service support 
as follows: 

• World Wide Web: You can access general customer service and product 
information at http://www.daz3d.com/i.x/contact/0/-/? on the Internet. 

• Email: You can send specific customer-service questions to DAZ Customer 
Service representatives by visiting 
http://www.daz3d.com/i.x/contact/contact_form/-/?. 

• Online Manual: You can find this manual online at 
http://documentation.daz3d.com/bryce/Bryce6ArtistGuide.htm 
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• Updates to the manual will be available as updated downloads in your account 
and on the downloads page at http://www.daz3d.com/i.x/support/downloads/-
/?product=bryce 

Copyright and Trademark Information 
Copyright © 2005, 2006, 2007 DAZ 3D, Inc. All rights reserved. 
This software is the property of DAZ 3D, Inc. and is copyrighted. Any reproduction in 
whole or in part is strictly prohibited.  
"DAZ" and "Bryce" are trademarks or registered trademarks of DAZ 3D, Inc' in the 
United States and/or other countries.  
"QuickTime" is a trademark of Apple Computer, Inc. 
"Poser" is a trademark of e frontier America, Inc. and e frontier, Inc. 
All other brand and product names, fonts, and company names and logos are 
trademarks or registered trademarks of their respective companies. 
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Introduction to Bryce 
Before you get started, you'll want to learn about the Bryce Interface. Here you'll find out 
where everything is and how to use various components of Bryce.  
Once you've gotten a quick overview of Bryce, you can move on to the Reference 
Section to get detailed descriptions on each Bryce function along with plenty of images 
and examples. 

The Bryce Interface 
The image below shows the Bryce Workspace when you first open up Bryce along with 
captions showing the names of each area. Notice that the controls have been changed 
to a light green instead of the blue controls introduced in Bryce 5. 
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The Bryce Window 

Bryce's default environment consists of the Menu Bar, the Working window, the Control 
palette, and the Tool palettes. By default, the Bryce environment replaces your screen 
whenever you launch the application. However, your operating system's standard 
menus and windows are still accessible. 

The Menu Bar 

The Bryce Menu Bar contains five menus: the File menu, the Edit menu, the Objects 
menu, the Links menu, and the Help menu. These menus provide access to several 
Bryce functions and editors. 
Refer to the "The Menu Bar" for more information on using the Menu Bar.  

 

The Working Window 

The Working Window is the area which displays all the objects in your Bryce scene. It's 
the work area where you'll arrange the objects and lights to create your environment. 
The view of your scene shown in the Working window is taken from a "camera" that you 
can move around for different views of your scene. The Working window also has 
several display modes that let you view a scene as a wireframe, a rendered object, a 
combination of both, or as OpenGL. Refer to "Display Modes" for more information. 
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Nano-Preview 

The Nano-Preview displays a rendered preview of your scene as shown in the figure 
below. As you update your scene, the Nano-Preview shows your changes. You can 
immediately see how your adjustments to object position or other properties affect the 
final look of the scene. 

 
The Nano-Preview shows a small rendered version of your scene. As you change the 
scene, the display updates to show your changes. 
You can use the preset viewing positions to see your scene from different angles, or 
you can use the Memory Dots to store and retrieve your favorite camera positions. 
Refer to "Nano-Preview" for more on working with the Nano-Preview. 

View Controls 

The View Control lets you adjust the view of your scene without moving the camera. 
Using this control you can see your scene from the top, bottom, left, right, front, or back. 
You can also set your scene to continuously rotate so you can see it from any angle. 
Refer to "Using the View Control" for more on using the View Control. 

 

Camera Controls 

Camera Controls change the position of the camera specifically along the X, Y, and Z 
axes. The Camera Trackball lets you move the camera in any direction, and along any 
axis. Refer to "Camera Controls" for more on moving the camera. 
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Render Controls 

The Render Controls let you render your scene to see all the materials and lighting 
effects you added. The center button starts the rendering process and the other buttons 
control rendering options. Refer to "Render Controls" for more on rendering. 

 

Text Display Area 

The area just below the Render Controls is reserved for momentary display of text 
information. When you pass your pointer over interface elements, this area displays the 
name of the interface element, and in some cases, it also displays the element's current 
settings. The Text Display Area also displays information about the total number of 
polygons in an object or a scene, and information about current control settings. Refer 
to "The Text Display Area" for more on this area.  

 

Tool Tips 

Bryce 6 adds Tool Tips to the main Working window. This allows you to quickly see 
what tool the mouse is over without having to look down to the Text Display Area. 
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The Palettes 

Bryce uses a series of palettes to manage tools and controls: the Create Palette, Edit 
Palette, Sky & Fog Palette, Advanced Display Palette, Selection Palette, and Animation 
Controls. These palettes let you create objects, edit objects, create skies and fog, 
control the display of your scene, select objects, and animate objects. Refer to "The 
Palettes" for more on using the different palettes.  
Beside the title of each of the three tool palettes (the Create palette, Edit palette, and 
Sky & Fog palette) is a small triangle that opens the different Preset Libraries available 
in Bryce.  
Refer to "The Bryce Preset Libraries" for more on Preset Libraries. 

The Create Palette 

The Create Palette contains tools for creating infinite planes, terrains, stones, primitive 
shapes, derivative primitives, 2D picture objects, and lights.  
Refer to "The Create Palette" for more on the Create Palette. 

 

The Edit Palette 

The Edit Palette contains tools for editing object materials and resizing, rotating, 
repositioning, aligning, and randomizing objects.  
Refer to "The Edit Palette" for more on the Edit Palette. 
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The Sky & Fog Palette 

The controls available on the Sky & Fog Palette let you add shadows, fog, and haze, 
and let you set the altitude, frequency, and amplitude of clouds. The Sky & Fog Palette 
also lets you control the color of clouds in your sky and the position of the sun and 
moon. Refer to "The Sky & Fog Palette" for more on the Sky & Fog Palette. 

 

The Advanced Display Palette 

The Advanced Display Palette contains tools for controlling the display of the interface 
and enabling/disabling the Nano-Preview and Plop Render features. The Advanced 
Display appears on the right side of the Working window.  
Refer to "The Advanced Display Palette" for more on using the Advanced Display 
palette tools. 
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The Animation Palette 

The Animation Controls on the Animation Palette let you set up key frames and edit the 
timeline of your animation. These controls also let you preview your animation, add and 
delete key frames, and access the Advanced Motion Lab.  
Refer to "Animation" for more on using the Animation Controls. 

 

The Selection Palette 

The Selection Palette contains tools for selecting specific types of objects in your scene. 
You do not see this palette in the default Working window. To view it, you must use the 
Time/Selection Palette toggle at the far bottom right of your Working window to replace 
the Animation Controls with the Selection Palette.  
Refer to "The Selection Palette" for more on selecting objects. 

 

The Time/Selection Palette Toggle 

The Time/Selection Palette Toggle lets you switch between the Selection Palette and 
Animation Controls. Simply click on the toggle to switch between the palettes 

 

Displaying Submenus & Popups 

Wherever you see an inverted or sideways triangle icon in the interface, it indicates that 
there is a menu or other item available that contains options pertinent to the item closest 
to it. For example, in the Create Palette, there are triangle icons next to each tool in the 
palette. These triangles access the additional options for the tools.  
To display a submenu, click on the triangle icon and the popup menu will be displayed. 
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Laboratories & Editors 
Bryce has several laboratories and Editors which allow you to apply materials and 
image textures to objects, adjust lighting, build terrains and textures, modify trees, and 
adjust animations. Click on the links below to find out what each lab or editor does, 
along with links to more detailed information. 

The Advanced Motion Lab 

The Advanced Motion Lab lets you fine-tune your animations. After you've created your 
key frames using the Animation Controls, you can use the tools available in this lab to 
control the speed at which objects move along a motion path, adjust the position of key 
frames, and preview your changes.  
Refer to "The Advanced Motion Lab" for more on animating scenes and using the 
Advanced Motion Lab. 

 

The Light Lab 

The Light Lab lets you tweak the default Bryce light settings. You can set the intensity of 
the light, the edge softness, whether the light casts shadows or not, the color, add a 
light gel, and set the falloff options. 
Refer to "The Light Lab" for more on working with lights. 

©2007 DAZ 3D, Inc.  17 



Bryce 6 Artist Guide 

 

The Materials Lab 

The Materials Lab is where you'll create the materials to apply to your objects. By 
combining up to four texture components on the materials grid, you can create 
incredibly complex surfaces that can bring your scene to life.  
There are two types of materials you can create: Surface materials, which define the 
surface properties of an object, and Volume materials, which define the properties of an 
object's volume as well as its surface. When you're creating volume materials, the 
settings in the Materials Lab change. Some of the surface material settings are replaced 
by volume effects settings.  
Refer to "The Materials Lab" for more on the Materials Lab and "Understanding Volume 
Material Channels" for more on Volume materials. 
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The Sky Lab 

The Sky Lab gives you control over your atmosphere, from adding stars and comets to 
cloud cover and fog. The left side of the Sky Lab changes depending on the palette 
selected, while the right side shows a preview of the sky, access to the sky library, and 
the overall sky settings. Animation controls are also available at the bottom of the lab. 
Refer to "The Sky Lab" for more on editing the sky settings.  

• The Sun & Moon palette provides the ability to affect the stars, sun, and moon, 
including setting the intensity of shadows, soft shadows, and the ambient and sky 
dome colors. 
 

 
• The Cloud Cover palette takes care of your clouds, including motion, height, and 

whether they cast shadows or not. 
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• The Atmosphere palette provides the ability to add fog and haze, rainbows, and 
volumetric world density and quality. 
 

 
• The IBL palette provides the ability to add an HDRI image to the scene. 
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The Terrain Editor 

The Terrain Editor is where you'll create all the terrain objects in your scene. The editor 
contains tools for painting and refining terrain objects. The Terrain Editor also has a 
real-time preview so you can see the effects of your changes instantly. Refer to "The 
Terrain Editor" for more on the Terrain Editor. 

 

The Tree Lab 

The Tree Lab lets you tweak the default Bryce trees. You can set the attributes of the 
branches and trunk, choose foliage shape, leaf distribution, tree shape, and apply 
textures. Refer to "The Tree Lab" for more on generating trees. 
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Adjusting Editor Settings 

The editors have unique interfaces that let you adjust individual settings by using a 
variety of tools, including controls, fields, knobs, and component indicators. To get the 
most out of each editor, it is important to know how these elements work. 

Using Controls 

Controls let you set a value for an element within an editor. For example, in the Sky 
Lab, the Cloud Cover control lets you set the amount of clouds in your scene. 
To adjust the value of a control using the slider:  

• In the Materials Lab, pull the sliders in and out from the top or side of the panels. 
 

 
• In other labs, slide the highlighted portion of the control to the left or right, or the 

small sliders above and below the oval sliders when available. 
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Using Fields 

Fields can be found in dialogs and in controls. A field lets you enter a precise numerical 
value. 

• To adjust the value of a text or numeric field:  
• Click in the field and type a value. Press the Enter key or click outside the 

field to accept the values. 
 

 
• To adjust the value of a control using a field:  

• Click the numerical value to the right of the control's slider. The field will 
appear.  
 

 
• Click in the field and type a value. 

Using Knobs 

Some of the editors in Bryce contain knobs. Knobs can perform many different 
functions, such as randomizing or saving elements. To activate the knob's function, click 
the knob. 
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Using Buttons 

Buttons come in different shapes and sizes, ranging from dots to markers to radio 
buttons. Buttons are activated or selected by clicking on them. 

 

 

Using Component Indicators 

Some of the editors contain component indicators. When you are combining several 
components to create a composite element, such as a texture, the component indicator 
lets you know which component you are currently manipulating. 
When working with materials, you can blend material components by turning on multiple 
component indicators simultaneously. Refer to "Combining Components" for more on 
using the component indicators to blend material components. 
To turn a component indicator on or off, click the component indicator. 

 

Using Color Swatches 

Color swatches are used to change the color of items in your scene. They come in 
several shapes and are accessed by clicking on the swatch, either with or without 
pressing a modifier key. 
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You can access different color pickers by pressing a modifier key when clicking on a 
color swatch.  

Mac Color Pickers 

The Mac OS Color Pickers are accessed from Bryce by pressing Ctrl+Opt and clicking 
any color dot or swatch.  
This opens the Colors dialog with five Pickers:  
Besides the standard OS controls, each Picker has several things in common. At the 
top is a long color bar which is the current picked color. The Magnifying Glass icon next 
to it lets you select a magnified color from anywhere on the current screen. At the 
bottom are the preset boxes which are loaded by click dragging the top color bar to any 
preset box. You can expand/collapse the presets by dragging the small center dot. 

• To use the Color Wheel, click on the color you want and adjust the brightness of 
the color from the right hand slider. 
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• The Color Slider Picker lets you select a color via four different color schemes: 
Gray Scale, RGB, CYMK or HSB, accessed from the popup menu. Values can 
be set by adjusting the sliders or by typing in the numeric values. 
 

 
• The Color Palettes Pickers allows a color to be picked from a number of different 

preset "swatch" palettes. These include the System and Web Safe color lists. 
User Color lists can be created by selecting New from the popup and dragging 
colors into the main window. There are also options for renaming and removing 
colors and lists. 
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• Most of the time the Image Palette is used to display a Spectrum image which 
can be clicked on to select a color. A user image can also be loaded from the 
bottom popup and stored permanently in the picker. The new image can be 
selected from the top popup. 
 

 
• The Crayon Picker shows 64 standard Crayon colors. Clicking on one selects the 

color and displays the Crayon color name at the top. 
 

 
There are also several 3rd party Color pickers to be found online. 
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Win Color Pickers 

Besides the basic Bryce Color Picker, there are two additional Color Pickers available 
for Windows users: 

• Left-click on a color swatch then move the color picker over the color sections 
and click to select a color. 
 

 
• Press Alt and click on a color swatch:  

• Default is RGB Color Picker 
 

 
• HSV Color Picker 

 

 
• HLS Color Picker 
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• CMY Color Picker 
 

 
• Press Alt+Ctrl and click on a color swatch to get the Windows Color Picker: 

 

 

The Preset Libraries 
Bryce has several libraries of presets that can make creating scenes easier. There are 
five preset libraries available in Bryce: the Preset Objects Library, the Preset Materials 
Library, the Preset Skies Library , the Preset Textures Library, and the Preset Brush 
Library.  
You can use the Preset Objects Library to add ready-made objects to your scene. 

• The Preset Materials Library lets you add a wide variety of materials to your 
objects. 

• The Sky & Fog Preset Library contains pre-made skies that you can add to your 
scene to quickly create an environment. 

• The Textures Preset Library contains pre-set textures created in the Deep 
Texture Editor. 

• The Brush Preset Library contains several brush shapes along with the ability to 
reselect the default Terrain brush.  
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Refer to "The Preset Libraries" for more on using the different libraries.  

 

Reference Section 
Menu Bar 
The Menu Bar is located at the top of the Bryce Working Window. In versions 5 and 5.5, 
this menu was hidden until you moved the mouse over the top of the window. Bryce 6 
now has the menu fully visible at all times as previous versions to 5 had. 
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File Menu 
The File Menu is where you access file-related functions. To access this menu, just left-
click on File.  

 

New Document 

The New Document command closes your closes your current Bryce scene file and 
opens a new blank scene. You will be prompted to save any unsaved changes. If you 
do not save these changes, you will lose them. This action will also clear and reset the 
Undo/Redo stack. 
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To create a new document:  
1. Select File > New Document from the menu or press Ctrl-N or, on the PC only, 

set the NumLock, then press Ctrl+decimal (on numpad). 
2. Select whether to save the current scene, to not save it, or to cancel creating a 

new document. 
 

 
3. Once the current scene has either been discarded or saved, the Document Setup 

dialog will come up. The current document settings will automatically be selected 
in the dialog.  
 

 
4. Enter values in the Document Resolution fields. 

 
This is the absolute size of your working space expressed in pixels. You can 
enter any values you like here, although it's recommended that you do not 
exceed your available screen space if you can avoid it. You can work small and 
render larger if you need to. The values in the Aspect Ratio fields will update 
automatically as needed. 

5. Enter values in the Document Aspect Ratio fields. 
 
These fields represent the Document Resolution as a ratio. Depending on the 
type of work you are doing, it may be more convenient to enter values here 

©2007 DAZ 3D, Inc.  32 



Bryce 6 Artist Guide 

rather than in the resolution fields above. For instance, many video formats, as 
well as the standard 13" screen, are 3:4 aspect ratios. 
 
The values in the Document Resolution fields will update automatically if you 
change the Aspect Ratio. 

6. Enable the Constrain Proportions button if you want to preserve the current 
aspect ratio as you adjust the resolution. 

7. Select whether to enable Anti-Aliasing and whether to use Normal or Superfine 
settings. 
 
These settings can always be changed later in the Render Settings. 

8. Enable Report Render Time if you want to view the render report once a render 
is completed.  

9. Select a Render Resolution from the list. 
 
This resolution sets the absolute size of your rendered image, expressed in 
pixels as a multiple of your document size. 
 
You can work in one size as you build your scene and render that scene in a 
different size. For example, you could be working at Bryce's default size but need 
to render four times larger for print or four times smaller for a Web page. Rather 
than resetting your document resolution every time you render (thereby 
impacting your wireframe workspace), you can simply set a separate size for 
rendering. Think of Document Resolution as input and Render Resolution as 
output. 
 
The default resolution is 540 x 405 and the default aspect ratio is 4:3. 

Document Setup 

The Document Setup command brings up the Document Setup dialog where you can 
change the dimensions and aspect ration of the current document. This is the same 
dialog that comes up when you create a new document. 
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To setup the document: 
1. Choose File > Document Setup from the menu or press the Render button or 

press Ctrl-Alt-N. The Document Setup dialog will come up.   
 

 
2. Enter values in the Document Resolution fields. 

 
This is the absolute size of your working space expressed in pixels. You can 
enter any values you like here, although it's recommended that you do not 
exceed your available screen space if you can avoid it. You can work small and 
render larger if you need to. The values in the Aspect Ratio fields will update 
automatically as needed. 

3. Enter values in the Document Aspect Ratio fields. 
 
These fields represent the Document Resolution as a ratio. Depending on the 
type of work you are doing, it may be more convenient to enter values here 
rather than in the resolution fields above. For instance, many video formats, as 
well as the standard 13" screen, are 3:4 aspect ratios. 
 
The values in the Document Resolution fields will update automatically if you 
change the Aspect Ratio. 

4. Enable the Constrain Proportions button if you want to preserve the current 
aspect ratio as you adjust the resolution. 

5. Select whether to enable Anti-Aliasing and whether to use Normal or Superfine 
settings. 
 
These settings can always be changed later in the Render Settings. 

6. Enable Report Render Time if you want to view the render report once a render 
is completed.  
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7. Select a Render Resolution from the list. 
 
This resolution sets the absolute size of your rendered image, expressed in 
pixels as a multiple of your document size. 
 
You can work in one size as you build your scene and render that scene in a 
different size. For example, you could be working at Bryce's default size but need 
to render four times larger for print or four times smaller for a Web page. Rather 
than resetting your document resolution every time you render (thereby 
impacting your wireframe workspace), you can simply set a separate size for 
rendering. Think of Document Resolution as input and Render Resolution as 
output. 
 
The default resolution is 540 x 405 and the default aspect ratio is 4:3. 

Document Presets 

To set up the document using presets, click one of the preset aspect ratios displayed 
along the right side of the dialog. 
These presets are aspect ratios for many useful document types. The pixel values that 
are placed in the Document Resolution fields are either absolute (as in Legal or Letter 
paper sizes) or based on your available screen resolution (as in Maximum 
Recommended or Square) 
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Animation Setup 

The Animation Setup command brings up the Animation Setup dialog where you set up 
the time settings for your animation. 
To set up the Animation: 

1. Choose File > Animation Setup from the menu or press Cmd/Ctrl+Shift+N. The 
Animation Setup dialog will come up. 
 
There are three parts to this dialog. The top part indicates where the animation is 
right now, the middle part is where you define the length (duration) of the 
animation, and the bottom part is where you control the playback and how the 
time readout is to be displayed. 
 

 
2. Set the animation time settings:  

• Current - As mentioned above, this shows where the current animation is 
at in time and the current frame number. The triangle next to Current 
brings up a popup menu where you can set the working range of the 
animation, for example, if you only want to work on minutes 5 through 9 in 
the scene.  

• Working Range Low - Select to set the start of the working range, set 
either the time or the frame number.  
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• Working Range High - Select to set the end of the working range, set 
either the time or the frame number. 
 

 
• Frame # - Shows the frame number of the current frame.  
• FPS (Frames per Second) - Sets the frames per second for the animation. 

Lower frame rates render faster but can produce a jerky animation while a 
higher frame rate will product a more smooth animation.  

• Duration - Shows the current duration of the animation and allows you to 
add more time to extend the length of the animation by either entering the 
time in the fields or entering a number in the Frame # field.  

• Frame # - Shows the total number of frames in the current animation.  
• Scale - Select to switch the Duration fields from setting the total time of the 

animation to setting the scale instead.  
• Extend or Clip - Select to switch the Duration fields back to setting the 

total time of the animation.  
• Play - Provides options you can use to alter the preview of your animation.  

• Once - plays the animation only once  
• Repeat - plays the animation continuously  
• Pendulum - plays the animation forwards then backwards, then 

forwards, continuously  
• The Play Mode can also be set in the Timeline Options menu. 
• Display - Select whether to display the animation in SMPTE Time or as a 

Frame Count. 
• The Display Mode can also be set in the Timeline Options menu. 
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Open File 

The Open command allows you to select a previously saved scene to work on. A 
standard Open File dialog box appears, allowing you to navigate to the folder containing 
your desired file and select it for opening. Note that this will clear your existing scene, 
though you will be prompted to save any work you've performed on the current scene 
before the other one is opened. This action will also clear and reset the Undo/Redo 
stack. 
To open a previously saved scene file: 

1. Choose File > Open from the menu or press Ctrl+O or, on the PC only, set the 
NumLock, then press Ctrl+/ (divide on numpad). The Open File dialog will come 
up. You can also open a scene file by double-clicking on the Bryce scene file 
itself although this will open the file in a new copy of Bryce. 

2. Navigate to the folder where the scene file is located and select it. If the scene 
file is from an earlier version of Bryce, choose the file type from the Files of type 
pull-down menu, then locate, and select the scene file. 
 

 
 
Note: Bryce 5 and 5.5 scene files can be opened in either Bryce 5 or 5.5.  

3. Click on Open to open the scene in Bryce. This may take some time depending 
on how large the scene file is and the capabilities of your system. 
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Merge 

The Merge command allows you to merge a second scene into the currently loaded 
scene. A standard Open File dialog box appears, allowing you to navigate to the folder 
containing your desired file and select it for opening. You will be prompted to save any 
work you've performed on the current scene before the other one is opened. You will 
not lose any work in the current scene if you decide not to save it first. This action will 
also clear and reset the Undo/Redo stack. 
Objects from the scene you're opening are placed in your current scene at the same 
absolute coordinates that they previously occupied. Some information from the scene 
you're opening will be discarded, such as family names. 
This feature is quite useful for large scenes where your computer cannot handle the 
size of the full size of the scene. The scene can be split up into multiple scene files, then 
merged prior to rendering. Once the files are merged, the camera will revert to the 
current Director's view so make sure you save the camera setting of the original scene 
before merging the files. 
To merge two scenes: 

1. Load first scene file. 
 

 
2. Choose File > Merge. A dialog appears prompting you to save the current scene. 
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Choose an option. If you choose to Save the current scene, Bryce will save the 
scene before doing anything else. The Open dialog will then come up. 

3. Use the dialog controls to locate the file you want to merge and click on Open. 
 

 
4. The file you selected is merged with the current scene. 

 

 
5. If you need to merge additional scenes, choose File > Merge again. 

Holding down the Opt/Alt key while performing this function will merge only the sky from 
the incoming scene.  
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Save / Save As 

The Save and Save As commands allow you to save your work prior to continuing work, 
merging, or closing the scene. Since your scene files can quickly become large and 
complex, you should save your work often. It is also helpful to save the files under 
multiple names so that you can always revert back to an earlier version if needed (for 
example, house01.br6, house02.br6, etc.).  
To save a file: 

1. Choose File > Save or press Ctrl+S. The Save dialog appears. 
2. Use the dialog controls to choose a location for your work and click Save. 

To save a file under a different name: 
1. Chose File > Save As or press Ctrl+Shift+S. The Save dialog appears. 
2. Enter a new name and/or location in the fields provided and click Save. 

 
A copy of your work is saved, leaving the original intact. 

If the Image With Scene Open/Save preference is selected, Bryce saves both the scene 
data and the rendered image when it saves the file. 

Revert to Saved 

The Revert to Saved command erases the effects of changes you made to your scene 
by reverting to the last saved version of your scene. All unsaved changes are discarded. 
To revert a scene to the saved version choose File > Revert to Saved from the menu or 
press Ctrl+Opt/Alt+S. 
Please note that using Revert to Saved can sometimes cause Bryce to crash and HDRI 
to stop working requiring you to restart Bryce to get it working again. The more memory 
intensive the scene is, the more likely a crash will occur on reverting. If this happens to 
you, use File > Open File to open the saved version instead of reverting to it. Of course, 
remember not to save the current scene when asked. 

Open Image 

The Open Image command allows you to open an image in Bryce in one of the following 
image types:  

• CompuServe® GIF (.gif)  
• DIB (*.dib) - Device Independent Bitmap  
• Enhanced Metafile (.emf)  
• FPix (*.fpi) - FlashPix Bitmap  
• FPX (*.fpx) - FlashPix Bitmap  
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• JP2 (*.jp2) - JPEG-2000 JP2 File  
• JPE (*.jpe) - JPEG/JIFF Image  
• JPEG (.jpg)  
• Photoshop® (.psd)  
• PIC (*.pic)  
• PICT (Mac only)  
• PNG (*.png)  
• Targa (.tga)  
• TIFF (.tif)  
• Windows Bitmap (.bmp)  

This is useful for loading an image to use as a modeling template or to add additional 
elements to a previous render without re-rendering the entire scene. 
To open an image: 

1. Choose File > Open Image from the menu. The Open File dialog will come up.  
2. Navigate to the folder where the image is located, select it, and click on Open.  
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The image will be loaded into the scene. 
 

 

Save Image As 

The Save Image As command allows you to save the rendered image out of Bryce. This 
allows you to save out a series of images of a scene as it is built for use in tutorials or 
for compositing in a paint program (i.e., object, distance, and altitude masks). 
You can export images to the file formats listed below: 

• Windows Bitmap (.bmp)  
• JPEG (.jpg)  
• Photoshop (.psd)  
• PICT (.pct) (Mac only)  
• TIFF (.tif)  

To save the current rendered image: 
1. Render the scene. 
2. Choose File > Save Image As from the menu. The Save As dialog comes up. 
3. Navigate to the folder where you want to save the file, then enter a filename for 

the image. 
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4. Select a file type from the Save as type field. The default format is JPEG, 

however, for production work, the Bryce JPEG format is not recommended. Use 
BMP, PSD, or TIFF instead. 
 

 
5. If you select JPEG, select a compression value from the Compression field. 

 

 
 
Please note that Bryce's JPEG compression is not the best, so choose either 
High or Max Quality. 

6. Click on Save to save the image to your computer.  
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Export Image 

The Export Image command allows you to save the rendered image out of Bryce. Unlike 
the Save Image As option, the Export Image option allows you to save out an image 
map for use on the web with embedded links or as a QuickTime VR file.  
To export an image: 

1. Choose File > Export Image from the menu. The Save As dialog will come up. 
2. Enter a file name in the Filename field. 
3. Select a file format from the Save as type field then click on Save.  

 

 

Import Object 

The Import Object command allows you to import objects in the following file formats: 
• 3d Studio® Objects (.3ds)  
• 3d Studio® Project Files (.prj)  
• 3DMF (.3mf, .b3d, & .t3d)  
• AutoCad® (.dfx)  
• Direct 3D (.x)  
• Heightfield (.hf) Used to import descriptions of heightfields (terrains)  
• LightWave™ (.lwo or .lws)  
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• Both objects and scenes are supported. The camera, lights, and all objects (with 
material information) are imported. Versions 6 and up are not supported.  

• Portable Greyscale Map (.pgm) Used to import descriptions of heightfields 
(terrains)  

• TrueSpace™ (.cob) Versions up to 4.0 are supported. Material properties are 
supported  

• USGS DEM (.dem) All forms of DEM files are supported  
• USGS SDTS (.ddf) This format is the new USGS format which will replace DEM 

files  
• VideoScape (.vsa) All versions are fully supported  
• VRML1 (.wrl) Imports all properties relevant to Bryce, including camera, light, and 

surface and material textures  
• Wavefront (.obj) Imports any textures referenced in the MTL file, if available  
• WCS Elev (.elev)  
• WorldToolKit® (.nff)  

To import an object: 
1. Choose File > Import Object from the menu. The Open dialog will come up.  
2. Choose the drive and folder where the file is stored. 
3. Select the file to import and click on Open.  

 
Note that when importing objects with an MTL file containing image references 
(exports from Poser are most often affected), if the pathname to the file is not in 
the MTL file or if the images are not in the same directory as the OBJ file, then 
you will be asked to locate each texture. Navigate to the folder(s) where the 
textures are located and select them when prompted. 
 
Two programs that help with this are Grouper and MeTaL Fixer - unfortunately 
for Mac users, these are PC only applications. See appendix E for links to these 
programs. 

Export Object 

The Export Object command allows you to export out terrains, symlats, and converted 
Boolean meshes from Bryce in the following formats: 

• 3D Studio 3DS Files (.3ds)  
• AutoCAD DXF Files (.dxf)  
• Direct3D Files (.x)  
• Infini-D 4.0 Files (.id4)  
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• Lightwave Files (.lws)  
• MetaStream Files (.mts)  
• PGM Files (.pgm)  
• Ray Dream Studio Files (.rds)  
• RayShade HF Files (.hf)  
• TrueSpace Files (.cob)  
• USGS DEM Files (.dem)  
• VideoScape Files (.vsa)  
• VRML 1.0 Files (.wrl)  
• Wavefront OBJ Files (.obj)  
• WorldToolKit NFF Files (.nff)  

When you export a file, you save information, such as vertices, smoothed normals, UVs 
(texture coordinates), and texture maps. 
Some file formats have limitations. For example, DXF doesn’t support smooth normals 
or UVs. If the file format doesn’t support texture embedding, each texture map is written 
as a separate image at the same location specified for the mesh file. The names of the 
images will start with the name you specified for the mesh file and include the name of 
the material. If UV information can’t be written, two texture maps are exported: one for 
the top part and one for the bottom. 
When you export to a 2D format such as DEM or PGM, all the possible texture maps 
are generated. 

Terrains, SymLats, & Converted Meshes 

To export a terrain, symlat, or converted Boolean mesh: 
1. Select an object or group to export. If the group contains a Bryce primitive (non-

converted), it will not export.  
2. Choose File > Export Object from the menu. The Save As dialog comes up. 
3. Enter a file name in the File name field. 
4. Select a file format from the Save as type field and click on Save. The mesh will 

be exported. If materials or textures were applied to the mesh, they will be 
exported as well (512x512 pixels in size). Meshes exported as OBJ format will 
also have an MTL file generated. 
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5. If exporting a terrain or symlat, the Export Terrain dialog will come up. Refer to 

"Exporting Terrains" for more information on exporting terrains.  

Rocks & Imported Meshes 

The Export Object command cannot be used to export rocks or objects that were 
imported from another program, like Poser or DS, or a Boolean group that was 
converted, exported, then re-imported into Bryce. Instead, these objects are exported 
using a shortcut key.  
To export a rock or imported object: 

1. Select a rock or a previously imported mesh. If the group contains a Bryce 
primitive (non-converted), it will not export. 

2. Click on the  button next to the selected object or group. The Edit Mesh dialog 
comes up. 
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3. Press Cmd/Ctrl+D. The Save As dialog comes up.  
4. Enter a file name in the File name field. 
5. Select a file format from the Save as type field and click on Save. The mesh will 

be exported. If materials or textures were applied to the mesh, they will be 
exported as well. Meshes exported as OBJ format will also have an MTL file 
generated. 
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Render 

The Render command immediately starts the scene to render using the current render 
settings. If no changes have been made to the scene, the render will continue where it 
left off. If any changes have been made to the scene, the render will start over.  
To render a scene, choose File > Render from the menu or press Cmd/Ctrl+R.  
If you have the Plop Render selection active, then only the selected area will render. 

Clear and Render 

The Clear and Render command will start a render over from the top. This command 
does not clear the screen before starting the render over.  
To start a new render, choose File > Clear and Render, or click the Clear and Render 
control, or press Cmd/Ctrl+Opt/Alt+R. 
If you have the Plop Render selection active, then only the selected area will render. 

Render to Disk 

The Render to Disk command allows you to render your image directly to disk. This is 
the best choice if you have created a very large image, because it lets you set the DPI 
and saves memory. In addition, rendering to disk is usually faster than rendering to 
screen (although this varies).  
In addition to saving files to 2D formats (.bmp, .jpg, etc.), you can also save files to the 
following formats using Render to Disk:  

• HTML (.htm)  
• QuickTime VR (.mov)  

To render a scene to disk: 
1. Choose File > Render to Disk. The Render to Disk dialog will come up. 

 
The Output Size in Pixels, Print Resolution, and Output Size in Inches will show 
the current settings for the scene. 
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2. Change the Print Resolution to the dpi you need for the image, the Output Size in 
Inches will change to match the new dpi. 
 

 
3. If you need the output size to be larger, change either the Output Size in Pixels 

or the Output Size in Inches, adjusting either one will automatically update the 
other setting. 
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4. If rendering a QuickTime VR, select the button next to that option. 
 

 
5. Click on the OK icon to accept the changes and the Save As dialog will come up. 

Select the file type and change the filename if needed, then click on Save. 
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6. Once you click on Save, the Render Progress panel will come up where you can 
watch the progress of the render. 
 

 
 
Note: If the render seems to stop in one place for a long time, clicking on the 
Progress Panel will sometimes "wake up" the render so it will continue. 

7. You can stop the render by clicking on the Cancel icon and the following dialog 
will come up asking if you want to stop or resume the render. 
 

 
8. Once the render has completed, you can find the image in the location you 

specified in the Save As dialog.  

Render Animation 

Rendering an animation is a lot like rendering a still image. Each frame in the animation 
is processed exactly like a still image. You can use the same rendering options you use 
to render still images. 
In addition to the standard still image rendering options, there are several options you 
can set for movie files: you can choose a file type, a compression option, and a range of 
frames to render.  
The Render Animation command lets you render an animation to several formats:  

• AVI Movie  
• BMP Sequence  
• QuickTime Movie  
• RealMovie  

In addition, you can use the Render Animation dialog to "Render a Wireframe View" of 
your scene. 
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To render an animation: 
1. Choose File >Render Animation from the menu or press Opt/Alt+Shift+R. 

 
The Render Animation dialog will come up. 
 

 
• By default, the Entire Duration is pre-selected but if you only want to 

render the Working Range, then select that instead. 
• The Start and End fields show the range of the animation to be rendered. 

You can change these manually to render only a particular frame or range 
of frames.  

2. Click the triangle icon beside Output Module and select the type of output to 
render. 
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• On the Macintosh, you can render a scene as a QuickTime (MOV) file or 
as sequenced frame files. 

• On the PC you can render your scene as a MOV, AVI file, or as 
sequenced frame files. 

3. Click on Edit and adjust the type of compression to use. The items listed in the 
Video Compression dialog depend on the compressors you have on your 
system. Refer to the documentation that came with the compressor or your 
system software for instructions on using a specific compressor. 

4. Click on Set and choose the drive and folder where you want to save the file: 
5. Type a filename and click on Save. 
6. Click on Render to Network to use the Bryce Network Render and configure the 

network. 
 
Refer to "Render on Network" for more on rendering an animation over a 
network. 

7. Click on the OK icon to accept the settings and start the animation render.  

Render on Network 

The Render Animation command allows you to select whether to render the animation 
over a network or not. The Network Render, also known as Bryce Lightning, allows you 
to render over a network of two or more computers. 
Rendering complex scenes and animations requires a significant amount of 
computational power. Using only one computer, a complex scene or animation can take 
many hours to render. You can take a number of steps to decrease the time required to 
render such a scene, such as reducing the complexity of the scene, reducing the quality 
of the render, or upgrading the computing power of the computer. 
The Network Rendering feature in Bryce lets you spread a rendering job over multiple 
computers. This lets you reduce the amount of time required to render a complex scene 
without sacrificing the complexity of the scene or the quality of the final rendered image 
or animation. 
This is accomplished by breaking a scene into smaller sections and sending each 
section to a separate computer to be rendered simultaneously. The more computers 
you have working on rendering a particular scene, the less time it takes to render the 
scene. 
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How Network Rendering Works  

To use network rendering, you need two or more computers connected by a TCP/IP 
network. One of the machines acts as a server that controls the other machines, 
sending them sections to be rendered and reassembling all of the rendered sections 
into the final image or animation. The other machines act as client machines, receiving 
and rendering their sections of the image and then sending the rendered section back to 
the server. 
When you render an animation over a network, by default, Bryce sends each frame of 
the animation to the client computers. 
When you render a single frame over a network with the Tile Optimization option turned 
on, Bryce divides the frame into tiles and sends the tiles to the client computers. 
The server is the only computer that needs to have Bryce installed; the other computers 
can have either a licensed copy of Bryce installed, or you can install Bryce Lightning, an 
application included with Bryce that is specifically designed for network rendering. 
To start a network rendering session, you will need to know the IP addresses of each of 
the client machines you want to use. When you launch Bryce Lightning, it will display 
that information for you. 
The next step is to open a scene on the server and select the network rendering option. 
You will then need to configure the server by giving it the IP addresses of the client 
computers you will be using for rendering the scene. 
To render over a network: 

1. First, make sure that Bryce Lightning is installed on all the client machines.  
2. Choose File > Render Animation from the menu or press Opt/Alt+Shift+R. 

 
The Render Animation dialog will come up. 
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• By default, the Entire Duration is pre-selected but if you only want to 
render the Working Range, then select that instead. 

• The Start and End fields show the range of the animation to be rendered. 
You can change these manually to render only a particular frame or range 
of frames.  

3. Click the triangle icon beside Output Module and select the type of output to 
render. 
 

 
 
Note: For an image (one frame), select Output Mode of BMP Sequence. 

4. Click on Edit and adjust the type of compression to use. 
5. Click on Set and choose the drive and folder where you want to save the file. 
6. Type a filename and click on Save. 
7. Click on Render to Network and click on the Configure button. 

 

 
 
The Network Render Settings dialog comes up. 
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8. Click on the Search button to have Bryce find the clients or enter the Client IP 

Address in the field and click on the Add button. If you have a firewall active, you 
may be asked whether to allow Bryce to access the network. Go ahead and let it. 
Please note that sometimes, Bryce will not be able find the clients so try again as 
needed.  

9. Once the clients have been located, click on the Select All button or click on the 
buttons next to each client in the Client List that you want to participate in the 
render. 

10. Click on the Update button to have Bryce check to see which clients are ready.  
 
The Client List either shows the IP address or the name of the client, if it is 
known to the system. All available clients get a Green Status. The client on which 
also the server runs sometimes shows as not being available (this is the case 
here). This can be ignored. Sometimes none of the clients turn up green. Ignore 
it for now and check back later.  
 

©2007 DAZ 3D, Inc.  58 



Bryce 6 Artist Guide 

 
 
Note: For single picture network rendering, Use Tile Optimization must be 
enabled (this is the default). 

11. Click on the OK icon to accept the settings and start the animation render. 
12. The following image shows that the Network Render is in full swing. All clients 

are shown as busy including the one that showed as unreachable earlier. 
 

 
13. Each render client will have a status dialog showing the status of the piece it is 

rendering. 
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14. To check on the render as a whole, choose File > Network Render Manager from 

the menu. 
15. When the Render job is finished, all clients will show as Ready (green). After a 

few seconds, the Status will turn black with a white question mark. 
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Render Wireframe View 

To render a wireframe view of your scene: 
1. Set up your scene and the document size. You cannot set the dpi for this type of 

render so take that into consideration when determining the render size. 
2. Deselect any objects in the scene unless you want the selected object to render 

selected in the wireframe render (see last image on this page). 
3. Choose File > Render Animation from the menu or press Opt/Alt+Shift+R.  
4. The Render Animation dialog will come up. 

 

 
• By default, the Entire Duration is pre-selected but if you only want to 

render the Working Range, then select that instead. 
• The Start and End fields show the range of the animation to be rendered. 

You can change these manually to render only a particular frame or range 
of frames. 

• If you have not set up an animation, the fields will all have zeroes in them. 
For a wireframe render, this is okay. 
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2. Click the triangle icon beside Output Module and select BMP Sequence from the 
list. 
 

 
3. Click on Set and choose the drive and folder where you want to save the file: 
4. Type a filename and click on Save. 

 

 
5. Press the Shift key and click on the OK icon to accept the settings. 
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6. When asked if you want to stop or resume the render, click on Resume. 
 

 
7. The frame will render and the bitmap file will open in your default picture editor. 

Note in the image below that any objects selected in the scene will render 
selected as well. 
 

 

Network Render Manager 

The Network Render Manager lets you monitor the progress of the network render. You 
can also monitor the status of individual client computers; pause rendering on a client 
computer; cancel rendering on a client computer; and add or remove client computers 
from the list of available clients.  
You will not see the scene being rendered on the server. However, you can go to the 
client computers and see the section that client is rendering. The Network Render 
Manager displays a list of all network rendering jobs in progress, the state of each job, 
and its percentage complete. You can use the Network Render Manager to change the 
settings of a network rendering job. 
To monitor a render using the Network Render Manager, choose File > Network Render 
Manager from the menu. From the Network Render Manager, you can monitor the 
progress of your network rendering jobs, view the status of the client computers working 
on a job, and pause or cancel a job. 
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To pause a network rendering job: 

1. Choose File > Network Render Manager from the menu. 
2. Select the job to be paused. 
3. Click Pause. 

To resume a network rendering job: 
1. Choose File > Network Render Manager from the menu.  
2. Select the paused job. 
3. Click Run. 

To cancel a network rendering job: 
1. Choose File > Network Render Manager from the menu. 
2. Select the job to be cancelled. 
3. Click Cancel. 

To view the status of the client computers working on a job: 
1. Choose File >Network Render Manager from the menu. 
2. Select the network rendering job. 
3. Click Settings. This brings you to the Network Render Settings dialog. Bryce will 

automatically verify the current status of client computers in the Client List, 
except for those clients you have manually disconnected. You can click the 
Update button to have Bryce verify the current status of the client computers in 
the Client List that are listed as unverified, unreachable, or disabled. The Status 
column in the Client List displays colored icons next to each client computer.  
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Each color represents a different status:  
• Green = Ready. The client computer at that IP address is running Bryce 

Lightning and is available to receive a rendering job from the server.  
• Orange = Working: The client computer at that IP address is running 

Bryce Lightning and is processing a rendering job.  
• Red with horizontal bar = Locked: The client computer at that IP address 

is connected to another server, or an error has occurred on the client 
computer.  

• Red with lightning bolt = Unreachable: The client computer at that IP 
address is unreachable or is not running Bryce Lightning, the IP address is 
invalid, or the client computer does not have enough memory to render 
the job.  

• Black with question mark = Unverified: The Network Render Manager did 
not attempt to determine the status of the client computer at this IP 
address. This icon will only appear when you first add a client to the Client 
List.  

• Grey = Disabled: The client computer at that IP address the user and will 
not be used for the rendering job  

Page Setup 

The Page Setup command allows you to setup the page settings for printing the current 
rendered image.  
On PCs, you can set whether to center the image on the page, how many copies to 
print, and what dpi to print it at.  
To set up the page: 

1. Choose File > Page Setup from the menu. The Page Setup dialog comes up. 
 

 
2. Select whether to center the page on the paper, the number of copies, and the 

DPI setting. Please note that if you set a Custom DPI setting, you will need to 
increase the document size before printing as a higher DPI will print the image 
smaller to accommodate the DPI.  
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3. Click on OK to save the settings. 
On Macs there are no options to set the dpi in the Page Setup. 

 

Print 

The Print command brings up the print menu for your printer so you can print the current 
working window. The Page Setup settings are used here to print the image. This is a 
great way to print out the wireframe view of your image without having to do a screen 
capture.  
To print the current working window: 

1. Set up the page using the Page Setup command. 
2. Choose File > Print from the menu or press Ctrl+P. The Print dialog for your 

system will come up. 
3. Select your printer from the drop down menu and click on OK to print. 
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Printing to a Software Program 

If you have Adobe Acrobat Standard or Professional, you can print the working window 
to PDF, then use the Snapshot Tool to copy the image and paste it into your paint 
program. 
You can also print to any other program format you may have available, such as 
Canvas or SnagIt. Make sure you click on properties and set the dpi setting for the 
program (page setup doesn't seem to affect printing to a paint program). This may be 
under advanced settings.  
If you do have Canvas, close the program before printing. Bryce prints the image and 
then Canvas opens with the image in a new document. Canvas saves the image in 
slices, so you'll need to merge the layers before trying to do any postwork on the image 
If you use SnagIt, make sure you save the image to a file and not to the clipboard. 
Pasting to the clipboard will do so at 72 dpi. 
See appendix E for links to the listed programs. 

Recent Files 

Between the Print and Quit items on the File menu, there are four slots for the four last 
saved scenes. Click on the one you want and it will load in Bryce as long as it is in the 
same location as where you saved it to. If it was moved, Bryce will notify you that it 
cannot find the file. 
Please note that any scenes that were opened but not saved, then that scene file will 
not be listed in the Recent Files listing. In addition, any scene files you worked on 
before a program crash will not be listed either. 
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Quit 

The Quit command will close Bryce, but not before you are given the chance to save the 
current scene or not, or to cancel closing Bryce.  
To exit Bryce: 

1. Choose File > Quit from the menu or press Ctrl-Q. A dialog appears prompting 
you to save the current scene. 
 

 
2. Select to not save the scene, to save the scene, or cancel the close.  

Edit Menu 
The Edit Menu is where you access object-related functions. To access this menu, just 
left-click on Edit. 
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Undo 

The Undo command undoes the last action performed on the objects, up to 16 steps. It 
does not affect changes made to the camera/view. 
To undo the last performed action, choose Edit > Undo from the menu or press 
Cmd/Ctrl+Z. 
Cmd/Ctrl+Z can also be used in the different laboratories, but the labs only undo the last 
step. If you press Cmd/Ctrl+Z a second time, then the lab will redo the previous step 
(the one you just reversed). 

Redo 

The Redo command redoes the last action previously undone on the objects, up to 16 
steps. It does not affect changes made to the camera/view. 
To redo an action, choose Edit > Redo from the menu or press Cmd/Ctrl+Shift+Z. 

Cut 

The Cut command removes the selected object or group from the scene and places it 
on the clipboard. The object can then be pasted back into the scene or into a new 
scene. 
To cut an object from the scene: 

1. Select the object(s) or group(s) you want to delete. 
2. Choose Edit > Cut or press Ctrl+X. 

Copy 

The Copy command copies the selected object(s) and places the copy on the clipboard 
ready to paste into the scene or into a new scene.  
When copying an item that is part of a group, using Copy/Paste will place the new 
object outside the group. Use Duplicate if you want the new object to be part of the 
group.  
To copy an object or group of objects: 

1. Select an object, multiple objects, or group(s). 
2. Choose Edit > Copy from the menu or press Cmd/Ctrl+C.  
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Paste 

The Paste command places any object currently in the clipboard, after using Cut or 
Copy, into the scene. 
To paste an object: 

1. Select an object or group and Copy or Cut it. 
2. Choose Edit > Paste or press Cmd/Ctrl+V. 

Clear 

The Clear command removes the selected object(s) from the scene without placing it on 
the clipboard. This means that you cannot use Edit > Paste or press Cmd/Ctrl+V to 
paste the object back into the scene. 
To clear an object(s) from the scene: 

1. Select an object or objects. 
2. Select Edit > Clear from the menu. 

To undo the clear: 
1. Choose Edit > Undo from the menu. 

 
OR 

2. Press Cmd/Ctrl+Z. 

Copy Material 

The Copy Material command copies the material on the current selected object so that it 
can be pasted onto another object using the Paste Material command. This is extremely 
useful when you have tweaked a material and want to quickly apply it to other objects 
without having to select it from the Materials Library each time.  
To copy a material: 

1. Select an object that has the material applied to it that you want to copy. 
2. Choose Edit > Copy Material or press Ctrl+Opt/Alt+C. 

©2007 DAZ 3D, Inc.  70 



Bryce 6 Artist Guide 

Paste Material 

The Paste Material command pastes the material copied using the Copy Material 
command, overriding the currently applied material. 
To paste a material onto an object: 

1. Select an object and copy the material using the Edit > Copy Material command. 
2. Select another object and choose Edit > Paste Material from the menu or press 

Ctrl+Opt/Alt+V. 

Copy Matrix 

The Copy Matrix command copies an object(s) position, rotation, and size. The copied 
Matrix can then be copied on to another object using the Paste Matrix command to 
override the object's own position, rotation, and size.  
This function is especially useful when using the DAZ Studio link to import figures and 
need to modify an item. Since Bryce literally deletes the object and replaces it, the 
object is loaded into Bryce at the default size, location, and rotation. Before going back 
into DS, copy the matrix of the object, then when you come back into Bryce and the 
object has been reloaded, paste the matrix on to the imported DS object to restore it to 
the size, position, and rotation the previous version was at.  
One caveat though, if you change the pose or clothing on the figure, you won't get 
exactly the same thing as before because the matrix of the new object is different than 
the new one. In this case, it is better to use the 3D Transformation and size the object 
by a percentage each time. 
To copy an object's matrix: 

1. Select an object or group. 
2. Choose Edit > Copy Matrix from the menu or press Opt/Alt+C. 

Paste Matrix 

The Paste Matrix command pastes the matrix copied using the Copy Matrix command, 
overriding the selected object(s) position, rotation, and size.  
To paste a matrix onto an object: 

1. Select an object and copy the matrix using the Edit > Copy Matrix command. 
2. Select another object and choose Edit > Paste Matrix from the menu or press 

Opt/Alt+V. 
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Duplicate 

The Duplicate command duplicates the selected object(s) and places the copy directly 
into the scene. The duplicate is not placed on the clipboard so it cannot be pasted into 
the scene later.  
If the selected object is part of a group, then the new object will also be part of the 
group. If you don't want the new object to be part of the group, use Copy/Paste instead.  
To duplicate an object(s) or group(s): 

1. Select the object(s) or group(s) you want to duplicate. 
2. Choose Edit > Duplicate from the menu or press Cmd/Ctrl+D. 

Replicate 

The Replicate command not only duplicates the selected object(s) or group of objects, 
but also the last 3D transformations made on the objects. For example, if you move an 
object up and rotate it, then Replicate will create a copy, then move it up, and rotate it 
the same amount. Each time you replicate, it moves and rotates the new object the 
same amount. 
Replicate only duplicates the object one time. To replicate the object more than once, 
use Multi-Replicate instead.  
To replicate an object: 

1. Select an object or group. 
2. Perform any required 3D transformations on the selection.  
3. Choose Edit > Replicate from the menu or press Opt/Alt+D. 

Example: 
Here is a cube rotated: 
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Replicated once: 

 
Replicated five times, notice how it only rotated the cube: 

 
Here's another cube, rotated and moved up:  

 
Replicated once: 
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Replicated five times, notice how it not only rotated the cube, but moved it up each time:  

 

Multi-Replicate 

The Multi-Replicate command works the same way as Replicate but instead of just 
replicating the object once, it can replicate it multiple times. It can either repeat the last 
transformations you made on the object or you can change the settings manually to 
modify the replications. 
To multi-replicate an object: 

1. Select an object or group to replicate. 
2. Choose Edit > Multi-Replicate from the menu or press Opt/Alt+Shift+D. The 

Multi-Replicate dialog will come up. 
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3. Enter values in the following fields:  
• Quantity - Enter how many objects to replicate, if you need 10 objects 

total, enter 9 in the field.  
• Scale Translation - Select to apply the size percentage to the Offset 

amount, for example, if the size percentage is 90%, then the offset will be 
at 90% of the entered amount for each object.  

• Offset - Enter the amount to move the replicated objects on the X, Y, 
and/or Z-axis.  

• Rotate - Enter the amount to rotate the replicated objects on the X, Y, 
and/or Z-axis.  

• Size - Enter the percentage to re-size the replicated objects on the X, Y, 
and/or Z-axis, set at 100% to keep them the same size as the original. 
 

 
• Scale Translation - enable to use this option 

4. Click on the OK icon to close the dialog and complete the operation.  
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And here is the rendered example:  

 
Notes: 

1. When the object is transformed prior to choosing Multi-Replicate, the fields have 
the matching amounts already in them. 

2. If the object has not been moved, the Offset and Rotate fields will be at zero and 
the Size at 100%. 

Scale Translation 

As mentioned on the Multi-Replicate page, selecting Scale Translation will apply the 
size percentage to the Offset amount, for example, if the size percentage is 90%, then 
the offset will be at 90% of the entered amount for each object. 
For example, the dialog below shows that we want to replicate an object four times, 
offsetting each duplicate 30 BU along the X-axis, and reducing the size of each 
duplicate to 90% of the previous duplicate:  
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And here is the result, notice how the cubes are all exactly the same space apart (30 
BU): 

 
But, if we select Scale Translation: 

 
Then the offset will be 90% of 30 BU for each duplicate:  

 

Random Replicate 

New in Bryce 6 is the Random Replicate command. This function is similar to Multi-
Replicate in that it replicates one or more objects. The difference is that each replication 
is random in placement and in the number each object is replicated. Each time you 
repeat a replication, the number of each object replicated changes.  

• Quantity - Enter how many objects to create during the replication  
• Boundary - Enter the boundary, in BUs for where the replicated objects can be 

created around the original objects  
• Collision Detection - Select to enable collision detection when replicating objects 
• Constrain Rotation to Y-axis - Select to constrain rotation to the Y-axis  
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• Land Objects - Select to have objects Snap to Land after being replicated 
 

 
Please note that if you are replicating Bryce Trees or Terrains, the Constrain Rotation to 
Y-axis function is automatically selected. If you deselect Constrain Rotation to Y-axis 
when trees or terrains are selected, Bryce will still constrain the objects to the Y-axis. 
To use random replicate: 

1. Create one or more objects 
2. Select all the objects you want to replicate. 
3. Choose Edit > Random Replicate from the menu or press Opt/Alt+R. 
4. Enter the number of replications in the Quantity field 
5. Enter the Boundary amount on the X, Y, and Z-axis (defaults to 200).  

• If you want the objects to be no more than 50 BU away from the originals, 
enter 100 (50 BU both positive and negative).  

• If you want the objects to be no more than 200 BU away from the 
originals, enter 400 (200 BU both positive and negative).  

6. To have the objects snap to land, select Land Objects. 
7. To only allow the objects to be rotated on the Y-axis (good for trees, houses, 

etc.), select Constrain Rotation to Y-axis. 
8. Click on the OK icon to accept the changes and complete the operation.  
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Examples:  
Basic Random Replication  
The following example replicates three objects (cube, sphere, and torus) 15 times with a 
boundary of 100 on all axes: 

 
And here is the result:  

• Sphere - Replicated four times  
• Torus - Replicated five times  
• Cube - Replicated six times  

 
If the objects are all selected and grouped, the size of the group (Boundary) will be 
around 100 BUs (give or take a few BUs) based on the boundary selected in the dialog.  
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After deleting the replicated objects and repeating the same Random Replication, a 
different combination of objects is created, for example: 

• Sphere - Replicated seven times  
• Torus - Replicated four times  
• Cube - Replicated four times  

 
Land Objects 
The following image shows the result of the random replication with the Land Objects 
selected. Since the default plane is the "land," the objects all snap to it. The same thing 
will happen if the default plane has been deleted (underground plane is considered the 
"land"). 
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The following image shows the result of the random replication with the Land Objects 
selected and a terrain in the scene. Only the primitives were replicated, not the terrain. 

 
This is especially useful for placing objects like trees and rocks around a terrain. The 
objects will snap to the terrain for a more natural look:  
(Okay, so primitives on a terrain aren't "natural" but you get the idea.) 
Constrain Rotation to Y-axis & Collision Detection 
The image below shows the result of the random replication with the Constrain Rotation 
to Y-axis and Collision Detection selected. Notice that the objects are only rotated 
around the Y-axis - useful for placing trees, houses, people, etc.  

 

Select All 

The Select All command will select all objects in the working window. 
To select all objects, choose Edit > Select All from the menu or press Cmd/Ctrl+A. On 
the PC, you can also set the NumLock, then press Ctrl+1 key on the numpad. 
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Deselect All 

The Deselect All command deselects all currently selected objects or groups in a scene.  
To deselect all selected objects or groups in a scene, choose Edit > Deselect All from 
the menu.  

Invert Selection 

The Invert Selection command will invert the selection by deselecting all currently 
selected objects in the scene and selecting all objects that weren't previously selected. 
To invert the selection, choose Edit > Invert Selection from the menu or press 
Ctrl+Shift+A. 

Reset to Defaults 

The Reset to Defaults command resets all menus, palettes, and the working window to 
their default factory position. 
To reset the interface to the default settings, choose Edit > Reset to Defaults from the 
menu.  

Reset Palettes 

The Reset Palettes command will reset all moved palettes back to their default position. 
To reset all palettes, choose Edit > Reset Palettes from the menu. 

Preferences 

The Preferences command brings up the preferences palette where you can set how 
Bryce launches and saves.  
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The Preferences dialog contains the following options: 

• Launch to default state - opens Bryce to the default factory state OR to the saved 
Default.br6 scene file.  

• Launch to previous state - opens Bryce to the last state Bryce was in before 
closing the program.  

• Image with Scene Open/Save - saves the rendered image with the scene and 
loads the image when the scene is loaded.  

• Create object within view - creates objects within the current view, this allows you 
to be anywhere in the scene and new objects will still be in view.  

• Create object at world center - creates objects at world center, no matter where 
the current camera view is at.  

• Create objects with default material - creates objects with the default gray 
material.  

• Create objects with last used material - creates objects with the last material 
loaded manually through the Materials Library or Texture Editor.  

• Copy sky to new document - will copy the sky in the current scene to a new 
scene created by File > New Document.  

By setting application Preferences, you can customize Bryce to suit the way you work. 
You do not have to restart Bryce to make these changes take effect. 
To set the application's launch state: 

1. Choose Edit > Preferences. The Preferences dialog appears. 
2. Enable either Launch to Previous State or Launch to Default State.  

• Launch to Previous State launches Bryce using the settings from your last 
session.  

• Launch to Default State launches Bryce using the default settings.  
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To save images used in a scene with a file: 
1. Choose Edit > Preferences. The Preferences dialog appears. 
2. Enable Image with Scene Open/Save. With this option enabled, Bryce will 

automatically open or save a PICT or BMP file (PICT/BMP files are automatically 
appended with the extension), along with your scene file, every time you open or 
save. In most cases, this option should always be selected. 

To control new object placement: 
1. Choose Edit > Preferences. The Preferences dialog appears. 
2. Enable either Create Objects Within View or Create Objects at World Center.  

• Create Objects Within View places newly created objects within the 
camera view, rather than at world center.  

• Create Objects at World Center places newly created objects at world 
center, regardless of whether they will be visible in your current camera 
view.  

Objects Menu 
The Objects Menu is where you access object-related functions. To access this menu, 
just left-click on Objects. 
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Edit Object 

The Edit Object command brings up the appropriate edit palette for the selected object. 
This only works on objects that have the  button next to the selected object.  
To edit an object: 

1. Select an object in the scene. 
2. Choose Objects > Edit Object from the menu or press Cmd/Ctrl+E. The editor for 

that object will come up.  

Object Selected  Edit Palette 

Terrain or SymLat Terrain Editor  

Torus Edit Torus 

Tree Tree Lab 

Rock, Imported 
Mesh * 

Edit Mesh 

 
* Once the Edit Mesh dialog comes up for rocks and imported meshes, you can export 
the mesh by pressing Cmd/Ctrl+D. See "Exporting Rocks & Imported Meshes" for more 
on this. 

Attributes 

The Attributes command brings up the Object Attributes dialog. This is the same dialog 
panel that comes up when you press the  button next to the selected object. 
To edit the object's attributes: 

1. Select a group or object. 
2. Choose Objects > Attributes from the menu or press Cmd/Ctrl+Opt/Alt+E. 

The Object Attributes dialog consists of three tabs: General, Linking, and Animation. 
• The General tab is where the basic object attributes are set: object name, 

position, size, rotation, and display quality. 
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• The Linking tab contains options that let you set up the link between two objects 

and set up the tracking link. 
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• The Animation tab contains options for controlling the display of motion paths 
and setting the motion path type. 
 

 
See "Working with Objects" for more on this dialog. 

Convert Boolean to Mesh 

The Convert Boolean to Mesh command is new in Bryce 6 and converts Boolean 
groups to mesh which can then be exported from Bryce and imported into other 
programs. 
To convert a Boolean group to mesh: 

1. Build an object using Boolean objects that are grouped together. 
2. Choose Objects > Convert Boolean to Mesh from the menu or press 

Opt/Alt+Shift+C. The Boolean group will be converted to a mesh. 
3. Choose File > Export Object from the menu and export the converted mesh to 

finalize the conversion. 
4. Choose File > Import Object from the menu to import the mesh. 

See "Convert Boolean Icon" for information on using this feature. 
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Edit Material 

The Edit Material command brings up the Materials Lab. This is the same editor that 
comes up when you press the  button next to the selected object. 
The Materials Lab is where you create the materials to apply to your objects. By 
combining up to four texture components on the materials grid, you can create 
incredibly complex surfaces that can bring your scene to life. 
There are two types of materials you can create: Surface materials, which define the 
surface properties of an object, and Volume materials, which define the properties of an 
object's volume as well as its surface. When you're creating volume materials, the 
settings in the Materials Lab change. Some of the surface material settings are replaced 
by volume effects settings. 
To edit a material in the Materials Lab, select Objects > Edit Material from the menu or 
press Cmd/Ctrl+M.  
You do not have to have an object selected in order to open the Materials Lab, 
however, if you want to edit a material already applied to an object, select the object 
first. 
Refer to "The Materials Lab" for more on the Materials Lab and "Understanding Volume 
Material Channels" for more on Volume materials. 
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Edit 2D Pictures 

The Edit 2d Pictures command brings up the Pictures Editor. You can also access the 
Pictures Editor from the Create Palette, the Materials Lab, the Light Lab, and the Tree 
Lab. 
To open the Pictures Editor, choose Objects > Edit 2d Pictures from the menu or press 
Cmd/Ctrl+Opt/Alt+M. You do not have to have an object selected to bring up the 
Pictures Editor this way. 
The Pictures Editor will come up: 

 

Edit 3D Textures 

The Edit 3d Textures command brings up the Deep Texture Editor (DTE) You can also 
access the Deep Texture Editor from the Edit Palette, Materials Editor, Light Lab, Sky 
Lab, Tree Lab, and Terrain Editor. 
To open the Deep Texture Editor, choose Objects > Edit 3d Textures from the menu or 
press Opt/Alt+M. You do not have to have an object selected to bring up the Deep 
Texture Editor this way. 
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Show Object As Box 

The Show Object As Box command changes the selected object(s) or group as box(es). 
This is useful when you just want to work with the object's position but don't need more 
details. 
To show objects as boxes, choose Objects > Show Object As Box from the menu or 
press Cmd/Ctrl+B.  
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Show Object As Lattice 

The Show Object As Lattice command changes objects shown as boxes back to 
wireframes. 
To show objects as a wireframe, choose Objects > Show Object As Lattice from the 
menu or press Cmd/Ctrl+L. 

 

Group Objects 

The Group Objects command groups two or more objects or groups into a single group. 
As your scene becomes more complex, you'll need to group objects. Grouping lets you 
control a set of objects as a single unit. When you perform a transformation on a group, 
all the objects are equally affected. If you scale a group, all the objects change size, or if 
you rotate a group, all the objects rotate around a single axis. 
Your choice of objects to place in a group depends on how you want to organize your 
scene. You may want to group the objects that comprise more complex objects, like the 
walls and turrets of a castle. You can group objects to keep all the components of a 
complex object like this train engine together. You can also create groups to maintain 
the spatial relationships between objects as you transform them. 
You can also create a group to maintain the spatial relationships between objects as 
you transform them, like the boards in this fence. You can place as many objects as you 
like in your group. You can even nest groups within groups. Nesting can be an easy 
way of managing more complex scenes. 
Groups are essential to creating Boolean objects and converting them to a mesh. 
Boolean operations will not work unless the objects are part of a group. You cannot 
create a group using a child object. If a child object is part of your selection the  icon will 
not appear. 
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To create a new group: 
1. Select all the objects and/or groups you want to group. 
2. Choose Objects > Group Objects from the menu or press Cmd/Ctrl+G. You can 

also click the  button next to the selected objects' bounding box. 
 

 
To select objects within a group: 

1. Hold down Cmd/Ctrl and click on an object inside the group bounding box. A 
popup menu will come up listing all the objects under the mouse. 
 

 

©2007 DAZ 3D, Inc.  92 



Bryce 6 Artist Guide 

2. Select the object you want from the menu. 
 

 

Ungroup Objects 

The UnGroup Objects command removes the grouping from the current selection. If the 
selection contains nested groups, you can continue to choose this command until all the 
groups are ungrouped, or until the ungroup control disappears. 
The ungroup control (button) only appears if you've selected a group or a number of 
objects contained in a group. When you click this control, any group in the selection is 
ungrouped. 
To ungroup a selected group of objects: 

1. Select all the groups you want ungrouped. 
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2. Choose Objects > UnGroup Objects from the menu or press Cmd/Ctrl+U. You 
can also click the  button next to the selected groups' bounding box. 
 

 

Break DAZ Studio Link 

The Break DAZ Studio Link command breaks the link between Bryce and the object(s) 
imported through the DAZ Studio link. 
Breaking the link will let you modify the mesh as needed, such as deleting meshes that 
won't be seen. If you attempt to the delete one of the meshes without breaking the link, 
you'll delete the imported objects instead. 
To break the link to DS: 

1. Select the object group that was imported from DS. 
2. Choose Objects > Break DAZ Studio Link from the menu. 

Caution: If you have imported an animation from DS, do not break the link! Since the 
animation is stored in the corresponding .daz file and not in Bryce, this will delete the 
animation as well. 

Create Path 

The Create Path command creates a default geometric path which can then be used as 
a motion path for other objects. 
A Geometric Path is an object that acts as a motion path for other objects. Geometric 
Paths do not render as objects. You can think of these paths as railroad tracks. Objects 
can move along the track but they can't move off of it. 
You can control how an object is constrained to the path using the options in the Object 
Attributes dialog. 
Geometric Paths can be edited just as you would any other object. You rotate, position, 
or scale the path using the tools in the Edit palette. You can also edit a path by dragging 
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its control points. This way you can change the geometry of the paths as well as the 
trajectory of any object attached to it. 
Geometric Paths are especially useful when you are creating motion animations, as 
they can help you create predictable and repeatable motion. 
The other great thing about Geometric Paths is that you can have more than one object 
attached to it. This can be very useful if you want a number of objects to move along the 
same trajectory. 

 
Objects that are attached to the same path can be animated at different rates. So, if you 
can think of the objects as different trains on the same track, some trains are at the 
beginning of the track, others are in the middle, and some are at the end. All the objects 
attached to the path will have the same trajectory. 
You can also align objects differently to the same path. So objects may appear to tilt 
differently as they follow the same trajectory. 
Since Geometric Paths are objects, they can also be attached to other paths. Some 
very complex types of motion can be created using this technique. For example, you 
can simulate the motion of the solar system by attaching an object on a circular path to 
a circular geometric path. The object on the circular path would act like a moon orbiting 
a planet which is also orbiting the Sun. 
To create a geometric path, choose Objects > Create Path from the menu or press 
Opt/Alt+P. A default-shaped path object appears in your scene. 
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To convert a motion path into a geometric path object: 

1. Select an object with a motion path. 
2. Choose Objects > Create Path from the menu. A path object with the same 

shape path you selected is created. 
To link an object to a path: 

1. Select the object you want to attach to the path. 
2. Move the cursor over the Link icon that appears next to its bounding box. 
3. Drag the linking control handle from the object to the path object. 

Fly-around 

The Fly-around command starts the wireframe view in the Working window to rotate 
allowing you to view the objects in the scene. 
To start the scene fly-around, choose Objects > Fly-around from the menu or press 
Cmd/Ctrl+Y. 
To stop the scene fly-around, click in the Working window.  
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Motion Lab 

The Motion Lab command opens the Advanced Motion Lab (AML) where animations 
can be modified. 
To open the AML, choose Objects > Motion Lab from the menu or press Cmd/Ctrl+T. 

 

Sky Lab 

The Sky Lab command opens up the Sky Lab where your sky can be modified. 
To access the Sky Lab, choose Objects > Sky Lab from the menu or press Cmd/Ctrl+K. 
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Preview Animation 

The Preview Animation command allows you to see a rendered preview of your 
animation either in the Nano-Preview window or as a storyboard depending on what is 
selected in the Preview Animation popup menu 
To preview an animation, choose Objects > Preview Animation from the menu. 

Links Menu 
The Links Menu provides links to DAZ3D.com, Tech Support, and DAZ Arcana 
Tutorials. 

 
To change the links in the Bryce 6 Links menu: 

1. Locate the file "Bryce6 Links.txt" in your Bryce folder.  
2. Open this file with a text editor.  
3. Type in a link name as you want to see it in the menu, followed by a comma (,) 

and two spaces, then on the same line type the URL in quotation marks such as 
"http://www.daz3d.com"  

4. To place a separator between links, type a dash between quotation marks ("-")  
5. Save the file to replace the existing one.  

Example: 
"Tech Support", "http://www.daz3d.com/redirects/contact_us.php" 
"Tutorials", "http://www.daz3d.com/redirects/bryce_tutorial.php" 
"-", "-" 
"How to change this menu...", "linksmenu.htm" 

You can replace the links that are there or add new ones.  
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Help Menu 
The Help Menu provides links to the included help file and other helpful links. 

 
To view the current version/build of Bryce, press Cmd/Ctrl and choose Help > About 
Bryce 6.x. 

Customizing Bryce 
The Bryce interface can be customized to better suit your personal workflow. If you want 
to, you can tear apart the interface and reposition any palette, or you can choose to hide 
the entire interface and leave only the working window visible. 

Moving Palettes 
Most of the palettes can be moved around the Bryce interface. This allows you to take 
advantage of some of the space around the Working Window and save time since you 
don't have to keep clicking the buttons at the top of the window to change palettes. 
To move the palettes:  

1. Move the cursor over the palette to be moved and press the Space Bar. The 
cursor will change to a hand. 
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2. With the Space Bar still pressed, left-click-drag the palette to where you want it. 
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3. Repeat for any other palettes you want to move. Using this technique, you can 
have the Create, Edit, and Sky & Fog palettes active at the same time instead of 
having to click on each palette name each time you want to use it. 
 

 
Note that the Time and Selection palettes cannot be moved separately. Continue to use 
the Time/Selection Toggle to switch between them.  
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Reset All Palettes 
To reset all the palettes to their original positions, select Edit > Reset Palettes from the 
menu or press Opt/Alt+Spacebar+click on any palette. 

 

Display or Hide Palettes 
To keep the interface uncluttered, some of Bryce palettes and toolbars may be hidden. 
To hide or display palettes, either click on a text button above the Working window or 
press the key combination for the desired palette: 

• Ctrl+1 - Create palette  
• Ctrl+2 - Edit palette  
• Ctrl+3 - Sky & Fog palette  
• Ctrl+4 - Control palette 
• Ctrl+6 - Advanced Display palette 
• Ctrl+Tab - Display or Hide all palettes 
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Hide Interface 
To hide the Bryce interface, press Cmd/Ctrl+Alt. All the palettes disappear and your 
image appears at the center of your work space. Press Cmd/Ctrl+Alt again to display all 
the palettes. 

The Palettes 
Bryce uses a series of palettes to manage tools and controls: the Create Palette, Edit 
Palette, Sky & Fog Palette, Advanced Display Palette, Selection Palette, and Animation 
Controls. These palettes let you create objects, edit objects, create skies and fog, 
control the display of your scene, select objects, and animate objects. Refer to "The 
Palettes" for more on using the different palettes.  
Beside the title of each of the three tool palettes (the Create palette, Edit palette, and 
Sky & Fog palette) is a small triangle that opens the different Preset Libraries available 
in Bryce. Refer to "Preset Libraries" for more on Preset Libraries. 

Create Palette 

 
The main tool for creating objects is the Create palette. This palette provides access to 
tools that let you create all the object types available in Bryce. The tools on the palette 
represent the type of object they create. The name of each tool appears in the Text 
Display Area and as a Tool Tip as you move your cursor over it. When you click a tool, 
the object appears in the center of the workspace or scene depending on your 
preference setting. 

To display the Create palette, click the  button at the top of the Bryce window. 
To use a Create tool: 

1. Display the Create palette by clicking on the Create button. 
 

 
2. Click on the tool for the object type you want to create. The object appears in the 

working window. 

©2007 DAZ 3D, Inc.  103 



Bryce 6 Artist Guide 

The Triangle icon next to the Create button at the top of the Bryce window lets you 
access the Object Presets Library. 

Objects Library 

The Preset Object Library contains all the preset objects distributed with Bryce as well 
as presets you add. Objects in the library are either 3D models or geometric paths. You 
can use the Preset Objects Library to add ready-made objects to your scene. 
You can place objects from the library anywhere in your scene and edit them just as you 
would any object. 
You can add and delete objects from the libraries, add and delete categories, and 
change the thumbnail preview image. 
To access the Preset Objects Library:  

1. Click quickly on the triangle next to the Create button. Please note that if you 
hold down the mouse key for too long, the library will open, then close 
immediately. To keep the library open, click quickly on the triangle icon.  
 

 
2. The Preset Objects Library will come up. 
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Bryce comes with two object preset category folders: Installed and User. The Installed 
preset category folder contains the presets that are installed with Bryce. The User 
preset category folder is empty by default and provides a quick way to save objects to 
the library. 
To choose a preset category folder, click the triangle icon next to the preset category 
folder name at the bottom left of the Preset Object Library and choose a preset category 
folder from the drop-down menu. The Preset Object Library opens that preset category 
folder and displays the categories and presets found in that folder. 

 
Refer to "Libraries" for more information on adding/deleting categories and presets and 
updating the thumbnail previews. 

Primitives vs. Procedurals 

Bryce's Create palette lets you create two different types of basic objects: Primitives and 
Procedurals. 
Primitives are basic geometric shapes such as the sphere, torus, cylinder, cube, 
pyramid, cone, plane, and disk. These shapes can be thought of as primary geometric 
building blocks, from which more complex objects are constructed. 
Primitives also have derivative groups (such as the ellipsoid and squashed sphere, 
which are derived from the Sphere), which allow you to create different shapes without 
having to perform the transformations yourself. 
Procedural objects are object that require special constructions, or "procedures," to 
create, such as terrains, trees, rocks, symmetrical lattices, and Metaballs. Procedures 
can include operations such as assigning materials, randomizing internal parameters, or 
assigning light properties. 

Creating Primitives 

Primitives are the primary geometric building blocks in Bryce. You can create spheres, 
tori, cylinders, cubes, pyramids, cones, discs, and 2D faces. 
By default all Primitives are assigned a flat gray color. 
Derivative Primitives  
Derivative Primitives are primitive objects whose shape is "derived" from basic 
geometric primitives. 
Derivative Primitives were created so that you could skip some of the editing 
procedures on most of the basic primitives. For example, instead of elongating a cube 
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to make it into a pillar, you can just use the Stretched Cube derivative. Instead of 
shortening a cube to make it into a rectangle, you can use the Squashed Cube 
derivative. 
To create a geometric primitive, click one of the primitive tools in the Create Palette. 

Creating a Sphere 

To create a default Sphere, click on the Sphere tool in the Create palette: 

 
The Sphere will be created with X, Y, and Z-size of 20.48 BU: 

 
To create a Stretched Sphere, press Shift+click Sphere tool. 
The Stretched Sphere will be created with X and Z-size of 20.48 BU and Y-size of 40.96 
BU: 
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To create a Squashed Sphere, press Cmd/Ctrl+click Sphere tool. 
The Squashed Sphere will be created with an X and Z-size of 20.48 BU and Y-size of 
10.24 BU: 

 

Creating a Torus 

To create a default Torus, click on the Torus tool in the Create palette: 

 
The Torus will be created with an X and Y-size of 20.48 BU, Z-size of 5.12 BU, and 
radius of 256: 

 
The torus has it's own editor which can be accessed by clicking the  button next to the 
torus. 
See the "Torus Editor" for more information on using the editor. 

Creating a Cylinder 

To create a default Cylinder, click on the Cylinder tool in the Create palette: 
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The Cylinder will be created with an X, Y, and Z-size of 20.48 BU: 

 
To create a Stretched Cylinder, press Shift+click Cylinder tool. 
The Stretched Cylinder will be created with an X-size of 20.48 BU, Y-size of 40.96 BU, 
and Z-size of 10.24 BU: 

 
To create a Squashed Cylinder, press Cmd/Ctrl+click Cylinder tool. 
The Squashed Cylinder will be created with an X and Z-size of 20.48 BU and Y-size of 
5.12 BU: 

 

Creating a Cube 

To create a default Cube, click on the Cube tool in the Create palette: 
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The Cube will be created with an X, Y, and Z-size of 20.48 BU: 

 
To create a Stretched Cube, press Shift+click Cube tool. 
The Stretched Cube will be created with an X-size of 10.24 BU, Y-size of 40.96 BU, and 
Z-size of 20.48 BU: 

 
To create a Squashed Cube, press Cmd/Ctrl+click Cube tool. 
The squashed cube will be created with an X and Y-size of 5.12 BU and Z-size of 20.48 
BU: 

 

Creating a Pyramid 

To create a default Pyramid, click on the Pyramid tool in the Create palette: 
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The Pyramid will be created with an X, Y, and Z-size of 20.48 BU: 

 
To create a Stretched Pyramid, press Shift+click Pyramid tool. 
The Stretched Pyramid will be created with an X-size of 10.24 BU, Y-size of 40.96 BU, 
and Z-size of 20.48 BU: 

 
To create a Squashed Pyramid, press Cmd/Ctrl+click Pyramid tool. 
The Squashed Pyramid will be created with an X and Z-size of 20.48 BU and Y-size of 
5.12 BU: 

 

Creating a Cone 

To create a default Cone, click on the Cone tool in the Create palette: 
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The Cone will be created with an X, Y, and Z-size of 20.48 BU: 

 
To create a Stretched Cone, press Shift+click Cone tool. 
The Stretched Cone will be created with an X-size of 10.24 BU, Y-size of 40.96 BU, and 
Z-size of 20.48 BU: 

 
To create a Squashed Cone, press Cmd/Ctrl+click Cone tool. 
The Squashed Cone will be created with an X and Y-size of 10.12 BU and Z-size of 
40.96 BU, it will also be lying on its side: 

 

Creating a 2D Disc 

To create a default, vertical Disc, click on the Disc tool in the Create palette: 
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The Disc will be created with an X and Y-size of 20.48 BU and Z-size of 0 BU: 

 
To create a horizontal Disc, press Cmd/Ctrl+click Disc tool: 

 

Creating a 2D Face 

To create a default, vertical 2D Face, click on the 2D Face tool in the Create palette: 

 
The 2D Face will be created with an X and Y-size of 20.48 BU and Z-size of 0 BU: 

 
To create a horizontal 2D Face, press Cmd/Ctrl+click 2D Face tool: 

 

Creating Infinite Planes 

An Infinite Plane object extends in all directions to infinity. You can create cloud, water, 
and ground planes.  
When you create a plane in Bryce it appears as a finite plane to make it easier to 
position, but when your scene is rendered the plane extends infinitely in all directions. 
Though procedurally the three infinite plane types are different, they are all considered 
to be Infinite Planes for the purpose of selecting with the Selection tools.  
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An Infinite Plane is a plane object that has no depth. An Infinite Slab is a plane object 
that has depth. The Infinite Plane has no effect on objects above it or below it; an 
Infinite Slab can affect objects within it. For example, anything you place within the 
slab's depth will be affected by the slab's volume color. 
Slabs are usually used to create water. When you create a water slab, you create water 
with realistic volume. This means that if you sink an object into the water it will be 
affected by the colors or textures you assign to the slab's volume. 
The realistic look of a water slab depends almost entirely on the material you assign to 
it. The Volume color plays an essential role in creating realistic water effects. 

Creating a Ground Plane 

Ground Planes are created at ground level. By default, all new scenes open with an 
infinite Ground Plane. 
To create a Ground Plane, click the Ground Plane tool in the Create palette. 

 
OR 
Left-click-hold on the Ground Plane and choose Surface from the menu: 

 
Once the plane appears in your scene you can edit it like any other object. Use the 
Ground Plane to add ground to your environment. 
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The Ground Plane is created with a gray color, as are all Bryce primitives. Once you 
begin assigning textures to objects, Ground objects (as well as all other primitive 
objects) will inherit the texture assigned to the previous object. 

 

Ground Slab 

To create a Ground Slab, press Alt+click Ground Plane tool 
OR 
Left-click-hold on the Ground Plane and choose Volume from the menu: 

 
The Ground Slab will be created with the base of the slab at the same level as the 
default Ground Plane:  
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The slab depth can be modified by clicking on the  button and changing the Y-size 
from the default 20.48 BU: 

 
Here the Y-size has been changed to 50 BU:  

 
A Ground Slab usually has an opaque material applied to it so it can't affect objects 
placed within it, however, when a cloud material is applied to it, you've got a fog object 
that affects the ground below it and any objects placed in it 
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Examples: 
• Ground Plane by itself: 

 

 
• Ground Slab added with foggy material applied: 

 

 

Creating a Water Plane 

Water Planes are created just a bit higher than ground level. That way, if you have 
already created ground and terrains, you can easily place a water plane into your scene 
and immediately see the terrains peeking out from the water. 
To create a Water Plane, click the Water Plane tool in the Create palette: 

 
OR 
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Left-click-hold on the Water Plane tool and choose Surface from the menu: 

 
The Water Plane will be created with the plane above the default Ground Plane: Once 
the plane appears in your scene you can edit it like any other object. 

 

 
Water Planes are created with a water texture randomly chosen from the Waters Preset 
Materials Library. You can change this material by selecting a different preset or 
creating a new material. 

Water Slab 

To create a Water Slab, press Opt/Alt+click Water Plane tool 
OR 
Left-click-hold on the Water Plane tool and choose Volume from the menu: 
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The water slab will be created with the Ground plane halfway between the top and 
bottom of the slab: 

 
The slab depth can be modified by clicking on the  button and changing the Y-size 
from the default 20.48 BU: 

Creating a Cloud Plane 

To create a Cloud Plane, click on the Cloud Plane tool in the Create palette: 

 
OR 
Left-click-hold on the Cloud Plane tool and choose Surface from the menu: 

 
Once the plane appears in your scene you can edit it like any other object. 

 
Cloud planes are created with a cloud texture randomly chosen from the Clouds > 
Infinite Planes Preset Materials Library. You can change this material by selecting a 
different preset or creating a new material. 
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Cloud Slab 

To create a Cloud Slab, press Alt+click on the Cloud Plane tool in the Create palette: 
OR 
Left-click-hold on the Cloud Plane tool and choose Volume from the menu: 

 
The volume Cloud Plane will be created: 

 

Creating Terrains 

Terrain Objects define the landscape of your scene. They represent the land forms of 
any scene: mountains, deserts, islands, or even floating cities. In Bryce, a Terrain 
Object is a height map that determines the shape of your landscape. 
Bryce creates a terrain's shape by converting brightness values in grayscale images 
into a height map. White areas in the image result in the highest altitudes and black 
areas result in the lowest. These maps are called grayscale-to-height maps (G2H). The 
Terrain Editor (TE) lets you generate the grayscale images that are used to create 
terrain objects and you can also create grayscale images in a paint program and import 
them into the TE.  
Once you have a Terrain object you can customize it in the Terrain Editor. 
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To create a Terrain, click on the Terrain tool in the Create palette:  

 
A randomly generated Terrain appears in your scene with X and Z-size of 81.92 and Y-
size of 20.48: 

 
To modify the Terrain, click on the  button next to the selected terrain to enter the 
Terrain Editor. 

Creating Symmetrical Lattices 

A Symmetrical Lattice (or SymLat) is a terrain object that has a mirror image of itself 
fused at its base. When you modify one half of the lattice, the corresponding changes 
are applied to the mirrored half. 

 
The Symmetrical Lattice can be a great timesaving tool. Instead of creating symmetrical 
shapes by duplicating and aligning two halves, you just need to create one half of a 
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lattice and your object is duplicated for you. Symmetrical Lattices are edited as Terrains, 
using the Terrain Editor. 
Many advanced types of objects can be created using the Symmetrical Lattice object. 
Any object that is symmetrical can be created by painting its shape in the Terrain Editor. 
The Ladybird in the image below was created using several Symmetrical Lattice objects 
for the legs, head, thorax, body, and antennae. The shell is a terrain. 

 
To create a Symmetrical Lattice, click the Symmetrical Lattice tool in the Create palette:  

 

Creating Trees 

The Tree Object tool creates natural-looking tree shapes that can be assigned 
materials, shaped, and positioned throughout your scene. 
To add a Tree Object to your scene, click the Tree Object tool. A random default tree 
appears in your scene. 
Once you have a Tree Object, you can customize it in the Tree Lab. You can control the 
size and texture of the tree trunk, the thickness and number of branches, and the type 
of foliage and its frequency, randomness, and color. You can import images to be used 
for the trunk or foliage texture. You can also control how gravity affects the tree, making 
branches bend and leaves droop to varying degrees. 
Once you have a tree object you can customize it in the Tree Lab. 
To create a Tree, click on the Tree tool in the Create palette:  
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A randomly generated Tree appears in your scene: 

 
To modify the Tree, click on the  button next to the selected Tree to enter the Tree 
Lab. 

Access Pre-Generated Trees 

Bryce includes a library of pre-generated Trees that can be accessed using a modifier 
key. 
To access these presets, press the Opt/Alt+click Tree tool, a File Open dialog will come 
up where you can select one of the .bto tree presets to load in the scene. 
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Saving Tree Presets 

To save a Tree preset to the Tree Library folder, select the tree then press the Ctrl+click 
Tree tool, a file save dialog will come up where you can name the Tree and save it. 

 
Please note that when you save a tree this way, only the material applied to the trunk 
and branches is saved along with the tree information. Any material applied to the 
leaves is lost. 
To save the tree with materials intact and to ensure that the tree isn't randomized on 
loading, save the tree to the Objects Library. 

Creating Stones 

The Stone Object tool creates random, natural-looking stone shapes that can be 
assigned materials and positioned throughout your scene. 
To create a Stone Object, click the Stone Object tool in the Create palette:  
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Each time you click the Stone Object tool, you will get a different shaped mesh. The 
image below shows examples of some of the possibilities: 

 
Stone Objects are mesh based, and can be smoothed or unsmoothed using the Edit 
Mesh dialog. See "Mesh Editor" for more information on smoothing and unsmoothing 
meshes.  
Stones are assigned random textures automatically from the Stones Preset Materials 
Library. 
Since Stones are essentially clumps of meshes, their realism is highly dependent on the 
textures assigned to them. For example, if you assign a flat texture with no bumpiness 
to a Stone, the results won't be very Stone-like. Try to assign rocky textures to stones. 
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Creating Metaballs 

Metaballs are spheres that blend into each other based on proximity. With Metaballs, 
you can create a wide variety of realistic-looking shapes. Metaballs let you quickly 
create fluid shapes that are otherwise time-consuming or even impossible to create 
using primitives and Boolean operations. 
When you are in Wireframe view, Metaballs are represented as simple spheres. To see 
how the Metaballs will blend together, you must either look at the Nano-Preview or 
render the image. 
To create a Positive Metaball, click on the Metaball tool in the Create palette: 

 
The Metaball will be created with X, Y, and Z-size of 20.48 BU (although the actual 
Metaball is much smaller than that): 

 
To create a Negative Metaball, press Shift+click Metaball tool.  
The Negative Metaball looks just like the positive one, even down to the Attributes being 
set to Neutral. You'll only be able to tell the difference by rendering the scene to see the 
effect of the Negative Metaball on the Positive Metaball(s). 
If your metaball looks like the image below (created by pressing N+click Metaball tool), 
then it will act like a Positive Metaball, even though it looks like a negative object: 
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Two rendered Positive Metaball compared to a Negative and Positive set: 

 
You can blend Metaballs of different sizes. This gives you more control over the 
resulting shape. To blend Metaballs, simply place the Metaballs close to each other. 
The closer together they are, the more they will blend into each other. The farther apart 
they are, the more they will resemble distinct spheres. 
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• Level of Attraction - find out more about metaballs and how they attract or repel 
each other. 

You can also change the shape of Metaballs in your scene to get different effects. For 
example, you can squash or stretch a Metaball, changing the surface area that blends 
into nearby Metaballs. Two oval Metaballs will give you a different blend result than two 
spherical Metaballs. 

 
For Metaballs to blend smoothly, they must have the same material. If you blend two 
Metaballs with differing materials, you will not always get a smoothly blended result - 
unless that's the effect you're going for. 

 
Metaballs can also be grouped - see "Grouping Metaballs" for more on this. 
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Level of Attraction 

Metaballs have a default "level of attraction" starting from the center of the Metaball and 
decreasing as it moves towards the outside edge. 
If we use a scale of 0 to 1, the center of the Metaball has an attraction level of 1 while 
the outer radius of the Metaball has an attraction level of 0.  

 
The level of attraction can be increased by duplicating one of the Metaballs. 
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Notice how the level of attraction increases where the two Metaballs are:  

 
Duplicating the Metaball again increases the level of attraction even more: 

 

Grouping Metaballls 

Metaballs can be grouped together to prevent other Metaballs from affecting them. 
In the example below, two positive Metaballs (green and red) are grouped and placed 
next to a positive and negative Metaball. 
The ungrouped Positive Metaball is affected by the Negative Metaball, but the grouped 
Metaballs are not.  
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If we ungroup the red and green Metaballs, they then can be affected by the other 
Metaballs, both positive and negative. 

 
Please note that grouped metaballs cannot be rendered with an object mask. 
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Creating 2D Picts 

A Pict Object is a 2D picture that is applied to a 2D finite plane. The object is basically a 
picture on a frame. The Frame is a 2D plane, meaning that it has no depth. If you view it 
from the side, it disappears. 
Using a Pict Object is a quick way of creating very complex-looking objects. The only 
limitation is that you can view them from only one angle, so the front of the Pict Object 
must always be facing the camera. 

 
The Alpha channel of the object can be used to create transparencies in the Pict Object. 
This object was created using a 2D Pict Object (top). However, if you move the camera, 
the 2D nature of the object is very obvious (bottom). 

 
A good way of ensuring that your 2D Pict Object never appears distorted is to have it 
track the camera. 

Alpha Channels and Pict Objects  

The picture you use as a Pict Object must have an Alpha channel if you need areas of 
the image to be transparent.. 
The Alpha channel of your Pict images will allow you to specify visible and invisible 
portions of your picture texture. 
For example, you can clip out a picture's background so that only the main object in the 
picture is visible. This is what the car image looks like with (top) and without (bottom) an 
alpha channel applied. 
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The shadow cast by the image will be in the shape of the picture's Alpha channel, which 
gives a more realistic look. 
To create a Pict Object: 

1. Click the Pict Object tool (Leo) in the Create palette to open up the Pictures 
dialog. 
 

 
2. Click on an image square to load an image. 
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3. If the image you want is not in the library, either:  
• Click the Combination Load button above the first box. The load image 

dialog appears. Use the dialog controls to locate the picture you want to 
use and click Open. 
 
OR  

• In another application, copy the picture you want to use to the clipboard. 
Access the Pictures dialog and click the Paste button. 
 
OR  

• Click on a blank square. The load image dialog appears. Use the dialog 
controls to locate the picture you want to use and click Open.  

4. When you load a new picture into the Pictures dialog, the main image is loaded 
into the first box, its alpha channel is loaded into the second box, and the 
combination is loaded into the third. If the image did not have an alpha channel, 
you can load a mask separately by clicking on the Load button above the second 
box: 
 

 
5. You can invert the alpha channel by clicking the Invert button. 
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6. Click the OK icon to exit the dialog. Bryce creates a 2D plane and maps the 
image onto it as a texture. The Pict Object is created with the same aspect ratio 
as the original picture. 
 

 

Creating Lights 

There are two types of lights in Bryce - natural and direct. Natural lighting is provided by 
the sun while direct lighting is provided by light sources. 
There are five types of direct lights you can create: Radial, Spot, Round Parallel, 
Square Spot, and Parallel. 
You can create as many light sources as you need. The only limit is your system's 
memory. Creating additional lights (or light sources) may add significantly to the render 
time of your scene. The size, position, and orientation of a light source can be edited 
exactly like any other object. 
You can also link lights to specific objects so that a light source moves as the object 
moves. You can also set a light to track an object. When it's tracking an object, the light 
reorients itself so that it's always facing the object no matter where it moves. Linking 
and tracking are quick ways of animating light positions. 
Light attributes can be edited in the Light Lab. 
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Radial Lights 

Radial Lights throw light equally in all directions. Use this as a general light source, and 
remember that you can make these lights as tiny as you like and use as many as you 
need. 
To create a Radial Light, left-click on the Radial Light tool in the Create palette. 

 
A Radial Light will be loaded into the scene. 

 
The example below shows how a radial light works in a scene. 
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Spotlights 

Spotlights throw light along a cone-shaped path, creating the classic "stage spot" effect. 
To create a Spotlight, left-click on the Spotlight tool in the Create palette. 

 
A Spotlight will be loaded into the scene. 

 
The example below shows how a spotlight works in a scene. 
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Round Parallel Lights 

Round Parallel Lights produce cylindrical tubes of light and cast circular spots where the 
light falls. 
To create a Round Parallel Light, left-click on the Round Parallel Light tool in the Create 
palette. 

 
A Round Parallel Light will be loaded into the scene. 

 
The example below shows how a round parallel light works in a scene. 
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Square Spotlights 

Square Spotlights are the same as spotlights, except they cast light along a pyramid-
shaped path, creating a square spot where the light falls.  
To create a Square Spotlight, left-click on the Square Spotlight tool in the Create 
palette. 

 
A Square Spotlight will be loaded into the scene. 

 
The example below shows how a square spotlight works in a scene. 
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Parallel Lights 

Parallel Lights cast parallel rays, resulting in no spatial distortion of shadows. This type 
of light is very useful for creating specific shadow patterns, or when used with gels, for 
creating a slide projector. 
To create a Parallel Light, left-click on the Parallel Light tool in the Create palette. 

 
A Parallel Light will be loaded into the scene. 

 
The example below shows how a parallel light works in a scene. 
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Apply Gradient 

You can apply a gradient file (.grd) created in another program by pressing Shift then 
clicking on the light tool. The Open File dialog comes up where you can locate and 
select a gradient file. Once you click on Open, the light source is created with the 
gradient applied. 

 

Launch DAZ Studio 

Bryce includes DAZ Studio (DS) as a plug-in. DS is a complete virtual photo studio 
where you can create scenes by adding and positioning figures, clothing, props, 
materials, lights, and more. Once you create one or more objects in your DS scene, 
exiting DS automatically brings these objects into Bryce, where you can work with them 
just as you would any other Bryce object. With Bryce 6, you can also import animations 
from DS.  
To launch DS from within Bryce, click on the Launch DAZ Studio button located at the 
right side of the Create palette:  

 
Refer to "Working with DAZ Studio and Poser" for more on importing objects and 
animations from DS and Poser. 
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Edit Palette 

 
The Edit palette contains tools for editing object materials and resizing, rotating, 
repositioning, aligning, and randomizing objects.  

To display the Edit palette, click the  button at the top of the Bryce window.  
The transformation tools let you perform all the object transformation operations 
available in Bryce. The tools act as interactive controls. As you drag over the tool, the 
operation is performed on the selected object.  
To select a tool:  

1. Click the Edit button at the top of the Bryce window to display the Edit Palette.  
 

 
2. Select an object.  
3. Drag over the tool to perform a transformation operation or click on the edit tools. 

The Triangle icon next to the Edit button at the top of the Bryce window lets you access 
the Preset Materials Library.  
To open the Preset Materials Library, click quickly on the triangle icon next to the Edit 
button at the top of the Bryce window. Please note that if you hold down the mouse key 
for too long, the library will open, then close immediately. To keep the library open, click 
quickly on the triangle icon.  
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Edit Materials 

The Edit Materials tool brings up the Materials Lab by default when it is clicked on and 
no objects are selected. 

 
Clicking on the triangle next to the tool brings up a popup menu allowing you to select 
whether to edit 2D Pict or 3D Solid Textures.  

 
You do not have to have an object selected before using the Edit Materials tool. This is 
useful if you want to add 2D picts to the Picture Editor or just want to make new 
materials in the Materials Lab. If you do have an object selected before clicking on the 
tool, then the selected material or 2D pict editor will be opened.  
To use the Edit Materials tool:  

• Edit 3D Solid Textures:  
1. Take sure the Edit palette is visible. If it's not, click the Edit button at the 

top of the Bryce window.  
 

 
2. Click on the Edit Materials tool to open up the Materials Lab. 

 
OR  

3. Click on the triangle next to the Edit Materials tool and choose Edit 3D 
Solid Textures from the menu.  

• Edit 2D Pict Textures:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the 

top of the Bryce window.  
 

 
2. Click on the triangle next to the Edit Materials tool and choose Edit 2D Pict 

Textures from the menu. The Picture Editor will come up.  
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Resize Tool 

 
Use the Resize Tool to resize objects along one or all of the three axes. Objects are 
resized from their origin point.  

 
When you create an object, it appears at a default size. Once you place it in your scene, 
you may need to resize it to make it proportional to the other objects in your scene.  
The Resize Tool has seven different states. As you move the pointer over the tool each 
state becomes active. The different states let you resize the object along different axes.   

• Resizing along the Y-axis increases/decreases the object's height. 
 

 
• Resizing along the X-axis increases/decreases the object's width.  
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• Resizing along the Z -axis increases/decreases the object's depth.  
 

 
There are four ways of resizing objects in Bryce:  

1. using the Resize tool to resize an object along different axes  
2. using the 3D Transformation dialog which lets you enter precise values to resize 

objects  
3. using the control points on the object's bounding box to interactively resize the 

object   
4. using the Object Attributes dialog to numerically resize the object   

Objects are measured in Bryce Units. When you resize an object, you are increasing or 
decreasing its size based on unity size. When you resize an object to 150%, you're 
sizing it to 150% of unity.  
Clicking the triangle icon to the bottom right of the Resize tool brings up a popup menu 
with various options for manipulating objects.  

 

©2007 DAZ 3D, Inc.  144 



Bryce 6 Artist Guide 

Resize on the X-Axis  

To resize from the right-hand X-axis:  
1. Move the cursor over the right-hand X-axis on the Resize tool.  

 

 
2. Hold down the left mouse button and drag right - the object scales larger towards 

the right.  
 

 
3. Drag left and the object scales smaller towards the left.  
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To resize from the left-hand X-axis:  
1. Move the cursor over the left-hand X-axis on the Resize tool. 

 

 
2. Hold down the left mouse button and drag right - the object scales larger towards 

the left. 
 

 
3. Drag left and the object scales smaller towards the right.  
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To resize in both directions on the X-axis:  
1. Move the cursor over the left or right-hand X-axis on the Resize tool. 

 

 
2. Press Opt/Alt and drag right to scale the object larger on the X-axis or left to 

scale the object smaller on the X-axis.  
 

 
Hold down Shift to constrain the resize increments to 50% intervals when 
increasing/decreasing the size of the object.  

Resize on the Y-Axis  

To resize from the top on the Y-axis:  
1. Move the cursor over the top of the Y-axis on the Resize tool.  

 

 
2. Hold down the left mouse button and drag right - the object scales larger 

upwards. 

©2007 DAZ 3D, Inc.  147 



Bryce 6 Artist Guide 

 

 
3. Drag left and the object scales smaller towards the ground.  

 

 
To resize from the bottom on the Y-axis: 

1. Move the cursor over the bottom of the Y-axis on the Resize tool.  
 

 
2. Hold down the left mouse button and drag right - the object scales larger 

downwards.  
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3. Drag left and the object scales smaller going up.   

 

 
To resize in both directions on the Y-axis:  

1. Move the cursor over the top or bottom of the Y-axis on the Resize tool.  
 

 
2. Press Opt/Alt and drag right to scale the object larger on the Y-axis or left to 

scale the object smaller on the Y-axis.  
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Hold down Shift to constrain the resize increments to 50% intervals when 
increasing/decreasing the size of the object.  

Resize on the Z-Axis  

To resize from the front-side Z-axis:  
1. Move the cursor over the front of the Z-axis on the Resize tool.  

 

 
2. Drag right to scale object larger from the top 
3. Hold down the left mouse button and drag right - the object scales larger towards 

the front.   
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4. Drag left and the object scales smaller towards the back.   
 

 
To resize from the back-side Z-axis:  

1. Move the cursor over the back of the Z-axis on the Resize tool.  
 

 
2. Hold down the left mouse button and drag right - the object scales larger towards 

the back. 
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3. Drag left and the object scales smaller towards the front.  
 

 
To resize in both directions on the Z-axis:  

1. Move the cursor over the back or front of the Z-axis on the Resize tool.  
 

 
2. Press Opt/Alt and drag right to scale the object larger on the Z-axis or left to 

scale the object smaller on the Z-axis.  
 

 
Hold down Shift to constrain the resize increments to 50% intervals when 
increasing/decreasing the size of the object.  
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Resize in All Directions  

To resize an object in all directions:  
1. Click the center of the Resize tool.  

 

 
2. Hold down the left mouse button and drag right to increase the size of the object.  

 

 
3. Drag left to decrease the size of the object. 
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Spatial Options  

Objects can be resized using any of the three spatial definitions: World, Object, or 
Camera. The definition you choose depends on the effect you wish to create.  
To choose a spatial option for resizing:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
 

 
2. Click the triangle icon next to the Resize tool and choose an option from the 

menu.   
 

 
• Object Space resizes your selection relative to itself.  
• World Space resizes your selection in absolute world coordinates 

(default). 
• Camera Space resizes your selection relative to the camera.  

When you set Object, World, or Camera Space for the Resize tool, it is also the option 
set for the other two transformation tools. However, spatial options are global for the 
transformation tools only. The option you select in the Edit palette does not affect the 
3D Transformations dialog.  
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Undo Resize Operation (Unscale) 

To undo resize operations:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window.  
 

 
2. Select an object.  
3. Click the triangle icon next to the Resize tool and choose Unscale from the 

menu. This will reset the object back to its original size, no matter how many 
scaling operations have been made to the object.  
 

 

Flipping Objects  

Flipping is not the same as rotating an object 180°. Flipping mirrors an object along an 
axis instead of rotating it.  
This option is extremely useful for placing copies of objects that are exact opposites of 
each other, such as towers on the side of a building.  
To flip an object:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window.  
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2. Select an object or group of objects. If you want all the object to flip together, 
group them before flipping.  
 

 
3. Click the triangle icon next to the Resize tool and choose a flip option from the 

menu:  
 

 
• Flip X: inverts your object's dimensions along the X axis.  
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• Flip Y: inverts your object's dimensions along the Y axis. 
 

 
• Flip Z: inverts your object's dimensions along the Z axis.  

 

 

3D Transformations 

Sometimes you will need more precise control over the size of your object. The 3D 
Transformations dialog lets you enter specific resize values for a selected object. All 
transformations you enter in this dialog are performed in World Space regardless of the 
spatial option you chose for the Resize tool.  
Resize values are expressed as a percentage of the current size of the selected object.  
You cannot enter negative numbers in this dialog.  
Resizing numerically is especially useful when importing objects from other programs 
(i.e., DAZ Studio & Poser) that come in small. See "Working with DS & Poser" for more 
information 
To resize an object numerically: 

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
 

 
2. Select an object.  
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3. Click the triangle icon below the Resize tool and choose 3D Transformations 
from the menu. 
 

 
 
The 3D Transformations dialog appears.  
 

 
4. Enter a percentage in one or all of the axis fields. The percentage determines the 

new size of the object based on its original size. For example, to double the 
object's size in all directions, enter 200 in the X, Y, and Z fields. To resize along a 
single axis, enter values in only one axis field.  
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And here is the result of the above changes on a sphere:  

 
And the Object Attributes dialog showing that the X and Z-axis have doubled in size:   

 
Since you are dealing with World Space transformations in this dialog, if you resize an 
object along only one or two axes you may unintentionally skew the object's shape.  
To resize the object without skewing it, use the numeric entry fields in the Object 
Attributes dialog. Using this dialog can resize the object based on its original position, 
with no unintentional skewing. 
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Rotate Tool 

 
Use the Rotate tool to rotate objects in 3D space. Objects can be rotated in World 
Space, Object Space, or Camera Space.  

 
Most objects have a specific up, down, left, right, back, and front associated with them 
when you create them.  
When you place the object in a scene, its orientation may need to be altered to achieve 
a desired effect. For example, an airplane that's taking off should be tilted upwards or 
tilted downward when it is descending. The Rotate tool has three states. As you move 
the cursor over the tool, one of the states becomes active. The different states let you 
rotate the object around different axes. 

• Rotating along the Z-axis:  
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• Rotating along the Y-axis:  
 

 
• Rotating along the Z-axis:  

 

 
There are four ways of rotating objects in Bryce:  

1. using the Rotate tool to resize an object along different axes  
2. using the 3D Transformations dialog, which lets you enter precise rotation angles  
3. using the object's control points to interactively rotate the object  
4. using the Object Attributes dialog to numerically rotate the object  

Clicking the triangle icon to the bottom right of the Rotate tool brings up a popup menu 
with various options for manipulating objects.  
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Rotate on the X-Axis  

To rotate on the X-axis:  
1. Move the cursor over the X-axis on the Rotate tool.  

 

 
2. Hold down the left mouse button and drag right - the object rotates on the X-axis 

in the negative direction.  
 

 
3. Drag left and the object rotates on the X-axis in the positive direction.  

 

 
Hold down Shift to constrain the rotate increments to 45 degree intervals when rotating 
the object.  
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Rotate on the Y-Axis  

To rotate on the Y-axis:  
1. Move the cursor over the Y-axis on the Rotate tool.  

 

 
2. Hold down the left mouse button and drag right - the object rotates on the Y-axis 

in the positive direction. 
 

 
3. Drag left and the object rotates on the Y-axis in the negative direction. 

 

 
Hold down Shift to constrain the rotate increments to 45 degree intervals when rotating 
the object.  
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Rotate on the Z-Axis  

To rotate on the Z-axis:  
1. Move the cursor over the Z-axis on the Rotate tool.  

 

 
2. Hold down the left mouse button and drag right - the object rotates on the Z-axis 

in the negative direction. 
 

 
3. Drag left and the object rotates on the Z-axis in the positive direction. 

 

 
Hold down Shift to constrain the rotate increments to 45 degree intervals when rotating 
the object.  
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Spatial Options  

Objects can be rotated using any of the three spatial definitions: World, Object, or 
Camera. The definition you choose depends on the effect you wish to create.  
To choose a spatial option for rotation:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
 

 
2. Click the triangle icon next to the Rotate tool and choose an option from the 

menu: 
 

 
• Object Space: rotates your selection relative to itself. 
• World Space: rotates your selection in absolute world coordinates. 
• Camera Space: rotates your selection relative to the camera  

The three spatial options are also available for the Resize and Reposition tools. When 
you select Object, World, or Camera space for the Rotation tool, it is also set for the 
other two tools. The option you choose in the Edit palette does not affect the 3D 
Transformations dialog.  

Undo Rotate Operations  

To undo rotate operations:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window. 
 

 
2. Select an object.  
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3. Click the triangle icon next to the Rotate tool and choose Unrotate from the 
menu. This will reset the object back to its original rotation, no matter how many 
rotation operations have been made to the object.  
 

 

3D Transformations 

In a complex scene, orienting objects may require more precision than the Rotation tool 
offers. The 3D Transformations dialog lets you enter specific rotation angles for a 
selected object.  
All transformations performed using this dialog use World Space coordinates regardless 
of the spatial option you chose for the Rotate tool.   
Rotation values are expressed as degrees, with 360° being a single full rotation. Since 
rotations are relative, you may enter negative values and cumulative values (greater 
than 360° or less than -360°).  
To rotate an object numerically:   

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
 

 
2. Select an object.  
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3. Click the triangle icon next to the Rotate tool and choose 3D Transformations 
from the menu. 
 

 
 
The 3D Transformations dialog appears.  
 

 
4. Enter a degree value in one or more of the Rotate fields. The degrees determine 

the angle of rotation. For example, to rotate an object 45° around Y, enter 45 in 
the Rotate Y field. To rotate around other axes, just enter values in the 
appropriate fields.  
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And here is the result of the above changes on a cylinder:   
 

 
Since you're dealing with World Space transformations, objects are rotated with respect 
to the World Space X, Y, and Z axes.  

Reposition Tool 

 
Use the Reposition tool to reposition objects along any of three axes.  

 
The composition of your scene depends on the position of the objects relative to other 
objects. In most cases, you'll need to use the Reposition tool in conjunction with the 
Resize and Rotation tools to create the desired relationships.  

• Repositioning along the Y-axis moves the object up and down on the Y-axis.  
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• Repositioning along the X-axis moves the object along the X-axis.  
 

 
• Repositioning along the Z-axis moves the object along the Z-axis.  

 

 
Positioning applies to objects, groups, and families as well as lights and the camera. In 
this section the term "object" also refers to the camera and lights.  
There are four ways of positioning objects in Bryce:  

1. using the Reposition tool to move objects along a specific axis  
2. using the 3D Transformation dialog to enter specific offset positions  
3. by dragging the object to a different location  
4. by using the arrow keys to nudge objects.  

Clicking the triangle icon to the bottom right of the Reposition tool brings up a popup 
menu with various options for manipulating objects. 
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Repositioning on the X-Axis  

To reposition on the X-axis (World Space):  
1. Move the cursor over either end of the X-axis on the Reposition tool.  

 

 
2. Hold down the left mouse button and drag right - the object moves towards the 

right. 
 

 
3. Drag left and the object moves towards the left.  
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You can see the results of moving the object by clicking on the  button and bringing up 
the Object Attributes dialog.  

• Moving the object by dragging right on the X-axis increases the value in the X-
position field. 

• Moving the object by dragging left on the X-axis decreases the value in the X-
position field. 
 

 
Remember that if Object or Camera Space is active, the object will move relative to the 
object or camera. So if using Object Space and the object has been rotated, it will move 
in the direction of the object's X-axis. 
Hold down Shift to constrain the reposition increments to 10.24 BUs (one-half of a Unity 
Unit).  

Repositioning on the Y-Axis  

To reposition on the Y-axis (World Space):  
1. Move the cursor over either end of the Y-axis on the Reposition tool.  
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2. Hold down the left mouse button and drag right - the object moves up.   
 

 
3. Drag left and the object moves down.   

 

 
You can see the results of moving the object by clicking on the  button and bringing up 
the Object Attributes 
dialog. 

• Moving the object by dragging right on the Y-axis increases the value in the Y-
position field.   

• Moving the object by dragging left on the Y-axis decreases the value in the Y-
position field.   
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Remember that if Object or Camera Space is active, the object will move relative to the 
object or camera. So if using Object Space and the object has been rotated, it will move 
in the direction of the object's Y-axis.   
Hold down Shift to constrain the reposition increments to 10.24 BUs (one-half of a Unity 
Unit).  

Repositioning on the Z-Axis  

To reposition on the Z-axis (World Space):  
1. Move the cursor over either end of the Z-axis on the Reposition tool.  

 

 
2. Hold down the left mouse button and drag right - the object moves towards the 

back.  
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3. Drag left and the object moves towards the front.  

 

 
You can see the results of moving the object by clicking on the  button and bringing up 
the Object Attributes dialog.  

• Moving the object by dragging right on the Z-axis increases the value in the Z-
position field.   

• Moving the object by dragging left on the Z-axis decreases the value in the Z-
position field.  

Remember that if Object or Camera Space is active, the object will move relative to the 
object or camera. So if using Object Space and the object has been rotated, it will move 
in the direction of the object's Z-axis.   
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Hold down Shift to constrain the reposition increments to 10.24 BUs (one-half of a Unity 
Unit).  

Spatial Options  

Objects can be repositioned using any of the three spatial definitions: World, Object, or 
Camera. The definition you choose depends on the effect you wish to create.  
To choose a spatial option for repositioning:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window.  
 

 
2. Click the triangle icon next to the Reposition tool and choose an option from the 

menu: 
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• Object Space: rotates your selection relative to itself.  
• World Space: rotates your selection in absolute world coordinates.  
• Camera Space: rotates your selection relative to the camera.  

The three spatial options are also available for the Resize and Rotate tools. When you 
select Object, World, or Camera Space for the Rotation tool, it is also set for the other 
two tools. The option you choose in the Edit palette does not affect the 3D 
Transformations dialog.  

Undo Reposition Operations  

To undo position operations:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window.  
 

 
2. Click the triangle icon next to the Reposition tool and choose Unreposition from 

the menu. This will reset the object back to its original position, no matter how 
many repositioning operations have been made to the object.  
 

 

3D Transformations  

The most precise method of positioning objects is by using the 3D Transformations 
dialog. This dialog lets you enter specific offset values for a selected object. 
All transformations performed using this dialog use World Space coordinates regardless 
of the spatial option you chose for the Reposition tool. 
Offset values are expressed in Bryce units of measure. You may enter negative 
numbers in the Reposition fields.  
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To reposition an object numerically:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window. 
 

 
2. Select an object. 
3. Click the triangle icon next to the Reposition tool and choose 3D Transformations 

from the menu.  
 

 
 
The 3D Transformations dialog appears.  
 

 
4. Enter a value in one or all of the Offset fields. The value determines the number 

of Bryce units the object is offset from its current position.  
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And here is the result of the above changes on a cube:   

 
And the Object Attributes dialog showing the changes: 
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Remember that since this dialog only performs transformations in World Space, you are 
moving the object relative to world X, Y, and Z coordinates.  

Align Tool 

 
Use the Align tool to align objects along their tops, bottoms, left sides, right sides, fronts, 
backs, or centers.  

 
Bryce's alignment features let you position several objects with respect to each other. 
Alignment transformations are performed with respect to the Grid. Bryce maintains an 
internal grid that is comprised of 3D cube increments, 20.48 x 20.48 x 20.48 Bryce units 
in size.  
The Align tool has ten states. As you move the pointer over the tool, the states become 
active.  
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The Grid is used for Snap To operations and acts as common reference for alignment 
operations. One grid unit is equal to unity size and unity position is always snapped to a 
position on the grid.  
Clicking the arrow icon to the bottom right of the Align tool brings up a popup menu with 
various options for aligning objects.  

 

Align X  

To align objects along the X-axis:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window.  
 

 
2. Select two or more objects.  

 

 
3. Move the cursor over the Align tool.  
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4. When the state you want to use is active, click the mouse button.  
 

 
The default alignment is "non-anchor based" which means that the tool aligns objects 
based on the bounding box of the selected objects.  
Examples:  

• Align X Left:  
 

 
• Align X Center:  
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• Align X Right:  
 

 
To align objects to a specific object, use Anchor-Based Alignment which aligns the 
selected objects to the first selected object.  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window.  
 

 
2. Click the arrow icon to the bottom right of the Align tool and choose Anchor-

Based Aligning from the menu.  
 

 
3. Select the object you want to use as the align anchor.  
4. Select the remaining objects to align.  
5. Move the cursor over the Align tool.  
6. When the state you want to use is active, click the mouse button.  
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The example below shows the selected objects aligned to the X Left edge of the sphere, 
which was selected first.  

 

Align Y  

To align objects along the Y-axis:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window.  
 

 
2. Select two or more objects. Move the cursor over the Align tool.  

 

 
3. When the state you want to use is active, click the mouse button.  
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The default alignment is "non-anchor based" which means that the tool aligns objects 
based on the bounding box of the selected objects. Examples:  

• Align Y Top:  
 

 
• Align Y Center:  
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• Align Y Bottom:  
 

 
To align objects to a specific object, use Anchor-Based Alignment which aligns the 
selected objects to the first selected object.  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window.  
 

 
2. Click the arrow icon to the bottom right of the Align tool and choose Anchor-

Based Aligning from the menu.  
 

 
3. Select the object you want to use as the align anchor.  
4. Select the remaining objects to align.  
5. Move the cursor over the Align tool.  
6. When the state you want to use is active, click the mouse button.  
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The example below shows the selected objects aligned to the Y Top edge of the 
sphere, which was selected first.  

 

Align Z  

To align objects along the Z-axis:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window.  
 

 
2. Select two or more objects.   

 

 
3. Move the cursor over the Align tool.  
4. When the state you want to use is active, click the mouse button.   
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The default alignment is "non-anchor based" which means that the tool aligns objects 
based on the bounding box of the selected objects. Examples:  

• Align Z Back:   
 

 
• Align Z Center:   
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• Align Z Front:   
 

 
To align objects to a specific object, use Anchor-Based Alignment which aligns the 
selected objects to the first selected object.  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window.  
 

 
2. Click the arrow icon to the bottom right of the Align tool and choose Anchor-

Based Aligning from the menu.  
 

 
3. Select the object you want to use as the align anchor.   
4. Select the remaining objects to align.  
5. Move the cursor over the Align tool.  
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When the state you want to use is active, click the mouse button.  The example below 
shows the selected objects aligned to the Z Back edge of the sphere, which was 
selected first.  

 

Align All  

To align objects to the center of the objects:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window.  
 

 
2. Select two or more objects. 

 

 
3. Move the cursor over the Align tool.  
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4. When the state you want to use is active, click the mouse button. 
 

 
The default alignment is "non-anchor based" which means that the tool aligns objects 
based on the bounding box of the selected objects. Example: Align All Center:   

 
To align objects to a specific object, use Anchor-Based Alignment which aligns the 
selected objects to the first selected object.  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window.  
 

 
2. Click the arrow icon to the bottom right of the Align tool and choose Anchor-

Based Aligning from the menu.  
 

 
3. Select the object you want to use as the align anchor.   
4. Select the remaining objects to align.  

©2007 DAZ 3D, Inc.  190 



Bryce 6 Artist Guide 

5. Move the cursor over the Align tool.  
6. When the state you want to use is active, click the mouse button.  The example 

below shows the selected objects aligned to the center of the pyramid, which was 
selected first.  
 

 

Snap To Options 

The Snap To Options let you automatically align objects to the grid, an anchor object, 
World Center, ground level, or to land on an object.  

 

Snap to Grid  

The Grid can be used as a guide to help you precisely position objects in your scene. 
To snap objects to the Grid:  

1. Make sure the Edit palette is visible. If it’s not, click the Edit button at the top of 
the Bryce window.  
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2. Select an object or multiple objects. 
 

 
3. Click the triangle icon next to the Align tool and choose Snap to Grid. 

 

 
 
The center of the object (or objects) will align to the nearest point on the grid.  
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Please note that the Align to Grid option does not place the objects on the 
ground. 
 

 

Snap Together  

To snap objects together:  
1. Make sure the Edit palette is visible. If it’s not, click the Edit button at the top of 

the Bryce window.  
 

 
2. Select the object you want to use as the anchor object.   
3. Select the remaining objects to align.  
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4. Click the triangle icon next to the Align tool and choose Snap Together.  
 

 
 
The X, Y, and Z centers of all selected objects are aligned to the X, Y, and Z 
center of the anchor object (in this case, the pyramid). 
 

 

Snap to World Center  

To snap an object to World Center:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window. 
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2. Select an object or multiple objects.  
 

 
3. Click the triangle icon next to the Align tool and choose Snap to World Center. 

 

 
 
The selected object(s) moves to coordinates X=0, Y=0, Z=0, or World Center. 
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4. If needed, click the triangle icon next to the Align tool and choose Snap to 
Ground to bring the object(s) back to ground level.  

Snap to Ground  

To drop or lift objects to ground level:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window. 
 

 
2. Select an object or multiple objects.   

 

 
3. Click the triangle icon next to the Align tool and choose Snap to Ground.  
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The selected object (or objects) will move up or down as necessary to place the 
object on the ground even if that puts the object inside another object. 
 

 

Snap to Land  

The Snap to Land option lets you snap an object to any object directly below it, much 
like creating a gravity effect.  
When you activate the Snap to Land option, Bryce snaps the selected object to the top 
of any object directly below its center Y control handle. The second object must be 
directly below the Y-control handle, otherwise the object lands on the ground plane (see 
left example).  

  
In the right hand example, a corner of the selected object is over the "land" object, but 
since there are no objects directly under its Y control handle, the selected object lands 
on the ground.  
Landing operations work best with objects that have not been rotated and that have no 
sloped characteristics.  
This option can create many interesting effects. For example, you can quickly create 
falling rock animations by placing rock objects throughout your scene with a terrain 
below them in one frame. Then, in a different frame, select all the rocks and choose the 
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Snap to Land option. When you run the animation, all the rocks will appear to fall onto 
the terrain.  
Another use of Snap to Land is when attempting to place trees on a terrain. Place the 
tree over the terrain then choose the Snap to Land option. The tree will drop to the 
terrain and you can then use the Reposition tool or Object Attributes dialog to lower the 
tree slightly to place the roots into the terrain.  
To snap an object to the top surface of an object below it:  

1. Make sure the Edit palette is visible. If it's not, click the Edit text button at the top 
of the Working window.  
 

 
2. Select an object that is above another object or above the ground plane. 

 

 
3. Either click the triangle icon next to the Align tool and choose Snap to Land from 

the menu or click the Down arrow icon that appears next to the object's bounding 
box.  
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The object will land on top of the object below it. 
 

 

Anchor & Non-Anchor-Based Aligning  

Bryce provides two options for aligning multiple objects: anchor-based aligning and non-
anchor-based aligning. 
Anchor-based aligning considers the first selected object to be the anchor of the 
aligning operation. All other objects are aligned to this object.  
With non-anchor-based aligning, objects are aligned to the bounding box of all the 
selected objects. 
To choose an aligning option:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window.  
 

 
2. Click the triangle icon next to the Align tool, and enable/disable Anchor-Based 

Aligning.  
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See the following for examples of using Anchor-Based Aligning:  
• Align X 
• Align Y 
• Align Z 
• Align All 

Randomize Tool 

Use the Randomize tool to scatter or disperse objects in 2D or 3D space.  

 
The Randomize tool is a great way of randomly dispersing objects throughout your 
scene without having to manually position each object. As you click the Randomize tool 
each of its states becomes active.  
Clicking the arrow icon to the bottom right of the Randomize tool brings up a pop-up 
menu with the options for randomizing objects.  
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2D Disperse  

Use 2D Disperse to disperse objects in 2D space.  

 
To disperse objects in 2D space:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
 

 
2. Select a number of objects.  

 

 
3. Either click the Randomize tool repeatedly until the mode you want to use is 

active or click the triangle icon next to the Randomize tool and choose the 2D 
Disperse mode from the menu.  
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4. Click and drag over the Randomize Amount sphere. The Randomize Amount 
sphere is the green sphere to the top-right of the Randomize tool.  
 

 
 
The objects will be dispersed along the 2D plane:   
 

 

2D Disperse Rotate  

Use 2D Disperse Rotate to disperse and rotate objects in 2D space.  

 
To disperse and rotate objects in 2D space:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
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2. Select a number of objects.  
 

 
3. Either click the Randomize tool repeatedly until the mode you want to use is 

active or click the triangle icon next to the Randomize tool and choose 2D 
Disperse Rotate mode from the menu. 
 

 
4. Click and drag over the Randomize Amount sphere. The Randomize Amount 

sphere is the green sphere to the top-right of the Randomize tool.  
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The objects will be dispersed and rotated along the 2D plane: 
 

 

2D Disperse Size  

Use 2D Disperse Size to disperse and resize objects in 2D space.  

 
To disperse and resize objects in 2D space: 

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
 

 
2. Select a number of objects.  
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3. Either click the Randomize tool repeatedly until the mode you want to use is 
active or click the triangle icon next to the Randomize tool and choose 2D 
Disperse Size mode from the menu.  
 

 
4. Click and drag over the Randomize Amount sphere. The Randomize Amount 

sphere is the green sphere to the top-right of the Randomize tool.  
 

 
 
The objects will be dispersed and resized along the 2D plane: 
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2D Disperse Size/Rotate  

Use 2D Disperse Size/Rotate to disperse, resize, and rotate objects in 2D space.  

 
To disperse, resize, and rotate objects in 2D space:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window.   
 

 
2. Select a number of objects.  

 

 
3. Either click the Randomize tool repeatedly until the mode you want to use is 

active or click the triangle icon next to the Randomize tool and choose 2D 
Disperse Size/Rotate mode from the menu.  
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4. Click and drag over the Randomize Amount sphere. The Randomize Amount 
sphere is the green sphere to the top-right of the Randomize tool.  
 

 
 
The objects will be dispersed, resized, and rotated along the 2D plane:  
 

 

3D Disperse  

Use 3D Disperse to disperse objects in 3D space.  

 
To disperse objects in 3D space:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
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2. Select a number of objects.  
 

 
3. Either click the Randomize tool repeatedly until the mode you want to use is 

active or click the triangle icon next to the Randomize tool and choose 3D 
Disperse mode from the menu. 
 

 
4. Click and drag over the Randomize Amount sphere. The Randomize Amount 

sphere is the green sphere to the top-right of the Randomize tool.  
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The objects will be dispersed along the 3D planes: 
 

 

3D Disperse Rotate  

Use 3D Disperse Rotate to disperse and rotate objects in 3D space.  

 
To disperse and rotate objects in 3D space:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
 

 
2. Select a number of objects.  
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3. Either click the Randomize tool repeatedly until the mode you want to use is 
active or click the triangle icon next to the Randomize tool and choose 3D 
Disperse Rotate mode from the menu.  
 

 
4. Click and drag over the Randomize Amount sphere. The Randomize Amount 

sphere is the green sphere to the top-right of the Randomize tool.  
 

 
 
The objects will be dispersed and rotated along the 3D planes:  
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3D Disperse Size  

Use 3D Disperse Size to disperse and resize objects in 3D space.  

 
To disperse and resize objects in 3D space:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
 

 
2. Select a number of objects. 

 

 
3. Either click the Randomize tool repeatedly until the mode you want to use is 

active or click the triangle icon next to the Randomize tool and choose 3D 
Disperse Size mode from the menu.  
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4. Click and drag over the Randomize Amount sphere. The Randomize Amount 
sphere is the green sphere to the top-right of the Randomize tool.  
 

 
 
The objects will be dispersed and resized along the 3D planes: 
 

 

3D Disperse Size/Rotate  

Use the 3D Disperse Size/Rotate to disperse, resize, and rotate objects in 3D space.  

 
To disperse, resize, and rotate objects in 3D space:  

1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 
the Bryce window. 
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2. Select a number of objects.  
 

 
3. Either click the Randomize tool repeatedly until the mode you want to use is 

active or click the triangle icon next to the Randomize tool and choose 3D 
Disperse Size/Rotate mode from the menu. 
 

 
4. Click and drag over the Randomize Amount sphere. The Randomize Amount 

sphere is the green sphere to the top-right of the Randomize tool.  
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The objects will be dispersed, resized, and rotated along the 3D planes:  
 

 

Edit Terrain/Object  

 
The Edit Terrain/Object tool brings up the appropriate lab or editor depending on what 
object is selected. Unlike the Edit Materials tool, you must have an object selected in 
order to use this tool.  
To use the Edit Terrain/Object tool, select an object and click on the Edit Terrain/Object 
tool.  

• Terrain or SymLat - opens the Terrain Editor  
• Tree - opens the Tree Lab  
• Rock - opens the Edit Mesh dialog  
• Imported Mesh Object - opens the Edit Mesh dialog  
• Torus - opens the Edit Torus dialog 
• Any Light - opens the Light Lab 
• Any other object - nothing happens  

Convert Selection To  

The Convert Selection To tool in the Edit palette lets you convert any type of object into 
another type of object with a single click. You can change a square into a light, a terrain 
into a sphere, or an infinite plane into a cone. Any transformations or materials you 
applied to the original object are preserved through the conversion. Just remember that 
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if the original object is larger or smaller than the default size of the object it is being 
converted to, then the converted object will reflect the size change.  
Conversions cannot be animated. You can't have a box that turns into a cone over time.  
The Convert tool is above and to the right of the Edit Terrain/Object tool and looks like a 
double-headed arrow:  

 
To convert an object to another type of object:  

1. Select the object you want to convert.   
2. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window. 
 

' 
3. Left-click-hold on the double-headed arrow in the top left corner of the palette 

and choose an object type from the palette that appears.  
 

 
4. The selected object will be converted to the chosen object.  The image below 

shows a rotated cube that has been converted to a cylinder:  
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The image below shows a cube converted to a torus (left) and a 2D square converted to 
a pyramid (right). Since the cube Z-size is longer than the default torus Z-size, the 
converted torus is stretched to match the original cube size. The same with the pyramid 
which is squashed on the Z-axis to match the Z-axis of the 2D square.  

 

Sky & Fog Palette 

 
The controls available on the Sky & Fog Palette let you add shadows, fog, and haze, 
and let you set the altitude, frequency, and amplitude of clouds. The Sky & Fog Palette 
also lets you control the color of clouds in your sky and the position of the sun and 
moon.  
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A Bryce sky defines the virtual environment of your scene. Unlike many other 3D 
applications, the Bryce virtual environment is not merely a backdrop; it is an infinite 3D 
representation of natural environmental phenomena.  
All of the elements in your sky interact with each other just as they would in the real 
world. Colors in your environment interact with everything in your scene just as they 
would in nature. For example, red sunlight is invisible until it strikes an object; then the 
object exhibits red highlights. If it's a blue object, it takes on a purple cast and so on.  
The colors in the sky change depending on the position of the sun, and how much 
moisture (Haze, Fog) is present in the atmosphere. All this, plus natural reflection, 
refraction, and more make the Bryce Sky & Fog Palette responsible for a great deal of 
the natural, or supernatural, look and feel of Bryce images.  
The objects in your scene may look incredibly realistic on their own, but when you add a 
sky, the scene becomes a window looking out into a real world. You can add even more 
realism to a sky by enabling one of the many environmental effects available for skies. 
Using these effects you can create night skies full of stars, or have a bright rainbow 
streaking across the roof of your world. One of the most spectacular effects is the 
Volumetric World effect. When this effect is enabled all the light in your scene appears 
as visible rays. This is similar to the effects of light shining through clouds on a hazy 
day.  
Like any other scene setting, skies can be animated. Any property of a sky can be 
changed at different points along the animation timeline. When the animation plays, the 
sky property will appear to change over time. Using this technique, you can create a 
scene that changes from day to night, or from clear to cloudy.  
The Sky & Fog Palette is where you'll set up the attributes of your environment. The 
palette uses visual controls in the form of thumbnails to help you see how changing the 
value of an attribute affects your sky.  
The name of the control you're adjusting appears in the Text Display area of the Control 
Palette. You can also use this area to help guide you if you prefer numeric precision, as 
when you are adjusting the setting of a control; this area displays the current control's 
value.  

 
Each control has at least one color swatch along the bottom of the thumbnail. These 
swatches are used to set the color for a given sky attribute, like cloud color or fog color. 
Next to the thumbnails are a series of controls that let you set the frequency and 
amplitude of clouds, set the position of the sun or moon, and store sky properties. You 
can see their effects in the Preview Area.  
The Triangle icon next to the Sky & Fog button at the top of the Bryce window lets you 
access the Preset Skies Library.  
To open the Preset Skies Library, click quickly on the triangle icon next to the Sky & Fog 
button at the top of the Bryce window. Please note that if you hold down the mouse key 
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for too long, the library will open, then close immediately. To keep the library open, click 
quickly on the triangle icon.  

 

Using the Control Thumbnails  

The thumbnails in the Sky & Fog Palette are visual guides and are also used to set the 
attributes of the Sky & Fog effects.  
To change the intensity of an effect, drag to the left or right, up or down, inside the 
thumbnail to change the intensity of the effect.  

 
To pick a color for an effect, click the color bar below the thumbnail. A color picker 
appears and your pointer changes to an eyedropper.  

 
While the eyedropper is active, you can select colors from anywhere in your scene, or 
even different parts of the interface.  

 
For more control after picking with the color picker, you can switch to HLS mode and 
adjust saturation or lightness (less saturated colors can make for more realistic fog and 
haze effects), or you can enter numeric values if you need to precisely match specific 
colors.  
For more on the different color pickers for both PC and Mac, refer to "Adjusting Editor 
Settings."  
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Setting Palette Options 

The Sky & Fog Palette options let you link the palette controls directly to your scene.  

 

Auto Update  

To link Sky & Fog attributes directly to your scene, click the triangle icon below the 
memory dots at the right edge of the palette and choose Auto Update from the menu.  

 
When this option is enabled, every change you make to the Sky & Fog Palette settings 
will start a render of your scene with the new sky settings.  
Unless you have selected a small region to be updated, every change you make will 
begin a completely new render.  
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Link Sun to View  

To link Sky & Fog attributes directly to your scene, click the triangle icon below the 
memory dots at the right edge of the palette and choose Link Sun to View from the 
menu.  

 

Select Cloud Types  

To select what cloud types to place in the scene or to choose spherical clouds, see the 
following pages for more information: 

• Adding Cumulus Clouds 
• Adding Stratus Clouds 
• Spherical Clouds 
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Reset Sky  

To reset Sky & Fog Palette settings to their defaults, click the triangle icon below the 
memory dots at the right edge of the palette and choose Reset Sky from the menu.  

 

Access Sky Lab  

To access the Sky Lab, either click on the Sky Lab button or click the triangle icon 
below the memory dots at the right edge of the palette and choose Sky Lab from the 
menu.  

 

©2007 DAZ 3D, Inc.  221 



Bryce 6 Artist Guide 

Saving Sky & Fog Settings  

The Memory Dots in the Sky & Fog Palette let you store your favorite Sky & Fog 
settings. Using these dots you can safely explore many Sky & Fog configurations 
without losing your favorite settings along the way.  
The Memory Dots appear along the right side of the palette.  

 
The Memory Dots in the Sky & Fog Palette mirror those inside the Sky Lab.  

 
To save Sky & Fog settings in the Sky & Fog Palette, click on an empty dot (empty dots 
are gray). All the current Sky & Fog Palette and Sky Lab settings (except for IBL 
settings) are stored in the selected dot.  

 
The dots let you store up to seven different sky settings.   

 
The uppermost dot, slightly separated from the rest, is a quick way to return to the 
default Bryce sky.  
There is no way to clear this dot. It will always contain the default Sky settings.  
Memory Dots are saved with the scene, but not between sessions, so you may want to 
save your favorite skies as presets before ending a Bryce session.  
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When you click on a full dot to activate it, the saved setting becomes the current Sky. 
When you no longer need a saved sky setting, you can delete it by clearing the dot it is 
saved to.  

• To save a sky setting to a Memory Dots, click an empty dot.  
• Empty dots appear gray -  
• Full dots appear green (blue in Bryce 5/5.5, teal in Bryce 3/4) -  

• To return to the default sky, click the top Memory Dot. The sky returns to the 
default, regardless of how many changes you've made.  

• To switch between saved skies, click a full (green) dot. 
 
Active dots appear green with a white dot in the middle -  

• To clear a full dot, Opt/Alt+click a full dot. The dot turns gray and a new sky 
setting can be saved to it.  

Please note that if you select a saved sky, then use the Sky Presets Library to change 
the sky, the Memory Dot you clicked to load the previous sky will still be active even 
though a different sky has been loaded.  

Randomizing Sky Settings 

Randomizing skies is a very powerful way of exploring possibilities you may never find 
any other way. When you randomize the sky all the settings in the palettes are replaced 
by randomly generated values.  
To randomize your sky, click on the Randomize Sky button.  

 
When you click on the button, it will turn red to show it is being activated.  

 
Each time you click on the Randomize Sky button, a random sky is generated and 
applied to the scene.   
Remember, you can always return to the default settings by clicking on the top Memory 
Dot or choosing Reset Sky from the Sky & Fog Options menu.  
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Working with Sky Modes 

The Sky Modes act as the base of your sky. The Sky Modes control lets you set the 
base colors and light tones for your environment. There are four modes available: Soft 
Sky, Dark Sky, Custom Sky, and Atmosphere Off. As you switch between the modes, 
the thumbnail also changes to give you a preview of what the mode looks like.  
To select a Sky Modes, either:   

• Click the Sky Modes thumbnail to cycle through the four modes,   
• Drag left or right inside the thumbnail to cycle through the modes, or  
• Click the triangle icon next to the thumbnail and choose a mode from the menu.  

 

Soft Sky  

Soft Sky is the default state of the sky. It features softer shades of blue and lighter tones 
To set the sky to soft, click the triangle icon next to the Sky Mode thumbnail and choose 
Soft Sky from the menu.  

 
The thumbnail changes to the Soft Sky control.  
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Darker Sky  

Darker Sky is a darker version of Soft Sky. It uses darker shades of color and tones. 
This mode is good for creating more brooding skies.  
To set the sky darker, click the triangle icon next to the Sky Mode thumbnail and choose 
Darker Sky from the menu.  

 
The thumbnail changes to the Darker Sky control.  

 

Custom Sky  

Custom Sky lets you choose your own colors for the sky; this way you can create some 
truly alien environments. When this mode is selected, the standard behavior of colors in 
the sky with respect to sun position is disabled.  
To set custom sky colors: 

1. Click the triangle icon next to the Sky Mode thumbnail and choose Custom Sky 
from the menu. 
 

 
 
The thumbnail changes to the Custom Sky control.  
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2. Click the Sky Color swatch and choose a color from the color picker. The Sky 
Color is the main sky color in this mode, regardless of sun position. 
 

 
3. Click the Sun Glow Color swatch and choose a color from the color picker. This 

is the color of the halo around the sun.  
4. Click the Horizon Color swatch and choose a color from the color picker.  

This color will, in certain cases, affect your scene below ground level if you have a haze 
setting of greater than zero. It will also impact the color of Stratus clouds near the 
horizon.   
In most cases, this will be the least obviously used color in your scene; unless you are 
making outer space scenes, in which case this could be very useful for you. 

Sky Mode Comparison  

Comparison images between Sky Modes, using the "Standard Daylight" sky setting: 
• Soft Sky:  
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• Darker Sky: 
 

 
• Custom Sky:  

 

 

Atmosphere Off  

Atmosphere Off disables the standard sky color behaviors, relative to sun position, and 
uses a single color for the sky. This mode is useful when you need to render objects 
against a simple colored (or black or white) background. The Sun color still affects 
objects in this mode. If you have red sunlight, for instance, objects in your scene will 
reflect red light.  
To render objects against a plain background:  

1. Click the triangle icon next to the Sky Mode thumbnail and choose Atmosphere 
Off from the menu. 
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The thumbnail changes to the Atmosphere Off control.  
 

 
2. Click the Atmosphere swatch and choose a color from the color picker.  

 

 
3. Drag left inside the Haze control and set the value to 0. This setting eliminates 

the suggestion of a horizon. 
 

 
 
And the result as seen in the Nano Preview:  
 

 

Setting Sky Attributes 

Once you've selected a Sky mode, you have the basis for your virtual environment. All 
the other atmosphere effects you add later will interact with the base mode.   
There are two other attributes that affect how all the other effects will appear:  

• Shadows  
 
and  

• Ambient Color. 

Shadows  
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All the objects in your scene cast shadows. Using the Shadow control you can set the 
intensity and color of all the shadows in your scene.  
As you change the value of the Shadow control, the brightness of shadows changes. In 
the images below, the shadow on the left is set to 25%, the one on the right to 90%.  

 
The Shadow control is not the only control for shadows. The position of shadows is 
dependent on the position of the sun. Since the sky interacts directly with objects in the 
scene, the color of the sun also affects the color of shadows.  
The object's material properties also affect the color of shadows. Semi-transparent or 
transparent objects with a transparency color will change the color of the object's 
shadow. In addition, volume materials can dramatically change the shape and color of 
shadows. Use the Shadows control to set the color and intensity of shadows in your 
scene.  
By default, the clouds in Bryce do not cast shadows. If you want the cloud layer to cast 
shadows on the ground below, enable the Cloud Shadows option.  
To set shadow intensity:  

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window. 
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2. Drag left or right inside the Shadow control thumbnail. Dragging left decreases 
the intensity and dragging right increases it. The cursor changes to a two headed 
arrow as you drag over the control.  
 

 
 
Keep an eye on the Text Display Area as you drag in the Shadow Control 
thumbnail. The numbers will change as you drag back and forth on the 
thumbnail.  
 

 
You can also set the Shadow strength on the Sun & Moon tab in the Sky Lab. 

 

Ambient Color  

 
The Ambient Color is the color of all the light that surrounds the objects in your scene. 
Light from the sun interacts with ambient color to produce the color for both highlights 
and shadows.  
Ambient Color is used as the source color for material Ambience. The Ambient Color 
tints the surfaces of all objects in your scene that have some level of ambience. Any 
other color you apply to the object's surface is mixed with the Ambient Color to create 
the final surface color. For example, if the Ambient Color is red, any color you assign to 
an object's surface ambience is mixed with red.  
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To set Ambient Color, click the color swatch below the Shadow control thumbnail and 
choose a color from the color picker. 

 
For realistic effects, at noon, or in the afternoon, Ambient Color should be a little blue to 
get nice blue-ish shadows. At dawn, you can set Ambient Color to red or pink, and at 
night you can set it to gray-blue.   

 
You can also set the ambient color by using the Ambient Color Swatch in the Sky Lab.  
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Adding Fog & Haze 

Fog and Haze are two atmospheric effects that can add realistic depth to your scene. 
Fog can make objects appear to disappear the farther they get from the camera. Haze 
can add the illusion of a distant horizon.  
The Fog and Haze controls in the Sky & Fog palette let you control the color and 
intensity of these effects.  

 
  

Fog 

 
Fog can add an element of sensuality, mystery, and realism to your scenes. It acts like 
a thin layer of cloud close to the ground.  
Using Fog you can create the illusion of depth without having to add distant objects. Fog 
can create a sense of depth in your scene.  

Fog Density  

To set the density/amount of Fog:  
1. Display the Sky & Fog palette by clicking the Sky & Fog text button.  
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2. Drag horizontally inside the Fog thumbnail to increase or decrease the density of 
the fog in your rendered scene. Drag to the left to decrease the density of the fog 
and to the right to increase it.   
 

 
 
The density value is displayed in the Text Display Area of the Control Palette as 
you drag.  
 

 
You can also set the fog density on the Atmosphere tab in the Sky Lab.  

 
Examples: 

• Fog Density = 3; Fog Thickness = 56  
 

 
• Fog Density = 75; Fog Thickness = 56  
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Fog Thickness  

To set Fog thickness/height:  
1. Display the Sky & Fog palette by clicking the Sky & Fog text button.  

 
 

2. Drag vertically inside the Fog control to increase or decrease the height of your 
fog. Drag up to increase the height and down to decrease it. 
 

 
 
The thickness value is displayed in the Text Display Area of the Control Palette 
as you drag.  
 

 
You can also set the fog thickness on the Atmosphere tab in the Sky Lab.  
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Examples:  
• Fog Density = 5; Fog Thickness = 56  

 

 
• Fog Density = 5; Fog Thickness = 100  

 

 

Fog Color  

To set Fog Color:  
1. Display the Sky & Fog palette by clicking the Sky & Fog text button.  

 
 

2. Click the color swatch beneath the Fog thumbnail and choose a color from the 
color picker.  
 

 
Fog color can also be set on the Atmosphere tab in the Sky Lab.  
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Examples:  
• Fog Color = White  

 

 
• Fog Color = Salmon  

 

 

Haze 

 
Haze is the natural effect you see when a plane (like the ocean) stretches out towards 
the horizon. At this distant point a different color appears over the horizon and light 
becomes fuzzy. Haze creates the illusion of a distant horizon.  
The Haze control lets you set the intensity and color of the Haze effect in your Bryce 
scene.  
With haze set to zero, your horizon will have an unnaturally hard edge. Also note that 
the Cloud Altitude control will affect the height of this band of haze. The higher the 
altitude of the atmosphere, the wider the band of haze at the horizon.  
Haze is applied to the entire scene equally and always appears at the horizon.  
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Haze Density  

To set Haze density/intensity:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
 

 
2. Drag horizontally inside the Haze thumbnail to increase or decrease the degree 

of haze in your scene.  Drag to the left to decrease the density of the haze and to 
the right to increase it.  
 

 
 
The density value is displayed in the Text Display Area of the Control Palette as 
you drag.  
 

 
You can also set the haze density on the Atmosphere tab in the Sky Lab.  

 
Examples:  

• Haze Density = 8  
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• Haze Density = 85  
 

 

Haze Color  

To set Haze color:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
 

 
2. Click the color swatch beneath the Haze thumbnail and choose a color from the 

color picker. 
 

 
 
Fog and Haze colors should be the same, or almost the same. For realism, the 
haze should be a little brighter and bluer than the fog. At nighttime, you have less 
illumination, so an effective nocturnal haze color could be dark blue-gray.  

Haze color can also be set on the Atmosphere tab in the Sky Lab.  
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Examples: 
• Haze color = White   

 

 
• Haze color = Lavender  

 

 

Clouds in Bryce 

There are two kinds of clouds in Bryce: clouds in the environment and cloud planes. 
Clouds you add to your sky interact with the light in your scene. They can block out the 
light of the sun and change the color of the light that hits the objects in the scene. These 
clouds are infinitely distant so you cannot fly through the clouds in the sky. If you want 
to have this effect, use a cloud plane. Sky clouds can also cast shadows on the ground 
below.  
The clouds in this scene were created using Cumulus clouds from the Sky & Fog 
palette.  

 
You can change the look of the clouds by editing the texture used to create them. By 
changing the texture you can alter the shape and position of the clouds within the sky. 
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Cloud planes are infinite planes that act as objects in your scene. They cast shadows 
and can interact with other objects. An infinite cloud plane was used to create the mist 
above the water in this scene.  

 
Both types of clouds can be animated. The clouds in the sky can be animated by 
changing their color, position or frequency, and cloud planes can be animated just like 
other objects. They can also be animated using the Cloud Motion controls. These 
controls let you set parameters for automatically animating clouds. Refer to "Animating 
Skies" for more on animating clouds.  

Adding Clouds  

The Sky & Fog Palette provides several controls that set the attributes of clouds in your 
sky. The Cloud Coverage, Cloud Altitude, and Cloud Frequency and Amplitude controls 
let you set the general appearance of your clouds. The Cloud Color sets the color of the 
clouds.  
You can add clouds to your scene in five easy steps:  

1. Select the type of cloud  
2. Adjust the cloud texture  
3. Set the cloud coverage and color   
4. Set cloud height  
5. Set the frequency and amplitude of clouds  

Cloud Types 

There are two types of clouds you can add to your Bryce environment: Cumulus and 
Stratus.  
Cumulus clouds are generally found at lower altitudes and appear thicker and fluffier.  
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The sky in this scene uses Cumulus clouds.  

 
Stratus clouds appear at higher altitudes and appear thinner and more wispy. The sky in 
this scene uses Stratus clouds.  

 

Adding Cumulus Clouds  

To add Cumulus clouds to a sky:  
1. If it's not already visible, display the Sky & Fog palette by clicking the Sky & Fog 

button at the top of the Bryce window.  
 

 
2. Click the triangle in the corner of the palette and choose Cumulus Clouds.  

 

 
Cumulus clouds are thicker, darker clouds at a lower altitude. These clouds will take on 
tints of Sunlight color, Ambient color, or Cumulus color. You can also choose both cloud 
types, or neither. Selecting neither cloud type creates a clear sky.  
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Cumulus Clouds can also be enabled in the Sky Lab on the Cloud Cover tab:  

 

Adding Stratus Clouds  

To add Stratus clouds to a sky:  
1. If it's not already visible, display the Sky & Fog palette by clicking the Sky & Fog 

button at the top of the Bryce window. 
 

 
2. Click the triangle in the corner of the palette and choose Stratus Clouds. 

 

 
Stratus clouds are bright white, thin, clean clouds that appear at high altitudes. These 
clouds are very responsive to Sunlight color and Sky Dome color, and less responsive 
to Cumulus color or Ambient color.  You can also choose both cloud types, or neither. 
Selecting neither cloud type creates a clear sky.  
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Stratus Clouds can also be enabled in the Sky Lab on the Cloud Cover tab:  

 

Spherical Clouds 

The default clouds in Bryce are fairly flat, like you'd see over a desert. To get puffier 
clouds, a Spherical Clouds option is provided. This option basically consolidates high 
frequency clouds, creating rounder, more dense clouds.   
To enable spherical clouds:  

1. If it's not already visible, display the Sky & Fog palette by clicking the Sky & Fog 
button at the top of the Bryce window.  
 

 
2. Click the triangle in the corner of the palette and choose Spherical from the 

menu.  
 

 
Spherical Clouds can also be enabled in the Sky Lab on the Cloud Cover tab:  
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Examples:  
• Stratus Clouds with Spherical Clouds disabled:  

 

 
• Stratus Clouds with Spherical Clouds enabled: 

 

 
• Cumulus Clouds with Spherical Clouds disabled: 
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• Cumulus Clouds with Spherical Clouds enabled:  
 

 

Cloud Height  

 
The height of your clouds has an impact on the appearance of your sky. Greater heights 
will result in smaller, more distant cloud formations, as well as a thicker band of haze at 
the horizon. Lower heights result in larger, more languorous cloud formations and a 
thinner band of haze at the horizon. The Cloud Height controls in the Sky &Fog palette 
let you interactively set the height of the cloud layer in the sky.  
There are two things to remember when working with this control.  
First, the Cloud Height will affect the size of your Haze band if you have a haze setting 
greater than zero. The higher the altitude, the wider the haze region will be on the 
horizon.  
Second, remember to lower your altitude setting if you are creating a nighttime scene. 
Since high altitudes increase the size of the horizon Haze region, the sky will be too 
unnaturally bright for realistic night scenes.  
To set cloud height:  

1. If it's not already visible, display the Sky & Fog palette by clicking the Sky & Fog 
button at the top of the Bryce window.  
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2. Drag horizontally inside the Cloud Height control thumbnail. Drag left to decrease 
altitude and right to increase it. 
 

 
 
The cloud height value is displayed in the Display Text Area of the Control 
palette as you drag. 
 

 
You can also set the cloud height on the Cloud Cover tab in the Sky Lab.  

 
Examples: 

• Cloud Height = 10%  
 

 
• Cloud Height = 90%  
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Cloud Cover 

 
Cloud Cover controls the quantity of clouds you can see in the sky. A high coverage 
means that there is a very dense cloud layer and a low setting means that there are 
very few clouds in the sky.  
Cloud Cover also indirectly controls the brightness of the environment. The more cloud 
coverage you have in a sky, the darker the environment since less sunlight can pass 
through the clouds. Adjusting cloud coverage changes the quantity of clouds but not the 
frequency. You can think of it as adjusting the volume on a radio without changing the 
station.  
The Cloud Coverage control in the Sky & Fog palette lets you interactively set the 
quantity of clouds in the sky.  
To set cloud coverage:  

1. If it's not already visible, display the Sky & Fog palette by clicking the Sky & Fog 
button at the top of the Bryce window.  
 

 
2. Drag left or right inside the Cloud Coverage control thumbnail. Drag left to 

decrease coverage and right to increase it.  
 

 
 
The cloud coverage value is displayed in the Text area of the Control palette as 
you drag.  
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3. Set "Cumulus Cloud Color." 
You can also set the Cloud Coverage on the Cloud Cover tab in the Sky Lab.  

 
Examples: 

• Cloud Cover = 10%  
 

 
• Cloud Cover = 90%  

 

 

Cumulus Cloud Color  

 
Cumulus Cloud Color affects only the Cumulus Clouds, so if Cumulus Clouds are 
disabled, this color swatch will have no effect on the scene. 
To set Cumulus Cloud color:  

1. If it's not already visible, display the Sky & Fog palette by clicking the Sky & Fog 
button at the top of the Bryce window.  
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2. Click the color swatch beneath the Cloud Coverage thumbnail and choose a 
color from the color picker. 
 

 
3. Choose Cumulus from the Sky & Fog Options menu.  

 

 
Note: Cumulus Cloud color can only be selected in the Sky & Fog Palette. It cannot be 
set in the Sky Lab. 
Examples:  

• Cumulus Cloud Color = White  
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• Cumulus Cloud Color = Pink  
 

 

Frequency & Amplitude 

 
The Frequency and Amplitude control lets you set the types of cloud formation you'll see 
in your sky. By combining these two controls you can change your clouds from light and 
fluffy to dark and brooding. Use Frequency and Amplitude to control the types of cloud 
formations in your scene.  
This graph shows the effects of different Frequency and Amplitude settings on a sky. 
Frequency values range from 2 at the top to 150 at the bottom. The Amplitude values 
range from 50 at the left to 500 on the right.  

 

Frequency  

To set Cloud Frequency:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
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2. In the Cloud Frequency and Amplitude control, drag horizontally to control the 
frequency of your cloud formations.  
 

 
• Drag right, and the "spikes" will get closer together, resulting in smaller 

formations. 
 

 
• Drag left for larger, more luxurious formations.  

 

 
The Text Display Area shows you the numerical value of the amplitude and 
frequency as you drag. 
 

 
You can also set the cloud amplitude on the Cloud Cover tab in the Sky Lab.  
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Amplitude  

To set Cloud Amplitude:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
 

 
2. Drag vertically to control the amplitude of your cloud formations. 

 

 
• Drag away from the horizontal center (up), and the spikes increase in 

height, resulting in formations with harder edges.  
 

 
• Drag toward the horizontal center (down) for softer-edged formations.  

 

 
It is possible to invert the spikes. This means that you can exchange positive and 
negative spaces in your sky. If you invert the amplitude, everything that was previously 
clear sky will be clouds, while everything that was cloud will be clear sky.  
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The Text Display Area shows you the numerical value of the amplitude and frequency 
as you drag.   

 
You can also set the cloud amplitude on the Cloud Cover tab in the Sky Lab.  

 

Sky Dome Color  

 
Sky Dome Color lets you create a color wash over your scenes, even if there is no 
sunlight present. This color simulates the natural effect that occurs when you have color 
in the sky even though the sun has set. Sky DomeColor lets you create late afternoon or 
evening scenes. The Sky Dome Color control in the Sky & Fog palette lets you choose 
a color from either the color picker or the color dialog.  
For late afternoon and early evening realism, try using a touch of orange or yellow. This 
will create a cast of color over your entire scene, regardless of the position or color of 
the sun or moon.  
To set Sky Dome color:  

1. If it's not already visible, display the Sky & Fog palette by clicking the Sky & Fog 
button at the top of the Bryce window.  
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2. Click the color swatch beneath the Cloud Height control thumbnail and choose a 
color from the color picker. 
 

 
The Sky Dome Color can also be set on the Sun & Moon tab in the Sky Lab.  

 
Examples:  

• Sky Dome = Purple  
 

 
• Sky Dome = Green  
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Working with the Sun & Moon 

The Sun 

The sun is the source of all natural light in your scene. Its attributes have a profound 
effect on the look of your scene. The color of the sun affects all the colors of all the 
objects in the scene; Sunlight color tints all the other visible colors.  
The position of the sun controls the time of day in your scene. If the sun is above the 
horizon, it is day; if it is below, it is night, and if it is at the horizon, it is sunrise or sunset.  
The sun can be animated just like all the other elements of your Bryce scene. You can 
create time-elapsed effects by changing the position of the sun over the course of an 
animation. Refer to "Animating Sun or Moon Position" for more on animating the sun. 
See "Positioning the Sun" for more on positioning the sun. 

The Moon 

The moon is normally the most prominent object in the night sky. In a night scene it 
provides all the natural light in the environment. Like the sun, the moon's attributes can 
greatly affect the final look of your scene. Its position in the sky affects all the angles 
and intensities of all the shadows in the scene.  
The brightness is affected by the illumination reflected off the earth. The brighter the 
earthshine, the brighter the moon appears. Unlike the sun, the moon has phases which 
simulate the effects of the moon's shadow becoming more or less prominent during a 
month.  
The moon's position and phases can be animated using the Animation controls and the 
timeline. Refer to "Animating Sun or Moon Position" for more on animating the moon. 
See "Positioning the Moon" for more on positioning the sun. 
See also: 

• Day and Night 
• Sunrise/Sunset 
• Sun/Moon Color 
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Positioning the Sun 

The sun position control sets the direction your natural light is coming from whether it is 
sunlight or moonlight. The position can be set using the Sun Control in the Sky & Fog 
palette. The control works like a trackball, with the sun (bright) at one end and the moon 
(dark) at the other.  

 
You can think of the control as a compass: if the highlight on the Sun Control sphere is 
positioned at 12 o'clock, the light comes from the north, and so on. As you change the 
position of the sun, the "time of day" changes. When the sun position is closer to the 
edges of the control, the sun appears closer to the horizon, making the scene darker. 
When the sun is in the center of the control, the sun shines from directly above the sun, 
like it would at high noon.  
The colors in your sky will change depending on the position of the Sun Control, or the 
"time of day..." just like in the real world. The angle of the shadows changes as the sun 
changes. If your object is shiny, and there are no other light sources, the position of the 
sun controls where the highlight appears. In this example, you can see the effects of the 
sun's position on several reflective and shiny objects.  
You can position the sun manually and with precision on the Sky & Fog Palette and in 
the Sky Lab. You can also position the sun numerically in the Sky Lab.  

Positioning the Sun Manually  

To position the sun manually:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
 

 
2. Drag the larger highlight area in the Sun Position Controls to the position where 

you want the light to originate. You can position the sun on the horizon as you 
like by nudging the Sun Control until the light is visible in your scene.  
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Positioning the Sun with Precision  

To position the sun with precision:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
 

 
2. Hold down Ctrl+Opt/Alt and double-click the Sun Control (either the sun or moon 

toggle can be active).  
 
Do not let up on the Ctrl+Opt/Alt keys.  
 

 
3. Continue holding down Ctrl+Opt/Alt and in the working window, click where you 

want to position the sun. A yellow asterisk will show up where you click indicating 
where you placed the sun.  
 

 
 
And the result:  
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Please note that if you move the sun using the Sun Position Control, the "wireframe" 
sun will not move with it but will stay where you clicked in the working window, even 
though the sun will move in the scene. 

Positioning the Sun Numerically  

To position the sun numerically:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
 

 
2. Click the Sky Lab button. The Sky Lab appears.  

 
 

3. If the sun is not showing, click the Day/Night toggle to display the sun icon.  
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4. In the Sun Controls area, type a value into the Azimuth field. The Azimuth field 
controls the east-to-west position of the sun. The range is 0 to +360. 
 

 
5. Enter a value in to the Altitude field. The Altitude field controls the height of the 

sun relative to your scene. The range is -90 to +90. Positive values are above the 
horizon, negative values below. 
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6. Check the results to see if any further changes are needed. 
 

 
7. Click the OK icon to exit the dialog.  

Positioning the Moon 

Positioning the Moon  
The moon is positioned at the same time as the Sun. The two are always at opposite 
ends of the sky, so wherever the sun is positioned, the moon is directly opposite. In the 
Sun/Moon control on the Sky & Fog palette, the moon's position is represented by the 
smaller highlight portion of the Sun Position trackball. 

 
You can position the moon manually and with precision on the Sky & Fog Palette and in 
the Sky Lab. You can also position the moon numerically in the Sky Lab.  
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Positioning the Moon Manually  

To position the moon manually:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
 

 
2. Drag the larger highlight area in the Sun Position Controls to the position where 

you want the light to originate. You can position the moon on the horizon as you 
like by nudging the Sun Control until the light is visible in your scene.  
 

 

Positioning the Moon with Precision  

To position the moon with precision:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
 

 
2. Hold down Ctrl+Opt/Alt and quickly double-click on the Sun Control (either the 

sun or moon toggle can be active).  
 
Do not let up on the Ctrl+Opt/Alt keys.  
 

 
3. While still holding down Ctrl+Opt/Alt , press the Shift key and, in the working 

window, click where you want to position the moon. A blue asterisk will show up 
where you click indicating where you placed the moon. If you have trouble 
placing the moon this way, place the sun, then click on the Day/Night Toggle to 
switch to the moon.  
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And the result:  
 

 
Please note that if you move the moon using the Sun Position Control, the "wireframe" 
moon will not move with it but will stay where you clicked in the working window, even 
though the moon will move in the scene. 

Positioning the Moon Numerically  

To position the moon numerically:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window. 
 

 
2. Click the Sky Lab button. The Sky Lab appears.  
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3. If the moon is not showing, click the Day/Night toggle to display the moon icon.  
 

 
4. In the Sun Controls area, type a value into the Azimuth field. The Azimuth field 

controls the east-to-west position of the sun/moon. The range is 0 to +360, and 
the default value is 60. The moon will be positioned exactly opposite these 
values, so you can invert them to position the moon numerically or place the Sun 
behind the camera so that the moon appears in front of it.  
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5. Enter a value into the Altitude field. The Altitude field controls the height of the 
sun/moon relative to your scene. The range is -99 to +99. Positive values are 
below the horizon, negative values above. 
 

 
6. Check the results to see if any further changes are needed. 

 

 
7. Click the OK icon to exit the dialog.  
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Day and Night  

Your sky normally contains two bodies: the sun and the moon. There is always one 
body visible in your sky. At night it is the moon and in the day it is the sun. The two 
bodies are connected and always remain at opposite ends of the sky. As you move the 
sun you're also moving the moon. This means that when the sun dips below the horizon 
in front of you, the moon is rising behind you.  
The link between the sun and the moon can be seen by positioning the sun at the 
horizon in front of the camera. If you turn the camera 180°, you'll see the moon just 
rising over the horizon as well.  
To switch between night and day:  

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window. 
 

 
2. Click the Day/Night toggle button in the top-left corner of the sun position 

controls.  
 

 
The Sun/Moon Control in the Sky & Fog Palette is linked to the same controls in the Sky 
Lab.  

 

Sunrise/Sunset  

You can create a sunset or sunrise by positioning the sun so that it is visible on your 
horizon.  
You can position the sun manually by using the Sun/Moon control, or numerically by 
specifying values in the Sky Lab. You can also position the sun exactly where you want 
it to appear in your scene. Sunsets or sunrises can be created by moving the sun closer 
to the horizon.  
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The colors in the sky automatically change to create the illusion of the sunrise or sunset 
colors. You can also use the Sky Dome color to give your sunset/sunrise added color.  
For a more realistic sunset you may want to link the fog and haze to the sun so that they 
react to the sun color as it approaches the horizon. Refer to "Blend with Sun" for more 
on this feature.  
You may also want to enable the Horizon illusion for the sun. This feature makes the 
sun appear larger as it approaches the horizon. Refer to "Sun/Moon Size" for more on 
this effect.  

Sun Color  

Light in nature is not usually visible until it strikes an object. When you're using normal 
light, a purple sunlight color will not paint your entire sky purple, but objects in your 
scene will reflect purple. When you're using Visible World, choosing purple will paint 
your entire scene purple.  
The grayscale bar at the bottom of the color palette lets you set the intensity of the sun. 
Black turns the sun off and white sets the sun to its brightest intensity.  

 
To set the Sun Color:  

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sun Color swatch and choose a color from the color picker. You can 

also set the sun color in the Sky Lab:  
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Advanced Display Palette 
The Advanced Display palette contains tools for controlling the display of the interface 
and enabling/disabling the Nano-Preview and Plop Render features.  
The Advanced Display appears on the far right side of the Working window. Click on the 
links on the right to learn more about each tool. 

 

Marker Pen 

The Marker Pen adds the functionality of a white board to your scene. When you're 
using the Marker Pen, you can draw anywhere in the Bryce environment without 
affecting your scene. Deselecting the Marker Pen tool erases all the marker pen lines.  
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To draw with the marker tool:  
1. Click the Marker Pen tool or press the M key.  

 

 
2. The Marker Pen tool will change to show a red tip: 

 

 
 
and the cursor will change to look like the Marker Pen tool:  
 

 
3. Left-click hold and drag the marker anywhere on your Bryce screen. 

 

 
4. By default, the marker color is red and fairly thin. To change the color and line 

size, see "Changing Marker Options." 
To erase marker pen lines, click the Marker Pen tool again or press the M key again.  
Note: While the Marker Pen is active, you will not be able to access the Windows 
toolbar without doing one of the following:  

• clicking on the tool again to deselect it   
• pressing the Windows key  
• pressing the Escape key  
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Changing Marker Options  

The default line color for the Marker Pen is red with the line being fairly thin, however, 
sometimes the color and/or thickness of the line needs to be different (for example, 
when explaining how to do something). Bryce provides a small palette with color 
swatches and a line bar where these options can be modified.  

 
To change the Line Color and Size of the Marker Pen:  

1. Click the Marker Pen tool or press the M key. 
 

 
2. Right-click+hold on the Marker Pen tool again. The Marker Palette will come up 

in the top left-hand corner of the Bryce window. 
 

 
3. While still holding down the right mouse button, drag the marker pen up to the 

palette and place the Marker cursor over the color swatch you want to use.  
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4. Let up on the mouse, then left-click+hold and drag the marker anywhere on your 
Bryce screen. 

5. Repeat to change the marker thickness but drag over the Line Thickness bar to 
increase or decrease the size.  

Examples of color and size changes: 

 
Remember that the marker lines disappear once you deselect the Marker Pen tool so if 
you want to save the sketches you made, you'll need to make a screen capture and 
paste it into your paint program.  

Spray Rendering 

In addition to using the Render Controls, you can also paint an area of your scene to 
render it. Use Spray Rendering to preview a specific area of your scene. If you render 
the entire scene after doing a spray render of a specific section, that area will not be re-
rendered.  
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The Spray Rendering controls include five circular and five square spray nozzles.  
While in Spray Rendering Mode, use the 1 through 5 keys to select the circular spray 
sizes and the 6 through 0 keys to select the square nozzles.  

 
To render using Spray Rendering:  

1. Click the Spray Rendering tool on the Advanced Display palette.  
 

 
 
The tool will change to a spray can with a red tip:  
 

 
 
and the cursor will change to the Spray Can:  
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2. Use the tool to paint over the area of your scene that you want to render. 
 

 
3. Adjust the brush size and shape using the 1 through 0 keys to more easily paint 

a larger or smaller area.  
You can also render a portion of your wireframe or rendered image to quickly see any 
modifications made to your scene. You can render from Wireframe mode or from 
Render mode. Spray Rendering from Wireframe mode is a preview render that is lost 
when you press the Escape key. Spray Rendering from Render mode is a true render 
and can be continued by using Resume Render. 

Spray Rendering From Wireframe  

To spray render from Wireframe mode:  
1. Select the Default Wireframe mode from the Display Modes tool.  

 

 
2. Click the Spray Rendering tool on the Advanced Display palette.  
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3. Use the tool to paint over the area of your scene that you want to render. 
 

 
4. Press the Spray Rendering tool again or press the Escape key to dismiss this 

render and return to Wireframe mode. This doesn't affect any previous render.   

Spray Rendering From Render Mode  

To spray render from Render mode:  
1. Press the Escape key to switch from Wireframe to Render mode or select the 

Default Render mode from the Display Modes tool. 
 

 
 
Your rendered scene will be displayed. If the scene has not yet been rendered, 
you'll see a blank "render." 
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2. Click the Spray Rendering tool on the Advanced Display palette.  

 

 
3. Use the tool to paint over the area of your scene that you want to render. 

 

 
4. Click the Spray Rendering tool to put the tool away and remain in render mode.  
5. Press Escape again to return to Wireframe mode yet not lose your paint 

rendered area.  
6. If you Resume Render your scene, Bryce continues to render the un-rendered 

portions of your scene.  
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Interface Max/Min  

When you first launch Bryce, the interface snaps to the edges of your Working window 
and other applications are hidden behind Bryce. This setup lets you work with an 
uncluttered desktop.  

 
Use the Interface Max/Min tool to increase or decrease the screen coverage of the 
Bryce window. The current size of the working window will determine the amount of 
"black space" around the minimized Bryce Window.  
The image below shows the minimized Bryce Window with the Working Window set to 
Default 540:405:   
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And the same window, maximized. If the Working Window is set to Max Recommended, 
you won't see much difference between minimum and maximum.   

 

Background Paper  

 
The background texture of the working window can add a great deal to the overall look 
of the interface. It makes it easier to see wireframes and selected objects.  
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To select a background texture, click the Background Paper button and choose a 
background from the menu (see examples at bottom of page).  

 
Adding a background texture may slow down some machines so if you need more 
speed for any reason, select No Texture and you will get a simple, clean background 
with no texture.  
To select a background color:    

1. Click the Background Paper button and choose Select Color from the menu.  
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2. Use the color picker to select a color. 
 

 
3. Click on the OK icon to accept the color change, the background will change to 

the selected color. 
 

 
To revert to the default gray, click on the Background Paper button again and choose 
Select Color from the menu. The default gray color will be selected, then click on the OK 
icon to accept the color.  
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Examples of Background Textures:  

 
Paper 

 
Streak Paper 

 
Gray 

 
Black 

 
Grid 

 
Legal Pad 
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White 

 
Paper Grid 

 
Grain 

  

Nano Editor On/Off  

Nano-Edit Mode activates the Nano-Editor which lets you perform camera 
transformations on a small preview of your scene, instead of the full scene.  
When this mode is active, the Nano-Editor appears any time you perform a camera 
transformation. The Nano-Editor window displays a small preview of your scene. The 
transformation is applied to the preview. When you close the editor, the transformation 
is applied to the full scene.   

Note: It may be useful to save the current camera setting before using the Nano-
Editor, just in case you aren't happy with the results since using the Undo feature 
will not reset the camera view.  

Use the Nano-Edit Mode to quickly see the effects of a transformation on a preview of 
your image. This mode is useful when you're working on a large scene as it saves on 
redraw time since only the preview window shows the changes instead of the entire 
Working Window.  
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To activate Nano-Edit Mode:  
1. Click the Nano-Edit button on the Display palette.  

 

 
 
When the smaller square inside the icon (which represents an active Nano-
Editor) is red, the Nano-Edit Mode is on; when it is white, it is off.  
 

 
2. Move the cursor over any of the Camera Controls, left-click hold and drag on the 

control to reposition the camera. Let up on the control to apply the changes to the 
scene.   

3. Let up on the mouse and the changes will be applied to the scene. 
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To temporarily activate Nano-Edit Mode, hold down Opt/Alt+Spacebar before you 
perform transformations. The Nano-Editor appears only during the operation and can be 
used without actually clicking on the camera controls.  

1. Press Opt/Alt+Spacebar and move the cursor over the working window. You'll 
see the rotate cursor in the window:  
 

 
2. Left-click on the working window and rotate the scene just as if you were using 

the camera controls: 
 

 
3. Let up on the mouse and the changes will be applied to the scene. 
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Plop-Render On/Off 

If you've begun rendering your image, you can use the Plop-Render controls to render 
specific areas of your image. You can use this mode to quickly see the results of 
repositioning and transformation operations.  
Plop-Render mode is enabled by default but can be turned off using the Display palette.  
To enable/disable Plop-Render mode, click the Plop-Render On/Off toggle in the 
Display palette. When the small rectangle inside the icon (which represents an active 
Plop-Render tool) is red, Plop-Render mode is on. When it is white, the mode is off.  

 
To render an area of your scene:  

1. Make sure Plop-Render mode is enabled.  
2. Begin rendering your scene by clicking the Render All button in the Render 

controls.  
 

 
3. Pause rendering by clicking the Render All button again or clicking in the working 

window.  
4. Drag a marquee around an area of your image. The selection is outlined in a thin 

white line and is separated from the rest of the image by a drop shadow. A series 
of buttons appear beside the marquee selection.   
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5. Click the top button that appears beside the selection, this is the Clear and 
Render button. You can interrupt the rendering by clicking the mouse. 
 

 
6. To resume a render, click the second button (Resume Render) that appears 

beside the selection. 
 

 
The following sections discuss additional Plop Render options 

Zoom to Selection 

To scale the selected area to fill the working window, click the triangle icon beside the 
Render Controls and choose Zoom to Selection from the menu.  

 
The command centers the selected portion of your wireframe scene and scales it up to 
fit your window. This is a pan and zoom operation and therefore does not affect your 
camera position, however, it will clear any previous render you performed.   
Note: You may want to save the camera position prior to performing this function so that 
you can view the entire scene after completing the plop-render.   

©2007 DAZ 3D, Inc.  284 



Bryce 6 Artist Guide 

  

Hide Selection  

To hide the Plop-Render selection but still use it, click the triangle icon beside the 
Render controls and choose Hide Selection from the menu.  

 
The frame around the selection will disappear but the selection can still be rendered 
without rendering the entire scene.  

 
Click on the Clear and Render button or on the Resume Render button in the Render 
controls:  

 
Do not click on the Render All button (large center one) as that will disable the Plop-
Render and render the entire scene.  
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Collapse Selection  

To completely get rid of the Plop-Render selection, click the triangle icon beside the 
Render Controls and choose Collapse Selection from the menu.  

 
This will remove the selection and you can render the full scene.   

Wireframe Attributes 

When you're in Wireframe mode, there are several options you can set to make the 
display more helpful. Disabling some of these options may speed up drawing time. 
There are four Wireframe Attributes:  

• Depth Cue 

• Shadows On/Off 

• Underground On/Off 

• Resolution 

Depth Cue  

Depth cueing allows you to see which objects are further away from the camera based 
on how light or dark the mesh is and not on the size of the mesh.  

 
To use Depth Cue, left-click-hold on the Depth Cue control and drag up or down.  

 

©2007 DAZ 3D, Inc.  286 



Bryce 6 Artist Guide 

The image below shows the default setting for depth cue.  

 
Drag up to increase the intensity of the depth cueing effect.  

 
Drag down to decrease the intensity of the depth cueing effect. When depth cueing is 
active, the wireframe appears lighter the farther it is from the camera.  
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If you hold down the Ctrl or Ctrl+Alt keys and click on the Depth Cue icon, Bryce will 
turn anti-aliased wireframes on or off.   

 

Shadows On/Off  

In Wireframe mode, shadows are designed to help you determine object placement in 
your scene. For this reason, shadows appear even when there is no ground plane or 
when the object is below the ground plane. This feature may slow down your system 
when working with a complex scene on slower machines.  

 
By default, shadows are turned on in Bryce. 
To turn off Shadows:  

• Click the Shadows On button.  
 

 
• The tool will change to the Shadows Off button.  
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• The shadows for the objects will disappear from the scene.  
 

 
To turn on Shadows:  

• Click the Shadows Off button.  
 

 
• The tool will change to the Shadows On button.  

 

 
• The shadows for the objects will appear in the scene.  

 

 

©2007 DAZ 3D, Inc.  289 



Bryce 6 Artist Guide 

Underground On/Off  

By default, any part of the scene below ground level is hidden for easy visualization and 
composition. However, you might overlook an object that is hidden underground. In 
addition, sometimes it is useful to see these objects especially when the scene doesn't 
use a ground plane, for example, space scenes.  

 
By default the underground is turned on. 
To turn off the Underground:  

• Click the Underground On button.  
 

 
• The tool will change to the Underground Off icon.  

 

 
• The scene will show the objects or parts of objects that are below ground level.  
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To turn on the Underground:  
• Click the Underground Off button. 

 

 
• The tool will change to the Underground On icon.  

 

 
• The scene will hide the objects or parts of objects that are below ground level.  

 

 

Resolution  

Wireframe Resolution can be set manually to suit your preferences using the Resolution 
tool. Reduce the resolution if Bryce slows down when a large scene is being worked on.  

 
Click the Resolution tool and choose Static, Selected, or Motion. Then choose a 
resolution for the wireframe mode.  

• Static lets you define the resolution of the wireframe when the object is not 
moving and not selected.  
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• Selected lets you define the resolution of the wireframe when the object is 
selected.  

• Motion lets you define the resolution of the wireframe when the object is being 
moved.  

• Selecting Auto LOD (Level of Detail) will allow Bryce to automatically force a box 
display of objects while moving objects or the camera if your computer cannot 
handle the selected settings.  

The new "Convert Boolean to Mesh" function depends on the Selected Resolution so if 
the Selected Resolution is set to 8, then the converted mesh will be "chunky" but if the 
Selected Resolution is set to 32, then the converted mesh will be much smoother.  
Below are examples of each setting, with the menu setting shown first and the result 
shown second.  

• Motion set to 8:  
 

 
• Example of objects in motion at 8:  
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• Static set to 16:  
 

 
• Example of static (non-selected) objects at 16:  

 

 
• Selected set to 32:  

 

 
• Example of selected objects at 32:  
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Display Modes 

The Display Mode tool, at the bottom-right corner of your Working window, toggles 
through the available display modes. This tool appears as a cube that is either 
wireframe or shaded, depending on the selected display mode.  

 

Default Display Modes  

By default, the Display Mode tool lets you cycle through three display modes by clicking 
on the Display Mode tool multiple times:  

• Default Wireframe, WireFrame, Lit WireFrame, Hidden Line, Wire Shaded, Wired 
Textured Shaded  
 

  
• Default Mixed  

 

 
• Default Rendered, Textured Shaded, Smooth Shaded  

 

 
Clicking and holding the mouse button on the Display Mode tool for a moment opens a 
menu allowing you select one of the default display modes without clicking multiple 
times on the Display Mode tool. Once you choose a type of mode (default or OpenGL) 
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from the menu, clicking on the Display Modes icon will cycle through the available 
options. 

 
Examples:  

• Default Wireframe  
 

 
• Default Mixed  
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• Default Rendered  
 

 

OpenGL Display Modes  

Clicking and holding the mouse button on the Display Mode tool for a moment opens a 
menu allowing you select one of the following OpenGL display modes.  

 
Once you select an OpenGL Mode, clicking the Display Mode tool cycles through the 
available OpenGL Display Modes. 
To switch between display modes:  

1. Click on the Display Mode tool in the corner of the Working Window.  
2. Click the button until you're in the desired mode. There are seven modes 

available: 
• Texture Shaded uses OpenGL (if available) to show all objects with 

textures and shadows. 
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• Wireframe shows all objects as wireframes. 

 

 
• Lit Wireframe shows all objects as wireframes and also displays areas of 

light and shadow. 
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• Hidden Line shows all objects as wireframes but hides portions of the 
objects that are not visible from the camera location/angle. 
 

 
• Wire Shaded shows all objects as a solid while also displaying the 

wireframes. 
 

 
• Smooth Shaded shows all objects as a solid but does not display the 

wireframes. This preview mode is only available if your system contains 
hardware that supports OpenGL®. When this mode is active your objects 
appear as flat shaded solids, without materials, instead of wireframes, and 
you can see the effects of light sources on object surfaces. 
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• Wire Texture Shaded uses OpenGL (if available) to display all objects with 

textures, shadows, and wireframes.  
 

 
Selecting Default Wireframe disables all advanced display modes.  
Note: If you have trouble opening scene files, such as the scene taking a long time to 
open without any obvious reason or the scene crashing on opening, then check the 
display options to see if any of the OpenGL options are selected. If they are, change to 
one of the default display options and try opening the scene again. This is a possible 
solution and not the only reason why a scene may take a long time to open or cause 
Bryce to crash.  
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Zoom In/Out 

 
In Bryce, there is a difference between moving the camera and using the zoom tools. 
When you move the Camera, you're moving in 3D space. When you use the pan and 
zoom controls, you're transforming a 2D projection of your 3D scene - your camera 
position does not change.  
When you use the Zoom tool, you are essentially making the 2D projection larger or 
smaller. Your camera position in 3D space does not change.  

• To zoom in, click on the Zoom In tool - Magnifying Glass with plus (+) sign. Bryce 
scales the 2D projection of your scene larger, creating the illusion of zooming into 
your 3D scene; your camera position remains unchanged. 
 
Keyboard shortcut: plus (+)  

• To zoom out, click the Zoom Out tool - Magnifying Glass with minus (-) sign. 
Bryce scales the 2D projection of your scene smaller, creating the illusion of 
zooming out of your 3D scene. Your camera position remains unchanged.  
 
Keyboard shortcut: minus (-)  

• To zoom into a specific area, hold down Cmd/Ctrl+Spacebar and drag a marquee 
around an area of your scene. Your cursor changes to a Zoom tool and Bryce 
centers and scales up the area in the marquee to fit your window. See "Zoom to 
Selection" to see this in action.   

• To zoom using the mouse, hold down Cmd/Ctrl+Opt/Alt+Spacebar and drag the 
mouse left or right in your scene.  
 
Dragging left zooms in and dragging right zooms out.  

• To zoom numerically:   
1. Double-click the Trackball in the Control palette. The Camera & 2D 

Projection dialog appears.  
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2. Enter a value in the Scale field. The default value is 100%. You can only 
zoom numerically when you are working in either Director's View or 
Camera View.  
 

 
• To reset the zoom value, press the Opt/Alt key and click on the Zoom tool. The 

view of your scene resets to 100%.  
• To zoom in or out while rendering, see "Zoom While Rendering." 

Zoom While Rendering  

The Zoom tool can also be used while the scene is rendering. This allows you to see 
more or less of the scene during the render without affecting the final render.  
To zoom while rendering:  

1. Set up the render size of the scene to a large size as needed.  
2. Click on the Render button.  
3. Once the render has started:  

• Click on the Zoom In tool or press the plus (+) key to zoom in.  
• Click on the Zoom Out tool or press the minus (-) key to zoom out. 
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Examples:  
• Render large started: 

 

 
• Zoomed out while rendering:  

 

 
 
The image may look odd but this is because the image is zoomed out. If you 
zoom in (see below), you'll see that the image looks fine.  
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• Zoomed in while rendering: 
 

 

Pan Tool 

 
Panning works the same way as zooming. When you use the Pan tool, you are moving 
a 2D projection of your scene right and left, up and down, in front of the camera. The 
actual camera position in 3D space does not change.  
The Pan tool can be very useful when you need to move the horizon up or down without 
affecting the view of the scene like zooming in or out would do. 
Note: It may be useful to save the current camera setting before using the Pan tool, just 
in case you aren't happy with the results since using the Undo feature will not reset the 
camera view.  
The Pan tool can be used with or without the Nano-Editor.  
There are three ways to Pan:  

• Clicking on the Pan tool 
• Using the Spacebar and the Pan tool 
• Using the Camera & 2D Projection dialog 

Once you've finished looking around your scene, you can reset the Pan tool if needed. 
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To reset the Pan tool to the default view:  
• Mac: Press Opt+ left-click on the Pan tool. 
• PC: Press Ctrl+Alt+left-click-drag on the Pan tool. 

Using the Pan Tool  

To pan your scene using the Pan tool, left-click+hold on the Pan tool and drag over the 
tool in the direction you want your scene to move.  

• With the Nano-Editor On:  
 

 
 
If the Nano-Editor is on, you'll see the preview window show up over the Pan tool 
button. The scene will pan inside the preview window and when you let up on the 
mouse, the scene itself will change to match the preview window.  
 

 
• With the Nano-Editor Off:  

 

 
 
If the Nano-Editor is off, the entire scene will move as you drag over the Pan tool 
button. When you let up on the mouse, the scene will stop at the same place 
where you panned to.  
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Using the Spacebar to Pan  

To pan your scene using the Spacebar, hold down the Spacebar and left-click+drag in 
your scene in the direction you want the scene to move.  

• With the Nano-Editor On:  
 

 
 
If the Nano-Editor is on, you'll see the preview window show up over the working 
window where you clicked in the scene. The scene will pan inside the preview 
window and when you let up on the mouse, the scene itself will change to match 
the preview window.  
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• With the Nano-Editor Off:  
 

 
 
If the Nano-Editor is off, the entire scene will move as you drag over the Pan tool 
button. When you let up on the mouse, the scene will stop at the same place 
where you panned to.  

Panning Numerically 

To pan your scene numerically using the Camera and 2D Projection dialog:  
1. Double-click the Trackball in the Control palette.  

 

 
 
The Camera & 2D Projection dialog appears.  
 

 
2. Enter a value in the Pan V (Vertical) field (default value is 0).  
3. Enter a value in the Pan H (Horizontal) field (default value is 0).  

©2007 DAZ 3D, Inc.  306 



Bryce 6 Artist Guide 

4. Click on the OK icon to close the dialog.  
 
The camera will move to the selected location.   

Note: You can only pan numerically when you are working in either Director's View or 
Camera View. 

Time/Selection Palette 
The Time/Selection Palette is located at the bottom of the Bryce window.  

 
Click on the toggle to switch between the Selection Palette and the Animation Controls. 

 

Animation Palette 

The Animation Palette contains controls that let you set up key frames and edit the 
timeline of your animation.  
These controls also let you preview your animation, add and delete key frames, and 
access the Advanced Motion Lab. Refer to the "Animation" section for more on using 
the Animation controls.  
While all animation palettes are almost the same, the one shown below is the one you 
see in the main working window.  
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Animating Transformations  

When you're in Auto-Key mode, every transformation you apply to an object is recorded 
as a key frame.  

 
In the Hierarchy area you can see where the key frames for these transformations 
appear in the timeline. By moving these key frames you can control the order in which 
transformations are applied. For example, you can take an object that grows larger and 
then moves left, and turn it into an object that moves left and then grows. Several 
animation techniques, like squash and stretch, can be simulated using transformations.  
See "Animating Transformations" for more on animating transformations.  

Animating Materials 

The Materials Lab has its own set of animation tools that let you animate material 
properties. You can animate almost any property or texture.  

 
When you're animating between textures, Bryce interpolates between patterns and 
colors over time. You can have a rocky terrain turn into a desert during the course of 
your animation.   
Refer to "Animating Materials" for more on animating materials.  
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Animating Terrains  

The Terrain Editor has a set of animation tools that let you animate a terrain over time.  

 
You can animate the shape of the terrain or the filtering effects like Erosion or Mounds. 
Using these tools, you can create a terrain that changes shape as time passes.  
Refer to "Animating Terrains" for more on animating terrains.  

Animating Skies  

The Sky & Fog palette and the Sky Lab dialog have a number of controls that let you set 
the properties of your environment. By changing these properties over the course of an 
animation, you can animate your environment. For example, you can make clouds 
move or gradually change the time of day.  
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Refer to "Animating Skies" for more on animating skies.  

Selection Palette 

The Selection Palette contains tools for selecting specific types of objects in your scene.  

 
When you first open Bryce, you do not see this palette in the default Working window.  
To view it, you must use the Time/Selection Palette Toggle at the far bottom right of 
your Working window to replace the Animation Controls with the Selection Palette.  

 

Select by Type  

The Select by Type icons let you select all the objects in your scene that are of a 
particular type. For instance, if you click on a sphere here, Bryce will select all spheres 
and sphere derivative objects in your scene.  
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All of the selection controls below respect the previously described Shift-click 
techniques for multiple selections and deselections.  
To select a specific object by type, hold down the cursor over the tool for the type of 
object you want to select and choose the name of the object from the menu that 
appears.   
By default, objects will be named with the object type followed by a sequential number 
based on when you placed that object in the scene, for example, Sphere To make it 
easier to select a particular object, you can give objects unique names that will appear 
in this menu.  

 
The selected object or objects will be selected.  

 

Select All of Type  

To select all objects of a specific type, hold down the cursor over the tool for the type of 
object you want to select and choose Select All of Type from the menu that appears.  
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All objects of the selected type will be selected.  

 

Select by Family  

To select objects by family: 
1. Click the Families tool. 

 

 
2. Choose the name of the family you want to select from the menu.  

 

 
 
All objects that have been set as a member of the selected family will be 
selected. For Mac users, if selecting by family crashes Bryce, make sure you 
have Bryce 6.1.13.1 or later installed. 
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Select Options 

The Select Options menu on the Selection Palette allows additional selections to be 
made. From this menu you can select meshes, groups, and paths. You can also select 
all objects, select none, or invert the selection.  

 

©2007 DAZ 3D, Inc.  313 



Bryce 6 Artist Guide 

Select Camera  

To select the camera, click the triangle icon next to the Selection Palette and choose 
Select Camera.  

 
The camera will be selected. 

 
This option is most useful when the camera has been hidden and cannot be selected 
any other way.  
Choosing this option will automatically unhide the camera if it was previously hidden via 
the Objects Attribute dialog. 
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Select by Mesh  

To select Mesh objects, click the triangle icon next to the Selection Palette and choose 
Select Meshes, then the particular mesh(es).  

• To select all meshes in the scene, choose Select All Meshes.  
• To select a specific mesh, choose that mesh from the listing. 
• To select multiple meshes, press Shift while selecting the meshes from the 

listing. 
 

 
 
The selected mesh or meshes will be selected.  
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Select by Group  

To select Group objects, click the triangle icon next to the Selection Palette and choose 
Select Group, then the particular group(s).  

• To select all groups, choose Select All Groups from the menu. 
• To select a specific group, choose that group from the listing. 
• To select multiple groups, press Shift while selecting groups from the listing. 

 

 
 
The selected group or groups will be selected.  
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Select by Path  

To select Path objects, click the triangle icon next to the Selection Palette and choose 
Select Paths, then the particular path(s).  

• To select all paths in the scene, choose Select All Paths.  
• To select a specific path, choose that path from the listing. 
• To select multiple paths, press Shift while selecting paths from the listing. 

 

 
 
The selected path or paths will be selected.  
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Select Web Links  

To select objects that have a Web Link attached to them, click the triangle icon in the 
Selection Palette and choose Select Web Links from the menu.  

 
All objects that have a web link associated with them will be selected.  
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Select Inverse  

There are two methods to select the inverse of the current selection. 
To select all objects except a specific type:  

1. Click the tool for the object you want to exclude from the selection. All the objects 
of that type are selected. 
 

 
2. Click the triangle icon in the Selection Palette and choose Select Inverse from 

the menu.  
 

 
3. The objects that were selected will be deselected while the objects that weren't 

selected will now be selected.   
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You can also Select Inverse by doing the following: 

1. Select the object(s) you don't want selected. 
 

 
2. Press Shift and drag a marquee around the objects you want to be selected. 

Note that the marquee is not being dragged around all objects in the scene as we 
don't want the other two objects to be selected. 
 

 
 
The unselected objects within the marquee will be selected, while the object(s) 
that were selected will be deselected. The objects that were outside the marquee 
remain unselected. 
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Select All  

To select all the objects in your scene, click the triangle icon in the Selection Palette and 
choose Select All from the menu.  

 
This will select all objects in the scene.   
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Select None  

To deselect all selected objects, click the triangle icon in the Selection Palette and 
choose Select None from the menu. All selected objects in the scene will be deselected. 

 
This option is most useful when the boundaries of your objects overlap and you can't 
find a spot in the working window to click on to deselect all objects. 

VCR Controls 

The VCR Controls let you step through the various selection tools and activate Solo 
Mode.  
If the Selection palette is not showing, click the Time/Selection Palette Toggle in the 
lower-right corner of the Working window.  

 
The Selection Palette appears and the VCR Controls are on the far right of the 
Selection Palette.  

 

Step Sequentially Through Object Types  

To step forward and backward through the object types in your scene:  
1. Click on the larger forward arrow to step forward through object types within the 

current scene. The first object of its type is selected.  
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2. Click on the larger backward arrow to step back through object types.  
 
If you watch the Select By Type icons, the object type you are stepping to will 
highlight momentarily. 
 

 
If you notice that Bryce is stepping through all objects in the scene instead of selecting 
the object type, click the triangle icon in the Selection Palette and deselect Alternate 
VCR Mode.  

 

Step Sequentially Through Objects of Selected Object Types  

To step forward and backwards through the object in a selected object type:  
1. Click on the smaller forward arrow to step forward through each object of the 

type in a selection. For example, you can use the large arrows to step to the first 
sphere created in your scene  
 

 
2. and then the smaller forward and backwards arrows to step through all other 

spheres in your scene.  
 

 
One advantage to making selections with this technique is that you can select objects 
within a Group. Simply clicking on a grouped object will not necessarily select the entire 
group; using the VCR Controls to select within a Group allows you to reposition objects 
or assign textures to objects within a Group without having to first Ungroup them.  
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If you notice that Bryce is stepping through families instead of objects, click the triangle 
icon in the Selection Palette and deselect Alternate VCR Mode.  

 

Step Sequentially Through all Objects in Scene  

To step sequentially through every object in your scene:  
1. Click the triangle icon in the Selection Palette and choose Alternate VCR Mode.  

 

 
2. Click the larger backward or forward arrow.   
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Step Sequentially Through Families  

To step sequentially through families:  
1. Click the triangle icon in the Selection Palette and choose Alternate VCR Mode.  

 

 
2. Click the smaller backward or forward arrow.  

 

 

Working in Solo Mode  

Solo Mode is a very useful option when working in complex scenes. It allows you to 
isolate groups of objects without being distracted by other objects. Solo Mode also 
speeds up your work significantly as Bryce does not have to calculate and draw 
extraneous wireframe objects.  
To work in Solo Mode:   

1. Select an object, several objects, or group(s).  
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2. Click the Solo Mode button in the center of the VCR Controls.  
 

 
 
The button color changes to red. 
 

 
3. Solo Mode will now be activated and the selected object(s) will show up in the 

working window without the rest of the scene showing. Modify the object(s) as 
needed. 
 

 
4. Once you have completed the edits in Solo Mode, click on the red Solo Mode 

button to return to the full scene. Any changes you made to the camera while in 
Solo Mode will be reflected in the full scene so be careful about using the camera 
in Solo Mode. It may be useful to save the camera setting before entering Solo 
Mode.  
 

 

Control Palette 
The Control Palette contains tools for positioning the camera and viewing your scene. 
When working in Bryce, you position objects in three-dimensional space while looking at 
a two-dimensional display.   
You may find that your scenes become rather large and you might not be able to see 
the entire landscape in the Working Window. Bryce has several tools that can help you 
position elements and see every inch of your new world from all angles.   
You can also control how individual objects are displayed in the Working Window, and 
how your scene is displayed in the Nano-Preview.  
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The tools available in the Control Palette are:   

• Nano-Preview 

• Camera Memory Dots 

• View Controls 

• Camera Controls 

• Render Controls 

• Text Display Area 
These tools are found in the Control Palette located on the far left side of the Working 
Window.  
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Nano-Preview  

The Nano-Preview is where your object is displayed before you render it. The Nano-
Preview can display your scene from a number of different angles without affecting the 
position of the camera.  
To display your scene from different angles in the Nano-Preview, click the triangle icon 
below the Nano-Preview and choose a preset display angle. The view of your scene 
does not change in the Working Window.  

 
To set Nano-Preview options, click the triangle icon below the Nano-Preview and 
choose a display option: 

 
• Sky Only previews only your sky settings.  
• Full Scene previews your actual scene. This is the default setting for the Nano- 

Preview.   
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• Wireframe Only previews your wireframes only, as opposed to a rendered 
preview.   

• Auto Update will automatically update the preview render with every single 
change you make during your session. In most cases, this gives you almost 
immediate feedback after any action. On slower machines, or when working with 
highly complex scenes, you can deselect this option.  

• With this option deselected, you'll need to click in the Nano-Preview 
window to update the render.  

• To set what view is shown in the Nano-Preview, select one of the View options:  
• Current View - will always show the same view as currently shown in the 

Working Window  
• Director's View - will always show the Director's View no matter what view 

is used in the Working Window Camera View - will always show the 
Camera's View no matter what view is used in the Working Window From 
Top - will always show the view from Top View no matter what view is 
used in the Working Window  

• From Right - will always show the view from Right View no matter what 
view is used in the Working Window  

• From Front - will always show the view from Front View no matter what 
view is used in the Working Window  

• From Left - will always show the view from Left View no matter what view 
is used in the Working Window  

• From Back - will always show the view from Back View no matter what 
view is used in the Working Window  

• From Bottom - will always show the view from Bottom View no matter 
what view is used in the Working Window  

• Select either Fast Preview or Full Rendering to adjust the quality of the rendered 
preview. With Full Render selected, every pixel is ray-traced and anti-aliased. 
Fast preview mode skips pixels to achieve faster updates. This can cause small 
objects to be partially or completely missing.  

Camera Memory Dots  

You can use the preset viewing positions to see your scene from different angles or you 
can use the Memory Dots to store and retrieve your favorite camera positions. The 
Camera Memory Dots are located at the top left of the Working Window next to the 
Preview Window.  
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The Camera Memory Dots are located at the top left of the Working Window next to the 
Preview Window.  

 
The dots let you store up to seven different views of your scene.   

 
The uppermost dot, slightly separated from the rest, is a quick way to return to the 
default Bryce camera position.  
There is no way to clear this dot. It will always contain the default Camera settings.   
Dot settings are saved with your scene file, so if you open a previously saved scene, 
your dot settings from the previous session remain in place.   
When you click on a full dot to activate it, the saved position becomes the current 
Camera View. When you no longer need a saved camera position, you can delete it by 
clearing the dot it is saved to.   

• To save a camera position to a memory dot, click an empty dot.  
• Empty dots appear gray -  
• Full dots appear green (blue in Bryce 5/5.5, teal in Bryce 3/4) -  

• To return to the default camera position, click the top memory dot. The view 
returns to the default, regardless of how many changes you've made.  

• To switch between saved positions, click a full (green) dot.  
• Active dots appear green with a white dot in the middle -  
• To clear a full dot, Opt/Alt-click a full dot. The dot turns gray and a new camera 

view can be saved to it. 

View Controls 

Bryce lets you view your scene from several preset positions: Top, Front, Side, Bottom, 
Right, Left, and Back. All these views, with the exception of the Perspective View, are 
special Orthogonal projections which allow perspective-free views well-suited for 
alignment operations.  
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Refer to "Orthogonality and Views" for an explanation of how and why Bryce uses 
Orthogonal projections. 

 

Orthogonality and Views  

When you view a scene from the side, front, top, or bottom using the Camera, you'll see 
certain amounts of perspective distortions. These distortions can make precise visual 
alignments difficult.  
For instance, if you have a dozen cubes in different locations and you place the camera 
so that it looks down on the scene from above, you will find it very difficult to place the 
cubes on top of one another. Cubes further from the camera would be slightly smaller 
than cubes close to the camera, resulting in a confusing array of lines.  
The more complex the scene, the more confusing and difficult this kind of alignment 
becomes. If, for example, you viewed objects from above through a real-world camera, 
the perspective distortions would make alignment or placement difficult.  

 
To solve this problem, Bryce uses a perspective free, drafting board kind of view in 
which like sized objects far away appear exactly the same as those up close. This 
perspective-free view is called an Orthogonal Projection. In Bryce, all views other than 
your Main View (that is, Top, Bottom, Right, Left, Front, and Back) are orthogonal 
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projections. They are not generated by the camera, and so do not contain the 
perspective distortion that would necessarily come with a camera view.  

 
As a result, Camera Controls do not work in these views and will be shaded to show 
they are not available in these views.  

• Camera Controls in Director's or Camera View :  
 

 
• Camera Controls in Orthogonal Views:   

 

 
You can, however, navigate within the orthogonal views using the Zoom and Pan tools.  
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If you press the Render button while in an orthogonal view, Bryce will quickly set up the 
camera position you need and render your image. There may be slight differences 
between what you see in the wireframe projection and what you see in the rendered 
image as a result of the added perspective distortion in the rendered image.  

Select Views & View Options 

The Select View control is an interactive way of cycling through the various preset 
views. The current position of the Select Views control indicates the view you're seeing 
in the Working window.  

• To switch views using the Select Views control, click or drag the Select Views 
control until you reach the view you are looking for. Every time you click the 
control, Bryce displays a different preset view (see images below).  

• To switch views using the Select Views control menu, click the triangle icon next 
to the Select Views control and select a view option:  
 

 
 
See "Orthogonal Views" for more on these views. 

• To switch views using the keyboard, select a preset view shortcut:  
• Director's View = ~ (apostrophe key, no Shift) 
• Camera View = 1 
• Top View = 2 
• Right View = 3 
• Front View = 4 
• Saved views = 5 through 9 

©2007 DAZ 3D, Inc.  333 



Bryce 6 Artist Guide 

Perspective Toggle  

The Perspective Toggle allows you to quickly switch between the Director's and Camera 
Views without having to select the views from the View Control menu.  
The default view is the Director's View and the toggle shows as a director's chair.   

 
To change to the Camera View, click on the Perspective Toggle. The toggle will change 
to a camera and the scene view will switch to the current Camera View.  

 
To switch back to the Director's View, click on the toggle again.  
While in an Orthogonal View, the Perspective Toggle will be hidden. In order to switch 
to Director's View or Orthogonal View, select the view from the View Options menu.  

 

Fly-Around View  

You may have noticed a tiny circular icon above and to the right of the Select Views 
icon. If you click here, you will This view gives you a sense of context in your Bryce 
world. If you're working close to the ground, or stuck in the midst of a clump of trees, or 
you've lost a cube you know you created a half an hour ago, you can use the Fly-around 
View to see your entire scene all at once.  
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In Fly-around View, Bryce positions the Camera on an imaginary monorail track above 
and away from your scene so that you can see the whole scene from all sides as the 
camera moves around it.  

• To switch to Fly-around View, click the Fly-around View icon next to the Select 
Views control, or choose Objects > Fly-around, or press Cmd/Ctrl+Y.  
 
The Select View control changes to the Fly-around control.  
 

 
• To switch back to Camera view, click on the Select Views control icon next to the 

Fly-around control.  
• To change the angle of your scene in Fly-around view, drag your mouse in your 

scene. The scene rotates in the direction you drag.   
• To zoom in and out in Fly-around view, hold down the Cmd/Ctrl key and move 

the mouse up or down in the window - do not click in the scene, just move the 
mouse itself. Moving the mouse up zooms in and moving the mouse down 
zooms out.  

• To slow the Fly-around, hold down the Shift key.  
• To pause the Fly-around, press the Spacebar. Press the Spacebar again to 

resume the Fly-around.  
• To end the Fly-around and return to the last active view, click anywhere in the 

Bryce window. The view switches back to the view that was active when Fly-
around was activated. To end the Fly-around and save the Fly-around position, 
press Return/Enter. The last Fly-around position becomes the new Current View.  

The View of Your Scene  

The view of your scene refers to the portion of the scene visible in the Working window. 
There are eight views of your scene available in Bryce: the Camera View, which is the 
view produced by the Camera in the scene; the Director's View, which shows your 
scene from the perspective of a director sitting outside of the scene; and the Orthogonal 
Views (Top, Bottom, Left, Right, Back and Front) which are perspective-free views of 
your scene.  
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Camera View 

Camera View is produced by the Camera in 3D space, meaning that you can view your 
scene from anywhere within your Bryce environment - even from underneath it. The 
Camera View can be positioned using the positioning tools or by repositioning the 
Camera in the scene.  
The Camera has a wireframe, which can be dragged in the Working window and its 
motions recorded as an animation. However, the wireframe is visible only in the 
Director's View or one of the Orthogonal Views.  

 

Director's View  

The Director's View gives you the freedom to look at your scene from any perspective 
while still being able to manipulate the Camera as an object.  
The Director's View motions are not recorded as part of an animation. This means that 
you can move to any position without inadvertently changing the view of your scene in 
the animation.  
The Director's View can also be an invaluable tool for animating the view of your scene. 
While in this view, you can select the Camera and reposition it anywhere in the scene to 
create camera motions. Director's View is the default view of the scene.  
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Orthogonal Views 

These six views let you see the scene from all sides. They do not show you any 
perspective, but you can see all the objects in the scene, including the camera. These 
views are only flat projections of the scene, so you can't move around them using the 
camera controls.  

Setting Up View of Your Scene 

Setting Up the View of Your Scene  
There are eight different views of your scene available in Bryce: Camera View, 
Director's View, and the six Orthogonal Views.  
The Camera View and Director's View let you see the scene from any perspective, while 
the Orthogonal Views let you see projections of the scene from the top, bottom, left, 
right, front, and back. 
See "Reset Views" to reset the views back to their default settings. 
To choose a view:  

1. Click the triangle icon next to the View Controls icon.  
 

 
2. Choose a view from the menu.  
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Camera View  

This view of your scene in the Working window is seen through the lens of the Camera 
object in your scene.  

 
Since your scene exists in 3D, you can view it from any vantage point: above, below, or 
even from inside an object. To see from these different perspectives, you change the 
position of the Camera. The positioning tools available in the Control palette let you 
position the Camera along specific axes and change its orientation.  
As you create and position the objects in your scene, you can use the position and 
orientation of the camera (called Camera Space) as a reference for several 
transformation operations. You can rotate, position and resize objects using Camera 
Space. 
When you've completed your scene, the Camera View can be used to create the final 
rendered image or animation. You can reposition the camera and render the scene from 
several different viewpoints.  
The camera can also be animated just like any other object. You can record changes in 
its position at different points along the timeline. When you run the animation, the view 
from your camera appears to change like the view seen from an airplane as it flies 
through a landscape. 
When you're in Camera View, a small camera icon appears in the View control.  
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To switch to Camera View, do one of the following:  
1. Click the triangle icon next to the View Control icon and choose Camera View 

from the menu.  
 

 
2. Click or Click+drag over the View Control until the Camera icon appears.  
3. If Director's View is active, click on the Director's Chair icon (Perspective Toggle) 

to switch to Camera View.  
 

 

Director's View  

Director's View lets you view your Bryce environment through the eyes of a director 
sitting outside the scene and directing the action of all the objects - including the 
camera. The camera that generates the Director's View cannot be seen or positioned 
like an object. You have to use the positioning controls to move this view. Unlike the 
Camera View, the motion of this view cannot recorded as part of an animation.  
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When you're working on a still image, you can use Director's View to get a second 
perspective on your scene. You can also render the Director's View of your image. In a 
still image, you can use both the Director's View and the Camera View to get different 
perspectives of your scene.  
The real power of the Director's View becomes obvious when you're working on camera 
animations. Animating camera motions while in Camera View (top, image) can be tricky. 
However, in Director's View (bottom, image) you can see the camera as an object, 
which means that you can set up camera motion just as you would any other object.  
When you're in Director's View, a small director's control icon appears in the Select 
Views control.  

 
To switch to Director's View, do one of the following:  

1. Click the triangle icon next to the View Control icon and choose Director's View 
from the menu.  
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OR 

2. Click or Click+drag over the View Control until the Camera icon appears.  
 

 
 
OR 

3. If the Camera View is active, click on the Camera icon (Perspective Toggle) to 
switch to Director's View.  
 

 

Orthogonal Views  

There are six other views available through the View controls, but these views are not 
generated by any camera. The views (Top, Bottom, Left, Right, Back, and Front) are 
perspective-free views of your scene called orthogonal projections. When you're using 
one of these views, you cannot use the Camera controls.  
The Orthogonal Views are another way of seeing the camera as an object in the scene. 
This can be invaluable when you're animating the camera, or setting up a complex 
scene. Using the orthogonal views, you can quickly move to different views of your 
scene. These views also let you see the camera as an object.  
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To switch to an Orthogonal View, do one of the following:  

1. Click the triangle icon next to the View Control icon and choose the Orthogonal 
View you want from the menu.  
 

 
 
OR 
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2. Click or Click+drag over the View Control until the Orthogonal View you want 
appears.  
 

 
• From Top: select this option to view a perspective-free orthogonal 

projection of your scene as seen from above (based on absolute world 
coordinates).  
 

 
• From Right: select this option to view a perspective-free orthogonal 

projection of your scene as seen from the right (based on absolute world 
coordinates). 
 

 
• From Front: select this option to view a perspective-free orthogonal 

projection of your scene as seen from the front (based on absolute world 
coordinates). 
 

 
• From Left: select this option to view a perspective-free orthogonal 

projection of your scene as seen from the left (based on absolute world 
coordinates). 
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• From Back: select this option to view a perspective-free orthogonal 
projection of your scene as seen from behind (based on absolute world 
coordinates). 
 

 
• From Bottom: select this option to view a perspective-free orthogonal 

projection of your scene as seen from below (based on absolute world 
coordinates). 
 

 

Reset Views  

To reset ALL views to their default setting, do one of the following:  
1. Click the triangle icon next to the Select Views control icon and choose Reset 

Views from the menu. 
 

 
 
or  
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2. Press the Opt/Alt key and click on the Select Views icon.  
 

 
Caution: This option reverts all views back to their original Bryce defaults and not back 
to a previous view you set earlier. Once you reset the views, you cannot undo this 
option if you selected it by accident. In order to revert back to a previous view, save the 
view in a Camera Memory Dot then click on the dot later to revert to that view.  

Camera Controls 

You can think of the view of your scene as a window to a whole new world. The view 
you see through this virtual window is determined by the orientation and position of a 
camera. As you move the camera, you get a different view of your world.  

Positioning the View of Your Scene 

When you position a view, you're affecting the location and orientation of a camera, not 
the scene itself. The scale and position of objects remains constant; only your view of 
the scene changes.  
The controls described in this section can be used to position either the Camera View or 
the Director's View. However, some controls, like the Trackball, are limited when you're 
in Camera View.  
Bryce has two sets of controls for positioning your view of the scene: the Trackball and 
the Camera Controls. The Trackball lets you adjust the position of the camera, as well 
as its orientation. The Camera Controls change the position of the camera along the X, 
Y, and axes. 
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Camera Modes  

The cameras in Bryce have four modes that affect the behavior of the Trackball: 

• Trackball 

• Center to Selection 

• Tripod 

• Free Camera 
All four of the modes are available when you're in Director's View.  

 
The only mode available in Camera View is Free Camera.  

 

Trackball Mode  

In Trackball Mode, the camera orbits around your scene. The center of the orbit, or 
origin, is the center point of a box that encompasses all the objects in your scene.  
As the size of your scene changes, so does the size of the box, which changes the 
box's center point. As a result, the center of rotation for the camera also changes as you 
change the size of your scene. In fact, in this mode the camera's center of rotation is 
constantly updated, so that it always remains in the center of the scene.  
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To change to Trackball Mode:  
1. If the Camera View is active, click on the Camera Perspective Toggle to switch to 

Director's View.  
 

 
2. If any of the Orthogonal Views are active, click on the triangle next to the Select 

Views control and choose Director's View from the menu.  
 

 
3. Click on the triangle next to the Trackball and choose Trackball from the menu.  

 

 
 
OR  

4. Double-click either the Trackball or one of the Camera Controls. The Camera & 
2D Projection dialog appears.  
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5. Click the Trackball mode button at the top of the dialog.  
 

 
6. Click on the OK icon to close the dialog.  
7. Use the Trackball to move the camera around your scene. The objects in the 

scene will remain in the center of the scene with the Director's View moving 
around the objects in a spherical orbit.  
 
If you move any of the objects so that the scene bounding box is decreased or 
increased, the view rotation will decrease or increase to match.  
 
The image below shows a sphere to give an example of where the camera will 
potentially rotate around the entire scene:  
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Center to Selection Mode  

In this mode the camera also orbits around the scene. The center of the orbit, in this 
mode, is a selected object. As the object moves, so does the camera's center of 
rotation. This mode is the best way of making sure that specific objects always remain 
in view.  
To change to Center to Selection Mode:  

1. If the Camera View is active, click on the Camera Perspective Toggle to switch to 
Director's View.  
 

 
2. If any of the Orthogonal Views are active, click on the triangle next to the Select 

Views control and choose Director's View from the menu.  
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3. Click on the triangle next to the Trackball and choose Center to Selection from 
the menu.  
 

 
 
OR  

4. Double-click either the Trackball or one of the Camera controls. The Camera & 
2D Projection dialog appears. Click the Center To Selection mode button at the 
top of the dialog. Note that the Origin fields are not available while in this mode. 
 

 
5. Click on the OK icon to close the dialog.  
6. In the scene, select the object to rotate the view around. If you don't select an 

object (or objects), then the Center to Selection mode will work like the Trackball 
Mode.  
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7. Use the Trackball to move the camera around your scene. The Director's View 

will rotate around the selected object in a spherical orbit. If you move the 
selected object, the view will move with it. 
 
You can select another object to change which object the view centers around.  
 
The image below shows a sphere to give an example of where the camera will 
potentially rotate around the selected object:  
 

 

Tripod Mode  

In Tripod Mode, the center of rotation is fixed at the center of the camera, so it actually 
pivots in place. As the name suggests, the camera acts as though it's on a tripod. It can 
rotate around, or tilt up and down, but it always remains in place.  
Use the Tripod mode in conjunction with the Eye Level Camera command to get a 
sense of height. 
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To change to Tripod Mode:  
1. If the Camera View is active, click on the Camera Perspective Toggle to switch to 

Director's View.  
 

 
2. If any of the Orthogonal Views are active, click on the triangle next to the Select 

Views control and choose Director's View from the menu.  
 

 
3. Click on the triangle next to the Trackball and choose Tripod from the menu.  

 

 
 
OR  
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4. Double-click either the Trackball or one of the Camera controls. The Camera & 
2D Projection dialog appears. Click the Tripod mode button at the top of the 
dialog.  
 

 
5. Click on the OK icon to close the dialog.  
6. Use the Trackball to rotate the camera. The Director's View will pivot around the 

current location of the Director's View camera. If you move the camera location, 
the view will move with it.  

Free Camera Mode  

In this mode the camera is completely unconstrained. Its center of rotation can exist 
anywhere, from its center to a point somewhere in the scene. Since the placement of 
the camera's center of rotation is not limited, this mode can simulate any of the other 
modes.  
For example, if you place the camera's origin point in its center, it acts as though it's on 
a tripod. Refer to "Manually Positioning the Camera" for more on positioning the 
camera's origin point.  

©2007 DAZ 3D, Inc.  353 



Bryce 6 Artist Guide 

To change to Free Camera Mode:  
1. If the Camera View is active, you are already in Free Camera Mode.  
2. To change to Director's View, click on the Camera Perspective Toggle to switch 

to Director's View.  
 

 
3. If any of the Orthogonal Views are active, click on the triangle next to the Select 

Views control and choose Director's View from the menu.  
 

 
4. Click on the triangle next to the Trackball and choose Tripod from the menu.  

 

 
 
OR  
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5. Double-click either the Trackball or one of the Camera Controls. The Camera & 
2D Projection dialog appears. Click the Free mode button at the top of the dialog.  
 

 
6. Click on the OK icon to close the dialog.  
7. Use the Trackball or Camera Controls to move the camera. The camera will 

move freely around the scene.  

Setting Camera Object Properties 

Since the Camera acts as an object, there are several object properties you can use to 
set how it's displayed, linked, or animated. 
You can hide the camera wireframe to get a better view of objects in your scene. When 
you want to change the camera properties, you can display the hidden camera 
wireframe. You can also lock the position of the camera.  
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Hiding the Camera Wireframe  

To hide the camera wireframe:  
1. Switch to Director's View or an Orthogonal View so you can see the camera's 

wireframe.  
 

 
2. Select the Camera in the Working window. 

 

 
3. Click the  icon that appears next to it. The Camera & 2D Projection dialog 

appears.   
4. Enable the Invisible option.  

 

 
5. Click on the OK icon to close the dialog. The camera will now be hidden in the 

scene.  
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Unhide the Camera Wireframe  

To display the hidden Camera Wireframe:  
1. If the Selection palette is not currently active, click the Time\Selection Palette 

Toggle at the bottom-right corner of the Working window to display the Selection 
palette.  
 

 
2. Click the triangle icon on the Selection palette and choose Select Camera. The 

camera will automatically be set to visible.  
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Locking the Camera Position  

To lock the Camera Position:  
1. Switch to Director's View or an Orthogonal View so you can see the camera's 

wireframe.  
 

 
2. Select the Camera in the Working window. 

 

 
3. Click the  icon that appears next to its bounding box. The Camera & 2D 

Projection dialog appears. 
4. Enable the Locked option.  

 

 
5. Click the OK icon to close. The camera position will now be locked so that the 

camera cannot be moved.  
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Unlocking the Camera Position 

To unlock the Camera position:  
1. Switch to Director's View or an Orthogonal View so you can see the camera's 

wireframe.  
 

 
2. Select the Camera in the Working window. 

 

 
3. Click the  icon that appears next to its bounding box. The Camera & 2D 

Projection dialog appears. 
4. Disable the Locked option.  

 

 
5. Click the OK icon to close. The camera position will now be unlocked allowing 

you to move the camera.  
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Using the Camera Axes Controls 

The Camera Axes Controls let you move the view of your scene along specific axes. 
When you're using these controls, the view does not tilt or rotate from its original 
position. It only moves up, down, back, or forward. The Camera Axes Controls affect 
your camera's location (Offset) only, not its orientation (Rotation).  
One thing to remember when using the Camera Axes Controls is that the movement 
along an axes is affected by the current camera rotation/angle so Bryce will move along 
all affected axes in order to move the required amount along the selected axes. In the 
working window, however, the scene moves in the exact direction you selected.  

 
The Camera Axes Controls are not available if you are in any Orthogonal View. When 
unavailable, these controls turn dark grey. If you are in an Orthogonal View, you must 
use the Zoom and Pan tools for navigation.  
Refer to "Orthogonality and Views" for more on these views.  
There are three Camera Axes Controls available: 

X-Y Camera Control  

The X-Y Camera control provides control for horizontal and vertical motion. The sphere 
at the center of the camera control lets you move the camera along both the X and Y 
axes. The arrows let you constrain movement either horizontally or vertically.  
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To move the camera along the X-axis:  
1. Move the mouse over the horizontal arrows on the X-Y Camera control until the 

cursor changes to an X with an arrow.  
 

 
2. Left-click-hold on the arrow and drag right or up to move the camera in the +X 

direction.  
3. Drag left or down to move the camera in the -X direction.  

To move the camera along the Y-axis:  
1. Move the mouse over the vertical arrows on the X-Y Camera control until the 

cursor changes to a Y with an arrow.  
 

 
2. Left-click-hold on the arrow and drag right or up to move the camera in the +Y 

direction.  
3. Drag left or down to move the camera in the -Y direction.  

To move the camera along the X and Y-axes at the same time:  
1. Move the mouse over the center sphere on the X-Y Camera control until the 

cursor changes to a four-way arrow.  
 

 
2. Left-click-hold on the button and drag up, down, left, or right to move the camera 

on the positive and negative X and Y-axes.  

X-Z Camera Control  

The X-Z Camera control provides control for horizontal and depth motion. The sphere at 
the center of the camera control lets you move the camera in both the X and Z-axes.  
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To move the camera along the X-axis:  
1. Move the mouse over the horizontal arrows on the X-Z Camera control until the 

cursor changes to an X with an arrow. 
 

 
2. Left-click-hold on the arrow and drag right or up to move the camera in the +X 

direction.  
3. Drag left or down to move the camera in the -X direction.  

To move the camera along the Z-axis:  
1. Move the mouse over the vertical arrows on the X-Z Camera control until the 

cursor changes to a Z with an arrow.  
 

 
2. Left-click-hold on the arrow and drag right or up to move the camera in the -

direction.  
3. Drag left or down to move the camera in the +direction.  

To move the camera along the X and Z-axes at the same time:  
1. Move the mouse over the center sphere on the X-Z Camera control until the 

cursor changes to a four-way arrow.  
 

 
2. Left-click-hold on the button and drag up, down, left, or right to move the camera 

on the positive and negative X and Z-axes.  

Y-Z Camera Control  

The Y-Z Camera control provides control for vertical and depth motion. The sphere at 
the center of the camera control lets you move the camera in both the Y and Z-axis.  
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To move the camera along the Y-axis:  
1. Move the mouse over the vertical arrows on the Y-Z Camera control until the 

cursor changes to a Y with an arrow.  
 

 
2. Left-click-hold on the arrow and drag right or up to move the camera in the +Y 

direction.  
3. Drag left or down to move the camera in the -Y direction.  

To move the camera along the Z-axis:  
1. Move the mouse over the horizontal arrows on the Y-Z Camera control until the 

cursor changes to a with an arrow.  
 

 
2. Left-click-hold on the arrow and drag right or up to move the camera in the -

direction.  
3. Drag left or down to move the camera in the +direction.  

To move the camera along the Y and Z-axes at the same time:  
1. Move the mouse over the center sphere on the Y-Z Camera control until the 

cursor changes to a four-way arrow.  
 

 
2. Left-click-hold on the button and drag up, down, left, or right to move the camera 

on the positive and negative Y and Z-axes.  
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Camera Axes Control Options  

The Camera Axes controls have options that let you move the camera to create specific 
views.  

 
To choose a Camera Axes control option, click the triangle icon next to the Camera 
Axes controls and choose an option from the menu:   

 
• Center Scene 
• Center Selection 
• Eye-Level Camera 
• Choose Camera to Director or Director to Camera to select either the Director or 

Camera View. See "Swapping Director's & Camera Views" for more on this 
option.  

• Edit Current Camera: Brings up the Camera & 2D Projection dialog that allows 
you to enter current camera information. This is the same dialog that comes up 
when you double-click on the Trackball or Camera Axes controls. Refer to 
"Positioning the Camera Numerically" for more information.  

Center Scene 

Selecting Center Scene from the Camera options menu, rotates the camera so that all 
items in your scene are centered in the Working window. This option affects only the 
camera's rotation, not its offset. If you can't see all the objects in your scene after using 
this option, try pulling your camera back a bit with one of the controls. 
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To center the scene: 
1. Create a new scene or open a scene from disk. 

 

 
2. Choose Center Scene from the Camera Options menu. 

 

 
 
The camera will move to center the scene in the camera's view. 
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Center Selection 

Selecting Center Selection from the Camera Options menu rotates your camera so that 
any selected object or objects will be centered in your view. This option does not 
reposition the object itself, only the camera's rotation relative to the selected object. 
To center the scene to the current selection: 

1. Select an object in the scene. 
 

 
2. Choose Center Selection from the Camera Options menu. 

 

 
 
The camera will move to center the selected object in the scene. 
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Eye-Level Camera 

Selecting Eye-Level Camera from the Camera Options menu repositions the camera to 
just above ground level. Use this command (especially in conjunction with the 
Trackball's Tripod mode) to create the feeling of large, looming mountains or other 
objects. This is also effective in concert with the Field of View control. 
To set the camera to eye-level: 

1. Create a new scene or open a scene from disk. 
 

 
2. Choose Eye-Level Camera from the Camera Options menu. 

 

 
 
The camera will move so that the camera is at "eye-level" or 5.12 BU above the 
ground. 
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Swapping Director's & Camera Views 

The Director’s View and the Camera View are interchangeable. So you can move the 
Camera View to the position of the Director’s View, or vice versa. 
Even though you can’t directly position the camera that produces the Director’s View in 
the Working window, you can set up a Director’s camera position by dragging the 
Camera to a position in the scene and then swapping the Camera position with the 
Director’s View position. 
To swap the Director’s View position for the Camera View position, click the triangle 
icon next to the Camera Axes controls and choose either Camera to Director or Director 
to Camera from the menu. 

 

Banking Controls  

The Banking control sphere tilts your Camera (actually rotating the camera on the Z-
axis), creating the effect of a tilted horizon. This control is great for creating tilted 
airplane cockpit views. Banking simulates a Roll action.  
Banking only works in Director's or Camera View.  
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To bank the camera,  
1. Drag the Banking control, which is located to the top left of the Camera Trackball.  

 

 
2. Drag right to bank to the right.  

 

 
3. Drag left to bank to the left. 

 

 
Press Opt/Alt+click on the Banking control to reset it to normal. The normal (default) 
setting is zero.  

Field of View Control 

The Field of View (FOV) control sphere acts like a zoom lens control. The higher the 
setting, the wider the field of view for your lens.  
Because you are admitting more information into your lens, it will create the illusion that 
objects are receding from view, or getting smaller. That is not the case. Since you're 
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admitting more information, existing objects necessarily occupy a smaller percentage of 
space within your field of view.  
If you drag the Camera control to bring your "receding" objects back up to a larger area 
in your view, perspective distortion effects appear. This is particularly effective for 
creating broad, swooping cloud scenes.  
When you view the camera in Director's View or one of the Orthogonal Views, you'll be 
able to see the camera's Field of View displayed as a 3D pyramid that extends from the 
camera wireframe. The large triangle that extends from the camera's wireframe 
represents its field of view. As the field of view changes, so does the shape of the 
triangle.  

 
By default, the camera's field of view projection is visible. 
Changing the Field of View only works in Director's or Camera View. 
To increase/decrease the Camera's Field of View, drag the Field of View control, which 
is located to the top right of the Camera Trackball.  
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• Drag right to increase the field of view.  
 

 
• Drag left to decrease it.  

 

 
• Opt/Alt+click on the Field of View control to reset to normal. The normal, or 

default, setting is 60°. 
 

 
To change the Field of View numerically, see "Set Field of View Numerically." 
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Displaying the Camera's Field of View  

To display the Camera's Field of View:  
1. Switch to Director's View or an Orthogonal View so you can see the camera's 

wireframe.  
2. Select the Camera in the Working window. 

 

 
3. Click the  icon that appears next to the camera object. The Camera & 2D 

Projection dialog appears.  
4. Enable the Show FOV option. 

 

 

©2007 DAZ 3D, Inc.  372 



Bryce 6 Artist Guide 

5. Click on the OK icon to close the dialog. The Camera Field of View will now be 
visible. 
 

 

Hiding the Camera's Field of View  

To hide the Camera's Field of View:  
1. Switch to Director's View or an Orthogonal View so you can see the camera's 

wireframe.  
2. Select the camera in the Working window.  

 

 
3. Click the  icon that appears next to the camera object. The Camera & 2D 

Projection dialog appears.  
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4. Disable the Show FOV option.  
 

 
5. Click on the OK icon to close the dialog. The Camera Field of View will now be 

hidden. 
 

 

Using the Trackball  

The Trackball lets you rotate the camera around its origin point. The position of the 
origin depends on the Camera mode you select. 
Refer to "Camera Modes" for more on these modes.  
The Trackball doesn't rotate the scene, it only changes the camera's location (Offset) 
and orientation (Rotation) relative to your scene.  
To move the camera using the Camera Trackball: 

1. Move the cursor over the Camera Trackball control. The cursor will change to a 
cross with arrows on each end.  
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2. Left-click-hold and drag the mouse over the Camera Trackball control. The 
Camera Trackball control will turn a darker grey and as you drag the mouse, the 
view of your scene moves in the direction you drag.   
 

 

Positioning the Camera 

The most precise way of positioning the view of your scene is by using the Camera & 
2D Projection dialog. This dialog lets you enter values to set the camera position, the 
position of the camera's origin point, rotation, and field of view. The dialog can be used 
to adjust either the Camera View or the Director's View. When you display the dialog, 
you can see the numerical position of the camera and the position of its origin point. 
You can also see the active Camera Mode.  
There are different options available in the dialog depending on whether you're in 
Camera View or Director's View. When you're in Camera View, the only Camera Mode 
available is Free Camera. In addition, the Origin fields are only available if you're using 
Free Mode.  
Since the camera is an object, there are several more controls available when you're in 
Camera View. These controls let you set linking and animation options. Refer to 
"Camera Modes" for more information. 
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Position Camera Numerically  

To set the position of the camera numerically:  
1. To position the Director's View camera, double-click either the Trackball or one of 

the Camera controls. The Camera & 2D Projection dialog appears.  
 

 
2. To position the Camera View camera, select the camera and click on the  icon 

next to the selected camera. The Camera & 2D Projection dialog appears. Make 
sure the General tab is active before continuing. 
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3. Enter values in the Position X, Y, and fields. You can enter negative values here.  
 

 
4. Click on the OK icon to exit the dialog. 

Technically, since the Bryce environment is infinite, the range is infinite as well, but 
higher values can create unpredictable results.  
The default values are 102.40, 30.72, and 102.40, respectively for the Director's View 
camera and -102.40, 30.72, 102.40, respectively for the Camera View camera.  
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Rotate Camera Numerically  

To rotate the camera numerically:  
1. To rotate the Director's View camera, double-click either the Trackball or one of 

the Camera controls. The Camera & 2D Projection dialog appears.  
 

 
2. To rotate the Camera View camera, select the camera and click on the  icon 

next to the selected camera. The Camera & 2D Projection dialog appears. Make 
sure the General tab is active before continuing 
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3. Enter values in the Rotate X, Y, and Z fields. Values are expressed in degrees. 
X, Y, and Z rotations are also known as Yaw, Pitch, and Roll. The rotation, or 
Roll field, displays the current value for the Banking control. You can enter 
negative values in these fields. The effective range is +/- 99. The default values 
for the Director's View camera are 0, -45, and 0°, respectively while the default 
values for the Camera View camera are 0, 135, and 0°, respectively. 
 

 
4. Click on the OK icon to exit the dialog.   
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Set Field of View Numerically  

To set the Field of View (FOV) numerically:  
1. To set the FOV for the Director's View camera, double-click either the Trackball 

or one of the Camera controls. The Camera & 2D Projection dialog appears.  
 

 
2. To set the FOV for the Camera View camera, select the camera and click on the 

 icon next to the selected camera. The Camera & 2D Projection dialog appears. 
Make sure the General tab is active before continuing 
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3. Enter a value in the Field of View field (FOV). The value in this field, expressed in 
degrees, describes current settings for the Field of View control. The effective 
range is 1 to 180°, and the default value is 60°.  
 

 
4. Click on the OK icon to exit the dialog. 

Position Camera Manually  

You can manually position the camera by adjusting the position of the camera 
wireframe in the Working window. The camera wireframe is visible only when you're in 
Director's View or one of the Orthogonal Views.  
In the Director's View or an Orthogonal View, you will see a blue Camera wireframe, 
which represents the location of your Camera. You can then drag the Camera 
wireframe to change the Camera position. The Nano-Preview updates to reflect your 
changes.  
There are two ways to manually position the camera: 

• Select the camera an drag it to a new location 
• Change to Camera View and use the Camera Controls to move the camera 
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To manually position the Camera by dragging:  
1. Change to the Director's View or one of the Orthogonal Views.  
2. Click on the Camera wireframe to select it. 

 

 
3. Left-click-hold on the camera and drag it to the new position. 

 

 
To manually position the Camera by using the Camera Controls:  

1. Change to the Director's View or one of the Orthogonal Views.  
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2. Click on the Camera wireframe to select it. 
 

 
3. Select Camera View from the View Controls Options. 

 

 
 
The view will now switch to the view from the camera. 
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4. Use the Camera Axes Controls and the Trackball to move the view of the scene. 
Since the camera is selected, you are actually moving the camera around in the 
view. 
 

 
5. View the scene from the Director's View to see how the camera has moved. 

 

 

Camera Origin Point 

In its default state, the Camera's Origin Point is not visible and is located at its center. 
When the Camera's Origin Point is visible, it appears as a green dot in the center of the 
camera's wireframe.  

 
You can simulate any of the camera modes by dragging the Camera's Origin Point to 
different locations in the scene:  

• If you position the origin point in the center of the scene, the camera acts as 
though it's in Trackball mode. When you rotate the camera, it moves around the 
origin point.   
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• If you position the origin point over an object in the scene, it acts as though it's in 
Center to Selection mode. When you rotate the camera object, it will pivot around 
the object under the origin point.   

• If you leave the origin point positioned at the center of the camera object, it acts 
as though it's in Tripod mode.  

Once you offset the origin point, all the camera's movements will be altered. If you offset 
the origin point, then switch to Camera View, the camera may not move as expected. 

Display Origin Point  

To display the Camera's Origin Point:  
1. Switch to one of the Orthogonal Views or Director's View so you can see the 

camera wireframe.   
2. Click the camera wireframe to select it.  

 

 
3. Click the  button that appears next to the camera's wireframe. The Camera & 

2D Projection dialog appears.  
4. Click the General tab and enable the Show Origin Handle option.  

 

 
5. Click on the OK icon to accept the changes. The Camera's Origin Point will now 

be visible. 
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Position Origin Point Numerically  

To position the camera's origin point numerically:  
1. To position the origin of the Director's View camera, double-click either the 

Trackball or one of the Camera controls. The Camera & 2D Projection dialog 
appears. Note that if in Trackball, Center to Selection, or Tripod mode, the Origin 
fields for the Director's camera are not active. 
 

 
2. Select the button next to the Free mode, if needed to enable the Origin fields.  
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3. To position the origin of the Camera View camera, select the camera and click on 
the  icon next to the selected camera. The Camera & 2D Projection dialog 
appears. Make sure the General tab is active before continuing. 
 

 
4. Before you can move the origin point, you will need to unlock the link between 

the Origin fields and the Position fields. If you change the Origin values while 
they are linked, you will be moving the camera and the origin point which defeats 
the purpose. 
 
Click on the red padlock icon next to the Origin and Position fields. 
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The icon will change to a gray padlock with the shackle open. 
 

 
 
You can now change the Origin values without moving the camera. 

5. Enter values in the Origin X, Y, and fields.  
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6. Click on the OK icon to exit the dialog. The new Origin Point location can be seen 
in the scene. Note that if you changed the Origin of the Director's Camera, then 
you will not see anything different until you actually try to move the camera. 
 

 
To reset the camera's origin point, hold down Shift and click the origin point or enter the 
Camera & 2D Projection dialog, unlock the padlock, set the Origin values to match the 
Position values, click on the unlatched lock to lock the fields, then click on OK to exit the 
dialog. 

Position Origin Point Manually  

To position the Camera's Origin Point manually:  
1. In the Camera & 2D Projection dialog, display the Camera's Origin Point.  
2. Move the mouse over the camera origin point. The cursor changes to a four-way 

arrow.  
 

 
3. Drag the green point to a location in the scene.   

 

 
To reset the camera's origin point, hold down Shift and click the origin point.  
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Aiming the Camera  

The only problem with positioning the Camera using the Orthogonal or Director's View is 
that the view from the Camera remains fixed as you adjust its location, so you may 
inadvertently lose the objects you were looking at when the position of the Camera 
changes.  
When you look at the Camera as an object, you'll see that there is a control handle 
extending from the front of the object. This handle represents the Camera's current aim. 
By dragging this handle to a point in your scene, you can change the Camera's aim.  

 
When you change the aim of the Camera, it rotates to face the new target, but remains 
in the same position.  
To change the Camera's aim in an orthogonal view:  

1. In the Working Window, click the triangle icon next to the View Control and 
choose top, left, right, bottom, front, or back from the menu.  
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2. Move the cursor over the end of the control handle. The cursor changes to a 
four-way arrow.  
 

 
3. Drag the end of the control handle to the point in you scene where you want the 

camera to aim. As you drag, the end of the handle changes to a red dot so you 
can see the aiming point better. 
 

 
4. When the camera is pointing in the right direction, let up on the mouse. The 

control handle will revert to its default size and the camera will be pointing in the 
direction you selected.  
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Render Controls 

Once you've selected the rendering options you want to use and chosen a rendering 
mode, you're ready to start rendering. You render your entire image using the Render 
Controls or use the Plop Render Controls to render areas of your image.  
The Render Controls let you start and resume a rendering of your image. There are 
controls for enabling two types of fast renders. Use the Render Controls to control the 
rendering of your scene.  

 

Render All  

To start a rendering of the entire scene, click the Render All button or press 
Cmd/Ctrl+R. If you have already rendered any portion of your scene but not changed 
anything in the scene itself, the render will start where it left off earlier. If any settings 
were changed after stopping the render, this will start the render over from the top.  

 
You can interrupt any rendering by clicking the mouse anywhere in the Working 
window.  
Please note that when rendering to screen, you may experience reduced multi-tasking 
capabilities due to the way Bryce uses CPU time during rendering. You may want to 
reduce using other programs while rendering to screen, specifically during the anti-
aliasing portion.  
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Resume Render  

To resume a rendering, click the Resume Render control or press Cmd/Ctrl+R . If any 
settings were changed after stopping the render, this will start the render over from the 
top.  

 
You can interrupt any rendering by clicking the mouse anywhere in the working window.  

Clear and Render  

To restart a rendering from the top, click the Clear and Render control or press 
Cmd/Ctrl+Opt/Alt+R. This control restarts a render of the scene or any selected region.  
Refer to "Plop-Render Mode" for more on rendering regions.  

 
You can interrupt any rendering by clicking the mouse anywhere in the Working 
window.   

Preview Rendering 

Preview Render Modes are accessed using the Render Controls or the Render Options 
dialog and provide lower quality renders that you can use to preview your image.  
There are two Preview Render Modes: Textures On/Off and Fast Preview. 
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Fast Preview  

When Fast Preview Mode is enabled, the render engine ignores areas of low frequency 
and only ray-traces areas of high frequency. This results in accelerated renders that are 
great for previewing during a session. However, it also results in some patchiness in 
certain mid-frequency areas, so it should not be used for final output.  

• To enable Fast Preview Mode, click the Fast Preview button in the Render 
Controls.  

• When the button turns a silvery green, the mode is enabled. 
 

 
• When the button is light green, the mode is off.  

 

 
• Alternatively, click the triangle beside the Render Controls and choose Render 

Options from the menu.  
 

 
• Select the Preview Render option to enable Fast Preview Mode; select the Full 

Render option to disable it.  
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Textures On/Off  

When this mode is enabled, all textural parameters are disabled, including textures in 
the Materials Library and Materials Lab.  

 
This mode performs the following procedures to speed up a render:  

1. Objects with properties like transparency, reflection, and bumpy textures are 
rendered in flat opaque shades.   

2. Fog, Haze and Clouds are disabled.  
3. Any item with a procedural texture is rendered with a color drawn from the 

ambient color channel in the Materials Lab.  
4. Any item with a simple color texture is rendered in that color. The Textures 

On/Off mode is available in any mode.  
• To enable Textures On/Off mode, click the Textures On/Off button in the Render 

Controls.  
• When the button turns a silvery green, the mode is enabled.   

 

 
• When the button is green, the mode is disabled.  
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• Alternatively, click the triangle beside the Render Controls and choose Render 
Options from the menu.  
 

 
• Click on the radio button/checkmark next to Render With Textures to enable the 

Textures Off mode.  
 

 
• Click the radio button next to Render With Textures to enable the Textures On 

mode.  
 

 

Render Options Menu 

Bryce offers a number of options and controls that let you control rendering. As you 
work on a scene, you can use settings that produce fast renders. When you're ready to 
produce your final image, you can choose settings that produce the highest quality 
image.  
The Render Options menu is available by clicking the triangle to the right of the Render 
Controls.  
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Once you click on the triangle the menu comes up.  

 

Render Quality  

The Render Quality options let you control the quality of the rendered image by setting 
the level of anti-aliasing. Anti-aliasing removes the jaggies on the edges of objects 
within the image. In Bryce, Anti-aliasing is performed using a super-sampling method. 
This means that for every pixel that's ray-traced, more than one ray is used to determine 
the pixel's color. The increase in rays increases the quality of the ray-traced object and 
the render time as well.  
Anti-aliasing can greatly improve the quality of your image, but it is time-consuming. It 
can also eliminate some desired roughness from high frequency textures. Anti-aliasing 
is performed on the last pass of the rendering process.  
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There are four quality modes available in Bryce:  

• Default 

• Regular 

• Super 

• Premium 
To set the quality mode:  

• Click the triangle icon beside the Render controls, point to Quality, and choose a 
quality mode from the menu.  
 

 
• Alternately, click the triangle icon beside the Render controls and click Render 

Options. 
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• Click one of the quality modes at the top-left corner of the dialog, then click on 
the OK icon to exit the dialog.  
 

 

Default (No Anti-Aliasing) 

In this mode there is no Anti-Aliasing performed on the image. In the image below, you 
can see jagged edges around the sphere and around some of the spots.  

 
To turn on default render quality:  

• Click the triangle beside the Render Controls, point to Quality and select the 
Default (No AA) quality mode.  
 

 
To turn on default render quality using the Render Options dialog:  
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1. Click the triangle beside the Render Controls and click Render Options. 
 

 
2. Select the Default (No Anti-Aliasing) quality mode.  

 

 
3. Click on the OK icon to exit the dialog.  

Regular (Normal Anti-Aliasing)  

In this mode, after the image is rendered, Bryce scans the entire bitmap to determine 
which areas require anti-aliasing. Only the areas of high concentration are anti-aliased.  

 
To turn on regular render quality:  

• Click the triangle beside the Render controls, point to Quality and select the 
Regular (Normal AA) quality mode.  
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To turn on default render quality using the Render Options dialog:  

1. Click the triangle beside the Render controls and click Render Options.  
 

 
2. Select the Regular (Normal Anti-Aliasing) quality mode.  

 

 
3. Click on the OK icon to exit the dialog.  

Super (Fine Art Anti-Aliasing)  

In this mode, you can control the number of rays Bryce uses to trace every pixel in the 
image. Higher values produce a higher quality image, but can slow down the entire 
rendering process. You should probably only use this mode to render showcase type 
artwork - not normal working images.  
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To turn on super render quality:  
• Click the triangle beside the Render controls, point to Quality and select the 

Super (Fine Art AA) quality mode.  
 

 
To turn on default render quality and set the number of rays per pixel using the Render 
Options dialog: 

1. Click the triangle beside the Render controls and click Render Options.  
 

 
2. Select the Super (Fine Art Anti-Aliasing) quality mode.  

 

 
3. Click the triangle beside Rays per pixel and choose a value from the pull-down 

list. The default value is 16. 
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4. Click on the OK icon to exit the dialog.  

Premium (Effect Anti-Aliasing)  

In this mode, you can use a variety of premium effects, such as Soft Shadows, Blurry 
Reflections, Blurry Transmissions, True Ambience, and Depth of Field.  
Premium effects include:  

• Soft Shadows 

• Blurry Reflections 

• Blurry Transmissions 

• True Ambience 

• Depth of Field 
To turn on premium effects from the Render Options menu:  

1. Click the triangle beside the Render controls, point to Quality and select the 
Premium (Effect Art AA) quality mode.  
 

 
2. Click the triangle beside the Render controls again to select a premium effect. All 

effects can be selected at the same time.  
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To turn on premium effects, set the number of rays per pixel, and select a premium 
effect using the Render Options dialog:  

1. Click the triangle beside the Render controls and click Render Options.  
 

 
2. Select the Premium (Effect Anti-Aliasing) quality mode.  
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3. Click the triangle beside Rays per pixel and choose a value from the pull-down 
list. The default value is 64 for Premium effects.  
 

 
4. Select a premium effect.  

 

 
5. Click on the OK icon to exit the dialog. 

Soft Shadows  

When you adjust the softness of a shadow, you blur or sharpen the shadow's edges. 
Soft shadows blend more smoothly with the background.  
To enable Soft Shadows when rendering using the Premium Quality Mode:  

1. In Render Options, enable the Premium Quality mode, then enable Soft 
Shadows.  
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2. Ensure that Shadows is enabled under the Optics options. If this option is not 

selected, then shadows will not render.  
 

 
3. Click on the OK icon to close the dialog.  
4. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
5. Click the Sky Lab button. The Sky Lab appears.  

 
 

6. Click the Sun & Moon tab.  
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7. Enable the Sun/Moon Shadows option. If this option is not selected, then the 
objects in the scene will not cast any shadows.  
 

 
8. Enable the Soft Shadows option.  

 

 
9. Click the OK icon to exit the dialog.  
10. Render the scene.  

Examples:  
• Soft Shadows disabled:  

 

 
• Soft Shadows enabled:  

 

 

©2007 DAZ 3D, Inc.  407 



Bryce 6 Artist Guide 

• Difference between Soft Shadows with Normal AA and with Premium AA:  
 

 

Blurry Reflections  

Blurry Reflections blurs reflections in glass, metal, and other reflective surfaces.  
To enable Blurry Reflections when rendering using the Premium Quality Mode:  

1. In Render Options, enable the Premium Quality mode, then enable Blurry 
Reflections.  
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2. Ensure that Reflections is enabled under the Optics options. If this option is not 
selected, then reflections will not be rendered.  
 

 
3. Click on the OK icon to close the dialog.  
4. Render the scene.  

Examples:  
• Blurry Reflections disabled:  

 

 
• Blurry Reflections enabled:  

 

 

Blurry Transmissions  

Blurry Transmissions blurs the transmission of light, for example, when light passes 
through frosted glass. 
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To enable Blurry Transmissions when rendering using the Premium Quality Mode:  
1. In Render Options, enable the Premium Quality mode, then enable Blurry 

Transmissions.  
 

 
2. Ensure that Transmissions is enabled under the Optics options.  

 

 
3. Click on the OK icon to close the dialog.  
4. Render the scene.  
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Examples:  
• Blurry Transmissions disabled:  

 

 
• Blurry Transmissions enabled:  

 

 

True Ambience  

True Ambience computes the ambient light for a surface using the color and intensity of 
nearby surfaces, resulting in color blending from one surface to another.  
To enable True Ambience when rendering using the Premium Quality Mode:  

1. In Render Options, enable the Premium Quality mode, then enable True 
Ambience.  
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2. Click on the OK icon to close the dialog.  

Render the scene.  
Examples:  
True Ambience disabled  
 

=  
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True Ambience enabled  
 

 

Depth of Field  

Depth of Field (DOF) lets you focus the camera on a particular object, blurring those 
closer and further away from the camera's focal point. You can control the Lens Radius 
and Focal Length numerically or you can have Bryce calculate these values based on a 
selected object.  
The Lens Radius determines how much or little of the scene is rendered with DOF. The 
larger this number, the more of the scene is blurred. The default Bryce Lens Radius is 
0.10 which is usually too large for most renders. You'll probably find that 0.01 or 0.02 is 
more than enough DOF.  
Focal Length determines the focus of the DOF - what the camera focuses on. You can 
set the focal length automatically by selecting an object and clicking on Set To Current 
Selection. To set the focal length manually, you need to determine how far the object is 
from the current camera.  

Set Focal Length Automatically  

To set the focal length automatically:  
1. Before entering the Render Options dialog, select an object or group in the scene 

to be the focus of the scene.  
2. Click the triangle beside the Render Controls and click Render Options.  
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3. In Render Options, enable the Premium Quality Mode, then enable Depth of 
Field.  
 

 
 
(Note: if the final render is too grainy, increase the Rays per pixel.)  

4. To set the Lens Radius, enter a value in the Lens Radius field. Remember that 
the larger this number is, the more of the scene will be blurred.  
 

 
5. To set the Focal Length automatically click on the Set To Current Selection 

button. The Focal Length field will change based on the currently selected object. 
Make sure you have an object or a group selected before selecting this.  
 

 
6. To set the Focal Length manually, refer to "Setting Focal Length Manually."  
7. Click on the OK icon to close the dialog.  
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Examples:  
• Depth of Field disabled:  

 

 
• Depth of Field enabled, set to current selection (ladybug):  

 

 

Set Focal Length Manually  

To set the focal length manually (best if you have one than one object as the focal 
point):   

1. Before entering the Render Options dialog, make sure that the perspective 
camera is the current camera. If using the Director's Camera as the main view, 
click on the triangle next to the camera controls and choose Camera to Director 
from the Camera Options menu.  
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2. Change the camera view to the top view (press the 2 key) and center the scene 

in the view.   
3. Create a cube, resize it along one axis, and rotate the cube until it lines up 

between the camera and the focal object/point. Continue resizing the cube until 
one end is at the center of the object/point and the other is at the tip of the 
camera focus.  
 

 
4. Click on the  button next to the selected cube and note down the size of the 

side you resized. In this case, 102.2. 
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5. Click the triangle beside the Render Controls and click Render Options.  
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6. In Render Options, enable the Premium Quality Mode, then enable Depth of 
Field.  
 

 
7. To set the Lens Radius, enter a value in the Lens Radius field. Remember that 

the larger this number is, the more of the scene will be blurred.  
 

 
8. Enter the cube length you noted earlier into the Focal Length field.  

 

 
9. Click on the OK icon to close the dialog.  
10. Render the scene.  

One caveat here is that as an object moves further from the camera, the focal point that 
Bryce uses shifts from the object center to the edge of the object nearest the camera. 
You can check this out by selecting each object and setting the Focal Length 
automatically, then using a cube to check the distance between the camera and object.  
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This is also helpful for finding what the focal length would be between two objects or in 
the middle of a wasteland. 

 

Depth of Field Examples  

Focal point of sphere 1 (closest to camera):  
• Lens Radius = 0.50  

 

 
• Lens Radius = 0.10 
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• Lens Radius = 0.05 
 

 
• Lens Radius = 0.01  

 

 
Random focal point:   

• Lens Radius = 0.02, Focal Length = 200  
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• Lens Radius = 0.10, Focal Length = 300   
 

 
• Lens Radius = 0.10, Focal Length = 400 

 

 
• Focal point of Sphere 5 (furthest from camera), set manually using a resized 

cube:  
 

 

Turn AA Off for Single Object or Group  

Sometimes a particular object or group needs to have the Anti-Aliasing turned off while 
leaving the rest of the scene with the AA turned on. This is especially useful for rocks or 
areas with grass and dirt that look better with no AA.  
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To turn off AA for a single object or group:  
1. Select the object or group.   
2. Click the  button next to the object/group. The Object Attributes dialog will come 

up.  
3. Press Ctrl+Shift+Alt and click on the OK icon in the Object Attributes dialog.  

 

 
4. Render the scene. The object with the AA turned off will have rougher edges 

than other objects. 
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Turn AA On for Single Object or Group  

To turn AA back on for a single object or group:  
1. Select the object or group. 
2. Click the  button next to the object/group. The Object Attributes dialog will come 

up.  
3. Press Shift and click on the OK icon in the Object Attributes dialog. 

 

 
4. Render the scene. The object/group will render more smoothly. 
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General Render Options  

The General Render Options provide an alternate method of turning the Plop Render 
and Textures On or Off.  

• Full Render - turns Fast Preview off  
• Preview Render - turns Fast Preview on  
• Render With Textures - Turns Textures on or off  

 
See "Preview Rendering" for more on these options. 

Optimizations  

Bryce includes several optimization options. These options change the mathematical 
algorithm used by Bryce to ray-trace your image depending on the contents of your 
scene. There are two types of optimization: BSP and Grid, and each has three levels of 
optimization to choose from.  
There are three Levels of Optimization to choose from for each of the above 
optimization types:  

• Minimal: This mode is best used for very simple scenes with less than five 
objects. In this mode, Bryce predetermines the areas where your objects reside 
and shoots rays only through that area.  

• Normal: This is the best mode for most scenes. In this mode, Bryce determines 
where your objects reside and then examines the concentration of objects within 
the larger area. This eliminates the computation of unnecessary rays.  

• Aggressive: This is a more extreme version of Minimal mode. It is best used for 
complex scenes with localized concentrations of objects. If you have imported 
DXF objects in your scene, this mode will speed up rendering considerably. 
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To set Optimization Options:  
1. Either click the triangle icon next to the Render Controls, choose Optimization 

from the menu, then the optimization type (BSP or Grid) and level.  
 

 
 
OR 

2. Click the triangle beside the Render Controls and click Render Options.  
 

 
3. Choose an optimization type and level from the Render Options dialog.  

 

 
4. Click on OK to close the dialog.  
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Render Priority 

New in Bryce 6.1 is the option to set the render priority on systems with multiple 
processors. 
To set the render priority, click the triangle icon next to the Render Controls and Priority, 
then Low, Normal, or High. The default setting is Normal.  
 

 
This allows you to determine whether Bryce runs at maximum capacity or at a more 
restrained rate to allow you to more easily work with other CPU intensive applications at 
the same time. With this feature, you can have Bryce 6.1 run 170% faster than under 
Rosetta.  
If you only have a single processor, then you will not have this option available. 
Render Options Dialog 
The Render Options Dialog provides access to most of the render settings plus options 
to set the premium and optic effects. 
To access the dialog, click the triangle icon next to the Render Controls and choose 
Render Options from the menu. 

 
The Render Options dialog will come up. 
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Setting Post-Processing Options  

Bryce includes two post-processing options to compensate for the differences between 
viewing images on a computer display and on paper.  

• 48 Bit Dithering: Helps you work around the limitations of computer displays. It is 
a process that allows you to avoid color bands by smoothing. Evening skies or 
moon rings are good candidates for this option. 

• Gamma Correction: Allows Bryce to compensate for some of the shortcomings of 
computer displays. Your images will be brighter and contain colors that are more 
true to nature. For many images, however, Gamma Correction will more than 
likely wash out your image more than you like, so if the image seems faded or 
washed out, turn off Gamma Correction and re-render.  

To set post-processing options:  
1. Either click the triangle icon next to the Render Controls and click the desired 

post-processing option  
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OR  

2. Click the triangle icon next to the Render Controls and choose Render Options 
from the menu, and   
 

 
3. Enable the desired post-processing options from the Render Options dialog.  

 

 

Render Reporting  

This option, when selected, produces a summary report when your image is finished 
rendering.  
The report tells you how long the render took, including the anti-aliasing pass. It also 
provides statistics on how many rays were shot to create the image and breakdowns for 
the different types of rays, including a per-pixel breakdown.  
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To produce a render report, do one of the following: 
1. Click the triangle beside the Render Controls and choose Report Render Time.  

 

 
 
OR 

2. Choose File > Document Setup and enable Report Render Time in the dialog. 
 

 
3. Once you've selected to report the render time, start your render. At the 

completion of the render, you'll hear a short beep and the render report will be 
visible in the working window.  
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4. Close the report by clicking on the OK icon.  

Projection Types  

There are two projection types available in Bryce:  
Perspective Projections: Renders a fully ray-traced color image, based on your current 
camera's position and view.  
360° Panorama Projection: Produces an image that looks as if your camera has a 360° 
lens. The left and right edges of the resulting image join seamlessly. 360° Panorama 
Projection is intended for use with the Bryce 360° scrolling screensaver, or QuickTime™ 
VR technology. 

Perspective Projection  

Perspective Projection is the default rendering mode for Bryce. Unless you are 
rendering a panoramic image, this option should be selected.  
To select Perspective Projection from the Render Options menu:  

• Click the triangle beside the Render Controls and select the Perspective 
Projection.  
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To select Perspective Projection using the Render Options dialog:  
1. Click the triangle beside the Render Controls and select Render Options.  

 

 
2. Select the Perspective Projection mode.  

 

 
3. Click on the OK icon to exit the dialog.   

360° Panorama Projection  

Rendered 360° images will have little resemblance to the wireframe working window 
behind it; this makes flipping back and forth between wireframe and bitmap modes 
during composition fairly difficult. For this reason, it is recommended that you work in 
standard Perspective Render mode as you compose your image.  
For a good 360° panoramic image, you need a natural distribution of objects on all sides 
of the camera.  
To render a QuickTime VR Panorama, see "Creating Quicktime VR Panoramas." 
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To prepare a 360° panoramic render:  
1. While in Perspective Render mode, switch to the Top view using the View 

Controls and position objects around the camera.  
 

 
2. Display the Document Setup dialog using File > Document Setup and either 

select the Panorama preset aspect ratio or type in the dimensions that you want. 
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3. The image below shows the dimensions for the default Panorama render:  
 

 
4. Do a quick test render in Perspective Render mode to check composition. 

Render from different views as needed. 
 

 
5. The horizon should be level at the vertical midpoint of your window. If it is not, 

double-click the Trackball, enter "0" in the Rotate X field and exit the dialog.  
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6. Adjust your camera position and Y-rotation as needed.  
7. When you are ready to render, click on the triangle next to the Render Controls 

and choose 360 Panoramic Projection from the menu.  
 

 
 
OR  
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8. You can also select the panoramic render by clicking the triangle beside the 
Render Controls and selecting Render Options.  
 

 
9. In the Render Options dialog, click on the button next to 360 Panorama 

Projection. Note that when this option is selected, the mask options are not 
available.  
 

 
10. Click on the OK icon to close the dialog.  
11. Render the scene and when the render is complete, save the image.  

 

 

Creating Quicktime VR Panoramas  

QuickTime VR allows you to take a 360° panoramic image, and make it into a VR 
Movie; this unique movie will display a 2D panoramic representation of your 3D world, 
and allow point and click navigation through the world. You can look up, down and 
around your rendered scene as though you were a camera on a tripod.  
Further, QuickTime VR lets you create "Nodes," or hotspots in the movie where you can 
click and go to another linked movie. This means you can look around a landscape, and 
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seeing an interesting rock formation in the distance, click on it to view the entire 
landscape from that new vantage point.  
These nodes can also contain "Object Movies;" another specialized technology from 
Apple that allows you to click and drag to, in effect, "pick up" any object in the VR movie 
and examine it from all sides, as if you literally picked it up and turned it around and 
around in your hands.  
The process of creating a panorama involves completing a few easy steps.  
To create QuickTime VR Panoramas:  

1. Choose Default in the Document Setup dialog.  
2. Click on the uppermost Views Memory Dot in the control palette, to make sure 

your camera is level.   
3. Set up your scene. The important thing to remember is that for a successful 360° 

scene, you need interesting objects all around your camera. The best way to 
work on this is to go to the Top View, and position objects all the way around the 
camera.  

4. Keep the Nano-Preview in Camera View mode to check your view while you are 
working in Top View.  

5. Drag the tip of the camera around in the Working window to check the view of 
your scene from all directions.   

6. Once you have a good distribution of objects in a visually interesting scene, 
switch back to Camera View and do a quick test render.   

7. After the render, make any required position changes.  
8. Choose File > Document Setup and select QTVR Panorama. This aspect ratio is 

optimized for use with Apple's Make QTVR Panorama tool, though many aspects 
will work. The preferred aspect is 13:Width must be divisible by 96, and height 
must be divisible by The QTVR Panorama option ensures that your image meets 
these criteria.  

9. Click the triangle icon next to the Render Controls and choose 360° Panorama 
from the menu.  

10. Click the Render button to do a quick test render. The panoramic render mode 
necessarily introduces some distortion into your image, and this may change the 
way you want your objects to appear. 

11. Make any position changes you like. When you do a panoramic render, your 
wireframe scene will bear little resemblance to the rendered scene. This is why 
you should work on your scene in standard Default mode and switch to 
Panoramic rendering after everything is set up.  

12. Choose File > Render To Disk. The Render to Disk dialog appears.   
13. Leave the default settings. The Output Size in Pixels was set by the QTVR 

Panorama option in the Document Setup dialog. The Print Resolution defaults to 
72dpi, which is the only acceptable setting for the screen-resolution VR movies; 
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and the Output Size in Inches is extra information. You can, however, use these 
features to your benefit if you need to print out a 2D version of your VR scene. 

14. Click the OK icon.  
15. In the Save dialog, choose QuickTime VR, then click the Save button.  
16. Specify the location and file name for your rendered QuickTime VR panorama.   

To export a QuickTime VR Panorama:  
1. Follow the steps above through step 11.  
2. Click the Render button if you made any changes after your test render.   
3. When the rendering is done, choose File > Export Image and choose QuickTime 

VR from the list.  
4. Specify a location for the saved panorama, then click Save.  

Further VR Exploration  

This is a quick way to get started with simple, single-node QTVR movie-making. To 
create movies with other embedded nodes, or to get deeper into the world of QuickTime 
VR, contact Apple Computer.  

Masking Modes  

Bryce offers several rendering modes that can be used to create different effects. For 
example, the Mask Render Mode lets you produce an image that can be used as an 
Alpha Channel in other graphics applications. 
To choose a mask mode, either click the triangle icon next to the Render Controls and 
choose a mask mode from the menu or click the triangle icon next to the Render 
Controls, click Edit Rendering, and choose a mask mode from the Render Options 
dialog.  
There are three different kinds of Mask Render Modes for rendering available in Bryce:  

Object Mask  

In Object Mask mode, Bryce renders any selected objects as anti-aliased white shapes 
against a black background. You can use the resulting image as a mask or alpha 
channel in other 2D image editing programs.  
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To render an object mask:  
1. Render the scene by rendering to screen or disk or as an animation. 

 

 
2. Select the object(s) or group(s) you want to mask out of the scene. 

 

 
3. Click on the Render Options triangle next to the Render Controls and choose 

Object Mask from the menu. 
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Alternately, you can select the Object Mask option from the Render Options 
dialog.  

• Click on the Render Options triangle next to the Render Controls and 
choose Render Options from the menu. The Render Options dialog will 
come up.   
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• Enable the Object Mask option under Projection & Masking. 
 

 
4. Render the scene. The selected object(s) or group(s) will render as white, with 

the non-selected objects and rest of the scene rendering as black.  
 

 
5. Save the mask render to disk.   
6. Open the original Perspective render and the mask render in your favorite paint 

program.  
7. Consult the Help file for the paint program on creating Alpha Channels from 

images and apply the mask as an alpha channel in the Perspective render. 
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Invert the alpha channel if needed. 
 

 
8. Once the mask has been applied as an Alpha Channel, modify the image as 

needed using the image and mask layers to select which sections to modify.  
 

 
 
The final example image:  
 

 

Distance Mask  

This mode results in a grayscale image, with objects represented in shades of gray 
based upon their distance from the camera. Nearby objects are black, distant objects 
are white, and objects in between are progressive shades of gray. You can use the 
Distance Mask image to produce depth-of-field effects using a 2D graphics application. 
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This mode can be used to create several distance effects. 
Distance Mask Render mode produces an image that can be used as a distance mask 
in most image-editing applications. The Distance Render image contains grayscale 
representations of all the images in your scene. Objects closer to the camera appear 
black, while those furthest away appear white. The objects in between are various 
shades of gray depending on their distance from the camera. 
This grayscale information can be used to create photographic depth of field effects. For 
example, if you take an image that has a lighthouse in the foreground and a fishing 
village in the background and render it using Distance Mask Render mode, you can 
take the image into Photoshop and create an image where the lighthouse is in sharp 
focus while the village is blurred. 
Do this by rendering the image as distance mask, using Distance Mask Render mode, 
and then using an image editing application to place the distance mask into the original 
image's alpha channel. Once the Distance Render is in the alpha channel, you can 
apply filters to create photographic depth of field. 
To render a scene as a distance mask: 

1. Render the scene by rendering to screen or disk or as an animation. 
 

 
2. Click on the Render Options triangle next to the Render Controls and choose 

Distance Mask from the menu.  
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Alternately, you can select the Altitude Mask option from the Render Options 
dialog.  

• Click on the Render Options triangle next to the Render Controls and 
choose Render Options from the menu. The Render Options dialog will 
come up. 
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• Enable the Distance Mask option under Projection & Masking. 
 

 
3. Render the scene. The scene will render in grayscale. 

 

 
4. Consult the Help file for the paint program on creating Alpha Channels from 

images and apply the mask as an alpha channel in the Perspective render. You 
can also place the mask render in a new layer. Apply a Gaussian filter to the 
mask layer/channel and adjust the transparency if needed. 
 

 
Objects close to you will appear sharp while objects farther away will become 
progressively more out of focus.  
You can also invert the selection and apply Motion Blur to the image. In this case, 
objects in the foreground would be motion blurred, and the background would be sharp, 
as if you took a picture from a moving car.  
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You could determine very specifically which objects in your scene are in focus and 
which are not. Select the Distance Rendered alpha channel and remap the gray values 
in the Curves dialog in Photoshop. Remap black input to lighter output and the gray 
value of the desired focal object to black.  

Altitude Mask  

This mode results in a grayscale image, with objects represented in shades of gray 
based upon their height. You can use Altitude Mask images in the same way you can 
use Distance Mask images to create special effects in other applications.  
To render a distance mask:  

1. Render the scene by rendering to screen or disk or as an animation. 
 

 
2. Click on the Render Options triangle next to the Render Controls and choose 

Altitude Mask from the menu.  
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Alternately, you can select the Altitude Mask option from the Render Options 
dialog.  

• Click on the Render Options triangle next to the Render Controls and 
choose Render Options from the menu. The Render Options dialog will 
come up. 
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• Enable the Altitude Mask option under Projection & Masking. 
 

 
3. Render the scene. The scene will render in grayscale. 

 

 
4. Open the original Perspective render and Altitude render mask in your favorite 

paint program. 
5. Consult the Help file for the paint program on creating Alpha Channels from 

images and apply the mask as an alpha channel in the Perspective render. You 
can also place the mask render in a new layer. Apply a Gaussian filter to the 
mask layer/channel and adjust the transparency if needed. 
 

= 

Optics Options  

Bryce includes a number of Optics options that can help increase the realism of a 
rendered scene. While these options can be used by themselves, most of them work 
best when used with the other options enabled.  
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The Optics options include:  

• Reflections 

• Transmissions 

• Refractions 

• Shadows 

• Maximum Ray Depth 

• Total Internal Reflection 
Examples of how the options work together:  

• Refractions only:  
 

 
• Transmissions only: 
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• Reflections + Transmissions: 
 

 
• Reflections + Transmissions + Refractions:  

 

 
• Reflections + Transmissions + Refractions + TIR: 

 

 

Reflections  

Reflections let you choose whether to render reflections in a scene or not. Reflections 
are necessary for natural reflections in windows and metallic objects (like mirrors).   
The number of reflections rendered are controlled by the Maximum Ray Depth setting. 
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To enable or disable Reflections:  
1. Click the triangle icon next to the Render Controls and select Render Options.  

 

 
2. Click on the Reflections option to enable or disable it. When a checkmark 

appears beside the option, it is enabled. When there is no checkmark, the option 
is off.  
 

 
3. Enable Shadows and set the Maximum Ray Depth.  

 

 
4. Click on the OK icon to accept the changes.  
5. Render the scene.  
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Examples:  
• Reflections Disabled:  

 

 
• Reflections Enabled:  

 

 

Total Internal Reflection  

Total Internal Reflection (TIR) lets you control the amount of TIR in a scene. When you 
have reflective objects such as prisms or mirrors in a scene, you can encounter 
situations where light rays bounce back and forth an infinite number of times within the 
object or between two objects. By limiting the TIR depth, you can produce realistic 
scenes that include a certain amount of TIR. This lets you avoid creating an infinite 
number of internal reflections, thus speeding up the rendering time.  
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To enable or disable Total Internal Reflection:  
1. Click the triangle icon next to the Render Controls and select Render Options.  

 

 
2. Since TIR is affected by the other Optics options, make sure they are enabled. 

When a checkmark appears beside the option, the option is enabled. When there 
is no checkmark, the option is off. 
 

 
3. Click on the Total Internal Reflection (TIR) option to enable it.  
4. Type a value in the Maximum TIR Depth field or leave it at the default setting of 

2. 
 

 
5. Click on the OK icon to accept the changes.   
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6. Render the scene.  
For a good explanation of TIR, go to Robin Wood's site, click on Tutorials and select 
General 3D from the list. In addition, Robin has a "Refraction Index of Various 
Substances for 3D modelers." Another site with a nice listing of refraction indices is 3D 
Lapidary where you can also download 3D models of gemstones in a variety of cuts 
(one of which is used in the examples below).  
Examples:  

• TIR = 4   
 

 
• TIR = 8   

 

 
• TIR = 12  
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Transmissions  

Transmissions lets you choose whether to render light transmissions in a scene. For 
transparent objects with a light source behind them, you must render transmissions for 
light to shine through the objects.  
The number of reflections rendered are controlled by the Maximum Ray Depth setting. 
To enable or disable Transmissions: 

1. Click the triangle icon next to the Render Controls and select Render Options. 
 

 
2. Click on the Transmissions option to enable or disable it. When a checkmark 

appears beside the option, it is enabled. When there is no checkmark, the option 
is off.  
 

 
3. Enable Shadows and set the Maximum Ray Depth.  
4. Click on the OK icon to accept the changes.  
5. Render the scene.  
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Examples:  
• Transmissions Disabled:   

 

 
• Transmissions Enabled:   

 

 

Refractions  

Refractions lets you choose whether to render light refractions in a scene. When light is 
bent by an object such as a prism or a glass of water, you can see distorted views of the 
environment behind or to the side of the object due to the refraction of light. For Bryce to 
render these refractions, you must enable this option.  
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To enable or disable Refractions:  
1. Click the triangle icon next to the Render Controls and select Render Options.  

 

 
2. Click on the Refractions option to enable or disable it. When a checkmark 

appears beside the option, it is enabled. When there is no checkmark, the option 
is off.  
 

 
3. Click on the OK icon to accept the changes.  
4. Render the scene.  

Examples:  
• Refractions Disabled:  
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• Refractions Enabled, without and with an object behind: 
 

 
 

 

Shadows  

Shadows lets you choose whether to render shadows in a scene. Enabling Shadows 
also enables the Maximum Ray Depth setting.  
To enable or disable Shadows:  

1. Click the triangle icon next to the Render Controls and select Render Options.  
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2. Click on the Shadows option to enable or disable it. When a checkmark appears 
beside the option, it is enabled. When there is no checkmark, the option is off.  
 

 
3. If needed, adjust the Maximum Ray Depth to control Reflections and/or 

Transmissions.  
4. Click on the OK icon to accept the changes.  
5. Render the scene.  

Examples:  
• Shadows Disabled:  

 

 
• Shadows Enabled:  
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Maximum Ray Depth  

Maximum Ray Depth lets you control the depth of rays during rendering. For example, if 
you place a series of transparent objects one in front of the other, the Maximum Ray 
Depth setting determines how many of these objects the light will pass through 
(transmissions). This setting also determines the number of times Bryce renders 
reflective "bounces" (reflections).   
To enable or disable Maximum Ray Depth:  

1. Click the triangle icon next to the Render Controls and select Render Options.  
 

 
2. Click on the Shadows option to enable or disable it. When a checkmark appears 

beside the option, it is enabled. When there is no checkmark, the option is off.  
 

 

©2007 DAZ 3D, Inc.  459 



Bryce 6 Artist Guide 

3. Enter a number in the Maximum Ray Depth field. Enter 0 in the field to disable 
Maximum Ray Depth.  
 

 
4. Click on the OK icon to accept the changes.  
5. Render the scene. See the following pages for examples of using Maximum Ray 

Depth. 

Maximum Ray Depth and Reflections  

Reflections are controlled by the material reflection setting and by the Maximum Ray 
Depth setting. Prior to Bryce 5, reflections were limited to six levels and this couldn't be 
lowered or raised. Bryce 5 introduced the Maximum Ray Depth setting which allows you 
to determine how many levels of reflection are rendered. Just remember when using 
this feature that the more levels of reflection you select, the more the render times are 
increased.   
The examples below use two "mirrors" set opposite each other with two spheres placed 
between the mirrors.   
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For brevity's sake, "MRD" will be used instead of "Maximum Ray Depth."  
• With the MRD set to 4, Bryce renders four levels of reflection. The fifth level isn't 

rendered and shows as black.  
 

 
• With the MRD set to 6 (the default), Bryce renders six levels of reflection. 

 

 
• With the MRD set to 15, we get fifteen levels. 

 

 

©2007 DAZ 3D, Inc.  461 



Bryce 6 Artist Guide 

• And with the MRD set to 30, thirty levels are rendered. and so on.  
 

 

Maximum Ray Depth and Transmissions  

Transmissions are controlled by the Maximum Ray Depth setting which determines how 
far light travels through transparent objects. The levels rendered include each side of 
the object. So, if you use a cube, remember that it has two sides for transmissions to go 
through. If you use a 2D Face, only one side is used for transmissions.  
Just remember when using this feature that the more levels of transmission you select, 
the more render times are increased.  
The examples below use five thin cubes placed one behind the other (remember, two 
sides per cube).  
For brevity's sake, "MRD" will be used instead of "Maximum Ray Depth."  

• With the MRD set to 5, Bryce renders five levels of transmission. Since the cubes 
have two sides, light only goes through the first two cubes and half of the third 
cube. The levels behind that render black. The edges of the cubes show the 
same levels of transmission depending on their placement.  
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• With the MRD set to 8, you can see clearly through four complete cubes. 
 

 
• With the MRD set to 10, you can see clearly through all five cubes. 

 

 

Document Setup  

The menu commands at the end of the Render Options menu are quick ways to resize 
your document. Values shown are expressed in pixels and are for customizing the size 
and aspect of your document and the resulting render. 
The render resolution options control the resolution of your final image. These options 
do not affect the resolution of your working document; they affect only the final rendered 
image. 
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To choose a document size, click the triangle icon beside the Render Controls and 
choose a document size from the bottom of the menu. 

 

Render Resolution 

To choose a render resolution: 
1. Double-click any of the Render controls or choose File > Document Setup from 

the menu.  
 

 
2. Click one of the render resolutions at the bottom of the dialog. The selected 

resolution appears highlighted.  
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3. Click the OK icon.  

Batch Rendering  

Batch Rendering lets you render a number of files at the same time. This way, instead 
of rendering each scene as you create it, you can set up a number of scenes, save 
them, and then render them all at once at a convenient time. 
To perform a batch render:  

1. Save a number of scenes to a folder, then select the files.  
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2. Drag all the files to the Bryce application. 
 

 
Bryce opens each file, renders it, saves it, and then opens and renders the next file. 
You can render any number of files this way.  
Mac users: Currently, Mac Bryce scene files must have the .BR6 extension (must be in 
all caps) in order for batch rendering to work correctly. If the files do not have the 
extension, Bryce 6 will render the default scene for the first queued scene file, then 
render the remaining scenes correctly. You must add the .BR6 extension in the folder 
where the files are saved, not when saving the scene file.  

Patch Rendering  

Using the Plop-Render mode, you can do a patch render of image. Patch rendering 
involves the rendering of background and flat elements using normal rendering and then 
using the Plop-Render controls to render areas that contain more complex elements.  
There are two things you should remember when using patch rendering:  

1. Make sure you use the Clear and Render button when you make changes to a 
partially rendered image. 

2. If you stop a rendering, make changes and then click Resume Render, you'll end 
up with noise instead of an image. 

If you change elements that don't affect a large area of your scene, you don't have to 
render the entire scene again. For example, if you render a scene with a floating sphere 
and then delete the sphere, you don't need to re-render the scene, only the area where 
the sphere was.  

©2007 DAZ 3D, Inc.  466 



Bryce 6 Artist Guide 

To patch render your image: 
1. Start a render as normal. 
2. Let the rendering proceed for two or three passes and then click the mouse.  
3. Switch to Bitmap display mode.   
4. Drag a marquee around key portions of your scene and then render those areas 

using the Plop-Render controls. 
See "Plop Render On/Off" for more on using this option. 

Speeding Up Renders  

There are several techniques you can use to speed up the rendering process. These 
techniques are most useful when rendering animations, where you may have a large 
number of images to render. 
You can greatly increase the speed of a render just by using the Preview Render 
modes. Here are the percentages of time it takes to a render a scene, containing 
complex materials and lights, using normal and preview modes.   

• Normal Render: 100% Fast Render: 41.7% Textures Off: 35.4% 
• Fast Render w/Textures Off: 8.3% 
• Fast, Textures Off, anti-aliasing Off: 2.1% 

You can also speed up rendering using these techniques:  
• Limit the number of lights. 
• Keep background objects simple. 
• Limit the number of volume materials you apply. 
• Limit the number of transparent and reflective objects. 
• Limit the number of frames per second to 15 for QuickTime movies. 
• Divide animations into smaller files and eliminate objects that won't be seen in 

the rendered frames. 
• Turn off anti-aliasing when previewing animations. 
• Group objects near each other to lessen how many objects Bryce has to 

calculate. 

Text Display Area  

The area just below the Render Controls is reserved for momentary display of text 
information. When you pass your pointer over interface elements, this area displays the 
name of the interface element, and in some cases, it also displays the element's current 
settings. The Text Display Area also displays information about the total number of 
polygons in an object or a scene and information about current control settings.  
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To display information about the interface:  
• Pass the pointer over any interface element. 

 
The name of the element is displayed. In some cases, the element's current 
settings are also displayed.  
 

 
To display statistics about the objects in your scene:  

1. Switch to Wireframe display using the Display Mode tool.  
2. Pass the pointer over the Working window.   

• If no objects are selected, the Text Display Area displays a count of all of 
the objects in your scene, as well as a total polygon count. 
 

 
• If an object is selected, the Text Display Area displays object and polygon 

counts for the selected object.  
 

 
To display information about rendered images:  

1. Switch to Bitmap display using the Display Mode tool. If you have not rendered 
your image, the Working window is blank.  

2. Pass the pointer over the Working window. The Text Display Area shows the 
scene filename and image pixel size. 
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Libraries 
Bryce contains several preset libraries where you can store objects, materials, skies, 
terrain brushes, and textures. The next several pages show how to add and delete 
presets, set up the preview, add and delete categories, and add presets to your scenes.  
New in Bryce 6 are the following for preset libraries:  

• Thumbnail preview sections expanded so more previews can be seen  
• Titles and descriptions can now contain more information 
• Ability to add and delete preset categories from within the library  
• Sky Library now allows for multiple categories   
• Each category can now have more than 14 sub-categories 

Pictures Editor 
The Pictures Editor in Bryce, also known as the Pictures Library, stores all the images 
available in Bryce and can be used to catalog pictures. You can store and import any 
number of pictures in the library that your system memory and disk space will allow. 
The Pictures Editor has three square previews at the top of the window. These three 
previews represent one image three different ways. The left image is the RGB 
information of the image, the middle one is the alpha channel, the right one is the 
combined image. 
You can apply filters to each of the three parts independently, load new images, copy, 
and paste between the previews, save a picture list, rename images, and delete 
images. 
There are several ways of accessing the Picture Library. The method you use depends 
on how you're going to use the image. 
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Accessing the Pictures Editor 

The Pictures Editor can be accessed from the following locations: 

From the Objects Menu 

In the Objects menu, the Edit 2d Pictures command brings up the Pictures Library. 
• To open the Pictures Library, choose Objects > Edit 2d Pictures from the menu 

or press Ctrl+Opt/Alt+M. 
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From the Create Palette 

To access the Pictures Editor from the Create Palette: 
1. Make sure the Create palette is visible. If it's not, click the Create button at the 

top of the Bryce window. 
 

 
2. Click on the Pict Object tool (Leo object). The Pictures Editor will come up. 

 

 

From the Materials Lab 

To access the Pictures Editor from the Materials Lab: 
1. Select an object. 
2. Click on the  button next to the selected object. The Materials Lab will come up. 
3. In the Materials Lab, click on one of the columns in the grid to activate a 

component window: 
 

 
4. In the component window, click on the P button in the bottom-left corner. The 

default moon texture appears in the window: 
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5. Click the Pink button at the top of the window, the Pictures Editor comes up. 
 

 

From the Light Lab 

To access the Pictures Editor from the Light Lab: 
1. Select a light source. 
2. Click the  button next to the selected light source. The Light Lab will come up. 
3. Click the radio button next to Use Gel, the Image and Procedural buttons will 

activate. 
 

 
4. Click on the Image button. The Pictures Editor comes up. 
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From the Tree Lab 

You can use a uniform color, an image, or a material as the texture for leaves of a tree. 
All the leaves will have the same texture; you cannot vary the texture of leaves. 
To use an image texture: 

1. Click the Image button at the bottom of the Branch/Trunk or Foliage section. 
 

 
2. Click the Edit button to the right of the Image button. The Pictures Editor 

appears. 
 

 

Previewing Pictures 

The three most prominent items at the top of the library are the RGB Image (left), Alpha 
(middle), and Combined (right) preview windows. The first window displays the current 
picture, the second window displays the alpha channel associated with the picture, and 
the third displays the resulting picture after the alpha channel is combined with the 
picture. 
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Alpha Channels 

Every image contains a number of channels that store data about the makeup of the 
picture. For instance, channels can contain masks, colors, or bump information. 
The Alpha Channel of an image is its second channel. The channel is like a grayscale 
map that accompanies an image that is used primarily as a "mask." Areas in the Alpha 
Channel that are black (appearing transparent) are ignored by the Bryce as it computes 
the picture. Bryce recognizes and computes areas that are white (appearing opaque). 
The most common use for alpha channels is to mask the contours of a 2D object, 
separating it from any unwanted background information. For instance, you may import 
a picture of a dog. If you have created an Alpha Channel "mask" describing the area of 
the dog as white and the "non-dog" area as black, then unwanted cats and mail carriers 
in the original picture's background will not be seen in your rendered image. This 
example illustrates how the Alpha Channel mask (bottom) is used to eliminate the 
unwanted areas of an image. 
In Bryce, Alpha Channels are also used when your picture is a component in a material. 
In this case the alpha channel can be used to determine everything from the bumps in a 
material to how a surface property is applied on an object. 
If you want to use the picture in the library for multiple purposes, you'll need to make 
sure that all the pictures have an alpha channel. 

Picture Thumbnails 

Below the three preview windows are the picture thumbnails that display a small 
preview of each picture in the library. The gray thumbnails represent empty slots in the 
library. When you load images, they are added to the first available gray slot. If there 
are a large number of pictures in the library, you can use the scroll bar to scroll through 
all the thumbnails. 
To display an image in the library, click on the picture's thumbnail. The picture and its 
associated alpha channel appear in the three preview windows at the top of the dialog. 
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Loading Pictures into the Editor 

You can load pictures into the library to create your own custom library. Pictures can be 
loaded into any of the three preview windows. If you want to add a new picture to the 
library, you need to load it into the last preview window, the Combined Image window. 
When you load a picture into the first window, you're loading only the picture's RGB 
(Red, Green, and Blue) color information. The picture loaded into the first preview 
window replaces the currently selected picture in the library, so you're replacing a 
picture in the library with the picture you're loading. Be careful when replacing the RGB 
Image since this will replace the texture for all objects that currently use the same 
image. 
When you load a picture into the second window, you're loading only the picture's alpha 
channel. The alpha channel determines which portions of the picture are visible. The 
areas of the picture that are transparent appear as a checkerboard pattern. Every 
picture should have an alpha channel assigned to it. If the picture does not have an 
alpha channel, the resulting Alpha image appears completely white. 
If your picture doesn't have an alpha channel, you can copy the image from the RGB 
Image window into the Alpha Channel window. This way your picture won't appear 
completely opaque. 
The Alpha channel you load does not have to necessarily match the image. You can 
create some interesting clipping effects by combining different alpha channels and 
images. 

Load New Picture 

To load a new picture into the Library: 
1. Click an empty picture slot in the bottom of the library where you want to load the 

new picture. The Load dialog appears. 
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2. Use the dialog controls to locate the desired image and click Open. 
 

 
3. The picture's thumbnail appears in the picture slot and the image and any alpha 

channel are loaded in the RGB Image and Alpha Channel windows. 
 

 

Replace Picture 

To replace the RGB information in a picture: 
1. Click the thumbnail of the picture you want to replace. 
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2. Click the Load button on top of the RGB Image window. The Load dialog 
appears. 
 

 
3. Use the dialog controls to locate the desired image and click Open. 

 

 
4. The picture appears in the first preview window. 
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Note: Replacing images over a previous image will not load any alpha channel 
layers. To load the alpha channel, load the replacement image into a new slot. 

Replace Alpha Channel 

To replace the Alpha channel information in a picture:  
1. Click the thumbnail of the picture you want to replace. 

 

 
2. Click the Load button on top of the Alpha Channel window. The Load dialog 

appears. 
 

 
3. Use the dialog controls to locate the desired image and click Load. The picture's 

Alpha Channel appears in the second preview window. 
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Copying & Pasting Pictures 

Copying and pasting in the Pictures Editor works differently for each of the three image 
windows. 
When you copy and paste into the first window, you're pasting only RGB color 
information, so if you copy an image from the Combined window, only the color 
information is pasted into the RGB window. As with loading, any changes you make in 
the RGB Image window affects the selected image. 
When you copy and paste into the second window, you're working with only the Alpha 
Channel information, so any image you paste into this window will appear as an alpha 
channel image (that is, black and white). Any changes you make in this window affect 
only the selected image. 
When you copy an image from the Combined window the entire image is placed on the 
clipboard. Depending on where you paste it, only a portion of the image may be used. 
When you paste a picture into the Combined window, it appears as a color image with 
transparent and solid areas. All pictures are treated as color. So if you paste a picture 
copied from the Alpha Channel window in this window, you'll get an RGB representation 
of the alpha channel image. As well, any image pasted into this window creates a new 
picture entry in the library. 
To copy and paste RGB information in a picture: 

1. Click the Copy button below the RGB Image window. 
2. Click the Paste button below the window where you want the RGB image to 

appear. 

•  If you paste the image into the Alpha Channel window, it is desaturated 
and used as an alpha channel. 

•  If you paste it into the Combined Image window, the RGB image becomes 
a new entry in the library.  

To copy and paste Alpha Channel information in a picture:  
1. Click the Copy button below the Alpha Channel window.  
2. Click the Paste button below the window where you want the Alpha Channel 

information to appear. 

•  If you paste the image into the RGB Image window, an RGB 
representation of the alpha channel is placed in the window. 

•  If you paste it into the Combined Image window, an RGB representation 
of the alpha channel is placed in an empty slot in the library.  
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To create a new picture using RGB color information only:  
1. Click the Copy button below the RGB Image window.  
2. Click the Paste button below the Combined window. The RGB information is 

placed in an empty slot in the library.  
To create a new picture using Alpha channel information only:  

1. Click the Copy button below the Alpha Channel window.  
2. Click the Paste button below the Combined window. The alpha channel 

information is placed in an empty slot in the library. 

Deleting Pictures 

When you delete a picture, you remove all the image information (including color and 
alpha channel) from the library. 
To delete a picture from the library: 

1. Click the thumbnail for the picture you want to delete. 
 

 
2. Click the Delete button. 

 

 
3. To delete all pictures from the library, click Delete All. 

 

 
Note: You cannot select more than one thumbnail at a time in the Pictures Editor. 
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Renaming Pictures 

To rename an image: 
1. Click the thumbnail of the image you want to rename. 

 

 
2. Click the Rename button. 

 

 
3. The Rename Pict dialog will come up. 

 

 
4. Type a new name for the image into the field and click on the OK icon. 
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5. Move the mouse over the image thumbnail and the new name will show up in the 
bottom left-hand corner of the Pictures Editor. 
 

 

Inverting the Alpha Channel 

When you invert an alpha channel all the black areas become white and the white areas 
become black. This means that all the areas that were transparent now become solid 
and vice versa. 
To invert an alpha channel, click the Invert button above the Alpha Channel window. 

 
Result: 
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Selecting a Plug-In Folder 

You can apply filters to each of the three parts independently. 
How to select a plug-in folder: 

1. Click on the triangle to the right of the desired preview type. If a plug-ins folder 
has been previously selected, a pull-down menu appears that displays the 
available Photoshop filters.  
 

 
 
If, for some reason, the Photoshop filters cannot be found, or you wish to select a 
new plug-ins folder, choose Select Plug-ins Folder at the bottom of the menu. 
 

 
2. Select a folder for the plug-in and click on OK. 
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Picture Lists 

A Picture List is a file that contains a group of pictures. A Picture List can be used to 
store all the pictures used in a given scene, or to store a series of 
pictures you use most often. You should also use a picture list to store any pictures 
you've used as part of a material. 
To open a picture list: 

1. Click the Open List button at the bottom of the Picture Library. The Open dialog 
appears. 

2. Use the dialog controls to locate the desired list and click Open. The pictures in 
the list appear in the library. 

3. To save a picture list: 
4. Click the Save List button at the bottom of the Picture Library. The Save dialog 

appears. 
 

 
5. Enter a name for the list and click Save.  

 
Name the list the same as the scene. This way, you can easily find the list that 
belongs to a specific scene. 

Preset Libraries 
In Bryce, the libraries provide quick access to objects, materials, textures, pictures, 
brushes, and skies that can be added to the scene. 
Bryce comes with two preset category folders in each library: Installed and User. The 
Installed preset category folder contains the presets that are installed with Bryce. The 
User preset category folder is empty by default. 
Each preset category folder can contain as many preset categories as you want and 
each preset category can contain a virtually unlimited number of presets - at least as 
much as your computer can handle that is. You can also create additional preset 
category folders and preset categories to suit your needs. 
In Bryce 6, the libraries were expanded to show more presets. This also allowed the 
preset titles and descriptions to contain more information, however, older presets copied 
into the preset libraries will still have the shorter titles and descriptions. See the issue in 
appendix c for more on this 
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All the libraries can be added to, deleted from, imported into, or exported out of in the 
same way. What differs is what is or is not selected and what gets added to the library. 

• The Objects Library contains all the preset objects distributed with Bryce as well 
as presets you add. Objects in the library are either 3D models or geometric 
paths. Objects added to the library include any applied materials and textures.  

• The Materials Library contains all the material presets available in Bryce.  
• The Textures Library contains procedural 3D textures generated by Bryce in the 

Deep Texture Editor.  
• The Skies Library contains all the preset skies available in Bryce. You can apply 

them to your scene and edit them just as you would another sky.   
• The Brush Library contains all the brushes available for use in the Terrain Editor.  
• The Pictures Editor contains the current imported textures for use in the scene. 

Working with Categories & Presets 

Each library contains categories for presets with each category containing sub-
categories which hold the actual presets. 
Each library can contain as many categories as you want, each category can contain as 
many sub-categories as you want, and each sub-category can contain as many presets 
as you want. The only limit is what your computer can handle.  
That being said, if sub-category gets too large and something happens, that sub-
category could become corrupted and you'll lose all the presets in that sub-category. 
So, a periodic backup of all preset categories might be a good thing to do. 
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Changing Preset Category Folders 

To change to a different preset category folder: 
Open any of the Preset Libraries. 

1. Click the triangle icon next to the preset category folder name at the bottom left 
of the Preset Library and choose a preset category folder from the drop-down 
menu. 
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2. The library opens that preset category folder and displays the categories and 
presets found in that folder. Click on any sub-category to access the presets 
stored there. 
 

 

Adding Categories 

Bryce 6 adds the ability to add or delete sub-categories from within the libraries 
themselves. Of course, categories and sub-categories can also be added and deleted 
from within the directory folders themselves 
As you add new categories, the category listing will continue to grow. Fourteen 
categories can be seen in the listing so if there are more than 14 categories, a scroll bar 
will be added to the listing allowing you to scroll up and down within the listing. 

 
There are three ways to add new categories to the libraries: 

• By creating a new category inside a library 
• By exporting presets out to a new category 
• By creating new folders inside the Preset folder 
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Inside a Library 

To add a preset category to the Preset Libraries from within the library: 
1. Open any of the libraries. 
2. Open the main category (i.e., Installed, User, etc.) to add the new preset 

category to. 
 

 
3. Click on the plus sign (+) just above the category triangle: 

 

 
4. The Add Category dialog will come up, enter the new category name in the field: 
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5. The new category will be created, ready for new objects, materials, brushes, 
skies, or textures: 
 

 

By Exporting 

To add a preset category by exporting presets: 
1. Open any Preset Library. 
2. Select any preset object or multiple objects. 
3. Click the Export button at the bottom of the dialog. The save file dialog appears. 
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4. Change directories to the category folder you want to add the new preset 
category to, enter a name for the file, and click Save. The file will be saved to the 
location you selected. 
 

 
5. Back in Bryce, the new preset category will now be in the selected category 

folder, ready for new presets to be added to. 
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Inside a Preset Folder 

To add a preset category folder to any library: 
1. Navigate to the folder where Bryce is installed. 
2. Open the Presets folder. 
3. Open the preset folder where you want to add a new library category. 

 

 
4. Create a new folder and give it a name. 

 

 
5. In Bryce, open the library and click on the triangle next to the current category 

name at the bottom left of the library window. The new category will now be in 
the list. 
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6. Select the new category to open it, you can now add new presets to the category 
or create new sub-categories. 
 

 
7. If you go back into the library folder, you'll see a preset file with the same name 

as the category. You can rename the file, duplicate it to create new sub-
categories, or even delete them from the folder. 
 

 

Deleting Categories 

Bryce 6 adds the ability to add or delete sub-categories from within the libraries 
themselves. Of course, categories and sub-categories can also be added and deleted 
from within the directory folders themselves. 
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Inside a Library 

To delete a preset category folder from within any library: 
1. Open any of the libraries. 
2. Select the main category where you want to delete a preset category from. 

 

 
3. Click on the minus sign (-) just above the category triangle: 

 

 
4. The Confirm dialog will come up, choose Delete to remove the category from the 

library or Cancel to leave it in. 
 

 
5. The category will be completely removed from the main category. 
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Inside a Preset Folder 

Both category folders and sub-category files (.mat, .obp, etc.) can be deleted from 
within the preset folders. 

Deleting a Category Folder 

To delete a preset category folder from any library: 
1. Navigate to the folder where Bryce is installed. 
2. Open the Presets folder. 
3. Open the preset folder where you want to delete a library category. 

 

 
4. Select the category folder you want to delete and cut/delete it from the folder. 

When you return to Bryce, the category will be gone. 
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Deleting a Sub-Category File 

To delete a preset sub-category from any library: 
1. Navigate to the folder where Bryce is installed. 
2. Open the Presets folder. 
3. Open the preset folder where you want to delete a library category. 

 

 
4. Open the category folder containing the sub-category you want to delete. 
5. Select the category you want to delete and cut/delete it from the folder. When 

you return to Bryce, the category will be gone. 
 

 

Adding Presets 

You can add presets to any library by either clicking on the Add button or importing new 
presets. 

Objects 

You can add preset objects to the Object Presets Library. The Objects Library retains all 
Boolean, grouping, and textural properties of the objects placed within it. 
When adding an object or group to the library, keep the following in mind: 
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• Only single primitives or groups can be added to the library. If you select more 
than one group, only the first group will be added to the library. To add both, 
either group them into one group or add them separately to the library. 

• The Perspective Camera cannot be added to the library. 
• All applied materials and images are saved with the object. 
• In Bryce 5 and 5.5, grouped Bryce Trees could be added to the library, but 

tended to crash Bryce when you tried to load them in the scene or import the 
saved OBP file. Bryce 6 has fixed this issue and grouped trees in the library no 
longer crash Bryce. 

• Some Bryce 4 objects will crash Bryce 6 when the thumbnail is selected. This 
can only be fixed by importing the object into the Bryce 5/5.5 Objects Library, 
exporting, then importing into Bryce 6. 

To add an object preset: 
1. Select the object or group in your scene that you want to add to the library. 
2. Click the Triangle icon next to the Create button at the top of the Bryce window. 

 
 

3. The Objects Library comes up with the selected object appears in the preview 
area of the Presets Object Library dialog. 
 

 
4. Click a category name. The library switches to the category you selected. The 

new preset will be added to the category you select.  

©2007 DAZ 3D, Inc.  496 



Bryce 6 Artist Guide 

5. Click the Triangle icon in the bottom-right corner of the thumbnail preview and 
choose a view option from the menu. 

•   Normal: is the default view of your selected object. 
 

 
•  Up Close: displays a close-up of your object. 

 

 
•  Render With Neutral Sky: displays your object with a flat sky, instead of 

the sky applied to your scene. When deselected, the current sky in the 
scene will affect the thumbnail preview. 
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6.  Set up the object location:   
• Drag in the preview area to rotate the view of the object: 

 

 
•  Hold down the Spacebar and drag up, down, right, or left to pan the object 

preview: 
 

 
•  Hold down Cmd/Ctrl and drag in the preview area to zoom in and out of 

the preview: 
 

 
•  Press Alt and click in the preview area to reset the preview to the default: 

 

 
• Once you're happy with the preview image, click on Add to add the object 
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7. Once you're happy with the preview image, click the Add button at the bottom of 
the dialog. The Add Preset dialog appears. 
 

 
8. Enter a name for the new preset in the Preset Name field. 
9. Enter a description of the preset in the Description field. This name and 

description will appear beneath the object preview whenever the preset is 
selected. 
 

 
10. Click the OK icon. Your preset is added to the first available space within the 

current category. 
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Materials 

To add a material preset to the Materials Presets Library along with any imported 
textures: 

1. Select the object in your scene that has the material applied that you want to add 
to the library or click on the Edit Materials tool in the Edit Palette. 
 

 
2. Click the Triangle icon next to the Edit button at the top of the Bryce window. 

 
 

3. The Materials Library comes up with the selected material in the Preview 
window. 
 

 
4. Set up the preview of the material: 

5.  Click the Triangle icon in the bottom-right corner of the thumbnail preview and 
choose a view option from the menu. 
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•  Normal: is the default view of your selected material. 

 

 
•  Up Close: displays a close-up of your material. 

 

 

©2007 DAZ 3D, Inc.  501 



Bryce 6 Artist Guide 

•  Render With Neutral Sky: displays your object with a flat sky, instead of 
the sky applied to your scene. 
 

 
• When deselected, the current sky in the scene will affect the thumbnail 

preview, including haze and the sun's location. 
 

 
•  Render with Neutral Ground: displays the material with a gray ground 

plane. 
 

 
• When deselected, the material is applied to the ground plane as well as to 

the selected object. 
 

 
•  Current Selection: displays the material on the same object type that is 

selected in the Working window. If the current selection is an imported 
mesh, the thumbnail preview will default to a sphere. 

•  Actual Selection: displays the material on the actual object selected in the 
Working window. 
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•  Box: displays your material applied to a cube. 

•  Sphere: displays your material applied to a sphere. 

•  Cone: displays your material applied to a cone. 

•  Cylinder: displays your material applied to a cylinder. 

•  Terrain: displays your material applied to a terrain. You might want to 
disable Render With Neutral Ground as terrain materials look better when 
placed on a ground plane with the same material. 

•  Ground: displays your material applied to an infinite plane.   

• Torus: displays your material applied to a torus object.   

• Pyramid: displays your material applied to a pyramid object.   
• Circle: displays your material applied to a 2D circle object.  

•  Square: displays your material applied to a 2D square object. 
6. Set up the preview of the object: 

• Drag in the preview area to rotate the view of the material.  
 

 
•  Hold down the Spacebar and drag up, down, right, or left to pan the 

material preview.  
 

 
• Hold down Cmd/Ctrl and drag in the preview area to zoom in and out of 

the preview.  
 

 
•  Press Alt and click in the preview area to reset the preview to the default. 
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7. Once you're happy with the preview image, click the Add button at the bottom of 
the dialog. The Add Preset dialog appears. 
 

 
8. Enter a name for the new preset in the Preset Name field. 
9. Enter a description of the preset in the Description field. This name and 

description will appear beneath the object preview whenever the preset is 
selected. 
 

 
10. Click the OK icon. Your preset is added to the first available space within the 

current category. 
 

 

Skies 

To add a sky preset to the Sky Presets Library: 
1. Create a new sky in the Sky Lab and using the Sky & Fog Palette. 
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2. Click the triangle icon next to the Sky & Fog text button at the top of the Bryce 
window 
 

 
3. or click the arrow next to the preview area in the Sky Lab dialog. The Preset 

Skies Library appears. 
 

 
4. Click a category name. The library switches to the category you selected. The 

new preset will be added to the category you select. Click the Add button at the 
bottom of the dialog. The Add Preset dialog appears. 
 

 
5. Enter a name for the new preset in the Preset Name field. 
6. Enter a description of the preset in the Description field. This name and 

description will appear beneath the object preview whenever the preset is 
selected. 
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7. Click the OK icon. Your preset is added to the first available space within the 
current category. 
 

 

Textures 

The Textures Library contains textures created in the Deep Texture Editor and can be 
used to create complex materials. 
To add a texture preset to the Textures Library: 

1. Access the Deep Texture Editor and generate a new texture. 
2. Click on the Texture Library knob to the right of the Combination panel. 
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3. The Textures Library will come up. Select the category to save the texture to, 
then click on Add. 
 

 
4. Enter a name and description for the texture then click on the OK icon.  
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The texture will be added to the library. 
 

 

Brushes 

The Brush Presets Library is new in Bryce 6 and is accessed from within the Terrain 
Editor. The brushes allow you to add frequently used shapes or special brushes to be 
used to paint terrains. 
To add a brush preset to the Brush Presets Library: 

1. In your paint program, create a new square image (i.e., 256x256, 512x512, etc.) 
with a black background. You can build a brush in color, but it will be converted 
to grayscale when imported into the Brush Library. 
 

 

©2007 DAZ 3D, Inc.  508 



Bryce 6 Artist Guide 

2. Select a brush preset from the program or create your own image. The brush 
color should be set to white or a light gray. 
 

 
3. Save the image in one of the following formats: 

•  .SGI 

•  .BMP 

•  .DIB   
• .EMF 

•  .FPI   
• .FPX 

•  .GIF    

• .JP2   

• .JPE   

• .JPG    
• .MAC 

•  .PCT 

•  .PSD    

• PIC   

• .PNG    
• .PNT 

•  .TIF 
4. In Bryce, create a new terrain or symlat. 
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5. Click on the  button next to the selected terrain to enter the Terrain Editor. 
6. Click on New to load a new terrain. 
7. In the Brush Palette, click on the Brush Tool. 

 

 
8. The Brushes Library will open up. 

 

 
9. Click on Add at the bottom of the library. 
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10. The Open File dialog will come up. Locate your brush image, select it, and click 
on Open. 
 

 
11. The brush will be imported into the library, ready to use. 

 

 
12. To use the brushes, select the brush and click on the OK icon. 
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13. Back in the Terrain Editor, adjust the brush size and flow as needed. 
 

 
14. Paint on the Terrain Canvas or use the brush as a stamp to stamp the design on 

the Terrain Canvas. 
 

 
Refer to the "Terrain Editor" section for more on working in the Terrain Editor. 

Importing 

Importing presets into the libraries is another way to add presets to your libraries. 
To import a preset to any library: 

1. Open the preset library you want to import into: Objects, Materials, Skies, 
Textures, or Brushes. 

2. Select the category to which you want to import presets. 
 

 
3. Click the Import button at the bottom of the dialog. The file Open dialog appears. 
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4. Locate the file that you would like to import and click on Open. 
 

 
5. The contents of the file are placed into the first available space in the current 

category if no object was selected  
 

 
 
or in front of any object selected when you clicked on Import: 
 

 
6. Click on the OK icon to close the library. 

Deleting Presets 

To delete a preset from any library: 
1. Open the preset library you want to delete from: Objects, Materials, Skies, 

Textures, or Brushes. 
2. Select the category from which you want to delete presets. 
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3. Click on the preset you want to delete: 
 

 
4. or hold down Shift and select a continuous series of presets or hold down 

Cmd/Ctrl and select a discontinuous set of presets: 
 

 
5. Click the Delete button at the bottom of the dialog. 

 

 
6. The Confirm dialog will come up, choose Delete to remove the preset from the 

library or Cancel to leave it in. 
 

 
7. Once deleted, the preset will no longer show up in the library, however, in the 

Objects Library, the object data is still in the OBP file for that category. If the 
category OBP file is too large after deleting several presets, you can export the 
remaining objects then replace the original OBP with the exported one to reduce 
the file size. 
 

 
8. Click on the OK icon to close the library. 
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Exporting Presets 

Importing and exporting presets is a handy way to exchange custom presets with other 
users and to store objects for later use. It can also be used to reduce the file size of a 
category when several presets have been deleted from the library. 
To export a preset from any library: 

1. Open the preset library you want to delete from: Objects, Materials, Skies, 
Textures, or Brushes. 

2. Select the category from which you want to export presets. 
3. Select the preset or presets you wish to export. Hold down Shift and select a 

continuous series of presets or hold down Cmd/Ctrl and select a discontinuous 
set of presets. 
 

 
4. Click the Export button at the bottom of the dialog. The save file dialog appears. 

 

 
5. Enter a name for the file, navigate to where you want to save it, and click on 

Save. The file will be saved to the location you selected with the correct 
extension for the preset type. If exporting objects to reduce the file size, name 
the exported file the same name as the one it will be replacing. 
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6. Click on the OK icon to close the library. 

To replace a category OBP file with one you just exported, refer to "Recovering Disk 
Space in the Libraries." 

Recovering Disk Space 

When you delete a preset from a library, the preset is removed from the thumbnail 
previews, but not from the actual preset file. In order to reduce the file size and get rid of 
the deleted data, the remaining presets need to be exported in order to replace the 
original preset file. 
There are two basic ways to recover disk space in the libraries: 

1. Export presets, then cut and paste it over the original preset file 
2. Export presets with new name, delete original sub-category, then rename new 

file 

Export and Paste Over Original 

To recover disk space by exporting and pasting over the original file: 
1. Select and export the presets that you want to keep into a temporary folder, 

saving the file with the same name as the original file. 
2. Navigate to the folder where you saved the exported preset file, select the file, 

and cut or copy it. 
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3. Notice the file size on the example above is just over 13 MB. Navigate to the 
Bryce Presets folder then to the folder where the original file is located.  
 
Paste the new file into the folder, confirming on any replace messages. 
 

 
 
In the example, the User.obp file is being replaced. Notice that the file size on the 
current version is over 17 MB. By exporting out the objects in the User category 
and copying it over the old version, 4 MB of disk space has been recovered. This 
may not seem like a lot, but a MB here and a MB there can start adding up very 
quickly. 

Export and Delete Original 

To recover disk space by exporting and pasting over the original file: 
1. Select the presets that you want to keep and click on Export. 
2. Navigate to the presets folder where the original file is located. Name the file the 

same as the original file but add a number to it. Click on Save. 
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3. Quickly select another category, then switch back to the category you were just 
in. This refreshes the sub-category listing. 
 

 
4. Select the original sub-category and click on the minus sign at the bottom of the 

listing. Confirm on Delete. 
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5. The original sub-category will be gone and the new one left in the listing. 
 

 
6. Since Bryce exports presets backwards, you may want to re-export the new file, 

so select all the presets in the new sub-category, click on Export, and give the file 
the same name as the original file. Click on Save. 
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7. Change categories, then change back to the one you're working with. Both 
versions of the new sub-category will be listed. 
 

 
8. Click on the first exported sub-category and click on the minus sign at the bottom 

of the listing. Confirm on Delete. 
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9. Refresh the listing by switching categories and the new sub-category will be 
listed. 
 

 

Thumbnail Preview Options 

The preview thumbnails in the Objects and Materials Libraries can be modified using 
various options in the library and by the selected sky and sun/moon settings. 
The number of thumbnails viewable in the libraries has been increased in Bryce 6, with 
the Skies Library increased from six thumbnails across to seven across and the 
remaining libraries increased from six to ten thumbnails across. 

Objects Library 

In the libraries, you can change the thumbnail preview either before or after adding the 
item to the library. 

1. Select the object in the working window and open the Objects Library 
2. OR 
3. Open the Objects Library and select the item you want to change the thumbnail 

for. 
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4. Set up the preview of the object: 

•  Click the Triangle icon in the bottom-right corner of the thumbnail preview 
and choose a view option from the menu.  Normal: is the default view of 
your selected object. 
 

 
•  Up Close: displays a close-up of your object. 
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•  Render With Neutral Sky: displays your object with a flat sky, instead of 
the sky applied to your scene. When deselected, the current sky in the 
scene will affect the thumbnail preview. 
 

 
5.  Set up the object location:   

• Drag in the preview area to rotate the view of the object: 
 

 
•  Hold down the Spacebar and drag up, down, right, or left to pan the object 

preview: 
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•  Hold down Cmd/Ctrl and drag in the preview area to zoom in and out of 
the preview: 
 

 
•  Press Alt and click in the preview area to reset the preview to the default: 

 

 
6. Once you're happy with the preview image, click on Add to add the object 

 
OR 

7. If you are changing the thumbnail of an item already in the library, press 
Ctrl+Shift+click on the thumbnail in the library 
 

 
 
and the thumbnail preview will be replaced with the new one: 
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Materials Library 

In the libraries, you can change the thumbnail preview either before or after adding the 
item to the library. 

1. Select the object with the material applied to it in the working window and open 
the Materials Library 
 
OR 

2. Open the Materials Library and select the preset you want to change the 
thumbnail for. 
 

 
3. Set up the preview of the material: 

•  Click the Triangle icon in the bottom-right corner of the thumbnail preview 
and choose a view option from the menu. 
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•  Normal: is the default view of your selected material. 

 

 
•  Up Close: displays a close-up of your material. 

 

 
•  Render With Neutral Sky: displays your object with a flat sky, 

instead of the sky applied to your scene. 
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• When deselected, the current sky in the scene will affect the 

thumbnail preview, including haze and the sun's location. 
 

 
•  Render with Neutral Ground: displays the material with a gray 

ground plane. 
 

 
• When deselected, the material is applied to the ground plane as 

well as to the selected object. 
 

 
•  Current Selection: displays the material on the same object type 

that is selected in the Working window. If the current selection is an 
imported mesh, the thumbnail preview will default to a sphere. 

•  Actual Selection: displays the material on the actual object 
selected in the Working window. 
 

 
•  Box: displays your material applied to a cube. 
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•  Sphere: displays your material applied to a sphere. 

•  Cone: displays your material applied to a cone. 

•  Cylinder: displays your material applied to a cylinder. 

•  Terrain: displays your material applied to a terrain. You might want 
to disable Render With Neutral Ground as terrain materials look 
better when placed on a ground plane with the same material. 

•  Ground: displays your material applied to an infinite plane.   
• Torus: displays your material applied to a torus object.  

•  Pyramid: displays your material applied to a pyramid object.   
• Circle: displays your material applied to a 2D circle object.  
• Square: displays your material applied to a 2D square object. 

•  Set up the preview of the material (see examples at bottom of page):   
• Drag in the preview area to rotate the view of the material.  

 

 
•  Hold down the Spacebar and drag up, down, right, or left to pan 

the material preview.  
 

 
• Hold down Cmd/Ctrl and drag in the preview area to zoom in and 

out of the preview.  
 

 
•  Press Alt and click in the preview area to reset the preview to the 

default.   
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• Example preview thumbnails:   
• Default view with sun control setting: 

 

 
•  Up Close: 

 

 
•  Up Close and Render with Neutral Ground deselected: 

 

 
•  Up Close, Render with Neutral Ground/Sky deselected, 

Plain Black Background sky applied, and sun moved: 
 

 
4. Once you're happy with the preview image, click on Add to add the material to 

the library 
5. OR 
6. If you are changing the thumbnail of an item already in the library, press 

Ctrl+Shift+click on the thumbnail in the library 
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and the thumbnail preview will be replaced with the new one: 
 

 

Using Presets 

The different types of presets all have their own use in Bryce. The following pages will 
show you how to use the presets. 

Adding Preset Objects to the Scene 

To add an object from the Presets Object Library to your scene: 
1. Click the Triangle icon next to the Create button at the top of the Bryce 

environment.  
 
The Create Palette does not have to be active in order to do this. 
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2. The Presets Object Library appears. 
 

 
3. Click on the name of a category (to the left of the thumbnails) to access the 

different libraries. 
4. Click on the preset thumbnails to view preset names and descriptions. 

 

 
5. Once you've decided which object to use, click on the OK icon to add the 

selected object to your scene.  
Remember, the Create palette does not need to be active for you to access the Objects 
Library. 
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Applying Materials to Objects 

The Materials Presets Library contains all the material presets available in Bryce. You 
can place them on your objects directly and edit them just as you would any other 
material. 
To add a material from the Materials Presets Library to an object: 

1. Select an object. 
2. In the Working window, click the triangle icon next to the Edit text button at the 

top of the Working window. The Materials Presets Library appears. 
 

 
3. Or, in the Materials Lab, click the triangle icon at the top-right of the Material 

Preview window. 
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4. Click one of the Category names along the left side of the dialog. 
 

 
5. Click the thumbnail of the preset you want to add. 

 

 
 
When you click on a preset thumbnail, you may notice that the preset thumbnails 
look different than the preview window. This is because the preset thumbnails 
may have added with the neutral sky deselected so that the current scene sky 
settings would affect the material.  
 
Refer to "Thumbnail Preview Options - Materials Library" for examples showing 
the difference using a neutral sky or a sky preset can make to the preview. 

6. Click the OK icon to add the selected material to your object. 
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You can also select presets in one motion by clicking the Materials Presets icon then 
dragging directly to the desired material preset and releasing the mouse button. You 
can also drag over the category names to change categories into the category's 
presets, and then release the mouse button. 

Applying Skies to the Scene 

To add a sky from the Preset Skies Library to your scene: 
1. Click the triangle icon next to the Sky & Fog text button at the top of the Bryce 

window. 
 

 
 
OR 

2. Click the arrow next to the preview area in the Sky Lab dialog. 
 

 
 
The Preset Skies Library appears. 

3. Click on the preset thumbnails to view preset names and descriptions until you 
find the sky you want to use in your scene. 

4. Click the OK icon to add the selected sky to your scene. 
The Sky & Fog palette does not need to be active for you to access the Preset Skies 
Library.  
You can also select presets in one motion by clicking and holding the triangle icon, 
dragging directly to the desired preset, and releasing the mouse button. 
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Applying Textures in the DTE 

To apply a texture from the Textures Library in the Deep Texture Editor: 
1. In the Deep Texture Editor, click on the top button on the right-hand side of the 

combination window. The "Texture Library" tool tip will show in the bottom left 
corner of the Deep Texture Editor. 
 

 
2. The Textures Library will come up. Select a texture and click on the OK icon. 
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3. The selected texture will be loaded in the Deep Texture Editor. Click on the OK 
icon to return to the Materials Lab. 
 

 

Applying Textures in the MatLab 

To apply a texture from the Textures Library in the Materials Lab: 
1. In the Materials Lab, click in a channel to load a random texture. 

 

 
2. Click on the top right button of the component window and select a texture from 

the fly-out menu. 
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OR 

3. Press Shift and click on the same button to open the Textures Library. 
4. In the Textures Library, select a texture and click on the OK icon. 

 

 
5. The selected texture will be loaded in the Materials Lab. 

 

 
6. Click on the OK icon to return to the Working window. 
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Using Preset Brushes in the TE 

See "Using the Preset Brushes" for information on how to use the brushes in the Terrain 
Editor and "Adding Presets to the Brushes Library" for information on creating and 
adding your own brushes. 

Laboratories & Editors 
Bryce has several laboratories and editors that let you do everything from creating 
terrains to editing the speed of animations. Each editor is like a separate room in Bryce. 
When active, the lab/editor takes over the interface, completely replacing the Working 
window (except for the torus and mesh editors). 

Materials Lab 
The Materials Lab (also known as the MatLab) is where you'll create and edit the 
materials to apply to your objects. This unique editor lets you combine a wide variety of 
components and channels to create an infinite number of different surfaces and 
volumes. 
There are two types of materials you can create: Surface materials, which define the 
surface properties of an object, and Volume materials, which define the properties of an 
object's volume as well as its surface. 
When you're creating volume materials, the settings in the Materials Lab change. Some 
of the surface material settings are replaced by volume effects settings. 
To display the Materials Lab: 

1. Create an object.  
2. Access the Materials Lab:  

• Click the  button next to the selected object.  
• OR choose Objects > Edit Material from the menu.  
• OR click on the Edit Material tool in the Edit Palette.  

The contents of the composer depend on the material currently applied to the object. If 
there is no material, the default material's settings appear. 
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A Quick Tour of the Materials Lab 

The Materials Lab is set up like a visual chart that lets you see all the different channels 
that make up your material. At a glance, you can see all the settings for each material 
channel and the texture components used to drive channel values. 

 
Material Mode Toggle 
In the top left corner is the mode toggle button. This button lets you switch between 
surface material and volume material. The buttons also indicates what type of material 
you're creating. Surface is enabled by default. When you toggle to Volume, the 
channels in the lab change to display the volume channels. 
Material Preview Window  
On the left side of the Materials Lab is the Material Preview. This little window shows 
you what your material will look like when it is applied to an object. The preview updates 
as you adjust the channels. 
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The Materials Grid 
The center of the Materials Lab is called the Materials Grid. This is where you combine 
values, colors and textures to set channel values. The Materials Grid is divided into 
three sections each containing logical groups of channels. 

• The Color channels group contains all the material channels that define the 
colors that appear on the object surface when it's struck by light. Each channel in 
the Color group has a color oval next to its title. This oval lets you quickly set a 
color for the channel.  

• The Value group contains all the channels that define how the object's surface or 
volume reacts to light. In other words, they control whether the object is shiny, 
metallic, bright or dark.  

• The Optics group contains all the channels that define any optical effects 
associated with the object. When you're creating volume materials, the Optics 
group is replaced by the Volume group. This group contains all the channels that 
define the appearance of an object's volume.  

All of the channels in these three groups have sliders on the left side of each row. The 
sliders let you quickly set the value of each channel. Values can be used in conjunction 
with textures or on their own. In the case of the Refraction channel, you must use a 
value. Each channel is divided into four columns: A, B, C, and D. These columns 
represent texture components you can use to set the value of the channel. At the top of 
each column is a Frequency slider. This slider lets you quickly set the frequency of a 
texture component. Setting the frequency is the same as scaling the texture. 
When a texture component indicator appears in a column, it means that a component is 
being used to drive the value of the channel. The column in which the indicator appears 
indicates which texture component is being used. For example, if a texture component 
indicator appears in column A of the Ambience channel, component A is being used to 
drive the Ambience value. 
Texture Component Windows  
Along the right side of the lab are the Texture Component windows. These four 
windows are labeled A, B, C, and D (shown from top to bottom in this image). When a 
texture component is active, these windows display a preview of the texture and provide 
access to texture editing tools. The four Texture Component windows correspond to the 
four columns in each channel in the Materials Grid. 
Animation Controls 
Along the bottom of the Materials Lab are the Animation controls. These controls let you 
animate between textures or animate the properties of a single texture over time 
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Working in the MatLab 

This section describes how to use the Materials Lab to create and store materials. 

Building Materials 

A material is a combination of values, colors and textures applied through fourteen 
different channels. You build materials by selecting components (colors, values, or 
textures) and combining them on the Materials Grid. 

Creating a New Surface Material 

 
To create a new surface material: 

1. Select an object and click on the E button next to the object. The Materials Lab 
will come up.  

2. Set the material channels to define the properties of your material. Remember, 
channels can be set using values, colors or texture components. You may want 
to experiment with different setting to see the results of your changes.  
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3. If you're using texture components, you can:  
• Edit the scale, position or rotation of the texture using the texture 

transformation controls.  
• Edit the makeup of the texture using the Deep Texture Editor.  
• Set a mapping mode for the texture.  

4. Choose a shading mode for the material by clicking the triangle icon at the top of 
the Materials Lab and choosing a mode from the menu.  

5. Click the OK icon. The new material is applied to the selected object.  

Creating a New Volume Material 

 
To create a new volume material: 

1. Select an object and click on the  button next to the object. The Materials Lab will 
come up.  

2. Click the toggle button to switch to Volume.  
3. Set the material channels to define the properties of your material. Remember, 

channel values are applied to the object's volume not its surface, so adjust the 
material's channels accordingly.  
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4. If you're using texture components, you can:  
• Edit the scale, position or rotation of the texture using the texture 

transformation controls.  
• Edit the makeup of the texture using the Deep Texture Editor.  
• Set a mapping mode for the texture.  

 
You should always use a texture component in the Base Density channel.  

5. Choose a shading mode for the material by clicking the triangle icon at the top of 
the Materials Lab and choosing a mode from the menu. The shading modes for 
volume materials are different from those for surface materials.  

6. Click the OK icon. The new material is applied to the selected object.  

Using and Activating Components 

To activate a component in the Materials Grid, click an empty channel column. A 
component window appears. 

 
To use a component in a specific channel, in a material channel, click the column that 
corresponds to the component you want to use. 
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To switch between components, click in a new column. 

 
To combine a component with a value: 

1. In a material channel, click an empty column.  
2. Drag over the value control for the channel or enter a new value in the value 

field.  
 

 

Copying and Pasting Materials 

The Materials Lab has its own dedicated clipboard that lets you store materials. You can 
have an object in your clipboard then enter the Materials Lab and copy a material 
without disturbing the contents of your objects clipboard. 
To copy a material to the Materials clipboard, click the Copy button below the Material 
Preview window.  

 
To paste a material to the Materials clipboard, click the Paste button below the Material 
Preview window. 
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Using the Material Preview Area 

There are several different ways you can see the effects of your material on an object.  
To switch preview modes, click the triangle at the bottom of the material preview and 
choose an option from the menu: 

• Normal: displays your object as it looks in your scene. This is the default view of 
your selected object.  
 

 
• Up Close: displays a zoomed-in view of your object.  

 

 
• Render With Neutral Sky: displays your object against a plain sky. When this 

option is disabled, your preview contains the current sky settings. This option 
makes it easier to see the material without being distracted by patterns in the 
sky.  

• Render With Neutral Ground: displays your object with a plain ground. When 
disabled, the ground in your preview has the same texture as the object.  
 
First image below is with the neutral sky and ground option selected, second 
image is with both options deselected.  
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• Current Selection: displays the material on the currently selected object type (i.e., 
box, sphere, etc.). This is the default object selected when you enter the 
Materials Lab.  
 

 
• Actual Selection: displays the selected object exactly as it appears in the your 

scene.  
 

 
• Cube: displays the material applied to a cube.  

 

 
• Sphere: displays the material applied to a sphere.  

 

 
• Cone: displays the material applied to a cone.  
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• Cylinder: displays the material applied to a cylinder.  
 

 
• Terrain: displays the material applied to a randomly generated terrain object.  

 

 
• Ground: displays the material applied to an infinite plane.  

 

 
• Torus: displays the material applied to a torus object. Torus objects are good for 

displaying material properties like altitude changes, slope and height changes, 
and metallicity.  
 

 
• Pyramid: displays the material applied to a pyramid.  
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• Circle: displays the material applied to a 2d disc.  
 

 
• Square: displays the material applied to a 2d face.  

 

 
To change the view angle of the preview area, drag the Preview area in the direction 
you want to view it from. The preview switches to wireframe as you move it. The angle 
of the preview does not affect the angle of the object in your scene. 

Materials Presets Library 

Material presets are predefined materials. Presets contain channels values that 
simulate a wide variety of commonly used surfaces. Presets are stored in the Material 
Presets Library. 
Presets are a great way of understanding how materials are made. You can open one 
of the presets and see what channel and components were used to create the final 
material. 

Using the Materials Presets Library 

The Materials Presets Library contains all the material presets available in Bryce. You 
can place them on your objects directly and edit them just as you would any other 
material. 
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To add a material from the Materials Presets Library to an object: 
1. Select an object. 

 

 
2. Access the Materials Library in one of the following ways:  

• In the Working window, click the triangle icon next to the Edit text button at 
the top of the Bryce environment.  
 

 
 
The Materials Presets Library appears.  

• Or, click on the  button, then on the Edit Materials tool.  
 

 
 
The Materials Lab will come up, click the triangle icon at the top-right of 
the Material Preview window.  
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• Or, click on the  button next to the selected object.  
 
The Materials Lab will come up, click the triangle icon at the top-right of 
the Material Preview window.  
 

 
3. Click one of the Category names along the left side of the dialog or click on the 

triangle icon at the bottom left of the library to choose a different category.  
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4. Click the thumbnail of the preset you want to add.  
 

 
5. Click the OK icon to add the selected material to your object.  
6. Render to see the result. 

 

 

Material Quick-Select 

You can also select presets in one motion by left-clicking then holding on the Materials 
Presets icon, then dragging directly to the desired material preset and releasing the 
mouse button. You can also drag over the category names to change categories into 
the category's presets and then release the mouse button. 
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To Quick-Select a material: 
1. Select an object in the scene.  
2. Left-click-hold on the Material Presets triangle. The Materials Library will come 

up. 
 

 
3. Without letting up on the mouse, drag the cursor over the categories until the one 

you want is displayed.  
 

 
4. Still holding down on the mouse, drag the cursor over the preset thumbnails, then 

let up on the mouse when the material you want to apply is selected.  
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The material will be applied to the object.  
 

 
Please note that you cannot change between main categories using this method. 

Animating Materials 

Animating Materials can add an exciting new dimension to your materials - time. Using 
the Animation Controls, you can interpolate between textures over time or change the 
properties of a single texture over the course of an animation. 
The animation tools are a great way of adding life to your scene. Instead of creating an 
animation with simple motion, you can create subtle effects like changing a cube from 
water to ice or changing the seasons on a mountain. 
Refer to "Animating Materials" for complete instructions on animating materials. 

Materials 

Materials are what brings your Bryce environment to life. A material defines the surface 
properties of an object in your scene. It has the power to turn a bunch of polygons into 
an island or the peaks of the Himalayas. You can also alter the basic function of an 
object. A simple cylinder becomes a pillar, a tree trunk or a metal pipe, just by adjusting 
the properties of the material applied to it. 
In Bryce, a material isn't just a picture that's wrapped around an object; it's a truly 3D 
surface. The material properties you assign to an object are applied to the whole object 
- inside and out. 
Bryce's volume materials let you apply a material to the interior of the object as well as 
to its surface. The Volume Material controls let you set how the entire object's volume 
reacts to its environment. 

Material Structure 

A material is made up of fourteen channels. Each of these channels defines a different 
property of an object's surface. When you combine all the channels together you get a 
material. New materials are created by adjusting the values for each channel. 
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There are two types of materials you can create in Bryce: surface materials, which 
define the properties of an object's surface, and volume materials, which define the 
properties of an object's volume. 

Understanding Surface Material Channels 

The fourteen channels of a surface material each represent a different surface property. 
These properties simulate different physical properties of a surface and the combination 
defines how the object's surface interacts with light in the Bryce environment. To 
understand how the channels work, you need to understand a little about how you 
perceive light and color. 
The color and size of an object are determined by how the light that hits the object is 
reflected back to your eye. Objects appear green because they reflect green light. An 
object appears shiny because it reflects light back at you. 
An object appears transparent because light passes through its surface, hits the objects 
behind it, and is reflected back through the surface. Bryce's material channels simulate 
all these behaviors. 
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When you set a channel value, you're setting how your object's surface interacts with 
the light that hits it, whether that light is from a direct source like the sun, or an indirect 
source like light reflected off other surfaces. 
When you're creating volume materials, your settings not only control how light interacts 
with the surface of the object, but also how it interacts with the object's volume. 
The effects of the channels are additive, meaning that each value you set directly 
affects all the other values. So, if you set the Diffuse Color to yellow and the Ambient 
Color to blue, the object will have a greenish tint. 

 
Channels are interdependent. For example, you won't see the effects of the Transparent 
Color if the object is not transparent or doesn't have a transparency map applied in the 
Alpha Channel. 
When you're using these channels, it's important to understand the physical property 
they're simulating. Only then can you make meaningful adjustments to the component 
values. 
For example, if you set both Transparency and Reflection to 100, you'll get an unusually 
bright object that doesn't look very realistic. The reason for this is that the object is 
emitting more light than it is receiving, something it couldn't do in reality. 

 
Since material channels simulate real-world surface properties, you should try to keep 
channel values within a realistic range. For example, in the image above, Transparency 
and Reflection are both set to 100. With these settings you're saying that 100% of the 
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light that hits the object passes through its surface and 100% of the light that hits the 
object is also reflected off its surface. The result is an object that emits more light than it 
receives because it is reflecting the light that hits it as well as the light from behind it. 
In reality, an object can only reflect a portion of the light that is passing through it. So, 
Transparency and Reflection values should always add up to 100. 
A good rule of thumb to keep in mind while you're setting these channels is that the 
Transparency and Reflection channels should always add up to 100 and the Diffusion 
and Ambience values should also always add up to 100. 

 
Each surface material is made up of fourteen channels, divided into three groups: 

• Color Channels 
• Diffuse Color   
• Ambient Color   
• Specular Color   
• Transparent Color   
• Specular Halo   
• Volume Color 

• Value Channels 
• Diffusion  
• Ambience   
• Specularity   
• Metallicity   
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• Bump Height  
• Optics Channels 

• Transparency   
• Reflection  
• Refraction  

 

Color Channels 

The Color group contains all the channels that control the color reflected off an object's 
surface. 
The channels in the Color group are Diffuse Color, Ambient Color, Specular Color, 
Transparent Color, and Volume Color.  

 
Diffuse Color, Ambient Color, and Specular Color define the colors the surface reflects 
when direct light hits it. For example, Diffuse Color defines the color that is reflected in 
all directions when direct light hits the object and Specular Color is the color that 
appears in the object's highlight. 
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These color channels are directly related to the Diffusion, Ambience, and Specularity 
channels. Diffusion, Ambience, and Specularity control how light reflects off the object, 
while Diffuse Color, Ambient Color, and Specular Color control the color of that light. So, 
for example, if you selected yellow as the Diffuse Color, the object appears yellow. The 
intensity of the yellow color is controlled by the Diffusion channel.  
Refer to "Diffuse Color," "Ambient Color," and "Specular Color" for more information. 
Transparent Color sets the color of any light that passes through the surface of the 
object and Specular Halo controls the size of the highlight that appears when an object 
has a shiny surface.  
Refer to "Transparent Color" and "Specular Halo" for more information.  
The remaining color channel, Volume Color, controls the color of the interior of the 
object. Refer to "Volume Color" for more information. 

Value Channels 

The second group of channels, the Value group, controls how much light affects an 
object. The channels in the Value group are Diffusion, Ambience, Specularity, 
Metallicity, and Bump Height. 

 
Diffusion, Ambience, and Specularity define how the surface interacts with direct light. 
They let you control how much direct light affects the surface of an object. In a physical 
environment, these channels control how shiny, dark, or bright the object appears.  
Refer to "Diffusion," "Ambience," and "Specularity" for more information. 
Metallicity is related to Reflection. It determines how much reflected light is filtered 
through the Diffuse Color.  
Refer to "Metallicity" for more information. 
Bump Height controls the height of any bumps or dents on the object's surface.  
Refer to "Bump Height" for more information. 
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Optics Channels 

The Optics group of channels controls the intensity of optical effects produced by the 
object's surface. The channels in the Optics group are Transparency, Reflection, and 
Refraction. 

 
Transparency and Reflection channels control how indirect light interacts with the 
object's surface. In a physical environment, these channels control how transparent or 
reflective the object appears.  
Refer to "Transparency" and "Reflection" for more information. 
Refraction is directly related to Transparency. The Refraction channel sets how much 
the light that passes though the object is bent.  
Refer to "Refraction" for more information. 

Understanding Volume Material Channels 

Surface Materials define the properties of the surface of an object. The interior of the 
object is empty. If you were to fly through the object you would see one layer of 
material, emptiness, and then another layer of material. A Volume Material is applied to 
the entire object, both inside and out. If you were to fly through a volume material you 
would be surrounded by material. 
When you're setting channel values for a Volume Material, you're setting up how light 
will interact with the object's volume. Channels control whether the interior of an object 
is bright, dark, shiny, or transparent. 
In most cases the interior of an object will be filled with a texture. If so, the channels 
control the surface properties of the elements within the texture. 
For example, if you apply blue spots as a Volume Material, you get a volume filled with 
blue spheres. The channels then control whether those spheres are bright, dark, shiny, 
or dull. When the interior of an object is filled with a texture, the material channels 
control the surface properties of the elements within the texture. 
Volume Materials are made up of thirteen channels, divided into three groups:  

• Color Channels 
• Diffuse Color 
• Ambient Color 
• Specular Color 
• Transparent Color 
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• Specular Halo 
• Volume Color 

• Value Channels 
• Diffusion 
• Ambience 
• Specularity 

• Volume Channels 
• Base Density 
• Edge Softness 
• Fuzzy Factor 
• Quality/Speed 

The channels in the Color and Value groups work exactly as they do for surface 
materials, except that the channel settings are applied to the object's volume instead of 
its surface. 
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Volume Channels 

The Volume channels control special volume properties of the object's interior. 

 
Base Density controls the density of the object. This channel defines how much material 
there is in the interior of an object. As a result, Base Density controls how much light 
passes into the object. A solid object doesn't allow any light to pass through it, while 
less dense objects allow more light in.  
Refer to "Base Density" for more information. 
Edge Softness, Fuzzy Factor, and Quality/Speed control the appearance of texture 
elements within the material. Edge Softness and Fuzzy Factor control the quality of the 
edges and sharpness of the texture, while Quality controls the render quality of the 
material.  
Refer to "Edge Softness," "Fuzzy Factor," and "Quality/Speed" for more information. 

Understanding Material Components 

Each Bryce material channel can contain up to three components that determine the 
channel's setting. A component can be a color, a texture or a numerical value. A texture 
can be either a 2D texture (picture) or a 3D texture. 
Each Bryce material channel contains components that determine its settings. You can 
have up to three texture components in a channel, and some channels let you use four 
textures and a value as components. 
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Colors can only be used in the Diffuse, Ambient, Specular, Specular Halo, Transparent, 
and Volume channels. Values are used in the Diffusion, Ambience, Specularity, 
Metallicity, Bump Height, Transparency, Reflection, Refraction, Base Density, Edge 
Softness, Fuzzy Factor, and Quality/Speed channels. 

 
When you're using a texture as a component, the information in the texture's channels 
is used as the value of the material channel. For example, if you're using a texture to set 
Diffuse Color, the texture's color channel is used. 
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If you're using a texture to set the Diffusion value, the texture's alpha channel 
determines the Diffusion intensity. 

 
Components are combined using one of three modes: Mode A, Mode AB, and Mode 
ABC. In Mode A, only one component is used to set the channel's value.  
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In Mode AB, two components are combined to set the channel's value, based on 
altitudes. The values from texture A are applied at low altitude and values from texture 
B are applied at higher altitude. 

 

 
In Mode ABC, the values of two textures, A and B, are blended based on the alpha 
channel of texture C. 
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When you're using textures as a component, you can choose from a number of preset 
textures or you can open the Deep Texture Editor and create your own textures. 
In some channels, you can use both a texture and a value. In this case, the value 
determines how much of the texture's value is used to drive the channel. For example if 
you apply a texture to the Bump Height channel, the texture sets the shape of the 
bumps and the value sets how prominent those bumps appear. 
In this example the shape of the bumps on the object is set by the texture component in 
the Bump Height channel, but the height of those bumps is set by the Bump Height 
value of 100. 

 

©2007 DAZ 3D, Inc.  565 



Bryce 6 Artist Guide 

Alpha Channels 

One of the outputs a texture component can produce is an Alpha channel. The Alpha 
channel is a grayscale representation of the texture pattern or grain. When you use a 
texture as a component in a material channel, these grayscale values are used to map 
surface properties. White areas in the Alpha channel represent 100% of the effect and 
black areas represent 0%.  

 
Images, or 2D textures, also contain an Alpha channel. In images, the Alpha channel 
acts as a mask for the image. The image's Alpha channel is used in the same way as a 
texture's Alpha channel. 

 

Surface Material Channels 

This section provides details on each of the Surface Material Channels. 

Diffusion 

Diffusion determines how much direct light is reflected diffusely, or scattered, in all 
directions. The small arrows projecting off the surface of the object illustrate how 
diffusion works. 
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When light hits an object with diffusion set to 100% (right image), all the light that hits it 
is reflected back scattered in all directions. This gives the object a flatly lit appearance. 
If the object's diffusion is set to 0% (left image), no light is reflected off its surface so the 
object appears black. Diffusion controls how much light is diffusely reflected off the 
object's surface. 

 

Setting Diffuse Color 

Diffuse Color acts like a filter through which all diffuse light passes. When light hits the 
object, the amount of light that's reflected diffusely is determined by the Diffusion 
channel setting, and the color of that light is set by the Diffuse Color channel. 
This graphic shows how diffuse light passes through the Diffuse Color. 

 

©2007 DAZ 3D, Inc.  567 



Bryce 6 Artist Guide 

When Diffusion is set to a value greater than zero, the Diffuse Color appears wherever 
the object is hit by direct light. Diffuse Color is the color of diffusely reflected light. 

 
Be careful when using pure constant colors as the Diffuse Color because you may not 
get the results you're expecting. If you use a pure color, only that color is reflected off 
the object. So if you're using 100% green, only green light is reflected off the surface. 
This doesn't cause a problem when the object is hit by white light because there is 
green in white. However, if you use 100% red light on the object, it will appear black, 
since there is no green in 100% red, so no light is reflected off the object. 

Setting Diffusion Using a Texture 

When you assign a texture to the Diffusion channel, the texture's alpha channel 
determines which areas of the surface have high diffusion and which have low diffusion. 
Bright areas in the alpha channel have a high diffusion value and darker areas have low 
diffusion values. 
When you use a texture to set the Diffusion channel, the grayscale values in the 
texture's alpha channel determine the diffusion of the objects. 
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If you're using a texture to set Diffuse Color, the texture's color channel is used and the 
value in the Diffusion value determines the intensity. 
Examples: 

• Diffusion value = 100  
 

 
• Diffusion value = 50 

 

 
• If you're using a texture to set the Diffusion value, the texture's alpha channel 

determines the Diffusion intensity. 
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Ambience 

Ambience simulates the effects of light hitting the object from all directions. The 
Ambience value controls the amount of light that is reflected off the surface uniformly. 
The large arrows represent ambient light hitting the object's surface. The smaller arrows 
represent the light reflected off the object's surface. 

 
When Ambience is set to a value higher than zero, the object will reflect light from all 
over its surface, not only from the area hit by light. This makes the object look brighter. 
The higher the Ambience value, the brighter an object appears. At 100% (right 
example), the object appears unnaturally bright, regardless of the light source. If you 
want to create a realistic effect, the sum of the Ambience and Diffusion values should 
add up to 100. The left example has Ambience set to 0%. 
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An object's Ambience is directly related to the general ambience of the environment. So, 
the ambient value you set for the object is directly affected by the Ambient Color you set 
in the Sky & Fog palette. 
The Ambient Color in the Sky & Fog palette controls how much ambient light is 
available in the environment. The Ambience channel controls how much of the available 
ambient light is reflected off the object's surface. 
So, if you set the Ambient Color in the Sky & Fog palette to black, or 0% ambience, then 
the Ambience channel value has no effect. If you set the Ambient Color to white, or 
100% ambience, the Ambience channel value will control how much of the available 
light is reflected off the object's surface. 

Setting Ambient Color 

Ambient Color is the color that is reflected off the surface of an object regardless of 
where the light source hits the object. The Ambient Color is directly linked to the 
Ambience channel setting. If the Ambience is set to zero, the Ambient Color is invisible. 
Ambient Color is the color that appears no matter where light strikes the object. 

 
The Ambient Color channel is also related to the Ambient Color you set in the Sky & 
Fog palette. The Ambient Color of the environment is added to the Ambient Color of the 
object, so if your environment is blue and your object's Ambient Color is yellow, your 
object appears green. 
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Setting Ambient Color Using a Texture 

When you assign a texture to the Ambient Color channel, the color channel in the 
texture is used as the Ambient Color. In other words, the texture's color is applied to any 
area of the object that's in shadow. 

 

Setting Ambience Using a Texture 

When you assign a texture to the Ambience channel, the grayscale values from the 
texture's alpha channel determine which areas of the surface have high ambience and 
which have low ambience. Bright areas in the alpha channel have high ambience 
values, and darker areas have low ambience values. 
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Generally, it's best to set Ambience using a value. However, you can get some 
interesting effects using textures instead. For example, if you use a splotchy texture, 
you'll get, mixed in with normal surface areas, areas that appear to glow regardless of 
external light. 

Specularity 

Specularity controls how much light is reflected back from the surface of the object 
directly at the viewer. Since the direct reflection creates a highlight on the object, you 
can think of Specularity as the channel that determines the intensity of the highlight that 
appears on the object or the "shininess" of the object. 

 
The higher you set the Specularity, the shinier the object appears. When the Specularity 
is set to zero, the object appears dull. This example shows Specularity set to 0% (left) 
and 100% (right). 

  

Setting Specular Color 

Normally, the color of an object's highlight would reflect the color of the light source. 
However, using Specular Color you can set a specific color for your highlight, as shown 
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here. Specular Color is directly linked to the Specularity channel. If the Specularity is set 
to zero, the Specular Color is invisible. 
By adding Specular Color, you can make it appear as though a colored light is shining 
on the object. 

 

Setting Specular Color Using a Texture 

When you assign a texture to the Specular Color channel, the texture's color channel is 
used as the Specular Color. In other words, the texture's color is applied to the object's 
highlight. 

 

Setting Specularity Using a Texture 

When you assign a texture to the Specularity channel, the grayscale values in a 
texture's alpha channel are applied to the object's highlight. Bright areas of the alpha 
channel increase the intensity of the highlight, and darker areas decrease the intensity. 
The alpha channel may also create patterns in the highlight. 
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When you use a texture to set the Specularity channel's value, the highlight's intensity is 
determined by the texture's alpha channel values. 

 

 

Specular Halo 

The Specular Halo channel lets you control the size of the Specular highlight. 
The size is controlled by the luminance value of the component you select. Brighter 
colors (left) create larger highlights and darker colors (right) create smaller highlights. 
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Colors are expressed as RGB (Red, Green, and Blue) values. Specular Halo channels 
use the values from each of these channels to set the size of the highlight. If the values 
are all in balance (that is, all the same), the highlight appears uniform. However, if one 
value is higher that the rest (for example, R=200, G=100, B=100), you'll get a highlight 
with a slightly colored ring (for example, a red ring). 

 
Depending on the component you use in this channel, you may be able to set each 
color value differently to create different highlight effects. The easiest way to use this 
channel is with a color. When using a color, try picking more desaturated colors. These 
colors produce more predictable results because the difference between RGB values is 
less. Check out the Specularity Lesson series in the Misc > Basic category in the Preset 
Materials Library to see Specular Halo in action. 

Setting Specular Halo Using a Texture 

When you assign a texture to the Specular Halo channel, the RGB value of the texture's 
color channel is used for the Specular Halo. 
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Metallicity 

The Metallicity channel value acts as a filter for reflected light. This value controls how 
much of the reflected light is filtered through the Diffuse Color. At 50% (left), half the 
reflected light is tinted with the Diffuse Color; at 100% (right), all the light that's reflected 
is tinted. 

 
Metallicity is linked to Reflection. If Reflection is set to zero, the Metallicity channel has 
no effect. 
Metallicity makes objects look metallic because it tints the color of reflections. If you 
want to create specific types of metals, you need to adjust the Diffuse Color. For 
example, to create gold use a yellow Diffuse Color. 

Setting Metallicity Using a Texture 

When you apply a texture to the Metallicity channel, the texture's alpha channel is used 
to determine the intensity of the Diffuse Color. Lighter areas of the alpha channel 
increase the intensity of the color, and darker areas decrease the intensity. 
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Bump Height 

The Bump Height controls the height of bumps in an object's surface. The bumps on an 
object's surface are determined by the texture's Bump channel. The Bump Height 
channel is linked to the Bump channel in the texture. If you use a texture without a 
Bump channel, the Bump Height channel has no effect. You can enter negative values 
(bottom image shows Bump = -100%) in this channel, which turns bumps into dents. 
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Transparency 

The Transparency channel controls how much light can pass through the object's 
surface. 
The higher the Transparency value, the more of the surrounding environment is visible 
through the object's surface. If there is no other light being reflected, an object set at 
100% Transparency appears invisible. 
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Transparency controls how much of the surrounding environment is visible through the 
object's surface. To create a realistic transparent object, you need to pay attention to 
details. You'll need to combine the effects of the other channels to simulate a realistic 
object. 
For example, transparent bubbles all have highlights, so you'll need to add Specularity. 
Balloons have a flatter surface so you'll need to add more Diffusion to the surface. 
Glass has a refraction effect associated to it, so you'll need to add Refraction to the 
surface.  
These examples show an object with 0% (left), 50% (middle), and 75% (right) 
transparency. 

   

Setting Transparency Color 

The Transparent Color channel determines the color of the transparent areas of your 
object. Light is filtered through this color as it passes through the object's surface. As a 
result, anything you can see through your object is tinted with the Transparent Color you 
select. 
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Keep in mind that the Transparent Color interacts with the other colors in the material. If 
the Diffuse Color is white, then the Transparent Color takes precedence. If the Diffuse 
Color is yellow, and the Transparent Color is red, the object appears orange. However, 
when you're using Refraction, the Transparent Color blends with the Diffuse Color. The 
Transparent Color tints everything you see through the surface of your object. This 
sample shows Transparent Color applied to the object. 

  
Transparent Color is linked to the Transparency channel. If the Transparency is set to 
zero, the Transparent Color is invisible. 

Setting Transparency Color Using a Texture 

When you assign a texture to the Transparent Color channel, the texture's color channel 
is applied to the transparent areas of your object. 
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Setting Transparency Using a Texture 

When you apply a texture to the Transparency channel, the texture's alpha channel is 
used to determine which areas of the object are transparent. Lighter areas of the alpha 
channel are not transparent while darker areas are. 
You can create some interesting effects using textures. For instance, a checkerboard 
texture will result in an object that's alternately transparent and solid. This example 
shows a checked texture applied to the Transparency channel. 
The final look of the Transparency channel is determined by the Shading mode. When 
the material is applied using normal shading, Transparency creates an optical effect. 
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When the material is applied using Blend Transparency mode, Transparency creates a 
punch-out effect, as shown here. The areas of the surface that are 100% transparent 
are completely ignored during shading so that they appear as gaps or holes it the 
surface. Any areas that are less than a 100% result in a normal transparency effect. 

  
Note that when using Blend Transparency, the Transparency value is set to 0. 

 

Reflection 

The Reflection channel controls how much light, direct or indirect, is reflected off the 
object's surface. Unlike diffusion, which scatters light, reflection directs light back at its 
source, giving the object a mirror-like appearance. 
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The higher the Reflection setting, the more reflective the surface. At 50%, half the light 
that hits the object's surface is reflected; at 100% all light is reflected. As you increase 
the Reflection value, the color of the object changes, since you can see more of the 
environment in the object's surface. 
Examples: 

• Reflection = 0 
 

 
• Reflection = 50 
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• Reflection = 100  
 

 

Setting Reflection Using a Texture 

When you apply a texture to the Reflection channel, the texture's alpha channel is used 
to determine which areas of the object are reflective. Lighter areas of the alpha channel 
are reflective, while darker areas are not. 

 

Refraction 

The Refraction channel determines whether light bends when it passes through the 
surface of an object. Higher Refraction settings produce slight reflections as some of the 
light is bent directly back at its source. Higher Refraction settings also change the color 
of the object's surface as the colors reflected from the environment affect the object's 
color. 
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The Refraction value is what makes transparent surfaces look like glass. As you 
increase the Refraction value, the edges of the object will become reflective. This 
simulates the effect of light being refracted so sharply that it does not penetrate the 
object's surface.  

 
In these examples you can see how the edges become more reflective as you increase 
the Refraction value. The higher you increase the Refraction value, the more the Diffuse 
Color is blended with the Transparent Color. The higher the value, the more Diffuse 
Color is visible in the object's surface. Any light that's visible through the surface of the 
object is then tinted through both the Diffuse Color and the Transparent Color. The 
examples below show a range of Refraction values from 0% to 300%. 
Refraction values are expressed as 100 x Refraction Index value. The Refraction Index 
contains refraction values for specific types of surfaces. For example, the Refraction 
Index of water is 1.3; this value is expressed as 130 in the Materials Lab. 
Robin Wood has an excellent tutorial on refraction along with a nice listing of the 
refraction index of gemstones, metals, liquids, and other transparent objects. Once at 
her site, click on Tutorials, then select General 3D from the popup listing. Link to her site 
is located in appendix E. 
Refraction is linked to Transparency. If Transparency is set to zero, the Refraction 
channel has no effect.  
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Examples: 
• Refraction = 0  

 

 
• Refraction = 50  

 

 
• Refraction = 120 (both); Diffuse Color = Pink (right) 

 

  

©2007 DAZ 3D, Inc.  587 



Bryce 6 Artist Guide 

• Refraction = 150 (both); Diffuse Color = Pink (right)  
 

  
• Refraction = 200  

 

 
• Refraction = 300  

 

 

Volume Material Channels 

Volume Materials use most of the same channels as surface materials. These channels 
all work the same as they do for surface materials. The only difference is that the 
channels control the properties of the object's volume, not its surface. 
In addition to the channels already discussed, Volume Materials have several 
specialized channels.  
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Volume Color 

The Volume Color channel controls the color applied to the interior of an object. 
Everything inside the object will appear tinted with this color as all light is filtered 
through the Volume Color. 

 
The Volume Color interacts with the Transparent Color. If your surface is transparent, 
light is tinted by the Transparent Color and the Volume Color. 
The Volume Color tints everything inside the object. This is an example of Volume Color 
applied to the object's interior. 

 
Volume Color is an excellent way of creating underwater light effects. 

Base Density 

Base Density controls how dense the object is. In areas where the object is very dense, 
no light passes through the object. Where the object is less dense, more light passes 
through its volume. Base Density works like Transparency in 3D space. Areas that are 
less dense appear to be more transparent.  
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This example shows Base Density set to 100% (left) and 10% (right). 

  
High values create very solid objects like rocks, while lower settings create less dense 
objects like clouds. You should use this channel cautiously. The more transparent 
objects are, the more time they take to render. 

Setting Base Density Using a Texture 

When you use a texture to set the Base Density channel, the Alpha channel is used to 
determine which areas of the object are solid and which are empty. 

 

Edge Softness 

Edge Softness controls the softness of the edges of the silhouettes of objects with a 
volume material. For example, a sphere with a low Edge Softness value will have a 
"hard" silhouette, meaning that you'll be able to clearly see the edges of the sphere. A 
high Edge Softness value will almost totally obscure the edges of the sphere.  
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This example shows an object with an Edge Softness of 0% (left) and 100% (right). 

  
This channel is useful for obscuring the general shape of an object. 

Fuzzy Factor 

Fuzzy Factor controls the dullness or sharpness of a material. Values greater than 100 
adjust the dullness of the material and values less than 100 adjust the sharpness of a 
material. At 100 there is no dullness or sharpness applied.  
As you increase the dullness of your object, it becomes less dense, so you may have to 
increase the Base Density to compensate. Likewise, as you increase the sharpness of 
the object it becomes more dense. You can use this channel to smooth sharp-looking 
clouds or sharpen dull stone textures.  
Examples: 

• Fuzzy Factor = 0  
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• Fuzzy Factor = 100  
 

 
• Fuzzy Factor = 200  

 

 
• Fuzzy Factor = 300 

 

 

Quality/Speed 

Quality/Speed controls the render quality of the texture. This channel represents the 
inverse relationship between render quality and rendering speed. As you increase the 
render quality of the material, you decrease the speed at which it's rendered. As you 
increase the speed at which a material is rendered, you decrease its quality. 
The material loses detail as the quality decreases. Detail is introduced as quality 
increases. For still images you probably want to increase the quality of the material and 
sacrifice speed, since the scene only has to be rendered once. For animations, you 
probably want to sacrifice quality since the scene will have to be rendered once for each 
frame in the movie. 
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Examples: 
• Quality/Speed = 0 

 

 
• Quality/Speed = 50 

 

 
• Quality/Speed = 100  
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Material Components 

This section describes the various components you can use to set a Material Channel 
Value. It also describes how to set the parameters for each component. 

Color Components 

A Color Component is an RGB color that is directly applied to a channel. Colors can 
only be used in the Color channels: Diffuse, Ambient, Specular, Specular Halo, and 
Volume. 

 
When you're using a color in these channels you cannot combine it with a texture. If you 
choose a texture component for any of the Color channels, the color oval appears 
blank. The Volume channel can only be set with a color. 

 
To use a color as a component, in the Materials Lab, click the color oval in one of the 
channel rows on the Material Grid and choose a color from the palette.  

 
The selected color appears in the color oval. 
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Value Components 

Value components are numerical values you use to set the intensity of a channel. 
Values can only be used in the Value, Optics, or Volume channels. 
A value is indicated by either the numerical field in the left side of the channel in the 
Material Grid, or the slider that extends out from the channel. The sliders let you quickly 
set the value of a channel, and the numeric field shows the current setting. 

 
Values can be used with textures. In this case the value sets how much of the texture is 
applied to the channel. For example, if you use an orange-colored texture to set the 
Diffuse Color channel, the value would indicate how much of the texture color is used as 
the Diffuse Color. 
A value of 100 means that all the texture information is used in the channel; a value of 0 
means that none of the texture is used. 
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Not all channels use values. The Color channels only use colors or textures. The 
Refraction channel can only be set with a value. 

 
To use a value as a component, in the Materials Lab, drag the slider next to the channel 
whose value you want to set. As you drag, the numerical value appears in the number 
field. The Bump Height channel let you set negative values. 

 
You can also click in the numeric field and manually enter a value. 

 

©2007 DAZ 3D, Inc.  596 



Bryce 6 Artist Guide 

Texture Components 

When you use a texture as a component, Bryce extracts values from the texture to use 
as a value for the material channel. There are two types of texture components you can 
use: pictures and 3D textures. 
Pictures are images you import from either the Pictures Editor or from another 
application. 3D textures are procedural textures generated by Bryce and stored in the 
Texture Library. 
You can assign up to four textures as components for a material. These textures can be 
any combination of pictures and 3D textures. Each texture component is assigned a 
letter: A, B, C, or D. The texture you assign to a component is used throughout the 
material, so the texture you assign as component A in the Diffusion channel is the same 
component A used in the Ambience channel and so on. 

 
When you're setting channel values, you can mix and match components. For example, 
you can assign component A to Diffusion and component D to Ambience. You can also 
combine textures within the same channel using the blend modes AB and ABC. In this 
case the texture you assigned to A is blended with the textures assigned to B and C to 
set a material channel value.  

 

The Texture Component Window 

The Texture Component Window displays the attributes of a selected texture 
component. You can have up to four windows visible in the Materials Lab. The six 
buttons on the Texture Component Window let you set the type of component, the 
texture mapping mode, and access the texture transformation controls and the Deep 
Texture Editor. 
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To use a Texture as a component, click a column in the material grid. A Texture 
Component Window appears. The component window corresponds to the columns in 
the grid, so if you click in column A in the grid, texture component A becomes active. 
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3D Textures 

3D Textures have three different types of outputs: Color, Alpha channel (value), and 
Bump. These outputs are used differently by the material channels. 

 
Color channels use the texture's color to set the value of the channel. For example, if 
you use a texture in the Diffuse channel, the colors in the texture appear wherever the 
object reflects light diffusely. 
When you use a texture to set the value of a Color channel, the color information is 
used to set the material channel value. The example below shows Diffuse Color set 
using a color (left) and using a texture (right). 

  
Value, Optics, and Volume channels use the Alpha channel information from a texture 
to set the value of the material channel. For example, when you use a texture to set 
Specularity, the texture's Alpha channel information determines which areas of the 
object are shiny. As a result, you'll see the pattern of the texture on the object. 
When you use a texture to set the value of an Intensity channel, the Alpha channel 
information is used to set the material channel value. In the example below, Specularity 
was set using a color (left) and a texture (right). 
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The Bump information in a 3D texture is used only by the Bump Height channel. The 
Bump channel in the texture determines the pattern of bumps or dents in the object. In 
fact, you won't be able to see the effects of the Bump Height value unless you assign a 
texture to the channel. Bump channel information from a texture is used to determine 
the pattern of bumps or dents in an object. You must assign a texture to the Bump 
Height channel to see the bumps or dents. 

  

Using a 3D Texture as a Component 

To use a 3D Texture as a component: 
1. Load an object and click on the  button to enter the Materials Lab. 
2. In the Materials Lab, click in a channel column. A randomly selected texture 

appears in the Texture Component Window. 
 

 
3. If you want to change this texture, click the triangle button next to the texture 

name at the top of the window 
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and choose a preset texture from the menu. You can also press Shift+click on 
the triangle to access the Texture Library directly instead of a listing of the 
textures. 

4.  
 
Note: To access a different main category from the Texture Library via the menu, 
you will need to enter the Texture Library, select a category, then exit the library. 
The new category will then be available from the menu.  
 
The texture you selected appears in the Component window. 
 

 
 
OR 

5. Click on the pink Texture Source Editor button on the left-hand side of the 
window to enter the Deep Texture Editor. 
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2D Textures 

2D Textures are pictures you've created in another application or ones you select from 
the Pictures Editor. The data in the channels of these pictures are used as values in the 
material channels. 

Loading a New 2D Texture 

To load a new 2D texture as a component, without overwriting one already in the editor: 
1. Load an object and click on the  button to enter the Materials Lab. 
2. In the Materials Lab, click in a channel column. A texture appears in the texture 

component window.  
 

 
3. In the Component window, click the P button at the bottom of the Component 

window. The button changes the component to a 2D picture.  
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4. A default picture appears in the Component window. 
 

 
 
To change the picture, click the pink button at the top of the Component window. 
The pink button displays the Pictures Editor.  
 

 
5. Click an image square to load an image or if the image you want is not in the 

library:  Click in an empty square. 
 

 
 
The Load Image dialog appears.  
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6. Navigate to the folder where the image is located, select it, and click on Open. 
 

 
 
The image will be loaded in the into the first image box. If an alpha channel is 
saved with the image, it will be loaded into the second image box.  
 

 
7. To load an alpha channel separately, click on the Load button above the middle 

box. 
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8. The Load Image dialog appears. Find the alpha channel image, select it, and 
click on Open.  
 

 
 
The alpha channel/mask will be loaded into the second image box.  
 

 
9. Click on the OK icon to exit the Pictures Editor. You'll be returned to the Materials 

Lab where you'll see the image in the component window. Notice that the alpha 
channel/mask is not "working" but that is easy to fix.  

10. If you loaded an image in the alpha channel, click in the column next to 
Transparency.  
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Make sure the amount is at zero (0). 
 

 
11. Click on the Material Options triangle to access the menu.  

 

 
12. Select Blend Transparency from the menu.  

 

 
13. The Material Preview should now show the texture with the alpha channel 

applied. Click on the OK icon to exit the Materials Lab. 
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14. Render the scene to see the result. 
 

 

Replace Current 2D Texture Using Load Button 

While clicking on a blank square adds a new Pictures Editor texture, a texture already in 
the editor can also be replaced by either loading a new texture or by copying an image 
from a paint program and pasting into the editor.  
To replace a 2D texture using the Load button: 

1. In Bryce, open the Pictures Editor, click on the square containing the image you 
want to replace. 
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2. Click on Load above the image window. The Open dialog will come up.  
 

 
3. Locate and select the image you want to load. Click on Open.  

 

 
4. The image will be loaded into the window you selected. Notice that the image 

was replaced in the square below. 
 

 
5. Click on the OK icon to exit the editor or load an image in the alpha channel if 

needed.  
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Caution: Once you load the image, you cannot get the original image back by clicking 
on the Close icon and canceling the operation. So be sure this is what you intend to do 
before you do this.  

Replace Current 2D Texture Using Copy/Paste 

While clicking on a blank square in the Pictures Editor adds a new texture, a texture 
already in the editor can also be replaced by either loading a new texture or by copying 
an image from a paint editor and pasting into the editor.  
To load a new 2D texture as a component, by copying from a paint program and pasting 
into the editor: 

1. Load or make an image in your favorite paint program (i.e., Paint Shop Pro, 
Photoshop, Painter, Dogwaffle, etc.).  

2. Copy the image to place it in the clipboard. 
3. In Bryce, open the Pictures Editor, click on the square containing the image you 

want to replace. 
 

 
4. Click on Paste below the image window. 

 

 
5. A popup will come up asking if you are sure you want to delete the image. Click 

on Delete. 
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The image will be loaded into the window you selected. Notice that the image 
was replaced in the square below. 
 

 
6. Click on the OK icon to exit the editor or load an image in the alpha channel if 

needed.  
Caution: Once you click on Delete and load the image, you cannot get the original 
image back by clicking on the Close icon and canceling the operation. So be sure this is 
what you intend to do before you confirm the deletion. 
Combining Components 

Combining Components 

You can combine material components using one of three blending modes: 
• Mode A 
• Mode AB 
• Mode ABC 
• What About D? 

©2007 DAZ 3D, Inc.  610 



Bryce 6 Artist Guide 

Mode A 

In Mode A, only one component is used to set the value of a channel. The component 
can be a value, a picture, or a 3D texture. 

 

 

Mode AB 

In Mode AB, two textures are blended together based on altitudes. At the lowest 
altitudes, the values from texture A are used; at higher altitudes, texture B is used to set 
the value of the channel. 
Altitude is based on the distance between the ground level and the highest object in 
your scene. 
When you use this mode, an object's surface material is a blend between two texture 
components. Texture B appears at the bottom of the object and Texture A appears at 
the top. In between is a blend between texture B and texture A. Bryce creates the blend 
by interpolating between the two textures. 
For example, if you use Mode AB in the Diffuse Color channel, the color in texture A 
appears at the bottom of an object's surface, and the color from texture B appears at the 
top. A color gradient between color A and color B appears in the middle of the object 
Mode AB can be used to create snow covered peaks on terrains or murky depths in 
infinite water slabs. 
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To use Mode AB to blend textures, in the Materials Lab, Ctrl+click the B column of a 
channel. Component indicators appear in both the A and B columns of the channel. 

 

 

Mode ABC 

In Mode ABC, two textures, texture A and texture B, are blended based on the alpha 
channel of texture C. 
In this mode, the alpha channel from texture C acts like a map that tells Bryce where to 
apply the values from texture A and texture  
B. The white areas of the alpha channel use values from texture A.  Black areas in the 
alpha channel use values from texture B. Gray areas in the alpha channel use a 
combination of both textures. 
To use Mode ABC to blend textures, in the Materials Lab, Ctrl+click the C column of a 
channel. Component indicators appear in the A, B, and C columns of the channel.  
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What About D? 

When Component D is used along with any other combination of textures, it is used to 
add a new element to the material. It is not combined with the other components. 
This allows you to use Components A, B, and C to drive the color of the material and 
use Component D to drive a different value, such as bump or transparency. 
The example below shows a material with the Diffuse color driven by A and B, and an 
entirely different texture in D driving the bump. 
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Texture Mapping Modes 

Once you've decided on a texture to use as a component, you need to decide how the 
texture is mapped onto your object. The appearance of the texture can change 
dramatically depending on how it's applied to the object. 
Each texture you apply can have a different mapping mode. When you're mixing 
textures (Mode AB or Mode ABC), you can choose which portions of your textures you 
want to combine. 
To select a mapping mode for a texture: 

1. In the Materials Lab, click a channel. A random material will be applied.  
 

 
2. If you'll be using a 2D image, load a 2D Texture to replace the 3D one.  
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3. Click the current Mapping Mode title to access the Mapping Mode Options. 
 

 
4. Choose a mapping mode from the menu.  

 

 

Object Space 

In this mapping mode, textures are scaled proportionally to the size of your object. If you 
change the size of your object, the texture scale changes with it. The texture also 
rotates along with the object. This means that the texture does not appear to move as 
you reposition or rotate the object. 
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World Space 

In this mode, the texture is applied throughout infinitely large 3D space, and only a small 
portion is applied to your object. This means that the texture appears to change as you 
move your object, since the object is moving through the texture in 3D space. 

 

Parametric 

In this mode, the texture is applied onto the object as if it were a decal. For example, if 
you use this mapping mode on a cube, one iteration of the texture is placed on each 
face. 
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Parametric mode applies the texture as a 2D decal. The texture is mapped onto the 
object so it rotates and scales as the object is scaled or rotated. This mode works best 
with 2D Pict textures. 

Parametric Scaled 

This mode works like the World Space mode, only in 2D. Textures mapped using this 
mode are not scaled with the object. 

 
Use this mode when you want to map a 2D picture onto constructed objects like 
buildings. 

Sinusoidal 

In this mode, the texture is applied as in a map projection usually used to show the 
entire surface of a spherical object, such as the earth, moon, or celestial map.  

  

Spherical 

In this mode, a 2D projection of your texture is mapped onto a virtual sphere that 
surrounds your object. It is then projected from the sphere onto your object. 
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Cylindrical 

In this mode, your texture is mapped onto the front of your object, wrapping around the 
right and left sides all the way to the back. Edge pixels going to the center appear on 
the top and bottom of your object. 

 

Reflection Map 

In this mode, a 2D projection of your texture is applied to a virtual sphere that surrounds 
your scene. The texture is then reflected off of the sphere and onto your object. 
This mode works best on objects with irregular surfaces. It also works well with terrains.  
The image below shows a sphere with reflection mapping (left), world space (middle), 
and parametric (right) mapping applied  
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Random 

This mode randomly applies a 2D projection of the texture all over the surface of your 
object. 

  

Object Top 

This mode applies a 2D projection of the texture to the top of your object. The texture 
rotates and scales along with the object. 
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Object Front 

This mode applies a 2D projection of the texture to the front of your object. The texture 
rotates and scales along with the object. 

 

Object Side 

This mode applies a 2D projection of the texture to the side of your object. The texture 
rotates and scales along with the object. 

 

Object Cubic 

This mode applies a 2D projection of the texture to all sides of your object. The texture 
rotates and scales along with the object. 
This is most clearly seen in the second image below where the Leo image is applied 
using Object Cubic mode. The image is seen in its entirety on all sides of the objects. 
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World Top 

In this mode a 2D projection of the texture is applied to the object from directly above it. 
If you move your object or rotate it, the texture does not move with the object; it remains 
constant while the object moves through it. 

  

World Front 

In this mode a 2D projection of the texture is applied to the object from the world front. If 
you move your object or rotate it, the texture does not move with the object; it remains 
constant while the object moves through it. 
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World Side 

In this mode a 2D projection of the texture is applied to the object from the world side. If 
you move your object or rotate it, the texture does not move with the object; it remains 
constant while the object moves through it. 

  

World Cubic 

In this mode a 2D projection of the texture is applied to the object from all world sides. If 
you move your object or rotate it, the texture does not move with the object; it remains 
constant while the object moves through it. 
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Mapping Mode Modifiers 

You can modify the mapping modes in the following ways:  

 

Symmetric Tiling 

When you tile a texture onto an object in symmetrical tiling mode, each repeated 
instance of your texture is tiled horizontally and vertically. as needed to seamlessly 
produce a symmetrical pattern over the surface of the object. 
In Symmetrical Tiling mode, textures are seamlessly tiled across the object. 

 

Repeat Tiling 

Unlike symmetrical tiling, in which a seamless tiled pattern is achieved by flipping the 
texture horizontally and vertically, Repeat Tiling repeats your texture across the surface 
of your object without any alteration in orientation. The number of instances of the 
texture depends on the scale applied to the texture. 
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Scale Pict Size 

This mode modifier only affects picture textures. When selected, the image behaves like 
a sticker placed on the surface of the textured object. Unless Scale Pict Size is 
selected, the picture will repeat itself across the surface in a similar way to Repeat 
Tiling. 

 

Centered Transforms 

Centered Transforms works with parametric mapping modes to force the transformation 
of the textures to be applied around the center of the object surface. 
This option is not available ("greyed out") unless a parametric mapping mode is 
selected. 
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Decal Colors 

Decal Colors blends the color of a texture with the affected component's base color. It 
uses the texture's alpha channel to control the amount of blending. This can make 
decalcomania effects easier to achieve. 
The image below shows the same checked pattern used on previous pages, but with 
Decal Colors selected. 

 

Alpha Scaling 

Normally, if you drive a component's value with a texture, the texture's alpha channel 
will set the value without regard to the amount that was set using the component's 
slider. With Alpha Scaling turned on, the amount set with the slider will "scale" the 
amount provided by the texture's alpha channel. This gives you more subtle control over 
the influence of the texture on the material component's value. 
Alpha Scaling works with Diffusion, Ambience, Specularity, Metallicity, Transparency, 
and Reflection. It has no effect on Bump Height since bump is not driven by alpha 
channels. 
The image below shows Diffusion set at 25, 50, and 75, with the second row using 
Alpha Scaling. Notice how the top row doesn't show any difference in diffusion without 
Alpha Scaling selected. 

 

©2007 DAZ 3D, Inc.  625 



Bryce 6 Artist Guide 

Pict Interpolation 

This mode modifier is enabled by default. It interpolates the pict file you are using, 
allowing the pict file to be applied smoothly to an object. With Pict Interpolation disabled, 
the image may appear to be pixelated or jagged. 
The image below shows two cubes with the same texture applied. The cube on the right 
has Pict Interpolation deselected.  

 

Transforming Textures 

Since a 3D texture exists in three-dimensional space, it can be transformed along the X, 
Y, or Z axis - just like a 3D object. Using the texture Transformation Tools, you can 
scale, position, or rotate your texture. 
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The final look of the transformation depends on the mapping mode you use to apply the 
texture to the object. In some modes, texture transformations may not be very 
noticeable, while in others, like Parametric, transformations can have a large impact on 
the look of the material. 
You may find it necessary to experiment with different settings to get the results you 
want. If you find that the texture isn't reacting the way you want it to, try changing the 
mapping mode. 
The transformation tools give you very fine control over the final appearance of the 
texture. 

Texture Scale 

Using the Scale Control, you can control the frequency of the texture. Increasing the 
scale of a texture decreases the frequency of the pattern, since it doesn't have to be 
repeated as many times to cover the surface of the object. 

 
Since a 3D texture exists in 3D space, you can change its size in all three axes. 

• Adjusting the scale in X changes the size of the texture along the X axis. 
• Adjusting the scale in Y changes the size of the texture along the Y axis. 
• Adjusting the scale in Z changes the size of the texture along the Z axis. 
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This example shows the X axis (top row), Y axis (middle row), and Z axis (bottom row). 
From left to right on each row, the scale values are 0%, 45%, and 90%.  

 

 
The texture can also be scaled by dragging the channel slider up or down. Dragging the 
slider up increases the texture size while dragging it down decreases the texture size. 
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Texture Rotation 

Using the Rotation Control, you can control the angle of the texture on the object's 
surface. You can create very different texture effects depending on the texture's 
orientation. 

 
Since a 3D texture exists in 3D space you can change its orientation in all three axes. 

• Adjusting the rotation in X changes the angle of the texture along the X axis. 
• Adjusting the orientation in Y changes the angle of the texture along the Y axis. 
• Adjusting the orientation in Z changes the angle of the texture along the Z axis. 

This example shows the X axis (top row), Y axis (middle row), and Z axis (bottom row). 
From left to right on each row, the rotation values are 0°, 45°, and 90°. 

  

Texture Position 

Using the Rotation Control, you can control the angle of the texture on the object's 
surface. You can create very different texture effects depending on the texture's 
orientation. 
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Since a 3D texture exists in 3D space you can change its orientation in all three axes. 

• Adjusting the rotation in X changes the angle of the texture along the X axis. 
• Adjusting the orientation in Y changes the angle of the texture along the Y axis. 
• Adjusting the orientation in Z changes the angle of the texture along the Z axis. 

This example shows the X axis (top row), Y axis (middle row), and Z axis (bottom row). 
From left to right on each row, the rotation values are 0°, 45°, and 90°.  

 

Shading Modes 

Shading refers to the process of applying material channel values to an object. When an 
object is shaded, the different values in the material are applied to the object. The 
shading modes available in Bryce determine how material channels are applied to 
create different effects. 
Using a material, you can define whether a surface is shiny, smooth, or opaque.  
Using a shading mode, you determine how those properties are applied to the object.  
The shading mode can not only determine how the material is applied to the surface of 
the object, but how it's applied to the object's volume as well.  

©2007 DAZ 3D, Inc.  630 



Bryce 6 Artist Guide 

To choose a shading mode, click the triangle icon next to the material type buttons at 
the top of the Materials Lab.  

  

Surface Material Shading Modes 

This section explains the Surface Material Shading Modes. 

Normal 

Normal mode applies the values of the material without modifying them in any way. 
Objects are shaded according to the values you set in the material channels. This mode 
has no special effects; it simulates a real-world appearance using the material channel 
values. This is the default mode and is appropriate for most objects. 
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Blend Transparency 

In Blend Transparency mode, visibility is controlled by Transparency. When this mode is 
active, areas of the object that are 100% transparent are ignored. Transparent areas 
are not shaded and do not cast shadows. These areas appear as gaps or holes in the 
object's surface. 

 
This mode lets you create punch-outs when using a texture. The lower cage in this 
example was created by using blend transparency to "punch-out" areas of the object's 
surface (the upper was created using normal shading). 
When the material is applied using Normal mode, Transparency creates an optical 
effect. 

 
When the material is applied using Blend Transparency mode, Transparency creates a 
punch-out effect, as shown here. The areas of the surface that are 100% transparent 
are completely ignored during shading so that they appear as gaps or holes it the 
surface. Any areas that are less than a 100% result in a normal transparency effect. 
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Fuzzy 

Fuzzy mode changes the effective transparency based on the thickness of the object. 
As a result, objects appear fuzzy on the edges and solid at the center. 
Since Bryce uses depth information to synthesize this blurry effect, it is not available for 
2D objects such as Squares or Disks. 
Use the Transparency setting to adjust the degree of fuzziness.  

 
The image below shows the material with Transparency at 0: 

 
And with transparency increased to 15: 

 

Light 

Light is a very specialized shading mode best used to create visible lighting effects. 
Objects shaded with this mode appear transparent and self-illuminating. 
Only the Diffuse, Ambient, and Transparent Color channels are used to determine the 
color of the light. All other channels are ignored. 
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This mode is useful for creating point lights without the rendering overhead that comes 
with true volume light objects (that is, light-sensitive volume materials). 

 
The image below shows a material applied to the Diffuse Color channel with the Light 
shading mode selected: 

 

Volume Material Shading Modes 

This section explains the Volume Material Shading modes. 
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Flat Shading 

Flat Shading mode is designed for clouds, gases, and other self-luminous gaseous 
materials. Flat Shading mode does not shade an object, meaning that light sources 
have no effect on the color or brightness of the object. 
When this mode is active, Diffusion, Ambience, Specularity, Ambient Color, Specular 
Color, and Transparency Color have no effect. 
The color of the material is determined entirely by the Diffuse Color channel. 

  

Basic Shading 

Basic Shading mode is designed to apply shading and light effects to the exterior 
surface of a volumetric object without affecting the interior. When this mode is active, 
volumetric objects are shaded as if they have a surface material applied to them rather 
than the actual volume material. 
In this mode, light sources have a limited effect on the color and brightness of an object. 
Only the exterior surface of the object will be affected by light sources; light and 
shadows will not be generated within the object. 
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Full Shading 

Full Shading mode is designed for hard edged, sharp objects like rocks. When Full 
shading mode is active, the visible portions of the material are shaded and can be 
affected by light sources. 
Since light sources can affect portions of your material, shadows will appear within the 
object. This can greatly increase rendering time. If you don't need to see shadows in the 
object, make sure the Receive Shadows filter is disabled. Usually you should disable 
this filter unless you're creating very specialized effects. 

  

Light Sensitive 

Light Sensitive mode is designed for creating visible light effects such as light beams. 
Light Sensitive mode does not shade objects, but the particles in your material are 
sensitive to light. 
In this mode, Density doesn't control density as much as it sets the light sensitivity of 
material particles. Higher values create brighter particles and lower values create darker 
particles. To get the best results for light objects, use the Additive blend mode. 
The color of the particles is determined entirely by the Diffuse Color channel. The result 
is like shining a light through a volume. If you were shining a light through a cloud 
material, you would be able to see the clouds within the light cone. 
When this mode is active, Diffusion, Ambience, Specularity, Ambient Color, Specular 
Color, and Transparency Color have no effect. 
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In this example, the Light Sensitive mode was used to apply material inside the sphere 
on the right (left image). When the sphere is lit by a light source, the particles of the 
material become visible (right image). 

  

Uniform Density 

Objects can have varying densities. By default, objects have a density that varies from 
center to surface. The object is most dense at the center and becomes less dense as 
you approach the surface. You can control the starting point of this variation in density 
by using the Edge Softness control. 
However, you may want to create objects that do not vary in density. Uniform Density 
mode sets the object to have a consistent density throughout the object. The density at 
the starting point is used throughout the object. This results in harder-looking objects 
and faster rendering times. 

 

©2007 DAZ 3D, Inc.  637 



Bryce 6 Artist Guide 

The image below shows two spheres with Uniform Density selected. The sphere on the 
left has the Edge Softness set to 100, while the sphere on the right has the Edge 
Softness set to 5. 

 

Sky Integration 

Sky Integration mode is designed to increase the realism of volume objects in scenes 
that have hazy or foggy atmospheres. When Sky Integration mode is active, the sky 
effects such as haze and fog are taken into account when the volume object is 
rendered. This helps blend objects realistically into the atmosphere. 
This mode is very useful for creating realistic cloud objects or fog objects. 
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The image below shows two spheres with a cloud texture applied. The sphere on the 
right has Sky Integration enabled. On these small objects, it's not easy to see the 
difference, but the sphere on the right shows a slight difference in how it is blended into 
the sky. 

 

Shading Mode Modifiers 

Shading Mode Modifiers are not shading modes, but they modify an existing shading 
mode. When you select a modifier it remains enabled until you disable it. You can also 
apply more than one modifier at the same time. 

Additive 

When the Additive modifier is active, material channels are applied to the environment 
behind the object instead of to the object's surface. 
If you put an object on a bright background, it appears almost white. For best results, 
set your Ambient Color control to zero and render against a dark, plain background. 
Objects with this shading mode modifier selected will not cast shadows. 
This mode is very useful for creating planets and quarter moons, light beams, and ghost 
images. 
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Cast Shadows 

The Cast Shadows modifier prevents an object from casting shadows. The object's 
surface still reacts normally with light but it does not cast any shadows. 

 

Receive Shadows 

The Receive Shadows modifier prevents an object's surface from accepting shadows 
cast by objects around it. The object itself will cast a shadow, but it won't accept 
shadows from other objects. 
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Self Shadows 

The Self Shadows modifier prevents an object from casting a shadow onto itself, yet still 
shadow all the other elements of the scene. 

 
The image on the left shows the bottom torus with Self Shadows enabled while the 
image on the right shows the same torus with Self Shadows disabled. The arrow shows 
where the difference is between the two. 

 

Distance Blur 

The Distance Blur modifier is designed to minimize the problem created by highly 
bumpy textures fading into infinity (i.e., the horizon). Often, moiré-like patterns appear in 
these cases as the pixels try to resolve the infinitely receding high frequencies of bumpy 
water or grooved sand, and so on. The Distance Blur modifier fades the bumpiness well 
before it hits the horizon. 
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The images below show the same material on the ground plane, but the image on the 
right has Distance Blur enabled. 

  

Sampling Blur 

The Sampling Blur mode is only available when using a Volume Material and helps to 
reduce rendering artifacts. This option should always be selected when using Volume 
Materials. 

 
Example: 
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Volume Blend-Altitude 

The Volume Blend - Altitude modifier gradually blends in the Volume color based on 
Altitude. Areas at lower altitudes are tinted with the 100% Volume Color; as you move 
higher up, less of the Volume Color is added. 
This modifier can be used to create a sense of depth in an infinite water slab. If you 
blend between a light Diffuse Color and a darker Volume Color, you can create the 
illusion of depth as you sink deeper into the water.  

 
The images below show a water slab with the Volume Blend - Altitude enabled in the 
image on the right. 

  

Volume Blend-Distance 

The Volume Blend - Distance modifier blends the Diffuse and Volume Colors of your 
material based on the distance from the camera. 
Areas that are closer to the camera will be tinted less with the Volume Color. As you 
move further away, more of the Volume Color is visible. This modifier is excellent for 
creating underwater depth effects. If you blend a darker Diffuse Color with a lighter 
Volume Color in an infinite slab, you can simulate the effects of murky water on distant 
objects. 
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The images below show a water slab with the Volume Blend - Distance enabled in the 
image on the right. 

  

Deep Texture Editor 
You can edit the makeup of an existing texture or create a completely new texture using 
the Deep Texture Editor. This editor uses some rather complex texture-generation 
concepts to create textures for Bryce. You can either choose to learn all these concepts 
to create your textures precisely, or use the editor as a type of lab where you combine 
random settings and see the results.  
The Deep Texture Editor (DTE) can be used in two ways: by working with equations 
and algorithms or by exploring and experimenting.  
If you're comfortable with equations and algorithms, the Deep Texture Editor gives you 
the freedom to create any textural pattern or surface you can imagine.  
For those who don't want to calculate, the Deep Texture Editor can be used as a large 
palette. Take a little of this and little of that, blend them all together and see if you like 
the result. You will find that experimenting with these deep functions can produce 
unexpected results.  
When experimenting with the Deep Texture Editor, you may inadvertently create a very 
complex texture that could add considerably to your rendering time. However, this is an 
easy pitfall to avoid. The last section of this chapter gives you some tips on reducing the 
complexity of your textures. Refer to "Tips for Speeding up Textures" for more. 
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A Quick Tour of the DTE  

The layout of the Deep Texture Editor is a visual representation of the texture creation 
process. The three components along the top combine to form the final texture, shown 
in the middle. The layout makes the editor very easy to use. Along the top of the editor 
you'll see the preview options. These three icons let you choose how you want to 
display the component.  
Below the preview control on the left, you'll see the Component Selector. This tool lets 
you choose the number of components you want to use to build your texture.  
The rest of the editor displays the component window. The three windows along the top 
represent the three components you can use in a texture and the center window 
represents the combined texture.  
TIP: When you're just exploring the editor, set all the component outputs to Alpha. This 
lets you see the effects of your changes more clearly.  
The three buttons along the bottom of the editor let you display the three editing 
palettes.  
The palettes let you control the noise, phase, and filtering applied to the texture.  
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You can access the Noise and Phase Editors from within the Noise and Phase Palettes.  

 

Accessing the DTE 

The Deep Texture Editor can be accessed from multiple locations depending on what is 
selected or what lab is currently active. 

From the Edit Palette  

To access the Deep Texture Editor from the Edit Palette:  
1. Make sure the Edit palette is visible. If it's not, click the Edit button at the top of 

the Bryce window.   
 

 
2. Click on the Edit Materials tool to open up the Materials Lab. If an object is 

selected, you can modify its material.  
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OR 

3. Click on the triangle next to the Edit Materials tool and choose Edit 3D Solid 
Textures from the menu. 
 

 

From the Light Lab  

To access the Deep Texture Editor from the Light Lab:  
1. Select a light source. 
2. Click the  button next to the selected light source. The Light Lab will come up.  
3. Click the radio button next to Use Gel, the Image and Procedural buttons will 

activate:  
 

 
4. Click on the Procedural button, the Materials Lab will come up.  
5. In the Materials Lab, click on one of the columns in the grid to activate a 

component window:  
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6. Click the Pink button at the top of the window, the Deep Texture Editor comes 
up.  
 

 

From the Materials Lab  

To access the Deep Texture Editor from the Materials Lab:  
1. Select an object.   
2. Click on the  button next to the selected object. The Materials Lab will come up. 
3. In the Materials Lab, click on one of the columns in the grid to activate a 

component window:  
 

 
4. Click the Pink button at the top of the window, the Deep Texture Editor comes 

up.  
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From the Objects Menu  

To access the Deep Texture Editor from the Objects Menu, choose Objects > Edit 3d 
Textures from the menu or press Opt/Alt+M. The Deep Texture Editor will come up.  
 

 
 
You do not have to have an object selected before choosing this command.  

From the Sky Lab  

To access the Deep Texture Editor from the Sky Lab:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears.  

 
 

3. Click on the Cloud Cover tab.  
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4. On the Cloud Cover tab, click on Edit under the selected cloud layer type: Stratus 
or Cumulus. The radio button next to the cloud type must be selected for the 
Deep Texture Editor to come up for that cloud type.   
 

 

From the Terrain Editor  

To access the Deep Texture Editor from the Terrain Editor:  
1. Select a terrain or symlat object in your scene. If none are available, display the 

Create palette by clicking the Create button at the top of the Bryce window.  
 

 
2. Click the Terrain tool or the Symmetrical Lattice tool. The default terrain or symlat 

appears in your scene.   
 

 

 
3. Click on the  button next to the selected terrain/symlat. The Terrain Editor 

appears.  
4. In the Editing Tools dialog, make sure that the Elevation tab is selected.  
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5. Press Shift+click on the Picture button. The Deep Texture Editor comes up. 
 

 

From the Tree Lab  

To access the Deep Texture Editor from the Tree Lab:  
1. Select a tree object in your scene. If no trees are available, display the Create 

palette by clicking the Create button at the top of the Bryce window.   
 

 
2. Click the Tree Object tool. The default tree appears in your scene.   

 

 
3. Click on the  button next to the selected tree. The Tree Lab appears.  
4. Click the Material button at the bottom of the Branch/Trunk or Foliage section. 

 

 
5. Click the Edit button to the right of the Material button. The Materials Lab 

appears.   
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6. In the Materials Lab, click on one of the columns in the grid to activate a 
component window:  
 

 
7. Click the Pink button at the top of the window, the Deep Texture Editor comes 

up.  
 

 

Working in the DTE 

This section describes how to use the Deep Texture Editor to create and store textures.  

Building Textures  

A texture is a combination of components. You build textures by designing or editing 
components (i.e., colors, noise, phase, or filters) and combining them using Blend 
Modes.  
To build a texture:  

1. Display the Deep Texture Editor.  
2. Click the Component Selector to choose the number of components you want to 

use to build the texture. The component windows become active. 
 

 

©2007 DAZ 3D, Inc.  652 



Bryce 6 Artist Guide 

3. In the first component window, click one or more of the Output buttons to choose 
an output type.   
 

 
4. If your component contains color, click one of the color circles and choose a color 

to apply to the texture. You can choose up to three colors for each component.  
 

 
5. Click the triangle icon below the color circles and choose a Color Blending Mode 

for your colors.   
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6. Click the Noise button at the bottom of the editor. The Noise Palette appears.  
 

 
7. Adjust the noise in the component by:   

• Dragging the Noise Slider on the Noise Palette to increase or decrease 
the amount of noise in the component.   
 

 
• Click the top left corner of the palette to display the Noise Editor, then use 

the editor controls to design or edit the noise in the component.  
 

 
8. Click the bottom-right button on the Component Window. The Phase Palette 

appears.  
 

 
9. Adjust the phase in the component by:   

• Dragging the Phase Slider on the Phase Palette to increase or decrease 
the amplitude of the phase in the component.   
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• Click the top left corner of the palette to display the Phase Editor, then use 
the editor controls to design or edit the phase in the component.  
 

 
10. Click the Filtering Button at the bottom of the editor. The Filtering Palette 
appears.  
 

 
11. Choose a filter to apply the component noise. 
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12. Adjust that filter's variables.  
 

 
13. Repeat steps 3 through 12 for each component in the texture. As you edit the 
noise, phase, or filter of the remaining components, make sure you move the 
component indicator at the top of each palette to be sure you're editing the right 
component's attributes.   
14. Click the text above Component 1 and choose a Blend Mode from the menu.  
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15. If you have more than two components, click the text above Component 2 and 
choose a second blend mode. The result of blending all the components appears in the 
Combination Window.  
 

 
16. Click the color circles in the Combination Component Window, and choose colors 
for the final texture. 
 

 

©2007 DAZ 3D, Inc.  657 



Bryce 6 Artist Guide 

17. You can also choose a Blending Mode.  
 

 
18. If you want to change the noise of combined component, display the Noise 
Palette. If it's already displayed, make sure the component indicator is on the fourth 
component.  
 

 
19. If you want to change the phase of combined component, display the Phase 
Palette. If it's already displayed, make sure the component indicator is on the fourth 
component.   
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20. If you want to change the filter of combined component, display the Filtering 
Palette. If it's already displayed, make sure the component indicator is on the fourth 
component.   
 

 
21. Click the OK icon at the bottom of the editor. The texture appears in one of the 
component windows in the Materials Lab.  
 

 

Using Drag & Drop in the DTE  

The Deep Texture Editor lets you drag and drop component elements between 
component windows. This a quick way of copying elements between components. For 
example, if you were setting up a red, green, and blue separation of the colors in your 
texture, you could drag the same elements to all three component windows and change 
the Color Blending mode.  
To drag and drop between windows, drag from the window you want to copy to the 
window where you want the elements to appear. Release the mouse button to drop the 
component elements. The elements you drop into a window replace the existing 
elements.  

©2007 DAZ 3D, Inc.  659 



Bryce 6 Artist Guide 

 

Changing Component Preview  

Each component window has a preview of the component's elements. You can choose 
to display the elements mapped onto a flat surface, a cube or a sphere. Displaying the 
component on a cube makes it easier to see 3D noise and phase changes.  
To choose a preview mode, click the flat surface, cube, or sphere in the top-right corner 
of the editor.  

 
Examples:  

1. Flat (default):   
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2. Cube:  
 

 
3. Sphere: 

 

 

Randomizing Textures  

A quick way of designing a texture without going into designing noise or filters is to 
create random components. The Randomize Buttons in the component windows let you 
randomize the elements in the component window. The type of output you choose for 
the component determines what part of the component is randomized.  
This is an excellent way of exploring the editor. Just randomize the components 
elements and combine them to see what happens.  
To randomize component elements, click the knob in the bottom-right corner of the 
component window.  
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Previewing Textures  

Textures can be previewed in a larger format in the Deep Texture Editor. You can 
preview the texture in a small preview or over the entire screen.  
To preview the texture in small format:  

1. Click in the Combination Component window.   
 

 
 
The preview will come up covering the Deep Texture Editor area.   
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2. Click on the window to close the preview.   
3. To change the Display Mode, click on one of the Display Mode buttons at the top 

right of the Deep Texture Editor. 
 

 
4. Then click in the Combination Component window.   

 

  
To preview the texture over the entire window:  

1. Press the Spacebar and quickly click in the Combination Component window, 
letting up on the Spacebar immediately after clicking in the window. This may 
take a bit of practice to get the preview to show and stay up. Change the Display 
Mode if needed. 
 
The preview will come up covering the entire screen.   

2. Click on the window to close the preview. 

Undoing Changes  

The Reset Control lets you undo all the changes you've applied to a component and 
returns to the component displayed when you first entered the editor.  
To reset a component, click the knob in the top-left corner of the component window. 
You can also click on the Cancel icon to exit the Deep Texture Editor without applying 
the changes.  
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Saving Textures  

You can save your texture as part of texture list so you can access it quickly from the 
Materials Lab.  
To save a texture:  

1. In the Combination Component Window, click the knob in the top-right corner of 
the component window.  
 

 
 
The Textures Library appears. 

2. Change categories if needed and select the sub-category to save the texture to. 
 

 

©2007 DAZ 3D, Inc.  664 



Bryce 6 Artist Guide 

3. Click on Add. The Add Presets dialog comes up.   
 

 
4. Enter a name for the new texture, and a description if you want, then click on the 

OK icon.  
 

 
 
The new texture is added to the library.  
 

 
 
The texture list can then be accessed from the Materials Lab.  
 

 
Please note that if you need to access the Installed texture category or another category 
from the Texture Library, you will need to change categories in the library before it can 
be accessed from the texture list in the Materials Lab. 
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Textures 

One of the things that makes Bryce so unique is its Materials. A Material can bring any 
object to life, and Textures are the power behind the Material. A Material can make your 
object shiny, dull, or transparent, but the Textures within that Material are what make it 
look like wood, rock, water, or clouds.  
Textures define the color, pattern, or bumps within a Material. A Material can contain up 
to four Textures. By altering the make-up or pattern of a Texture you can dramatically 
alter the appearance of a Material.  

Texture Structure 

A Bryce Texture can be made up of three Components. These Components contribute 
the raw patterns or Textures within a Texture. Each Component can then contribute one 
of three types of Output to the final Texture. These Outputs are then combined to create 
the final Texture.  
The following diagram shows the structure of a Texture.  

 
Within each Component is a combination of colors and noise that create a pattern. The 
shape of the noise inside a Component is determined by the phase of the noise and the 
filter applied to it. The filter can create coherent patterns, random spots, or anything in 
between. Refer to "Noise," "Phase," and "Filtering" for more on noise, phase, and 
filtering. 
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The following diagram shows the structure of a Texture including the structure of a 
Component.  

 
A Component can contribute one of three types of output to the final Texture: Color 
output, which determine the colors in a Texture, Alpha output, which determines the 
bright and dark areas in a Texture, and Bump output, which determines the size and 
pattern of bumps in the Texture.  
The Component can contribute any combination of outputs. So you can have a final 
Texture that contains Color output, Alpha output, and Bump output, or it can have all 
Color output or all Bump, or any combination of the three.  
The outputs in a Texture are used by the material, so the type of output you have in a 
Texture depends entirely on how you want to use the Texture in the material. For 
example, if you're using the Texture as a bump map for the Bump Height channel in a 
material, you'd probably want all the Components to contribute only Bump output.  
A Texture can contain up to three Components. It can be made up of all three 
Components or just one, depending on the type of Texture you want to create. The 
more Components you use, the more complex your Texture.   
Components are combined using Blend Modes. These modes can create a wide range 
of effects. The way Components are combined to create the final Texture is determined 
by the Blend Mode you select.  
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Components are combined differently depending on how many you use. If you use one 
or two they are combined according to the blend method you select. If you use three, 
the first two Components are combined, and the resulting Texture is then combined with 
the third Component to create the final Texture.  
When you use three Components, the first two Components (C1 and C2) combine to 
create a hybrid Texture which is then combined with the third Component (C3) to create 
the final Texture. So they're combined using the formula (C1+C2)+C3=FINAL.  
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The Texture Components are combined together to form the final Combination Texture. 
The final Texture can have its own color scheme, noise, phase, or filter. Any changes 
you make to the combination Texture changes the final Texture. These types of 
operations are called Global changes. Refer to "Global Changes" for more on global 
changes. 
The end result of the Global changes is the final Texture which can then be used in the 
Materials Lab to create a Material. 

Components vs. Texture Components  

Before you get any deeper into the discussion of texture structure you should 
understand a little terminology.  
A texture is a part of a material. It can be used to drive any of the material's channels. 
When you use a texture in a material, it's called a material component.  
The texture itself also has components. It can be made up of up to three components 
that determine the look and color of the texture. The components that make up a texture 
are called components.   
The difference between components and texture components may be a bit confusing. 
Just remember that when you're talking about a texture, you're dealing with 
components. When you're working with materials, you're using texture components.  
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Understanding Component Structure  

A texture can have up to three components. When combined, the components create 
the final texture. A component consists of noise and color.  
A component can have up to three colors. The combined texture can also have a 
different set of three colors which is added to the colors from the components. In total 
your texture can contain up to twelve colors.  
The noise in a component is made of base Noise which is modified by the Phase, which 
controls the complexity of the noise, and the Filter, which determines the shape or 
pattern of the noise.  

 

Components and Output  

A component's output type determines what type of information it's going to contribute 
to the final texture.  
The Output type also determines the component's structure. A component that does not 
have a Color output won't contain any color information. The same is true for the two 
other types of output. If there's no Alpha or Bump output, then there's no Alpha or Bump 
information in the component. 

Component Output 

The main purpose of creating a component is to use it as part of a material which will 
then be applied to an object. How and what a texture contributes to a material is 
determined by the type of output it produces.  
A texture can produce three different types of output: Color, Alpha, and Bump.  
When you apply a texture to a material, you can see the output types in the Texture 
Component Window in the Materials Lab.  
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The three boxes in the Texture Component Window in the Materials Lab represent the 
three output types available for a texture.  
If a texture does not produce a particular output, the box appears gray. Refer to 
"Texture Components" for more on using textures in materials.  
In the Deep Texture Editor, the output type for a component is indicated by the three 
output buttons along the right side of the Component Window.  

 

Assigning Output Types  

A texture can produce all three output types or only one. The number of output types for 
the final texture depends on the output you assign to the components. A component can 
produce one or all three types of outputs.  
You can assign more than one component to the same output type. If you do have more 
than one component with the same output type, the output information will be blended 
to produce a final output. For example, if you have two components that produce color 
output, when you combine them the colors from both components are blended together 
and the result is applied to the final texture.  
In order to produce an output type, a final texture must contain at least one component 
that produces the type of output you want. For example, if you want your final texture to 
contain color output, at least one of its components must produce color output.  
Each output type contributes something different to the final material.  

Color Output  

Color output is used by the color channels of a material. The color values you assign to 
a texture's components are combined to form a final texture. The combined values are 
then used to drive the Diffuse, Ambient, Specularity, Specular Halo, or Transparency 
Color channels.  
The colors in a texture usually appear in the form of a pattern or grain. When you assign 
the texture to a material, this pattern appears in the final material.   
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The texture in this example was applied to the Diffuse Color and Ambient Color 
channels of the object's material. You can see how the color pattern in the texture 
appears in the material.  

 
To assign Color output to a texture: 

1. Display the Deep Texture Editor. 
2. In the desired component window, click the C button on the right side of the 

component window. The output mode is active when it is a light gray color.   
 

 

Alpha Output  

Alpha Output is used by the various Intensity and Optic channels of the material. When 
a texture's Alpha Output is assigned to a material, it's used either to determine an 
effect's intensity or as a guide map for combining multiple textures.  
When there is only one texture component in a material channel, the texture's Alpha 
Output is usually used to determine the intensity of a channel effect. For example, if you 
assign a texture to the Diffuse channel, the texture's Alpha Output is used to determine 
which areas are the most diffuse and which are the least diffuse. The texture in this 
example was applied to the Diffuse channel of the object's material. You can see how 
the alpha pattern in the texture controls the diffuse intensity on the object's surface.  
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To assign Alpha output to a texture:  
1. Display the Deep Texture Editor.  
2. In the desired component window, click the A button on the right side of the 

component window. The output mode is active when it is a light gray color.   
 

 

Bump Output  

The Bump Output is used only by the Bump Height material channel to determine the 
pattern and height of the bumps in a material. The texture in this example was applied 
to the Bump Height channel of the object's material. You can see how the bump output 
in the texture controls the pattern of bumps on the object's surface.  
To assign Bump output to a texture:  

1. Display the Deep Texture Editor.  
2. In the desired component window, click the B button on the right side of the 

component window. The output mode is active when it is a light gray color.   
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Component Elements 

A Texture is made up of Components. Each of those Components can contain several 
elements that determine the color, pattern, grain, or bumps in the Component.  

The Component Window  

You can have up to three components in your texture. As you activate components, a 
Component Window becomes active. Each window displays a preview of the 
component elements. The Component window displays the selected component and its 
current attributes.  
The three buttons on the Component Window let you access the Noise Palette, the 
Filtering Palette, and the Phase Palette. The buttons along the right side of the window 
indicate the type of output produced by the component.  
To activate a component:  

1. Display the Deep Texture Editor.  
2. Click the Component Selector in the top-left corner of the editor.   

 

 
The Component Selector lets you pick how many components you want to use to build 
your texture. The selector lets you choose from 1, 2, or 3 components.  
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Color  

The Colors in a component determine its color scheme. Each component can have up 
to three colors. Colors can be chosen using the Color Picker or the Color Dialog.  
The color in a component is affected by the noise, filter and phase. You can create 
some very interesting patterns of color by modifying the noise. The color pattern created 
by the changes in the noise is applied directly to the final texture. So even if Color is the 
only output type for the component you'll still see a pattern in your final texture.  
When the Color Output is selected for a component, only the color information is 
combined with the other components. Also, when you apply the texture to a material, 
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the colors in the component contribute to the colors used in the Color channels of the 
material.  
If the Color Output is not active for a component, changing the colors or Color Blending 
Modes has no effect.  

Activate Color Output  

To activate Color Output for a component: 
1. Display the Deep Texture Editor. 
2. In the desired component window, click the C button. 

 

 
An output type is active when the button appears light gray.   

Choosing a Color Model  

There are two color models you can use to create colors in the components: RGB and 
HLS. RGB combines red, green, and blue to create color. HLS combines Hue, 
Lightness, and Saturation values to create color. The method you choose depends on 
the final output of your Bryce scene. RGB works best for most types of output.  
To choose a color model:  

1. Display the Deep Texture Editor.  
2. In the desired component window, make sure the C button is active.  
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3. Click the triangle icon in the lower left corner of the window and choose a either 
RGB or HLS from the menu.   
 

 

Choosing Colors  

To choose colors for a component:  
1. Display the Deep Texture Editor.  
2. In the desired component window, make sure the C button is active.  

 

 
3. Click one of the color indicators along the left side of the component window and 

choose a color from the palette. The three color indicators along the left side of 
the window display the colors used in the component.  
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Mixing Colors  

To mix colors for a component:  
1. Display the Deep Texture Editor.  
2. In the desired component window, make sure the C button is selected.   

 

 
3. Opt/Alt+click the one of the color indicators along the left side of the component 

window. The Color dialog appears.  
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4. Choose a color model by clicking one of the buttons along the bottom of the 
dialog.  
 

 
5. Enter color values or adjust the sliders to mix a new color. 

 

 
6. Click the OK icon.   
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Color Blending Modes  

There are several blending modes you can use to create a color scheme. 
To choose a Color Blending Mode:  

1. Display the Deep Texture Editor. 
2. In the desired component window, make sure the C button is active.  

 

 
3. Click the triangle icon in the lower left corner of the window and choose a 

blending mode from the menu.  
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See the following for examples of each color mode: 

None  

This option deactivates the color blending mode. No blending is applied to the 
components.  

 

Red or Hue  

When the RGB model is used, this mode outputs only red color values.  

 
When the HLS model is used, only Hue values are output.   

 
This mode, and the Green or Light and Blue or Saturation mode, are available so that 
you can separate color values among the components. For example, you could set 
each component to output one of the different color values.  
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Green or Light  

When the RGB model is used, this mode outputs only green color values.  

 
When the HLS model is used, only Lightness values are output.  

 

Blue or Saturation  

When the RGB model is used, this mode outputs only blue color values.  
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When the HLS model is used, only Saturation values are output.  

 

Spline Interpol  

This mode creates a blend between all the colors in the component. This is what a color 
blend looks like using Spline Interpol.  

 

Linear Interpol 2  

This mode creates a linear blend between the first two colors selected for the 
component. This is what a color blend looks like using Linear Interpol 2.  
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Linear Interpol 3  

This mode creates a linear blend between all the colors in the component. This is what 
a color blend looks like using Linear Interpol 3.  

 

Randomized  

In this mode the three colors are blended and then applied randomly throughout the 
component. This is what a color blend looks like using Randomized.  

 

Earth Map  

In this mode extra colors are generated according to the contours of the component's 
bump map. The three colors you selected for the component are applied to the middle 
range of the bump map. Blue is applied to the lowest bump values and white is applied 
to the highest values to simulate polar caps. Earth Map is excellent for creating planets. 
This is what a color blend looks like using Earth Map.  
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Banded  

In this mode colors are applied in bands. The bands are determined by color values. 
Colors with the lowest value (i.e., dark colors) are applied to the bands furthest from the 
center, colors with middle range values are applied next and colors with the highest 
values (i.e., bright colors) are applied closest to the center. This is what a color blend 
looks like using Banded.  

 

Perturbed  

In this mode colors are applied in irregular patterns. This is what a color blend looks like 
using Perturbed.  

 

Interferences  

In this mode the red, green, and blue values of the first color in the component are used 
to create a repeating pattern around the contours of the component's noise. This is what 
a color blend looks like using Interferences.  
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Altitude  

In this mode, a white layer is added above the colors at high altitudes. Any portion of the 
object below ground is automatically colored blue. Altitudes are based on the object's 
height. This is what a color blend looks like using Altitude.  

 

Interpol + Interferences  

This mode is a combination of Linear Interpolation and Interferences. This is what a 
color blend looks like using Interpol + Interferences.  

 

Slope  

In this mode the three colors are applied to the object depending on its slope. This is 
what a color blend looks like using Slope.  
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Spline with Snow  

This mode performs a spline interpolation of the colors in the component, but adds a 
white layer above the colors at high altitudes. Altitudes are based on the object's height. 
This is what a color blend looks like using Spline with Snow.  

 

Orient  

In this mode the three colors are applied to the object according to its eastwest 
orientation. This is what a color blend looks like using Orient.  

 

Noise  

Noise is the background turbulence that creates the basis for texture patterns. In audio 
terms you can think of noise as the background static that you hear on old recordings. 
Sound is layered on top of this noise to create music. Like in audio, you layer other 
functions on top of the noise in your texture to create the final pattern or look of your 
texture.  
There are two ways of creating noise: the Noise Palette or the Noise Editor. The Noise 
palette can increase or decrease the amount of noise in any of the texture components. 
However, using the palette, you can only edit the existing noise. The Noise Editor is 
much more powerful than the Noise palette. It contains controls for creating noise from 
scratch.  
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Noise Palette  

To display the Noise palette and adjust the current noise:  
1. Display the Deep Texture Editor.  
2. Either click the Noise button at the bottom of the editor or click the Noise button 

in the top-left corner of on any of the component windows. 
 

 
 
The Noise palette appears.   
 

 
3. Select which component to adjust by clicking in one of the indentations of the 

Component Indicator. The first three indentations are for Components 1, 2, and 
3, while the fourth one is for the Combination (final) Component.   
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4. Move the mouse over the red ball in the Frequency slider. The cursor changes to 
a double-ended arrow.  
 

 
5. Left-click on the ball and drag right to increase the noise.  

 

 
 
If you reach the end of the slider and the noise is still not enough, let up on the 
ball and it will return to the center (or 0). The new setting becomes the baseline 
and you can drag the ball again to increase the noise frequency even more.   
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6. Left-click on the ball and drag left to decrease the noise.   
 

 
 
If you reach the start of the slider and the noise is still not enough, let up on the 
ball and it will return to the center (or 0). The new setting becomes the baseline 
and you can drag the ball again to decrease the noise frequency even more.   

7. You can also click on the arrows at each end of the Noise Frequency slider to 
adjust the frequency without having to let up on the mouse continually, however, 
the numeric indicator will always show 1 or -1. 
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Noise Editor  

To display the Noise Editor:  
1. Display the Deep Texture Editor.  
2. Either click the Noise button at the bottom of the editor or click the Noise button 

in the top-left corner of on any of the component windows.  
 

 
 
The Noise palette appears.   
 

 
3. Select which component to adjust by clicking in one of the indentations of the 

Component Indicator. The first three indentations are for Components 1, 2, and 
3, while the fourth one is for the Combination (final) Component.   
 

 
4. Click the top-left corner of the palette. The corner turns a slightly brighter green 

as you pass your cursor over it.  
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The Noise Editor comes up.  
 

 

Creating Noise  

The Noise Editor is the tool you'll use to create noise with a component or combined 
texture. The noise creation process involves several steps:  

1. Choose the number of dimensions in the noise.   
2. Choose a Noise Type. This will give the basis for creating a noise pattern or 

grain.  
3. Adjust the frequency of the noise.  
4. Adjust the direction of the noise.   
5. Apply a modifier to your noise, by choosing a Noise Mode. 

The following sections describe the various parts of the editor and how to use them in 
the noise creation process.  

Noise Dimensions  

Textures in Bryce can exist in 3D so your noise can have up to three dimensions. Noise 
dimensions determine which axes you can use to adjust the orientation and frequency 
of the noise. It's easier to see the number of dimensions for your noise if you use a cube 
in the Noise Preview. These three examples show the difference between 1D (left), 2D 
(middle) and 3D (right) noise.  

 
To choose the number of dimensions for your noise:  

1. Display the Deep Texture Editor.  
2. Display the Noise Editor.  
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3. Click one of the Dimension buttons at the bottom of the editor.   
 

 

Noise Type  

There are 50 different types of noise available in the Noise Editor. Random noise is the 
default (RND). Each noise 
type provides you with a different basic pattern to start your texture. Some are more 
linear or geometric while others are  
more random.  
More complex noise types require more rendering time. The time it takes to render the 
preview is a good indication of  
how long the final texture will take to render. You should use the more complex noise 
types cautiously.  
The best way of choosing a noise type is to apply a few to your component and see how 
they look. Remember that this 
noise is only the basis of the texture. You can still edit this noise using the other controls 
in the editor, so don't discard a  
noise type because it's not perfect. The other controls can help you fine-tune the noise.  
To choose a noise type:  

1. Display the Deep Texture Editor.  
2. Display the Noise Editor.  
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3. Click the Type field at the top of the editor and choose a noise type from the 
menu.   
 

 
Below are examples of the 50 Noise Types available along with examples: 

Nothing 

 

Sine 

 

Square 

 

Triangle 
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RND Discrete 

 

RND Linear 

 

RND Continuous 

 

RND Saw 

 

Vortex Noise 

 

Fractal 

 

Turbulence 
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Spots 

 

Fract Stone 

 

Triangles Discrete 

 

Square Lines 

 

Sparse RND Paths 

 

RND Lines 

 

Waves 
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Liquid 

 

Linear Sine 

 

Stucco Noise 

 

Stone Cliff 

 

Multifractal 

 

Leopard 

 

Techno 

 

©2007 DAZ 3D, Inc.  697 



Bryce 6 Artist Guide 

Distance Origin 

 

Time Random 

 

Value 

 

Gradient 

 

Weird Value 

 

Weird Gradient 

 

Voronoi Distance1 
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Voronoi Distance2 

 

Voronoi Distance3 

 

Voronoi Distance4 

 

Voronoi DistSq1 

 

Voronoi DistSq2 

 

Voronoi DistSq3 

 

Voronoi DistSq4 
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Voronoi D2-D1 

 

Voronoi D2sq-D1sq 

 

Voronoi D3-D2 

 

Voronoi D3sq-D2sq 

 

Voronoi D4-D3 

 

Voronoi D4sq-D3sq 

 

Voronoi ID1 
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Voronoi ID2 

 

Voronoi ID3 

 

Voronoi ID4 

 

Distance Squared 

 

Noise Orientation  

Noise Orientation controls the direction of the noise. When you adjust the noise 
orientation, you change how the noise is laid out within the texture. When you apply a 
texture, the direction of the noise within the texture remains constant regardless of the 
orientation of the object. Since noise can exist in three dimensions, you adjust the 
direction of the noise in the X, Y, or Z axis. This example shows rotation in X (left), XY 
(middle), and XY (right).  

 
The number of dimensions in the noise determines how many axes you can use to 
adjust the orientation. For 1D noise you can only use the X axis. With 2D noise you can 
use both the X and Y axes. For 3D noise you can use all the axes.  
You can edit the noise orientation using the Direction numerical fields. The fields let you 
enter precise angles for noise orientation. You can also use the scroll arrows to set the 
angle in increments. Changing noise orientation can dramatically change the look of 
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your noise. You'll see just how different your noise can look when you rotate it along a 
single axis.  
To change the orientation of noise:  

1. Display the Deep Texture Editor.  
2. Display the Noise Editor.  
3. Click one of the Dimension buttons at the bottom of the editor.   

 

 
4. Drag over the XY field in the Direction area to set the noise angle in the X and Y 

axes. Drag left to decrease the value or right to increase it.  
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5. Drag over the YZ field in the Direction area to set the noise angle in the Y and Z 
axes.   
 

  
6. You can also drag over the scroll arrows to speed up the increase/decrease or 

click on the arrows to increment the values by one number at a time.  

Noise Frequency  

Noise Frequency determines how often the pattern within a texture repeats. Frequency 
is like scaling the noise. Higher frequencies decrease the scale of the noise so you can 
see the pattern more often. Lower frequencies increase the scale of the noise so the 
pattern repeats less often.  
You can change noise frequency using the Frequency fields. The fields let you enter 
numerical values to adjust the noise frequency along the X, Y or axis. You can also 
adjust the values using the scroll arrows. The number of dimensions in the noise 
determines how many axes you can use to adjust the frequency. For 1D noise you can 
only use the X axis. With 2D noise you can use both the X and Y axes. For 3D noise 
you can use all the axes. If you try to adjust the axis frequency for a 2D noise, your 
changes will have no effect.  
Adjusting the frequency can radically change the look of your noise. If you adjust the 
frequency in separate axes, you can achieve even more interesting effects. This 
example shows frequency settings of 10 (left), 50 (middle), and 100 (right).  
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In this example, the noise frequency was changed in only the Y axis (X=10, Y=80, 
Z=10).  

 
To change the frequency of noise:  

1. Display the Deep Texture Editor.  
2. Display the Noise Editor.  
3. Click one of the Dimension buttons at the bottom of the editor.   

 

 
4. Drag over the X field in the Frequency area to set the noise frequency in the X 

axis. Drag left to decrease the value or right to increase it.   
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5. Drag over the Y field in the Frequency area to set the noise frequency in the Y 
axis.  
 

  
6. Drag over the field in the Frequency area to set the noise frequency in the axis.   

 

  
7. You can also drag over the scroll arrows to speed up the increments. 

Noise Octaves  

Noise Octaves are like musical octaves. In a musical scale, if you play F and then F an 
octave down, you're playing the same note, only it sounds lower. If you play both notes 
at the same time, the sound is more complex than if you played only one note. The 
same is true of noise. When you add an octave to noise it becomes more complex but 
the type of noise remains the same. These examples use Square noise to show the 
effects of increasing octaves from 0 (far left) 1 (second from left) to 2 (second from right) 
and 3 (far right). Increasing the octaves adds processing time to the component.  
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To change the number of octaves:  
1. Display the Deep Texture Editor.  
2. Display the Noise Editor.  
3. Click one of the Dimension buttons at the bottom of the editor.   

 

 
4. Drag over the Octaves field.  

 

  

Noise Modes  

Noise Modes modify the octaves of a noise. As you add complexity by increasing the 
octaves, the Noise Modes let you modify the additional noise so that it produces 
different effects.  
Many of the Noise Modes use dark and light values to modify the existing noise. Also, 
you may not see the effects of the modes if the Octave is set to 0.  
To choose a Noise Mode:  

1. Display the Deep Texture Editor.  
2. Display the Noise Editor.  
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3. Click the Mode field at the top of the editor and choose a mode from the menu. 
 

 
There are 13 noise modes available:  

Standard  

Standard mode adds a new octave to the noise at half the frequency and twice the 
amplitude. This is the default mode. In this example, Standard mode was applied to 
RND Continuous noise.  

 

Irregular  

Irregular mode adds a new octave to the noise at half the frequency and twice the 
amplitude. However, in this mode higher frequency noise is modified more than the rest. 
The end result is that more detail is added to the noise. In this example, Irregular mode 
was applied to RND Continuous noise.  

 

More Irregular  

More Irregular mode works exactly like Irregular except that this mode is more intense. 
In this example, More Irregular mode was applied to RND Continuous noise.  
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Maximum  

When two components are combined using Maximum, the two components are 
compared and the one that's lighter becomes the result.  

 

MultiFractal  

In MultiFractal mode, lighter areas create higher contrast noise. In this example, 
MultiFractal mode was applied to RND Continuous noise. 

 

With Rotation  

In With Rotation mode, each additional octave is rotated. With Rotation mode it’s easier 
to see linear noise types. In this example, With Rotation mode was applied to RND 
Linear noise.  

 

Minimum  

Minimum mode uses only the lowest values, or darkest areas, to produce the modified 
noise. In this example, Minimum mode was applied to RND Continuous noise.  
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Multiply  

In Multiply mode all the values in the noise are multiplied together. The results is a 
darker noise. In this example, Multiply mode was applied to RND Continuous noise.  

 

Difference  

In Difference mode all the values in the noise are evaluated. All the values that are 
equal create black areas. When the values are different, the lower value becomes 
darker. The more octaves you have in the noise, the darker the modified noise. 
Difference works even at 0 octaves. In this example, Difference mode was applied to 
RND Continuous noise.  

 

Minimum90  

Minimum90 mode repeats the noise at a 90° angle from its original orientation and 
combines the original and copy using only the lowest values. In this example, 
Minimum90 mode was applied to RND Continuous noise.  
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Maximum90  

Maximum90 mode repeats the noise at a 90° angle from its original orientation and 
combines the original and copy using only the highest values. This mode is good for 
creating woven patterns. In this example, Maximum90 mode was applied to RND 
Continuous noise.  

 

Auto-Phased  

Auto-Phased mode automatically introduces phase shifts into the noise. In this example, 
Auto-phased mode was applied to RND Continuous noise.  

 

Displaced Max  

Displaced Max mode creates a copy of the noise, displaces noise by a small amount, 
and then lightens any areas where the two overlap. This mode is good for creating 
stone textures. In this example, Displaced Max mode was applied to RND Continuous 
noise.  

 

Phase  

Phase introduces turbulence into your noise. The phase displaces the grain or patterns 
within the noise. When you design the phase, you're creating a displacement map along 
which the noise will be modified.  
You can control how the phase interacts with your noise using the Phase Palette. You 
can design your phase using the Phase Editor. The Phase palette controls the 
amplitude. The Phase Amplitude controls the intensity of the displacement. As the 
amplitude is increased, there is more interference with the original noise.  
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You won't have to increase the amplitude very much before you start seeing the phase 
pattern you designed interfere with the existing noise. In fact, it's probably a good idea 
to keep the phase amplitude low so that the phase pattern doesn't overwhelm the noise.  
This graph shows how the phase interacts with the noise at different amplitude settings.  

 
The Phase Editor looks a lot like the Noise Editor. It has the same type of tools and they 
work exactly like they do in the Noise Editor. The difference is that you're using noise 
patterns, orientations, frequencies, and modes to design how the basic Noise will be 
displaced. Using the Phase Editor you can perform several functions:  

• Create 1D, 2D, or 3D phase 
• Change the type of noise 
• Change the frequency of the phase 
• Change the orientation of the phase 
• Change the noise octaves 
• Change the noise modulations 

While the Phase Editor lets you create the noise pattern or grain within the phase, the 
Phase Palette controls how that phase is applied to the component or the combined 
texture.  

Phase Palette  

To display the Phase palette: 
1. Display the Deep Texture Editor.  
2. Click the Phase button at the bottom of the editor or the bottom-right corner of 

any of the component windows.   
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The Phase palette appears.   
 

 
3. Select which component to adjust by clicking in one of the indentations of the 

Component Indicator. The first three indentations are for Components 1, 2, and 
3, while the fourth one is for the Combination (final) Component. 
 

 
4. Move the mouse over the green ball in the Amplitude slider. The cursor changes 

to a double-ended arrow.   
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5. Left-click on the ball and drag right to increase the amplitude up to 1000.   
 

 
6. Left-click on the ball and drag left to decrease the amplitude down to 0.   

 

 
7. You can also click on the arrows at each end of the Amplitude slider to adjust the 

amplitude manually.  
 

 

Phase Editor  

To display the Phase Editor:  
1. Display the Deep Texture Editor.  
2. Click the Phase button at the bottom of the editor or the bottom-right corner of 

any of the component windows.   
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The Phase palette appears.   
 

 
3. Select which component to adjust by clicking in one of the indentations of the 

Component Indicator. The first three indentations are for Components 1, 2, and 
3, while the fourth one is for the Combination (final) Component. 
 

 
4. Click the top left corner of the palette. The corner turns green as you pass your 

cursor over it.   
 

 
 
The Phase Editor comes up.  
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Creating Phase  

Phase is designed using the Phase Editor. The phase creation process involves several 
steps: 

1. Choose the number of dimensions in the phase.   
2. Choose a Noise Type. This gives the basis for creating a phase pattern or grain. 
3. Adjust the frequency of the noise.  
4. Adjust the orientation of the noise.   
5. Apply a modifier to the noise by choosing a Noise Mode.  

You'll notice that many of the steps for creating the phase are the same as those for 
creating noise. That's because you are creating noise. The difference is that instead of 
applying the noise to the texture, the noise you create for the phase is used to displace 
the existing noise.  
The following sections describe the various parts of the editor and how to use them in 
the phase noise creation process.  

Phase Dimensions  

Just like noise, you can set the dimensions of the phase. The number of dimensions 
determines which noise axes will be displaced when you apply the phase. For example, 
if you apply a one-dimensional phase to a three-dimensional noise, only the X axis of 
the noise will be displaced. It's easier to see the number of dimensions for your phase if 
you use a cube in the Phase Preview. In this example, a 1D phase (left) was applied to 
a 3D noise (right) to create the result (bottom).  
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To choose the number of dimensions for your phase: 

1. Display the Deep Texture Editor.  
2. Display the Phase Editor. 
3. Click one of the dimension buttons at the bottom of the editor.  

 

 

Phase Noise Type  

There are 50 types of noise available in the Phase Editor. Random Noise is the default 
(RND). Each noise type provides you with a different basic pattern for the phase. The 
noise types available in the Phase Editor are the same as those in the Noise Editor.  
To choose a noise type:  

1. Display the Deep Texture Editor.  
2. Display the Phase Editor.  
3. Click the Type field at the top of the editor and choose a noise type from the 

menu.  
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Below are the 50 Phase Noise Types available:  

• Nothing   
• Sine  
• Square   
• Triangle   
• RND Discrete   
• RND Linear  
• RND Continuous   
• RND Saw  
• Vortex Noise  
• Fractal   
• Turbulence  
• Spots  
• Fract Stone   
• Triangles Discrete   
• Square Lines  
• Sparse RND Paths  
• RND Lines  
• Waves   
• Liquid   
• Linear Sine   
• Stucco Noise   
• Stone Cliff   
• Multifractal   
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• Leopard  
• Techno  
• Distance Origin   
• Time Random 
• Value  
• Gradient   
• Weird Value  
• Weird Gradient  
• Voronoi Distance1  
• Voronoi Distance2  
• Voronoi Distance3  
• Voronoi Distance4  
• Voronoi DistSq1  
• Voronoi DistSq2  
• Voronoi DistSq3  
• Voronoi DistSq4  
• Voronoi D2-D1  
• Voronoi D2sq-D1sq  
• Voronoi D3-D2  
• Voronoi D3sq-D2sq  
• Voronoi D4-D3  
• Voronoi D4sq-D3sq  
• Voronoi ID1  
• Voronoi ID2  
• Voronoi ID3  
• Voronoi ID4  
• Distance Squared   

Phase Noise Orientation  

Phase Noise Orientation controls the direction of the noise within the phase. The 
number of dimensions in the phase determines how many axes you can use to adjust 
the orientation. You can edit the noise orientation using the Direction numerical fields. 
The fields let you enter precise angles for noise orientation. 
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You can also use the scroll arrows to set the angle in increments. Like frequency, 
changing the orientation of the phase noise in only one or two axes can create some 
very interesting results. In this example, the phase noise orientation was changed in 
only the Y-axis and then applied to 3D noise.  
To change the orientation of phase noise:  

1. Display the Deep Texture Editor.  
2. Display the Phase Editor.  
3. Click one of the dimension buttons at the bottom of the editor.  

 

 
4. Drag over the XY field in the Direction area to set the noise angle in the X and Y 

axes. Drag left to decrease the value or right to increase it.  
 

  
5. Drag over the YZ field in the Direction area to set the noise angle in the Y and Z 

axes.  
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6. You can also drag over the scroll arrows to speed up the increments.  

Phase Frequency  

Phase Frequency determines how often the pattern within the noise repeats. Frequency 
is like scaling the noise. Higher frequencies decrease the scale of the noise so you can 
see the pattern more often. Lower frequencies increase the scale of the noise so the 
pattern repeats less often. You can change phase noise frequency using the Frequency 
numerical fields. The fields let you enter numerical values to adjust the noise frequency 
along the X, Y, or Z-axis. You can also adjust the values using the scroll arrows.  
The number of dimensions in the phase determines how many axes you can use to 
adjust the noise frequency. For 1D phase you can only use the X axis. With 2D phase 
you can use both the X and Y axes. For 3D phase you can use all the axes. Adjusting 
the frequency of the Phase noise disproportionately can have some very interesting 
effects on your noise.  
To change the frequency of phase noise:  

1. Display the Deep Texture Editor.  
2. Display the Phase Editor.  
3. Click one of the Dimension buttons at the bottom of the editor.   
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4. Drag over the X field in the Frequency area to set the phase noise frequency in 
the X axis. Drag left to decrease the value or right to increase it.   
 

  
5. Drag over the Y field in the Frequency area to set the Phase noise frequency in 

the Y axis.  
 

 
6. Drag over the Z field in the Frequency area to set the Phase noise frequency in 

the Z axis.   
 

 
7. You can also drag over the scroll arrows to speed up the increments  
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Phase Noise Octaves  

Phase Noise Octaves work exactly like the noise octaves. They introduce an extra level 
of complexity to the noise. Refer to "Noise Octaves" for more on octaves.  
To change the number of octaves:  

1. Display the Deep Texture Editor. Display the Phase Editor.  
2. Click one of the dimension buttons at the bottom of the editor.  

 

 
3. Drag right over the Octaves field to increase the octaves, drag left to decrease.  

 

  

Phase Noise Modes  

Phase Noise Modes work exactly like the noise modes. They modify the octaves of a 
noise. Refer to "Noise Modes" for more on modes.  
To choose a Phase Noise Mode:  

1. Display the Deep Texture Editor.  
2. Display the Noise Editor.  
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3. Click one of the dimension buttons at the bottom of the editor.  
 

 
4. Click the Mode field at the top of the editor and choose a mode from the menu. 

 

 
There are 13 noise modes available:  

• Standard  
• Irregular   
• More Irregular  
• Maximum   
• Multi-Fractal   
• With Rotation   
• Minimum   
• Multiply  
• Difference  
• Minimum90  
• Maximum90  
• Auto-Phased  
• Displaced Max  
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Filtering  

The Filter you apply to the Noise in a component can change the entire look of the 
noise. The filter refines the noise so that it has more or less detail, increases its 
contrast, applies it only at high altitude, or changes its spatial orientation. Whatever the 
change, the filter has a profound effect on the final look of your texture.  
Filters are expressed as equations with variables. When the equation is applied to the 
noise, it changes some aspect of the noise. You can control how the equation affects 
the noise by changing the values of the variables. The filter only affects the Noise.  
The Phase cannot be altered using a Filter. The Phase is blended with the Noise.  
Filters are edited using the Filtering Palette.  
The palette displays the current filter and provides tools for editing the filter graph.  

Filtering Palette  

Filters are equations which have variables. Each equation can have up to three 
variables labeled a, b, and c. The values for each variable are displayed at the bottom 
of the palette.   
Generally, a controls the intensity of the filter effect while b controls the overall height. In 
some filters a and b may stand for other things. For those filters that use it (Quantize 
and Snow Puddles), c controls the number of steps between values or the height 
required for snow to appear.  
There are two ways you can adjust a filter: by changing the variable values or by 
changing the shape of the graph (which automatically changes the variable values). The 
method you use depends on how much you know about a particular filter. If you're not 
sure what the filter does, change the graph - it's a much more intuitive way of working.  
To display the Filtering palette and edit the current filter: 

1. Display the Deep Texture Editor.  
2. Click the Filter button at the bottom of the editor or the bottom-right corner of any 

of the component windows.   
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The Filter palette appears.  
 

 
3. Select which component to adjust by clicking in one of the indentations of the 

Component Indicator. The first three indentations are for Components 1, 2, and 
3, while the fourth one is for the Combination (final) Component   
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4. If the current filter is set to None, left-click hold on the filter name and select a 
filter from the list. See "Choosing a Filter" for examples of each filter. 
 

 
5. Left-click hold over the Filtering graph area. The cursor changes to a four sided 

arrow. Drag over the filter and the shape of the graph changes as you drag. 
 

 
6. Notice that the variables also change as you move the graph. 

• Dragging horizontally changes the value of a. 
• Dragging vertically changes the value of b.  
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7. To change variable values:  
• Display the Filtering palette.  
• Left-click hold over the variable field you want to change. The cursor 

changes to a double-ended arrow. Drag left to reduce the value or right to 
increase it. The shape of the graph changes as you adjust the values.   
 

 
• Please note that if the filter equation does not include the c value, then 

adjusting that value will not affect that particular filter. 

Choosing a Filter  

Each filter available in the Filtering palette offers something unique. The best way of 
choosing which filter you want to use is to apply it to a component and see what 
happens.  
To choose a filter: 

1. Display the Deep Texture Editor.  
2. Display the Filtering palette.  
3. Click the Filtering Equation area and choose a filter from the menu.  

 

 
There are fourteen filters available.  

None  

This option deactivates the filter. No filtering is applied to the component.  
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Quantize (Xa+b, c)  

This filter works like a Posterize effect. When it's applied, gray values jump from one 
value to the next, creating a blocky stair-step type of effect. 
In this filter, a and b control the contrast and height, while c controls the number of 
levels between white and black. Notice in the images below how the c value affects the 
levels.  

   
In this example, Quantize (right) was applied to RND Continuous noise (left).  

  

SawWave(Xa+b)  

When the graph for this filter has only a small curve, it acts like a contrast filter. As it 
approaches the height limits (set by b), it bounces back on itself. This creates high-
contrast breaks in the noise. For color output use this filter to get areas of high-contrast 
alternating color.  
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When you set the value of a to a high number you'll get areas with a larger amount of 
noise. 

   
In this example, Saw Wave (right) was applied to RND Continuous noise (left).  

  

Sin(aX+b)  

This filter creates noise that appears as large number of lines that are oriented in the 
same direction. Use this filter to generate wood grains.  
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The a variable controls the number of lines. Higher values create a better effect.  

 
In this example, Sine Wave (middle) was applied to RND Continuous noise (left). In the 
far right example, the a variable for Sine Wave was increased.  

   

Abs(aX+b)  

This filter works like a Difference effect. When it's applied, you'll get more light areas in 
your noise and a higher level of detail in a bump map.   

   
To get additional bump information using this filter, set a to 2 and b to -1.  
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In this example, Absolute (right) was applied to RND Continuous noise (left).  

  

(X pwr a)+b  

This filter smoothes out the darkest areas of your noise. However it has less effect on 
lighter areas and no effect on white.  

 
In this example, XPower (right) was applied to RND Continuous noise (left).  

  

Gaussian(a(X+b))  

This filter smoothes out darker areas of your noise and makes lighter areas noisier. 
White areas become the noisiest.  
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In this example, Gaussian (right) was applied to RND Lines noise (left).  

  

Clip aX+b  

Clip is probably the filter you'll use most. It's a contrast filter. The a variable controls the 
contrast and b controls the overall brightness.  
For a low contrast effect make the wave in the graph smaller. Decrease the value of a to 
reduce the size of the wave and increase b to move the wave up. 

  

  
Using this wave, all the values will be expressed as mid-gray. For a high contrast effect, 
adjust the wave so that it hits both the top and bottom edges of the preview.   
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Increase the value of a and make b negative to move the curve down.  

  
To invert the colors in your noise, make a negative and increase b.  

  
In these examples, different levels of Clip were applied to Linear Sine noise. The black 
and white versions show the contrast/brightness changes when Color is disabled.  
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Xb+a(Altitude-Slope)  

This filter applies noise only at certain combinations of slope and altitude. The Altitude 
Minus Slope filter works on the slope and altitude of an object in World Space. In these 
examples, Altitude Minus Slope was applied to Voronoi DistSq4 and then to objects in a 
scene.  
When a is positive and b is negative, noise is applied at high altitudes and on flat 
surfaces.  
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When a is negative and b is positive, noise is applied at low altitudes and on steep 
slopes.  

   

X(a*Slope+b)  

This filter applies noise based on an object's slope. Slope can range anywhere from flat 
and horizontal to steep and vertical. This is an excellent filter to use if you want to 
isolate a texture to vertical cliffs or flat surfaces.  
In this filter, a determines the steepness of the noise (-4 is flat, 4 is vertical). The b 
variable controls the starting point of the transition.  
To place noise on vertical surfaces make a=4 and b=2.  
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To place noise on flat surfaces make a=-4 and b=1.5.  

   
The Slope filter works on the slope of an object in World Space. In this example, the 
default Slope (bottom) was applied to Fract Stone noise (top) and then to objects in a 
scene.  
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X(a*Altitude+b)  

This filter modulates the scale of the noise according to an object's altitude.   
In this filter, a determines how fast the noise is scaled by altitude. A lower value creates 
a gradual transition, while higher values create sharper transitions.  
To apply noise at higher altitudes make sure a is positive. At high altitudes b controls 
the transition. The higher the transition, the lower the number. So, at high altitudes b 
should be a negative number.  

   
To apply noise at lower altitude, reverse the variables so that a is negative and b is 
positive.  
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The Altitude filter works on the altitude of an object in World Space. In this example, 
Altitude (bottom) was applied to RND Continuous noise (top) and then to objects in a 
scene.  

  

  

X(a*Orientation+b)  

This filter applies noise based on an object's east-west orientation.  
In these examples, Orientation was applied to Voronoi ID2 noise and then to objects in 
a scene.  
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Smooth Clip aX+b  

This filter works exactly like the Clip filter. It's also a contrast filter, except that this filter 
smoothes out the transitions between darks and grays. The a variable controls the 
contrast and b controls the overall brightness.  
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In these examples, Smooth Clip was applied to Linear Sine noise.  
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Snow Puddles  

This filter turns noise into snow patches. Snow is applied according to an object's slope 
and altitude.  
The a variable controls how much the noise interferes with the smoothness of the snow.  
When a=0 the noise doesn't interfere at all so the snow is perfectly smooth.   

   
When the a value is higher, the snow starts looking like the noise. The b variable shifts 
the altitude or snow level. It sets where the snow begins. The c variable controls how 
steep an object has to be before the snow appears on its surface. The higher the 
number, the flatter an object has to be before snow appears on its surface.  
In these examples, Snow Puddles was applied to RND Continuous noise and then to 
objects in a scene. The a, b, and c variables are varied to show how different values 
affect the material. 
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Combining Components 

The Deep Texture Editor gives you unparalleled control over the look and feel of each 
one of the components that make up a texture, but the control doesn't stop there. The 
Deep Texture Editor also lets you control how those components are combined to 
create the final texture.  

Blend Modes  

Components are combined using Blend modes. These modes are filters applied to the 
components to determine how the properties in each component are combined with the 
other components' properties to form the final texture.  
The number of blend modes you can use varies depending on how many components 
you're using to build the texture. If you're using only one component, the properties in 
the component are applied directly to the final texture. When you're using two 
components, they're blended using a single blend mode, and the result is then applied 
as the final texture.  
When you're using three components, the first two components are blended together 
using a blend mode, then the result of that blend is combined with the third component 
using a second blend mode. The result of all the blending is then applied as the final 
texture.  
This diagram explains when the blend modes are applied as you combine components 
to form a texture.  
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Depending on the Blend mode, the different types of output can affect each other during 
the combination process. So its possible that the Bump output of one component may 
affect the Color output of another.  
To apply a blend mode:  

1. Display the Deep Texture Editor.  
2. Click the text above Component 1 to choose a Blend Mode to combine 

components 1 and 2. 
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3. Click the text above Component 3 to choose a Blend Mode to combine the 
results of Component 1 and 2 with 3.  
 

 
There are nineteen blend modes you can use to combine your components:  

Parallel  

This mode does not blend components. Use it when each component has a different 
output type. If two components share an output type, only the first output will be applied 
to the final texture.  
For example, if Component 1 has output = Color and Bump, and Component 2 has 
output = Color and Alpha, only the color from Component 1 will be applied to the 
texture.  
The texture below shows an example of this with a randomized combination. Both 
Component 1 and 2 have the Color output but if the Color output is disabled, as in the 
second image, you can see that it makes no difference in the final output.  
The Parallel mode took the color from Component 1 and the Alpha and Bump from 
Component 2, throwing out the color from Component 2.  
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Combine  

Combine is a blend mode for colors only. When you use this blend mode, the first color 
in Component 2 is used as an alpha channel. Wherever that color appears in 
Component 2, it is replaced with the colors from Component 1.  
For example, lets say Component 2 has Yellow, Green, and Blue and Component 1 has 
Orange, Purple, and Black as its color scheme. When you combine them using the 
Combine blend mode, Yellow disappears from Component 2. Everywhere that Yellow 
appeared, you'll see Orange, Purple, and Black.  
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Average  

Average is a normal blend mode where all the component values are mixed with equal 
weight. So if one component is white and the other is black, the result is gray. This is a 
good all-purpose blend mode to use for creating textures.  

 

Multiply  

When you use this blend mode to combine components, you'll get a darker result. In this 
mode, when a black component is combined with a gray component, the result is black. 
When a gray component is combined with a white component, the result is gray. When 
two shades of gray are combined, the result is proportionally darker. In the case of 
Bump output, this mode will flatten most areas since black is flat and darker values 
create flatter bumps.  
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Maximum  

When two components are combined using Maximum, the two components are 
compared and the one that's lighter becomes the result.  

 

Minimum  

This mode is the opposite of Maximum. When two components are combined, they're 
evaluated and the darker areas of both are combined to produce the result.  
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Add  

Add combines colors so that they appear dramatically lighter. However, it doesn't have 
the same effect on Bump output.  

 

Subtract  

When you combine grayscale components using Subtract, they tend to turn out black or 
very dark. When you use it with colored components, the result is brilliant colors that 
tend to compliment the original colors.  
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Blend V1  

The Blend v1 blend mode lets you use the first component as an alpha channel for 
blending. When you choose Blend v1, the noise in the first component is used as an 
alpha channel to blend the two components. To use the noise in the second component 
instead, use Blend v2.  

 

Blend V2  

The Blend v2 blend mode lets you use the second component as an alpha channel for 
blending. When you choose Blend v2, the noise in the second component is used as an 
alpha channel to blend the two components. To use the noise in the first component 
instead, use Blend v1.  
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Blend Slope  

Using Blend Slope, components are combined according to an object's slope. The first 
component is applied to areas that are flat and the other is applied to areas that are 
steep.  

 

Blend Altitude  

This mode blends components according to an object's altitude. The first component 
appears at low altitudes and the second appears at high altitudes.  
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Blend Orientation  

In this mode, one component is applied in all directions, while the other is applied in 
only one direction. You can use this mode to simulate things like moss that only grow on 
one side of a tree.  

 

Fast Slope  

Fast Slope works exactly like Blend Slope except that the transition from one 
component to the other is more abrupt.  
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Blend Random  

This mode introduces an extra layer of noise and uses it as an alpha channel for 
combining the two components. Component 1 appears in some areas of the new noise, 
and Component 2 appears in other areas. Since this mode adds another layer of noise, 
you're also adding more processing time.  

 

Blend Minimum  

Blend Minimum works the same as Minimum except that it creates blurring at points of 
sharp transition. When Blend Maximum is applied to Bump output, the resulting bump 
map will have mostly low areas with very few high points.  

 

©2007 DAZ 3D, Inc.  753 



Bryce 6 Artist Guide 

Blend Maximum  

Blend Maximum works the same as Maximum, except that it creates blurring at points of 
sharp transition. When Blend Maximum is applied to Bump output, the resulting bump 
map will have many high points and few deep pits. This mode works best on Bump 
output.  

 

Procedural  

Procedural Blend combines two components so that the color and values of Component 
1 are applied to Component 2 based on the gray values in Component 2. In essence, 
the Alpha output from Component 2 is used as a guide for blending.  
Where Component 2 is light, Component 1 is not applied. Where Component 2 is dark, 
Component 1 is made darker. Where Component 2 is gray, Component 1 is applied 
without change. This mode usually results in more saturated colors.  
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Difference  

Difference finds the difference between the noise in the two components and displays 
the result. This mode only works on output of like types. So if Component 1 has Alpha 
and Color output while Component 2 has only Alpha, the two Alpha outputs are 
combined and the Color output is left unchanged.  

 

Global Changes  

The component window in the center of the editor, called the Combination component, 
represents the final combined texture. Any changes you make to this final component 
are considered global changes since they affect the entire texture.  

 
The Combination component can have its own color scheme, filter, noise pattern, or 
phase. These attributes are applied to all the component elements. For example, the 
Combination noise values affect the noise within each component. 
Global changes give you a way of applying a last layer of complexity to your texture.  

©2007 DAZ 3D, Inc.  755 



Bryce 6 Artist Guide 

Global Colors  

The colors in the Combination component interact with the combined colors in the three 
components. They act as a final color filter for the texture. After the colors in each 
component are combined, they are blended with the combination component colors to 
produce the colors in the final texture.  
You can also apply a final Color Blending method to the combination component. The 
Blending method you apply to the combination component is applied on top of the other 
modes used in the components.  
For example, if you choose Altitude in the Combination component, the texture color is 
applied using the blend modes in the components and then also applied by altitude. The 
example below shows a texture containing a texture with different Color Blending 
modes in it.  
To add colors directly to a texture:  

1. Click the top color circle in the Combination component window and choose a 
color from the palette. The color circles in the Combination component window 
let you apply colors directly to the final texture.  
 

 
2. Repeat for each of the other two color circles. 

Global Noise Filter  

When you change the noise in the Combination component, (i.e., globally) it applies to 
all the components equally. So if you increase the noise in the final component, the 
noise in each of the components increases. Likewise, when you decrease the noise 
globally, the noise in each individual component decreases. Global noise can be 
different than component phase, so you can introduce a completely different type of 
noise into the texture.  
Use this option cautiously. The more noise you introduce into your texture, the longer it 
takes to render and draw. If you introduce too much complex noise patterns into a 
texture, you may find your render time increased significantly. You can adjust global 
noise in the same way you would for a single component, using the Noise Palette or the 
Noise Editor.  
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To adjust noise globally:  
1. Click the top left button in the Combination Component window.  

 

 
 
The Noise palette appears.   

2. Either drag the slider to adjust the noise value 
 

 
 
or click the top left corner of the Noise palette to display the Noise Editor.  
 

 
 
Note: If the Noise palette won't come up, click in the Component Indicator for one 
of the other Components, then click on the top left corner of the Noise palette. 
Once the Noise Editor comes up, move the Component Indicator back to the last 
position.   
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3. Use the editor's controls to design the global noise pattern or grain.   
 

 

Global Phase  

As you adjust the Global Phase value, new phase is introduced into each of the 
components. Global phase can be different than component phase, so you can 
introduce a completely different type of phase into the texture.  
You can adjust global phase in the same way you would for a single component using 
the Phase palette or the Phase Editor.  
To adjust phase globally:  

1. Click the bottom-right button in the Combination Component window.   
 

 
 
The Phase palette appears.  

2. Either drag the slider to adjust the phase amplitude 
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or click the top left corner of the Phase palette to display the Phase Editor.  
 

 
3. Use the editor's controls to design the global phase.  

 

 

Global Filtering  

The Filter affects the final look of the noise within a component. The Global Filter affects 
the look of the combined noise. The Global Filter is applied to the noise in the 
Combination component. The global filter only affects the noise, not the phase in the 
component. Any of the filters you used in the components can be used as the global 
filter.  
Use this option cautiously. The more complex the noise in your texture, the longer it 
takes to render and produce. If you introduce too much complexity, you may find your 
render time increased significantly.  
To filter noise globally:  

1. Click the top-right button in the Combination Component window.   
 

 
 
The Filtering palette appears.  
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2. Choose a filter and adjust its variables to create the desired effect.  
 

 

Tips for Speeding Up Textures 

Textures can be the most powerful effects you create in Bryce. They can also be the 
most costly. The more complex the texture, the longer it takes to calculate and the 
longer it takes to apply to an object, which finally increases the rendering time. When 
you're creating the texture, you always have to keep in mind that it's part of a material, 
which is part of an object. All these parts can contribute to the rendering time. 
The material that contains the texture may have several complex attributes of its own, 
like Transparency and Reflection. The size of the object may also contribute to the 
rendering time. 
Consider the effect of applying a complex texture to a complex material onto an infinite 
plane. The time to calculate this object would be staggering. A good rule of thumb when 
working with complex objects and textures is to make the texture element as simple as 
possible. 
These tips are meant only as a precaution to prevent you from inadvertently creating a 
huge texture. That doesn't mean that you shouldn't use the more complex features as 
well, after all they were created for a reason. You should just use them cautiously. 

Speeding Up Noise  

Use a simpler noise type. Some noise types (like Vortex) require more time to process 
than others.   
Restrict the amount of noise you add to each component. In fact, not all the components 
need to have noise.  
Watch the frequency of the noise. Higher frequency noise requires more time to 
calculate then lower frequency  
noise.  
Watch the number of octaves in the noise. Each octave adds another level of 
complexity.  
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Speeding Up Phase  

When you're designing the phase, you may want to use simpler noise. 
Cut down on the number of phase types you combine. If each component has a 
different type of phase, combining them can increase calculation times. 
Watch the amplitude of the noise. Higher amplitude phase takes much longer to 
calculate. 
Apply Global Phase cautiously. This is the quickest way of increasing the complexity of 
your texture because global phase introduces more complexity into each component 
simultaneously. 

Speeding Up Filtering  

Filtering introduces complexity or detail into the noise of a component. Make sure that 
you aren't using a filter  
unnecessarily. Not all noise needs filters.  
Be careful when you apply a Global Filter as this adds even more complexity to the 
noise.   

Sky Lab 
The Sky Lab button provides access to the Sky Lab dialog. This dialog contains controls 
for fine-tuning environmental effects like clouds, rainbows, and sun and moon rings. 
Click the Sky Lab button, which looks like a cloud with a rainbow, in the Sky & Fog 
palette to display the Sky Lab dialog. You can also click the triangle icon below the 
memory dots and choose Sky Lab from the menu. 
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The dialog contains four tabs: 
• Sun & Moon contains controls for positioning the sun and moon as well as 

adding effects like rings and horizon illusions. 
• Cloud Cover contains controls for editing cloud textures and setting up cloud 

animations. 
• Atmosphere contains controls for rainbows, visible lights, and color blending.  
• IBL contains controls for adding an HDRI image and managing the effect. 

You can preview your changes in the Sky Lab dialog. 
To view the different preview options, click the downward pointing triangle at the lower 
corner of the preview area. You can also change the camera position in the preview 
area. To change the position of the camera, drag the preview. To orbit around the 
scene, drag the preview in the direction you want to move the view of your scene. 

 

Sun & Moon Tab 

The Sun & Moon tab contains controls for positioning the sun and moon as well as 
adding effects like star fields, rings, and horizon illusions. 
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Star Fields 

Bryce lets you create night skies complete with stars and comets by using the Sky Lab. 
Stars appear in the night sky and are affected by the moon's brightness and color. They 
are also infinitely distant, i.e., they do not get closer as you move the camera. In this 
example, you can see how the moon affects the color and intensity of the stars around 
it. 

  
You can create a star field that is based on a randomly generated star map or a star 
field based on the stars we see from the Earth. 
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Random Star Field 

To add a Star Field based on a random star map: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Enable the Celestial option. 

 

 
5. Enable the Random Field option. This will create a star field based on a randomly 

generated star map. 
 

 
6. You can get a different random configuration of stars by Opt/Alt+clicking the 

Random Field button. Pressing Shift+clicking the Random field button generates 
the default random star field. 

7. Enable the Stars option. Adjust the Intensity and Amount as needed.  
 

 
8. Set the Ambient and Sky Dome colors to black. 

 

 
9. Click the OK icon to exit the dialog.  
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Note: When selecting the Random Star Field, all stars will have the same brightness 
level. 
Examples: 

• Default Random Star Field: 
 

 
• A Random Star Field (by using Option/Alt+clicking the Random Field button): 

 

 
• Another Random Star Field: 
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Earth-based Star Field 

To add a Star Field based on Earth's star map: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Enable the Celestial option. 

 

 
5. Enable the Custom Field option. 

 

 
6. Enable the Star option. Adjust the Intensity and Amount as needed.  

 

 
7. Set the Ambient and Sky Dome colors to black. 

 

 
8. Click the OK icon to exit the dialog.  

©2007 DAZ 3D, Inc.  766 



Bryce 6 Artist Guide 

Examples: 
• Earth-based Star Field: 

 

 
• Random Star Field with same Intensity and Amount settings:  

 

 

Customizing Star Fields 

After you have generated your star field, you can customize certain parameters of the 
star field. You can control the intensity of the stars, the amount of stars that are visible, 
and the portion of the star field that is visible in your scene. 

Star Field Position Control 

The Star Field Position Control lets you choose which portion of the star field is visible in 
your scene. The control works like a trackball, with the stars of the northern hemisphere 
on one side and the stars of the southern hemisphere on the other. As you drag over 
the control, the star field moves in the direction you drag. 

©2007 DAZ 3D, Inc.  767 



Bryce 6 Artist Guide 

To set the Star Field Position: 
1. Apply the settings for either a Random or Earth-Based Star Field. 
2. Move the mouse cursor over the Star Field Position Control then left-click and 

drag to change the position. 
 

 
3. Render the scene to check the star position, modify as needed. 

Setting Star Field Position for Earth-Based Star Fields 

When you enable the Celestial option, the Star Field Position Control has the "sun" in 
the center. If you rotate the camera to have all rotation angles at 0°, you'll see the Earth 
sky at a Right Ascension (RA) of 6h (hours) with the horizon at a Declination of 0°. You 
will see the constellation of Orion near the center of the screen, the lower part of which 
is below the horizon. A bit higher up and to the right, you will notice the constellation of 
Taurus with the beautiful Pleiades. 
If you push the Position Control upwards, the stars nearer to the North Pole appear. If 
the "Sun" just disappears over the top of the control, the sky of the North Pole is shown 
with Polaris - the North Star - in the center. Similarly, moving the control downwards 
opens up the sky to the south. Note that the star field is as you would see it on a 
cloudless dark night, not like on a star map, which shows the sky with left and right 
sides swapped as if seen in a mirror.  
If you move the control from the center to the right, the RA decreases towards 0h and if 
you move the control to the left, the RA increases towards 12h. The faintest stars shown 
are those with a magnitude of 6. This is what we can see with the unaided eye on a 
clear dark night. The Milky Way and other rather bright Deep Sky objects like Nebulae 
or Galaxies are not in the star map and hence are not shown. 
The image below is the star field generated with the position control in the center: 
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The image below shows the change in the star field after dragging the trackball to the 
right: 

 
And after dragging the trackball to the left and up: 

 

Star Field Intensity 

Changing the Intensity of a star field lightens or darkens the visible stars. When you are 
using a star field based on the stars we see from Earth, changing the intensity lightens 
and darkens the stars uniformly; their relative intensities do not change. 
To change the Intensity of a star field: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
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4. Enable the Celestial option. 
 

 
5. Enable the Random or Custom Field option. 

 

 
6. Enable the Stars option. 

 

 
7. Drag the Intensity slider or enter a value in the Intensity field. 

 

 
8. Set the Ambient and Sky Dome colors to black. 

 

 
9. Click the OK icon to exit the dialog.   
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Examples: 
• Intensity = 54 

 

 
• Intensity = 100 

 

 

Star Field Amount 

You can increase or decrease the number of stars in the star field by changing the Stars 
Amount. When you change the amount, new stars are not generated. Instead, stars that 
are usually too dim to see become more visible. 
To change the Amount of visible stars in a star field: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
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4. Enable the Celestial option. 
 

 
5. Enable the Random or Custom Field option. 

 

 
6. Enable the Star option. 

 

 
7. Drag the Amount slider or enter a value in the Amount field. 

 

 
8. Set the Ambient and Sky Dome colors to black. 

 

 
9. Click the OK icon to exit the dialog.   
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Examples: 
• Amount = 3000 

 

 
• Amount = 6000 

 

 

Star Field Glow 

Haze and the Color Perspective directly affect the color of the glow around the stars. 
This allows you to find some really neat effects in the sky. 
To add a glow around the stars, set up the star field as shown in the previous pages, 
then do the following: 

1. Delete the ground plane. 
2. On the Sun & Moon tab, set the Star Intensity to a fairly high amount, between 60 

and 100, and the Amount to a very large number.  
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3. Make sure that Sun/Moon Shadows are enabled and set the Ambient and Sky 

Dome colors to white. 
 

 
4. Change to the Atmosphere tab, then disable Fog and enable Haze and Color 

Perspective. Set the Haze color to white. Drag over the RGB buttons to adjust 
the colors. You'll need to know what the RGB settings are for the color you want, 
which you can get from some of the available color pickers. 
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The Sky Preview should now look something like this: 
 

 
5. Click on the OK icon to close the Sky Lab. 
6. Double-click on the Trackball to open the Camera & 2D Projection dialog. 

Change the settings as shown below. 
 

 
7. Click on the OK icon to close the dialog. 
8. Render the scene. 
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9. Adjust the Haze settings and Color Perspective colors to get a different view. 
 

  
10. Render to see the differences. 

 

 
11. Adjust the camera settings to similar settings shown below to get a "warp speed" 

effect. 
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12. Render to see the results. 
 

 
Thanks to Clay Hagebusch for showing how to get this effect. 

Comets 

You can add Comets to your night skies but since comets are not a common sight in the 
night sky, you'll usually only 
need one or two comets per star field. 
To add Comets to a night sky: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Enable the Celestial option. 
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5. Enable the Random Field option. This will create a star field based on a randomly 
generated star map. You can only add comets to a star field that is based on a 
randomly generated star map. 
 

 
 
You can get a different random configuration of stars by Op/Alt+clicking the 
Random Field button. Shift+clicking the Random field button generates the 
default random star field. 

6. Enable the Stars option. Adjust the Intensity and Amount as needed. 
 

 
7. Enable the Comets option. 

 

 
8. Adjust the intensity and amount of comets by dragging the Intensity and Amount 

sliders or entering a value in the Intensity and Amount fields. 
 

 
 
The number of comets is spread around the sky dome, so setting the amount to 
1 or 2 means you'll need to adjust the Star Field Position Control until you find 
the comets. Setting the amount higher gives you a better chance of finding the 
comets faster.  

9. Set the Ambient and Sky Dome colors to black. 
 

 
10. Click the OK icon to exit the dialog.   
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Examples: 
• Amount = 20 

 

 
• Amount = 75 

 

 

Moon Phases 

The Moon Phases Control simulates different aspects of the moon as it orbits the earth. 
The moon phase is a visual clue 
to the time of the month. In an animation, you can use the moon phase to simulate the 
passage of a time. 
The phase is controlled using the Moon Phase Controls in the Sky Lab palette. 
To set the Moon's Phase: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
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2. Click the Sky Lab button. The Sky Lab appears. 
 

 
3. Click the Sun & Moon tab. 

 

 
4. Enable the Moon Phase option.  

 

 
  

5. Left-click+drag over the Moon Phase control. The phase changes as you drag.  
 

 
6. Adjust the Moon Brightness and Sharpness and Moon Texture if needed. 
7. Click the OK icon to exit the dialog.   
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Examples based on settings in step 5 above: 

  

 

Moon Brightness and Sharpness 

The moon is directly affected by the light reflected from the earth. The brighter the 
reflection, the brighter the moon's shadow. In Bryce this effect is controlled by the 
Earthshine setting which makes the moon brighter or darker. 
A realistic moon does not have sharp edges and may appear blurry on hazy nights. The 
Softness control lets you set the moon's edge softness to give a more realistic feel. 

Moon Shadow 

To set the brightness of the moon's shadow: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 
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3. Click the Sun & Moon tab. 
 

 
4. Enable the Moon Phase option.  

 

 
5. Drag the Earthshine slider right to increase the brightness and left to decrease it 

or enter a value in the Earthshine field. 
 

 
6. Click the OK icon to exit the dialog.   

Examples: 
• Earthshine = 15 
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• Earthshine = 50 
 

 

Moon Edge Softness 

To set the moon's edge softness: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Enable the Moon Phase option.  

 

 
5. Drag the Softness slider right to soften edges or left to sharpen them or enter a 

value in the Softness field. 
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6. Click the OK icon to exit the dialog.   
Examples: 

• Softness = 30  
 

 
• Softness = 100  

 

 

Moon Texture 

Previous versions of Bryce provided a default Moon texture that was applied by 
enabling the Texture option under Moon Phase. Bryce 6 includes this option but 
introduces the ability to add your own texture to the moon. This new feature means you 
could add a face to the moon or a texture that looks like a distant planet. 
To add a texture to the moon: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 
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3. Click the Sun & Moon tab. 
 

 
4. Enable the Moon Phase option. Adjust the moon phase if needed. 

 

 
5. Under Moon Phase, enable the Texture option. This will load the default moon 

texture. To add a different image, click on the Edit button. 
 

 
6. The Picture Editor will come up. Click on the first empty square. 
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7. The Open file dialog will come up. Locate the texture you want to load and click 
on Open. 
 

 
 
The image will be loaded in the Picture Editor. 
 

 
8. Click the OK icon to exit the dialog.  
9. In the Sky Lab, make sure that the Sun/Moon Size is enabled and set a Disk 

Size. 
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10. Click the OK icon to exit the dialog.  
11. In the Bryce Working Window, adjust the moon's location until it is visible in the 

scene, then render.  
 

 

Sun/Moon Visible 

Showing the sun or moon in your scene can provide interesting scenes with beautiful 
colors, however, there may be times when you need the shadows that are visible when 
the sun or moon is up, but you don't want the sun or moon to actually be visible in the 
scene. You could disable the sun/moon but then the shadows would also be disabled. 
The solution to this is to disable the Sun/Moon Visible option. Of course, to show the 
sun or moon in the scene, enable the Sun/Moon Visible option. 
To set the Sun/Moon visibility: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to 

hide the sun/moon. 
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Note: Disabling Sun/Moon Visible will automatically disable the Sun/Moon Size 
and Halo Rings options. 

5. If the Sun/Moon Visible option is enabled, adjust the Disk Intensity and Glow 
Intensity as needed. 

6. Click the OK icon to exit the dialog.  
Examples: 

• Sun/Moon Visible enabled.  
 

 
• Sun/Moon Visible disabled - notice that shadows are still visible without having to 

add additional lights.  
 

 

Disk Intensity 

Disk Intensity controls the intensity of the interior portion of the sun/moon disk itself. A 
higher value will make the sun/moon disk more visible in your scene while lowering the 
intensity will make the disk fade into the sky dome or clouds. This setting only comes 
into play if the sun or moon is visible in the scene at the time of render. This also applies 
to reflections of the sun/moon that might be in the scene. 
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To set the Sun/Moon Disk Intensity: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to 

hide the sun/moon. 
 

 
5. Drag the Disk Intensity slider right to increase the intensity or left to decrease it or 

enter a value in the Disk Intensity field. 
 

 
6. Click the OK icon to exit the dialog.  
7. If you don't see any changes to the Disk Intensity when rendering, lower the 

Glow Intensity. 
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Examples:  
• Disk Intensity = 25; Glow Intensity = 50 

 

 
• Disk Intensity = 75; Glow Intensity = 50 

 

 
• Disk Intensity = 100; Glow Intensity = 50 

 

 
* Thanks to Wolfiesden for the disk intensity description 
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Glow Intensity 

Glow Intensity controls the intensity of the halo or glow around the outside the 
sun/moon disk, not the interior portion of the disk. A higher value will bleed more of the 
glow color into the sky dome color. This has the effect of changing the dome color as it 
nears the location of the sun/moon disk.  
A typical example of a high setting here is an average Earth sunset, the sky can fade 
from a yellowish near the sun to a deep blue/purple away from the sun. Another 
example, think about looking at headlights of an automobile at night under different 
haze situations. If the night air has a lot of moisture or haze there will be a glow around 
the actual lights because the moisture scatters some of the light in random directions, 
this equates to a high Glow Intensity. On a clear night, there will be limited glow, 
because of the lack of scattering, making the edges of the lights more defined which 
equates to a low Glow Intensity. At low settings, the sun/moon disk must be visible in 
the scene to see this effect, at higher settings, the Glow Intensity can affect the sky 
even when the sun/moon disks are not directly visible in the scene.  
To set the Sun/Moon Glow Intensity: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to 

hide the sun/moon. 
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5. Drag the Glow Intensity slider right to increase the intensity or left to decrease it 
or enter a value in the Glow Intensity field. 
 

 
6. Click the OK icon to exit the dialog.   

Examples:  
• Disk Intensity = 100; Glow Intensity = 50 

 

 
• Disk Intensity = 100; Glow Intensity = 75 
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• Disk Intensity = 100; Glow Intensity = 100 
 

 
* Thanks to Wolfiesden for the glow intensity description 

Sun/Moon Size 

The size of the sun or moon can affect the overall mood of your scene, especially when 
simulating a sunset's horizon illusion. The Disk Size can be used alone to modify the 
size of the sun and moon but the Horizon Illusion is dependent on the Disk Size. 
If you've ever watched a sunset, you probably noticed that the sun appeared to get 
larger as it approached the horizon. The same is true for the moon. At certain times of 
the month it appears huge. This illusion can be simulated using Sun/Moon size. When 
the illusion is active, the sun or moon will appear to grow larger as it approaches the 
horizon.  
To change the size of the Sun or Moon as it approaches the horizon: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 

©2007 DAZ 3D, Inc.  793 



Bryce 6 Artist Guide 

4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to 
hide the sun/moon. 
 

 
5. Enable the Sun/Moon Size option. 

 

 
 
Note: To disable the Sun/Moon Size, disable Sun/Moon Visible to hide the 
sun/moon and disable the size option at the same time, or just disable the 
Sun/Moon Size option. 

6. In the Sun/Moon Size area, enter a value in the Disk Size field or drag the slider 
to set the overall size of the sun/moon anywhere in the sky. 
 

 
7. Enter a value in the Horizon Illusion field or drag the slider to set multiplier used 

to determine how much larger the sun or moon gets as it approaches the 
horizon. 
 

 
8. Click the OK icon to exit the dialog.   
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Examples: 
• Disk Size = 25; Horizon Illusion = 5  

 

 
• Disk Size = 25; Horizon Illusion = 25 

 

 
• Disk Size = 10; Horizon Illusion = 25  
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• Disk Size = 35; Horizon Illusion = 25 
 

 

Sun/Moon Rings 

If you look directly at the sun on a hazy day, you'll be able to see rings surrounding it. 
These rings are created by the reflection off ice particles in the air. In Bryce, you can 
use the Sun/Moon Rings to create this effect. 
This effect creates concentric circles around the image of the sun or moon. Using the 
Sky Lab palette, you can set the radius of the rings and add a secondary ring to 
increase the effect. The color of the rings is controlled by the color of the sun/moon. 
To add Sun/Moon rings: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Enable the Sun/Moon Visible option to make the sun/moon visible or disable it to 

hide the sun/moon. 
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5. Enable the Halo Rings option. 
 

 
6. In the Rings area, enter a value in the Intensity field or drag the slider to set the 

brightness of the ring. 
 

 
7. Enter a value in the Radius field or drag the slider to set the radius of the ring. 

 

 
8. If you want to add a secondary Sun/Moon ring, enable the Secondary Ring 

option. (Issue) 
 

 
9. Click the OK icon to exit the dialog. 
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Examples: 
1. Intensity = 50; Radius = 50 

 

 
2. Intensity = 100; Radius = 25  

 

 
3. Intensity = 100; Radius = 50 
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4. Intensity = 100; Radius = 100 
 

 

Shadows 

All the objects in your scene cast shadows. Using the Shadow control you can set the 
intensity and color of all the shadows in your scene. 
As you change the value of the Shadow control, the brightness of shadows changes. 
In the images below, the shadow on the left is set to 25%, the one on the right to 90%. 

 
The Shadow control is not the only control for shadows. The position of shadows is 
dependent on the position of the sun. Since the sky interacts directly with objects in the 
scene, the color of the sun also affects the color of shadows. 
The object's material properties also affect the color of shadows. Semi-transparent or 
transparent objects with a transparency color will change the color of the object's 
shadow. In addition, volume materials can dramatically change the shape and color of 
shadows. Use the Shadows control to set the color and intensity of shadows in your 
scene. 
By default, the Clouds in Bryce do not cast shadows. If you want the cloud layer to cast 
shadows on the ground below, enable the Cloud Shadows option. Refer to "Cloud 
Cover" for more on this option. 
To set shadow intensity numerically: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
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2. Click the Sky Lab button. The Sky Lab appears. 
 

 
3. Click the Sun & Moon tab. 

 

 
4. Enable the Sun/Moon Shadows option. 

 

 
 
Note that if you disable the Sun/Moon Shadows option, all shadows in your 
scene will also be disabled. 

5. Click the Sun/Moon Shadows field, then enter a value or drag the slider. This 
field governs the intensity of shadows rendered in your image. The range is 0 to 
100 and the default value is 90. 
 

 
6. Enable Soft Shadows if needed. 
7. Click the OK icon to exit the dialog. 

You can also set shadow intensity and color using the Sky & Fog Palette: 
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Soft Shadows 

When you adjust the softness of a shadow, you blur or sharpen the shadow's edges. 
Soft shadows blend more smoothly with the background. 
To enable soft shadows: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Enable the Sun/Moon Shadows option. 

 

 
5. Enable the Soft Shadows option. 

 

 
6. Click the OK icon to exit the dialog.   
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Examples: 
• Soft Shadows disabled: 

 

 
• Soft Shadows enabled: 

 

 

Ambient Color 

The Ambient Color is the color of all the light that surrounds the objects in your scene. 
Light from the sun interacts with ambient color to produce the color for both highlights 
and shadows. 
Ambient Color is used as the source color for material Ambience. The Ambient Color 
tints the surfaces of all objects in your scene that have some level of ambience. Any 
other color you apply to the object's surface is mixed with the Ambient color to create 
the final surface color. For example, if the Ambient Color is red, any color you assign to 
an object's surface ambience is mixed with red. Refer to "Ambience" for more on 
material ambience. 
To set Ambient Color: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
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2. Click the Sky Lab button. The Sky Lab appears. 
 

 
3. Click the Sun & Moon tab. 

 

 
4. Click the Ambient color swatch below the Sun/Moon Shadows option and choose 

a color from the color picker. 
 

 
 
For realistic effects, at noon or in the afternoon, ambient color should be a little 
blue to get nice blue-ish shadows. At dawn, you can set Ambient Color to red or 
pink, and at night you can set it to gray-blue. 
 

 
5. Click the OK icon to exit the dialog. 

You can also set the ambient color using the Sky & Fog Palette: 
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Sky Dome Color 

Sky Dome Color lets you create a color wash over your scenes, even if there is no 
sunlight present. This color simulates the natural effect that occurs when you have color 
in the sky even though the sun has set. Sky DomeColor lets you create late afternoon or 
evening scenes. The Sky Dome Color control in the Sky Lab lets you choose a color 
from either the color picker or the color dialog. 
For late afternoon and early evening realism, try using a touch of orange or yellow. This 
will create a cast of color over your entire scene, regardless of the position or color of 
the sun or moon. 
To set Sky Dome color: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
 

 
4. Click the Sky Dome color swatch below the Sun/Moon Shadows option and 

choose a color from the color picker. 
 

 
5. Click the OK icon to exit the dialog. 

You can also set the sky dome color using the Sky & Fog Palette: 
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Examples: 
• Sky Dome Peach 

 

 
• Sky Dome Blue 

 

 

Working with the Sun & Moon 

Working with the Sun 

The sun is the source of all natural light in your scene. Its attributes have a profound 
effect on the look of your scene. The color of the sun affects all the colors of all the 
objects in the scene; Sunlight color tints all the other visible colors. 
The position of the sun controls the time of day in your scene. If the sun is above the 
horizon, it is day; if it is below, it is night, and if it is at the horizon, it is sunrise or sunset. 
The sun can be animated just like all the other elements of your Bryce scene. You can 
create time-elapsed effects by changing the position of the sun over the course of an 
animation. 
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Working with the Moon 

The moon is normally the most prominent object in the night sky. In a night scene it 
provides all the natural light in the environment. Like the sun, the moon's attributes can 
greatly affect the final look of your scene. Its position in the sky affects all the angles 
and intensities of all the shadows in the scene. 
The brightness is affected by the illumination reflected off the earth. The brighter the 
earthshine, the brighter the moon appears. Unlike the sun, the moon has phases which 
simulate the effects of the moon's shadow becoming more or less prominent during a 
month. 
The moon's position and phases can be animated using the Animation controls and the 
timeline. 
Refer to "Animating Sun or Moon Position" for more on animating the moon. 

Positioning the Sun 

The sun position control sets the direction your natural light is coming from whether it is 
sunlight or moonlight. The position can be set using the Sun control in the Sky & Fog 
palette or in the Sky Lab. The control works like a trackball, with the sun (bright) at one 
end and the moon (dark) at the other. 
You can think of the control as a compass: if the highlight on the Sun Control sphere is 
positioned at 12 o'clock, the light comes from the north, and so on. As you change the 
position of the sun, the "time of day" changes. When the sun position is closer to the 
edges of the control, the sun appears closer to the horizon, making the scene darker. 
When the sun is in the center of the control, the sun shines from directly above the sun, 
like it would at high noon. 
The colors in your sky will change depending on the position of the Sun Control, or the 
"time of day..." just like in the real world. The angle of the shadows changes as the sun 
changes. If your object is shiny, and there are no other light sources, the position of the 
sun controls where the highlight appears. In this example, you can see the effects of the 
sun's position on several reflective and shiny objects. 
You can position the sun manually and with precision on the Sky & Fog Palette and in 
the Sky Lab. You can also position the sun numerically in the Sky Lab. 

Positioning the Sun Manually 

To position the sun manually:  
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
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2. Use the Sun Controls on the palette or click on the Sky Lab button. The Sky Lab 
appears. 
 

 
3. In the Sun Controls area, drag the larger highlight area in the Sun Position 

Controls to the position where you want the light to originate. You can position 
the sun, or the moon, on the horizon as you like by nudging the Sun Control until 
the light is visible in your scene. 
 

  

Positioning the Sun with Precision 

To position the sun with precision: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Hold down Ctrl+Opt/Alt and double-click the Sun control. 

 

 
3. Continue holding down Ctrl+Opt/Alt and in the working window, click where you 

want to position the sun. A yellow asterisk will show up where you click indicating 
where you placed the sun. 
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And the result: 
 

 

Positioning the Sun Numerically 

To position the sun numerically: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. In the Sun Controls area, type a value into the Azimuth field. The Azimuth field 
controls the east-to-west position of the sun. The range is 0 to +360.  
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4. Enter a value in to the Altitude field. The Altitude field controls the height of the 
sun relative to your scene. The range is 90 to +90. Positive values are above the 
horizon, negative values below. 
 

 
5. Check the results to see if any further changes are needed.  

 

 
6. Click the OK icon to exit the dialog. 
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Positioning the Moon 

The moon is positioned at the same time as the Sun. The two are always at opposite 
ends of the sky, so wherever the sun is positioned, the moon is directly opposite. In the 
Sun/Moon control on the Sky & Fog palette and in the Sky Lab, the moon's position is 
represented by the smaller highlight portion of the Sun Position trackball. 
You can position the moon manually by using the Sun/Moon control, or numerically by 
specifying values in the Sky Lab. You can also position the moon exactly where you 
want it to appear in your scene. 
You can position the moon manually and with precision on the Sky & Fog Palette and in 
the Sky Lab. You can also position the moon numerically in the Sky Lab. 

Positioning the Moon Manually 

To position the moon manually: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Use the Sun Controls on the palette or click on the Sky Lab button. The Sky Lab 

appears. 
 

 
3. In the Sun Controls area, drag the larger highlight area in the Sun Position 

Controls to the position where you want the light to originate. You can position 
the sun, or the moon, on the horizon as you like by nudging the Sun Control until 
the light is visible in your scene. 
 

 

Positioning the Moon with Precision 

To position the moon with precision: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
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2. Click the Day/Night Toggle to display the moon icon.  
 

 
3. Hold down Ctrl+Shift+Opt/Alt and quickly double-click on the Sun control.  

 

 
4. Continue holding down Ctrl+Shift+Opt/Alt and in the working window, click where 

you want to position the moon. A blue asterisk will show up where you click 
indicating where you placed the moon. If you have trouble placing the moon this 
way, place the sun, then click on the Day/Night Toggle to switch to the moon. 
 

 
 
And the result: 
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Positioning the Moon Numerically 

To position the moon numerically: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Day/Night toggle to display the moon icon. 
 

 
4. In the Sun Controls area, type a value into the Azimuth field. The Azimuth field 

controls the east-to-west position of the sun/moon. The range is 0 to +360, and 
the default value is 60. The moon will be positioned exactly opposite these 
values, so you can invert them to position the moon numerically or place the Sun 
behind the camera so that the moon appears in front of it. 
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5. Enter a value into the Altitude field. The Altitude field controls the height of the 

sun/moon relative to your scene. The range is -99 to +99. Positive values are 
below the horizon, negative values above.  
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6. Check the results to see if any further changes are needed.  
 

 
7. Click the OK icon to exit the dialog. 

Linking the Sun to the Camera 

Normally, you'd have to reposition the sun every time you changed the camera to 
maintain a certain effect or sunlight angle. However, if you apply the Link Sun to 
Camera option, your sun will track the camera. The position of the sun relative to the 
camera remains the same no matter where the camera is positioned. This way you can 
set up the sun position once and then not worry about losing the effect as you move the 
camera. This feature can also be very useful when you're animating your scene. 
To link the sun to the camera: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
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4. Click the Link Sun to View button. When this option is enabled, your sun will 
always remain in the same position relative to the camera. Wherever you move 
the camera the sun will follow. This is an easy way of seeing how a sunset will 
look against different skylines. 
 

 

Disabling Sunlight 

You can remove the sunlight in your scene by disabling it. When the sunlight is 
disabled, the sun remains in the scene, but does not throw light. The only light visible in 
your scene comes from individual light sources. (The scene will still be illuminated.) 
When using image-based lighting, the sun will need to be disabled.  
To disable the sunlight: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
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4. Click the Disable Sun Light button. 
 

 

Sun/Moon Color 

Light in nature is not usually visible until it strikes an object. When you're using normal 
light, a purple sunlight color will not paint your entire sky purple, but objects in your 
scene will reflect purple. When you're using Visible World, choosing purple will paint 
your entire scene purple. 
The grayscale bar at the bottom of the color palette lets you set the intensity of the sun. 
Black turns the sun off and white sets the sun to its brightest intensity. 

 
To set the Sun Color: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Sun & Moon tab. 
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4. Left-click-hold on the Sun Color Swatch and select a color from the color palette 
that comes up.  
 

 
5. Click the OK icon to exit the dialog.  

Examples: 
• Sun Color = White 

 

 
• Sun Color = Hot Pink 
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• Sun Color = Bright Red 
 

 
You can also set the sun/moon color using the Sky & Fog Palette: 

 

Switching Between Sun & Moon 

Your sky normally contains two bodies: the sun and the moon. There is always one 
body visible in your sky. At night it is the moon and in the day it is the sun. The two 
bodies are connected and always remain at opposite ends of the sky. As you move the 
sun you're also moving the moon. This means that when the sun dips below the horizon 
in front of you, the moon is rising behind you. 
The link between the sun and the moon can be seen by positioning the sun at the 
horizon in front of the camera. If you turn the camera 180°, you'll see the moon just 
rising over the horizon as well. 
To switch between night and day: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 
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3. Click the Day/Night Toggle button in the top-left corner of the Sun Position 
Controls.  
 

 
The Sun/Moon Control in the Sky Lab is linked to the same controls in the Sky & Fog 
Palette. 

 

Cloud Cover Tab 

The Cloud Cover Tab contains controls for adding, controlling, and animating clouds. 
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Setting Cloud Types 

There are two types of clouds you can add to your Bryce environment: Cumulus and 
Stratus. 
Cumulus clouds are generally found at lower altitudes and appear thicker and fluffier. 
The sky in this scene uses Cumulus clouds. 

 
Cumulus clouds are thicker, darker clouds at a lower altitude. These clouds will take on 
tints of Sunlight color, Ambient color, or Cumulus color. 
Stratus clouds appear at higher altitudes and appear thinner and more wispy. The sky in 
this scene uses Stratus clouds.  

 
Stratus clouds are bright white, thin, clean clouds that appear at high altitudes. These 
clouds are very responsive to Sunlight color and Sky Dome color, and less responsive 
to Cumulus color or Ambient color. 
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Using both cloud types at once creates a more realistic sky. 

 
Deselecting both cloud types creates a clear sky.  

 

Cumulus Clouds 

Cumulus clouds are thicker, darker clouds at a lower altitude. These clouds will take on 
tints of Sunlight color, Ambient color, or Cumulus color. 
To add Cumulus clouds to a sky: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
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4. Activate the Cumulus Clouds option. 
 

 

Stratus Clouds 

Stratus clouds are bright white, thin, clean clouds that appear at high altitudes. These 
clouds are very responsive to Sunlight color and Sky Dome color, and less responsive 
to Cumulus color or Ambient color. 
To add Stratus clouds to a sky: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Activate the Stratus Clouds option. 
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Editing Cloud Textures 

Clouds in Bryce are created using a procedural texture with a cloud pattern. The color, 
position, size, and pattern within the texture determines the final look of the cloud in 
your sky. You can edit this texture using either the Sky Lab palette, or for more complex 
editing, you can use the Deep Texture Editor. 
The texture used for a cloud can come from either the Bryce Texture Library or you can 
create your own. 

In the Sky Lab 

To edit cloud textures in the Sky Lab: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Activate either the Stratus or Cumulus cloud type, or both. 
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5. Click the grey + or -Turbulence buttons to increase or decrease the amount of 
noise in the texture. Increasing the Turbulence creates a more dense pattern 
within the texture. 
 

 
 
Note: The turbulence of the original texture is the lowest setting for that texture. 
The turbulence can only be increased then decreased back down to the original 
setting. 

6. Click the blue + or -Complexity buttons to increase or decrease the amount of 
detail in the texture. Increasing the Complexity increases the complexity of the 
patterns within the texture. 
 

 
 
Note: The complexity of the original texture is the highest setting for that texture. 
The complexity can only be decreased then increased back up to the original 
setting. 

7. Click the Reset button to restore the original settings if you want to start over.  
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8. Click the Edit button to enter the Deep Texture Editor to adjust or change the 
cloud texture. 
 

 
9. Click the OK icon to apply your changes.  

Examples:  
• Stratus - Original; Increased Turbulence; Decreased Complexity  

 

   
• Cumulus - Original; Increased Turbulence; Decreased Complexity  

 

   

In the DTE 

To edit cloud textures in the Deep Texture Editor: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
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2. Click the Sky Lab button. The Sky Lab appears. 
 

 
3. Click the Cloud Cover tab. 

 

 
4. Activate either the Stratus or Cumulus cloud type, or both. 

 

 
5. Click the Edit button below the type of clouds you want to edit. 
6. Click the Edit button. The Deep Texture Editor appears. The cloud texture and its 

components appear in the component windows. If you're not familiar with using 
the Deep Texture Editor you may get some very unpredictable results which may 
result in clouds that don't look much like clouds. Before you start editing the 
clouds texture you may want to refer to "The Deep Texture Editor" for more 
instructions on how to use the editor. 

7. If you want to add additional turbulence to the cloud texture, adjust the texture's 
Noise:  

• Click the Noise button at the bottom of the editor. The Noise control 
appears. The Noise control lets you adjust the frequency of the noise in 
any of the texture's components.  

• At the top of the Noise control, click the button associated with the 
component you want to edit.  

• Adjust the Noise slider to increase/decrease the frequency of the noise in 
the texture.  

8. If you want to change the colors of a component, click one of the color indicators 
in the component window and choose a new color. 

9. If you want to add more complexity to the texture, adjust its Phase:  
• Click the Phase button at the bottom of the editor. The Phase control 

appears. The Phase control lets you adjust the amplitude of the phase in 
any of the texture's components.  

• At the top of the Phase control, click the button associated with the 
component you want to edit.  
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• Adjust the Phase slider to increase/decrease the amplitude of the ph
If you want to change the pattern in t

ase.  
10. he texture, apply a filter:  

sentation of the 
e 

 
nt you want to edit.  

ed to 
er complex operation. Try experimenting 

11. 

When setting up animations, you can set the speed and turbulence of clouds as well as 
f motion. 

animations: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

• Click the Filter button at the bottom of the editor. The Filtering control 
appears. The Filtering control displays a graphical repre
filter applied to your texture. By changing the equation of the filter to th
value of the variables, you can change the patterns within the cloud 
texture.  

• At the top of the Filtering control, click the button associated with the
compone

• Change the filter equation and variable values to adjust the filter appli
your texture. Filtering is a rath
with different equations and see what happens.  

Click the OK icon to exit the editor. 

Setting Cloud Motion 

Setting Cloud Motion 

specify the direction o
Please note that these controls only work during animations. They have no effect on still 
images. 

Setting Cloud Speed 

To set cloud speed for 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
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4. Activate either the Stratus or Cumulus cloud type, or both. 
 

 
5. Drag the slider or enter a number in the Speed field. 

 

 

Setting Cloud Turbulence 

To set cloud turbulence for animations: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Activate either the Stratus or Cumulus cloud type, or both. 
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5. Drag the slider or enter a value in the Turbulence field.  
 

 

Setting Direction of Motion 

To set the direction of motion for animations: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Activate either the Stratus or Cumulus cloud type, or both.  

 

 
5. Drag the Cloud motion control to specify the angle of motion. 
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Reset Cloud Speed & Turbulence 

To reset the Cloud Speed & Turbulence to zero for animations: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Click on the large center sphere in the Cloud motion control. Both Speed and 

Turbulence will be set to zero. 
 

 

Setting Cloud Cover 

Cloud Cover controls the quantity of clouds you can see in the sky. A high coverage 
means that there is a very dense cloud layer, and a low setting means that there are 
very few clouds in the sky. 
Cloud cover also indirectly controls the brightness of the environment. The more cloud 
coverage you have in a sky, the darker the environment, since less sunlight can pass 
through the clouds. Adjusting cloud coverage changes the quantity of clouds but not the 
frequency. You can think of it as adjusting the volume on a radio without changing the 
station. 
The Cloud Coverage control in the Sky Lab lets you interactively set the quantity of 
clouds in the sky. 
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For example, you can see how the clouds change in these skies as the cloud coverage 
value changes. 
To set cloud coverage numerically: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Activate either the Stratus or Cumulus cloud type, or both. 

 

 
5. Drag the slider or enter a value in the Cloud Cover field. 

 

 
You can also set Cloud Cover in the Sky & Fog Palette. 
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Setting Cloud Height 

The height of your clouds has an impact on the appearance of your sky. Greater heights 
will result in smaller, more distant cloud formations, as well as a thicker band of haze at 
the horizon. Lower heights result in larger, more languorous cloud formations and a 
thinner band of haze at the horizon. The Cloud Height controls in the Sky & Fog palette 
let you interactively set the height of the cloud layer in the sky. For example, you can 
see how the clouds change in these skies as the cloud altitude value changes from 10% 
to 90%. 
There are two things to remember when working with this control. First, the Cloud 
Height will affect the size of your Haze band, if you have a haze setting greater than 
zero. The higher the altitude, the wider the haze region will be on the horizon. Second, 
remember to lower your altitude setting if you are creating a nighttime scene. Since high 
altitudes increase the size of the horizon Haze region, the sky will be too unnaturally 
bright for realistic night scenes. 
To set cloud height numerically: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Drag the slider or enter a value in the Cloud Height field. 

 

 
You can also set Cloud Height in the Sky & Fog Palette. 
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Setting Frequency & Amplitude 

The Frequency and Amplitude control lets you set the types of cloud formation you'll see 
in your sky. By combining these two controls you can change your clouds from light and 
fluffy to dark and brooding. Use Frequency and Amplitude to control the types of cloud 
formations in your scene. 
This graph shows the effects of different Frequency and Amplitude settings on a sky. 
Frequency values range from 2 at the top to 150 at the bottom. The Amplitude values 
range from 50 at the left to 500 on the right. 
To set Frequency and Amplitude numerically: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Drag the slider or enter a value in the Frequency field. The Frequency field 

controls the frequency (scale) of cloud formations in your scene. 
 

 
5. Drag the slider or enter a value in the Amplitude field. The Amplitude field 

controls the amplitude (edge softness) of clouds in your scene. 
 
Drag right to increase the Amplitude amount, drag left to decrease the amount. 
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You can also set Cloud Frequency & Amplitude in the Sky & Fog Palette. 

 

Cast Shadows 

By default, the Clouds in Bryce do not cast shadows. If you want the cloud layer to cast 
shadows on the ground below, 
enable the Cloud Shadows option. 
To have the clouds cast shadows: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Activate either the Stratus or Cumulus cloud type, or both. 
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5. Enable the Cast Shadows option. 
 

 

Linking Clouds to the Camera 

If you move the camera view during an animation, the clouds in your environment will 
appear to zoom by, creating a kind of time-lapsed effect. If you want the clouds to 
appear fixed as you move the camera, link the cloud in the sky to the camera view. This 
way, wherever the camera moves the clouds will follow so that they seem to remain 
stationary. 
To link clouds to view: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Click the Link Clouds to View button. 

 

 
Refer to "Animating Skies" for more on animating skies. 

Using a Fixed Cloud Plane 

As you move higher up in a Bryce environment, the cloud pattern shifts, so that it 
appears as if you're getting closer to the clouds. If you want to counter this effect, you 
can use the Fix Cloud Plane option to freeze the cloud pattern so that it doesn't change 
as you move higher up. 
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To use a fixed cloud pattern in your sky: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Cloud Cover tab. 
 

 
4. Activate either the Stratus or Cumulus cloud type, or both. 

 

 
5. Enable the Fixed Cloud Plane option. 

 

 

Spherical Clouds 

Selecting Spherical Clouds consolidates high frequency clouds, creating rounder more 
dense clouds. Works for both 
stratus and cumulus. 
To enable Spherical Clouds: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
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2. Click the Sky Lab button. The Sky Lab appears. 
 

 
3. Click the Cloud Cover tab. 

 

 
4. Activate either the Stratus or Cumulus cloud type, or both. 

 

 
5. Enable the Spherical Clouds option. 

 

 
6. Click the OK icon to exit the dialog.  

Examples:  
• Stratus Clouds, Spherical Clouds disabled: 
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• Stratus Clouds, Spherical Clouds enabled: 
 

 
• Cumulus Clouds, Spherical Clouds disabled: 

 

 
• Cumulus Clouds, Spherical Clouds enabled: 
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• Stratus & Cumulus Clouds, Spherical Clouds disabled 
 

 
• Stratus & Cumulus Clouds, Spherical Clouds enabled: 

 

 

Atmosphere Tab 

Environmental effects controls are located on the Atmosphere tab of the Sky Lab dialog. 
The elements in a sky aren’t constant; the sky is always changing, reflecting weather 
patterns or the time of day. If it rains, there’s a rainbow. If it’s night, there are stars. If it’s 
sunset, the sun looks bigger. If you look right at the sun on a hazy day, you’ll see rings 
around it. Sometimes, if it’s hazy enough you can even see the sunlight streaking out of 
the clouds. All these illusions are called environmental effects and the Sky Lab palette 
contains all the controls you’ll need to add them to your scene. 
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Fog 

Fog can add an element of sensuality, mystery, and even realism to your scenes. It acts 
like a thin layer of cloud close to the ground. 
Using Fog you can create the illusion of depth without having to add distant objects. Fog 
can create a sense of depth in your scene. 
In this scene, the fog was used to add depth to the road as it moves away from the 
camera. Notice how the feeling of depth was created without the addition of background 
objects. 

 
You can set intensity, height, and color attributes for the fog. 
The fog acts as a global layer covering the entire scene. Its color and intensity are the 
same throughout the scene. Localized fog can be created by adding a volume cloud 
material to a plane or sphere within the scene. 
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To enable Fog: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Enable the Fog option. 

 

 
5. Adjust the Fog Color, Density, Thickness, and Base Height as needed. 
6. Click the OK icon to exit the dialog. 

Fog Color 

To set Fog color: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
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4. Enable the Fog option. 
 

 
5. Click the color swatch above the Density slider and choose a color from the color 

picker. 
 

 
Refer to "Blend with Sun" for information on blending the fog color with the sun. 
Examples: 

• Fog Color = Peach 
 

 
• Fog Color = Green 
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Fog Density 

Fog Density sets the amount of fog rendered in the image. It works along with Fog 
Thickness to create the fog. Fog Density can be set from 0 to 100% with a default value 
of 0%. 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Enable the Fog option. 

 

 
5. Drag the Density slider or enter a value in the Density field. 
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Examples: 
• Fog Density = 0 

 

 
• Fog Density = 15, Thickness = 5 

 

 
• Fog Density = 25, Thickness = 5 
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• Fog Density = 75, Thickness = 5 
 

 
• Fog Density = 100, Thickness = 5 

 

 

Fog Thickness 

Like Fog Density, Fog Thickness sets the amount of fog rendered in the image. It works 
along with Fog Density to create the fog. Fog Thickness can be set from 0 to 100% with 
a default value of 0%. 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
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4. Enable the Fog option. 
 

 
5. Drag the Thickness slider or enter a value in the Thickness field. 

 

 
Examples: 

• Fog Thickness = 0, Density = 0 
 

 
• Fog Thickness = 5, Density = 5 
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• Fog Thickness = 5, Density = 10 
 

 
• Fog Thickness = 10, Density = 10 

 

 
• Fog Thickness = 15, Density = 10 
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• Fog Thickness = 15, Density = 50 
 

 
• Fog Thickness = 15, Density = 75 

 

 
• Fog Thickness = 15, Density = 100 

 

 

©2007 DAZ 3D, Inc.  848 



Bryce 6 Artist Guide 

Fog Base Height 

Fog Base Height sets the height of the fog in your scene, assuming there is a value 
greater than zero in the field. The range is 0 to 100%, and the default value is 0%. It 
translates the entire atmospheric effect up or down without changing the density or 
thickness, however, the effect is more obvious with changes in thickness in addition to 
the height changes. Base Height provides control over density at low altitudes, such as 
in valleys. In early versions of Bryce, you had to move the entire scene up or down 
relative to the atmosphere. 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Enable the Fog option. 

 

 
5. Drag the Base Height slider or enter a value in the Base Height field. 
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Examples: 
• Fog Density = 5, Thickness = 25, Base Height = 25 

 

 
• Fog Density = 5, Thickness = 45, Base Height = 50 

 

 
• Fog Density = 5, Thickness = 65, Base Height = 75 
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• Fog Density = 5, Thickness = 85, Base Height = 100 
 

 

Haze 

Haze is the natural effect you see when a plane (like the ocean) stretches out towards 
the horizon. At this distant point a different color appears over the horizon and light 
becomes fuzzy. Haze creates the illusion of a distant horizon. In this scene, the haze is 
used to create the distinction between the water plane and the sky. 
The Haze control lets you set the intensity and color of the Haze effect in your Bryce 
scene. 
With haze set to zero, your horizon will have an unnaturally hard edge. Also note that 
the Cloud Altitude control will affect the height of this band of haze. The higher the 
altitude of the atmosphere, the wider the band of haze at the horizon. 
Haze is applied to the entire scene equally. The haze always appears at the horizon. 
To enable Haze: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
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4. Enable the Haze option. 
 

 
5. Adjust the Haze Color, Density, Thickness, and Base Height as needed. 
6. Click the OK icon to exit the dialog. 

Haze Color 

To set Haze Color: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Enable the Haze option. 

 

 
5. Click the color swatch above the Density slider and choose a color from the color 

picker. 
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Refer to "Blend with Sun" for information on blending the haze color with the sun. 
Examples: 

• Haze Color = Yellow 
 

 
• Haze Color = Blue 

 

 

Haze Density 

Haze Density, along with Thickness and Base Height, govern the amount of haze 
rendered into your scene. The range is 0 to 100, and the default value is 4. Density 
controls the density of the lower part of the atmosphere and affects the scattering of 
light around the sun. 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 
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3. Click the Atmosphere tab. 
 

 
4. Enable the Haze option. 

 

 
5. Drag the Density slider or enter a value in the Density field. 

 

 
Examples: 

• Haze Density, Thickness, & Base Height = 25 
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• Haze Density = 50, Thickness & Base Height = 25 
 

 
• Haze Density, Thickness, & Base Height = 50 

 

 
• Haze Density = 75, Thickness & Base Height = 50 
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• Haze Density = 75, Thickness =50, Base Height = 100 
 

 

Haze Thickness 

Haze Density, along with Thickness and Base Height, govern the amount of haze 
rendered into your scene. The range is 0 to 100, and the default value is 4. Thickness 
scales the whole atmosphere up or down, with the density at "sea level" remaining 
unchanged. In earlier versions of Bryce, you had to move the entire scene up or down 
relative to the atmosphere. 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Enable the Haze option. 
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5. Drag the Thickness slider or enter a value in the Thickness field. 
 

 
See "Haze Density" for examples of Haze Thickness used in conjunction with Density 
and Base Height. 

Haze Base Height 

Haze Base Height, along with Density and Thickness, govern the amount of haze 
rendered into your scene. The range is 0 to 100, and the default value is 4. Base Height 
provides control over density at low altitudes, such as in valleys. It translates the entire 
atmospheric effect up or down without changing the density or thickness. In earlier 
versions of Bryce, you had to move the entire scene up or down relative to the 
atmosphere. 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Enable the Haze option. 
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5. Drag the Base Height slider or enter a value in the Base Height field. 
 

 
See "Haze Density" for examples of Haze Base Height used in conjunction with Density 
and Thickness. 

Rainbows 

In the real world rainbows appear after rainstorms as arcs of light displaying all the color 
in the spectrum. In Bryce a rainbow is an atmospheric effect that can be added to any 
sky. A rainbow is only visible if the sun is visible, meaning you can't have a rainbow at 
night. As well, you can add a secondary rainbow to create the illusion of reflection. 
Rainbows are linked to the sun. As the color or intensity of the sun changes, so does 
the rainbow. In addition, the position of the rainbow in the sky is dependent on the 
position of the sun. Rainbows appear to be infinitely distant from the camera. You can't 
approach them by moving the camera, so the pot of gold is always just out of reach. 
To add a rainbow to your sky: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Enable the Rainbows option. 
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5. Drag the s
s

lider or enter a value in Radius field in the Rainbow area. This value 
ets the width of the rainbow and can be set from 0 to 100 with the default value 

of 33.33. 
 

 
6. Drag the slider or enter a value in the Opacity field. This controls the rainbow's 

transparency and can be set from 0 to 100 with the default value of 30. 
 

 
7. If you want to add a secondary rainbow to your sky, enable the Sec

o
ondary Bow 

ption. By default, the Secondary Bow option is enabled when you enable the 
Rainbow option. Disable it to only have one rainbow in the scene. 
 

 
Examples: 

• Radius = 33.33, Opacity = 30 
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• Radius = 45, Opacity = 45 
 

 
• Radius = 75, Opacity = 65 

 

 
• Radius = 100, Opacity = 100 
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• Radius = 45, Opacity = 75, Secondary Bow enabled 
 

 

Blend with Sun 

Since fog remains constant throughout the scene, you may get some odd looking 
results when you're creating a sunset or sunrise. In these cases the sun is very close to 
the ground plane where the fog exists, so the fog should react to the sunlight. The Blend 
with Sun feature lets you create exactly this effect. As the sun approaches the Fog, the 
color and intensity of the fog changes to interact with the color of the sun. 
Since the Haze always appears at the horizon it should change color as the sun sets or 
rises. The Blend with Sun feature lets you simulate this effect. When the two elements 
are linked, the haze color and brightness change depending on the position of the sun. 
This creates very realistic looking sunsets. When you're using this feature to create 
sunsets, you should choose the haze color carefully so as to create a natural-looking 
color scheme. 
To blend the fog and haze with the sun: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
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4. Enable the Blend with Sun option. Blend Haze and Blend Fog will be 
automatically enabled. 
 

 
5. Enter a value in the Color field or drag the slider to set how much of the fog and 

haze color is blended with the sun. 
6. Enter a value in the Luminance field or drag the slider to set the intensity of the 

fog and haze color when it's blended. To get the best effect, set both these fields 
to 100. 

Examples:  
• Blend Color with Sun = 50; Blend Luminance with Sun = 100 

 

 
• Blend Color and Luminance with Sun = 50: 
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• Blend Color and Luminance with Sun = 100 
 

 

Blend Haze 

To link Haze to the Sun controls: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Click the Blend with Haze button. Blend Haze and Blend Fog will be enabled 

automatically. Leave the Blend Fog enabled to increase the haze effect. 
 

 
5. Enter a value in the Color field, or drag the slider, to set how much of the haze 

color is blended with the sun. 
6. Enter a value in the Luminance field, or drag the slider, to set the intensity of the 

haze color when it's blended. To get the best effect, set both these fields to 100. 
7. Enable the Haze option, change the color of the haze if you want (the better to 

see the effect). Enable the Fog option as well if the Blend Fog option was left 
enabled under Blend with Sun. 
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8. Adjust Fog and Haze Density, Thickness, and Base Height as needed. 
9. Click on the OK icon to close the dialog.   

Examples: 
• Blend with Sun disabled: 

 

 
• Blend with Haze enabled: 
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• Blend with Haze enabled, sun lower over horizon: 
 

 

Blend Fog 

To link Fog color to the Sun controls: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Click the Blend with Sun button. Blend Haze and Blend Fog will be enabled 

automatically. Disable Blend Haze if you wish. 
 

 
5. Enter a value in the Color field or drag the slider to set how much of the fog color 

is blended with the sun.  
6. Enter a value in the Luminance field or drag the slider to set the intensity of the 

fog color when it's blended. To get the best effect, set both these fields to 100. 
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7. Enable the Fog option, change the color of the fog if you want (the better to see 
the effect).  
 

 
8. Adjust Fog Density, Thickness, and Base Height as needed. 
9. Click on the OK icon to close the dialog.   

Examples: 
• Blend with Fog disabled:  

 

 
• Blend with Fog enabled:  
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• Blend with Fog enabled, sun higher over horizon:  
 

 

Volumetric World 

The Volumetric World effect simulates the effects of particles in the air being illuminated 
by light sources. In Bryce this effect turns all the light sources in your scene into visible 
light sources. 
Sunlight also becomes visible so that any color you applied to the sun appears 
everywhere in the scene. Visible sunlight is volumetric, meaning that it is affected by all 
the objects within it. 
Although Volumetric World is a very beautiful effect, it's also a time consuming one. It 
will add considerably to your scene's rendering time. 
To add visible sunlight to your scene: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Enable the Volumetric World option. 
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5. Drag the Quality slider or enter a value in the Quality field. Values can be set 
from 0 to 100 with the default value of 50. 
 

 
6. Drag the Density slider or enter a value in the Density field. Higher values result 

in brighter, more visible sunlight. Values can be set from 0 to 100 with the default 
value of 50. 
 

 
7. Click the OK icon to exit the dialog. 

Examples: 
• Volumetric World disabled, Render Time = 0:11 

 

 
• Volumetric World enabled, Density & Quality = 50, Render Time = 3:45 
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• Volumetric World enabled, Density = 100, Quality = 50, Render Time = 3:26 
 

 
• Volumetric World enabled, Density =50, Quality = 100, Render Time = 7:20 

 

 

Color Perspective 

Color perspective is the change in color with distance that characterizes the appearance 
of distant scenes in Nature: Dark areas turn blue and light ones yellow to orange to red. 
In Bryce you can make things change any color you like with distance. Color 
perspective is half of aerial perspective, while the other half is the loss of contrast with 
distance. Color perspective controls the rate at which the red, green, and blue 
components of the atmosphere come in with distance.  
In Nature, the atmosphere is white or a pale shade of gray. The blue component of that 
shade comes in faster than the green, which in turn comes in faster than the red. This is 
because the Earth's atmosphere scatters blue light more efficiently than green, and red 
least efficiently of all. The net result is that as a dark area recedes into the distance, it 
will turn blue before it turns white or pale gray in the far distance. Similarly, white areas 
will turn yellow, then orange, then red with increasing distance. 
The default values of color perspective are very delicate: if you change them, expect 
unpredictable results! 
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To set the color perspective: 
1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 

Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the Atmosphere tab. 
 

 
4. Click the Color Perspective button. 

 

 
5. Drag over the RGB controls or enter a number in the field to control the rate at 

which the red, green, and blue components of the atmosphere come in with 
distance.  
 

 
Examples: 

• Color Perspective Disabled: 
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• RGB = 79 2 30: 
 

  
• RGB = 0 1 88: 

 

  

Image Based Lighting Tab 

Bryce 6 introduces Image-Based Lighting (IBL) which uses an image to light your Bryce 
scene in addition to traditional Bryce lighting. Bryce 6.1 added the Orientation Control, 
Falloff options, Radius slider, and a completely different IBL algorithm.  
Please note that because of the extreme differences between the Bryce 6 and Bryce 6.1 
algorithms, there is no easy conversion method from HDRI scenes created in Bryce 6 to 
the same scene in Bryce 6.1. 
The IBL Tab contains controls for adding an HDRI image, setting the quality and 
intensity, the HDRI Effect, Falloff and Radius, and whether to render the image as the 
scene background or not. 
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Links to sites providing HDRI Maps/Information: 

• HDRI FAQs  
• Wikipedia article - has links to other sites on HDRI, some with maps for download  
• HDRIMaps.com  
• Thread at C4D Cafe with lots of links and text 
• Debevec Light Probes - several free HDRI files that can be used in Bryce 
• {E}-vermotion - free HDRI images - can be converted to the format Bryce needs 

using the free HDRShop program - see tutorials at the end of this section on how 
to convert the images. 

IBL in a Nutshell 

Traditionally, a scene is lit by the sun and/or one or several additional lights. The Light 
Lab lets you configure the properties of those lights. The appearance of materials may 
change dramatically depending on the setup of the lights, their position, color, and 
intensities. 
Image based lighting is a completely different approach to illuminating a scene. Here, a 
radiance picture - a picture with a very high dynamic range - is mapped on the inside of 
an imaginary sphere surrounding the whole "world.". It is a spherical panorama, 360° 
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wide and 180° high, all around the scene, including sky and ground. The bright parts of 
the picture are so bright that they actually radiate light and thus illuminate the scene and 
can even throw shadows. It doesn’t matter whether that sphere is invisible in the render 
or the HDR image is rendered as a backdrop. 
Image based light simulates the physics of light much more accurately than the light 
sources traditionally available in Bryce. When image based light is used exclusively to 
light a scene, the effect of some channels in the Materials Lab change. The Specularity 
channel in particular becomes almost ineffective because specularity is an artificial 
property used to simulate blurry reflection from a light source. In nature, there is no 
specularity as such - what we perceive as a quality of glossiness on a body is in fact a 
blurred, defocused reflection from a bumpy surface that disperses the light reflected on 
it. Consequently, you’ll have to substitute specularity with the Reflection channel. 
Image based light can nicely simulate light with scientifically correct properties but there 
are moments when you want to pursue your own visions and such correctness is not an 
issue for you at all. You need that bright specularity on a body to make a point in your 
artwork and doing it with the Reflection channel might prove a bit of a challenge at 
times. You may have to resort to mixed light. 
Just as a scene lit by no other means than the Bryce sun may give very pleasing 
results, the same is true when using image based light exclusively. However, this 
exclusivity also means limitation. Consider using image based light in conjunction with 
the traditional Bryce light sources. Then you have all the options you need to make your 
work look as extraordinary as you wish. 
If you render the HDRI as background you might be disappointed by its blurriness. It is 
blurred because it is too small. If your document is 800 pixels high and the camera FOV 
set to 30°, you’ll need an Angular Map of 7,700 x 7,700 pixels to get it well focused. 
Even the most state of the art home computers of today will start to labor under this 
load. 

Using IBL 

Bryce 6 introduces Image Based Lighting (IBL) which uses a High Dynamic Range 
Image (HDRI) to light your Bryce scene in addition to traditional Bryce lighting. 
Currently, Bryce will only import .hdr format HDRI images created using a light probe 
(spherical). 
If you try to open a .hdr file in a format that Bryce can't use (non-probe), you will get the 
following error message: 
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Click on OK and load an HDR file compatible with Bryce. 
To use Image Based Lighting: 

1. Display the Sky & Fog palette by clicking the Sky & Fog button at the top of the 
Bryce window.  
 

 
2. Click the Sky Lab button. The Sky Lab appears. 

 
 

3. Click the IBL tab. 
 

 
4. Enable the Use HDRI Image option. 

 

 
 
By default, when you enable the use of an HDRI image, Bryce disables the 
Sunlight and turns off any Atmospherics that were selected, like Fog and Haze. 

5. Click on Edit, the Open dialog comes up. Locate and select a .hdr image, click on 
Open. 
 

 
 
Please note that In the current version, Bryce accepts pictures in a square aspect 
ratio in the radiance .hdr format. It can correctly map "Angular Map" or - as they 
are also called "Light Probe" - projections. 
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The HDRI preview thumbnail will look similar to the following, along with the 
image showing in the Sky preview thumbnail: 
 

 
• The Sky Preview shows the HDRI as seen from the Directors camera 

because it is set to "Render Against Neutral" by default. If set to "Render 
in Scene", it will show the HDRI as seen by the camera selected. 

• The Sky Preview is rendered with only 16 lights and at a higher quality 
setting, things may not appear in the right light. Because of this, the view 
in the Sky Preview may not be exactly the same as the actual scene. 

6. If the HDRI preview thumbnail doesn't show the image, disable the Use HDRI 
Image option, then enable it again. 

7. If the Sky preview thumbnail doesn't show the image, disable the Render HDRI 
Image as Background option, then enable it again. 
 

 
8. To use the IBL but not render the image as the background, disable the Use 

HDRI Image as Background option. 
 

 
9. The Disable Sun Light option will automatically be disabled when an HDRI image 

is loaded, as will Fog and Haze. To use Fog and Haze, click on the Atmosphere 
tab and re-enable the options. Re-enabling Fog and Haze will help add more 
realism to the scene. 

10. Adjust the IBL settings as needed. 
• Orientation Control - Controls the orientation of the HDRI around the X 

and Y-axes. 
• X - degrees of rotation around X axis 
• Y - degrees of rotation around Y axis 
• The "cross" on the Roller Ball indicates where the horizon is on the 

HDRI sphere in the North position. The sun spot indicates the 
center of the light probe. Rotate the Roller Ball to rotate the HDRI 
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around the light probe sphere. Holding down Cmd/Ctrl while 
rotating the ball to constrain the rotation to around the Y-axis only. 
The X and Y values update as the ball is rotated and changing the 
numbers moves the ball to the appropriate orientation. 
 

 
 

 
 

 
• Quality -The number of lights used to render IBL. This control ranges from 

16 to 4096. 
• Intensity - This controls the exposure level of the HDRI. This affects both 

the light emitted from the 
• HDRI for lighting with IBL and the image when rendered in the 

background. Exposure is not linear, rather it is exponential. See this 
website for a better explanation: 
http://freespace.virgin.net/hugo.elias/graphics/x_posure.htm. This control 
ranges from 0 to 100. 

• HDRI Effect - This controls the intensity of lights when using an HDRI for 
IBL. This is just like changing the intensity of any light object in Bryce. This 
will only affect light intensity during IBL. It will NOT affect the look of HDRI 
rendered in the background. This control ranges from 0 to 100. 

• A large HDRI needs considerable computer power and the controls may 
appear to react very sluggishly or not at all. Be patient or use a smaller 
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H
 
Any objects with specularity will need to be modified to use reflection 
instead. Either that or increase the specularity rang

DR image (800 x 800 instead of 1600 x 1600, for example). 

e of the material. Refer 
to "IBL in a Nutshell" for more information on this. 

• Falloff - Determines the type of light falloff to be used.  
• None – light never falls off due to distance (Radius becomes 

 off as a function of distance squared (much 

ar 

the 
e how low it needs to be to get some light with a default 

ryce scene. 
 

irrelevant) - Default 
• Linear – light falls off as a function of distance 
• Squared – light falls

faster than Linear) 
• Radius - This controls the distance of the lights (used for IBL) from the 

center of the Bryce universe. This is only important if falloff is set to Line
or Squared. The radius will have to be quite small if falloff is used at all 
since light falls off rather quickly with both of these formulas. Play with 
control and se
B

 
11. Periodically, exit the Sky Lab and check the scene in the Working window to s

how it looks. It may take sometime to get the right settings for your particular 
s
 
When checking the scene in the Working window, do not rely on the Nano-
Preview for the lighting since it may not accurately preview the IBL-enabled 
image. Instead, re

ee 

cene. Bryce lights can also be used to enhance certain areas of the scene. 

nder the scene, with or without AA, to get a better idea of the 

n in the Render Options dialog may help even up the gamma 
when rendering. 

current settings. 
Something else to be aware of: 

• The Gamma between the Mac and PC differ slightly so sky settings from one 
system may not look the same on the other one. Selecting or deselecting the 
Gamma Correctio
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IBL Examples 

HDRI disabled, Sunlight enabled - base scene 

 
HDRI enabled, Render Image as Background enabled, Sunlight disabled; Render time = 
3:10: 

 
HDRI enabled, Render Image as Background disabled, Sunlight enabled; Render time = 
1:45: 
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Comparison (from Bryce 6.0):  
HDRI Disabled, Simple Black Background sky with sun moved to front; Render time = 
2:00 

 
HDRI Enabled, Render Image as Background enabled, Sunlight disabled; Render time 
= 24:34  

 

Converting HDRIs using HDRShop 

Currently, Bryce only supports Radiance Image Maps. If you try to import an HDR file 
that Bryce doesn't support, it will give you an error message. Some HDR files will give 
an infinite error loop (like those generated from Artizen) and the only way to get out of 
the loop is to close Bryce using the File Manager. 
Fortunately, HDRShop provides a quick way to convert between different HDR file 
types. HDRShop is available in a free version (v1) which can only be used for personal 
use and a commercial version which allows you to create HDR files and use/sell them. 
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To get you started, we'll show you how to convert a cross probe into a mirrored ball 
probe. The same basic procedure is used to convert other types as well. 
First, download the free version of HDRShop if you haven't already. The executable file 
runs the program so there is no need to install it. 
Second, download the HDR file that you want to convert. The one used for this tutorial 
is the Grace cross downloaded from the Debevec website. 

1. Open HDRShop and choose File > Open from the menu. Locate and load the 
HDR file you want to convert.  
 

 
2. Choose Image > Panorama > Panoramic Transformations from the menu. 
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3. In the Panoramic Transform dialog, select the type of HDR file you loaded from 
the first Format field, in this case, a Cubic Environment (Vertical Cross). 
 

 
4. The default Destination Image is New Image while the default Format is Mirrored 

Ball. Do not change these options. Click on OK. 
5. Once the image is converted, check it for seams. The red arrows point to the 

seams in this version.  
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6. To get rid of the seams, HDRShop provides a Gaussian Blur filter. Choose Image 
> Filter > Gaussian Blur from the menu.  
 

 
7. Enter a Blur Width (default is 4) and click on OK. 

 

 
 
If the blur is too much, you'll need to start over as there is no working undo for 
many of the functions. 
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If you would rather correct the seams in your favorite paint program, you can 
save the image in a format the program can open and make the changes there. 

8. To do this, choose File > Save As from the menu and click on the Low Dynamic 
Range button corresponding to the format you want to work with. Name and save 
the file to your computer. 
 

 
9. Open the image in your paint program and use the Smudge Tool to clean up the 

seams. Save the file. 
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10. Reopen the image in HDRShop and choose File > Save As from the menu. Click 

on the Radiance format button. 
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11. Enter the file name, making sure to add the extension of .hdr. 
 

 
12. In Bryce, load the new HDR file in the IBL tab of the Sky Lab. Adjust the IBL 

settings as needed.  
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13. Render your scene. 
 

 

Animating Skies 

All the properties of a Bryce sky can be animated. This means that any attribute you can 
set in the Sky & Fog palette or the Sky Lab dialog can be animated using the Animation 
controls on the Timeline. This section assumes that you're familiar with the concepts 
and procedures involved in creating skies. 
By changing the attributes in the Sky & Fog palette at different points in the timeline, 
you can animate everything from the position of the sun to the color of the clouds. For 
example, you can simulate changes in the time of day by changing the position of the 
sun over time. 
There are several techniques you can use to add motion to your skies. You can animate 
all or some of the properties of your sky. You can activate and deactivate sky effects at 
different points in the animation. You can also animate the position of the sun or moon. 
Sky animations are created using the Animation tools in the Working window and the 
Sky Lab dialog. 

Sun & Moon 

One of the most spectacular effects you can create using the scene's sky is elapsed 
time. In the great outdoors we perceive time in relation to the position of the sun and the 
brightness of the sky. By changing the position of the sun or moon you can simulate 
time passing in terms of days or months. In this example, the passage of time is 
simulated by the change in the sun's position. 
Since all the elements in the sky are linked, the other properties of the sky like Ambient 
Light change as the position of the sun changes, adding to the realism of the effect. 
For the moon, you can also change its phases, so you simulate the passage of an entire 
month just by adjusting the moon attributes. 
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To animate Sun or Moon position: 
1. Click the triangle icon in the Animation controls and make sure Auto-Key is 

enabled.  
2. Move the Current Time Indicator to the point in the Timeline where you want the 

sky to change.  
3. Adjust the position of the sun or moon using the Sun Position control in the Sky & 

Fog palette. 
4. Move the Current Time Indicator to a different point on the timeline. 
5. Change the position of the sun or moon again. 
6. Continue moving the Current Time Indicator and changing the sun or moon 

position until you achieve the desired effect.  

Clouds 

You can create the effect of wind in your environment by setting up cloud motion 
parameters. Based on your settings, 
Bryce automatically moves the clouds in your environment to create motion. 
Cloud motion parameters are set in the Sky Lab dialog. The Cloud Direction control lets 
you set the direction for cloud motion, while the other controls set the speed and 
distortion of the clouds. 
To animate clouds: 

1. Click the triangle icon in the Animation controls and make sure Auto-Key is 
enabled.  

2. In Sky & Fog palette, click the Sky Lab button. The Sky Lab dialog appears. 
3. Click the Cloud Cover tab. 
4. Move the direction indicator in the Cloud Motion controls to set a direction for the 

clouds as they move in the animation. 
5. Adjust the speed control to set how fast the clouds move. You can also enter a 

speed value. 
6. Adjust the Turbulence control to set how much the clouds will distort as they 

move. You can also enter a turbulence value. 

Sky & Fog Settings 

Animating Sky & Fog settings changes the properties of a sky over time. For example a 
scene can become cloudier, or darker during an animation. The intensity of the change 
depends on how many properties you adjust and the amount of each adjustment. In this 
example, the animation of approaching storm clouds was created by changing the 
Cloud Frequency and Amplitude value and the Cloud Color at different points in the 
Timeline. 
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Most Sky & Fog properties can be changed using the thumbnail controls. Other settings 
are available in the Sky Lab dialog. 
You won't be able to see the effects of a sky animation until you render the entire 
animation. 
To animate Sky & Fog settings: 

1. Click the triangle icon in the Animation controls and make sure Auto-Key is 
enabled.  

2. Move the Current Time Indicator to the point in the Timeline where you want the 
sky to change.  

3. Adjust the sky's properties using the Sky & Fog palette controls.  
4. Move the Current Time Indicator to a different point on the Timeline. 
5. Change the properties of the sky again. 
6. Continue moving the Current Time Indicator and changing the sky's properties 

until you achieve the desired effect. 

Environmental Effects 

Many environmental effects like rainbows and fog are not permanent features of a sky. 
They appear for a brief time and then fade way. You can simulate this action by 
changing the properties of the environmental effects at different points along the 
Timeline. 
Environmental effects controls are located on the Atmosphere tab of the Sky Lab dialog. 
You can also animate the various settings for an effect. For example, the radius of 
moon rings can increase or decrease during the course of your animation. 
To animate environmental effects: 

1. Click the triangle icon in the Animation controls and make sure Auto-Key is 
enabled.  

2. Move the Current Time Indicator to the point in the Timeline where you want the 
sky to change.  

3. Display the Sky Lab dialog: Atmosphere tab and change the properties of an 
effect.  

4. Move the Current Time Indicator to a different point on the Timeline. 
5. Change the properties of the effect again. 
6. Continue moving the Current Time Indicator and changing the effect's properties 

until you have the desired effect. 
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Terrain Editor 
The Terrain Editor can be used to generate a grayscale image that is converted into a 
terrain object. It can also be used to edit an existing terrain. 
Creating terrains in the Terrain Editor is a two-step process. First, generate the source 
of your terrain image by using the preset effects, painting an image using the 
paintbrush, or importing a picture. Then, use the Terrain Editor's filtering tools to fine-
tune the grayscale values in your terrain. 
To access the Terrain Editor, you must have a terrain object in your scene. When the 
Terrain Editor opens, it temporarily replaces the screen and displays the current terrain 
in a two-dimensional preview and a three dimensional preview. The height map that 
was used to create the terrain is displayed in the Terrain Canvas. 
You can also animate the creation of a terrain. Using the Animation controls available at 
the bottom of the editor, you can change the shape of your terrain object over time. 

A Quick Tour of the TE 

The Terrain Editor is divided into five sections: 
• Terrain Canvas: displays the grayscale image used as a height map 

• Terrain Canvas Tools: contains a Gradient Strip and Bracket for clipping 
operations, and controls for Color Mapping 

• Terrain Canvas Options: contains options for setting the preview size and 
exporting the image and terrain mesh 

• 3D Preview: displays a three-dimensional preview of the terrain you're working 
on 

• Paintbrush Controls: let you adjust the paintbrush 
• Editing Tools: let you generate and edit the terrain's height map  
• Animation Controls: let you set up key frames for animating the terrain 
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Accessing the TE 

To open the Terrain Editor: 
Select a terrain object in your scene and do one of the following: 

1. Click the  button that appears next to the terrain object.  
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2. Choose Objects > Edit Object. 
 

 
3. Click the Edit button to open the Edit palette, and then click the Edit Terrain tool. 

 

 
4. Press Cmd/Ctrl+E. 

Terrain Canvas 

The Terrain Canvas displays the grayscale image that is used to create the terrain 
object. You can think of the Terrain Canvas as a top view of the terrain object you're 
creating. The Terrain Canvas is where you paint the height map for your terrain. 
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You can also access a number of tools in the Terrain Canvas, including the Gradient 
Strip, the Clipping Bracket, controls for Color Mapping, the Zoom Area control, and the 
Brush Mode selector. 

Terrain Canvas Tools 

To access a Terrain Canvas Tool on the Terrain Canvas, click the menu icon at the top 
right of the Terrain Canvas. 

 
The Terrain Canvas Tool area will open up. 
The right side of the Terrain Canvas tool area contains a Gradient Strip and Bracket for 
clipping operations. In the bottom right corner, you will find controls for Color Mapping.  
Refer to "Adding Color to Terrains" and "Clipping Terrains" for more on these tools. 
Across the bottom of the Terrain Canvas tool area, you will find a Brush Mode selector 
and the Zoom Area controls.  
Refer to "Brush Behavior" and "Using the Zoom Area" for more on these tools. 
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Clipping Terrains 

Using the Terrain Editor's Clipping Controls, you determine which values in your terrain 
are rendered as the final terrain object. The Clipping Controls next to the Gradient Bar 
represent the render range for the terrain. Anything outside the range included in the 
brackets will not be rendered. 
You can use these controls to eliminate unwanted information from the terrain without 
altering its basic shape. For example, you can keep the main terrain while eliminating 
the black square on which it sits to create islands. 

 
The clipping feature is particularly useful when editing a Symmetrical Lattice. The 
maximum lower range of the Clipping Bracket determines where the two halves of the 
Symmetrical Lattices are joined. The higher the clipping bracket, the smoother the 
seam. 

©2007 DAZ 3D, Inc.  893 



Bryce 6 Artist Guide 

 

Setting the Clipping Range 

To set the clipping range: 
1. Drag the top of the Clipping Bracket to set the maximum upper range. Any areas 

in the Terrain Canvas whose gray levels fall outside the bracket's maximum 
upper range will appear colored to indicate they will be omitted from rendering. 
 

 
2. Drag the bottom of the Clipping Bracket to set the maximum lower range. Any 

areas in the Terrain Canvas whose gray levels fall outside the bracket's 
maximum lower range will also appear colored to indicate they will be omitted 
from rendering. 
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The out-of-range colors for upper and lower limits are different, to better enable 
you to distinguish upper and lower clipped areas at a glance. Upper out-of-range 
color is usually yellow and lower out-of-range is usually red, though the colors 
change for many of the color maps. 

Setting Terrain Solid 

Terrain objects are hollow, so if you clip the upper range off your terrain, you'll be able 
to see through the top of the terrain to whatever is underneath. This is good for crater 
lakes but not good for a desert plateau. 
To make the top solid, you should select Solid from the drop-down menu at the top right 
of the Terrain Canvas. 
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Reset or Move the Clipping Bracket 

To reset the Clipping Bracket. hold down Opt/Alt and click the bracket. 
To move the entire Clipping Bracket at once, click the center of the Clipping Bracket and 
drag up or down.  
If the Clipping Bracket has not been shortened, then it won't move, you'll need to drag 
the bracket up or down and then move the entire bracket. 
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Adding Color to Terrains 

Color in the Terrain Editor is used as a visual aid to help you see the relationship 
between color values and altitude.  
This color only exists in the Terrain Editor and is not applied to the terrain object. 
When you apply color in the editor, it maps a Gradient to the altitudes in your Terrain 
Canvas. For example, if you apply a gradient from blue to yellow, blue might represent 
the lowest altitude while yellow may represent the highest. Which colors are mapped to 
which altitudes is left completely up to you.  
Gradients can be extremely useful when you're filtering terrains, as they emphasize the 
differences between gray levels. 

Mapping Color to Terrains 

The Terrain Editor's color picker contains all the gradients you can apply to your terrain. 
The gradient you select is applied to both the Terrain Canvas and the 3D Preview. 
Use the Color Picker button to choose a Color Gradient and the Gradient Bar to set 
Color Mapping.  
To map colors to your Terrain Canvas: 

1. Left-click hold on the Color Picker button in the bottom right corner of the Terrain 
Canvas Frame. 
 

 
 
and drag over a gradient in the palette. As you drag over the Gradient Bars, the 
current bar is highlighted with a white border. 
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The gradient you select appears in the Gradient Bar and is mapped to the 
Terrain Canvas and the 3D Preview.  
 

 
2. Drag the Gradient up or down to map the colors to altitudes. The colors at the 

bottom of the gradient represent the lowest altitude and those at the top 
represent the highest. 
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3. To return to grayscale, click the Color/Grayscale toggle to switch back to the 
default gray gradient. 
 

 

Applying Gradient to Diffuse Channel 

Although gradients are meant to be used only in the Terrain Editor, you can apply the 
gradient to the terrain's Diffuse channel. The gradient then becomes the terrain's Diffuse 
color. This allows you to render the gradient with the terrain. 
To add a gradient to a terrain's Diffuse channel: 

1. Apply a gradient to the terrain in the Terrain Editor. 
2. Select Keep Gradient from the drop-down menu at the top right of the Terrain 

Canvas. 
 

 
3. Exit the Terrain Editor and go into the Materials Lab.  

 
Terrains are created with a random material applied and in order to get the 
gradient to render on the terrain, the material has to be removed from the Diffuse 
channel.  

4. Remove any dot (or dots) from the Diffuse channel(s). You don't have to remove 
the other dots unless you don't want the original texture applied to those 
channels. 
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5. Exit the Materials Lab and render. The gradient will render on the terrain. 

 

 
Some items to note about applying Terrain Editor gradients to the diffuse channel: 

1. The original diffuse color will show in the color dot, not the gradient.  
2. Once applied, the gradients can be added to the Materials Library and applied to 

other terrains - Macs only. (PCs - Issue) 

Removing Gradient 

To remove a gradient from a terrain's Diffuse channel: 
1. Open the terrain in the Terrain Editor. 
2. Click the Color/Grayscale toggle. 
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Gradient Bar Modifiers 

The Gradient Bar has two modifiers:   
1. Opt/Alt+Click Gradient Bar resets the Gradient Bar.  
2. Cmd/Ctrl+F flips the colors in the gradient. 

 

  

Using the Zoom Area 

When the Zoom Area is active, only a small portion of your terrain is displayed in the 3D 
Preview. The 3D Preview displays the zoomed-in portion of your Terrain Canvas. You 
can use this feature to see small variations in the surface of your terrain. The Zoom 
Area can be moved to any point on your Terrain Canvas. You can always paint while 
the Zoom Area is active; in fact this is a nice way to paint in the Terrain Canvas while 
previewing a small section in the 3D Preview to observe details. 
To turn the Zoom Area on or off, click the Zoom Area button in the Terrain Canvas tool 
area.  

 
 
The Zoom Area button will change to white and toggles a marquee on your Terrain 
Canvas. 
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The area within the marquee will be displayed in the 3D Preview. 
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Moving Zoom Area 

To move the Zoom Area: 
1. Move your pointer over an edge of the Zoom Area marquee. The pointer 

changes to a hand tool. 
 

 
2. Drag the marquee to a different area in the Terrain Canvas. 

 

 

Resizing Zoom Area 

To resize the Zoom Area: 
1. Move the pointer over a corner of the Zoom Area marquee. The pointer changes 

to an arrowhead cursor. 
 

 
2. Drag away from the center of the marquee to enlarge the Zoom Area or towards 

the center to shrink the area.  

©2007 DAZ 3D, Inc.  903 



Bryce 6 Artist Guide 

 

 

Scale Zoom Area to Fill Canvas 

To scale the Zoom Area to fill the Terrain Canvas, 
1. Activate the Zoom Area and move/resize it to where you want it on the Terrain 

Canvas. 
 

 
2. Click the Crop button below the Zoom Area button in the Terrain Canvas tool 

area.  
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3. The contents of your Zoom Area are scaled to fill the entire Terrain Canvas area. 
The Zoom Area contents replace the existing contents of the Terrain Canvas. 
This feature can be useful for creating new terrains from larger high-resolution 
terrains. 
 

 
4. Deactivate the Zoom Area tool so you can work on the new terrain. 

Scale Terrain to Zoom Area 

To fit the contents of the Terrain Canvas into the Zoom Area: 
1. Activate the Zoom Area and move/resize it to where you want it on the Terrain 

Canvas. 
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2. Click the Fit text button below the Zoom Area button in the Terrain Canvas tool 

area. 
 

 
 
The entire contents of your Terrain Canvas are scaled down to fit into the Zoom 
Area marquee. The rest of the Terrain Canvas is filled with black. 
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The resulting terrain will be shown in the 3D Preview: 
 

 

Brush Behavior 

The Paintbrush in the Terrain Editor paints elevations by default, but this is not the only 
way of painting using the brush. You can also set the brush to paint effects. This lets 
you apply elevation effects locally, or to increase/decrease existing gray levels in your 
Terrain Canvas. 
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The Brush Behaviors are located at the bottom left of the Terrain Canvas Tool. The 
Brush Behaviors are discussed a bit further down in the "Paintbrush Controls" section. 

 

Terrain Canvas Options 

To set the Terrain Canvas options: 
1. Click the triangle icon in the top right corner of the Terrain Canvas.  

 

 
2. Choose an option from the menu. Click on the topic links below for more on using 

each option. 
 

 

Set Preview Size 

Set Preview Size: lets you change the size of the Terrain Canvas frame. You can 
choose from six preview sizes. 
Changing the preview size allows you to work on the terrain in a variety of sizes. Just 
remember that as the canvas increases, so does the brush size so adjust the size of the 
brush before you start painting on a larger or smaller canvas. 
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To set the canvas preview size: 
1. Click the triangle icon in the top right corner of the Terrain Canvas.  

 

 
2. Choose the Set Preview Size option from the menu, following the arrow to 

access the sub-menu where you can choose a size option. 
 

 
Examples (size relative to a 1024x1280 monitor): 

• 384x384 
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• 512x512 
 

 
• 960x960 

 

 

Visible Brush 

Visible Brush lets you turn the circle of the brush on and off. Sometimes the circle can 
get more in the way than a help but turning off the brush circles does not change the 
actual brush size, so remember that as you work. 
By default, the brush circle is set to visible. 
To turn off the brush circle: 

1. Click the triangle icon in the top right corner of the Terrain Canvas.  
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2. Select the Visible Brush option from the menu to deselect it. 
 

 
 
The brush circle will disappear leaving only the cursor cross visible.  
 

 
3. Select Visible Brush again to turn the brush circle back on. 

 

 

Solid 

Solid sets the terrain to a solid object instead of the default hollow setting. This is useful 
for plateaus and other terrain objects that you don't want to be hollow. See "Setting 
Terrain Solid" for help on using this option along with the Clipping Bracket. 
To set a terrain to solid: 

1. Click the triangle icon in the top right corner of the Terrain Canvas.  
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2. Choose the Solid option from the menu. 
 

 

Smooth 

Smooth allows a smooth rendering of the terrain. If this is not selected, the terrain is 
faceted, which may help create a more detailed terrain if needed. 
By default, Smooth is selected. 
To turn off the terrain smoothing: 

1. Click the triangle icon in the top right corner of the Terrain Canvas.  
 

 
2. Choose the Smooth option from the menu. 
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The following images show the difference between a smoothed (left) and unsmoothed 
(right) terrain: 

  

Keep Gradient 

Keep Gradient sets the current applied gradient to be the terrain's diffuse color. This 
also allows the gradient to remain selected when you exit, then re-enter the Terrain 
Editor.  
Refer to "Applying Gradient to Diffuse Channel" for more information on using this 
feature. 
To enable the gradient as the diffuse color: 

1. Apply a gradient to the Terrain Canvas.  
2. Click the triangle icon in the top right corner of the Terrain Canvas.  

 

 
3. Choose the Keep Gradient option from the menu. 
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Exporting the Terrain 

Terrain objects in Bryce can be exported and used in other programs. The next few 
pages will provide details on exporting terrains along with images and detailed 
descriptions of the different features of the Export Terrain Lab. 
To export a terrain: 

1. Click the triangle icon in the top right corner of the Terrain Canvas.  
 

 
2. Choose the Export option from the menu. 

 

 
 
The Save As dialog will come up. 

3. Select a file type from the Save as type menu. Selecting the OBJ format will 
export an material file (MTL) with the textures linked to the terrain. This allows 
you to import the OBJ file into another program without having to manually locate 
and apply the textures. 
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4. Change the File name and click on Save. 

 

 
 
The Export Terrain Lab will come up. The "Features of the Export Terrain Lab" 
will explain the different features of the lab so you can decide which options to 
use when exporting your terrain. 

Export Terrain Lab 

The Export Terrain Lab allows you to convert Bryce terrains into polygonal meshes. The 
Lab provides you with full control over the level of detail in the polygonal mesh. You can 
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adjust the number of polygons with real-time feedback so you can instantly see the 
resulting change to your mesh. In addition, the Lab allows you to manage the all-
important texture maps so that your exported meshes retain the cool look as generated 
within Bryce. 
To export a terrain: 

1. Create a terrain and apply materials.  
2. Either select the terrain and go to File > Export Object or enter the Terrain Editor 

and click Export or press Ctrl+D (PC only).  
3. Choose the desired file format and target folder. 

 
Please note that four of the file formats do not export via the Export Terrain Lab, 
they export immediately once you click on Save: RGM, Rayshade, DEM, and 
Videoscape. 

4. Adjust the complexity of the mesh.  
5. Select material properties to be exported as image maps. 
6. Select image map size.  
7. Click the OK icon to cause the tessellated mesh to be written to the exported file. 

Features of the Export Terrain Lab 

The Export Terrain Lab is divided into two areas:  
• The Polygonal Mesh Previewer with Polygon Count Slider  
• The Image Map Controls 
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Mesh Previewer Inspection 

The Mesh Previewer allows you to instantly examine the quality of the current 
tessellation by rotating the mesh, zooming in and out, and changing the display mode. 

• To rotate the mesh, click and drag in the previewer. 
 

 
• To move the terrain in the preview window, press Spacebar+drag in the 

previewer. 
 

 
• To zoom the mesh in and out, press Cmd/Ctl+click and drag forward to zoom in, 

back to zoom out. 
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• To adjust the contrast of the mesh color, press Cmd/Ctrl+Opt/Alt+drag left to 
increase the contrast, drag right to decrease the contrast.  
 

 
• To adjust the lighting in the previewer, press Cmd/Ctrl+Shift+drag left to 

decrease the brightness, drag right to increase the brightness. 
 

 

Previewer Display Modes 

To change the Previewer Display Mode, select one of the buttons to the right of the 
previewer. 
Available preview modes are: Wireframe, Shaded, Textured, and Textured With 
Wireframe Overlay. 
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Examples of the Preview Modes are shown below.  
• Wireframe:  

 

 
• Shaded:  

 

 
• Textured:  
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Depending on the terrain size and material complexity, creating the preview 
maps can take a few seconds to several minutes.  

• Textured with Wireframe Overlay: 
 

 
 
Wireframe Overlay can be used with either the Shaded or Textured preview. To 
turn off the wireframe overlay, click on the button again. 

Previewer Color Options 

The Color Swatches under the preview buttons adjust the color of the previewer 
background, the wireframe and shaded color, and the wireframe color for the wireframe 
overlay. 

 
Examples of the Color Adjustments are shown below. 
To adjust the colors of the preview background, wireframe, and the shaded preview, 
select the color swatches underneath the preview mode buttons. 

• Background Color - The top color swatch adjusts the color of the previewer 
background. Left-click-hold on the color swatch and select a color from the color 
picker. Note that the color swatch shows the original color on the left side and the 
new color on the right side. If you decide to revert back to the original color, move 
the eyedropper over the left side of the swatch.  
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Please note that you will only get the default color picker here. Wireframe and 
Shaded Color - The middle color swatch adjusts the color of the wireframe and 
the shaded preview. 

• Wireframe Preview Color - When in Wireframe preview, the middle color adjusts 
the wireframe color. 
 

 
• Shaded Preview - The same color swatch adjusts the color of the shaded 

preview. 
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• Wireframe Overlay Color - The last color swatch adjusts the color of the 
wireframe when used as an overlay. 

• Shaded Preview with Wireframe Overlay - The simplest wireframe overlay is 
used over the shaded preview. In the image below, you can see the default terra 
cotta shaded mesh overlaid with the dark grey wireframe color. 
 

 
• Textured Preview with Wireframe Overlay - When in textured preview mode, the 

wireframe overlay is shown over the applied texture. The texture applied to the 
mesh will determine the color of the wireframe, so take a few moments to find the 
best overlay color. 
 

 

Adjust Triangulation 

Webster's Dictionary defines tessellation as: 
1 a: mosaic b: a covering of an infinite geometric plane without gaps or overlaps by 
congruent plane figures of one type or a few types 
2: an act of tessellating : the state of being tessellated 
Any shape can be used to create a tessellation, a triangle, square, hexagon, octagon, or 
a non-geometric shape (think Escher). Bryce uses triangles so "triangulation" and 
"tessellation" can be used interchangeably within Bryce. 
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You can create two types of tessellations in the Export Terrain Lab: Grid and Adaptive. 
Grid tessellates the original height field with a grid. In order to achieve a good mesh 
representation of the source terrain, selecting Grid requires a large number of polygons. 
This method is suitable for geometric shapes.   
Adaptive achieves much lower polygon counts with good representation of the terrain. 
This is an excellent choice when the terrain models natural landscapes. The default 
triangulation method is Grid Triangulation. The initial tessellation is set to 7,938 
polygons for the default terrain resolution (512). The default number of polygons and the 
range of polygons differs depending on the terrain resolution. For Adaptive, the 
allowable range of polygons is shown on the far left and right of the polygon slider. 
To switch between Grid and Adaptive tessellations, click on the triangle to the left of the 
previewer and select the tessellation type. 

 
You will get a Tessellating Progress dialog as the mesh is converted: 

 
When using Adaptive Triangulation, you can effectively double the number of polygons 
by selecting Add Polygons in the drop down menu at the right bottom corner of the 
previewer. 

 
To adjust the polygon count, move the slider below the previewer. This changes the 
quality of your mesh. The number of polygons in the mesh is displayed in the right 
bottom corner of the previewer. Please note that the plus and minus symbols are not 
active and cannot be used to adjust the polygon count. 
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Tessellation Examples 

Examples of Grid and Adaptive Triangulation:  
• Default Terrain, Grid Triangulation, 7938 Polygons: 

 

 
• Number of polygons increased to 9248: 
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• Changed to Adaptive Triangulation reduces polygon count to 840: 
 

 
• Selecting Add Polygons increases count to 1654: 
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• Selecting Add Polygons again increases the count to 3282: 
 

 
• And decreased to 648 polygons: 

 

 

Shaded Tessellation Examples 

Below are examples of different levels of triangulation for both Grid and Adaptive on a 
default terrain (512).  
A quick way to view the results of increasing or decreasing the polygon count is to drag 
the slider left and right. You'll get a quick "animation" of the terrain as it is modified. 
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Grid: 

 
Adaptive: 

 

©2007 DAZ 3D, Inc.  927 



Bryce 6 Artist Guide 

 

 

Handling Image Maps 

The second area of the Export Terrain Lab deals exclusively with handling image maps. 
A large part of the appeal of Bryce terrains are Bryce materials, which consist of 
different significant properties. Each of these properties can be exported, along with 
their geometry, through the Export Terrain Lab. 
The image map controls let you refine which of the material properties you wish to 
export by selecting out of the list of ten. By default any material properties of the terrain 
that use image maps will be exported. The image below shows the image map controls 
with the Diffusion Color, Ambient, Color, Diffusion, and Bump selected. If we go back 
into the Materials Editor, we'd see that the material is applied to these four channels. 
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Depending on the selected export file format, the image maps will be embedded within 
the export file. If, however, the export file format does not support embedding of image 
maps, they will be saved as separate image files in the same folder as the export file 
(such as an MTL file for OBJs). The filename of each separated image will be the name 
of the export file appended with the name of the appropriate material property. 
Next steps: 

1. Add or remove channels - In our example, there is only one material applied to 
four channels. If the program you will be importing the terrain into doesn't need 
some of the channels, click on the orange dot to deselect the channel you don't 
need. In most cases, the Diffusion Color and Bump are sufficient. In the image 
below, the Ambient Color and Diffusion have been deselected but notice that 
they are still white. This means that if you change your mind, you can reselect 
them. The greyed out items cannot be selected for this terrain since the Bryce 
material applied isn't applied to those channels.  
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What About Clip? 

2. Select an image size/resolution from the Size menu. The default is 512x512.  
 
Next, select what format to export the image as from the Format menu. The 
default is bitmap (BMP) but you can also select from JPEG, Mac PICT, 
Photoshop, and TIF formats 
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3. The final step is to save the terrain and the image maps, so click on the OK icon 
(or click on the Cancel icon to cancel the export). Bryce will save the mesh and 
images to your selected storage directory. 
 

 

What About Clip? 

Good question. Clip was originally meant to be used for specific CAD output formats, 
unfortunately, the knowledge of how to use this option has been lost to time. 

Exporting to MetaStream 

MetaStream is format developed by MetaCreations allowing users to view objects in a 
browser and rotate the object within the viewer. 
When exporting to MetaStream, you can select additional options: Clamp Minimum and 
Clamp Maximum.  
These options define the lowest and highest polygon counts within the multi-resolution 
mesh. 
To export as MetaStream and apply the Clamps: 

1. Click the triangle icon in the top right corner of the Terrain Canvas.  
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2. Choose the Export option from the menu. 
 

 
 
The Save As dialog will come up. 

3. Select the MetaStream file type from the Save as type menu. 
 

 
4. Use the slider to set the desired lower polygon count. 
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5. Select Clamp Minimum from the options menu. 
 

 
6. Use the slider to set the desired higher polygon count.   
7. Select Clamp Maximum from the options menu. 

 

 
8. Click on the OK icon to accept the changes and export the MetaStream file. 
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If Clamp Minimum 
file will contain a sin

and Clamp Maximum are set to the same amount, the MetaStream 
gle resolution. 

Export Image 

s a new feature in Bryce 6 and lets you export the terrain grayscale 

To reset the Clamp Minimum and Clamp Maximum, select Reset Clamps within the 
Options menu. 

Export Image i
image for use in other programs.  
Refer to "Exporting 8-bit and 16-bit Pictures" for more on using this option. 

3D Preview 

The 3D Preview displays a terrain object based on the image in the Terrain Canvas. As 
you edit the terrain image, the preview updates to show the result of your changes.  
The preview of your terrain can be rotated so that you can see your terrain object from 
different angles.  

3D Preview Options 

The 3D Preview has several options that control how the preview updates and displays.  
To set 3D Preview options, click the triangle icon in the top right corner of the 3D 
Preview and choose an option from the menu. 
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Set Preview Size 

Set Preview Size lets you change the size of the 3D Preview frame. You can choose 
from four preview sizes although the default size is 256x192 

 

Flat Preview 

Flat Preview is the default preview type. In Flat Preview, you see a basic rendered 
preview of the terrain using a plain grayscale material with basic shading and lighting. 
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Rendered Preview 

als Rendered Preview displays a fully rendered view of the terrain, including any materi
you have applied. 

 

Auto Rotate 

Auto Rotate sets the 3D Preview to rotate when it is in Flat Preview mode. The 3D 
Preview updates as it turns. To stop the Auto Rotate, deselect Auto Rotate from the 
menu. 

 
If Rendered Preview is selected, the Auto Rotate will not go into effect until you select 
Flat Preview. 
To rotate the preview manually, see "Manual Rotation." 
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Realtime Linking 

Real-time Linking connects all terrain
make is applied simultaneously to th

 editing to the 3D Preview. Every change you 
e Terrain Canvas and the 3D Preview. 

 let up on the mouse. 
When this option is not active, any updates you make to the terrain aren't shown in the 
3D Preview window until after you

 

Rip to Screen 

Rip To Screen displays a full-screen preview of your terrain. 

 
Clicking anywhere on the screen will return you to the main Terrain Editor.  
Use Cmd/Ctrl+W to toggle in and out of this mode.  
The 3D Preview size will affect the size of the terrain when ripped to screen. 
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Please note that if you rip the 3d preview to screen then change to a different program, 
you will not be able to return to Bryce without manually shutting down the program and 
reopening it. Remember to click on the screen to reset the preview before changing to 

Manual Rotation & Zooming 

In addition to using the Auto-Rotate in the 3D Preview window, you can also rotate and 
zoom the 3D preview manually.  

• To rotate the preview, left-click in the preview window and drag the mouse up, 
down, left, and right.  

• To rotate the preview in a continuous circular rotation, press Shift then left-click 
hold in the preview window.  

• Drag left slightly to rotate the preview to the left, drag right slightly to rotate the 
preview to the right. 

• To rotate the preview in small increments, left-click-drag in short motions in the 
preview window. This rotates the preview in short jerky motions. To smooth it out, 
press Shift while dragging in short motions in the preview window.   

• To zoom the preview in and out, press Ctrl+drag forward and back. 
• To reset the zoomed preview, press Alt+click in the preview window. Please note 

that if you rotated the preview prior to zooming, this will only reset it to the default 
size, not the default rotation.  

Paintbrush Controls 

Although you can create some very spectacular terrains using just the elevation tools, 
there are times when you want to create a precise Terrain Canvas. The Terrain Editor's 
Paintbrush lets you paint any type of terrain you wish. Using the Paintbrush, you can 
recreate real-world topographical maps or design landscapes with specific contours. 

another program. 
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The Paintbrush Control
Paintbrush, as well as c

s let you select the size, hardness, flow, and level of the 
ontrol the resolution of the grayscale data. 

 

Preset Brushes 

Preset Brushes 
The Brush Presets Library is new in Bryce 6 and is accessed from within the Terrain 
Editor. The brushes allow you to add frequently used shapes or special brushes to be 
used to paint terrains.  
To access the Brush Library, left-click on the Brush Control. 

 
See "Libraries" for information on importing, exporting, and deleting brush presets. 
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Adding a New Brush 

To add a brush preset to the Brush Presets Library: 
1. In your paint program, create a new square image (i.e., 256x256, 512x512, etc.) 

with a black background. You can build a brush in color, but it will be converted 
to grayscale when imported into the Brush Library. 
 

 
2. Select a brush preset from the program or create your own image. The brush 

color should be set to white or a light gray. 
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3. Save the image in one of the following formats:  .SGI .BMP .DIB .EMF .FPI .FPX 

.GIF .JP2 .JPE .JPG .MAC .PCT .PSD .PIC .PNG .PNT .TIF 
4. In Bryce, create a new terrain or symlat. 
5. Click on the  button next to the selected terrain to enter the Terrain Editor. 
6. Click on New to load a new terrain. 
7. In the Brush Control Tools, click on the Brush Tool. 
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The Brushes Library will open up. 
 

 
8. Click on Add at the bottom of the library.  

 

 
9. The Open File dialog will come up. Locate your brush image, select it, and click 

on Open. 
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The brush will be imported into the library, ready to use. 
 

 

Using the Preset Brushes  

To use a preset brush: 
In Bryce, create a new terrain or symlat. 
Click on the 

1. 
2.  button next to the selected terrain to enter the Terrain Editor. 
3. 
4. ush Tool. The Brushes Library will open up. 

Click on New to load a new terrain.  
In the Brush Tools, click on the Br
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5. Select the brush you want to use and click on the OK icon to close the library.  
 

 
6. In the Terrain Editor, adjust the brush size and flow as needed. 

 

 
7. Paint on the terrain or use the brush as a stamp to stamp the design on the 

terrain.  
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Reverting to Default Brush 

To revert to the default brush: 
1. In the Brush Control Tools, click on the Brush Tool. The Brushes Library will 

open up. 
 

 
2. Select the Default Brush and click on the OK icon. The brush will revert to the 

default paintbrush. 
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Size 

The Paintbrush Size Control lets you select the size of the Paintbrush. 
To change the Paintbrush size, drag left or right over the Paintbrush size control. 
Dragging towards the center decreases the Paintbrush size while dragging away from 
the center increases the Paintbrush size. 

 
This control is hard to adjust precisely so take your time increasing and decreasing the 
brush size until you get the size you need. 
Examples: 
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Hardness 

The Paintbrush Hardness Control lets you choose how hard to make the edges of
Paintbrush. A hard Paintbrush has sharp edges and will create a very vertical effec
such as a cliff edge. A soft Paintbrush has feathered edges and will blend more with the 
existing terrain, providing a more gently sloping effect. 

 the 
t 

 To change the paintbrush hardness, drag left or right over the Paintbrush Hardness
Control. Dragging towards the center increases the hardness of the Paintbrush, while 
dragging away from the center makes the Paintbrush softer. 

  
Examples: 
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Flow 

The Paintbrush Flow Control lets you set the density of the grayscale value being 
applied by the Paintbrush. 
To change the Paintbrush Flow, drag left or right over the Paintbrush Flow Control. 
Dragging left decreases the flow, while dragging right increases the flow. 

  
Examples: 
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Level 

The Paintbrush Level Control lets you set t
values produce lower 

he grayscale value of the Paintbrush. Darker 
terrain while lighter values produce higher terrains. To change the 

intbrush Level Control. A small red dot in 
trol indicates the current level. 

Paintbrush Level, drag up or down over the Pa
the middle of the con

   
Examples: 
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Grid Selector 

The Grid Selector controls the resolution of the grayscale data in the terrain. The 
terrain's resolution determines the amount of detail in your terrain. The higher the 

re memory. 
r terrains that are very close to your 

camera or where detail is important. For terrains that are far away, or where detail is not 
so important, lower resolutions are more appropriate. 
To set the Terrain resolution using the Grid Selector, click the Grid Selector icon at the 
bottom of the Paintbrush Controls and choose a resolution from the menu. Brush sizes 
may appear to vary depending on your resolution, but in fact they remain proportional to 
the size of the Terrain Canvas. 

resolution, the more detail appears in your terrain's surface. However, higher resolution 
values also increase the rendering time for your scene and require mo
The highest resolutions should be reserved fo

  

Brush Behaviors 

The Paintbrush in the Terrain Editor paints elevations by default, but this is not the only 
way of painting using the brush. You can also set the brush to paint effects. This lets 
you apply elevation effects locally, or to increase/decrease existing gray levels in your 
Terrain Canvas.  
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The Brush Behaviors are located at the bottom left of the Terrain Canvas Tool. 
To access the Brush Behaviors, click on the triangle icon under Brush Behavior:. 

 

Modifying Brush Behavior 

The Opt/Alt key can modify the behavior of the paintbrush on-the-fly.  
• In Elevation mode, Opt/Alt inverts the gray level. For example, if you’re painting 

white, holding down Opt/Alt will paint black. 
• In Paint Effect mode, the Opt/Alt key will toggle to Unpaint Effect mode.  
• Hold down Shift to constrain the pen movements to 45 degree steps. The default 

is to paint vertical, but with a bit of playing around, you can get it to paint 
horizontally and diagonally, but how it works is not as consistent as it should be. 

• Click and hold down the mouse on the canvas then press Shift and drag 
up and down to paint a vertical line. 

• Drag brush horizontally a short di , then press Shift to continue 
painting horizontally. Do not let up on the mouse or it will start painting 
diagonally. 

ght or right to left on the canvas to 

stance

• Press Shift, then drag from left to ri
paint a diagonal line. 
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Rendered with edges visible: 

 
Rendered with edges solid: 

 

Painting Elevations 

To paint elevations: 
1. Click the Menu icon on the Terrain Canvas to bring up the Terrain Canvas Tools. 
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2. Click the triangle icon below the Brush Behaviors heading and choose Ele
fr

vation 
om the menu. The brush paints in shades of gray that are then used to 

generate altitudes. This is the default brush behavior.  
 

 
3. Pres

Examples:
s Opt/Alt and paint on the canvas to invert the gray levels. 

 

 

Picking up Gray Levels from the Terrain 

While you’re painting, you may want to re-create a specific altitude in different parts of 
the terrain. If you’ve changed the brush settings, re-creating a specific altitu
quite difficult. However, using the Height Picker tool, you can quite easily re-create 
altitudes by picking up gray levels from different parts of your image and applying them
to the brush. 

de can be 
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To pick up gray levels from the terrain image: 
1. While holding down the spacebar, move the cursor over the Terrain Canvas and 

click the desired altitude color. The color is applied to the brush and the Level 
tool will update to reflect the new color.  
 

 
2. Drag the brush over a different area of the canvas. The altitude color you picked 

up is applied to the new area. 
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Paint 

To apply an effect locally using the Paint Effect: 
1. Click the Menu icon on the Terrain Canvas.  
2. Click the triangle icon below the Brush Behaviors heading and choose Paint 

Effect from the menu. 
 

 
3. Select a paint level from the Level tool. 

 

 
4. Click the Elevation tab in the Editing tools palette.  
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5. Hold down the Spacebar and click the Elevation effect you want to paint.  
 

 
 

circle with a double-cr
 

The button next to the effect will turn yellow and the paintbrush will change to a 
oss in the center. 

 
 
OR 
 
Click once on the effect you want to use, then press Cmd/Ctrl+Z to undo. 

6. Drag the paintbrush over an area of your canvas. The chosen effect will be 
painted on the canvas. 
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7. Press Opt/Alt and drag on the canvas to switch to the Unpaint Effect. 
d/Ctrl+Z to undo the last effect and 
u painted on the terrain. 

lease note that if you turned on the paint effect by clicking on the effect then 
ssing Cmd/Ctrl+Z, you cannot turn off the paint effect using the above 

ther effect or change to a different 
effect, or turn on painting 

as in step 4 and disable as in step 6. 

Unpaint 

To remove an effect locally using the Unpaint Effect: 
1. Paint an effect on the canvas following the instructions in "Paint

8. Click the effect button again then press Cm
turn off the effect but retain the changes yo
 
P
pre
method. Instead, you must either choose ano
brush behavior, neither of which will actually turn off the 

." 
2. Click the triangle icon below the Brush Behavior heading and choose Unpaint 

Effect from the menu. 
 

 
3. Drag the paintbrush over an area of your canvas where you applied an effect 

locally. The terrain in that area will begin reverting to its original shape. 
 
If you drag over an area where you did not paint an effect, nothing will happen. 
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Erode Terrains 

To erode areas of your terrain: 
1. Click the Menu icon on the Terrain Canvas.  
2. Click the triangle icon below the Brush Behaviors heading and choose Erosion 

from the menu. 
 

 
3. Drag the pain

erosion effect
tbrush over the area you want to erode. The paintbrush applies the 
 to the area painted over. The erosion effect will increase as you 

continue to paint over an area. 
 

 

Minimum 

The Minimum brush behavior uses the current gray level and darkens levels above that 
level to match the current level. Values below the current level setting are untouched.  
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To darken gray levels use the Minimum effect: 
1. Select a paint level from the Level tool. 

 

 
2. Click the Menu icon on the Terrain Canvas. 
3. Click the triangle icon below the Brush Behavior heading and choose Minimum 

from the menu.  
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4. Drag the paintbrush over an area you want to darken. 
 

 

Maximum 

To lighten gray levels using the Maximum effect: 
1. Select a paint level from the Level tool. 

 

 
2. Click the Menu icon on the Terrain Canvas. 
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3. Click the triangle icon below the Brush Behavior heading and choose Maximum 
from the menu. 
 

 
4. Drag the paintbrush over an 

your canvas that a
area you want to lighten. In this mode, gray levels in 

re below the current gray level are lightened to match the 
current level. Values above the current level setting are untouched.  
 

 

Editing Tools 

The Editing Tools let you generate and edit the terrain’s height map and are organized 
into three tabs: Elevation: contains tools for generating terrains, and applying effects. 
Filtering: contains tools for fine-tuning the gray levels in your Terrain Canvas. Pictures: 
contains tools for importing a picture to use as a height map. 
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To access a tab, click the tab label. The tools associated with that tab move to the front. 
By default, the Elevation tools are in front. 

 
Most of the tools in the Terrain Editor are displayed as control dots. These dots let you 
apply an effect or operation to the terrain gradually or at 100%. 
To apply an editing tool to the Terrain Canvas: 

1. Move the cursor over the tool you want to use. 
2. Do one of the following: 

• To apply an effect or operation at full strength, click the control dot once. 
Clicking a tool more than once applies the effect in 100% increments. 

ntrol 

lculations to your Terrain Canvas.  
 the Elevation tab along with general tools 

• To apply an effect gradually, click and drag left or right over the co
dot. 

Elevation Tab 

The Elevation Tools are preset effects that apply ca
The tools are divided into three categories on
along the top:  

• General Tools: create new grayscale image, invert, undo, and erode 
• Starting a New Terrain 
• Inverting Terrains 
• Undoing Operations 
• Eroding Terrains 
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• Source Generators: create basic terrain surfaces.   
• Basic Tools: edit the overall shape of your terrain.  
• Special Effects: add realism to your terrain's surface. 

 
You can create a terrain by combining effects. For example, you can start off creating a 
basic terrain using the Fractal tool, then create realistic ridges by applying the Erode 
tool. From there you can fine-tune your terrain by applying Spikes, creating Mounds or 
adding Cross Ridges. Finally, you can define the basic shape of your terrain by blurring 
the edges. 
To use an elevation tool: 

1. Click the Elevation tab. 
2. Click an Effect tool. 100% of the effect is applied to the Terrain Canvas.  
3. Click the tool again to increase the intensity of the effect. 

Most elevation effects can also be applied gradually. 

©2007 DAZ 3D, Inc.  963 



Bryce 6 Artist Guide 

To apply an elevation effect gradually: 
1. Move the pointer over an Elevation tool. The pointer changes to a two-headed 

 the right to 
arrow. 

2. Click and drag to the left to increase the effect or click and drag to
decrease it. 
 

 

Starting a New Terrain 

By default, when you open the Terrain Editor, the terrain you selected in the Working 

w button, or press Cmd/Ctrl+N. 

window appears in the Terrain Canvas. If you want to begin with a new, flat Terrain 
Canvas, use the New button. 
To create a new Terrain Canvas: 

1. Click the Elevation tab. 
2. Either click the Ne

 

 
 
A flat black image appears in the Terrain Canvas. 
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To gradually flatten your terrain, click and drag to the right over the New button. 
The existing Terrain Canvas gradually fades to black. Many of the effects in the 
Elevation tab require grayscale values. If you apply these effects to a black map they 
may have no effect.  
To reset your terrain, hold down Ctrl and click the New button. The Terrain Canvas is 
reset to the terrain that appeared when you first opened the editor. 

Invert 

Since the Terrain Editor uses brightness to determine altitude, you can change 
mountains into canyons by inverting the black and white values in your image. 
To invert your terrain image: 

1. Click the Elevation tab. 
2. Click the Invert button, or press Cmd/Ctrl+I. 

 

 
 
All the black areas of your image become white and white areas become black. 
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To gradu
The blac

ally invert your terrain image click and drag to the right over the Invert button. 
k areas in the Terrain Canvas progressively turn white. 

Original terrain: 

 
Inverted terrain:  
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Undoing Operations 

tions in the Terrain Editor, on the Elevation tab, click the Undo button, or 
+Z. The last operation you applied is undone. 

You can reverse any effect you apply to your terrain using the Undo button. You can 
toggle between Undo and Redo by clicking the Undo button repeatedly. 
To undo opera
press Cmd/Ctrl

 

Eroded 

Erosion simulates the effects of water erosion on your terrain objects. The calculations 
simulate rainfall and runoff based on the shades of gray progressing towards black. This 
effect works best on terrains that have large sloping areas. 
The Eroded button simulates the effects of erosion over relatively short periods of time, 
like decades. To simulate the effects of centuries of erosion, use the Erode tool at the 
top of the Elevation tab. 
To erode terrains: 

1. Click the Elevation tab. 
2. Click the Erode button. 

 

 
3. To gradually apply erosion, click and drag while the pointer is over the Erode 

button. 
The upper image is what a terrain looks like before you apply the Erode effect. Notice 
that this image map has sloping areas that will make the erode effect more visible. The 
lower image is the same terrain after the Erode effect is applied. You can see how the 
surface now contains tracks created by running water. 
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Source Generators 

The Source Generators create basic terrain surfaces. They create the basis of your 
terrain and should be the first options used when creating your terrain. 
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Fractal 

The Fractal t
existing image and it can be applied gradually.  

ool creates terrains based on fractal patterns. It can be applied to an 

To use the fractal tool: 
1. Click the Elevation tab. 
2. Left-click on the triangle icon next to the Fractal effect. 

 

 
3. Select a fractal type from the menu that comes up. 

 

 
 
See "Fractal Types" for examples of each fractal type. 

4. Click on the Fractal effect button to apply the effect 100% or drag right slowly to 
apply the effect in increments.  
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5. If you don't like the effect, Undo the change or click the Fractal effect button 
again to see a new variation of the selected fractal type. 
 

 

Fractal Types 

Below are examples of the different fractal types available. Each type can produce 
multiple variations so the images below are just one example of many available for each 
type. 
Bryce Classic 
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Ridged Multifractal 

 
Perlin Hills  

 
Rounded Dunes 
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Classic Fractal  

 
Round Hills 

 
Slick Rock 
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Ridges  

 
Rolling Hills  

 
Alpine Valleys 
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Chaotic 

 
Pocked  

 
Crystalline  
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Lava 

 
Metamorphism  

 
Metamorphised 
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Fractured  

 
Weathered Dikes  

 
Warped Slickrock  
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Warped Ridges  

 
Zorch  

 
Warped Zorch 
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Mordor  

 
Shattered Hills  

 
Cauliflower Hills 
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Planet X 

 
Mud Cracks 

 

Random Generators 

Three options that are rarely used in the Terrain Editor (but should be used more often) 
are the Random Generators:  

• Random Extent which deals with how much surface the terrain extends over or 
the scale of the terrain's features  

• Random Position which deals with the position of the terrain within the entire 
"fractal terrain universe"  

ne 
• Random Character which deal  with the look or character of the terrain 

The Random Generators control the randomness of the terrain, so deselecting any o
or more of them means that you turn off the randomness of that option. 

s
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To access these options, click on the triangle option next to Fractal and select any 
fractal type except for Bryce Classic. 

 
The options will be active and enabled near the bottom of the menu. 
If Bryce Classic is selected, these options will be greyed out and not available. 

 
So, if these options determine the randomness of the terrain extent, position, and 
character, then what good are they? Basically, if you find a terrain that you like the look
of, you can turn off the options so that the feature you like isn't changed. 
To take advantage of the Random Generators: 

 

1. Create a new terrain and enter the Terrain Editor.  
2. Set the resolution to 128. This allows you to get results more quickly.  
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3. Select any fractal type except for Bryce Classic. 
 

 
4. Click on the Fractal button until you find a terrain that has a pleasing scale to the 

features. 
 

 
5. Bring up the fractal menu and deselect Random Extent. Since we like the scale 

of the terrain, we want to keep the same scale as we continue.  
 

 
6. Click on the Fractal button again. Notice that even though the terrain changes, 

the overall scale remains the same.  
7. Continue clicking on the Fractal button if you would like to see what else comes 

up.  
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8. Once you have a terrain that you like the look of, deselect Random Character so 

the terrain retains the look you like. 
 

 
9. Click the Fractal button and notice that even though the terrain changes, the 

basic look of the terrain remains the same.  
 

 

©2007 DAZ 3D, Inc.  982 



Bryce 6 Artist Guide 

10. Once you have a terrain that you're happy with, deselect Random Position as 
well. 
 

 
11. Set the resolution to 512 or larger. 

 

 
12. If you will be using the terrain in a larger tiled terrain group, click on the Fractal 

button one more time to redraw the terrain at the selected resolution. This is 
needed when tiling to ensure that the terrain matches up exactly with the other 
terrains. 
 

 
13. Exit the Terrain Editor.  To use this terrain for tiling, continue to the section on 

"Tiling Terrains." 
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Tiling Terrains 

Tiling Terrains allows you to generate a terrain, then tile "copies" of the terrain around 
the working window to create a larger terrain with no visible seams. You can tile terrains 
to the North, South, East, and West. 
To tile terrains: 

1. Build a new terrain following the instructions for the "Random Generators." 
 
Note: Tiling terrains does not work for the Bryce Classic fractal terrain. 

2. Exit the Terrain Editor. 
3. Once back in the working window, press Cmd/Ctrl+D to duplicate the terrain. 
4. With the duplicate terrain selected, press Shift+Up Arrow eight (8) times to move 

the terrain up to the North. You can also go into the Object Attributes dialog and 
enter the terrain size into the Z-Position field to move it up the same amount as 

terrain, you'll need to use the Object 
tributes dialog to move the terrain up.  

the terrain size. If you've resized the 
At
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5. With the terrain still selected, go back into the Terrain Editor, make sure that all 
 deselected  and select Tile North. the Random Generators are

 

 
6. Click on the Fractal button. 
7. Exit the Terrain Editor.  
8. R

 
ender and you should see the terrains matching up at the seam. 

 
9. If  you notice a slight gap between the 

a smidge by pressing Opt/Alt+Down Arrow key three or four times until the edges 
two terrains, nudge the terrain back down 

meet. 
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10. Select the new terrain, duplicate and move North, East, or South. 
11. Enter the Terrain Editor and choose to Tile based on the direction you moved the 

terrain and click on the Fractal button. 
12. Repeat as needed, making sure that you select the terrain next to the new 

location. For example, if you move a terrain East and then want to go South, 
make sure you select the terrain you just moved. If you want to go West or South 
from the original terrain, select the original terrain, etc. 

Caveat: When the terrain has been manually sculpted using the brush tool or by 
importing an image, the tiling options won't  work since clicking on the Fractal button will 
generate a fractal terrain overwriting the sculpted terrain. In this case, you can manually 
"tile" the terrain by doing the following: 

1. After moving the terrain to the North, access the Object Atrributes and enter 180 
in the Z-Rotate field to rotate the terrain around 180° on the Z-axis. 
 

 
2. Click on the OK icon to close the Terrain Editor.  
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3. Click on the triangle icon under the Resize tool and choose Flip from the menu 
then nudge the terrain down as in step 7 above.  
 

 
4. Duplicate the second terrain and move it right, or to the East, by pressing 

ditor 

at by duplicating the third terrain, moving it down, and Tiling South (or 
 

 

Shift+Right Arrow eight (8) times, then selecting Tile East from the Terrain E
(deselect Tile North). If that doesn't work, flip the terrain on the X-axis, then 
nudge it into place next to the second terrain. 

5. Repe
flipping on the Z-axis).
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Erode 

This tool applies natural erosion to your terrain. It can be applied to either a blank im
or an existing image. You can also gradually apply erosion to an image. The Eroded
tool is a more intense version o

age 
 

f the Erode tool. Notice that when animating this type of 
terrain, material is actually added to the terrain, not removed from it as you might 
expect. 

 
To erode the terrain, click on the Erode button. You may need to click several times to 

able effect, but the effect is much sharper than if you used the Eroded tool. 
Original terrain vs Eroded terrain: 
get a notice

  

Picture 

This tool creates terrains from imported images. When you click this tool, the Open 
dialog appears. You can use this dialog to locate and load a picture to use as a Terrain 
Canvas.  
Refer to the "Pictures Editor" for more information on loading pictures. 
Using this tool you can import an image map created in another application like Painter 
or Photoshop. 
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To load a picture to use as a terrain: 
1. Click on the Picture button. 

 

 
2. The Open dialog will come up. Locate and select the picture you want to use in 

the Terrain Editor then click on Open. 
 

 
 
The image will immediately be applied to the terrain.  
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Raise/Lower 

This tool adjusts the brightness of your Terrain Canvas.  
To raise or lower the terrain, click and drag to the right to lower your height map or click 
and drag to the left to raise it. Single clicks gradually lower the map. 

 
Examples: 

  

Sharpening 

ns the gray values in your Terrain Canvas. Click and drag left to This tool sharpe
increase sharpening and right to decrease it. 

 

©2007 DAZ 3D, Inc.  990 



Bryce 6 Artist Guide 

Examples: 

 

Smoothing 

This tool blurs the Terrain Canvas. Click and drag right to decrease the blurring effe
left to increase it. 

ct or 

 
Smoothing is especially effective prior to using the Erode button, since the Erode 

 

es: 

algorithm works best when there are shades of gray in an image. If your canvas has too
many sharp black to white transitions, the Erode may not be as effective. 
Exampl
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Basic Tools 

The Basic Tools edit the overall shape of your terrain and are located immediately 
below the Source Generators. 

 

Basic Noise 

This tool adds roughness to your terrain's surface by adding noise to the Terrain 
Canvas. Click and drag left to increase the noise and right to decrease it. 
Examples: 

  

Slope Noise 

This tool adds roughness to any sloping surfaces in your terrain. Click and drag left to 
increase the noise and right to decrease it. Slope Noise has no effect on flat surfaces. 
More noise is added to steep slopes. 
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Examples: 

  

Height Noise 

r This tool adds small amounts of noise at lower altitudes and more noise at highe
altitudes. Click and drag left to increase the noise and right to decrease it. 
Examples: 

  

Gaussian Edges 

es not blur your map. It creates a "Gaussian curve" from dark to light, 

Gaussian Edges eliminates the seams between ground and terrain objects, when the 
ground plane and the terrain have the same surface material. You should apply this tool 
to any terrain that is going to be sitting on a ground plane in your scene. 

This tool do
starting from the edges of your Terrain Canvas. This creates edges that gradually 
transition from dark to light, or start at the lowest possible altitude, and gradually 
progress into higher altitudes. 
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Examples: 

  

Square Edges 

y. 
crease it. 

This tool creates an abrupt drop at the edges of your terrain. Use this tool when you 
have a terrain whose edges are not level, and you do not wish to use the Gaussian 
Edges tool for soft transitions. 
You can add a slope to the square edges of your terrain by applying this tool graduall
Click and drag left to increase the slope and right to de
Example: 

 

Round Edges 

This tool creates an abrupt circular drop at the edges of your terrain. You can add a 
slope to the round edges of your terrain by applying this tool gradually. Click and drag 
left to increase the slope and right to decrease it. 
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Example: 

 

Special Effects 

 
 

The Special Effect tools add realism to your terrain's surface. These tools, located 
below the Noise tool, apply filters to your terrain that act like image filters. They can
change the look of the terrain without altering its basic shape.

 

Spikes 

This tool adds spiky structures to your map. When you apply the right material to these 
structures they can look remarkably like trees when viewed from a distance or even 
grass. 
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Example: 

 

Mounds 

This tool adds midsized splotches to your canvas. You can use this tool to create the 
appearance of stones or boulders under transparent water planes. 
Examples: 

  

Dampen 

This tool works like a contrast control. It will push gray values towards either black
white depending on where the gray value falls in the black/white range. Less than
goes to black, greater than 50% goes to white. 

 or 
 50% 
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Examples: 

  

Equalize 

This tool acts like the Equalize function you may have seen in 2D image editing 
applications. It redistributes gray values in your Terrain Canvas such that a full range 
from black to white is present in your canvas. 
Examples: 

  

Posterize 

This tool stratifies the gray levels in your Terrain Canvas, resulting in stair-stepped 
terrain structures. This is a good tool for creating desert plateaus. 
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Examples: 

  

Mosaic 

This tool is not a button on the Elevation tab. To use this tool, hold down Opt/Alt as you 
drag over the Posterize button. Mosaic creates highly pixelated square structures based 
on the gray content of your canvas. 
This tool is excellent for instant cityscapes. Try adding one of the sci-fi city materials 

aterials Library to a Mosaic terrain. from the Preset M
Example: 

 

Sawtooth 

This tool modifies your Terrain Canvas based on a sawtooth waveform structure. The 
results look like desert canyons and icebergs. 
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Example: 

 

Subcontours 

This tool works like a contrast control with the threshold set almost at white. Most values 
are pushed to black while only the very lightest are pushed to white. Subcontours 
produces spiky peaks with very low, gently sloping contours. 
Example: 

 

Blob Maker 

This tool creates a smooth, circular structure within your existing Terrain Canvas. Click 
and drag left or right to change the size of the structure. Click and drag up and down to 
set the vertical location of the structure. 
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Examples: 

  

Relief Noise 

This tool acts like an emboss effect. It will emboss the grayscale data in your canvas 
and convert it to height information. 
Examples: 

  

Raise Edges 

This tool acts like an inverted version of the Square Edges tool. It creates abrupt 
increases in altitude at the edges of your terrain. 
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Examples: 

  

Subplateaus 

rectly related to your original gray data. 
Examples: 

This tool smears your grayscale data in one direction while averaging the gray values. 
The result is natural structures not unlike those created by the Mounds effect, except 
that these structures are more di
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Cross Ridges 

This tool creates sharp ridges in a cross pattern. It creates very interesting canal-like 
structures. 

 
Example: 

 

Cross Ridges 2 

This tool is the inverse of the Cross Ridges tool. Instead of creating canals, it creates 
peaks. 
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Example: 

 

Bubble Ridges 

Similar to the Blob Maker, the spherical structure this tool creates is of a consistent size. 
Dragging this button allows you to place the structure anywhere you like in your canvas. 

 
Example: 

 

©2007 DAZ 3D, Inc.  1003 



Bryce 6 Artist Guide 

Filtering Tab 

The Filtering tab is divided into three areas: the Filtering Graph, the Preview area, and 
the Filtering Presets. 
The Filtering graph displays your Terrain Canvas' gray levels as value inputs and 
outputs. You can edit this graph to adjust the gray level values in your canvas. 
Next to the graph is the Preview area. This area shows you what your Terrain Canvas 
would look like if applied to the current Filtering graph. This area automatically updates 
as you make changes to the graph. 
Along the top of the tab are the nine Filtering presets you can apply to the graph. Each 
preset represents a different predefined graph. They are designed to create specific 
changes in gray levels, like smooth gradients a  abrupt transitions.  nd

 

How Filtering Works 

The Filter area is essentially a graph that represents gray level input from black to white 
horizontally, and gray level output from black to white vertically. 
The default diagonal filter creates a graph where all values input as black are also 
output as black, and all values input as white are also output as white. That is why your 
Terrain Canvas appears unchanged - none of its gray level values have been altered. 
By dragging in this Filter area, you can remap the gray values in your Terrain Canvas. 
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To see how filtering works: 
1. Generate your terrain. 

 

 
2. Place your cursor (which changes to a Pen within the Filtering area) in the top left 

corner of the Filter Area.  
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3. Drag diagonally to the bottom right corner. 
 

 
4. Click Apply.  

 

 
As you can see in the Preview area, your Terrain Canvas is inverted. The original graph 
showed that all values input as black were output as black and all the values input as 
white were output as white. 
The new graph you created now shows that all values input as black are output as white 
and all the values input as white are now output as black. In other words all the dark 
values are light and all the light values are dark. 
In the new Filtering graph all values input at 0 are output at 255 and all values input at 
255 are output at 0. 
This is a drastic example. In most cases you would adjust more selectively, like 
lightening the mid tone grays or darkening specific gray values. Remember that this 
graph represents your Terrain Canvas, so you're changing the shape of your terrain 
object as you adjust gray values. 
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Altering the Filtering Graph 

The best way to start adjusting the Filtering graph is to determine the type of effect you 

1. Click the Filtering tab. 
 

want to create. For example, if your canvas is too dark, raise the value of the darker 
gray value inputs by drawing a ridge in the left side of the graph. 
To alter the Filtering graph: 

 
2. Drag your pointer over the area of the Filtering graph you want to adjust. When 

 in black. Tracing over any lines you've drawn erases them.  
you drag over a black area, the pencil draws in gray; dragging over a gray area 
draws
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Undoing Filter Changes 

To undo all changes to the Filtering graph: 
1. Click the Filtering tab. 
2. Click the Reset text button below the Filtering graph. The graph returns to the 

default Filtering graph. 
 

 

Softening Harsh Transitions 

To soften harsh transitions in the graph: 
1. Click the Filtering tab. 
2. Click the Smooth text button below the Filtering graph.  
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3. Click the Smooth bu
button continuously 

tton again to soften the transitions more or press the Smooth 
until the curve is smooth enough for your needs. 

Applying Filter Presets 

Filtering presets are provided to help you get started adjusting the Filtering graph. 
These presets are designed to provide different effects. The best way to understand 
these presets is to apply them to your graph and see what happens. 
To apply presets: 

1. Click the Filtering tab. 
2. Click one of the preset buttons along the top of the tab. 

 

 
 
The current graph is replaced with the preset graph. 
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Applying Filter Changes 

Although any changes you make to the graph are applied to the Preview area, they do 
not automatically affect your Terrain Canvas. You have to apply the changes before 

ding down 
er the Filtering graph. (Issue

they affect the canvas. 
You can temporarily apply your changes to the 3D Preview in real-time by hol
Ctrl as you click and drag ov ) 
To apply the Filtering graph to the 3D Preview. click and hold the mouse button over the 
filter graph preview. The 3D Preview updates. When you release the mouse the 3D 
Preview switches back to the unfiltered terrain. (Issue) 
To apply filtering changes to the Terrain Canvas, click the Apply text button beneath the 
Preview area. 

 

Blending the Filtering Graph 

The Filtering Tab offers several ways of applying your Filtering graph to the Terrain 
Canvas. You can apply the graph directly or you can blend the graph with the canvas. 
When you use a blending option you're essentially drawing a grayscale gradient and 
then blending it with your original canvas. The upper terrain in this image was altered by 
directly applying a filtering effect. The lower terrain was altered by blending a filtering 
effect with the original canvas. 
To blend the Filtering graph with the Terrain Canvas: 

1. Adjust the Filtering graph to achieve the desired effect.  
2. Click the triangle icon below the Filtering graph and choose an option from the 

menu. 
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• Horizontal: horizontally ble d

ering graph, expressed as a grayscale 
gradient, with your Terrain Canvas.   

• Horizontal Add: horizontally blends your Filtering graph, expressed as a 
grayscale gradient, with your Terrain Canvas. This option uses a slightly 
different algorithm than the previous Horizontal option: it's not a traditional 
Additive, but an average of the existing terrain grayscale values with the 
maximum of the Terrain and Filter values. 

• Vertical Add: vertically blends your Filtering graph, expressed as a 
grayscale gradient, with your Terrain Canvas. This option uses a slightly 
different algorithm than the previous Vertical option: it's not a traditional 
Additive, but an average of the existing terrain grayscale values with the 
maximum of the Terrain and Filter values. 

3. Click Apply.  

n s your Filtering graph, expressed as a 
grayscale gradient, with your Terrain Canvas.  

• Vertical: vertically blends your Filt
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Pictures Tab 

The Picture tab has three picture squares and a blend control. The first two picture 
squares let you load a picture to use as a terrain and the third square shows you the 
result of combining the two pictures. The blend control lets you specify how the pictures 
are combined. 

 

Loading Pictures 

You can load any two pictures from your system. You can also paste images from the 
Clipboard.  
To load pictures,  

1. Click the Load text button above the picture box into which you want to load the 
picture.  
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2. The Open dialog will come up. Lo
c
 

cate the image you want to load, select it, and 
lick on Open.  

 
3. From the Picture button in the Elevation tab, hold down the Opt/Alt key to load 

the picture's color data directly into the 3D Preview. This allows you to see the 
interaction between the picture and the grayscale-to-height interpretation of its 
luminance values. The color data is only for viewing purposes and will not render 
with the terrain. (Issue)  

ture tab: 
 another application, copy the picture you want to use to the Clipboard. 

k the Paste text button below the picture box where you 
you use Cmd/Ctrl+V to paste from the 

lipboard, the picture always appears in the first square. 
 

To copy and paste a picture into the Pic
1. In
2. In the Picture tab, clic

want the picture to appear. When 
C
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8-bit and 16-bit Terrains 

New in Bryce 6 is the ability to import/export 16-bit grayscale images from the Terrain 
Editor. By default, Bryce creates terrains in 8-bit grayscale which can often be less 

 16-bit 
it 

 or Paint 
grams, like Paint Shop Pro, some of the 

 not work in 16-bit mode, only in 8-bit mode. You may 
crease it to 16-bit before saving it. 

 a 16-bit 
itor, 

Creating 16-bit Pictures 

tor: 

2. Enter a name, width, height, and resolution. Choose a color mode of Grayscale 
and select 16 bit from the pull-down menu. If your background color is black, set 
the Background Contents to Background Color. 
 

smooth than needed but stores the images as 16-bit. Being able to import
grayscale images provides the ability to take advantage of Bryce's ability to store 16-b
and to add more detail to your terrains, with a much smoother surface. 

r. Please note that you cannot convert 8-bit terrains to 16-bit in the Terrain Edito
Conversion between the two must be done in a paint program, like Photoshop
Shop Pro. Just be aware that in some paint pro
tools (brushes, picture tubes) may
need to create your image in 8-bit then in
In addition, not all formats work the same between programs. For example,
TIFF image exported from Paint Shop Pro X cannot be imported into the Terrain Ed
but the same image exported as TIFF from Photoshop, can be imported into the Terrain 
Editor. 

The instructions below use Photoshop as the paint program. 
To create 16-bit images for import into the Terrain Edi

1. Open Photoshop and choose File > New from the menu. The New file dialog will 
come up.  
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3. Click on OK to create the new image. The canvas title will indicate the color 
mode and bit size. 
 

 
4. Paint your terrain or image using grayscale colors. 
5. Save the image, selecting None for PNG Options and clicking on OK. 

 

 
 
For Macs, w
c

hen saving the images as TIF files, they need to be saved or 
onverted to PC Byte Order. 

Loading 8-bit and 16-bit Pictures 

To load 8-Bit and 16-bit images into the Terrain Editor: 
1. Create a terrain image in a paint program on a square canvas (i.e., 512x512, 

256x256, etc.). 
2. Open Bryce and create a terrain or symlat.  
3. Click on the  button next to the selected terrain to enter the Terrain Editor. 
4. In the Terrain Editor, for 16-Bit images check the Terrain Resolution to make 

sure it is at least at 512 - ultra fine, although 1024 massive resolution or higher is 
probably better. Just remember that if you downgrade the resolution later then 
upgrade it again, you will lose some resolution in the process. See the examples 
at the bottom of the page.  
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5. Click on the Pictures tab in the Editing Tools panel.  
 

 
6. In the Pictures tab, click on Load above the first window. 

 

 
7. The Open dialog will come up, locate and select your 16-bit PNG file. Click on 

Open. 
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8. The image will
window, then o

 be loaded into the first window. Click on Copy under the first 
n Paste under the second window. 

 

 
9. The copy will be pasted into the second window. Click on Apply to load the image 

into the Terrain Canvas. 
 

 
10. The image will be loaded into the Terrain Canvas where you can modify it further 

if needed.  
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Examples: 

• 16-Bit Image at 1024 resolution:  
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• 16-Bit Image at 128
 

 resolution: 

 
• 8-Bit 512 Resolution Rendered: 
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• 16-Bit 512 Resolution Render
 

ed: 

 
• 16-Bit 1024 Resolution Rendered: 

 

 

Exporting 8-bit and 16-bit Pictures 

Sometimes, it is easier and/or more efficient to modify terrains in a paint program rather 
than in the Terrain Editor.  
There are three ways to export the terrain grayscale images from Bryce: 

1. Copy the original image in the Terrain Canvas and paste into a paint program. 
2. Copy the original image in the Pictures tab and paste into a paint program. 
3. Export the terrain image and open in a paint program - new in Bryce 6 

To copy the image using the Terrain Canvas: 
1. Create a terrain or symlat. 
2. Click on the  button next to the terrain to enter the Terrain Editor.  

©2007 DAZ 3D, Inc.  1020 



Bryce 6 Artist Guide 

3. Select the terrain resolution for the size you'd like to work with in your paint 
program. For example, if you select 1024, then the grayscale image in your paint 
program will be 1024x1024, etc. 
 

 
4. Modify the terrain to get your starting point, then press Ctrl+C. 
5. Minimize Bryce and open your paint program. 
6. Paste as a new image. he image will have the same dimensions as the selected 

terrain resolution in the errain Editor and will be in 8-bit format. 
 T
 T

 

 
7. Modify the terrain using the tools in the paint program and save the image. 
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8. Bring the image back into Bryce by doing one of the following: 
• Load it into the Pictures tab by clicking on Load 

m and press Cmd/Ctrl+V in the Terrain Canvas 

Once you have a picture in each of the first two squares, you blend them to create a 
third image that is used to create the new Terrain Canvas. 
To blend pictures: 

• Copy it in the paint program and click on Paste in the Pictures tab 
• Copy it in the paint progra

Blending Pictures 

1. Load pictures into the first two squares. If you load only one picture a white 
square is used as the second blend image. 
 

 
2. Click the triangle icon under the third picture box and choose a Blend mode from 

the menu. 
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• Blend: compares each corresponding pixel from the first two squares, and 
displays an average of the two in the corresponding location of the third 
square.  

• Minimum: compares each corresponding pixel from the first two squares, 
and displays the darker of the two in the corresponding location of the 
third square.  

• Subtract: compares each corresponding pixel from the first two squares, 
subtracts the brightness value of one from the brightness value of the 
other, and displays the result in the corresponding location of the third 
square. 

• Add: compares each corresponding pixel from the first two squares, adds 
the brightness value of one to the rightness value of the other, and 
displays the result in the corresponding location of the third square.  

3. Drag the pointer over the Blend control. Click and drag to the left to use more of 
the first image in the blend. Click and drag to the right to use more of the second 
image.  
 

b
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Applying Changes 

Although the result of blend
automatically applied to your Terrain Canv

ing pictures appears in the third picture box, it is not 
as. 

To apply a picture to the Terrain Canvas, click the Apply text button beneath the third 
picture square. 

 
And the Terrain Canvas will be updated: 
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Animation Controls 

The Animation controls at the bottom of the editor let you create key frames for your 
terrain. Any change you make to the geometry of the terrain can be stored in a key 
frame and animated. 
The Timeline that runs along the bottom of the editor displays the length of the 
animation. The Current Time Indicator within the timeline lets you set the current time of 
the animation. 
The buttons in the Animation controls let you preview the animation. The buttons beside 
the Preview controls let you add and delete key frames from the Timeline. The 
Animation controls at the bottom of the editor let you create key frames for your terrain. 

he terrain can be stored in a key frame and Any change you make to the geometry of t
animated. 

 

Speeding up the Terrain Editor 

To speed up performance on slower machines, disable both the Real-time Linking and 
AutoRotate options. 
To speed up the Elevation effects, use the single-click method rather than the click-drag 
"dial in" method, as the latter can be qui .
The larger terrain grid sizes, such as Massive, Gigantic, and Planetary, require a 
significant amount of memory and computing power. Only use these terrain grid sizes 
when necessary. If you are working on a slower machine, you may experience 
problems such as "out of memory" errors. 
When you create a terrain in your Bryce scene, a natural impulse is to immediately 
dress it up with a cool material and render it right away to see what it looks like. For 
serious composition, consider keeping your terrains free of textural attributes until the 
final stages, as procedural textures take longer to render than smooth shaded surfaces. 
This will keep you working rapidly on your composition. Then, before your final output, 
you can take some time to design textures for your terrain. Export lets you save a 
terrain in a variety of file formats. You can then import a saved terrain into another 3D 
application or a different Bryce scene. 

te slow  
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Cr ng Terrains 

generating a terrain based on a series of algorithms, you can use the editor's painting 
tools to create a custom image, or you can import an image into the editor. 
When you generate a terrain, you use the Terrain Editor's Elevation tools, which include 
dozens of effects optimized for the purpose of heightening realism in Bryce terrains. 
When you paint a terrain you use the editor's grayscale paintbrush to paint a 
topographical image. The image is then converted to a terrain object. 
You can also create a terrain by importing a picture into the editor. The picture is 
converted to grayscale and used to generate altitude values. 

Creating Landscapes 

the shape of your terrain, keep in mind the kind of landscape you 
n't have to create all the land in your scene as a single terrain. 

ht be combined to create a single land 

e a bigger scale for the environment. 
ic looking effect. 

Before you start creating terrains you should map out all the land masses in your 

Pay attention to where the camera is positioned in the scene. Terrains that are closer to 
the camera need to be more detailed than those off in the distance. 

Animation & Terrain Editing 

You can record the process of creating a terrain into an animation using the Animation 
controls. Refer to “Animation

eati

You can create terrains in several ways. You can let the editor do all the work of 

When you're planning 
want to create. You do
You can create complex landscapes by combining several terrain objects. 
Before creating terrain objects, plan out the entire map of your landscape. Then you'll 
be able to see where different terrain objects mig
mass. 
If you have more terrains in your scene, you'll hav
This gives you more resolution and a more realist

environment. You'll then be able to see where you will need to combine more than one 
terrain to create a specific type of landscape. These images show an example of 
mapping and the final result. 

” for more on animating terrains. Some of the Elevation 
tools can produce unpredictable results when they’re animated, so you may want to 
experiment with animating elevations before you create your final terrain. 

Light Lab 
The Light Lab is used to set the attributes of your light sources. You can edit the 
attributes of a light using the Light Lab. For example, you can control the intensity and 
sharpness of a light source, set its shadow attributes, change its color, add a gradient or 
light gel, and set the falloff pattern. 
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Accessing the Light Lab 

ss the Light Lab: 
1. Select a light object in your scene. 
2. Click the 

To acce

 button that appears next to its bounding box. The Light Lab will come 
up. 
 

 

Light Preview 

The Light Preview area displays the effects of any changes you make to the attributes 
of a light source. This preview can display the light against a neutral background or 
show the light in the scene. You can also choose between a faster, low-quality preview, 
and a slower, high-quality preview. 
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To set the preview options 
corner of the preview area 

in the Light Lab, click the triangle icon at the bottom right 
and choose a preview option:  

 
• Render in Scene displays your scene in the Preview area. This lets you see how 

the changes you make to the selected light will impact your entire scene. 
 

 
• Render Against Neutral displays the light against a flat background. This lets you 

isolate the light so you can clearly see subtle changes. 
 

 
• Fast Preview lets you achieve faster updates. 
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• Full Rendering displays a high-quality rendered scene or light. 
 

 

Light Attributes 

You can change the intensity of a light source, set its color, and adjust a light's edge 
softness. When your light source is a spotlight, you can also control the spread of the 

Intensity 

To adjust light Intensity in the Light Lab, drag the light Intensity control. Drag right to 
increase light intensity and 
left to decrease intensity. 
The default Intensity is 25, although the slider can be set from 0 to 999 for positive lights 
and from 0 to -999 for negative lights. 
Positive settings will show up as gold on the slider, while negative settings will show up 
as blue. 

light. 

 
Negative lights are good for removing light from an area, either to darken a specific spot 
or to lower the intensity of the positive lights without affecting shadow ambience. Used 
correctly, negative lights can increase the realism in your scenes. 
Examples: 

• Radial Light Intensity = 25 
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Radial Light Intensity = 50 
 

• 
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 adial Light Intensity = -25 
 
R•

 
 

 

Edge Softness 

The Edge Softness attribute lets you set the sharpness/softness of the edges of the 
spot projected by a light. 
The default setting for Edge Softness is 0 with the slider having a range from 0 to 100. 
To adjust a light's edge softness in the Light Lab, drag the Edge Softness control.  
Drag left to sharpen the edges and right to soften the edges, or enter an amount in the 
numeric field. 

 
Please note that for radial lights, the Edge Softness control is disabled. 
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Examples: 
• Intensity = 25; Edge Softness = 0 

 

 
 

 
• Intensity = 25; Edge Softness = 25 
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• Intensity = 25; Edge Softness = 50 
 

 
 

 

Spotlight Spread 

The Spread of the Spotlight (also called the Half Angle) controls the size of the 
projected light cone. The size of the light's wireframe determines the spread of the light. 
The bigger the wireframe, the larger the spread. 
To adjust the spread of a Spotlight: 

1. Select a Spotlight in the Working window. 
 

 
2. Drag one of its bounding box control points to set the wireframe's size. Increase 

the size to increase the spread and decrease the size to decrease the spread. 
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Examples: 
• Default spread: 

 

 
• Increased spread: 
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• Decreased spre
 

ad: 

 
 

 

Cast Shadows 

By default, any light source in Bryce causes objects in its way to cast shadows. You can 
 to produce realistic-looking shadows or 

. 

h  u change a Shadow's Ambience, you add a color to the shadow and can adjust 
the amount of the new color in the shadow. 
The default setting is 0 for Shadow Ambience with the slider having a range of 0 to 100. 

control the ambience and softness of a shadow
surrealistic effects

Shadow Ambience 

W en yo

 

©2007 DAZ 3D, Inc.  1035 



Bryce 6 Artist Guide 

To change a shadow's ambience: 
1. In the Light Lab, ensure the Cast Shadows option is enabled. 

 

 
2. In the Shadow Ambience area, click the Shadow Color swatch and choose a 

color from the color picker. 
 

 
3. Drag the Amount control right to increase the amount of the new color or left to 

decrease the amount, or enter an amount in the numeric field. 
 

 
4. Click on the OK icon to close the dialog. 

You can also disable the shadow casting of a light source. This results in a light that 

s 
illuminates surfaces but does not create shadows. 
To disable shadow casting for a light source in the Light Lab, disable the Cast Shadow
option. 
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Examples: 
• Shadow Ambience = 21; Soft Shadows = 0; Color = Hot Pink 

 

 
 

 
• Shadow Ambience = 21; Soft Shadows = 81

 
; Color = Hot Pink 
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• Shadow Ambience = 80; Soft Shadows = 81; Color = Hot Pink 
 

 
 

 

Soft Shadows 

When you adjust the softness of a shadow, you blur or sharpen the shadow's edges. 
Soft shadows blend more smoothly with the background. 
The default setting is 0 for Soft Shadows with the slider having a range of 0 to 100. 
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To adjust the softness of a shadow: 
1. In the Light Lab, ensure the Cast Shadows option is enabled. 

 

 
2. Drag the Soft Shadows control right to soften the shadow's edges or left to 

sharpen them, or enter an amount in the numeric field. 
 

 
3. Click on the OK icon to close the dialog.  

Examples: 
• Shadow Ambience = 21; Soft Shadows = 0; Color = Hot Pink 
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• Shadow Ambience = 21; Soft Shadows = 81; Color = Hot Pink 
 

 
 

 

Light Color 

 
the light object, not the color of the shadow it 

There are two types of color that can be applied to a light: 
• Uniform

The Color of a light is different than the color of the Shadow Ambience. The light Color
is the actual color of light that is cast by 
casts. 

 - which applies the same color over the entire light spread. 
• Gradient - which applies a range of colors of the light spread. 

Color - Uniform 

When a Uniform Color is applied to a light, the selected color is applied to the entire 
spread of the light. No matter where the light falls, the light color will be the same. 
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To set a light's Color uniformly: 
1. In the Light Lab, enable t

 
he Uniform option in the Color area. 

 
2. Click the Color swatch, and choose a color from the color picker. 

 

 
3. Click on the OK icon to close the dialog.  

Examples:
• C

 

 
 olor = Yellow 
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• C olor = Blue 
 

 
• Color = Green 

 

 

Color - Gradient 

Gradient Lights change color as they get further away from the light source, thus 
coloring surfaces along the way differently. 
For example, when you apply a red-to-yellow gradient to a light, the resulting gradient 
light colors nearby surfaces red and distant surfaces yellow. The mid-range surfaces will 
reflect blends of red and yellow light. This feature is useful for creating custom light 
falloff patterns. 
You can create a gradient in Bryce or on the PC, you can import a gradient created with 
another application (Photoshop 5.5 and earlier). Macs cannot currently import any 
gradients. 
When you create or import a gradient, it is automatically applied to the active light. 
The Light Lab lets you control the range and offset of gradients. You can also change a 
gradient's colors and transparency. 
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Import Gradient 

To import a gradient: 
1. In the Light Lab, enable the Gradient option in the Color area. 

 

 
2. Click on the Import button. 

 

 
3. Locate the drive and folder where the gradient file (.grd) is stored. 
4. Select the file and click on Open.  
5. Click on the OK icon to close the dialog. 

Modifying Gradients 

To modify a Gradient, in the Light Lab, click the Edit button in the Color area. 
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The E id t Gradient dialog appears. 
 

 
The Edit Gradient dialog lets you edit gradients added to lights. You can change a 
gradient's colors and transition points, add colors to a gradient, or remove unwanted 
colors. You can also change the transparenc ent to create various light 

The Gradient Preview is automatically updated as you edit a gradient. 

y of a gradi
patterns. 
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Edit Gradient Dialog 

The Edit Gradient Dialog provides the ability to modify the current gradient colors and 
transparency. 

Modify Gradient Colors 

To modify a Gradient's Colors: 
1. In the Light Lab, click the Edit button in the Color area. 

 

 
 
The Edit Gradient dialog appears. 
 

 
2. In the Adjust area, enable the Color option. 
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3. Click a color node below the Gradient Control. A black arrow displays below the
node indicating that the color node is selected. 
 

 

 
4. Click the Color swatch, and choose a color from the color picker. 

 

 
5. The Gradient Control and Gradient Prev

selection. 
iew will update to match the new color 
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6. Repeat steps 3 and 4 to modify other colors in the Gradient. See "Add Colors to 
Gradient" to add more color nodes or "Delete Colors from Gradient" to remove 
color nodes. 
 

 
7. Click on OK to exit the dialog then on the b to return to the 

Bryce Working Window. 
OK icon in the Light La

 

 

Add Colors to Gradient 

The default Gradient has two color nodes which is usually sufficient for most renders, 
however, sometimes you need more colors, especially if the Range of the Light has 
been increased. 
To add Colors to a Gradient: 

1. Make sure that one of the Color Nodes is selected, then click the Add (+) button 
next to the Gradient control. 
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A new color node appears below the center of the Gradient control. 
 

 
2. Click the Color Swatch, and choose a color from the color picker. 
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The Gradient Preview will 
 

update to show the new color. 

 
3. If needed, drag the Color Node left or right to position it or click in the Location 

field and enter a number. 
 

 
4. Repeat steps 1 to 3 to add other colors. 
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5. Click on OK to exit the dialog then on the OK icon in the Light Lab to return to the
Bryce W
 

 
orking Window. 

 

Delete Colors from Gradient 

When you no longer need a Color, you can remove it. 
To remove a Color: 

1. Select the Color Node you want to delete below the Gradient Box and click the 
Delete (-) button. 
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The Color Node will be removed. 
 

 
Repeat to delete any additional nodes. 
Once you've deleted the Color Node(s)
of any remaining Color Nodes as needed. 
 

2. 
3. , adjust the Location and Transition Point 

 

ansition Point 

A Transition Point is an imaginary line between 
Transition Point lets you change the ratio 
blends dominated by one of the two colors. 

Change Tr

two colors in a gradient. Changing the 
between the two colors and produce color 
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To change a Transition Point in a Gradient: 
1. In the Edit Gradient dialog, left-click on the Transition Node you want to adjust. 

The Node will turn black indicating that it is selected. 
 

 
2. Drag a Transition Point left to make the end color dominant or right to make the 

start color dominant. You can also change the transition point by typing values in 
the Location field. 
 

 
3. Click on OK to exit the dialog then on the OK icon in the Light Lab to return to the 

Bryce Working Window. 
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Change Gradient Transparency 

By default, all Gradients created in Bryce are fully opaque. You can change the 
Transparency of a Gradient to create light sources that fade in or out. You can also 
create complex transparency patterns by adding Transparency Nodes with various 
opacity values. 
To change the Transparency of a Gradient: 

1. In the Light Lab, make sure Gradient is enabled then click the Edit button in the 
Color area. 
 

 
 
The Edit Gradient dialog appears. 
 

 
2. In the Adjust area, enable the Transparency option. 
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3. Click a Transparency Node below the Transparency control. A triangle app
below the Transparency Node indicating that the node is selected. 
 

ears 

 
4. Type a value in the Opacity field. The Gradient Preview will be updated to refl

the selected Opacity value. 
 

ect 

 
5. If you want to adjust the Transparency between two Transparency Nodes in a 

Gradient: 
• Left-click on the Transition Node you want to adjust. The Node will turn 

black indicating that it is selected. 
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• Drag the Tr
right or ente

ansparency Node above the Transparency control to the left or 
r a value in the Location field. 

 

 
6. See "Add Transparency Node" to add new Transparency Nodes or "Delete 

Transparency Node" to delete Transparency Nodes, then adjust as needed. 
7. Click on OK to exit the dialog then on the OK icon in the Light Lab to return to the 

Bryce Working Window.  
Examples: 

• Opacity = 25: 
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• Opacity = 75: 
 

 
You can also use the above procedure to change the Transparency of imported 
Gradients. 

 

Add Transparency Node 

To add transparency nodes: 
1. Make sure that one of the Transparency  or Transition Nodes is selected, then

click the Add (+) button next to the Transparency box. 
 

 
 
A new Transparency Node appears below the center of the Transparency 
control. 
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2. Select a Transparency Node to edit and type a value in the Opacity field. Type a 

 Transparency Node to where you want to change the 

When you no longer need a Transparency Node , you can remove it. 
To remove a Transparency Node: 

1. Select the Transparency or Transition Node you want to delete and click the 

value in the Opacity field. 
3. Drag the new

transparency. 

Delete Transparency Node 

Delete (-) button. 
 

 
 
The Transparency Node will be removed. 
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2. Once you've deleted the Transparency Node, adjust the Location and Transition 

Point of any remaining Transparency Nodes as needed. 
 

 

Gradient Range & Offset 

The Range of a gradient is the distance in Bryce units that the gradient spans. When a 
gradient light is this distance from its source, the gradient's end color is applied to the 
light (provided you've accepted the default offset value of zero). 
The Offset of a gradient determines how the gradient colors will be applied to the light 
source. By default, the offset value is zero, which means that the light will start with the 
start colors of the gradient. When you increase the offset, intermediary gradient colors 
will be applied to the light at its source. The maximum offset value of 100 results in a 
light source which begins with the end color of the gradient. See the last image on this 
page for an example of the Offset set to 100. 
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To change a gradient's Range in the Light Lab, click the Range control in the Color 
area, and type a value in the field. The Range can be set from 0 to 99,999. 

  
To change a gradient's Offset in the Light Lab, click the Offset control in the Color area, 
and type a value in the field. The Offset can be set from 0 to 100. 

  
You can also change a gradient's Offset by dragging the Offset button next to the 
Gradient preview. 

 
Examples: 

= 0: 1. Range = 51.2; Offset 
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2. Range = 25; Offset = 0: 
 

 
3. Range = 100; Offset = 0: 

 

 
4. Range = 100; Offset = 25: 

 

 
5. Range = 100; Offset = 50: 
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6. Range = 100; Offset = 55 - showing the center still a bit green, then changing to
orange: 
 

 

 

Saving Gradients 

Once you've edited a Gradient, you can save the Gradient by adding the Light Object to 
Library or by adding the Light Material to the Materials Presets 

ht 

the Objects Presets 
Library. 
Saving to the Objects Presets Library saves both the light and the material. The lig
can be loaded into the scene from the library with all settings intact. 
Saving to the Materials Presets Library saves only the material.  
To use the saved Gradient material, apply the material to the light, then enter the Light 
Lab and enable the Gradient option to activate the Gradient. 

 

Light Falloff 

Light Falloff lets you control the relationship between the intensity of a light and 
distance from the light. In the real world, the farther you are from a light source, the less 
influence it has on the illumination of your surroundings. In other words, the greater 
distance, the weaker the light.  

the 

the 
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In Bryce there are four falloff types you can apply to a light: 

• None (No Falloff) causes the intensity of the light to stay the same regardless of 
the distance. 

• Linear Falloff causes the light's intensity to fall off at a constant rate. When you 

tdoor lights like searchlights. 
is 

ful for creating indoor 
lights, like lamps. 

 change abruptly from full intensity to zero (no 

ne, 
ecting Ranged falloff will enable the Amount slider. 

use this type of falloff, the light's range is rather large. This type of falloff is useful 
for creating ou

• Squared Falloff causes the light's intensity to fall off rapidly. When you use th
type of falloff, the light's range is quite limited. This is use

• Ranged Falloff causes the light to
illumination) after a distance range you define. 

To set a light's Falloff in the Light Lab, enable one of the following options: No
Linear, Squared, or Ranged. Sel
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To define the Range of a light's Ranged Falloff: 
he Falloff area. 

ight to define a greater range or left to define a smaller 
nge or enter a value in the Amount field. The default Amount is 10 but can vary 

from 0 to 9999. 
 

1. In the Light Lab, enable the Ranged option in t
2. Drag the Amount control r

ra

 
Examples: 

• Falloff - None 
 

 
• Falloff - Linear 

 

 
• Falloff - Squared 
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• Falloff - Ranged = 10 
 

 
• Falloff - Ranged = 100 

 

 
• Falloff - Ranged = 200 
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• Falloff - Ranged = 1000 
 

 

Visible Lights 

Visible Lights make your light source visible in the scene, like the ball of light that 
appears around a lamppost on a foggy night. 
There are two types of Visible Lights: 

• Surface Visible Lights 
• Volume Visible Lights 

 

 
When you create a Surface Visible Light, the light from the object appears as a semi-
transparent shape extending from the light source. 
Surface Visible Lights have the same attributes as non-visible lights, so you can use the 
Edge Softness control to make the shape that extends from the light fuzzier at the 
edges, to give it a more realistic feel, or the Falloff options to adjust the range of the 
light. 
The properties within the light are controlled by the default Surface Material applied to 
the light object. The material can be edited in the Materials Lab. By changing the 
material, you can change the color of the light, the intensity of the light's color, and 

me Visible Light source, a preset Light-sensitive Volume 
ce 

many other properties. 
When you create a Volu
Material is applied to the light source. This makes the light coming from the light sour
appear visible in the scene, so in the case of a spotlight, the light would appear as a 
cone. The light also becomes volumetric and reacts to other lights around it. Objects 
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within the cone interact with the light. They can block it, reflect it, etc. Any textures
applied to the light also have volume. 
The material applied

 

 to the object is pre-defined for you, but you can edit its properties 
in the Materials Lab. By editing the material you can change the light's intensity, color, 

ight 
side 

erence between the two types of lights becomes apparent when you apply a 
ht. In Surface Visible Lights, the gel texture is wrapped around the light 

nsparent makes it look more real, but it doesn't make 

On the other hand, Volume Visible Lights create a real illuminated volume. The texture 
gel exists everywhere inside the cone, and the objects within the cone are directly 
affected by the texture. The light also interacts with the surrounding light sources. 

 first illuminated by a surface visible light (top) 

and transparency. 
When you create a Volume Visible Light source, the light emanating from the l
source is visible in the scene. This light has volume and interacts with the objects in
it. 
The real diff
gel to the lig
cone like a skin. Making it semi-tra
it interact fully with objects inside the cone. 

In this example, the same objects were
and then a volume visible light (bottom). 

  
It's a good idea to choose to apply the Infinite Light option to both types of visible lights, 
as this option extends the light's range and gives the light a more realistic look. 
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Surface Visible Lights 

When you create a Surface Visible Light source, it appears as a semi-transparent 
in the scene. 
To create a Surface Visible Light: 

object 

1. Create a Light Source. 
 

 
2. Click the  button that appears next to the light's bounding box. The Light Lab 

appears. 
3. In the Render options area, enable the Visible Object and Surface options. A 

number of preset Surface material properties are applied to the light, creating a 
visible cone of light. 
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4. If you want to extend the light's range, enable
 

 the Infinite Light option. 

 
 

 

Volume Visible Lights 

To create a Volume Visible Light:  
1. Create a Light Source. 

 

 
2. Click the  button that appears next to the light's bounding box. The Light Lab 

3. In the Render options area, enable the Visible Object and Volume options. A 
number of default Volume material settings are applied to the light source 
creating a softer visible cone of light. 
 

appears. 
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4. If you want to extend the light's range, enable the Infinite option. 
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Editing Visible Light Materials 

The materials applied to a Visible Light control many of its properties. Although these 

y to the light's material will appear as gels. 
 Visible Lights, the light's material is a Surface material. For a Volume 

materials can be edited, just like any other object's material, you should keep in mind 
that when you're editing a light's material in the Materials Lab, you're changing how the 
light source will appear in the scene. 
Any texture components you appl
For Surface
Visible Light the material is a Volume Material. 
Refer to "Surface Material Channels" for more on editing Surface materials and "Volume 
Material Channels" for more on editing Volume materials. 

Applying Gels 

Gels are filters placed directly in front of lights to change the colors cast by the light or to 
cast specific kinds of shadows. 

 
In Bryce, you can use any image or procedural texture as a Gel. Once you've assigned 
a Gel to a light source, you'll be able to see the pattern of the Gel on any object it shines 
on. For example, if you apply an image to a Square Spotlight, you can create a slide 
projector. You can apply an unusual texture across your entire scene by assigning a 

Using an Image as a Gel 

To use an image as a Gel: 
1. In the Light Lab, enable the Use Gel option. 

 

Texture Gel to a Radial Light. 
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2. Click the Image button. 
 

 
 
The Picture Editor appears. 

3. Choose an image from the Picture Library or click the Load button and load an 
image. Refer to "Pictures Editor" for more on the Picture Load dialog. 
 

 
4. Click the OK icon to close the dialog. The picture is applied as a Gel. 

 

 
When you apply a Gel to a Visible Light, the texture's pattern is visible throughout the 
visible light. 
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* Image Gels used are from the gel packages by Alex Aurichio. 

n Procedural as a Gel 

xture. 
 in the 

If you selected a color other than white in the Light Lab, that color overrides colors from 
Texture Gels. However, the luminance patterns are still used. 
To use a procedural texture as a Gel: 

1. In the Light Lab, enable the Use Gel option. 
 

Using a

To use a procedural texture as a Gel, you must select a preset that contains a te
Preset materials that contain only color or optic information (such as many found
Misc > Basic category) will have no effect. 

 
2. Click the Procedural button. 

 

 
 
The Materials Lab appears. 
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3. Select a material from one of the categories available. 
 

 
4. Click the OK icon to close the dialog. The texture in the material is a

g
 

pplied as a 
el. 

 
 

 

Saving Light Settings 

ts. 

time. When you no longer need a configuration 
of light settings, you can delete it. 
The leftmost dot, slightly separated from the rest, is a quick way to return to the default 
Bryce sky. 
There is no way to clear this dot. It will always contain the default light settings. 

You can save up to five light settings using Memory Dots. This feature lets you 
experiment safely with various light attributes without losing your favorite light effec
You can switch between different saved light settings to compare them. Also, you can 
reset the light settings to default at any 
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Memory Dots are saved with the scene, but not between sessions, so you may want to 
save your favorite lights as presets before ending a Bryce session. 
When you click on a full dot to activate it, the saved setting becomes the current Light. 
When you no longer need a saved light setting, you can delete it by clearing the dot it is 
saved to. 

• To save a light setting to a memory dot, click an empty dot. 
• Empty dots appear gray -  
• Full dots appear green (blue in Bryce 5/5.5, teal in Bryce 3/4) -  

• To return to the default light, click the far left memory dot. The light returns to the 
default, regardless of how many changes you've made. 

• T
• Active dots appear blue with a white dot in the middle - 
 o switch between saved light settings, click a full (green) dot. 

 
• To clear a full dot, Opt/Alt+click a full dot. The dot turns gray and 

setting can be saved to it. 
a new sky 

Positioning Lights 

Light wireframes can be edited exactly like any other object, either directly in the scene 
using its bounding box or indirectly using the tools in the Edit palette.  
Refer to "Repositioning Objects" for more on positioning objects. 

Linking & Tracking with Lights 

Since lights act just like other objects, you can link them to other objects or have them 
track other objects in the scene. 
In an animation, lights that track an object can create some very complex lighting 
effects.  
Refer to "Animating Techniques" for more on linking and tracking. 

ights 

by using the Animation Controls in the Light Lab. For example, 
ate a light's edge softness and intensity.  
ation

Animating L

You can animate lights 
you can anim
Refer to "Anim " for more on the animation controls. 
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Tree Lab 
The Tree Lab lets you control the various attributes of tree objects. Using the tree lab, 

nk, branches, and foliage of a tree object to achieve a particular 
t access the Tree Lab unless you have a tree object in your scene. 

aces the screen and displays the currently 
the Tree Preview. 

he Tree Lab 

 Lab: 
ct in your scene. 

you can edit the tru
look. You canno
When the Tree Lab opens, it temporarily repl
selected tree object in 

Accessing t

To access the Tree
1. Select a tree obje
2. Click the  icon that appears next to its bounding box or choose Objects > Edit 

enu bar. The Tree Lab appears. Object from the M
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Editing Trees 

In Bryce 5, the ability to create organic tree shapes was added. This lets you add 
realistic or fantasy trees to your scenes. You can then customize your trees in the Tree 
Lab by assigning materials, controlling the shape of the trees, and more. 
Trees have four essential components: the overall shape, the trunk, the branches, and 

criteria. For example, the 
sugar maple has an almost spherical silhouette; a poplar tree has a cylindrical shape 

f the tree; however, different species 
e different widths when mature. A birch tree, even when quite old, will not 

have as wide a trunk as an oak tree of the same age. The texture of the trunk can also 
be a good indicator of the species or age of the tree; the trunk generally becoming 
coarser with age. 
The characteristics of branches, such as their thickness, how the branches are 
arranged on the trunk, how they are positioned relative to each other, and how they are 
affected by gravity can also vary greatly between species. For example, a weeping 

the foliage. How these elements are shaped and organized around each other defines 
the appearance of the tree. 
The overall shape of trees varies greatly between species. In general, trees have 
several feet of trunk before they begin to branch out, and the branches eventually form 
a crown. The shape of the tree can vary greatly within these 

that tapers to a point at the top; and conifers such as pine trees have a triangular shape. 
The width of the trunk generally indicates the age o
of trees hav
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willow tree has bra
gravity bends them towards the ground, gi

nches that begin growing upwards from the trunk but are so thin that 
ving the tree a distinctive, drooping 

appearance. Some species of conifers have symmetrically spaced and sized branches, 
giving them a very geometric appearance. 
Finally, the foliage of the tree is probably the most obvious indicator of species. Species 
of trees have greatly varying leaf shapes and colors. Oak and ginkgo trees are both 
easily recognized by the distinctive shape of their leaves. 
The variations in trees are virtually limitless. You need only look at the wide variation 
found in nature for inspiration when creating and customizing trees in Bryce. 

Min/Max Sliders 

The Tree Lab uses a unique kind of slider for setting some of the attributes of the trunk 
and branches. These sliders, called Min/Max sliders, let you set both the minimum and 
maximum values for an attribute using the same slider. 

 
Bryce will choose a random value between the specified minimum and maximum when 
generating the tree. 

 value, drag the arrow below the Min/Max slider to the desired 
set to less than the Min slider. 

To set the maximum
value. The Max slider cannot be 

 
To set the maximum value numerically: 

1. Click the field to the right of the Min/Max slider. 
2. Type a value in the field. 

 

 
3. To set the minimum value, drag the arrow above the Min/Max slider to the 

desired value. The Min slider cannot be set to more than the Max slider. 
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To set the minimum value numerically: 
1. Click the field to the left of the Min/Max slider. 
2. Type a value in the field. 

 

 

A Quick Tour of the Tree Lab 

 
anches.  

ts the tree.  
ge: lets you control the overall shape of individual leaves, the scale and 

number of leaves, the distribution of the leaves, and the materials used for the 
leaves. 

The Tree Lab is divided into four sections: 
• Tree Preview: lets you preview changes to your tree. 
• Branch/Trunk: lets you control the size of the tree trunk; the placement, number,

and thickness of branches; and the materials used for the trunk and br
• Tree: lets you control the overall shape of the tree, the randomness of the tree, 

and how gravity affec
• Folia

 

©2007 DAZ 3D, Inc.  1078 



Bryce 6 Artist Guide 

Branch/Trunk Settings 

You can use the Branch/Trunk settings located on the left side of the Tree Lab to control 
the thickness of the trunk and branches, the distribution of branches around the trunk, 
the number of segments, the number of branches per segment, the starting and ending 
angles of the branches, and the texture used for the trunk and branches. 

 

Trunk Thickness 

The Trunk Thickness slider lets you specify a minimum and maximum width of the 
trunk, from 1 to 200. The minimum width controls the thickness of the twigs at the 
outermost reaches of the tree while the maximum width controls the base of the tree. 

 
To set the maximum trunk thickness, drag the arrow below the Trunk Thickness slider to 
the desired value, or type a value in the field to the right of the slider. The maximum 
trunk thickness can be set from 1 to 200 but cannot be set thinner than the minimum 
trunk slider. 
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To set the minimum trunk thickness, drag the arrow above the Trunk Thickness slider to
the desired value or type a value in the field 
thickness can be set from 1 to 99 but c

 
to the left of the slider. The minimum trunk 

annot be set thicker than the maximum trunk 
slider  

 
Examples: 

• Minimum = 1, Maximum = 148 
 

  
• Minimum = 

as the minim
99, Maximum = 148 - notice how the upper sections became thicker 
um slider increased 

 

  

Branch Thickness 

 Thickness slider lets you specify a minimum and maximum percentage 
es, from 1 to 100. This setting doesn't control the actual width of the 

ild branches. For example, if the branch 

The Branch
width for the branch
branches; it is the percentage width of ch
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thickness is set to 50%, each child branch will be 50% of the width of the parent branch 
it is spawned from. 

 
To set the maximum branch thickness, drag the arrow below the Branch Thickness 

e or type a value in the field to the right of the slider. 
nch thickness, drag the arrow above the Branch Thickness 
e or type a value in the field to the left of the slider. 

 Maximum = 50 

slider to the desired valu
To set the minimum bra
slider to the desired valu
Examples: 

• Minimum &
 

  
• Minimum = 70,

 
 Maximum = 95 
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Number of Segments 

 tree is divided into a number of segments. Each segment is a 
nt" branch where "child" branches will be formed. The number of 

Each branch of the
location on a "pare
segments can be set from 1 to 20. 

 
To set the maximum number of segments, drag the arrow below the Segments slider to 
the desired value, or type a value in the field to the right of the slider. 
To set the minimum number of segments, drag the arrow above the Segments slider to 
the desired value, or type a value in the field to the left of the slider. 
Examples: 

• Segments = 6-10, Branches per Segment = 4-7 
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• Segments = 7, Branches per Segment = 4 
 

 
• Segments = 10, Branches per Segment = 4 

 

 

Branches per Segment 

r lets you specify how many "child" branches will be 
egment. 

The Branches Per Segment slide
formed in each branch s
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To set the maximum number of branches per segment, drag the arrow below the 
Branches Per Segment slider to the desired value, or type a value in the field to the right 
of the slider. The maximum number of branches per segment can be set from 1 to 20. 

er Segment slider to the desired value, or type a value in the field to the left 
. The minimum number of branches per segment can be set from 1 to 4. 

• Segments = 6-10, Branches per Segment = 4-7 
 

To set the minimum number of branches per segment, drag the arrow above the 
Branches P
of the slider
Examples: 

 
 

 

©2007 DAZ 3D, Inc.  1084 



Bryce 6 Artist Guide 

• Segments = 7, Bran
 

ches per Segment = 4 

 
• Segments = 10, Branches per Segment = 4 

 

 

Branch Angles 

The starting and ending angles for branches help determine the overall shape of a tree. 
The branch start angle is the angle of the branch at the thickest part of the tree. The 
slider can range from 0 to 180. 
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The branch end angle is the angle of the branch at the thinnest part o
slider can range from 0 to 180. 

f the tree. The 

 
To set the branch start angle, drag the Branch Start Angle slider. Drag right to increase 
the angle and left to decrease it. 
To set the branch end angle, drag the Branch End Angle slider. Drag right to increase 
the angle and left to decrease it. 
Examples: 

• Branch Start Angle = 25, Branch End Angle = 50 
 

 
• Branch Start Angle = 50, Branch End Angle = 50 
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• Branch Start Angle = 75, Branch End Angle = 75 
 

 
• Branch Start Angle = 75, Branch End Angle = 150 
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Trunk and Branch Texture 

; 
You can use a uniform color, an image, or a material as the texture for the trunk and 
branches of a tree. All the branches and the trunk of the tree will have the same texture
you cannot vary the texture for the branches and the trunk. 

 
To use a uniform texture: 

1. Click the Uniform button at the bottom of the Branch/Trunk section. 
 

 
2. Click the Uniform Color swatch and choose a color from the color picker. 

 

 
To use an image texture: 

1. Click the Image button at the bottom of the Branch/Trunk section. 
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2. Click the Edit button to the right of the Image button. The Pictures Editor 
appears. Refer to "Pictures Editor" for more on the Pictures Editor. 
 

 
To use a material texture: 

Trunk section. 
 

1. Click the Material button at the bottom of the Branch/

 
2. Click the Edit button to the right of the Material button. The Materials Lab 

appears. 
 

 
3. Select a material from the lab and click on the OK icon to return to the Tree Lab. 

Tree Settings 

You can use the tree shape settings to set the overall shape of a tree and how the tree 
is affected by gravity. You can set the amount of randomness for the tree, ensuring that 
even with the same settings, no two trees will look alike. You can also use the Tree 
Lab's memory dots to store settings as you experiment with different tree attributes. 
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Tree Shape 

The overall shape of a tree varies greatly for different species of trees. Using the Shape 
drop down list, you can choose a species of tree for the overall shape of the tree. 

, click the Shape drop down list and choose a species of 1. To choose a tree shape
tree. 
 

 
2. You can also select a tree shape by pressing Opt/Alt and clicking on the Default 

button. 
 

 
3. The Open file dialog will come up where you can navigate to the 

Presets/Treeshapes/Installed folder and select a tree shape. 
 

 
There are 60 tree shapes available: 

• Acacia 
• American Plum 
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• Apple 
• Aspen 
• Austrian Pine 
• Bald Cypress 
• Bamboo 

 

• Birch 
• Black Walnut 
• Cedar of Lebanon 

• Common Ash 
• Common Holly 
• Common Juniper 
• Common Lime 
• Date Palm 
• Dogwood 
• Douglas Fir 
• Elm 
• Eucalyptus 
• Fir Tree 
• Giant Sequoia 
• Ginkgo 
• Hemlock 
• Hornbeam 
• Horse Chestnut 
• Italian Cypress 
• Japanese Maple 
• Joshua Tree 
• Magnolia 
• Mangrove 
• Monkey Puzzle 

• Baobab 
• Basswood 
• Beech 

• Coconut Palm 
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• Mountain Ash 
• Norfolk Island Pin
• Norway Maple 

e 

 ed Oak 
• Rhododendron 
• Russian Olive 
• Sassafras 
• Scotts Pine 
• Seagrape 
• Silver Maple 
• Spruce 
• Sugar Maple 

• White Pine 
• Yew 

Gravity 

The branches and leaves of a tree can be affected by gravity. When gravity is high, the 
branches of a tree will droop and the leaves will be oriented towards the ground. When 
gravity is low, the same branches may be more upright, and the leaves may be oriented 
in all directions. The Gravity slider lets you specify how much gravity will be applied to a 
tree. The slider can be set from 0 to 100. 

• Norway Spruce 
• Papaya 
• Poplar 
• R

• Sumac 
• Sweet Gum  
• Sycamore 
• Tamarack 
• Tulip Tree 
• Weeping Willow 
• White Cedar 
• White Oak 
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To set the gravity amount, drag the Gravity slider right to increase the amount of gravity 
and left to decrease it, or enter a value in the field. 
Examples: 

• Gravity = 5 
 

 
• Gravity = 25 
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• Gravity = 5
 

0 

 
• Gravity = 100 

 

 

Randomness 

Trees in nature are not perfectly shaped. Two trees of the same species growing under 
identical conditions will vary greatly from one another. In Bryce, you can control the 
randomness of a tree so that, even with the identical settings, no two trees will be 
identical. 
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The randomness sett
set from 0 to 100. 

ing affects both branch angles and leaf angles. The slider can be 

 
To set a value for randomness, drag the Randomness slider right to increase the 

ree will not activate the randomness. 

amount of randomness and left to decrease it, or enter a value in the field. 
Once the randomness has been set, the tree will need to be saved to the tree presets 
folder since copying or duplicating the t
See "Saving Tree Presets" and "Access Pre-Generated Trees" for information on how to 
save and use tree presets. 
Examples: 

 

Foliage Settings 

You can use the foliage settings to control the appearance of the leaves on a tree. 
Using the foliage settings, you can choose a leaf shape, size, and quantity, and 
determine how the leaves are distributed on the branches. You can also specify a 
texture for the leaves. 
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Foliage Shape 

The leaves of different species of trees have different shapes. The Shape setting l
you choose a leaf shape from a drop down list. 

ets 

 1. To choose a leaf shape, click the Shape drop down and choose a species of tree
from the list. 
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2. You can also select a leaf shape by pressing Opt/Alt and clicking on the Default 
button. 
 

 
3. The Open file dialog will come up where you can navigate to the 

Presets/Leaves/Installed folder and select a leaf shape. 
 

 
There are 61 foliage shapes available: 

• Acacia 
• American Plum 
• Apple 
• Aspen 
• Austrian Pine 
• Bald Cypress 
• Bamboo 
• Baobab 
• Basswood 
• Beech 
• Birch 
• Black Walnut 
• Cedar of Lebanon 
• Coconut Palm 
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• Common Ash 
• Common Holly 

 

• Date Palm 
• Dogwood 
• Douglas Fir 
• Elm 

• Mountain Ash 
• Norfolk Island Pine 
• Norway Maple 
• Norway Spruce 

• Scotts Pine 
• Seagrape 

• Common Juniper 
• Common Lime 

• Eucalyptus 
• Fir Tree 
• Giant Sequoia 
• Ginkgo  

• Hemlock 
• Hornbeam 
• Horse Chestnut 
• Italian Cypress 
• Japanese Maple 
• Joshua Tree 
• Magnolia 
• Mangrove 
• Monkey Puzzle 

• Papaya 
• Poplar 
• Red Oak 
• Rhododendron 
• Russian Olive 
• Sassafras 
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• S ilver Maple 
• Spruce 
• Sugar Maple 
• Sumac 
• Sweet Gum 

 eeping Willow 
• White Cedar 
• White Oak 
• White Pine 
• Yew 

You can control the size of the leaves on a tree using the Scale slider. The Scale slider 
 of the size of the tree. The slider can 

be set from 1 to 20. 

• Sycamore 
• Tamarack 
• Tulip Tree 
• User Leaf 
• W

Foliage Scale 

measures the size of the leaves as a percentage

 
To choose the size of leaves, drag the Scale slider. Drag right to increase the scale and 
left to decrease it. 
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Examples: 
• Scale = 5 

 

 
• cale = 10 

 
S

 
• Scale = 15 
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• Scale = 20 
 

 

Num eb r of Leaves 

The Number of Leaves slider lets you choose how many leaves will appear on each 
branch. 

 
To set the number of leaves, drag the Number of Leaves slider right to increase the 
number of leaves and left to decrease the number of leaves, or enter a value in the field. 
The slider can be set from 0 to 20. 
The number of leaves along with the scale will directly affect the length of the branches. 
Examples: 

• Scale = 4, Number = 7 
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• Scale = 8, Number = 15 
 

 
• Scale = 10, Number 10 

 

 
• Scale = 15, Number 5 
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Foliage Distribution 

In nature, different species of trees have di
have leaves that are c

fferent arrangements of leaves. Some trees 
lustered together while others have leaves that spiral around a 

branch in an almost symmetrical pattern. Bryce offers five different leaf arrangements: 
Stacked, Staggered, Spiral, Bunched, and Coniferous. 

 
To choose a leaf distribution, click the button beside one of the following options

• Stacked: leaves are arranged in pairs on eac
odd numbe

: 
h side of the branch. If there is an 

r of leaves, a single leaf will be placed at the tip of the branch.  
umber 

f leaves, a single leaf will be placed at the tip of the branch.  
• Spiral: leaves are arranged around the branch in a spiral formation.  Bunched: 

leaves are clustered at the tip of the branch. 
• Coniferous: leaves are placed along the middle of the branch.  

The image below shows examples of the different distribution options. 

• Staggered: leaves alternate on each side of the branch. If there is an odd n
o

 

©2007 DAZ 3D, Inc.  1103 



Bryce 6 Artist Guide 

Please note that on trees that are densely populated with branches, segments, and/or 
leaves, the difference between some distribution options may not be very obvious. This 
is especially true for the staggered and spiral options. Decreasing the number of le
or their scale will make the difference more obvious. 

Foliage Texture 

aves 

aterial as the texture for leaves of a tree. 
 you cannot vary the texture of leaves. 

You can use a uniform color, an image, or a m
All the leaves will have the same texture;

 
To use a uniform texture: 

1. Click the Uniform button at the bottom of the Foliage section. 
 

 
2. Click the Uniform

 
 Color swatch and choose a color from the color picker. 

 
To use an image texture: 

1. Click the Image button at the bottom of the Foliage section. 
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2. Click the Edit button to the right of the Image button. The Pictures Editor 
appears. Refer to "Pictures Editor" for more on the Pictures Editor. 
 

 
To use a material texture: 

1. Click the Material button at the bottom of the Foliage section. 
 

 
2. Click the Edit button to the right of the Material button. The Materials Lab 

appears. 
 

 
3. Select a material from the lab and click on the OK icon to return to the Tree Lab. 

You can only change the material of the leaves if you access the Materials Lab through 
ct a tree and access the Materials Lab or the Materials Preset 

Library from the Edit palette and choose a material, the material will only be applied to 

Saving Tree Lab Settings 

ory dots appear at the bottom of the Tree Lab. 

d Tree Lab setting, click on a full dot (full dots are green). The 

Lab settings to default, in the Tree Lab, click the leftmost memory dot. 
This dot always appears full. 

the Tree Lab. If you sele

the trunk and branches of the tree. 

The memory dots in the Tree Lab let you store your favorite Tree Lab settings. Using 
these dots you can safely explore many Tree Lab configurations without losing your 
favorite settings along the way. Mem
To save Tree Lab settings, in the Tree Lab, click on an empty dot (empty dots are gray). 
All the current Tree Lab settings are stored in the selected dot. 
To switch to a save
current settings are replaced with the settings stored in the dot. An active dot will be 
green with a white point inside it. 
To reset Tree 
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To delete a saved Tree Lab setting, Opt/Alt+click on a full memory dot. The leftmost dot 
cannot be cleared. 
Tree settings can be saved permanently using the Create palette. 

Animation 
n is the process of adding a fourth dimension to your scene - time. To create 

an animation, you arrange a scene then record your movements or transformations of 
objects over time. Bryce creates a motion path from your recorded movements and then 
generates an animation.  

ene: the motion of objects and the camera, 
perties. 

The Animation Process 

 and Bryce. You arrange objects and 
nd then make adjustments to the objects and scene over time. 

1. Create objects using the Create tools.  
2. Build a scene by arranging and transforming objects, lights, and the camera. 
3. Adjust the position, orientation, or scale of objects. Each time you make an 

adjustment, you create a key event which indicates a point where an object 
property was changed.   

4. Adjust the shape or placement of the motion path.  
5. Adjust the speed at which the object moves along the motion path using the 

Advanced Motion Lab.  
6. Render the animation as a movie file.  
7. You can render the animation as a QuickTime/AVI movie file or as a set of 

frames.  

 events are tied to real-world time increments (minutes and seconds) 
rather than individual animation frames. This means that you can create key events at 

ut the number of frames in your final 
animation.  

frame rate, Bryce adjusts the number of the frames between 
key events to match the new frame rate. 

Animatio

You can animate almost anything in your sc
object size and shape, object materials, terrain objects, and sky pro

Animation is a cooperative process between you
choose scene settings, a
Bryce fills in the gaps between adjustments. When you play the animation, the illusion 
of motion is created.  
The steps to creating an animation are as follows:  

Time-Based Animation 

In Bryce, key

specific points in time without worrying abo

Bryce automatically creates all the frames necessary to move from one key event to 
another. If you change the 
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For example, let's say your frame rate is set to 15 fps (frames per second) and then you 
set up two key events, one at 1 second and the other at 2 seconds. Bryce automaticall
fills in the 15 frames necessary to move from the key event at 1 second to the key

y 
 event 

at 2 seconds. If you change the frame rate to 30 fps, Bryce will add another 15 frames 
ch the new frame rate. 

ect, Bryce creates a motion path which shows you 
the path the object will take as it moves from one key event to another.  
You can edit an object's motion path to adjust its trajectory throughout the course of the 
animation.  
Refer to "Editing Motion Paths

between the two key events to mat

Animation and Motion Paths 

As you change the position, of an obj

" for more on motion paths.  

 

Animatable Properties 

Each characteristic of an object or effect that can be animated is called a property. Most 
objects have many animatable properties. Properties like position, size, and orientation 
are common to all objects. Other properties are specific to certain types of objects. 
Lights have special properties like brightness, falloff, and gels.  
Skies have their own set of properties that control everything from cloud coverage to the 
time of day.  
The properties of individual objects can change depending on the material you apply. 
The color, texture, and density of an object can also be animated.  
Some properties can be animated directly in a specific editor. Object material properties 
can be animated from within the Materials Lab and terrain geometries can be edited 
from within the Terrain Editor.  

Properties in the Sequencer 

Every time you change an object's property, it appears as a key event in the animation's 
Sequencer. In the Sequencer, each property of an object can be viewed on a separate 
timeline. You can expand an object's listing to see all the transformations or changes 
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that have been applied to its properties. If y
on the object, it cannot be expanded. Refer

ou have not performed any transformations 
 to "Property Timelines" for a complete 

discussion of the Sequencer.  

ced Motion Lab is visible. If it's not, choose Objects > 
r click on the Motion Lab button.  

To expand a listing in the Sequencer:  
1. Make sure the Advan

Advanced Motion Lab o
 

 
2. Click on the object name to expand th

 
e listing.  

 

Creating Animations 

The Animation controls are the tools you'll use most often when creating animations. 
The palette provides tools for most of the basic animation functions:  

• viewing the timeline  
• moving the current time  
• setting the length of the animation   
• specifying the Working Area  
• previewing the animation   
• recording key events  
• adding/deleting key frames   

The Animation controls appear at the bottom of the Working window as well as in the 
Terrain Editor and the Materials Lab. 
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The Animation controls are made up of
• The Timeline, located at the top 

 three areas:  
of the palette, displays a visual representation of 

iew Controls, located below the Timeline, let you preview 

key frames. To display the Animation controls in the Working window: By 
are located at the bottom of the Working window.   

 

the time in your animation. The indicator on the timeline (called the Current Time 
Indicator) represents the current time.   

• The Animation Prev
your animation in the Working window.  

• The Key Frame Controls, located at the right edge of the palette, let you add and 
delete 
default the Animation controls 

 
If the Selection palette appears at the bottom of the window, click the Time/Selec
Palette toggle in the bottom-right corner of the Bryce window or press S. The but
switches between the Selection palette and the Animation controls

tion 
ton 

.   

 

Setting Up an Animation 

Before you start setting up key frames or adjusting the timeline, you should set up some 
general parameters for your animation.  
The Animation Setup dialog lets you set up the duration, the frame rate and whether 
you want to display animation time as SMPTE (i.e.; hours:minutes:seconds:frames) or 
frame numbers. See "Animation Setup" for more detailed information on the setup 
dialog.   
To set the duration of your animation numerically:  

1. Choose File > Animation Setup from the menu or double-click the Current Time 
Indicator.  
 

 
 
The Animation Setup dialog appears. 
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2. Click the Scale button. This switches to the Duration fields to set the duration of 
your animation.  
 

 
3. In the Duration fields, enter the total length of your animation in hours, minutes,

seconds and frames. When you enter a duration, Bryce auto
 

matically calculates 
the n mber o n the current frame rateu f frames in the animation, based o . The 
number of frames is displayed in the Frame # field.  
 

 
4. Click on the OK icon to close the dialog.  

y of your 
r but may produce motion which is 

 much smoother motion.  
d enough 

Setting the Frame Rate 

The frame rate for your animation can have a large impact on the final qualit
rendered movie. A low frame rate is faster to rende
more jumpy, while a higher frame rate produces a
Bryce displays frames as frames per second (fps). Fifteen fps is usually goo

30 fps is standard for broadcast-quality for motions displayed on a computer while 
video.   
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To set the frame rate for your animation:  
u or double-click the Current Time 1. Choose File > Animation Setup from the men

Indicator (also called a Scrubber).  
 

 
 
The Animation Setup dialog appears. 

2. Enter a frame rate in the FPS field.  
 

 
3. Click on the OK icon to close the dialog.  

Animation Tools 

Bryce's animation tools are designed to help you animate the properties of your scene.  

Animation Controls 

The Animation Controls let you record an animation and preview it in the Working 
window. You can also use the controls to change the current time or move to different 
points in time.  
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The Timeline appears in four
the Sky Lab, and the Materia

 places in Bryce: the Working window, the Terrain Editor, 
ls Lab.  

an 
e, 

h terrain properties.  
When you preview a timeline in the Working window, you'll be able to see all the 

The Timeline is a graphical representation of time.  

All four timelines represent the same time. The only difference is that when you're in 
editor, you can only add frames for properties associated with that editor. For exampl
in the Terrain Editor you can only add key frames associated wit

changes in your scene, including any changes you may have made in other editors or in 
the Advanced Motion Lab.  

The Timeline 

 
The light blue colored section of the Timeline represents the length of the Working Area. 
The Working Area can be used as a visual guide to help you isolate portions of your 
timeline.  
The dark blue colored section of the Timeline represents the current length of your 

 render the entire timeline or just the 
Working Area. When you use the animation preview controls, only the Working Area is 

Refer to "

animation.  
When you render the animation you can choose to

previewed.  
Setting Up the Working Area" for more on the Working Area.  

Th  you move to different points in 
time. This is the main tool you'll use to 
ke

e Current Time Indicator, also called the Scrubber, lets
create animations. Every time you want to add a 

y event, you move the Current Time Indicator to a different point on the timeline.  
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Working with Time 

n the Timeline is called the Available Time Area and it represents all 
limited; you can scroll the time area infinitely.  

The light gray area i
time. This area is un

 
The white tick marks within the Timeline are visual cues that let you know when the time 
area is moving. If you move the Current Time Indicator off the screen, you'll see these 
white ticks move along the time area.  
To scroll the time area, drag the Current Time Indicator off the screen to the right. You'll 
see the white tick marks move along the time area to the left.  

 

Setting Animation Range in the Timeline 

 
e 

Setting the Animation Range in the Timeline The dark blue within the light gray area of 
the Timeline represents the total length of your animation. This area is usually hidden by
the Working Area, so you may need to shorten the Working Area to adjust th
Animation Range.  

 
The Animation Range is automatically generated as you set up key events. The time of 
the final key event automatically creates the limit of the Animation Range. However, you 
can manually extend or shorten the area to set the range of your animation. You cannot 
shorten the Animation Range below the last frame in the scene since you can't have 
frames outside the Animation Range.  
To manually set the Animation Range, in the Timeline, drag the handle that appears at 
the end of the Animation Range to the point where you want the animation to end. The 
handle may be obscured by the Current Time Indicator, so you might have to move the 
indicator to a different position in order to see it.  
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Setting Current Time for an Animation 

The large green handle in the Timeline is called the Current Time Indicator (commonly 
called a Scrubber). It sets the current time of the animation.  
The Current Time Indicator is the most important tool of the Animation controls. When 
you're creating key events, the Current Time Indicator controls when the key event 
occurs in the animation. Refer to "Recording Key Events" for complete instruction on 
creating key events.  
As you move the Current Time Indicator, the Text Display Area shows you the current 
time. If you're using SMPTE time, the current time is displayed as 

ou Hours:Minutes:Seconds:Frame # (such as 00:01:25:13). The Frame # changes as y
change the frame rate for the animation. For example, at 15 fps Bryce will insert 15 
frames within each second.  

 
If you're using Frame Count, the number of the current frame is displayed.   

 
You can also move to a specific point in time using the Animation Setup dialog. In this 
dialog, you can move to either a specific time or frame.  
To move to a specific frame manually:  

1. Drag the Current Time Indicator along the Timeline. As you drag, watch the Text 
Display Area. You'll notice that the final number cycles through each frame in the 
second of animation time. So at 15 fps the final number will cycle through frame 
0-14 between seconds.  

2. Release the mouse button when the Frame # reaches the desired frame. 
The Current Time Indicator also controls which portion of your animation is being 
displayed in the Working window. 
When the indicator is at the beginning of the animation, you're seeing the first frame of 
the animation in the Working window. When you move the indicator, the Working 
window displays a different portion of the animation. So, when you move the indicator to 
the center of your animation range, you're seeing what the animation looks like at the 
middle of the movie.  
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To move the current time manually: 
1. Drag the Current Time Indicator along the Timeline.  

Setup. The Animation Setup dialog appears.   
frame you want to 

he number of the frame located at the 

2. Release the mouse button when the Text Display Area shows the desired time. 
To move the current time numerically: 

1. Choose File > Animation 
2. In the Current fields, enter the hour, minutes, seconds and 

move to. The Frame # field displays t
specified time.   
 

 

Time Dots 

The Time Dots let you save positions on the timeline. You can use the dots to quickly 
as of the timeline you're working on.  

To save the position of the Current Time Indicator: 
jump between are

1. Move the Current Time Indicator to the position you want to save.   
2. Click on an empty Time Dot at the bottom of the Animation controls. A dot is 

empty when it appears white.  
 

 
To move the Current Time Indicator to a saved position, click the Time Dot for the 
position you want to use. The current position appears green with a white dot.  

s Opt/Alt+click on a full Time Dot. A full dot appears To delete a saved position, pres
green.  
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Setting Up the Working Area 

The light blue portion of the Timeline represents the Working Area. This area highlights
the portion of the timeline you're currently working on.  

 

 
When you're previewing your animation, only the portion of the timeline within the 
Working Area is previewed.  
The Working Area is most useful when you're working on a long animations as it saves 
on preview time or when you're refining a specific portion of your animation.  
When you're rendering the animation, you can choose to render the entire animation or 
just the Working Area portion. 
You can also use the Working Area to rende out sections of the timeline while you're 

g Working Area.  

r 
setting up the animation, and then render the entire Animation Range when you're 
creating the final animation.  
To set the range of the Working Area manually: 

1. Click+drag either end of the existin
 

 
2. Release the mouse button when the Working Area is the desired length. The 

Working Area cannot be extended past the end of the Animation Range.  
 

 
To set the range of the Working Area numerically: 

.  
 

1. Choose File > Animation Setup or double-click the Current Time Indicator
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The Animation Setup dialog appears.  

2. Click the triangle icon at the top-left of the dialog and choose Working Range 
Low from the menu.   
 

 
3. Enter the starting time for the Working Range.   

 

 
4. Click the triangle icon again and choose Working Range High. 

 

 
5. Enter the ending time for the Working Range.  

 

 
6. Click on the OK icon to close the dialog.  
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Setting Timeline Scale 

The Scale Indicator at the right edge of the timeline let you adjust the scale the timeline
If you have a very long Timeline, you can use this control to scale it down so you can 

. 

If you have a very short timeline, you can use the 
 across the length of the palette.   

see the whole timeline at once. 
control to scale it up so it extends

 
To set the scale of the Timeline, drag the Scale Indicator.  

• Drag right to increase the scale.  
 

 
• Drag left to decrease the scale.  

 

 
The scale of the Timeline does not affect its length, only how it's displayed in the 
Animation Controls.  

Scaling Animation Duration 

tain 
amount of time. For example, if you created an animation that's five seconds long but 

 three seconds, you can scale the entire animation to last only 

ents 
take longer to complete. If you decrease the scale, the events 

are compressed so the action speeds up.  
To set the scale of the entire animation manually:  

1. Hold down Opt/Alt+drag the Animation Range Handle.  
 

You can adjust the length of your animation, by scaling its duration to fit within a cer

only want it to take up
three seconds.  
When you scale the animation, all the events in the animation are compressed or 
stretched to fit within the desired amount of time. If you increase the scale, the ev
are stretched out, so they 
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2. Release the mouse button when the duration of the animation is the desired 
length.  
 

 
To scale the animation numerically: 

1. Choose File > Animation Setup or double-click the Current Time Indicator.  
 

 
 
The Animation Setup dialog appears.   

2. Click the Scale Animation button.  
 

 
3. Enter the desired animation duration in the Duration fields.  
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4. Click on the OK icon to close the dialog.  

ty 
corded as a key event. A key event can store any change in size, 

a key event can only store one change per property at a specific point in time 
for each object in the scene. This means that at a single point in time, you can only 

the same point in time, the new changes 
replace existing changes. Only the last change you perform is recorded as the key 
event. To record more than one change in the same object's property you have to move 
to a different point in time. Then each change can be recorded as a separate key event 
and applied to the animation.  
For example, if you move an object up and down at the same point in time, only the last 
transformation is recorded as the key event. However, if you move the object up at one 
point in time and then move the object down at a different point in time, both 
transformations are recorded.  
When Auto-Record mode is disabled, the animation system is off. This means that your 
changes are not recorded as key events and changes in the Timeline do not affect your 
view in the Working window.  
You can continue changing object and scene properties, but they won't be recorded as 

ing or transformation you'll have to manually add 

Recording Key Events 

You can record key events by either enabling the Auto-Record mode or manually 
adding key frames.  
When you enable Auto-Record mode, every object transformation or change of proper
you perform is re
position, orientation, material property, sky property, light property or geometry. 
However, 

have one change in position, size, material, or geometry per object recorded as a key 
event.  
If you keep changing the same properties at 

key events. If you want to record a sett
a key frame using the Add Frame button.  
Refer to "Auto-Record Mode" for enabling the automatic animation system. 
Refer to "Adding & Deleting Key Frames" for more on manually adding and deleting 
frames. 

Key Frame Controls 

The Key Frame Controls let you add and delete key frames in your animation.  
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The Key Frame Indicator is only active when the current time is at a key frame.  

 

Auto-Record Mode 

The Timeline options menu, located at the right edge of the controls, lets you enable or 
disable Bryce's automatic animation system.  

 
To enable or disable Auto-Record mode:  

e right of the controls and choose Auto-Key.  
 

1. Click the triangle icon to th

 
2. The animation system is on when the option has a checkmark next to it.   

 

 
3. Choose the Auto-Key option again to turn off the automatic animation system.  

Adding & Deleting Key Frames 

Adding & Deleting Key Frames 

Usually you use the Auto-Record mode to add key frames to your animation, but there 
are some cases when you would need to force the system to create a key frame. For 
instance, if you accidentally make a number of changes while Auto-Record mode is 
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disabled, you'll have to create a key frame to store your changes or they'll be discarded 
when you move to a different point in time.  

Adding Key Frames 

The Add Key Frame (plus) button lets you add a key frame.  

 
When you are in Camera View, with nothing selected, the Add Key Frame automatically 
key frames the camera. In Director's View, it does not. It also keys the sky.  
In Auto-Key mode, Bryce automatically adds key frames for you but when you disable 

 timeline.  
 property for the 

selected object. If you have nothing selected, Bryce only records the changes in the sky 
(i.e., changes you make in the Sky & Fog palette).  
You can also modify the Add Key Frame operation so that, for a selected object, only a 
specific property is recorded as a key event.  
To add a key frame:  

1. Move the Current Time Indicator to the point where you want to add a key frame   
 
or  
 
If you need to force Bryce to overwrite an existing key frame, leave the Current 
Time Indicator where it is.   
 

the mode, you'll have to use Add Key Frame to add key frames at points in the
If you have an object selected, Bryce only records the changes in

 
2. Make any changes needed to the scene for the next key frame. 
3. Click the Add Key Frame button. Any changes you made above are recorded in 

the key frame.  
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To add a frame for a certain property: 
1. Select an object and make the necessary changes for the next key frame. 
2. Hold down the mouse button over the Add Key Frame button and choose an 

 
object property from the menu that appears.   

 
3. To add a key frame for sky properties: Make sure there is nothing selected and 

click the Add Key Frame button. or Hold down the mouse button over the Add 
Key Frame button and choose Sky from the menu.  
 

 
4. Follow the menu arrow to key frame a specific sky property.  
5. Repeat to add key frames for the camera and sun. 

Deleting Key Frames 

The Remove Keyframe button deletes the current key frame event or a specific type of 
key event.  

 
In the Working window, deleting a key event deletes all the frames at the current time. 
In the editors the Remove Keyframe button only deletes key events for the properties 
associated with the current editor.  
As with adding frames, Bryce deletes frames differently based on your current selection. 
If you have an object selected, Bryce only deletes the changes in property for the 
selected object. If you have nothing selected, Bryce deletes the changes recorded for 
your scene's sky.  
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You can modify the Delete 
object property is deleted. A

Key Frame button's function so that only a certain type of 
dding or deleting frames will effect the shape of an object's 

to move through the key frames until you 
nd the frame you want to delete.  

motion path.  
To delete a key frame:  

1. Use the Animation Preview Controls 
fi
 

 
2. Click the Remove Keyframe button.  

 

 
 
All the properties recorded at that point in time are deleted.  
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To delete a frame for a specific object property: 
1. Select an object. 
2. Hold down the mouse button over the Delete Key Frame button and choose the 

object property from the menu that appears.  
 

 
To delete all keyframes at once (PC only), press Ctrl+Shift+Alt and click on the Remove
Keyframe button. This will delete a

 
ll keyframes for all objects, materials, skies, terrains, 

etc. with no option to get them back unless you revert to the saved version or open a 
backup file. 

When you add a frame in the editors, only the properties associated with the editor are 
recorded as a key frame.  
When you delete a frame in the editors only the properties associated with the editor are 
deleted. For example, if you delete a frame that contains position, material, and scale 
data in the Materials Lab, only the material data is removed from the key frame.  

Previewing Animations 

You can preview your animations using either the mini-preview in the nano-preview or 
by using the Animation Preview controls. Both of these methods allow you to see either 
a rendered preview or a storyboard. 

Adding/Deleting Frames in the Editors 
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Using the Movie Preview Window 

Using the movie preview window, you can see a rendered version of your animation 
quickly.  
To preview your animation: 

1. Create an animation.   
2. Left-click+hold on the Preview Animation button to bring up the Preview Options 

menu.   
 

 
3. Deselect Storyboard if it is selected.  

 

 
4. Let up on the

The animation
 mouse to close the menu and click the Preview Animation button. 
 will preview in the Nano-Preview window.  
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Using the Storyboard Preview 

Using the storyboard preview feature, you can review or navigate your animation, frame 
by frame.  
To view your storyboard:  

1. Left-click+hold on the Preview Animation button to bring up the Preview Options 
menu. 
 

 
2. Select Storyboard if it is not selected. 

 

 
3. Click on the Preview Animation button.  
4. All of the frames appear in a grid pattern as they are rendered. When the 

rendering is finished, the movie plays in the nano-preview.  
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5. You can stop the preview at any time by clicking the mouse.  
6. To exit movie preview mode completely, press the Esc key or redraw/render your 

scene or click on the Preview Animation button again. 
Additional Features of the Storyboard 

 
 animation.  

You can: 
• Click on a frame to select it.  
• Set the current time to that frame.  
• Drag the scrubber and move forward or backwards through the animation.  

Animation Preview Controls 

The Animation Preview controls let you move between the key frames in your 
animation.  
The outermost buttons move to the beginning and the end of the animation. The inner 
buttons move to the next and previous key frames, and start or stop the preview.  

If you pause in the storyboard portion of the animation preview, you can perform various
manipulations on your

• Double-click the corresponding storyboard image to render any of the frames.  
As you perform these manipulations, the animation updates in real-time in the movie 
preview window.  

 
When you play an animation, all the frames in the animation within the Working Area 
are displayed. The preview is shown in Wireframe display mode.  

 Starts a quick animation preview. 

 Moves to the beginning of the Recorded Area. 

Moves one key frame backward in the animation.  
Shift+click moves one frame forward. 

 Stops the animation.  

 Plays the animation. 
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 Pauses the animation during play 

Moves one key frame forward in the animation.  
Shift+click moves one frame backward.  

Moves to the end of the Recorded Area.  

Setting Previewing Options 

There are three options you can use to alter the preview of your animation: 
• You can preview the animation only once.   
• You can play the animation continuously.  

To set a preview option: 
1. Choose File > Animation Setup. The Animation Setup dialog appears.   
2. Enable a Play option:  

1. Once plays the animation only once.  
2. Repeat plays the animation continuously.   
3. Pendulum plays the animation forwards then backwards, then forwards, 

continuously.   
 

• You can cycle forwards and then backwards through the animation.  

 
3. Click on the OK icon to close the dialog.  
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Animation Options 

The triangle icon to the right of the animation controls displays the Timeline Options 
menu. This menu lets you turn the animation system on or off.  

 
When the animation system is enabled (Auto-Key selected), every change you make to 
the scene is recorded as a key event. Changes can include things like moving an 
object, changing a material, or changing the shape of a terrain. The Auto-Key option is 
only available on the Animation Palette in the Working window.  

 
When the animation system is disabled, your changes are not recorded. To record a 

button. In Bryce 6, the animation system 
ions of Bryce have the animation system enabled 

 icker Marks lets you select how Ticker Marks are displayed on the Timeline.  
 

key event you have to use the Add Key Frame 
is disabled by default. Previous vers
by default.  
This menu also contains the following:  

• T

 
• Play Mode - Provides options you can use to alter the preview of your animation.  

• Once - plays the animation only once  
• Repeat - plays the animation continuously  
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• Pendulum - plays the animation forwards then backwards, then forwards, 
continuously   
 

 
• Time Display - Select whether to display the animation in SMPTE Time or as 

Frame 
 

a 
Count.  

 

Motion Paths 

A Motion Path is a visual representation of an object's trajectory as it moves through 
time. An object's Motion Path is automatically generated as you create key events. Each 
new key event adds a new point to the path.  

 
The shape of the curve is determined by the interpolation performed by Bryce. In most 
cases Bryce tries to create smooth motion so the path is drawn as a curve.  
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As you add key events, the curve is adjusted to include the new motion. As you add 
more key events to your animation, the path changes shape to include the new motion. 
Bryce always keeps the motion smooth, so each new point is added as a curve.  

 
Motion Paths exist in 3D space so they can be viewed from any angle. If you move the 
camera, you can see how the object moves along the X, Y, and Z axes.  
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The default state of the Motion 
give your Motion Path some ex

Path can be difficult to see in a complex scene. You can 
tra depth by displaying it as a ribbon.  

 
The ribbon lets you see the motion path as 
By default, the Motion Path for an o

a flat track running through the scene.  
bject only appears when the object is selected. 

 

th by displaying it as a ribbon. 

Otherwise the path is invisible (including when selected as a preset in the Objects 
Library) and does not render in the final animation. You can change the display mode of
the motion path in the Animation tab of the Object Attributes dialog.  

Show as Ribbon 

The default state of the Motion Path can be difficult to see in a complex scene. You can 
give your Motion Path some extra dep

 
The ribbon lets you see the motion path as a flat track running through the scene.  
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To show the Motion Path as a ribbon: 
1. Select the object.  
2. Click the   button that appears next to its bounding box. The Object Attributes

dialog appears.   
 

3. Click the Animation tab.  
4. Enable the Show as Ribbon option and click the OK icon.  

 

 

Show When Selected 

By default, the Motion Path for an object only appears when the object is selected. 
Otherwise the path is invisible and does not render in the final animation. You can 
change the display mode of the motion path in the Animation tab of the Object Attributes 
dialog.  
To display the path only when the object is selected:  

1. Select the object.  
2. Click the  button that appears next to its bounding box. The Object Attributes 

dialog appears.   
3. Click the Animation tab. 
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4. Enable the Show Only when Selected option and click the OK icon.  
 

 

Show Always 

By default, the Motion Path for an object only appears when the object is selected. 
Otherwise the path is invisible and does not render in the final animation. You can 
change the display mode of the motion path in the Animation tab of the Object Attributes 
dialog.  
To display the path at all times: 
Select the object. 

1. Click the  button that appears next to its bounding box. The Object Attributes 
dialog appears. 

2. Click the Animation tab. 
3. Enable the Show Always option and click the OK icon. 
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Editing Motion Paths 

Changing the shape of the motion path changes the trajectory of the object. The path 
ou can change its shape by dragging its control points.  

e path. The changes you make to 
eal time.  

that 
the same time regardless of where it is.  

acts like a Bezier curve. Y
You don't have to be in Auto-Record mode to edit th
the path's shape are applied directly to the path in r
Changing the shape of a path does not affect when key events occur. A key event 
occurs at 00:00:01.00 will still occur at 

 
The eve

the direction in which the object travels c
same time they did in the original path.  

nts on the path in this image occur at 00:00:00.00, 00:00:00.04, 00:00:00.08, 
00:00:00.12, 00:00:01.00, and 00:00:01.04. When you change the shape of the path, 

hanges, but all the events still occur at the 

Since Bryce treats the motion path as a Bezier curve, you can edit it just as you would 
any curve in any 2D illustration application. You can also display the curve's tangents 
which indicate the angle of the curve.  

 
When you display a path's tangents you can see the angles of its curve points.  
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Finer adjustments can be made to the curves by constraining the points to a specific 
axis. 

. 
onstrain to X-axis - Click on point to select and without letting up on the mouse, 

press Cmd/Ctrl+Opt/Alt and drag left or right. 
3. Constrain to Z-axis - Press Cmd/Ctrl and drag left or right on the point 

Note that only constrain to the Z-axis allows you to press the modifier keys before 
selecting the point. For the constrain to Y or X-axis, pressing the modifier key(s) first will 
lock the point in place until you do it correctly. 
If the path is shown as a ribbon, pressing Opt/Alt or Cmd/Ctrl+Opt/Alt and dragging on 
the point will twist the ribbon but won't actually do anything to the object, i.e., the object 
won't twist around the path. 

occurs along the path. 
Normally an object moves from the first key event on the path to the last over the course 

u want the object to move backwards along the path, or repeat its 
action, you would have to reposition the object and set up new key events. The 

 of effects automatically. 
randfather clock pendulum, you 

on and then the backward motion.  
However, using the Pendulum modifier you just have to set up the forward motion path 
since the modifier changes the object's behavior so that it moves forward then back 
along the same path during the course of the animation. All you have to do to see the 
new motion is extend the duration of the animation. 
There are four modifiers available: 

• Make One Shot restores the motion of the path to its original configuration, 
meaning the action along the path only occurs once.  

• Make Repeat creates a loop in the action. The motion on the path repeats 
continuously.  

 ake Circular closes the path to create a circular path. The object will move 
it'll swing around to the front of the 

path and start all over.  

1. Constrain to Y-axis - Click on point to select and without letting up on the mouse, 
press Opt/Alt and drag left or right

2. C

Motion Path Modifiers 

There are a number of modifiers you can apply to the path to change the way motion 

of the animation. If yo

modifiers let you create these types
For example, if you wanted to animate the motion of a g
have to set up the forward moti

• Make Pendulum creates a repeating cycle in the action along a path. The object 
will move forward on the path, then back and then forward continuously.  

• M
along the path and when it reaches the end, 
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To apply a modifier to a motion path:  
1. Select the object. 
2. Click the  button that appears next to its bounding box. The Object Attributes 

lick the Animation tab.  
4. Enable a modifier.   

 

dialog appears.   
3. C

 
5. Extend the duration of the animation so you can see the change in motion.  

Moving the Path 

You can also move the path by dragging it to a new location. When you drag the path, 
all the events on the path shift position. Changes in motion path position are not 
recorded as key events.  
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To move a motion path:  
1. Click on a section of the path that does not contain any control points. You have 

to click on a part of the path without control points, otherwise you'll change its 
shape instead of moving it.  
 

 
2. Drag it to new location.  

 

 
3. The object may not move with the path, but once the path is where you want it, 

press the Play button or the Last Frame button and the object will snap back on 
to the path.   
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Aligning Objects to the Path 

 object remains fixed relative to world space as it moves 
ave the object's orientation 

You can use this option to create more realistic motion for objects that have a distinct 

istic since it's rising and falling without 

Normally, the orientation of an
from point to point. Using the Aligning option, you can h
remain parallel to the path so that it reorients itself as it moves from point to point.  

front and back.  
The motion of this rocket looks rather unreal
pitching.  

 
If you align the rocket to its path, the rocket's nose tilts down as it moves down and up 
as it moves up.  

 
There are two align options available: 

• Do Not Align disables aligning. The shape of the curve has no effect on the 
object's orientation.  

• Align adjusts the object so that its orientation matches the shape of the path.  
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To align an object to a motion path: 
1. Select the object.  
2. Click the  button that appears next to its bounding box. The Object Attributes 

dialog appears.   
3. Click the Animation tab.  
4. Enable an alignment option and click the OK icon.  

 

 
Please note that if the motion path has tight curves, using the Align option may cause 
the object to flip as it goes around the curve. To avoid this, widen the curves on the path 
by moving points and/or adjusting the tangents.  

The Advanced Motion Lab lets you fine tune your animations. After you've created your 
the Animation Controls, you can use the tools available in this lab to 
at which objects move along a motion path, adjust the position of key 

that let you control the detailed properties of your animation. 

Advanced Motion Lab 

key frames using 
control the speed 
frames, and preview your changes. Use the Velocity Curve editor to create different 
velocity effects and the Hierarchy area to control when object transformations occur.  
The Advanced Motion Lab button opens the Advanced Motion Lab, which contains tools 
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You can use the lab to: 
• view the hierarchical structure of your scene  
• rearrange the sequence of key events for individual object properties  
• remap the time it takes to move from one key event to another  
• preview your animation  

The Advanced Motion Lab is divided into four areas: 
• The Hierarchy List Area, located in the bottom-left corner of the window.  
• The Sequencer Area, in the bottom center of the window.  
• The Time Mapping Curve Editor, located at the top-left of the window.  
• The Preview Area, located at the top right of the window.  

 

Hierarchy List Area 

archies expanded or just the parent objects in the 
scene. You can also expand an object's listing to show all of its properties.  

d 
 

The Hierarchy List Area displays the scene's hierarchical structure, including links and 
groups. You can view all the hier

The Hierarchy List Area is used to control the display of both the object hierarchies an
object property timelines. If you want to view only your scene's object hierarchies you'll
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have to hide all the properties for all objects. You can hide each object individually or
select from the menu to the right of the Preview Area to display or not displa

 
y the 

hierarchy. Refer to "Object Hierarchies" for more on object hierarchies.  

Display Property Timelines 

To display property timelines:  
• To display an individual object's property timelines, click the name of the object 

whose properties you want to display. 
 

 
• To display all the property timelines of an object and its children, hold down 

Opt/Alt while you click on the name of the parent object.  
• To display all property timelines in the Hierarchy List Area, select Expand All 

Timelines from the menu to the right of the Preview Area.  
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Hide Property Timelines 

whose properties you want to hide.  
 

To hide property timelines:  
• To hide an individual object's property timelines, click the name of the object 

 
• To hide all the property timelines of an object and its children, hold down Opt/Alt 

while you click on the name of the parent object.  
• To hide all property timelines in the Hierarchy List Area, select Collapse All 

Timelines from the menu to the right of the Preview Area.  
 

 
• h  all the object timelines are hidden, the only thing displayed in the 

View

 can use the 
 to expand or collapse the Hierarchy. When the Hierarchy List is collapsed 

you can only see the Parent objects in the object hierarchies. When it's expanded, you 
can see all child objects in the hierarchy.  

 W en
Hierarchy Area is the hierarchical structure of your scene.  

ing Hierarchies 

The Hierarchy List can be viewed in two ways: collapsed or expanded. You
arrow icons
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The indents indicate Parent-child links or groups. The parent is aligned to the left an
children are indented from there. 

d its 
 

 
To display or hide the hierarchical relationship:  

• To display the hierarchical relationship in the Hierarchy List Area, select from the 
menu to the right of the Preview Area.  

• To hide the hierarchical relationship in the Hierarchy List Area, deselect Display 
Hierarchy from the menu to the right of the Preview Area.   
 

 
To expand/collapse the Hierarchy List: 

• To expand or collapse individual items in the Hierarchy List, click the arrow icon 
beside an object's listing.   
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• To expand the entire hierarchy, hold down Opt/Alt and click an arrow or select 
Expand All Hierarchies from the menu to the right of the Preview Area.  
 

 
• To collapse all hierarchies, select Collapse All Hierarchies from the menu to the 

right of the Preview Area.  
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• A right facing arrow indicat
indicates an expanded listin

es a collapsed hierarchy and a down-facing arrow 
g.  

 

 

Hiding & Displaying Objects 

ene. The icons on the left side 
ed in 

The Hierarchy List Area displays all the objects in your sc
of the listing indicates whether (eye open) or not (eye closed) the object is display
the preview area.  

 
When you hide an object it does not appear in the Preview Area at the top of the 
Advanced Motion Lab. This setting has no effect outside the lab. Objects that are 
hidden in the lab will be visible in the Working window and will still render normally. You 
can use this feature to isolate objects that you're editing in the Sequencer or Time 
Mapping Areas.  
To hide/display an object:  

1. Click the Eye icon to hide the object.  
2. Click the Closed Eye icon again to display the object.   

ct. 
n 

ine. The current time is indicated by the Current Time bar.  
me a change in an object's property occurred 

.  

lp you isolate objects in a complex scene.  

The Sequencer 

The Sequencer lets you see the key frames recorded for each property within an obje
Each property has its own timeline track. Key frames are displayed as white marks o
the timel
The Sequencer lets you see where in ti
and edit the position of that event. Different types of objects have different properties
A scene contains more than just objects. You can expand the Hierarchy List to also 
display the properties for your scene's sky and the camera.  
The display buttons along the left side of the hierarchy area let you hide or display an 
object in the animation preview. This can he
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Property Timelines 

Each object in the Hierarchy List has a number of timelines associated with it. When 
you display an object's properties you can see the timelines associated with each 
object.  
To display an object's property timelines:  

• To display an individual object's property timelines, click the name of the object 
whose properties you want to display.  
 

 
• To display all the property timelines of an object and its children, hold down 

Opt/Alt while you click on the name of the parent object.  
• To display all property timelines in the Hierarchy List Area, select Expand All 

Timelines from the menu to the right of the Preview Area.  
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These timelines represent the various animatable properties for an object type. Different 
types of objects have different animatable properties.  

s that a key event has been recorded for the property.  

For example, this is the listing for a sphere object. When the object's property timelines 
are displayed, you can see the key events recorded for each property. The white tick on 
a property timeline indicate

 
The ru ey 
event w

ler at the top of the Sequencer lets you see the exact point in time when the k
as recorded.  

 
You can tell exactly when an event was recorded by lining the key event marker up with 
the ruler at the top of the Sequencer area. In the example above, a position key event 
was recorded at time 00:00:00.06 (or 0 seconds and 6 frames).  

©2007 DAZ 3D, Inc.  1149 



Bryce 6 Artist Guide 

By moving these key events you can control precisely when events occur. For example, 
p and down four times, 
ouncing.  

this sequence represents an animation where a ball moves u
rotates as it makes its third jump, and shrinks when its done b

  
If you move the position key events closer together the bounces occur faster, but the 
timeline remains the same.  

  
If you move the fourth position key event in front of the third event, you're changing the 
shape of the motion path, because the ball bounces up before it bounces down.  
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Position is not the only key event you can arrange. Here both the rotation and scale key 
events have been repositioned. Now, the ball grows larger as it bounces and it rotates 
only at the end of the animation.  

  
It's a good idea to activate the continuous preview while editing the timeline, so you can 
quickly see the effects of your changes. Refer to "Previewing Animations" for more o
previewing.  
The amount of time available in the Sequencer area is not limited by the current 
Animation Range

n 

. If you position a key event past the current limit of your animation, the 
Animation Range is automatically extended.  

 

Moving a Key Event 

To move a key event on a timeline: 
1. Expand the listing you want to edit. 
2. Click the white tick mark on the listing's timeline.   
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3. Drag the key event to a new position.  
 

 

Moving a Group of Key Events 

ou want to select or hold down Shift 
 events you want to move. You can select key events on 

To move a group of key events:  
1. Drag a marquee around all the key events y

and click each of the key
different timelines.   
 

 
2. The selected key events will be highlighted.   

 

 
3. Drag one of the selected key events. All the other selected key events move 

also.   
 

 

Deleting a Key Event 

To delete a key event from a timeline: 
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1. Select the key event or group of events you want to delete.  
 

 
2. P

labeled "Delete"). The key event 
ress Backspace (on some Macintosh keyboards, the backspace key may be 

is removed from the timeline.  
 

 

Copying a Key Event 

To copy a key event on a timeline, hold down Cmd/Ctrl and drag a key event. The 
original remains in place, but the copy moves as you drag.  
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Saving Frame Positions 

The Memory Dots below the Sequencer Area let you save specific frame positions for 
later use.  

 
• To save a frame position, either play the animation and then stop it at the point 

you want to save or move the Current Time Bar in the Hierarchy Area to the 
position you want to save.   

• Click on an empty Memory Dot on the right side of the Preview Area. A dot is 
empty when it appears gray.   

• To move to saved position, click on a full Memory Dot. A dot is full when it 
appears teal. The selected dot will have a white dot in the center.  

• To delete a saved position, Opt/Alt+click on a full Memory Dot.  

Time Mapping Curve Editor 

The Time Mapping Curve Editor lets you control the length of time between key events. 
Each property listing in the Hierarchy List has its own Time Mapping Curve.  
The curve acts like a time filter which remaps the time in your animation. Depending on 
the shape of the curve, the events in your animation may take longer to complete or 
may occur very rapidly. 
A Time Mapping Curve can speed up events while slowing down others. You can even 
reverse the action in your animation.  
Refer to "Time Mapping Curves" for more on working with Time Mapping Curves.  
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Time Mapping Curves 

Time Mapping Curves are graphical representations of the time mapping filter. The filter 
remaps the time in your animation, so that the events that occur at specific times in your 
animation occur differently in actual time.  
By adjusting the shape of the curve, you can control how fast events occur. When you 
create a sharp jump in the curve, you speed up the events in your animation. When you 

rent curve, so you can have key events 

The curve acts like a filter. Time from the actual animation is remapped according to the 

me available in the animation. You cannot 
me or reduce the amount of time in an animation.  

Editing Time Mapping Curves 

The horizontal axis in the editor displays all the time in the animation. The vertical axis 
displays the time map for the properties' timeline. The key events recorded for an object 
property are displayed as horizontal dotted lines. The curve in the middle represents the 
time mapping filter. The point where the curve intersects a key event line tells you 
exactly when an event occurs. For example, at point A in this timeline, an event that 
occurred at 0.4 seconds in the original animation, will occur at 0.65 seconds after it's 
passed through the filter.  

flatten the curve, you slow down key events.  
Each property of your scene can have a diffe
occurring at different speeds.  

shape of the curve to produce the final time. Depending on the shape of the curve, 
events can occur faster or slower.  
Time Mapping Curves can only remap the ti
add more ti

 
The default Time Mapping Curve for any property is a diagonal line. In this curve, t
not being remapped since events occur at the same time along both the horizontal
vertical axes. At point A in the default timeline, an event that occurred at 

ime is 
 and 

0.4 seconds in 
original animation, also occurs at 0.4 seconds in the time map.  
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When you change the shape of the default curve, you're remapping time.  
For example, if you make the curve convex, events occur later in the animation, but 
they're closer together which means the action at that point in your animation will speed 
up. In this example you can see that at point A an event that occurred at 0.5 seconds 
now occurs at 0.71 seconds. At point B an event that occurred at 0.8 seconds now 
occurs at 0.95 seconds.  

 
Although both events now occur later, there's much less time between them, so the 
action in your animation occurs later but the changes at that point are faster.  
A concave curve would create the same type of effect, except that the events occur 
earlier. Here, event A and B occur much earlier, within the first half second and the 
amount of time between them is much less.  

 
Different curve shapes represent different time mapping effects. A flat curve means that 
no motion is occurring since all the events on the curve are happening at exactly the 
same point in time. This curve indicates that a pause occurs during the course of the 
animation.  
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A steep jump in the curve indicates a sharp increase in speed, as many events occur in 
a very short time. This curve indicates a sharp increase in speed.  

 
An oscillation in the curve, indicates that events repeat, since they intersect the cu
more than once. In this curve event A occurs once at 0.5 seconds and again at 0.75 
seconds.  

rve 

 
You can combine any variation of curve slopes to create different velocity effects.  
While you're editing a Time Mapping Curve, you may want to continuously run the 

This way you can quickly see the 
animation preview. As the preview runs, the cross-hairs in the Time Mapping Editor 
move from the beginning of the animation to the end. 
effects of your edits. Refer to "Previewing Animations" for more on continuous preview. 
The counter at the bottom of the editor shows you the current time of the animation. As 
the animation runs, the counter updates to continuously show the current time.  
You can also move the current time by dragging the Current Time bar in the Hierarchy 
Area.  
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Zoo

To zoom into an area of the Time Mapping Curve: 

om In cursor.  

ming In on a Curve 

1. Move the cursor over the curve in the Time Mapping Editor. The cursor will 
change to the Zo
 

 
2. Click and drag over an area of the curve.  

 

 
 
When you release the mouse,
 

 the area is enlarged.  
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Zooming Out on a Curve 

To zoom out from an area of the Time Mapping Curve: 
1. Move the cursor over the curve in the Time Mappin

change to the Zoom In cursor.  
g Editor. The cursor will 

 

 
2. Hold down the Shift key and click inside the Time Mapping Editor. The cursor will 

change to the Zoom Out cursor.  
 

 
 
When you release the mouse, the area is reset.   
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Panning the Curve 

To pan the Time Mapping Curve, : 
r the Time Mapping Editor.  1. Move the cursor ove

 

 
2. Press the S

in
pacebar (the cursor will change to the Pan cursor) and drag the curve 

 the editing window.   
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Resetting the Curve Editor View 

To reset the view in the Curve Editor View after zooming in or panning:  
1. Move the cursor over the Time Mapping Editor.  

 

 
2. Press Cmd/Ctrl+Shift then click in the editor window.  

 

 
 
The view will be reset.  
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Adding a Point on a Curve 

1. Move the cursor over the Time Mapping Editor where you want to add a new 
point. The cursor will change to a pen cursor.  
 

To delete a point on a Curve: 

 
2. Left-click on the curve and a new point will be added. 
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Deleting a Point on a Curve 

To delete a point on a Curve: 
1. Move the cursor over the Time Mapping Editor.  

 

 
2. Press Cmd/Ctrl+Shift then click on the point to be deleted in the editor window. 

The point will be deleted.  
 

 

Using Presets 

Above the Time Mapping Curve Editor are eight time mapping curve presets. You can 
 curve then apply it to a different attribute of the same create a preset of the current

object or to another object. 
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To add, apply, or remove a preset: 

 blank squares. Scroll using the arrow at the 
re is not available. 

• To add a preset, click in one of the
right if a blank squa
 

 
• To apply a preset, click in the square that displays the preset you want to apply.  

 
 

 
• To remove a preset, press Opt/Alt and click on the square that displays the 

preset you want to delete.  
 

 

©2007 DAZ 3D, Inc.  1164 



Bryce 6 Artist Guide 

• When all the preset slots are filled, a new one is automatically generated when 
you click on the right arrow.  
 

 
• T o scroll to the newest preset or to the next preset in line, click on the arrow at 

the end of the preset container.   
 

 

Preview Area 

The Preview Area in the Advanced Motion Lab contains tools that let you preview your 
animation. It lets you see any changes you make to the timing and velocity of objects.  

 
The Preview Area has four parts:  

• The Animation Preview Area displays a wireframe preview of your scene. Any 
changes you make in the Time Mapping Curve Editor or the Sequencer are 
updated to this area.  

• The Preview VCR Controls let you play the animation like a movie. You can stop, 
play, move forward one key frame, or back one. The far right button renders the 
scene.  
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• The Preview Display Controls let you zoom in/out of the preview, switch betwee

Camera View and Director View, pan the preview, and reset the preview.   
 

n 

 
• The Camera Preview Memory Dots let you save specific camera positions in the 

review for later use.  p
 

 
Once you start the animation, it will run continuously until you press the Stop button. 
Running the preview also moves the Current Time Bar in the Sequencer area and the 
cross-hairs in the Time Mapping Editor. In addition, the counter at the bottom of the 
Time Mapping Editor displays the current time of the animation as it plays.  
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Preview VCR Controls 

The Preview VCR Controls let you play the animation like a movie. You can stop, play, 
move forward one key frame, or back one. The far right button renders the scene.  

 
Once you start the animation, it will run continuously until you press the Stop button. 
Running the preview also moves the Current Time Bar in the Sequencer area and the 
cross-hairs in the Time Mapping Editor. In addition, the counter at the bottom of the 
Time Mapping Editor displays the current time of the animation as it plays.  
To preview an animation:  

• Click the Play button in the Preview Area Controls. The animation starts running. 
It will continue playing until you press the Stop button.  
 

 
• Click the Stop button to stop the preview.  

 
 

• Click the First Frame button to go to the first frame in the preview.  
 

 
• Click the Last Frame button to go to the last frame in the preview.  

 
 

• Click the Previous Frame button to go to the previous frame in the preview.   
 

 
• Click the Next Frame button to go to the next frame in the preview.  
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• Click the Animation Setup button (first button on VCR 
A
 

Controls) to open the 
nimation Setup dialog.   

 
• Click on the Render View button (last button on VCR Controls) to render the 

current frame in your preview.   
 

 

Preview Display Controls 

The Preview Display Controls let you zoom in/out of the preview, switch between 
Camera View and Director View, pan the preview, and reset the preview.   
 

 
The controls along the left side of the Preview Area control several options for your 
animation preview.  

• To switch between Camera View and Director's View in the preview:  
• Click the Swap Views button next to the Preview Area. When you first 

open the Advanced Motion Lab, the Preview Area displays the current 
camera view. In Director's View you'll be able to see the camera in the 
scene.   

• Click the button again to switch back to Camera View.  
 

 
 
Changing views in the Preview Area doesn't affect the view in the Working 
window.  

• To change the view in the Preview Area to orbit around your scene, click+drag 
iew of your scene.  the preview in the direction you want to move the v
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• To zoom in and out of the preview, click the + and - buttons next to the Preview 
Area. The view of the scene enlarges or gets smaller depending on the button 
clicked.  
 

 
• To reset the view in the preview area, click the Reset button next to the Preview 

en you first entered the Area. The view returns to the view displayed wh
Advanced Motion Lab.  
 

 
• To pan the Preview Area, drag the cursor over the Pan button next to the 

Preview Area.  
 

 
• To rotate the Preview Area, drag in the Preview Area. 

Saving Camera Preview Positions 

The Memory Dots next to the Preview Area let you save specific camera positions in the 
preview for later use.  

 
To save a camera position:  

• Change the view in the Animation Preview Area by using the Zoom/Pan buttons
or rotate the view by clicking in the preview window and dragging.   

• Click on an empty Memory Do

 

t on the right side of the Preview Area. A dot is 

ed camera position, click on a full Memory Dot. A dot is full when 
it appears purple.  

• To delete a saved camera position, Opt/Alt+click on a full Memory Dot.  

empty when it appears gray.   
• To move to sav
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Animating Techniques 

Bryce has several features you can use to add realism to your animations. The 
techniques can be used together to help you develop more exciting, natural, and 
dynamic animations.  
In this section, you'll learn how to animate objects using the Tracking feature. You'll also 
learn how to animate several different properties of your scene like material channel 
properties, which can dramatically alter the look of your objects, and terrain object 
properties, which can alter the layout of your landscape.  

Tracking Objects 

Tracking lets you connect an object to another, called the target, so that the object 
remains pointed at the target throughout the animation.  
As the target moves, the original object pivots around its origin so that it remains 
pointed at the target. Normally, the orig al object does not change position, only 
orientation. However, if you offset the object's origin point, it might change location as it 
rotates around the offset point.  

in

 
You can use tracking to quickly set up the animation of a number of objects at once. 
When an object is tracking another, you only have to set up the motion path of the 
target object. The motion of the objects tracking the target are automatically created. 
The original object pivots around its origin point so that it's always facing the target 
object.  
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For example, in this scene the motion of all the lights is created when you move the 
targ
pointed at an object during the entire course of

et object. You can use this feature to ensure that a light or the camera remains 
 the animation. You can also use it to 

create motions like a radar dish following a satellite or a sunflower following the sun. A 
parent object cannot track its child object.  
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Set Track Object Interactively 

 want to remain stationary (that is, the one that tracks the 
To set up object tracking interactively: 

1. Select the object you
target object).   
 

 
2. Move the cursor over the target button (  ) that appears next to the object's 

bounding box.   
 

 
3. Left-click and drag the Target line from the  button to the target object. The 

target object turns green. As you drag the Tracking icon from the tracking object 
to the target, a tracking line 
 

appears. Let up on the mouse.  
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4. If you need to change the orientation of the tracking object, click the  button that 
ct's bounding box. The Object Attributes dialog will come 

6. he selected target object will now show in the Track Object Name field and the 
Orientation options will be visible. The default orientation is +Z which points the 

ton 

appears next to the obje
up. 

5. Click the Linking tab. 
T

front of the object on the Z-axis towards the object it is tracking. Click on a but
to change the orientation. 
 

 
 
Example - Cone tracking a cube with orientat
towards the cube: 
 

ion of +Y, so top of cone points 

 
7. Click on the OK icon to close the dialog. 
8. Move the target object to test that the tracking is working.  
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Set Track Object in Object Attributes Dialog 
To set up object tracking using the Object Attributes dialog:  

1. Select the object you want to remain stationary.   
 

 
2. Click the  button that appears next to the object's bounding box. The Object 

Attributes dialog appears.  
3. Click the Linking tab. 
4. Click the Target Object Name menu and choose the name of the target object.  

 

 
5. T

Orientation options will becom
he selected target object will now show in the Track Object Name field and the 

e visible. The default orientation is +Z which points 
 the front of the object on the Z-axis towards the object it is tracking. Click on a

button to change the orientation. 
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Example - Cone tracking a cube with orientat
towards the cube: 
 

ion of +Y, so top of cone points 

 
6. Click on the OK icon to close the dialog. 
7. Move the target object to test that the tracking is working.  

Animating the Camera 

Wh urse 
of the animation. Since you're in 3D space you can move the camera to any position in 
the d the scene, zoom into it or even fly 
under it. There are two ways of animating t

en you animate the camera, you're changing the view of your scene over the co

 scene. You can have your camera circle aroun
he camera in Bryce: using the Camera 

Position Controls or by moving the camera as an object.  
The easiest way of animating the camera is to use the Trackball (or other Camera 
Position Controls) in Camera View while Auto-Key mode is enabled. Any changes you 
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make to the position of the camera are automatically recorded as part of a key event. 
When you play the animation, your camera changes are added to all the other changes 

.  
s 
o 

ng a precise motion 

 just as you would for any other object. 
h so you can make precise adjustments to 

its movements.  
After you're done setting up the key events for the camera, you can see the changes in 
the Sequencer in the Advanced Motion Lab. There you can rearrange the order of 
events or change how long it takes to move between camera positions. Refer to 
"Viewing Hierarchies

in scene properties to create the action in your animation
While working in Camera View may be the easiest way of animating the camera, it i
not the most precise. Because of the view's first person perspective, it can be hard t
see the exact path of the camera as it moves. This can make creati
difficult. However, if you switch views, to an Orthogonal View or the Director's View, 
you'll be able to see the camera as an object in the scene. Then you can select the 
camera and set up key events for its position,
You can also display the camera's motion pat

" for more on working in the Hierarchy or "Time Mapping Curves" 
for more on remapping time.  

Camera Motion & Skies 

The motion of sky elements can affect how fast the action in your animation appears. 
For example, in time-elapsed movies, the clouds and sun fly by quickly as the objects 
stay in the same position. You could inadvertently create this type of action in your 
scene if you move only the camera in the scene without considering the static nature of 

ce the clouds stay in exactly the same position as you move the 
camera, they'll appear to be moving much faster than the objects in the scene.  

n also link the sun to the camera, it's not a very good idea to link the 

lready visible, display the Sky & Fog palette by clicking the text item on 

the sky elements. Sin

To avoid this problem, Bryce lets you link the clouds to the camera. This way, whenever 
the camera moves, the cloud positions also move so they look like they're staying in the 
same position.  
Although you ca
two during an animation since any change in the camera position will change the time of 
day.  
To link clouds to the camera:  

1. If it's not a
the menu bar.  
 

 
2. Click the Sky Lab button. The Sky Lab dialog appears. 

 
 

3. Click the Cloud Cover tab.  
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4. Click the Link Clouds to Vie
 

w button at the bottom of the palette.   

 
5. Click the OK icon to exit the palette. 

Using the Orthogonal Views 

In Camera View you can't see the physical position of the camera in the scene since 
you're looking through it, but using one of the Orthogonal Views (Top, Bottom, Left, 
Right, Front, and Back) you'll be able to see the camera as an object. In this example, 
the scene is displayed in Top view. Here you can see the exact position of the camera 
in the scene.  

 
In these views you can animate the camera by changing its position at different points in 
time. When you run the animatio
sm

n, Bryce fills in the gaps between positions to create 
ooth camera motion.  

To animate the camera in an orthogonal view:  
1. In the Working window, click the triangle icon next to the View Control and 

choose an Orthogonal View from the menu: Top, Left, Right, Bottom, Front, or 
Back.   
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2. Move the Current Time Indicator in the Timeline to the point where you want to 

start changing the Camera View.  
 

 
3. Click the triangle ic

enabled.   
on in the Animation Controls and make sure Auto-Key is 

 

 
D4. rag the Camera wireframe in the Working window to a new position. Continue 
moving the Current Time Indicator and the Camera wireframe until all camera 
movements have been key framed.  
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5. If you want to see the results of your changes, choose Camera View from the 

View Control menu and click the Play button in the Animation Controls.  

Using Director's View 

Director's View is similar to Camera View, except that in this view, you can see the
camera as an object in the scene and the move
recorded as key events. In Director's View 

 
ments of the Director's camera are not 

you see the camera as an object in the 
Working window. You can change this view using any of the Camera Position Controls 

 of the scene using the Trackball or the 
Camera Position tools. The view of the scene changes in the Working window, but no 
new key events are created.  
You can also preview the animation while in Director's View. In the Working window you 
can see all the objects moving along their motion paths -including the camera.  
To animate the camera using Director's View:  

1. In the Working window, click the triangle icon next to the View Control and 
choose Director's View from the menu.   
 

in the Control Palette.  
In Director's View, you can move the view
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2. Move the Current Time Indicator in the Timeline to the point where you want to 
start changing th
 

e Camera View.  

 
3. Click the triangle icon in the

e
 Animation Controls and make sure Auto-Key is 

nabled.   
 

 
Drag the Camera wireframe in the 4. Working window to a new position. Continue 

 Camera wireframe until all camera 
movements have been key framed.  
moving the Current Time Indicator and the

 

 
5. If you want to see the results of your changes, click the Play button in the 

y 

h for the camera, you may want to display its motion 
a by 

adjusting the shape of the path. R

Animation Controls.  

Displaying the Camera's Trajector

If you're setting up a precise pat
path. Just like with other motion paths, you adjust the trajectory of the camer

efer to "Editing Motion Paths" for more on working 
ctory, you can see the exact 

path it will take during the course of the animation.  
with motion paths. When you display the camera's traje
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To display the camera's trajectory:  
1. In the Working window, click the triangle icon next to the View Control and 

, Bottom, Front, or Back from the menu.  choose: Top, Left, Right
 

 
2. Select the Camera in the Working window.  

 

 
3. Click the  but

& 2D Projection
ton that appears next to the camera's bounding box. The Camera 
 dialog appears.   

4. Click the Animation tab and enable the Show When Selected or Show Always 
option.   
 

 
5. Click on the OK icon to close the dialog.  
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Linking & Tracking with the Camera 

Since Bryce lets you treat the camera as an object, you can also link the camera to an 
object or you can have it track an object. When you link the camera to an object, the 
view of the scene changes as the position of the parent object changes.  

 

 
When the camera is linked to an object, both its aim and position change as the object 
changes. When you set the camera to track an object, the camera remains pointed at 

 
ays 

the target object no matter where the object moves in the scene. This means the 
Trackball is disabled because the orientation of the camera is controlled by the position
of the target object. Also, you can't change the aim of the camera because it alw
aims at the target object.  
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However, you can position the camera using th
change the position of the camera not its orientation. 

e Camera Controls as these controls 

table movements when you're in Camera View. 

object interactively:  

Linking the camera can cause unpredic
If you change the position of the target object, the view of the scene will also shift. 

Set Link Camera to Object Interactively 

To link the camera to an 
1. Switch to an Orthogonal View or Director's View.  
2. Select the camera.  

 

 
3. Move the cursor over the Tracking button (  ) that appears next to the camera's 

bounding box.   
4. Drag the tracking handle from the button to the object you want to use as the 

target object. The target object will show as green.  
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Set Link Camera to Object in Camera & 2D Projection Dialog 

To link the camera to an object using the Camera & 2D Projection dialog: 
1. Switch to an Orthogonal View or Director's View.  
2. Select the camera.  

 

 
3. Click the  button that appears next to the object's bounding box. The Camera & 

lick the Track Object Name menu and choose the name of the target object.  
 

2D Projection dialog appears.   
4. Click the Linking tab.  
5. C

 
6. Click the OK icon to close the dialog. 

You can also access the Camera & 2D Projection dialog by double-clicking the 
Trackball or by clicking the triangle icon beside the Camera Controls and choosing Edit 
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Current Camera from the drop down menu. Only the Camera & 2D Projection tab will be 
available when you access the dialog using one of these methods.  

Creating Camera Orbits 

The camera's Origin Point controls its center of rotation. When the Origin Point is at the 
camera's center, it rotates around in place. When the Origin Point is positioned 
somewhere in the scene, it will orbit around the Origin Point. During an animation, the 
view of your scene will orbit around a specific point in the scene. In this example, the 
camera's Origin Point was positioned in the center of the scene. During the course of 
the animation, the camera appears to orbit around the entire scene.  

 
To create a camera orbit: 

1. Switch to Director's View or one of the Orthogonal Views.  
n the Animation Controls and make sure Auto-Key is 

 

2. Click the triangle icon i
enabled.   
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3. Click the Cam
 

era wireframe in the Working window.  

 
4. Click the  button that appears next to the camera wireframe. The Camera & 2D 

 Origin Handle button and click the OK icon.  

Projection dialog appears.   
5. Click the General tab.  
6. Click the Show

 

 
 
The Origin Point will now be visible in the scene as a bright green dot.  
 

 

©2007 DAZ 3D, Inc.  1186 



Bryce 6 Artist Guide 

7. Drag the Origin Handle to a position in the scene.  
 

 
 
Note that it is easier to move the Origin Point if the camera is not yet linked to a
object. Once the Origin Point is moved,

n 
 then set the linking options.  

rded 

es for these transformations 
control the order in which 

ect that grows larger and 
en grows. Several 
d using transformations.  

8. Rotate the object using the Rotation tool in the Edit palette or the Trackball.  
9. Play the animation to see the camera orbit around the scene.  

Animating Transformations 

When you're in Auto-Key mode, every transformation you apply to an object is reco
as a Key Frame.  
In the Hierarchy Area you can see where the key fram
appear in the timeline. By moving these key frames you can 
transformations are applied. For example, you can take an obj
then moves left, and turn it into an object that moves left and th
animation techniques, like squash and stretch, can be simulate
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Animating Materials 

The Materials Lab has its own set of animation tools that let you a
properties. You can animate almost any property or texture.  

nimate material 

 
imation Controls in the Working window except for the 

Material animations are created using the Animation Controls at the bottom of the 
Materials Lab, which let you move along the Timeline and preview your animation. 
These controls let you move along your animation's timeline. This Timeline is the same 
as the one at the bottom of the Working window. It contains all the same key events as 
the Working window timeline. The Animation Controls in the Materials Lab can perform
all the same features as the An
Auto-Key option.  

 
When you're animating between textures, Bryce interpolates between patterns and 

de much more that just motion. Many subtle or 

n assumes that you're familiar with the concepts and procedures involved in 
creating material and textures. Refer to "Materials Lab

colors over time. You can have a rocky terrain turn into a desert during the course of 
your animation.  
The action in your scene can inclu
dramatic effects can be created by changing the properties of an object's surface over 
the course of the animation.  
This sectio

" for more on creating materials 
and "Deep Texture Editor" for more on editing textures.  
By animating an object's texture you can create subtle effects like changing the color of 
an object to simulate things like a tomato ripening. You can also create more dramatic 

ties of a material at once. Using this technique you 
ple, in this 

the color and 

he animation 
tools in the Materials Lab you set the properties of a material at different points along 

animation, Bryce interpolates between the properties to 

ty of a material's:  

• Channel values  
• Texture component usage (that is, switching between components A, B, C, and 

D)  
• Texture properties  
• Volume Material properties  

effects like changing all the proper
can change an object from marble to metal or glass to wood. For exam
animation, the illusion of a banana ripening was created by changing 
texture of a material over time.  
In Bryce, animating materials is a rather straight-forward process. Using t

the Timeline. When you run the 
create a transition from one material to the other.  
You can animate any proper

• Colors  
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Take care when you're choosing which properties to animate. Some properties, like 
transparency, and volumetric effects can greatly increase the rendering time of your 
animation.  

Animating Material Channel Values 

By animating the channels in a material you can alter the properties of a material 
without changing its basic  
function. Using this technique, a rock material would still look like a rock, but change 
color, or glass would still look like glass except become shinier. Animating a channel 
value is the simplest way of animating a material and it requires the least amount of 
processing time.  
To animate a material's channel values:  

1. Select an object.   
ke sure Auto-Key is 2. Click the triangle icon in the Animation Controls and ma

enabled. 
 

 
3. Click the  button that appears next to the object's bounding box. The Materials 

 
Lab appears.  

4. Move the Current Time Indicator to the point where you want to start changing
the material.  

5. Either change the values of the material channels using the Value controls or 
change the color used for a channel by using the color picker.  
 

 
6. Move the Current Time Indicator to a different point on the Timeline. The current 

time appears in the counter next to the preview controls. 
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7. Change the channel values again. 

ct you want.  
8. Continue moving the Current Time Indicator and changing channel values until 

you achieve the effe
9. Click the OK icon to exit the Materials Lab.  
10. Click on the Preview Animation button to preview the material changes.  

 

 

Animating Texture Components 

Animating a texture component is an effective way of creating motion within a material. 
When you change the orientation, position, or scale within a texture component, the 
texture elements (like dots, checks or patterns) will appear to move.  
You can use this technique to create realistic wave motion in a water texture. If you 
change the position of the texture pattern at different points in the Timeline, the waves 
will appear to move over the surface of the object.  
If you wish to avoid unexpected texture movement during a texture animation, use 
Object Space mapping mode for the texture. This way the texture moves as the object 
moves. However, you can create some very interesting effects using World Space.  
You can also animate a texture component by altering the makeup of the texture using 
the Deep Texture Editor. Using the Deep Texture Editor you can change the make-up of 
any or all of the four texture components in a material.  
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To animate a material's texture components:  
1. Select an object.   
2. Click the triangle ic

e
 

on in the Animation Controls and make sure Auto-Key is 
nabled. 

 
3. Apply a material preset from the Materials Preset Library. Click the  button that 

appears next to the object's bounding box. The Materials Lab appears.  
4. Move the Current Time Indicator to the point where you want to start changing 

the material.  
 

 
5. Click the button in the upper left corner of the texture component window. Th

Transformation Tools palette appears. 
e 

 

 
6. Adjust the position, orientation, and/or scale of the texture and click the T butt

to exit the pa
on 

lette. 

©2007 DAZ 3D, Inc.  1191 



Bryce 6 Artist Guide 

 

 
7. Click the pink button in the upper-left corner of the texture component window. 

The Deep Texture Editor appears. 
 

 
8. Adjust the values of the texture's components and click the OK icon to close the 

editor. 
9. Move the Current Time Indicator to a different point on the Timeline. The current 

time appears in the counter next to the preview controls.  
10. Change the texture properties again.  
11. Continue moving the Current Time Indicator and changing texture properties until 

you achieve the effect you want.  
 

 
12. Click the OK icon to exit the Materials Lab. 
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13. Click the Animation Preview button to see the result.  
 
Example using a different texture: 
 

 

Animating Between Materials 

Animating channel values or texture components is a good way of creating subtle 
effects in a material, but to create more dramatic action, you'll need to animate between 
two completely different materials.  
This is how you create a transition from rock to glass, or wood to metal. For example, 
the transition between rock and marble in these temple columns was created using two 
completely different materials.  

  
Animating between materials is exactly like creating two different materials for the sam
object. As long as the Auto-Key mode is enabled, all yo
events, so you can set up a material at one 

e 
ur settings are recorded as key 

point in time and then move to a different 
point on the Timeline and create a completely different material. 

ou can 
ern, or bumpiness of a texture.  

• Using the Preset Materials Library, you can quickly apply a different material to 
the object.  

There are two quick ways of creating different materials: 
• By switching the Texture Component used to set a material channel, y

completely change the color, patt
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Previewing Material Animations 

Any change you make to a material's properties are displayed in the Material Preview 
Area. When you play a material animation, the same preview area shows you the 
transition of the material from one key event to the other. This is not the most effective 
way to see a material animation. The best way of seeing a material transformation is by 
rendering the scene.  
To preview a material animation in the Materials Lab: 

1. Click the Play button in the Animation Controls at the bottom of the Materials 
Lab. 

2. Click the Stop button to stop the preview. 
To preview a material animation in the Working window:  

1. Click the Play button in the Animation Controls at the bottom of the Working 
window. The material animation shows in the Nano-Preview.  

2. Click the Preview Animation button in the Animation Controls at the bottom of the 
Working window. The storyboard preview comes up showing the material 
animation. 
 

 

Animating Terrains 

Terr i  a n objects are animated by changing their properties in the Terrain Editor.  
This section assumes that you're familiar with the concepts and procedures involved in 
creating terrains. Refer to "Terrain Editor" fo
changing the shape of your landscape at different points on the Timeline you can 

r more on creating and editing terrains. By 

simulate geological events like earthquakes or erosion.  

cale paintbrush to totally change the geometry of the 
There are several techniques you can use to control how the shape of your terrain 
changes. You can use the grays
terrain by adding new peaks and valley or you can use the Filtering tools to add small 
changes in elevation to the terrain.  
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Terrain animations are created using the Animation Controls that appear at the bottom
of the Terrain Editor.  

 

 
The Timeline in the Terrain Editor is the same as the one in the Working window except 
for the Auto-Key option. All the key events recorded for object transformations and 
material changes are displayed in the Timeline. The Animation Controls in the Terrain 
Editor can perform all the same functions as the those in the Working window.  

Animating Terrain Geometry 

There are two ways of changing the geometry of a terrain object: by painting directly on 
the 2D Preview or by applying an elevation effect. When you paint on the canvas you 
create large changes in the terrain like the creation of new mountains or valleys.  
The violent motion of great rock columns shooting up from the ground was created by 
applying the Mounds filter onto an existing terrain at different points along the timeline.  
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When you apply an effect you create smaller more subtle changes like a mountain 
eroding over time. 
You can also use this technique to record how a terrain object was formed. By adjusting 
the Current Time as you add elements to the terrain, you'll have a complete record of all 
your steps. 
To animate terrain geometry: 
Click a terrain object.   

1. Click the triangle icon in the Animation Controls and make sure Auto-Key is 
enabled.   
 

 
2. Click the  button that appears next to the terrain object's bounding box. The 

ly one 

e shape of the terrain again using an effect or the paintbrush.   

Terrain Editor appears.  
3. Move the Current Time Indicator to the point in the Timeline where you want the 

terrain to change.   
4. Either paint new areas in the terrain using the Grayscale paintbrush or app

of the effects in the Elevation tab.  
5. Move the Current Time Indicator to a different point on the Timeline.  
6. Change th
7. Continue moving the Current Time Indicator and changing the terrain's shape 

until you achieve the desired effect. 
8. Click the OK icon to exit the editor.  
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Animating Terrain Filtering 

By animating the shape of a terrain object's Filtering Graph you can create some very 

o 

tairs in 
ring graph at different points in the timeline. 

specific geometry effects.  
For example, you can make specific areas of your terrain sink to simulate the damage 
caused by an earthquake. To create this effect you would darken only areas you want t
sink in the Filtering Graph. Likewise, you create the effect of ridges forming by 
lightening specific areas of the graph. For example, the gradual appearance of s
this terrain was created by adjusting the filte

  

  

  
You can also use the Filtering Graph to gradually raise or lower the entire terrain over 
the course of your animation. 
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To animate terrain filtering: 
1. Click a terrain object.   
2. C

enabled.   
lick the triangle icon in the Animation Controls and make sure Auto-Key is 

 

 
3. Click the  button that appears next to the terrain object's bounding box. The 

Terrain Editor appears.  
4. Move the Current Time Indicator to the point in the Timeline where you want the 

terrain to change.   
5. Click the Filtering tab.  
6. Adjust the shape of the Filtering Graph or select a preset filter.   
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7. Click on Apply to apply the filter.  
 

 
8. Move the Current Time Indicator to a different point on the Timeline.  
9. Change the shape of the graph again. 

rain's graph 
 the desired effect.   

The setting of the Terrain Clipping Bracket can also be animated. As areas of the terrain 
are clipped, they're removed from the terrain object in the scene. Your terrain will look 
like it's breaking up, or like portions it are falling into the sea. For example, the gradual 
destruction of this island was created by changing the length of the clipping bracket at 
different points in the Timeline.  

10. Continue moving the Current Time Indicator and changing the ter
until you have

11. Click the OK icon to exit the editor.   

Animating Terrain Clipping 
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To animate terrain clipping: 

1. Click a terrain object.   
2. Click the triangle icon in the Animation Controls and make sure Auto-Key is 

enabled.   
 

 
3. Click the  button that appears next to the terrain object's bounding box. The 

Terrain Editor appears.  
4. Mo

terrain to change.   
ve the Current Time Indicator to the point in the Timeline where you want the 

on 5. If the Clipping Bracket is not visible, click on the Display Clipping Bracket butt
at the top right of the Terrain Canvas.  
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6. Click+drag up on the bottom of the Clipping Bracket to adjust the length of the 

Clipping Bracket.  
 

  
7. Move the Current Time
8. Ch

 Indicator to a different point on the Timeline.  
ange the length of the bracket again.   

Previewing Terrain Animations 

Any change you make to a terrain's properties appear in the 3D Terrain Preview. When 
you play a terrain animation, the same preview area shows you the transition of the 
terrain from one key event to the other.  
To preview a terrain animation in the Terrain Editor:  

1. Click the Play button in the Animation Controls at the bottom of the Terrain 
Editor.  

2. Click the Stop button to stop the preview.  
Please note that if you exit the Terrain Editor, then re-enter it, the Terrain Canvas and 
3D Terrain Preview will show the terrain at the current frame in the Working window. 
The Animation Controls can be used to animate the terrain in the 3D Terrain Preview 
but the Terrain Canvas will not update to match the preview. To update the terrain at a 

9. Continue moving the Current Time Indicator and changing the length of the 
bracket until you achieve the desired effect.  

10. Click the OK icon to exit the editor.   
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different frame, exit the Terrain Editor, move the Current Time Indicator to the frame you 
want, then re-enter the Terrain Editor.  
To preview a terrain animation in the Working window:  

1. Click the Play button in the Animation Controls at the bottom of the Working 
window. The terrain animation shows in the Nano-Preview.  

2. Click the Preview Animation button in the Animation Controls at the bottom of the 
Working window. The storyboard preview comes up showing the terrain 
animation. 
 

 

Anim ting Skies 

All the properties of a Bryce sky can be animated. This means that any attribute you can 
b dialog can be animated using the Animation 

sumes that you're familiar with the concepts 

a

set in the Sky & Fog palette or the Sky La
Controls on the Timeline. This section as
and procedures involved in creating skies. Refer to "Sky & Fog Palette" for more on 
creating skies. 
By changing the attributes in the Sky & Fog palette at different points in the timeline, 
you can animate everything from the position of the sun to the color of the clouds. For 
example, you can simulate changes in the time of day by changing the position of the 
sun over time.  
There are several techniques you can use to add motion to your skies. You can animate
all or some of the properties of your sky. You can activate and deactivate sky effects a
different points in the animation. You can also a

 
t 

nimate the position of the sun or moon.  
e Sky animations are created using the Animation tools in the Working window and in th

Sky Lab dialog.  
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Animating Sky & Fog Settings 

Animating Sky & Fog settings changes the properties of a sky over time. For example a 
scene can become cloudier or darker during an animation. The intensity of the change 

 sky 
depends on how many properties you adjust and the amount of each adjustment.  
In this example, the animation of approaching sunset was achieved by changing the
settings at the end of the Timeline to a sunset.  

  
Most Sky & Fog properties can be changed using the thumbnail controls. Other settings 
are available in the Sky Lab dialog.  
You won't be able to see the effects of a sky animation until you render the entire 
animation. 
To animate Sky & Fog settings: 

1. Click the triangle icon in the Animation controls and make sure Auto-Key is 
enabled.  
 

 
2. Move the Current Time Indicator to the point in the Timeline where you want the 

sky to change. 
3. Adjust the sky's properties using the Sky & Fog palette controls.  
4. If the property to be changed is in the Sky Lab, enter the Sky Lab and adjust the 

property there.  
5. Move the Current Time Indicator to a different point on the Timeline. Change the 

properties of the sky again.  
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6. Continue moving the Current Time Indicator and changing the sky's properti
until you achieve the desired effect.  

Animating Clouds 

es 

our environment by setting up cloud motion 
Bryce automatically moves the clouds in your 

ters are set in the Sky Lab dialog. The Cloud Direction control lets 

distortion of the clouds. Refer to "Setting Cloud Motion

You can create the effect of wind in y
parameters. Based on your settings, 
environment to create motion.  
Cloud motion parame
you set the direction for cloud motion, while the other controls set the speed and 

" for more information on setting 
cloud motion in animations.  
To animate clouds:  

1. Click the triangle icon in the Animation controls and make sure Auto-Key is 
enabled.  
 

 
2. If it's not already visible, display the Sky & Fog palette by clicking the text item on 

the menu bar.   
 

 
3. Click the Sky Lab button. The Sky Lab dialog appears.   

 
 

4. Click the Cloud Cover tab.  
 

 
5. Move the direction indic

clouds as they move in
ator in the Cloud Motion controls to set a direction for the 

 the animation.  
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6. Adjust the Speed control t
speed value.   

o set how fast the clouds move. You can also enter a 

 

 
7. Adjust the Turbulence control to set how much the clouds will distort as they 

move. You can also enter a turbulence value.  
 

 
8. Click on the OK icon to close the dialog.   

Animating Environmental Effects 

Many environmental effects like rainbows and fog are not permanent features of a sky. 
ay. You can simulate this action by 
 effects at different points along the 

on the Atmosphere tab of the Sky Lab dialog. 
You can also animate the various settings for an effect. For example, the radius of 

se of your animation. 
To animate environmental effects: 

They appear for a brief time and then fade w
changing the properties of the environmental
Timeline.  
Environmental effects controls are located 

moon rings can increase or decrease during the cour

1. Click the triangle icon in the Animation controls and make sure Auto-Key is 
enabled.  
 

 
2. Move the Current Time Indicator to the point in the Timeline where you want the 

sky to change. 
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3. If it's not a
the menu

lready visible, display the Sky & Fog palette by clicking the text item on 
 bar.   

 
 

4. Click the Sky Lab button. The Sky Lab dialog appears.   
 

 
5. Click the Atmosphere tab.  

 

 
6. Change the properties of an effect: Fog, Haze, Rainbow, Blend with Sun, 

Volumetric World, and/or Color Perspective.   
7. Move the Current Time Indicator to a different point on the Timeline.  

e desired effect.  

n Position 

osition of the sun and the 

ample, the passage of time is 

sky are linked, the other properties of the sky like Ambient 
Light change as the position of the sun changes, adding to the realism of the effect.  
For the moon, you can also change its phases, so you simulate the passage of an entire 
month just by adjusting the moon attributes.  
To animate the Sun or Moon position:  

ls and make sure Auto-Key is 
enabled.   

nt Time Indicator to the point in the Timeline where you want the 

ky & 

8. Change the properties of the effect again.   
9. Continue moving the Current Time Indicator and changing the effect's properties 

until you have th
10. Click on the OK icon to close the dialog.  

Animating Sun/Moo

One of the most spectacular effects you can create using the scene's sky is elapsed 
time. In the great outdoors we perceive time in relation to the p
brightness of the sky. By changing the position of the sun or moon you can simulate 
time passing in terms of days or months. In this ex
simulated by the change in the sun's position.  
Since all the elements in the 

1. Click the triangle icon in the Animation contro

2. Move the Curre
sky to change. 

3. Adjust the position of the sun or moon using the Sun Position control in the S
Fog palette.  

4. Move the Current Time Indicator to a different point on the timeline.  
5. Change the position of the sun or moon again.  
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6. Continue moving the Current Time Indicator and changing the sun or moon 
effect.  

Preview g Sky Animations 

ear in the Sky Lab Preview. When you 
nsition of the terrain from 

one key event to the other.  
To r

1. Controls at the bottom of the Sky Lab .  

To preview a sky animation in the Working window:  

comes up showing the sky animation.  
 

position until you achieve the desired 

in

Any change you make to a sky 's properties app
play a sky animation, the same preview area shows you the tra

p eview a sky animation in the Sky Lab:  
Click the Play button in the Animation 

2. Click the Stop button to stop the preview.  

1. Click the Play button in the Animation Controls at the bottom of the Working 
window. The sky animation shows in the Nano-Preview.  

2. Click the Preview Animation button in the Animation Controls at the bottom of the 
Working window. The storyboard preview 

 

Importing Animations from DAZ Studio 

Bryce 6 adds the capability to import animations from DS. You can also import saved 
Poser scenes containing animations into DS, then import them into Bryce.  
Refer to "Importing Animations via DS Link" for more on importing animations from DS.  

QuickTime VR 

QuickTime VR allows you to take a 360&deg; panoramic image, and make it into a VR 
Movie; this unique movie will display a 2D panoramic representation of your 3D world 
and allow point and click navigation through the world. You can look up, down, and 
around your rendered scene as though you were a camera on a tripod.  
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Further, QuickTime VR lets you create "Nodes" or hotspots in the movie where you can 
round a landscape, and 
 view the entire 

er specialized technology from 
ck and drag to, in effect, "pick up" any object in the VR movie 

and examine it from all sides, as if you literally picked it up and turned it around and 
around in your hands. 

Creating QuickTime VR Panoramas 

The process of creating a panorama involves completing a few easy steps.  
To create QuickTime VR Panoramas: 

1. Choose Default in the Document Setup dialog.  
2. Click on the uppermost Views Memory Dot in the control palette, to make sure 

 in Camera View mode to check your 
 working in Top View.   

 to check the view of 

a visually interesting scene, 
switch back to Camera View and do a quick test render.   

6. After the render, make any required position changes.   
7. Choose File> Document Setup and select QTVR Panorama. This aspect ratio is 

optimized for use with Apple's Make QTVR Panorama tool, though many aspects 
will work. The preferred aspect is 13:4. Width must be divisible by 96, and height 
must be divisible by 4. The QTVR Panorama option ensures that your image 
meets these criteria.   

8. Click the triangle icon next to the Render controls and choose Select 360&deg; 
Panorama from the menu. 

9. Click the Render button to do a quick test render. The panoramic render mode 
necessarily introduces some distortion into your image, and this may change the 
way you want your objects to appear.  

10. Make any position changes you like. When you do a panoramic render, your 
wireframe scene will bear little resemblance to the rendered scene. This is why 
you should work on your scene in standard Default mode, and switch to 
Panoramic rendering after everything is set up.   

11. Choose File menu >Render To Disk. The Render to Disk dialog appears.  

click and go to another linked movie. This means you can look a
seeing an interesting rock formation in the distance, click on it to
landscape from that new vantage point.  
These nodes can also contain "Object Movies" anoth
Apple that allows you to cli

your camera is level.  
3. Set up your scene. The important thing to remember is that for a successful 

360&deg; scene, you need interesting objects all around your camera. The best 
way to work on this is to go to the Top View, and position objects all the way 
around the camera. Keep the Nano-Preview
view while you are

4. Drag the tip of the camera around in the Working window
your scene from all directions.   

5. Once you have a good distribution of objects in 
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12. Leave the default settings. The Output Size in Pixels was set by the QTVR 
Panorama op

13. Setup dialog. The Print Resolution defaul
setting for the screen-resoluti

tion in the Document  
ts to 72dpi, which is the only acceptable 

on VR movies; and the Output Size in Inches is 
s to your benefit if you 

need to print out a 2D version of your VR scene.   
 OK icon.  

ting a QuickTime VR Panorama through step 11.  
tton if you made any changes after your test render.  

ose File > Export Image and choose QuickTime 
R from the list.  

4. Specify a location for the saved panorama, then click Save.   

Further VR Exploration 

This is a quick way to get started with simple, single-node QTVR movie-making. To 
create movies with other embedded nodes, or to get deeper into the world of QuickTime 
VR, contact Apple Computer.  

extra information. You can, however, use these feature

14. Click the
15. In the Save dialog, choose QuickTime VR, then click the Save button.   
16. Specify the location and file name for your rendered QuickTime VR panorama. 

Exporting QuickTime VR Panoramas 

To export a QuickTime VR Panorama: 
1. Follow the steps for crea
2. Click the Render bu
3. When the rendering is done, cho

V
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Torus Editor 
r lets you adjust the inner radius of any torus object. The preview is 

e inner radius. You can zoom in and out of the 
object from different angles by rotating 

Torus edito
automatically updated as you change th
preview window, and you can preview the torus 
the preview image. 
To display the Torus editor: 

1. Select a Torus object. 
2. Click the  icon that appears next to the object’s bounding box. 

To adjust the inner radius of a torus: 
1. In the Torus editor, drag on the Torus in the preview window. Release the mouse 

when the radius is the size you want. You can also specify the inner radius by 
typing a value in the Radius field or dragging on the arrows next to the Radius 
field. 
 

 
2. To zoom in and out in the Torus editor, hold down Ctrl+Opt/Alt and drag on the 

Torus in the Preview window. 
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3. To preview a torus from different angles in the Torus editor, either hold down Ctrl 
and drag on the Torus in the preview window or press Caps Lock to toggle the 
continuous spin mode. 
 

 
4. Once you're satisfied with the radius and size, click on the OK icon to accept the 

changes. 
 what you want. You can adjust the X, Y, 5. Check the edge of the torus to see if it's

and Z-size as needed to get different looks. 
 

   
You can  get all kinds of cool shapes by adjusting the radius and size of the torus object: 
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Mesh Editor 

ss of an object’s surface. You can smooth 
objects that are very rough or remove the smoothing previously applied to DXF objects. 
It is not a good idea to smooth or unsmooth stones. These objects are highly dependent 
upon the clumpiness of the polyhedral shape as well as the bumpiness in the assigned 
procedural texture to retain their realism. Smooth stones look very unnatural. 
To smooth imported objects or stones: 

1. Select the imported object or stone. 

Imported objects (such as OBJ or DXF objects) and native Stone objects are both 
treated as meshes inside Bryce. 
The Mesh Editor lets you adjust the smoothne

2. Click the  button that appears next to the object’s bounding box. 
3. Adjust the value of the smoothing range by dragging the gauge along the left s

of the dialog. 
ide 

 

 
 
The gauge sets the maximum angle you wish to be smoothed.  

For instance, you may wish to smooth all angles under 90° to preserve the 
of cubes. In that case, set the maximum angle to 85° before 

smoothing. 
on until you achieve the desired effect. The more you click, 

 

sharpness 

4. Click the Smooth butt
the smoother the object becomes. 

To unsmooth imported objects or stones: 
1. Click the imported object or stone. 
2. Click the  button that appears next to the object’s bounding box. 
3. Adjust the value of the smoothing range by dragging the gauge along the left side 

of the dialog. 
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The gauge sets the maximum angle you wish to be unsmoothed. 
 
For instance, you may wish to unsmooth all angles under 90°. In that case, set 
the maximum angle to 85° before unsmoothing. 

4. Click the Unsmooth button until you achieve the desired effect. The more you 
click, the sharper the object becomes. 

There are times when you will need to have an imported mesh be solid in order to use it 
in Boolean operations. When this is needed, enable Solid When Boolean Rendering. 
To export a mesh object: 

1. Select the mesh object you want to export. 
2. Click the  button next to the object’s bounding box. The Edit Mesh dialog 

appears. 
3. Click Cmd/Ctrl+D. The Save dialog appears. 

 location and filename for the mesh object. 

h DAZ Studio & Poser 
 is a complete virtual photo studio 

m 
 

 
ed the ability to add transparency map information into the MTL file, however, 

the transparency maps don't import into Bryce because the MTL file uses "map_d" while 
to "map_D" allows Bryce to import the 

, but the transmaps will not 
ded manually. 

One caveat when setting materials in DS or Poser, if the diffusion value is too low, 
w diffusion value and the object will look black. To prevent this, 

4. Choose a

Working wit
Bryce includes DAZ Studio (DS) as a plug-in. DS
where you can create scenes by adding and positioning figures, clothing, props, 
materials, lights, and more. Once you create one or more objects in your DS scene, 
exiting DS automatically brings these objects into Bryce, where you can work with the
just as you would any other Bryce object. With Bryce 6, you can also import animations
from DS. In addition, you can export objects from DS with specific settings for Bryce 
imports. 
Poser from e-frontiers also provides the ability to export OBJ files and Poser 6 SR2
implement

Bryce needs "map_D." Changing the "map_d" 
transmaps correctly. You'll still need to locate the textures
have to be ad

Bryce will also have a lo
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set the diffusion in DS/Poser to 1 prior to exporting, otherwise, you'll have to update 

S using the Launch 
e imported 

ts as primitives, meaning that bones and joints do not 
transfer between applications. 
Bryce creates one object per body part per material. For example, if a finger group has 
two materials (such as Skin and Nails), Bryce will create Pinky_Skin and Pinky_Nail 
objects. You can access these objects by ungrouping the imported object(s) or pressing 
Cmd/Ctrl and left-clicking on top of the object and choosing the required mesh from the 
list. 

ecommend setting material attributes 

1. Launch DS by clicking the Launch DAZ Studio button located at the right side of 
 will be launched.  

 

each mesh piece separately in Bryce. 

Importing Static Objects via Studio Link 
Bryce makes it extremely easy to import figures and props from D
DAZ Studio button. Scenes can also be set up in Poser, then the Poser scen
into Bryce via DS. 
Bryce treats imported DS objec

All DS material settings transfer to Bryce. We r
inside DS to take advantage of the material groups assigned to the DS objects. 
To import static objects from DS: 

the Create palette. DS

 
 
Remember to set the diffusion values to 1 prior to closing DS. 

2. Once you have created your DS scene, exit DS OR click on the Return to Bryce 
button to return to Bryce with your object(s) in your Bryce scene.  
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If the Return to Bryce button is not visible, choose View > Tools > Bryce while in 

se and Bryce will import the object(s). 

DS. 
 
DS will clo
 

 

Importing Animations via Studio Link 
Bryce 6 adds the ability to import full animations from D
keep the Bryce files down to a more manageabl

S, including textures. In order to 
e size, Bryce uses DS as an animation 

e 
e Bryce scene file 

f 
to Bryce is practically limitless (well, depending on what 

There are some known issues with this new function: 
• Breaking the link to DS deletes the animation in Bryce since the animation is 

stored in the .daz file. After breaking the link, closing the Bryce scene file, then 
re-opening the scene file, Bryce will re-import the animation and objects. You'll 
now have a static object from the original scene and a new object linked to the 

BREAK THE LINK TO DS FOR AN 

imation after breaking the link to a previous 
nstead of trying to import two or more separate 

S (either as one file or multiple, then 
merge), then import the full animation into Bryce. 

plug-in, saving the figure and the animation in a DS scene file instead of in the Bryce 
scene file. If the animation and objects were physically imported into Bryce, each fram
would require a new object which would increase the file size of th
and cause memory issues, effectively limiting the ability to import more than about 10 
seconds of animation. By using DS to store the objects and animations, the number o
frames that can be imported in
your machine can handle that is). 

"new" animation. Basically .... DON'T 
IMPORTED ANIMATIONS!!!! 

• Trying to import a second an
animation will crash Bryce. I
animations, build all the animations in D

©2007 DAZ 3D, Inc.  1215 



Bryce 6 Artist Guide 

To import animations from DS: 

ining a figure with an animation applied, apply a saved 
 figure, or import a BVH file. 

1. Launch DS by clicking the Launch DAZ Studio button located at the right side of 
the Create palette. 

2. Load a figure into DS and animate it using the Timeline tool. You can also import 
a saved Poser file conta
animation pose file to the
 

 
 
Remember to set the diffusion values to

3. O
Save As
h

 1 prior to closing DS. 
nce you have finished animating the figure, save the scene by choosing File > 

 > Scene from the menu. This is just a precaution because mistakes do 
appen. 
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 When the scene has finished saving, exit DS by clicking on the Return to Bryce 
button to return to Bryce with your object(s) in your Bryce scene. You can also 
return to Bryce by clicking on the X button in DS, pressing Ctrl-Q, or choosing 
File > Quit in DS. 
 

 
 
If the Return to Bryce button is not visible, choose View > Tools > Bryce while in 
DS. 

5. DS will close and Bryce will come back up from the background with the Import 
ation dialog showing. Accept the default of 0 to import the entire 

ber to start the import at. Please note 
e DS frame. 

Studio Anim
animation or enter the time or frame num
that currently, the frame import indicates the Bryce frame not th
 

 
6. Click on the OK icon to close the dialog and begin the import. Bryce will first 

7. The imported objects with animations will import at full Poser/DS size. Once 
imported, you can select all the objects, group them, then resize or move the 
group as needed. 

8. In the image below, note that the animation timeline is filled with the imported 
animation. You can preview the animation or play it, just remember that doing so 
will not be as smooth or fast as an animation containing a couple of objects. 
 
Note: Playing the animations is not compatible with the OpenGL display modes 
since the display cannot refresh quickly enough and the meshes break apart 
temporarily. 

convert the objects then the animation. 
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9. Setup and render the animation just as you would any other animation. 

make some changes to the animation. However, you do not want to just go back into 
DS and reimport the animation into Bryce. 

 
imation is 

mation is imported. 
To update an imported animation: 

1. Launch DS by clicking the Launch DAZ Studio button located at the right side of 
the Create palette. 

2. Modify the animation as needed, e DS, and the animation will import into 

Updating Imported Animations 
Once you've imported your animation from DS into Bryce, you may find that you need to 

When you import static objects from DS into Bryce, then go back into DS to make 
changes, Bryce deletes the old object and imports the updated object as a new object.
The same thing happens to the object(s) for an animation but the old an
deleted and the updated ani

 clos
Bryce. 
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Importing Static Objects via Studio Export 
It's not always practical to import figures from DS using the Launch DS link in Bryce. To 
help with this, DS provides a specific export filter for Bryce that takes into account how 
Br  addition, DS will gather all the 
image maps together into folders in the same folder as the OBJ. 
To import static objects from DS: 

1. Launch DS and load the figures, etc. you need for your scene. Remember to set 
the diffusion values to 1 prior to exporting from DS. 

2. Once you have created your DS scene, choose File > Export from the menu in 
DS. 

3. Make sure that Wavefront Object (*.obj) is selected, then enter a filename and 
click on Save to save the file to your computer.  
 

yce reads reflection, bump, and transparency maps. In

 
4. The Export dialog will come up. Choose Bryce from the pull-down menu and set 

the scale. The default is 100% but that is probably going to be too large once you 
return to Bryce. Start at 50% and modify it as needed as you gain experience. If 
parts of the figure have been set to invisible, check the Do not export Invisible 
Nodes option so they aren't brought into Bryce. 
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5. Click on the Advanced tab and select the options you want to export. Make sure 

you select to Convert Maps (for Bryce) especially if the maps include 
transparencies and bump maps. 

©2007 DAZ 3D, Inc.  1220 



Bryce 6 Artist Guide 

 

 
6. Click on Accept and DS will export the mesh and save the maps to a folder in the 

same directory as you saved the mesh to. It will also convert the maps so that 
Bryce can correctly import the bump maps, transparency maps, etc. 

7. Exit DS. 
8. Open Bryce and choose File > Import Object from the menu. The File Open 

dialog will come up. 
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9. Locate the mesh file and click on Open. Bryce will import the object. 
 

 

Breaking Link from Studio 
Sometimes it is necessary to break the lin
origina

• When you are finished modifying an imported object and are ready to finalize the 
scene. 

• When you want to duplicate an imported object but keep the original one. 
• When you want to remove parts of the imported content, the link to Studio will 

need to be broken before you can delete the part. Not breaking the link will delete 
all the imported content instead of just the part you wanted to remove.   
 
Just remember ... don't break the link to DS for an imported animation or the 
animation will no longer work. 

k between a static object in Bryce and the 
l file in DS, for example: 
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To break the link between DS and Bryce: 
1. Select the object group in Bryce that you want to break the link to. 
2. Choose Objects > Break DAZ Studio Link from the menu. 

 

 
3. The object is now a standalone object that can be manipulated without affecting 

the DS file. 
Remember, once you break the link between DS and Bryce, the object can no longer be 
modified via DS. 

ia Studio Link 
W
were
exitin e-imported into Bryce. 
Keep the following in mind when returning to DS to modify the figure/animation: 
When saving your Bryce scene with imported objects from DS, Bryce saves the DS 
scene along with the Bryce scene and automatically loads it the next time the scene is 
loaded. The Bryce file contains a live link between the scene and the saved DS scene. 
Because of this: 

1. Deleting a model in either program removes that object from both programs.  
2. You can edit DS objects in Bryce like any other object. However, if you go back 

into DS at any time, you will lose those edits since Bryce has to delete the 
previous object then re-import the new modified object.  

Editing Objects Imported v
hile working on your scene, you may find that you need to modify the objects that 

 imported from DS. This is done by launching DS again, modifying the figure, then 
g DS so that the modified figure and/or animation is r
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3. Saving the Bryce scene and closing Bryce does not break the DS link. If you are 
finished editing the figure/object, break the link to DS so the object becomes a 
standalone mesh in Bryce. 

4. If you modified the figure in Bryce by resizing or moving it, re-importing it from DS 
will place it at the original import location in Bryce. As long as the object size is 
the same as the original imported object, you can copy the object matrix before 
returning to DS, then paste the matrix on the re-imported figure in Bryce. 

To copy the settings from a DS imported object and paste on to a new version: 
1. Select the object group(s) in Bryce. 
2. Choose Edit > Copy Matrix from the menu. 

4. 
5. Edit > Paste Matrix from the menu. 

e parameters have changed so that the object matrix is 
maller than before, then using the Copy/Paste Matrix may alter the 

ported from Poser into Bryce, however, not all Poser material 
rted with the OBJ file includes basic color 

nd transparency maps (as of Poser 6 SR2). However, 
 instead of "map_D," the transmaps don't import into 

elow. 
To i

1. Launch Poser and load the figures, etc. you need for your scene. (You may need 
to hide the eyebrow mesh using the provided morphs for the figure.) 
 
Remember to set the diffusion values to 1 prior to exporting from Poser. 

2. Once you have created your Poser scene, choose File > Export > Wavefront 
OBJ from the menu. 

3. Launch DS from the Create Palette and modify the figure and/or animation. 
Exit DS and wait for the import to complete. 
Select the object group(s) and choose 
 
Remember that if the figur
larger or s
object incorrectly for the new matrix properties 

Importing Static Objects via Poser Export 
Figures can also be ex
settings transfer to Bryce. The MTL file expo
settings, textures, bump maps, a
since the MTL file uses "map_d"
Bryce. This is easily taken care of as shown b

mport static objects from Poser: 
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3. 
 
The Export Range dialog will come up. Choose Single Frame and click on OK.  

 
 
The Select Objects dialog will come up. 

 everything you want to export is selected 
nt exported is deselected (like Ground).  

4. Check the selections to make sure that
and anything you don't wa
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5. Click on OK. 
 
The Export Options dialog will come up. 

6. Select the export options you want to export. 
 

 
7. Click on OK to accept the settings. 

e up. Navigate to the folder where you want to save 8. The Export as dialog will com
the OBJ file and rename the file. 
 

 
9. Click on Save. The file will be exported to the selected directory. 
10. Close Poser. 
11. If the figure included transparency maps, navigate to the directory where you 

saved the OBJ file and open the matching MTL file in a text editor. 
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12. In the text editor, do a search/replace and replace "map_d" with "map_D." 
 

 
 

 
13. Save and close the MTL file. 
14. Open Bryce and choose File > Import Object from the menu. The File Open 

dialog will come up. 
15. Locate the mesh file and click on Open. 
16. Bryce will import the object 

 

 
 
then start asking you to locate the textures. For each texture it asks for, navigate 
to the textures folder where the image is located and click on Open. Continue 
until all textures have been imported. 
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17. When the import is complete, your object(s) will be very tiny. This is because 
Bryce imports static objects at their actual size and not scaled to match Poser. 
 

 
18. To increase the size of the object(s), you can manually resize it by using the 

Scaling tool or by dragging on the object handles. 
19. However, it is easier to resize using the 3D Transformation tool: { Click on Edit to 

bring up the Edit Palette, then click on the triangle under the Scaling tool. Choose 
3D Transformations from the menu. 
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20. Enter a percentage in the Size fields, such as 800%, then click on the chec
to accept the change. 
 

kmark 

 
21. The object(s) will resize by the entered amount, but may be above or below the 

 the triangle under the Align tool and choose Snap To ground plane. Click on
Ground from the menu: 
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22. The object(s) will snap up to the ground plane and your import is complete. 
 

 

Working With Objects 
Objects are the building blocks of your Bryce world. They can be used as props, to 
populate a scene, or to add detail to landscapes.  
An object is the most basic item in Bryce. Objects can be anything from terrains to 
pebbles. In Bryce, there are several ways of creating objects. Some objects use unique 
editors; others can be created by a simple one-step click. 
There are two main tools for creating objects. The Create Palette, which contains tools 
for creating objects with a single click, and the Preset Objects Library, which contains 
pre-made objects you can add to your scene.  
In a scene, the arrangement of objects is as important as their form. You can design 
beautiful landscapes, or build complex models, but if they're the wrong size or in the 
wrong position, they won't look right in the scene. To get the right look, you'll need to 
position or rotate the objects to make sure they are in the right places within the scene, 
or you may need to resize an object so that it is in proportion to the rest of the objects. 
These kinds of operations are called transformations.  
Bryce supports three basic types of transformations: size, position, and rotation. The 
tools in the Edit palette let you interactively perform these operations on any object in 
your scene. As well, the Object Attributes dialog lets you transform objects numerically 
for greater precision. 
As you arrange objects, you'll probably need to create some kind of object hierarchy. An 
object hierarchy lets you create a structure in your scene that organizes objects 
according to their spatial or logical relationships. The structure can make arranging 
objects much easier and faster.  
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You can create an object hierarchy by grouping and linking objects. The following 
to 

ight side of an object's 

 list vary depending on the type and number of objects selected.  

sections describe how to use the transformation tools and the Object Attributes dialog 
resize, reposition, rotate, align, and randomize objects. It also describes how to create 
object hierarchies.  

Object Control Palette 
The Object Control Palette appears as a list of buttons along the r
bounding box. The  
icons that appear in this

 
These icons let you:  

• access the Object Attributes dialog, the Materials Lab, and any editors 

• 

 

associated with the object  
• group and ungroup objects in a selection  
• add objects to families  
• land objects  
• link objects  

convert Booleans to mesh  
• set up object tracking  

If your selection falls outside of your Working window, the icons appear in the rightmost
area available on the screen. 
To display the Object Control Palette, select an object or group of objects.  
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Object Attributes Icon 

 
The Object Attributes icon control displays the Object Attributes dialog. When the dialog 
opens, it shows the current name, position, orientation, and scale of the object.  
The Object Attributes dialog is where you'll set up the object's name, size, orientation, 
placement, and display quality. It is most often used to numerically transform the object. 
When you're animating an object, the dialog is used to control how the object interacts 
with its motion path. Refer to "Animation" for more on animating. 
The Object Attributes dialog contains three tabs which let you set various object 
properties:  

• General: contains options that let you set the object name, position, size, 
rotation, and display quality.  

• Linking: contains options that let you set up a link between two objects. You can 
also use this tab to set up a tracking link.  

• Animation: contains options for controlling the display of motion paths and setting 
the motion path type. To display the Object Attributes dialog:  

To open the Object Attributes dialog: 
1. Select an object or group of objects.  
2. Choose Objects > Edit Attributes or press Cmd/Ctrl+Opt/Alt+E or click the  icon 

next to the object's bounding box. 

 
3. Click on a tab to access the required options: 

• General Tab 
• Linking Tab 
• Animation Tab 

©2007 DAZ 3D, Inc.  1232 



Bryce 6 Artist Guide 

General Tab 

The General tab contains controls for setting the object's name and display attributes 
and position. 

Object Name 

The Object Name field in the General tab of the Object Attributes dialog lets you name a 
selected object. 
When you create an object, the first thing you should do is assign a name to it. An 
object's name identifies it within the scene.  
You can select objects, by name, using the Selection palette. The name can also help 
you distinguish a specific object when your scene contains more than one object of the 
same type. Refer to "Selecting Objects" for more information.  
The name is also used to identify an object in a hierarchy. Object hierarchies a
the Hierarchy List area of the Advanced Motion Lab. Refer to "

ppear in 
Object Hierarchies" for 

more on hierarchies.  
also used when creating parent-child links and setting object 

To name an object:  
1. Select an object.  

An object's name is 
tracking.  

2. Click the  icon that appears next to its bounding box. 
 
The Object Attributes dialog will come up. 

3. Select the current Object Name and type in a new name. 
 

 
4. Click on the OK icon to accept the changes. 

Boolean Attributes  

Boolean attributes, listed in the General tab of the Object Attributes dialog, control how 
an object acts in a Boolean operation. For example, if a Boolean attribute is set to 
Negative, the object subtracts an area from a positive object. These are examples of 
some of the objects you can create using Boolean operations. Refer to "Boolean 
Operations" for a complete discussion of Boolean operations.  
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To set an object's Boolean attributes:  
1. Display the Object Attributes dialog.  

 

 
2. Make sure the General tab is displayed. 

t the top of the dialog: 
ines any selected object, objects, or group as non-Boolean. No 
eration can be performed on a neutral object. This is the 

default setting for all objects.  
• Positive: defines any selected object, objects, or group as solid when 

a "cutting object."  
 any selected object, objects, or group as an intersecting 

3. Enable one of the check boxes a
• Neutral: def

Boolean op

grouped.  
• Negative: defines any selected object, objects, or group as negative when 

grouped. Think of a negative object as 
• Intersect: defines

object when grouped.  
 

 

Transfer Material of Negative Boolean  

In the Object Attributes dialog under the General tab there is a option called "Transfer 
Material of Negative Boolean." When selected, this transfers the material of the negative 
Boolean object in a group to the area of contact on the positive Boolean object.  
For example, in the first image below, a green positive sphere is Booleaned by a red 
negative sphere giving a kind of green bowl with a red interior. The second image 
shows the same Boolean group but this time, the Transfer Material of Negative Boolean 
option is disabled, so the interior of the bowl is green.  
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To enable transfer material of negative Boolean:  

1. Select an object.  
2. Click the  icon that appears next to its bounding box.   
3. On the General Tab, enable the Negative radio button. Transfer Material of 

Negative Boolean will be selected by default. 
 

 
4. Click the OK icon to exit the Object Attributes dialog.   
5. Select all objects that are to be part of the group and click the  button next to 

the selected objects' bounding box.  
To disable transfer material of negative Boolean:  

1. Select an object.  
2. Click the  icon that appears next to its bounding box.   
3. On the General Tab, enable the Negative radio button. Transfer Material of 

Negative Boolean will be selected by default.   
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4. Click on the checkmark next to Transfer Material of Negative
the option.   
 

 Boolean to disable 

 
5. Click the OK icon to exit the Object Attributes dialog.  

to Unity command. 
t by using the Set As Unity function. 
bject to whatever it was when you 

1. Create an object and modify it. 
 

Set As Unity 

After editing an object for a while, you may find a shape you don't like and would like to 
reset the object to its original shape, you can revert the shape using the unreposition, 
unrotate, and unscale commands. 
You can also use the Reset 
However, you can change the Unity of any objec
This function changes the default of the current o
selected the menu command. 
To set an object as unity: 

 
2. Click on the  icon next to the selected object to access the Object Attributes 

dialog. 
3. Choose Set As Unity from the Coordinates menu. 

 

 

©2007 DAZ 3D, Inc.  1236 



Bryce 6 Artist Guide 

4. Click on OK to exit the dial
5. Make changes to the objec

og. 
t, then hold down Control/Ctrl+Alt and click one of the 

bounding box handles. The object will revert to the shape you set as unity. 

Remove Shear 

While it is possible to skew objects in Bryce, this is usually done by accident and isn't 
desirable. 
To reset the object back to the default: 

1. Select the object. 
2. Click on the  icon next to the selected object to access the Object Attributes 

dialog. 
3. Choose Remove Shear from the Coordinates menu. 

 

 
4. Click on the OK icon to accept the changes. The object will revert back to its 

default shape. 
 
If you chose Set As Unity before removing shear, well ... the skewing is now the 
default and you'll need to create a new object and start over. 

Editing Transformation Attributes 

The numeric entry fields on t Attributes dialog describe an 
ze in 3D space. You can adjust these attributes by 
umeric fields. 

he General tab of the Object 
dobject’s position, orientation, an  si

entering values in one or all of the n

 
To the far right of the Origin, Position, and Size fields are B's standing for "Bryce Units" 
and a degree symbol next to the Rotated field for degrees of rotation. 

e World Space X, Y, and Z-axes as a 
The values in this dialog use either Absolute or Definition coordinates for 
transformations. Absolute coordinates use th
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reference for transformations. Definition coordinates redefine how the object is cre
in Object Space. 
Refer to “

ated 

Coordinate Systems” for more on these coordinate systems. 
Using Definition coordinates can create some unpredictable results because you’
redefining the entire object when you change the Offset, Rotate, and Size values. 

Origin F

1. Displ y t
2. Make sure the General tab is displayed. 
3. Enter values in the Origin X, Y, and Z fields. 

 

re 

ields  

The origin point is the center of the object, so when you change the Origin values, the 
position of the object changes as well. 
To set an object’s origin point: 

a he Object Attributes dialog. 

 
4. Click on the OK icon to exit the dialog. 

To set an object's origin point without moving the object: 
1. Display the Object Attributes dialog. 
2. Make sure the General tab is displayed. 
3. Click on the red padlock icon next to the Origin and Position fields. 
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The icon will change to a gray padlock with the shackle open. 
 

 
 
You can now change the Origin values without moving the camera. 

4. Enter values in the Origin X, Y, and Z fields.  
 

 
5. Click on the OK icon to exit the dialog. The new Origin Point location can be seen 

in the scene as a green dot if you selected to Show Origin Handle. 
 

 
6. If you go back into the Object Attributes dialog, the padlock will be l

so that the new origin point and the object's position are linked again allowing 
normal operations to be performed on the object. 

ocked again 

To reset the object's origin point: 
1. Hold down Shift and click on the origin point. 

 
or  

2. Enter the Object Attributes dialog. 
3. Unlock the padlock. 
4. Set the Origin values to match the Position values. 
5. Click on the unlatched lock to lock the fields. 
6. Click on OK to exit the dialog. 
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Position Fields  

To set an object’s position: 
1. D
2. Make sure the General tab is displayed. 

isplay the Object Attributes dialog. 

3. Enter a value in the Position X field to set the object’s position on the X axis. This 
axis moves the object left or right. 

4. Enter a value in the Position Y field to set the object’s position on the Y axis. This 
axis moves the object up or down. 

5. Enter a value in the Position Z field to set the object’s position on the Z axis. This 
axis moves the object backward or forward. 
 

 
6. Click on the OK icon to exit the dialog. 

When you select multiple objects and access this dialog, there are no values displayed 
in the Position fields. If you then enter a value in any field, the selected objects are 
moved to the new coordinate(s). 
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Rotate Fields  

To rotate an object: 
1. Display the Object Attributes dialog. 
2. Make sure the General tab is displayed. 
3. Enter a value in the Rotate X field to set the object’s rotation around the X axis.  

e reduces the value to an absolute value within a range of 0° - 360°. 
 axis. 

ield to set the object’s position on the Z axis. 

 
You can enter negative values, values greater than 360° or values less than -
360°. Bryc

4. Enter a value in the Rotate Y field to set the object’s position on the Y
5. Enter a value in the Rotate Z f

 

 
6. Click on the OK icon to exit the dialog. 

Size Fields  

To set an object’s size: 
1. Display the Object Attributes dialog. 
2. Make sure the General tab is displayed. 
3. Enter a value in the Size X field to set the object’s size in the X axis. 

 
You can enter negative values here if you need to. 

4. Enter a value in the Size Y field to set the object’s size in the Y axis. 
5. Enter a value in the Size Z field to set the object’s size in the Z axis. 

 

 
6. Click on the OK icon to exit the dialog. 
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When you select mult
in the Size fields. If yo

iple objects and access this dialog, there are no values displayed 
u then enter a value in any Size field, the selected objects are 

scaled to the new coordinate. 

u 
ome of these options can 

h  u apply this option to an object, it is not rendered when you render your scene.  
The object remains visible in the Working window, where you can still select and edit it, 

ttributes dialog. 
2. Make sure the General tab is displayed. 
3. Enable the Hidden button. 

 

Display Quality Attributes 

The display options available in the General tab of the Object Attributes dialog let yo
control how the object appears in the Working window. S
speed up the redraw of your scene.  

Hidden  

W en yo

but it will not display in the final render.  
To hide an object: 

1. Display the Object A

 
4. Click on the OK icon to exit the dialog. 

To lock an object:  
butes dialog.  
 tab is displayed.   

Locked  

This option locks any selected object, objects, or group, preventing unintentional 
changes to size, position, or rotation. Locked objects appear grayed out in your 
wireframe view.  

1. Display the Object Attri
2. Make sure the General
3. Enable the Locked button.  
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4. Click on the OK icon to exit the dialog. 
To select a locked object: 

1. Press Cmd/Ctrl, click on the object, and select it from the popup list. 
 

 
 
OR 

2. Click the Time Selection Palette toggle at the bottom of the Working window to 

 

display the Selection palette. Use the Time Selection Palette toggle to switch 
between the Animation controls and the Selection palette.  

3. Click an object type button, and choose the desired object from the menu that 
appears.  

 
4. Display the Object Attributes dialog.  
5. Make sure the General tab is displayed.   
6. Disable the Locked button. 
7. Click on the OK icon to exit the dialog. 

Show as Box  

This option displays any selected object, objects, or group as a box. This is useful when 
you just want to work with the object's position. It can speed up work in a complex 
scene because it displays simpler objects. You can still manipulate your object using the 
bounding box control points.  
To display an object as a box:  

1. Display the Object Attributes dialog.  
2. Make sure the General tab is displayed.   
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3. Enable the Show as B
 

ox button.  

 
4. Click on the OK icon to exit the dialog. 

 
Result: 
 

 

Show Origin Handle 

This option displays the selected object's
the point to change the object's center o

 origin point. You can then edit the position of 
f rotation. Refer to "Object Origin Points" for 

3. Enable the Show Origin Handle button.   

more on origin points.  
To display an object's origin point:  

1. Display the Object Attributes dialog.  
2. Make sure the General tab is displayed.   

 

 
4. Click on the OK icon to exit the dialog. 

 
The origin handle will show up as a green dot when the object is selected. 
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Linking Tab 

Link attributes control how an object is linked to another. The controls on the Linking tab 
of the Object Attributes dialog let you set parent-child link attributes and tracking 
attributes.  

Linking Objects 

When you link two objects, you connect them in a Parent-Child link.  
In a parent-child link, the parent controls the actions of the child. This means that when 
the parent object moves, so does the child object. However, when the child object 
moves, the parent object does not.  
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A child object will start its moveme
constant distance from the parent

nt from its original position and always maintain a 
. The distance is determined by the original positions 

of the objects before they were linked. The movement of the child object depends 
e parent object.  

e child will orbit around it like a moon around a planet.  
entirely on the type of transformations you apply to th
If you rotate the parent, th

 
If the parent is moving along a path, the child will match the trajectory of the parent's 
path, but maintain a constant distance from the parent object.  

 
If both the parent and the child are moving along a path, the child object moves alon
path while matching the trajectory

g its 
 of the parent object's path.  

 
Objects can also be linked to a path for animations. See "Geometric Path Linking" for 
more information on this option. 
See "Link to Parent Icon" for information on linking objects interactively. 
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To link objects in the Object Attributes dialog:  
1. Display the Object Attributes dialog.  
2. Click the Linking tab. 
3. Click the Object Parent Name field and choose a name from the menu that 

appears. Choose None to break a link. 
 

 
4. Enable a Propagate option or disable the ones you do not want to use. These 

options control which parent object transformations are applied to child objects 
and how objects are constrained when they're linked to a path.  
 
 

 
5. Click on the OK icon to exit the dialog. 
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Examples: 
• Rotation 

 

 
• Offset - parent moved, child moves with it 

 

 
• Size 

 

 

Tracking Objects 

When you set up a tracking link, the stationary object tracks the target object as it 
moves or rotates. Whenever the target object moves, the stationary object pivots so th
it's always facing the target. 

at 
The Tracking options let you set the target object for the 

selected object and define which axis of the stationary object will face the target.  
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To set an object to track another:  
1. Display the Object Attributes dialog.  
2. Click the Linking tab.   
3. Click the Track Object Name field and choose a name from the menu that 

appears. Choose None to break a tracking link.  
 

 
4. Enable one of the Orientation options. These options set which object axis will 

track the target.   

Web Link  

Use Bryce to get your images on the Web! Bryce will export an HTML page with your 
rendered image, along with any hotspot links associated with the objects in your scene.  
With the HTML dialog, you can set your Web page title, the server directory for the page 
(either your local hard disk or the Web host), the name of the JPEG file for the image, 
your e-mail address, and the Background URL.  
Also, in the dialog are two sliders -one for the level of JPEG compression, and the other 
for how precise you wish the hotspot polygons to be. Bryce will then generate the HTML 
page and the JPEG image file for you, ready to be brought straight onto the Web. To 
create an HTML page:  
To add a web link to an object:  

1. Select the objects that will become hotspot links.  
2. Click the  icon to display the Object Attributes dialog.   
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3. Click the Linking T
 

ab, and enter an URL in the Web Link box.  

 
4  C. lick on the OK icon to exit the dialog. 
5. When you are done with your scene, render the scene to disk as an HTML file.  

Animation Tab 

Animation attributes control the display of an object's motion path. A motion path is a 
graphical representation of an object's trajectory over the course of the animation. Refer 
to "Motion Paths" for more on motion paths. The options on the Animation tab of the 
Object Attributes dialog let you control how an object's motion path is displayed in the 
Working window and how that path is drawn.  

Motion Path Display Options  

 is displayed as it is being drawn and when the object is 
 the Animation tab of the Object Attributes 

s displayed.  
y options: 

Normally, a motion path
selected. The motion path display options on
dialog let you control when the motion path i
To set motion path displa

1. Display the Object Attributes dialog. 
2. Click the Animation tab. 
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3. Enable one or all of the display options: 
• Hide Trajectory: enables or disables the display of the motion path. When 

 is drawn. it is disabled, no motion path
 

 
• Show When Selected: displays the motion path only when the object is 

selected. 
 

 
• Show Always: displays the motion pat  at all times, even when the object 

is not selected. 
 

h
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Motion Path Attributes  

When a motion path is created, it looks like a curve that extends out from an object. The 
motion path attributes let you display additional information on a motion path.  
To set motion path attributes:  

1. Display the Object Attributes dialog.  
2. Click the Animation tab.  

 

 
3. Enable one or all of the attributes:  

• Show Handles: displays or hides the path's control handles. The handles 
represent key frames. The image below shows the handles hidden with the 
image in step 2 showing the handles shown. 
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• Show Tangents: hides or displays lines extending from each control handle. 
Tangents help you see the slope of the curve.  
 

 
• Show as Ribbon: displays the motion path as a flat ribbon in the working 

window. This makes the path easier to see when you move the camera.  
 

 

Align Options  

Normally, unless you apply a rotation, an object's orientation remains constant as it 
moves along a motion path. The align options let you force the object's orientation to 
match the slope of the motion path so that as the path curves up, the object tilts up.  
To set align options:  

1. Display the Object Attributes dialog.  
2. Click the Animation tab.  
3. Enable one of the following options:   

• Do Not Align: disables aligning. The shape of the curve has no effect on 
the object's orientation.  
 
This is the default setting. 
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• Align: adjusts the object so that its orientation matches the shape of the 
path.  
 

 

Motion Path Geometry Options  

ry options let you change the shape of 
the path to create different effects.  
To set motion path geometry options:  

1. Display the Object Attributes dialog.  
2. Click the Animation tab.  
3. Enable one or all of the options:  

• Make One Shot: performs the motion once and does not repeat the 
motion.  

• Make Repeat: creates a loop in the action. The motion on the path will 
continuously repeat.  

• Make Pendulum: creates a repeating h. The 
object will move forward on the path and then back.  

ar: closes the path to create a circular path. The object will 
move along the path until it reaches the end. It then swings around to the 

 key 

The shape of a motion path is determined by the position of the object as it moves 
through the animation. The motion path geomet

cycle in the action along a pat

• Make Circul

front of the path and starts over. You must have at least four position
frame points for this feature to work.   
 

 

Families Icon  

 
Families are a way of creating “logical groups.” Unlike regular groups, families are not 
treated as a single unit with regards to transformations. Families help you keep track of 
elements in your scene and can be used for selection purposes. For example, you can 
put all the elements that make up the background of your scene in to one family, all the 
items with a particular material in another, all trees in another and so on. 
Each family has a different object color. The color appears only when the object is not 
selected, since a selected object’s bounding box and wireframe appear red. You can 
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easily see which objects belong to the same family when there no objects selected in 

ault family and group them, the group is 
a member of the default family although the objects stay with their own family. 

elect all the objects you want to add to the family.   
2. Click the 

the Working window. 
When grouping objects that belong to a non-def

To add selected objects to a family:  
1. S

 icon that appears next to the object's bounding box.  
 

 
The Family dialog appears. 

3. Choose a color that represents an existing family.   
 

 
 
Once a color family has been selected, you can change both the family name 
and color. 

©2007 DAZ 3D, Inc.  1255 



Bryce 6 Artist Guide 

4. To change the family name, c
b

lick on the name, i.e., Family 18 in our example, 
ackspace over the current name and enter a new name. 

 

 
5. To change the family color, left-click on the lower color swatch to bring up the 

color picker and select a new color. 
 

 
6. Click the OK icon. The color you select becomes the object's wireframe color.   

 

 
The new selected family will be available in the Selection palette and if you 
changed the name of the family, it will be listed under the new name. 
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Select by FamilyRefer to " " for information on selecting objects by family. 

Linking to Parent Icon 

 
This control lets you set up a parent-child link b

Linking Objects

etween two objects. When the objects 
are linked, the transformations you apply to the parent object affect the child. Refer to 
“ ” for more information. 

link where the parent object is the child of its own child object (i.e. 
a loop). The parent object turns blue.   
The first object you select becomes the child object. The object you drag the link line to 
becomes the parent object.  

Creating Link 

To link one selected object to another: 
1. Select the object you want to be the child object within the link. 
2. Click the 

You cannot create a 

 icon and drag it to the object you want to be the parent object.  
 

 

©2007 DAZ 3D, Inc.  1257 



Bryce 6 Artist Guide 

3. Release the mouse button when the parent object turns green. A link line 
extending from the child object to the parent appears as you drag. 
 

 

Breaking Link  

1. Select a child object.  
2. Click the 

To break a link:  

 icon that appears next to the object's bounding box. The Object 
Attributes dialog appears.  

3. Click the Linking tab.  
4. Click the Object Parent Name menu and choose None. 

 

 
5. Click the OK icon to unlink the two objects.   

Geometric Path Linking 

A Geometric path is an object that acts like a track for controlling the motion of objects. 
Normally, when you link an object to a Geometric Path, it is constrained to the path. 
However, using the linking options in the dialog you can disable or enable constraining. 
When an object is constrained to the path, it can only move along the path. When it’s 
not constrained it acts like a regular child of the path. Its movement is not constrained to 
the path. The options in this dialog also let you set where on the path an object begins 
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its motion. For more information about geometric paths, refer to “Creating Geometric 
Paths.” 
To constrain/unconstrain an object to a geometric path: 

1. Select an object linked to a geometric path. 
2. Display the Object Attributes dialog. 
3. Click the Linking tab. 
4. Enable the Constrain to path button to constrain the object to the path. Disable 

the button to unconstrain it. 
 

 
5. Click on the OK icon to exit the dialog. 

To set where the object sits on the path: 
1. Select an object linked to a geometric path. 
2. Display the Object Attributes dialog. 
3. Click the Linking tab. 
4. Enter a percentage in the Position field. 100% places the object at the end of the 

 at the beginning. path, and 0% places it
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5. Click on the OK icon to exit the dialog. 

Object Hierarchies 

An object hierarchy lets you create relationships between objects.  
A hierarchy adds structure to the objects in your scene. This can make arranging and 
animating objects much easier. When you're arranging objects, a hierarchy can make 
positioning and rotating easier since you can transform an entire hierarchy all at once 
instead of separately. The same is true for animating. You can quickly create motion 
animations by changing the position of a parent object, since its children will move with 
it.  
Hierarchies can be created by either grouping or linking objects.  

Grouping vs Linking  

Both grouping and linking let you create functional or spatial relationships between 
objects. The difference is how the objects within each hierarchy work. 
Within a group all the objects act as one. When you resize a group of objects, you are 
resizing all objects in the group simultaneously. This type of hierarchy is good for 
creating complex objects with static parts, like a tree or a large terrain. 
Within a linked hierarchy objects behave differently depending on which object within 
the hierarchy is being transformed. Any transformation you apply to the parent object is 
applied to all its children. However, transformations applied to a child object do not 
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affect the parent. This type of hierarchy is good for creating objects that have movi
parts like this train engine. As you move the parent all the objects in the hierarchy move,
as the child 

ng 
 

moves the parent remains unchanged.  
You can control exactly which transformations are applied to a child object using the 
options on the Linking tab in the Object Attributes dialog. 

Hierarchical Structure  

A hierarchical structure consists of a parent object or objects and its descendants. In the 
case of linking, the parent object is at the top of the hierarchy and its children are below 

 
you have multiple linked objects in a 

hierarchy, the parent object at the top of the hierarchy is the parent object in the first link 
you created.  

it. Children in the hierarchy can also have children creating a branched hierarchy. 
In a hierarchy created using links, the parent object is the primary object in the link. The
children are any objects linked to the parent. If 

 
In this link hierarchy, the p
of which also has a child. So if you were 

arent object has one child and that child has two children one 
to transform this hierarchy, any operation you 

perform on the Parent at the top of the hierarchy is applied to all its children.  
In a hierarchy created using groups, the parent object is the group. All the objects within 
the group are the children. If you have multiple groups within a group, the parent object 
is the final group you create. In this group hierarchy the parent group has four children 
one of which is a group that contains three children. If you were to  
transform this hierarchy, any operation you perform on the parent group would be 
applied to all the children.  

 up of both linked and grouped objects. One way of creating 
 by grouping the parent objects from different link hierarchies 

together. In this case, the final group you create would become the parent object of the 
hierarchy. 

A hierarchy can be made
this type of hierarchy is
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You cannot create a group using a child object. Only parent objects can be part of a 
group. When the parent is in a group all its children are also part of the group since the
must follow the parent. 
You could also create a hierarchy where a group is linked to a parent object. In this 
case, the parent object of the hierarchy w

y 

ould be the parent from the first link you 
created. In this hierarchy the parent object is a group that has four children one of which 

k hierarchy that has two children. 

ts 

is the parent object of a lin

Viewing Object Hierarchies 

The Hierarchy List area of the Advanced Motion Lab lets you see a list of all the objec
in your scene. Object hierarchies are indicated by indents. A parent object is listed at 
the far left of the area; its children appear indented beneath it. 
Refer to "Animation" for more information on viewing object hierarchies. 

Tracking Icon  

 
This control lets you set up a Tracking link between two objects. When an object tracks 
another, the selected object pivots as the target object changes position. As a result, the 
object always faces its target. Refer to "Tracking Objects" for more on tracking. 
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To set a selected object to track another:  
be the stationary object.   

 
1. Select the object you want to 
2. Click the Tracking icon and drag it to the object you want to be the target object. 

 

 
3. Release the mouse button when the target object turns green. A tracking line 

extending from the stationary object to the target appears as you drag. 
 

 

Material Icon 

 
This control displays the Materials Lab. Refer to “Materials” for more on Materials. 
When you use this control, the Materials Lab displays the material currently applied t
the selected object, and the object appears in the Material Preview area of the lab. 

o 
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To display the Materials Lab: 
1. Select an object or group of objects. 
2. Click the  icon that appears next the bounding box. 

 

 
3. The Materials Lab will come up. 

Edit Object Icon  

 
This control only appears if the object you selected is a terrain, a symmetrical lattice, a 
torus, a stone, an imported pol d  object, or a light. When you click this control, the 

 e ected opens.  

the 

yhe ron
s leditor for the object type you have

To display an object's editor:  
1. Select an object or group of objects.   
2. Click  icon that appears next to the bounding box. 

• If a light object is selected, the Light Lab will open. 
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• If a rock or imported object is 
 

selected, the Edit Mesh dialog will open. 

 
• If a terrain or symlat is selected, the Terrain Editor will open. 

 

 
• If a tree is selected, the Tree Lab will open. 
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• If a torus is selected, the Edit Torus dialog will open. 
 
 

 

Group Icon  

 
This control appears only if your selection contains multiple objects. When you clic
control all the objects in the select

k this 
ion are grouped. Refer to "Grouping Objects" for more 

e a multiple selection, it means that you can't 
object hierarchy conflict. Refer to "Object 

on grouping.  
If this icon does not appear when you hav
group the selected objects because of an 
Hierarchies" for more information.  
To group selected objects:  

1. Select all the objects you want grouped.  
2. Click the  icon that appears next to the object's bounding box. A group 

bounding box appears around all the objects. 
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Convert Boolean Icon  

 
The Convert Boolean icon converts Boolean groups to mesh which can then be 
exported from Bryce and imported into other programs.  
This control only shows up when Boolean primitives are grouped. When you click this 
control, the Boolean group is converted to a mesh.  
To convert a new Boolean b up to a mesh:  

1. For a new object, create a Boolean group using positive, negative, and intersect 
primitives and sub-groups. Do not include neutral objects, infinite planes/slabs, 
trees, metaballs, lights, or the camera.  

2. In the image below, the two spheres are grouped together to create a hollow 
sphere and the group set to positive. A negative cylinder is then added and 
grouped with the positive cupola group. This new group is set to positive and 
grouped with the remaining positive objects.  
 

o ject gro
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3. Apply a texture if you wish.  
 

 
4. After grouping all the objects and/or sub-groups, a new  icon will appear under 

the  icon. 
 
Click on the  icon to start the mesh conversion or choose Ob
Boolean to Mesh from the menu or press Opt/Alt+Shift+C.  
 

jects > Convert 

 
5. Wait until the conversion is complete and the object looks like a "real" mesh.  

 
Depending on the size of your object, the conversion could take a while to 
complete. If the object is complex, it can take a very long time to convert or may 
crash Bryce if your system runs out of memory. To help with this, change the 
Selected Resolution of the object to a lower number. So, if the Selected 
Resolution is set to 8, then the converted mesh will be "chunky" but if the 
Selected Resolution is set to 32, then the converted mesh will be much smoother 
and take longer to convert.  
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While converting the Boolean to a mesh, as long as the timer cursor is showing, 
Bryce is working on the conversion. Bryce may even show as not responding in 
the task bar or File Manager, however, unless the program crashes, wait until the 
process is complete instead of closing the process manually.   

6. Notice that there is no  icon next to the converted mesh shown below. This is 
because the group still contains the original Boolean information. However, the 
new mesh can be set to positive, negative, or intersect, and then grouped with 
another converted mesh or wit  ewly created primitives.  h n
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7. If you press Ctrl+click on the mesh, you'll see a list of the meshes but you will not 
be able to select them. The mesh still needs to be finalized.   
 

 
8. To complete the mesh conversion, choose File > Export Object from the menu. 

The Save As dialog will come up. 
9. Select the file type from the Save as type pull-down list.  
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10. Change the name of the file
then click on the Save butto

 so it makes more sense and can be located later, 
n. 

 

 
11. A Progress dialog will come up showing the conversion process.   

 

 
12. Once the export has completed, the mesh can be re-imported into Bryce or into 

another program.  
13. To import the mesh back into Bryce, choose File > Import Object from the menu. 

The Open dialog will come up.   
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14. Locate and s
 

elect the mesh to import, then click on Open.  

The mesh will be imported, along with any textures that were exported.  
 

 
Please note that Bryce applies a very basic UV mapping to the object and as a result, 
the textures may not map correctly on the imported mesh. This can be fixed by applying 

ack onto the object or by modifying the texture scale in the 

1. Select each primitive in the object group.  
2. To set the primitive to positive, press the P key on the keyboard.  
3. To set the primitive to negative, press the N key on the keyboard.  
4. To set the primitive to intersect, press the I key on the keyboard.  
5. Repeat steps 1 through 4 for each sub-group in the object group.  
6. Convert the mesh as shown above, export, then re-import to finalize the mesh.   

the original texture b
Materials Lab.  
Boolean objects from older versions of Bryce can be converted to a mesh as long as all 
the included primitives and sub-groups are set to a Boolean state.  
To convert an older Boolean object group to a mesh:  
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When building Boolean groups for conversion, the following must be kept in mind:  
1. Each object in a group, including any sub-groups, must be set to positive, 

negative, or intersect. You cannot have a neutral object or sub-group in the final 

sh can be set to positive, negative, or intersect, then Booleaned 
nverted mesh or new primitive objects or even with imported 

e 
planes/slabs, or the camera.  

5. The final group can contain multiple sub-groups, but each sub-group must be set 
to positive, negative, or intersect.  

The image below shows a Boolean object that had some neutral primitives and groups 
in the final group. The top image shows the original object in Bryce while the bottom 
image shows the same object after being converted to a mesh, exported, then re-
imported. Notice that parts of the model are missing. These are where the neutral 
objects/groups were that the conversion process threw out.  

group as the conversion process will discard it.  
2. The Group can contain any object that can be Booleaned except an infinite 

plane/slab.  
3. A converted me

with another co
objects.  

4. The final group cannot contain metaballs, Bryce trees, lights, infinit
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Ungroup Icon  

 
This control only appears if you've selected a group or a number of objects contained in 
a group. When you click this control, any group in the selection is ungrouped. If the 
selection contains nested groups, you can continue clicking this control until all the 
groups are ungrouped, or until the control disappears.  
To ungroup a selected group of objects:  

1. Select all the objects you want ungrouped.  
2. Click the  icon that appears next to the object's bounding box.   

 

 
3. If the group had sub-groups, continue clicking on the  icon until all groups that 

you want ungrouped are ungrouped. 

Land Object Icon  

 
This control appears as either an arrow pointing up or down, depending on the position 

cts" for more information. 
To land a selected object:  

1. Select the object you want to land.  
2. Click the 

of the object selected.  
When you click this control, the object snaps to the top of the object below it. This 
control works like the Land Selection option available in the Edit palette. Refer to 
"Landing Obje

 or  icon that appears next to the object's bounding box. The object 
snaps to the top of the object directly below it or if the selected object is below 
ground, it snaps to the bottom of the object directly above it. 
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Selecting Objects 
Before you can perform any type of editing or transforming operation on an object, you 

e will appear 

objects, either choose Edit > Select All, or press Cmd/Ctrl+A.   

lick the 

 
obscuring object. All objects underneath the cursor will be selected. If the 

lready selected, it will be deselected and all the objects 
ted.  

. 

e scenes.  

need to select it. As well as selecting objects using the cursor, Bryce's Selection tools 
let you select objects by type or family. You can also cycle through all the objects in 
your scene.  

• To select an object, click on any object. A selected object's wirefram
red. Alternatively, you may drag a marquee around the object.  

• To step through all the objects in your scene, press the Tab key until the object 
you want selected appears in red.  

• To select a number of objects, drag a marquee around a number of objects.   
• To select an object within a group, hold down Ctrl and click the desired object.  
• To select all 
• To deselect all, either choose Edit > Deselect All, or click anywhere outside the 

selected area.  
• To add objects to a selection, hold down the Shift key while selecting the object.  
• To remove objects from a selection, hold down the Shift key and c

selected object.  
• To select obscured objects, hold down the Shift key and select through the

obscuring object is a
behind it will be selec

• Alternatively, hold down Cmd/Ctrl and click an object to select or deselect. Use 
Shift to select multiple objects. You will see a list of all objects under the cursor
This lets you not only view the selection status of all the listed objects, but 
change it as well. This aids in dealing with larg
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Resizing Objects 
When you create an object, it appears at a default size. Once you place it in your sce
you may need to resize it to make it proportional to the other objects in your scene. 
There are five ways of resizing objects in Bryce: using the Resize tool, in the Edit 
palette, to resize an object along differe

ne, 

nt axes using the 3D Transformation dialog 
which lets you enter precise values to resize objects using the control points on the 
object’s bounding box to interactively resize the objects using the Object Attributes 
dialog using keyboard commands  
Objects are measured in Bryce units. When you resize an object, you’re increasing or 
decreasing its size based on unity size. When you resize an object to 150%, you’re 
sizing it to 150% of unity. Refer to “Bryce Units” for more information. 

Resize Using the Resize Tool 

The Resize Tool is available on the Create palette and is often the easiest method of 
resizing objects quickly. 
Refer to "Resize Tool" for more on using this tool. 

Resize Using the Keyboard 

You can use the keyboard keys to resize objects:  
t/Alt+8 to double a selected object's size.  

d object's size.  
nd snap it to the Grid. 

R

Ob bject Attributes dialog. 
ttributes

• Press Shift+8 (asterisk) or Shift+Op
• Press / (slash) to halve a selecte
• Press = (equal) to return the object to unity size a

esizing Numerically 

jects are resized numerically using the O
Refer to "Editing Transformation A " for more information on resizing objects this 
way. 

Resize Interactively 

ng the Resize tool or the 3D Transformation dialog, 
there are resize controls on the object's bounding box that let you resize objects directly 
in t e uch more intuitive way of transforming 
yo

While you can resize objects usi

h  Working window. You may find this a m
ur objects.  
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When you select an object, a bounding box appears surrounding your selection. At each 
corner of the box, and at the center of each face, is a control point.  

 
As l points, it changes to a generic Resize 
cursor.  

 your cursor passes over the corner contro

 
As ces, it changes to an X, Y or Z. This 

ze the object by clicking and dragging on that 
 it passes over the control points on the fa

indicates the axis along which you can resi
point.  
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Scale Along a Single Axis 

To resize an object along a single axis interactively:  
1. Select an object.  
2. Drag one of the control points at the center of a bounding box face. As you pass 

xis your cursor over the face, the cursor changes to an X, Y, or Z to indicate the a
you're resizing along.  
 

 
3. Drag right to enlarge it

 
 or left to shrink the object.  

 
 
The object will scale along the axis 
 

of the selected control point.   

 

Scale Object from Specific Side 

To resize an object from a specific side:  
1. Select an object.  
2. Click the any face control point and hold down the mouse button, then press 

Cmd/Ctrl+Opt/Alt.  
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3. Drag right to enlarge it or left to shrink the object.  
 
The object resizes in all directions from the center of the face opposite the 

of 
 

selected control point. For example, if you select the Y control point on the top 
the object, the object will scale up and out, but not down.
 
Make sure to select the control point and hold the mouse down before pressing 
Cmd/Ctrl+Opt/Alt. If you press Cmd/Ctrl+Opt/Alt first, nothing will happen.  

To show some examples, below is a cube that has been moved so that the edges 
line up with the ground plane grid: 
 

 
1. Select the X control point nearest the Director's View, press Cmd/Ctrl+Opt/Alt 

and drag right.   
 
Notice how it resizes on the Y and Z-axes in both directions, but only to the right 
on the X-axis. The arrow shows the side that doesn't move.  
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2. Select the control point on the opposite side of the cube, press Cmd/Ctrl+Opt/Alt 
and drag right.  
 
Notice how it resizes on the Y and X-axes in both directions, but only to the back 
on the Z-axis. The arrow shows the side that doesn't move.  
 

 
3. Once more, select the Y control point on the top side of the cube, press 

Cmd/Ctrl+Opt/Alt and drag right.  

cube stays firmly on the ground plane.  

 
Again, notice how it resizes on the X and Z-axes in both directions, but only up 
on the Y-axis. The bottom of the 
 

 

Scale from Opposite Side 

To resize an object from the opposite side:  
1. Select an object.  
2. Click one of the control points on a face and hold down the mouse button, then 

press Ctrl. The cursor will  a double-sided arrow. change to
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Note: Make sure to select the control point and hold the
pressing Ctrl. If you press Ctrl first, you'll rotate the obje

3. Drag right to enlarge it

 mouse down before 
ct instead.  

 or left to shrink the object.  
 

center of the object. This 
ground and you want it to 

 a cube that has been moved so that the edges line up 

The object resizes in all directions from the bottom 
transformation may be useful if the object is on the 
remain there. 

To show an example, below is
with the ground plane grid:  

 
Then resized by clicking on the X control point nearest the user, pressing Ctrl and 
dragging right. If the mouse had been dragged left, the cube would have been resized 
smaller on the opposite side. 
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Scale from Corner 

To enlarge or shrink an object interactively:  

rag one of the control points on the corners of the bounding box. Drag right to 
enlarge or left to shrink the object.  

1. Select an object.  
2. D

 

 
 
The object will resize in the direction of 
below):   
 

the selected corner (circled in images 

  

Scale from Center 

To resize an object from the opposite side:  

2. Click one of the control points on a face and hold down the mouse button, then ... 
3. Press Opt/Alt and drag on one of the control points on a face.   

r  enlarge it or left to shrink the object. The object resizes in both 

t/Alt and drag 

1. Select an object.  

4. D ag right to
directions from the bottom center of the object on the selected axis.  

5. Select the X control point nearest the Director's View, press Op
right. Notice how it resizes from on the X-axis in both directions. The arrows 
show the direction it scales towards.  
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Scale by 50% from Specific Side 

2. Press Shift then select any control point and drag right on the control point once 
for each increase.  
 
The object will increase by 50% in the direction of the selected control point.   
 
The image below shows a cube increased to the right on the X-axis by 50%. 
 

To increase the size of an object by 50%:  
1. Select an object.  

 
 
 
 
 
 
 
 

©2007 DAZ 3D, Inc.  1283 



Bryce 6 Artist Guide 

Then increased towards the front on the Z-axis by 50%:  
 

 
To decrease the size of an object by 50%:  

1. Select an object.  
2. Press Shift then select any control point and drag left on the control point once 

for each decrease.  
 

 

Scale by 50% from Center 

To increase the size of an object by 50% from the center:  
1. Select an object.  
2. Press Shift+Opt/Alt then select any control point and drag right on the control 

point once for each increase.  
 
The object will increase by 50% in both directions for the selected control point. 
The image below shows a cube increased on both sides of the X-axis by 50%: 
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To decrease the size of an object by 50% from the center:  

int and drag left on the control point 
once for each decrease. The object will decrease by 50% in both directions for 
the selected control point.  
 

1. Select an object.  
2. Press Shift+Opt/Alt then select any control po

 

Reset Object to Unity Size/Rotation 

Every object in Bryce has a default size and shape. When you create an object, the 
default size is used to define its size and placement. As you transform and edit objects, 
these default properties are discarded and replaced. However, you can return an object 
to its original state for size and rotation at any time. 
The Restore control returns the object to its default size and orientation, also called 
Unity, regardless of the number of resize and rotate transformations you’ve applied to it.  
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To reset an object to unity size and rotation:  
1. Select o
2. Press Ctrl+Alt and move the mouse curs

bject.  
or over a control point. The cursor will 

change to a "1" cursor. 
 

 
3. While still holding down Ctrl+Alt, left-click on the control point. The object will be 

reset back to its default size and rotation, but not reset to the original location.  
 

 

Skewing Objects 

While Bryce does not have the ability to deform objects by manipulating vertices, 
objects can be skewed to get some interesting shapes, like making a diamond shape 
out of a cube.  
This is accomplished by rotating the object, then resizing the object in World Object 
mode using the Scaling tool.  
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For an example:  
1. Create a cube, rotate it 45 degrees on the Z-axis, and drop it to ground. 

 

 
2. Select World Space from the Scaling or Resizing tool sub-menu.   

 

 
3. The bounding box changes to align with World Space.  
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4. Scale along the X or Z-axis. 
 

 
 
The cube skews along that axis. 
 

 
5. Now scale the other way.   

 

 
6. A

 
nd it skews in the opposite direction.  
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7. Continue rotating the object and scaling along different axes just to see what 
happens.    
 

 
 
And here's the object above rendered. 
 

 
Now for a pyramid:  
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This is a pyramid skewed so much that it is literally folded in on itself: And when ro
is completely flat:  

tated, 

   
Any object can be skewed, including imported 
Below are examples of a skewed c

objects, metaballs, and infinite planes. 
one, sphere, cylinder, and torus:  
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And here they are rendered:  

 
And of course, you can still adjust the radius of the torus to get a thinner object:  

 
And lights can cast some interesting shapes when skewed:  
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Rotating Objects 
The Rotate tool is available on the Create 
rotate objects. 
Refer to "

Palette and is usually the easiest way to 

Rotate Tool" for more on using this tool. 

Rotate Numerically 

Objects are rotating numerically using the Object Attributes dialog. 
Refer to "Editing Transformation Attributes" for more information on rotating objects this 
way. 

Rotate Interactively 

While you can rotate objects using the Rotate tool or the 3D Transformation dialog, 
there are rotate controls on the object's bounding box that let you rotate objects directly 

tive way of transforming 

 At each 

in the Working window. You may find this a much more intui
your objects.  
When you select an object, a bounding box appears surrounding your selection.
corner of the box, and at the center of each face, is a control point.  

 
As your cursor passes over the corner control points, it changes to a generic Resize 
cursor.  
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As it pas
a

ses over the control points on the faces, it changes to an X, Y, or Z. This 
indic tes the axis along which you can transform the object by clicking and dragging on 
that point.  

   
Press the Cmd/Ctrl key and click on one of the control points. The cursor changes to an 
double arrow arc. Do not click on the control point before pressing the Cmd/Ctrl key or 
you will resize the object instead of rotating it. 

 
Click on the control point you want to rotate the object around and drag the mouse left 
and right to rotate the object. 
Examples: 

• Rotate on any corner: 
 

 
• Rotate on X-axis: 
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• Rotate on Y-axis: 
 

 
• Rotate on Z-axis: 

 

 

Repositioning Objects 
When you create a new object it can be placed in your scene either at absolute world 
center or at an arbitrary location based on your current view. Object placement is 
determined by your preference setting. The Reposition tool is located in the Create 
Palette and is usually the easiest way to reposition objects, however, there are other 
ways to move objects around the scene. 

Nudging Objects 

Nudging lets you move objects by pressing the arrow keys and the PageUp and 
PageDown keys.  
Nudging uses World Space coordinates to reposition objects. Each time you press a 
key, the object is moved in 1/4 unity size increments (5.12 Bryce units). Refer to "Bryce 
Units" for more on Unity.  
To nudge an object along the X axis:  

1. Select one or more objects.  
rrow keys.  Hold down Shift to nudge objects in 2. Press either the Right or Left a

1/2 unity size increments (10.24 Bryce units) Hold down Option/Alt to nudge 
objects in 1/256 unity size increments (0.08 Bryce units).  
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To nudge an object along the Y axis:  
1. Select one or more objects.  
2. Press either the PageUp or PageDown keys.  Hold down Shift to nudge objects 

in 1/2 unity size increments (10.24 Bryce units) Hold down Option/Alt to nudge 
objects in 1/256 unity size increments (0.08 Bryce units).  

To nudge an object along the axis:  
1. Select one or more objects.  

 
/256 unity size increments (0.08 Bryce units).  

Reposition Interactively 

The simplest way of positioning objects is by dragging them to different locations in your 
scene. When you drag an object, you're repositioning it with respect to the camera.  
To reposition an object interactively, select the object or group and do one of the 
following: 

• Drag the object to a new location.  
• Hold down X while dragging to constrain movement to the X-axis.  
• Hold down Y while dragging to constrain movement to the Y-axis.  
• Hold down while dragging to constrain movement to the Z-axis.   

 
 a transformation on a group, 

d. If you scale a group, all the objects change size, or if 

scene. You may want to group the objects that comprise more complex objects, like the 
walls and turrets of a castle. You can group objects to keep all the components of a 
complex object like this train engine together. You can also create groups to maintain 
the spatial relationships between objects as you transform them. 
You can also create a group to maintain the spatial relationships between objects as 
you transform them, like the boards in this fence. You can place as many objects as you 
like in your group. You can even nest groups within groups. Nesting can be an easy 
way of managing more complex scenes. 
Groups are essential to creating Boolean objects. Boolean operations will not work 
unless the objects are part of a group. Refer to “Boolean Operations

2. Press either the Up or Down keys. Hold down Shift to nudge objects in 1/2 unity 
size increments (10.24 Bryce units) Hold down Option/Alt to nudge objects in
1

Grouping Objects 
As your scene becomes more complex, you’ll need to group objects. Grouping lets you
control a set of objects as a single unit. When you perform
all the objects are equally affecte
you rotate a group, all the objects rotate around a single axis. 
Your choice of objects to place in a group depends on how you want to organize your 

” for more on 
Boolean objects. 
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You cannot create a group using a child object. If a child object is part of your selection 

ess Cmd/Ctrl+G. 
You can also click the G button next to the selected objects’ bounding box. 

1. Select all the objects you want grouped.  
2. Click the 

the “G” icon will not appear. 
To create a new group: 
1 Select all the objects you want to group. 
2 Choose Objects >Group Objects, or pr

 icon that appears next to the object's bounding box. You can also 
choose Objects > Group Objects or md/Ctrl+G. A group bounding box press C
appears around all the objects. 
 

 
To select objects within a group: 

1. Hold down Control/Ctrl and click on an object inside the group bounding box. 
2. Select the object you want from the menu. 
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Creating Boolean Obje

Bryce uses Object properties to perform Boolean operations. Objects can be Neutral, 
Positive, Negative, or Intersecting. When you combine these objects in a group, the 
result is a Boolean object. 

cts 
A Boolean object is an object created by combining two or more objects to form a single 
object. Boolean objects are created by performing Boolean operations on a number of 
objects. You can perform three types of Boolean operations in Bryce: union, subtraction, 
and intersection. 

Boolean operations do not have any effect on Neutral objects. When you group a 

 
operation (bottom). The original object 

placement appears on the left. 
If you are importing objects from Bryce 2, you may want to change some positive 
objects to neutral for faster rendering. 

used in Bryce: 

neutral object with a Boolean object, no Boolean operation is performed. Objects are 
neutral by default. This image shows the result of a Positive and Negative Boolean
operation (top) and a Positive and Neutral 

Boolean Operations 

There are three Boolean operations 
• Boolean Union is performed by grouping two positive objects. The area that is 

ple, 

 oolean Subtraction

common to both objects is removed, creating a continuous object. For exam
when you group two positive spheres, you get a kind of peanut shaped object 
which is the union of the two objects. 

• B  is performed by grouping a negative object with a positive 
object. The area that is common to both objects is subtracted from the positive 
object, resulting in a positive object with negative space. For example, when you 
group a positive sphere with a negative one, the resulting object looks like a 
sphere with a crater.  

• Boolean Intersection is performed by combining an Intersecting object with a 
Positive object. The area that is common to both objects becomes the only 
visible portion of the group. 

Negative or Intersecting objects must share space with at least one Positive object in 
the group to exhibit a Boolean operation. If there is no common space, Negative objects 
are invisible when rendered. 
A group that contains an Intersecting object that does not intersect with any other object 
in the group becomes entirely invisible; this is because the Intersecting object is 
intersecting with nothing. 
You can build very complex objects by compounding Booleans. Suppose you wanted to 
create a flute. You would first create the hollow tube by combining a positive cylinder 
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with a negative cylinder, then create several negative spheres and group those with the 

mple flute, you could create 

S e performs Boolean operations using object attributes, you can adjust the 
repositioning the objects in the group. You can edit 

 mode in the Selection palette.  
he rendered image or in the Nano-Preview. 

object in the Wireframe preview. 

1. Select an object. 
2. Click the 

tube, creating a simple flute. 
By compounding more Boolean operations on top of this si
even more complex objects. 

ince Bryc
shape of a Boolean object by 
objects within groups using the Solo
The final Boolean object appears only in t
You won’t be able to see the Boolean 

Boolean Union 

To create an object that is a union of two objects: 

 button next to the object’s bounding box, or press 
Cmd/Ctrl+Opt/Alt+E, or choose Objects menu> Edit Attributes. The Object 
Attributes dialog appears. 
 

 
3. l e Intersecting checkbox. Enab e th
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4. Move the  object so that it intersects another object. 
 

 
5. Make sure that the second object’s Boolean attribute is set to Positive. 
6. Select both objects and click the  icon next to the selection’s bounding box to 

group them.  
 

 
7. When your scene is rendered, the area common to the two objects is removed, 

creating a continuous object. 
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For many objects you build with no negative or intersect operations, setting the objects
to positive isn't necessary, however, if you plan on grouping the Boolean Union grou
with other groups that contain Boolean operations, then all objects in the groups (an
the groups) must be set to positive, negative, or intersect. 

 
p 
d 

2. Click the 

Boolean Subtraction 

To subtract one object from another: 
1. Select an object. 

 icon next to the object’s bounding box, or press Cmd/Ctrl+Opt/Alt+E, 
rs. or choose Objects menu> Edit Attributes. The Object Attributes dialog appea

3. Enable the Negative checkbox. 
 

 
4. Move the negative object so that it intersects another object. 

 

 
5. Make sure that the second object’s Boolean attribute is set to Positive. 
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6. Select both objects and click the  icon ne
g

xt to the selection’s bounding box to 
roup them.  

 

 
 
When your scene is rendered, the area w
removed from the positive object. 
 

here the two objects intersect is 

 

Boolean Intersection 

To create an object that is the intersection of two objects: 
1. Select an object. 
2. Click the  button next to the object’s bounding box, or press 

menu> Edit Attributes. The Object 

nable the Intersecting checkbox. 

Cmd/Ctrl+Opt/Alt+E, or choose Objects 
Attributes dialog appears. 

3. E
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4. Move the intersecting object so that it intersects another object. 
 

 
5. Make sure that the second object’s Boolean attribute is set to Positive. 
6. Select both objects and click the  icon next to the selection’s bounding box to 

group them.  
 

 
7. When your scene is rendered, the area where the two objects intersect becomes 

the only visible portion of the group. 
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Bryce and 3D Space 
Since all the objects in your scene exist in 3D space (defined by XYZ), any 
transformation you perform is a 3D transformation. This means that you're changing th
attribu

e 
tes of the object in each axis.  

f defining 3D space:  Bryce has three ways o
• World Space, which is constant 
• bject SpaceO , which changes as the object changes 
• Camera Space, which changes as the camera changes 

When you're using the interactive transform tools on the Edit palette you can use any 
one of the 3D space definitions.  
To choose a 3D spatial option for transformations:  

1. Click the Edit button at the top of the Bryce window to display the Edit palette.  
 

 
2. Click the triangle icon below one of the transformation tools and choose a 3D 

spatial option from the menu.  
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Wor d

left and right and the Z-axis represents 

l  Space 

World Space is the coordinate system that defines all the space in the Bryce universe. It 
is constant and cannot be modified. It is also the default space used for transformations.  
World Space is defined by three axes, X, Y, and Z, that all meet at world center. This 
center is defined numerically as 0, 0, and 0 for the X, Y, and Z-axes. By default, all new 
objects appear at world center.  
The Y-axis that extends from world center defines all vertical space. Positive values 
represent distances above ground level and negative values represent distances below 
ground. The X-axis represents distances 
distances backward and forward.  
When you use World Space for transformations, objects move in relation to this 
absolute coordinate system. 

 

Object Space 

When Bryce creates an object, it defines the up, down, right, left, back, and front of the 
object. These definitions remain with the object no matter what transformations you 
apply to it. So in a sense, each object carries with it its own coordinate system.  
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When you transform an object using Object Space, the
internal coordinate system. Fo

 object moves in relation to its 
r example, you can increase the height of an object 

based on its own Y axis.  
Because Object Space ignores the absolute coordinates, the object becomes taller 
without being skewed. If you used World Space, the object would become deformed 
since it increases along the absolute Y axis.  

Camera Space 

Camera Space is defined by three axes, X, Y, and Z, that extend from the camera 
center. Wherever you move the camera, these axes move along with it.  

 
When you use Camera Space for transformations, you're moving objects in relation to 
the camera. When you drag along the X-axis in Camera Space, you're moving left or 
right from the camera.  
When you move along the Y-axis in Camera Space, you're moving up or down from the 
camera. When you move along the axis, you're moving away or towards the camera. 
Since the camera can be rotated and repositioned, it can sometimes be hard to tell 
which way is up, left, or right, because your view from the camera is no longer aligned 
to the absolute XYZ-axes.  
Suppose you've rotated the camera and then you move an object along the Y-axis in 
World Space. Instead of moving up, it may appear to move off to the left, since your 
view of the scene is not aligned to the World Space Y-axis.  
However, in Camera Space, the object will move up, because the object moves along 
the camera's Y-axis.  
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Bryce Units 

Bryce maintains an invisible, absolute, infinite 3D grid internally. This grid is comprised 
of 3D cube increments, each of which is 20.48 x 20.48 x 20.48 "Bryce Units" (or BUs) in 
size. Most of the primitive objects (spheres, cubes, etc.) are created at the same size as 
a 3D cube.  

 
All interactive 3D transformations are relative to an absolute (Unity) size, position, and 
orientation for all objects.  
To reset primitive objects to Unity, hold down Ctrl+Opt/Alt and click one of the object's 
control points. The object is reset to it's default size and rotation.  
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Coordinate Systems 

When you're transforming objects numerically in the Object Attributes dialog, you can 
use one of two coordinate systems:  

• Absolute Coordinates 
• Definition Coordinates 

Absolute Coordinates 

Absolute Coordinates use the World Space axes as the reference for object 
transformations. When you enter transformati
you're defining how the object is transformed 

on values using Absolute Coordinates, 
along the World Space, or absolute, X, Y, 

and Z-axes.  

 

De

Definition Coordinates 

fine how an object is actually created. In object 
t X=0, Y=0, Z=0. All the other points in the 

 and Z-axes.  

finition (Object Space) Coordinates de
space, the origin of the object is located a
object are defined by coordinates along the object's internal X, Y,
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This coordinate system uses the object's internal axes as a reference for 
transformations. When you enter transformation values using this system, you change 

clude the position of its origin, its size, and orientation. In 
gin point of the object always remains at Object Space 

 or grows along its internal 
e unpredictable results. For 

act center of the object. When you rotate the object, it won't rotate 
around its center.  

the same as using Object Space with 
one of the Transformation tools. When you choose Object Space for one of the 

xes as a 
nal position, or size, is calculated using Absolute Coordinates. So in 
 origin and all its points move along with the object.  

 change as the size and position change.  

tes 

Relative Coordinates use the World Space axes as reference for object transformations, 
but the values represent changes relative to the object's current position or size. For 
example, if you enter a position change of 2 units, the object moves two units from its 
current position along one of the World Space axes  
Relative Coordinates is the only coordinate system available in the 3D Transformation 
dialog.  

how the object is defined to in
Definition transformations, the ori
0, 0, 0. As you move or scale the object, it changes, moves
axes, but the origin remains at 0, 0, 0. This can cause som
example, if you scale an object using Definition Coordinates, the origin point will no 
longer be in the ex

Transforming using Definition Coordinates is not 

transformation tools, transformations are performed using Object Space a
reference, but the fi
this case the object
When you use Definition Coordinates to transform an object, you're redefining how the 
object is created, so its origin does not

Relative Coordina
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Practical Application 
Welcome to the Bryce tutorial. This tutorial introduces you to the major features and 

torial shows you how to create a terrain, 
ody of water. “Creating a vaulted roof” teaches you 

how to create a more complex environment and an animation. 
Each section of the tutorials is self-contained, so you can start from any point. All the 
files necessary for completing the lessons are provided for you in the "Tutorials/Manual 
Tutorial" folder. While the preset libraries shown in the tutorials are the ones from Bryce 
6, any version of Bryce can be used to follow these tutorials although the presets will be 
in different categories (i.e., in Water, not in Waters > Turbulent, in Terrains, not in 
Terrains > Rocky, etc.) 
Note: While following the tutorial lessons, objects (especially terrains, rocks, and trees) 
will look noticeably different than what you see in your Bryce scene. This is because 
these objects are created with random settings each time. Another item that will look 
different are the libraries for materials, objects, textures, and skies, since you may not 
have the same items installed although the default installed categories will be the same 

functions of Bryce. The main goal is to teach you the basic techniques you’ll need to 
create landscapes and environments.  
There are two separate tutorials. The basic tu
customize the sky, and create a b

for everyone using Bryce 6. 
• Lesson 1: Creating a New Document 
• Lesson 2: Positioning the Camera 
• r anging Objects in the SceneA r  

• Lesson 3: Adding & Adjusting the Terrain 
• Lesson 4: Applying a Texture 
• Lesson 5: Adding a Sky Preset 
• Lesson 6: Adjusting the Sky 

• Creating a Body of Water 
• Lesson 7: Preparing the Landscape 
• Lesson 8: Creating the Interior of the Lake 
• Lesson 9: Filling the Lake 

• Creating a Vaulted Roof 
• Lesson 10: Creating a Pyramid 
• Lesson 11: Converting the Pyramid 
• Lesson 12: Resize the Pyramid 
• Lesson 13: Use the Sphere to Carve out the Roof 
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• Lesson 14: Creating a Group 
• Building the Walls 

• Lesson 15: Moving the Roof 
• Lesson 16: Creating the Walls 
• Lesson 17: Adjusting the Wall Size 
• Lesson 18: Duplicate the Walls 
• Lesson 19: Make the Walls Taller 
• Lesson 20: Adding a Doorway 
• Lesson 21: Assigning Boolean Properties 

• Group and Grow the Entire Building 
• Lesson 22: Grouping the Building 
• Lesson 23: Change Your Viewpoint of the Scene 

al• Sphere on a Pedest  
• Lesson 24: Merging an Existing Scene 
• Lesson 25: Adjusting Lighting 

• Pre-Production 
• Lesson 26: Pre-Visualizing & Timeline for the Sequence 
• Lesson 27: Setting up the Timeline for the Sequence 

• Animate the Camera 
• Lesson 28: Setting the Camera Trajectory 
• Lesson 29: Pointing the Camera 
• Lesson 30: Making Camera Adjustment 
• Lesson 31: Smoothing the Camera's Trajectory 
• Lesson 32: Test Render 

• Fine Tuning Your Animation 
• Lesson 33: Converting the Trajectory to a Path 
• Lesson 34: Creating Keyframes from the Beginning & End of the Path 
• Lesson 35: Velocity Adjustment 
• Lesson 36: Another Test Render 

• inal CommentsF  
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L se on 1: Creating a New Document  
When you set up a new document, you define the size of your working space in pixels. 
The higher the resolution, the larger your working space. The resolution you choose 
depends on what type of scene you want to create. 
To help you choose a resolution, Bryce provides several preset aspect ratios for the 
most commonly used types of documents.  
To set up a new document:  

1. Choose File > New Document from the menu. 
 
The Document Setup

2. Click the button beside the Default preset in the list of presets on the right side of 
the dialog. 
 

s

 dialog appears.  

 
 
The Resolution and Aspect Ratio fields update automatically.   

3. Click the OK icon at the bottom of the dialog to accept your changes and exit the 
dialog. 

Now that you have a document, you can set up the camera view and start creating a 
scene.  
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L se on 2: Positioning the Camera  
e the Director’s View to view objects in the scene. In this view, 

the scene including the camera.  
, 

When you reposition the camera, you’re changing the view of the scene, not the 
position of the objects.  
To open the camera lesson file:  

1. Choose File > Open from the menu.  
2. Locate the file "Camerascene" in the "Tutorials/Manual Tutorial" folder and click 

on Open. The scene will open showing a scene that is close to the camera. 
 

s
In this lesson you’ll us
you can see all the objects in 
There are four controls you can use to position the camera: the Camera axes controls
the Trackball, the Preset Views, and the Camera and 2D Projection dialog. Most of 
these tools are located on the Control Palette.  

 
To reposition the camera using the Camera axes controls:  

he scene away from you. When 
n the Camera control, the cursor changes to 

1. On the XZ control, drag the Z arrow up to move t
you move over the tip of an arrow i
an axis indicator. 
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2. On the XY control, drag the tip of the Y arrow up to move the scene up. Your 
scene should look like this when you’ve finished using the Camera controls.  
 

 
 
T
a

he sphere and the torus objects should now be easier to see, but you can 
f the hidden cylindrical objects.  djust the camera again to get a better view o

 

 
To reposition the camera using the Trackball, click the center of the Trackball and drag 
to the right. The scene appears to rotate to the left.    

 
The camera is now in an almost perfect position to view the scene. You can also see 
the camera object in the background. 
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You can place the camera in a precise position by moving it numerically. 
To reposition the camera numerically:  

sition Y = 32, Position Z = -100, Rotate X = 0, Rotate 
1. Double-click the Trackball. The Camera & 2D Projection dialog appears.  
2. Enter Position X = 104, Po

Y = -46, Rotate Z = 0.  
 

 
3. Leave the remaining values at their defaults.  
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4. Click the OK icon to apply the changes to the camera.  
 

 

Arranging Objects in the Scene 
A 3D illustration depends heavily on the arrangement of the objects in the scene to 
create a specific look or feel.  
In 3D space, an object can be viewed from any angle. You should take all of these 
angles into account when you’re arranging objects. 
The lessons in this section will help you learn how to add, position and transform 
objects to create a 3D illustration.  

• Lesson 3: Adding & Adjusting the Terrain 
• Lesson 4: Applying a Texture 
• esson 5: Adding a Sky PresetL  
• Lesson 6: Adjusting the Sky 
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Lesson 3: Adding & Adjusting the Terrain  
To create a terrain:  

1. Click on the Create button to display the Create Palette.  
 

 
2. Click the Terrain Object.  

 

 
 
The terrain appears in your scene. 
 

 
To reposition the terrain, you can use the Reposition tool to move the terrain to the 
rear left of your scene. As you move the mouse pointer over the arms of the Reposition 
tool a small tag appears and displays the name of the axis over which you are 
positioned.  

1. With the terrain selected (outlined in red), click Edit to display the Edit Palette.  
 

 
2. Click the upper X (left) arm of the Reposition tool, and drag to the left.  

 

 
 
The terrain will move along the X-axis towards the rear of your scene.  
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3. Click the upper Z (right) arm of the tool, and drag to the right.  
 

 
 

 
The terrain will move along the Z-axis towards the middle of your scene.  

 
4. Repeat this process as needed until the terrain is in the position shown below.  

 

 

©2007 DAZ 3D, Inc.  1317 



Bryce 6 Artist Guide 

To resize the terrain:  
1. With the terrain still selected, clic

ri
k the center of the Resize tool, then drag to the 

ght to increase the size of the terrain. 
 

 
 
Notice that as you resize the terrain it appears to disappear below the ground 

fault 
 to 

se it is 

plane. The ground plane is the grid in the foreground which appears by de
whenever you start a new project. It is an infinite plane because it extends
infinity along the X and Z-axes. The terrain appears to disappear becau
resized evenly about its center.  
 

 
2. Click the Land Objects button (the arrow button located at the bottom of the 

vertical row of buttons to the right of the terrain).  
 

 
 
The terrain repositions on the ground plane and the arrow button disappears.  
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3. Resize the terrain until it looks something like the image below.  
 

 
To add and reposition a second terrain:  

1. Click Create, then click the Terrain Object to add a second terrain.  
2. Click Edit, to display the Edit palette.  
3. Use the Reposition tool to move the terrain to the far right of the scene.   

 

 
4. Increase the size of the terrain, using the Resize tool. Note that this terrain 

(Terrain 2) is further back than the first one.  
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5. Click the Land Objects button to align the sec
p

ond terrain along the ground 
lane. 

 

 
6. Click the Render button to view your image.  
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To switch back to Wireframe display mode: 
• Click the 

the
 

Display Modes button once to return to Wireframe display mode, or hit 
 Escape key to toggle between the modes. 

 
To change the terrain’s appearance:  

1. Select Terrain 2. The wireframe turns red.  
2. Click the Editor button (the E button located in the Object Control Palette - the 

vertical list of buttons associated with the selected terrain object).  
 

 
 
Your screen is overlaid by the Terrain Editor.  

3. In the Editing Tools palette, click the 
update in the Terrain Canvas to show the erosion effect. 
 

Eroded button twice. The terrain will 

 
4. Exit the Terrain Editor by clicking the OK icon.  
5. Select Terrain 1.  
6. Click the Editor button to display the Terrain Editor.  
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7. In the Editing Tools palette, click the Smoothing button once.  
 

 
8. Exi
9. Click the Render button to view your image.  

 

t the Terrain Editor by clicking the OK icon.  

 

Lesson 4: Applying a Texture  
Now you will apply a material to the terrains and the ground plane. 

de.  
elect Terrain 1.  

3. Hold down the Shift key on your keyboard and click Terrain 2; still holding the 

utlined in red.  

To apply a texture:  
1. Click the Display Modes button to return to Wireframe display mo
2. S

Shift key down, click the  
ground plane (Plane 1). All three wireframes are selected and o
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4. Click the triangle icon next to Edit to display the Material Presets Library.  

 

 
5. In the Material Presets Library, click on the triangle icon next to Architectural 

and choose Terrains from 
selection of preset materials appears. 
 

the menu to change to that category. Another 
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6. Click on the Rocky category, then on the Desert Rock preset (second from the 
left on the second row). A red border appears around your selected material. 
 

 
7. Click the OK icon to return to your scene. If you look at the Nano-Preview 

window (top left), you'll see that  
the Desert Rock material has been applied. 
 

 
8. Click the Render button to view your image. 
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Lesson 5: Adding a Sky Preset  
To complete these lessons, you’ll need a terrain. If you’ve been following this tutorial 
from the beginning, you can use your scene. Otherwise, you can use the sample file 
provided for you. The sample file is called "Finished Terrain" and is located in the 
"Tutorials/Manual Tutorials" folder.  
While the default scene created by Bryce includes the default sky, you can easily 
change the sky preset for the scene.  
To change the sky preset:  

1. Click the triangle next to Sky & Fog. The Sky & Fog Presets Library appears.  
2. Click on the Daytime category, then on the Jetstream preset (third from the left 

on the fifth row). A red border appears around your selected sky. 
 

 
3. Click the OK icon to apply the sky preset to the scene. 
4. Click the Render button to view your image. The first image shows the scene 

with the default sky while the second image shows the scene after applying the 
Jetstream sky preset. 
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Lesson 6: Adjusting the Sky  
Once you have added a sky preset you can adjust the appearance of the sky. You can 
determine what type of clouds are included in the scene. You can also add perspective 
to the scene by adjusting the amount of Haze in the scene.  
To modify the clouds:  

1. On the Sky & Fog palette, click the triangle beneath the Sky Memory Dots. This 
displays the Sky & Fog options menu.  
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2. From the menu that appears, clic
 

k Cumulus Clouds to deselect it.  

 
To adjust the sky:  

1. M
Haze

ove the pointer over the thumbnails on the Sky & Fog palette to locate the 
 thumbnail. Note that the names of the palettes appear in the bottom left of 

umber 1 appears at the bottom left corner of the 
ryce window; this is the Haze value.  

 

the Bryce window and as tool tips near the thumbnails. 
2. Click the Haze thumbnail. The n

B

 
3. Click the Haze thumbnail, drag to the right to increase the Haze value to 17.  
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4. Render the scene again to view your image.  
 

 
 
Note that the increased haze value has separated the two mountains, appearing 
to push the second terrain farther back in the distance.  

Creating a Body of Water 
To complete these lessons you’ll need a terrain. If you’ve been following the tutorial 
from the beginning, you can use the files you have created. Otherwise, you can load the 
sample file, "Finished Sky" provided for you in the "Tutorials/Manual Tutorial" folder. 

• Lesson 7: Preparing the Landscape 
 esson 8: Creating the Interior of the Lak• L e 

• Lesson 9: Filling the Lake 

Lesson 7: Preparing the Landscape  
xt you will create a body of water by digging a hole a

In this tutorial, we'll use a Negative Boolean op
Ne nd adding some water.  

eration to cut a hole out of the ground 

 object. Objects can be given Negative, 
Positive, Neutral, or Intersect attributes in the Object Attributes dialog.  
To set the landscape as a Positive Boolean object:  

1. Click the Display modes button to switch to Wireframe mode.   
2. Select one of the terrains.  
3. Holding down Shift, select the second terrain and the ground plane. All three 

wireframes should now be highlighted in red.  

plane. A Negative Boolean operation requires a Positive object (or a Positive group of 
objects) and a Negative object. When these are grouped together the shape of the 
Negative object is cut out of the Positive
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4. Click the Object Attributes button (the A button) to display the Object Attributes 
dialog. 
 

 
5. Click on the Positive button to enable it. This makes each one of the selected 

objects positive.   
 

 
6. Click the OK icon.  

To group the terrains:  
iated with the 

e objects (Terrain 1, Terrain 2, and 
1. Click the Group button (the G button in the vertical list assoc

selected objects). This will group the thre
Plane 1) together in a Group called Group 1.  
 

 
2. With Group 1 still selected, click the Objects Attributes button (the A button) to 

display the Object Attributes dialog. 
 

 
3. Enable the Positive option.  
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4. Click the OK icon. The objects and the group are now all set to Positive. 

hird terrain object—Terrain 3 -and apply the same Desert Rock 
d 

ouped with the positive terrains created in the last 
ne.  

1. Click on the Create button to display the Create Palette.  

n the triangle icon next to Architectural and choose Terrains 
t category. 

ry, then on the Desert Rock preset (second from the 

e OK icon.  
This terrain needs to be rotated through 180 degrees about the X or Z-axis to create the 
interior of the lake.  
To rotate the terrain:  

1. Click on the Edit button to display the Edit Palette. 
2. Locate the Rotation tool. Move the pointer over the X or Z-axis rotation ring. 

 

Lesson 8: Creating the Interior of the Lake  
Next you will create a t
material as you used before. Then you will rotate the terrain object to create an inverte
terrain that will eventually form the interior of the lake. Next you will make the inverted 
terrain a Negative Boolean object. Gr
lesson, this negative terrain will ‘cut’ a hole out of the ground pla
To create a new terrain object:  

2. Click the Terrain Object to add a third terrain to the scene.  
3. Click on the Edit button to display the Edit Palette. 
4. Click the triangle icon next to Edit to display the Material Presets Library.  
5. If needed, click o

from the menu to change to tha
6. Click on the Rocky catego

left on the second row). A red border appears around your selected material. 
7. Click th

 
3. Hold down the Shift key (this causes the rotation to be carried out in 45-degree 

crements), then click n on ring. You’ll see the 
ee 

in a d drag horizontally on the rotati
angle of rotation displayed at the bottom left of your screen. Drag until you s
either 180 or -180 in the Text Display Area. 
 

 
 
The terrain will now be upside down and your screen should look like this.  
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To create a Negative Boolean object:  

1. With Terrain 3 still selected, click on the A button to display the Object Attributes 

It is now a negative Boolean object. This means that Bryce will ‘cut’ this shape 

2. Exit by clicking the OK icon.  

 3 wireframe is dotted, since it is now Negative.  

dialog, then click on Negative.  
 

from the ground plane.  

 
You'll notice that the Terrain
 

 
To create the lake:  

1. Ensure that the Wireframe Underground On/Off button, found on the 
Advanced Display Palette, is off. When the underground is off, the button will be 
 square with a line through it as seen in t e s d image below. a h  econ
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2. Click and drag Terrain 3 until the square base (which is now on top) is just above 

the ground plane. Watch the Nano-Preview window to track your progress.  
 
Your scene in wireframe mode should look like this.  
 

 
To group the terrains:  

1. With Terrain 3 still selected, hold down the Shift key and click one of the other 
terrains to select Group 1 together with Terrain 3.  

2. Click the Group button.  
3. Click the Render button to see the hole in the ground plane.  
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To make the interior of the lake bigger:  
1. Click the Display modes button to return to Wireframe mode.  

at the bottom of the Bryce window, click the 
ttom right corner of the Bryce window, 

2. If the Animation Palette is visible 
Time/Selection toggle, located in the bo
to display the Selection Palette.  
 

 
3. Click and hold the Terrain icon on the Selection Palette at the bottom of the 

screen, then select Terrain 3 from the list. 
 

 
 
Terrain 3 should now be the only selected object. Althou
th

gh it is part of a group, 
is terrain can still be repositioned, resized, and rotated on its own. 

 

 
4. With Terrain 3 selected, use the Resize tool to make i

R
to check the effect you're creating. W
s
the ground plane. 

t bigger and the 
eposition tool to fine- tune the positioning. Watch the Nano-Preview window 

hen you lower the terrain, keep the terrain’s 
quare bottom above the ground plane; otherwise, the hole will disappear under 
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Lesson 9: Filling the Lake  
Now we'll fill the hole with water. 
To fill the lake:  

1. Click on the Create button to display the Create Palette. 
2. Click the Water Plane icon.  

 

 
A water plane appears with a random material applied. It covers the whole of 
your image up to the bases of the mountains.  
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3. Click the triangle icon next to Edit to display the Materials Presets Lib
 

rary.  

 
4. In the Material Presets Library, click on the triangle icon next to Architectural 

and choose Waters from the menu to change to that category. Another selection 
of preset materials appears. 
 

 
5. Click on the Turbulent category, then on the Waves of Reflection preset 

w). A red border appears around your selected 
aterial. 

(second from the left on the first ro
m
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6. S
7. Click the OK icon to exit the Materials Presets Library.  
8. From the View Options menu choose From Front. 

 

elect Waves of Reflection (third row down, third from left).  

   
 
 
 
 
 
 
 

©2007 DAZ 3D, Inc.  1336 



Bryce 6 Artist Guide 

Your scene will look similar to this: 
 

 
Ensure that the Wireframe Underground On/Off button
Advanced Display Palette, is off. When the underground
a square with a line through it as seen in the second image below. 
 

9. , found on the 
 is off, the button will be 

 
If the water plane has been deselec
icon on the Selection Palette
from the list. 
 

10. ted for some reason, click the Infinite Planes 
 at the bottom of the screen and choose Plane 2 

 
11. Click on the  button to zoom in on the selected water plane. Zoom In
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Your scene will look similar to this: 
 

 
Click on the Edit button to display the Edit Palette

13. Use the Reposition tool to move the water plane al
until it is just below the ground plane.  
 
Your scene in wireframe mode should 
 

12. . 
ong the Y-axis (i.e., down) 

look similar to the image below.  
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14. Choose Director’s view from the View Options menu. 
 

 
15. Check the Nano-Preview window to ensure that the water pla

in
 

ne has filled the 
verted terrain.  

 
16. Click the Render button to view the final image.  

 

 
This concludes the beginner’s tutorial.  
This tutorial has only touched on a very small fraction of the controls and procedures 
available in Bryce. You could go further with this image by adding some rocks and 
vegetation to the foreground. Try different water materials for the lake and different 
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terrain and plane textures and a different sky - in Bryce the variations are literally 
endless. 

Creating a Vaulted Roof 

Creating a Vaulted Roof  
In this tutorial, you will create an animation of an interior scene of a building with a 
vaulted ceiling. You’ll work with an imported image, adjust the lighting of the scene, and 
finally animate the camera to fly through the scene.  

• Lesson 10: Creating a Pyramid 
• Lesson 11: Converting the Pyramid 
• Lesson 12: Resize the Pyramid 
• Lesson 13: Use the Sphere to Carve out the Roof 
• Lesson 14: Creating a Group 

Lesson 10: Creating a Pyramid  
oof, you will become familiar with the create and edit 

Create to display the Create Palette.  
the Pyramid icon.  

While creating the building’s r
controls of Bryce, as well as Boolean operations.  
To create the pyramid:  

1. Click 
2. Click 

 

 
 
A pyramid appears in your scene.  
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Next, make the pyramid flatter by reducing its height. 

To resize and reposition the pyramid: 
1. Click Edit to display the Edit Palette.  
2. Click the upper Y-axis of the Resize tool. 

 

 
3. Hold down the Shift key and slowly drag to the left. 

 

 
 

 
Until the pyramid looks similar to the image below: 
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Press
 
Next, you’ll proportionately enlar

ing the Shift key constrains the change to regular increments.  

ge the pyramid. This time, work directly with the 
 scene window.   

ing box, next to 
 to a 

roportional resize icon.  
 

object’s handles in the
4. Place the cursor over the upper right corner of the object’s bound

the Object Attributes button (the A button). The cursor changes
p

 
5. Hold down the Shift key and drag the corner of the bounding box to the right.  

 
The pyramid snaps to a larger size.  

6. Drag for three more steps. The pyramid is enlarged and should extend off the 
right edge of the scene window as seen below. 
 

 
 
Next, you'll use the arrow keys to nudge the pyramid to a more central position in 
the scene window.  

7. Press the left arrow key four times move the pyramid to the left. The pyram
moves so

id 
 that the entire object can be seen in the scene window. It will not be 

centered in the scene. 
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Lesson 11: Converting the Pyramid  
The next task is to duplicate the pyramid and convert it to a sphere. Eventually the 
sphere will be “cut out” from the pyramid using a Boolean operation.  
To duplicate the pyramid:  

1. Click Edit to display the Edit Palette.  
2. Make sure the pyramid is selected and choose Edit > Duplicate from the menu. 

A second pyramid appears in the exact place where the first one is.  
3. Click the double arrows at the top right of the Edit Palette.  

 
A set of Bryce primitives appears.  
 

 
4. Drag to the left until the sphere primitive is highlighted.  

 
The pyramid has changed to a sphere.  
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Lesson 12: Resize the Sphere 
To cut the sphere out of the pyramid, the sphere needs to be resized and slightly 
repositioned. This time you will resize the object using the 3D Transformations dialog 
box.  
To resize the sphere:  

1. On the Edit Palette, click the triangle beneath the Resize tool and select 3D 
Transformations from the list.  
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A dialog box appears.  
 

 
 
The bottom row of options are for changing an object’s size. Size is expressed as 
 percentage of the current size. To enlarge the sphere horizontally without 

) axis unchanged.  
 the numerical boxes for the size of the X and Z-axes, enter 125 (for 125%).  

 

a
affecting the height, you will enter new values for the X (width) and Z (depth) 
axes and leave the height (Y

2. In

 
3. Click the OK icon to exit the dialog box.  

 
The sphere expands slightly on the horizontal axis while the height remains 
unchanged. 
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To adjust the position of the sphere:  
1. From the View Co

 
ntrols menu, select From Front.  

 
 
The scene changes so that you are viewing 
view.  

the objects from a straight horizontal 

 

 
2. Click the upper Y-axis of the Reposition tool.  
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3. Hold down the Shift key and drag once to the left. 
 

 
 

 
The sphere drops so that it is half hidden under ground.  

 
 
Next you will lower the sphere a bit more until the next “rung” of the wireframe is 

.  
 key and drag to the left slightly until the wireframe is aligned 

several times to get the alignment exact. If 
the sphere in smaller increments. 

aligned with the ground level.   
4. Again, click and hold the upper Y-axis of the Reposition tool
5. Hold down the Shift

with the ground.  
 
You may have to repeat this step 
needed, let up on the Shift key to move 
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Next you will carve out the under side of the roof with the sphere using a Boo
operation.  

lean 

Lesson 13: Use the Sphere to Carve out the Roof 
To carve out the roof:  

1. Change back to Director’s View, by choosing Director’s View from the View 
Options menu on the Control Palette.  
 

 
 
N
s

ow, you will assign Boolean properties to your objects. The sphere is selected, 
o we’ll start with that.  

ox.   

he Object Attributes dialog box appears.  
 
Under the title, Sphere 1, the button for Neutral is selected. That is the default for 
all Bryce objects.  

 
2. Click the Object Attributes button (A) next to the sphere’s bounding b

 
T

©2007 DAZ 3D, Inc.  1348 



Bryce 6 Artist Guide 

 

 
3. Enable the Negative option by clicking on the button next to that option. 

 

 
4. Click the OK icon to exit the Object Attributes dialog box.  

 
The sphere’s wireframe changes to dotted lines.  
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Next, make the pyramid positive.  

5. Select the Pyramid by clicking it. Its wireframe turns red.  
 
You could use the Object Attributes dialog box to make the pyramid positive. 
However, Bryce has an easier way.  

6. Type P (for positive).  
 
The wireframe doesn’t change; its line is still solid.  

TIP: To make an object negative, type N. To make it intersect, type I. To make it neutral, 
type the letter O.  

Lesson 14: Creating a Group  
To make the Boolean effect work, you must group the objects together.  
To group objects:  

1. If the Selection Palette is not visible at the bottom of the Bryce window, click on 
the Toggle button or type S.  

2. If the pyramid is not currently selected, on the Selection Palette, click the Select 
Pyramid icon. 
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3. Hold down the Shift key and click the Select Sphere icon on the Selec
Palette.  

tion 

 

 
4. Both objects will be selected and the Object Control Palette next to the objects 

G). Click on the Group button to group the will change to add a Group button (
selected objects. 
 

 
 
The bounding box changes slightly, with diagonal ins
indicates that the object is a Boolean group. In addition, the 
and a U button takes its place. (The U stands for 
 

ets at each corner. This 
G button disappears, 

Ungroup)   
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5. Change the view back to Director's View an
y

d click the Render button to check 
our work. Your scene should look like the following figure.  

 

 
To create a family group:  

1. Press the Esc key to sw
 
The wireframe of your scene appears.  

2. Click the gray Family button underneath the Object Attribut

itch back to wireframe mode.  

es button.  
 

 
 
The Family dialog box appears. The gray color is selected and the Default
Family name displays at the bottom of the dialog box.  
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Click the bottom left color (maroon). T
 

3. he text display now reads Family 21.  

 
4. Select the words Family 21 and type the words Boolean Roof.  
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5. Click the OK icon to exit the Family dialog box.  
 
The dialog box disappears, and the Family button has changed to the maroon 
color.  
 

 
6. Deselect the object by clicking the background of the image. The wirefra

now changed to maroon to match 
 

me has 
the selected family color. 

 
7. Save your scene file and give it the name Rendered Boolean.  

Building the Walls 
In this next section, you will create walls for your roof using the cube primitive. Before 
doing so, however, you will need to raise the roof so that the walls can fit underneath.  

• Lesson 15: Moving the Roof 
• Lesson 16: Creating the Walls 
• Lesson 17: Adjusting the Wall Size 
• Lesson 18: Duplicate the Walls 
• Lesson 19: Make the Walls Taller 
• Lesson 20: Adding a Doorway 
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• Lesson 21: Assigning Boolean Properties 

1. If needed, select the Group by clicking it in the scene window. The wireframe 
turns red. 

2. Press the 
the horizon.  

Lesson 15: Moving the Roof  
To raise the roof:  

Page Up key six  times. The bottom of the pyramid will be aligned to 

 

 
 
TIP : You can also change the position of the roof by clicking the Object 
Attributes button and changing the Y-axis position to 35.60.  
 
You can zoom in for a closer view if needed. 

3. Click the Zoom In tool on the Advanced Display pale te ( he Zoom In tool is the 
magnifying glass with a plus sign (+)). 

t t

 

 
 
The objects appear larger, with the selected cube near the center of your scene.  
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Yo

Lesson 16: Creating the Walls  
 

will be the basis of your walls.  

reate Palette, click the Create Cube icon. 

u are now ready to create walls to go underneath your roof with the arched cutouts.
The Cube primitive 
To create the walls:  

1. On the C
 

 
 
A cube appears in your scene.  
 

 
2. Click the family color button to access the Family dialog box.   
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3. Select Family 17, type the word Wall in the text entry field, and click on the OK 
button. 
 

 
 
The family color is changed.  
 

 
4. Select the roof then change the view to Top View by choosing From Top from 

the View Options menu.  
 
The scene changes to top view. 
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TIP: Another way to change to top view is to use a keyboard shortcut. Press the 
number 2 key. (or ~ for Director’s View, 1 for Camera View, 2 for Top View, 3 for 
From Right, and 4 for From Front).  

5. Click the Zoom In tool once or twice to zoom in on the roof. By selecting th
earlier, the camera will zoom in on the selected object, centering it in the 
viewport. 

e roof 

s edge. However, it needs 
to be made wider to match the pyramid’s width, but less deep so that it does not occupy 
so or.  
To

Selection Palette to select the cube. 

Lesson 17: Adjusting the Wall Size  
Notice that the  lower edge is aligned with the pyramid’ cube’s

 much of the pyramid’s interi
 adjust the wall size:  
1. Click on the Select Cubes icon on the 

 

 
2. Place the cursor over the top center control point of the cube’s bounding box.   

 Z, indicating that Bryce is ready to work with the object 
 
The cursor changes to a
along the Z-axis.  
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y and s3. Click on the control point, hold dow lowly drag once the left. 

naps to half its depth. 

n the Shift ke
 
The cube s
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4. Repeat the procedure to shrink the cube to half its depth again.  
 

 
5. Place the cursor over the right center point of the bounding box. The cursor 

changes to an X.  
 

 
6. Press the Alt/Opt key (this will resize the object 

control point and drag
from the center), click on the 

 slowly to the the edges pf the cube line up with 
es of the pyramid. 

right until 
the edg
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Lesson 18: Duplicate the W
uplicate this wall to create the one opposite.  

1. With the wall still selected, choose Edit >

An identical cube appears in the sa
e up arrow key to align the wall with the opposite side of the pyramid. 

alls 
You now have one wall. D
To duplicate the walls:  

 Duplicate from the menu.   

me place.  
 

2. Press th
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3. Click the Select Families icon on the Selection Palette and select Wall from th
list. Both walls will be selected.  

e 

 

 
4. Duplicate these walls by choosing Edit > Duplicate from the menu or by 

pressing Cmd/Ctrl+D. A second se

For the next action you will tempora t of 

5. Click the Group button to group the walls.  

ects are grouped. The Family 
button color is gray for Default family (as a new entity, it takes on the Default 
family color and label). 

 rotate this group arou ns to be the same 
f the pyramid.  

it button to display the 
r cursor over the horizont
o a Y.  

t of walls is created in your scene.  

rily group the newly created seco
 

nd se
walls.   

 
The G button changes to a U, indicating that the obj

 
Now you can
as the center

nd its center, which happe
 o

6. Click the Ed Edit Palette.  
7. Place you al band of the Rotate tool. The cursor 

changes t
 

 
8. Press the Shift key to constrain rota rements.  

direc naps first to 45 degrees, 
to 9

tion to 45 degree inc
9. Click and slowly drag in either 

and, as you continue dragging
tion. The group s
0 degrees.  , 
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anges to a G, and the Family color changes 

 Taller  

10. Click the Ungrou
to the Wall color.

p button. The U ch
  

Lesson 19: Make the Walls
Before starting this lesson, press ~ to switc ill show 

To make the walls taller:  
1. Make sure all the walls are selected  

icon on the Selection Palette. 
r over the top axis o nges to a Y.  

h back to Director’s View. This view w

 by selecting them with the Select Cubes

more depth perspective.  

2. Place the curso
 

f the Resize tool. The cursor cha
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3. Press the Shift key then click and d p up to meet rag to the right until the walls po
the bottom of the pyramid.   
 

 
4. Click the Render button to see your progress. 

 

 

Lesson 20: Adding a Doo
licating t cuts a 

1. Switch to Top View.  
s if they are not already selected. 

rway 
You will make a doorway by dup
Boolean hole through the wall.  

and resizing one of the cubes so that i

To add a door:  

2. Select the wall object
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3. On the Selection Palette, click the   Solo Mode button. 
 

 
 

ground plane and the Boolean group) disappear, 
bjects and the camera.  

 

All unselected objects (the 
leaving only your selected o

 
 
The Solo M utton will change to red to indicate you are in Solo Mode. 
 

ode b

 
4. Deselect the wall objects by clicking ne window.  

ll object to select i
 elsewhere in your sce

5. Click the front wa t.  
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6. Duplicate the object by choosing Ed enu or pressing 
trl+D. This new object will become the doorway object.  

orway object must be a little ll. While you’re still in Top 
ou will increase its depth slig

n the Resize tool, /Alt key to change the 
ly, and drag slightly e the doorway object 

it > Duplicate from the m
Cmd/C
 
The do thicker than the wa
View, y htly.  

7. Click the Z-axis 
size symmetrical

o  hold down the Opt
 to the right to mak

thicker.  
 

 
 
The other resize adjustment must b ct from Front 

ne e wall more clearly. 
 tool,  key, and drag to the 

out the width in the following figure.  

e made looking at the obje
View.   

8. Switch to Front View. Zoom in if eded to see th
9. Click the X-axis on the Resize

 is ab
 hold down the Opt/Alt

left until the object
 

 
10. Click and drag the top Y-axis to the left. This will shorten the 

doorway. Continue until it is about t
 on the Resize tool 

he height in the following figure. 
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Lesson 21: Assigning  Properties  
ay object is created and siz , assign Boolean properties to it. 

 must be cut out of the wall, so you’ll need to make the doorway object 

olean properties:  
 N key to make the doorway object negative. The wireframe changes to 

e.  
to Top View.  

on it. The wireframe turns red.  
ange t

elect both the front wall and the doorway by drawing a selection marquee 
nd their centerpoints.  

 Boolean
After the doorw ed correctly
The doorway
negative.  
To add Bo

1. Press the
a dotted lin

2. Switch 
3. Select the front wall by clicking 
4. Press the P key to ch his object’s properties to positive.  
5. S

arou
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6. Click the Group button to group t
changes to Default Gray.  

hem. The G changes to a U and the family color 

 
Since this group is part of the Wall family a to assign the 

oup to the Wall family.  
lick the Family button on the rol Palette next to the group to access 

the Family dialog box.   
 family. 

 of objects, it’s a good ide
gr

7. C Object Cont

8. Select the Wall
 

 
  

9. Click the  icon to exit the dialog box. The Family button changes to the Wall 

ton to exit s e. The rest of your scene appears 
 Mode button changes green. 

OK
wireframe color.  

10. Click the 
and the S

Solo Mode but olo mod
 back to olo

 

 
11. Change to Director’s View.   

 Render button. You may n
alls and the r

12. Click the eed to adjust the walls if there is a gap 
between the w oof.  
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13. Save your scene.   

Group and Grow th
ing objects inside this b ugh it with 

eeds to b ject as a 
dividual objects retain

: Grouping the Building

e Entire Building 
Since you’ll be plac uilding and eventually flying thro
the camera, the building n e bigger. When you enlarge the entire ob
group, the in  their relative size and position.  

• Lesson 22  
3: Change Your Viewpoint cene• Lesson 2  of the S  

ect All from the menu or press Cmd/Ctrl+A. All of your 
ncluding the ground, are selected.  

the Shift key and click the ground to deselect it. The selection 
s only all objects. The Group 

Lesson 22: Grouping the Building  
To group the building:  

1. Choose Edit > Sel
objects, i

2. Hold down 
bounding box enclose  the pyramid group and the w
button is showing.  
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3. Click the Group button to group these objects.  
 

 
4. Press the * key twice (Shift+8). Each time you press this key, your group’s size 

 button (located with the group of buttons 
x of the selected object). The group jumps up so 

el

doubles.  
5. Click the upward pointing arrow

associated with the bounding bo
that it is now resting at ground lev .  
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Lesson 23: Change Your Viewpoint of the Scene 
the entire building.  

ckball  Controls Palette. The cursor 
rows.

to the r scenes rotates counter clockwise in 

You need to adjust your viewpoint of the scene so that you can see 
To change the viewpoint:  

1. Place the cursor over the Tra  control on the
changes to double crossed ar   

2. Click and drag the Trackball ight. The 
the scene window.   
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3. Continue dragging until the blue cam n the left side of the 
ame lin ck walls line up in the 

g like th e.  

era wireframe is o
window and the center wirefr es of the front and ba
center of the window, lookin e following figur
 

 

he doorway of the buildin
 
You are now looking through t g. 

ottom Z 
 

arrow of the .XZ Camera Control . 4. Place the cursor on the b

 
5. Drag up on the XZ Camer til you can see the entire front wall of the 

 like this.  

a Control un
building.  
 
The scene should look
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6. Save your scene and call it 

Sphere on a Pedestal 
ial will incorporate merged into the scene you are creating.  

Grouped Building.  

The next section of this tutor
• Lesson 24: Merging an Existing Scene 
• Lesson 25: Adjusting Lighting  

ene into the current s
eselect All

le > Merge from the menu
log, navigate to the utorial folder.  

 button. The Wireframe for the merged scene appears in your 
elected.  

Lesson 24: Merging an Existing Scene  
To merge another sc cene:  

1. Choose Edit > D  from the menu. 
2. Select Fi . 
3. In the Open dia Tutorials/Manual T
4. Select the scene file called Pedestal Merger.   
5. Click the Open

e and is sscen
 

 
6. Render the scene

are lights in the s
. There is now a p  with a mirrored sphere on it. There 

cene as well.  
edestal
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Lesson 25: Adjusting 
d use Bryce’s 

oint at certain objects. To make it easier, 
ome extra objects.  

p and lights.  
 button on the Selection Palette to change to Solo mode.   

lls and building objects disappear, leaving only the two lights and 
l and sphere.  

Lighting 
In this next lesson, you will make slight modifications to the lights an
tracking controls to make the lights always p
you’ll need to temporarily rid your scene of s
To adjust lights:  

1. Select the pedestal grou
2. Click the Solo Mode

 
The ground, wa
the pedesta
 

 
3. Click away from the objects to deselect them.  
4. Select the lower light.  
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5. Click the Tracking icon (the fourth button do
associated with the selected object) and drag

wn in the group of buttons 
 from it to the sphere object. 

 

 
 
While your mouse button is still
cursor turns green.   

 pressed, whatever object is underneath the 

n when the sphere turns green.  6. Release the mouse butto
 

 
 
The light is now set to track the sphere.  

at it is located above and to the left of the sphere.  The light 7. Drag the light so th
remains pointing at the sphere.  
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8. Click the Land Object button (the Down arrow button located in the group of 

ct). The light snaps to the ground, pointing toward the sphere from 
buttons associated with the  
selected obje
this position.  

9. Select the light that is located above and to the right of the pedestal.  
10. Drag from this light’s Tracking icon to the tall cylinder.  

 

 
11. Release the mouse button when the tall cylinder turns blue.  
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12. Drag the light down slightly to th
 

e right.  

 
13. Click the Solo Mode button to exit Solo Mode.  
14. Render and save your scene. 

 

 

Pre-Production 
 work on 
mation, and 

eline for the Sequence

In this section of the tutorial, you will plan the creation of an animation. You’ll
some pre-production tasks. Then you will animate the camera, tweak the ani
conduct test renders.  
You can use either the scene you created in this tutorial or the file entitled "Animation-
start" in the Manual Tutorials folder. 

• Lesson 26: Pre-Visualizing & Tim  
• Lesson 27: Setting up the Timeline for the Sequence 
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Lesson 26: Pre-Visualizing the Sequence  
Up until now, you’ve been working with your scene in Director’s View and in the differen
orthogonal views. For  
animating you will use Camera View. 

t 

quence:  
1. On the Controls Palette, choose Camera to Director from the Camera Options 

To plan and time the se

menu. 
 

 
 
The camera wireframe disappears from the scene. The camera object has 

n, the camera will go through 
y just 

moved to the same location as the Director’s View, so it is now located at your 
point of view.  

2. Switch to . Your scene changes to top view. The camera is now located Top View
at the bottom of the scene window. In this animatio
the doorway, circle around the pedestal, then go out through the archwa
above the left wall.  
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3. On the Display palette (to the right of the Working Window) click the Demo 
marker tool.  
 

 
4. Beginning at the camera’s location, drag the mouse to draw a path from the 

or, around the pedestal, and out the left side. Your scene 
 like this.  

camera, through the do
should look something
 

 
 
F
to travel.  
Press the space bar

or this example, let’s assume that this path will take 9 seconds for the camera 

5.  to remove the marked path and deactivate the Demo Marker 

Lesson 27: Setting up the Timeline for the Sequence  
Now that you have decided that t it is time to set it up 
and
To set

es 

(or click on the Demo Marker icon again). 

he animation will take 9 seconds, 
 begin animating the camera.  

 up the Timeline:  
1. Choose File > Animation Setup from the menu.  
2. In the dialog, enter 9 seconds in the Duration section and change the fram

per second (FPS field) to 10.  
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When you exit the dialog box, the Time Scrubber and Current Time Indicator
the Animation palette fill with a green timeline.  
 

 on 

 
 
The blue extends beyond what is visible in the Time Working area. You will 
the Scale tool above the right end o

use 
f the timeline to scale the timeline so that you 

3. On the Scale tool, drag the cursor to the right.  
can see it.  

 

 
 
The tick marks move closer togeth

4. Continue dragging until you can se
er and more of them appear from the right.  
e the entire green portion of the timeline.  

 

 
5. If the Selection Palette is showing, toggle to the Animation Palette by clicking the 

Toggle in the lower right corner of the Bryce interface.   
6. Click the triangle on the right side of the Animation palette and ensure Auto-key 

is selected.  
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7. Click the triangle again and select Ticker Marks > Every 5 Frames.  

 

 
 
When your fram
equivalent to a 

e rate is 10 frames per second, a ticker mark every 5 frames is 
ticker mark every half a second.  

 

 

Animate the Camera 
animation for a smooth animation.  This section shows how to adjust the camera 

• Lesson 28: Setting the Camera Trajectory 
• Lesson 29: Pointing the Camera 
• Lesson 30: Making Camera Adjustment 
• Lesson 31: Smoothing the Camera's Trajectory 
• Lesson 32: Test Render 

Lesson 28: Setting the Camera Trajectory  
To adjust the camera’s trajectory:  
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1. Drag the Scrubber three ticks to the right.
 

  

 
 
The time reading is 00:00:01.05.  

 

nter of the camera; you will 
ctual key position rather than the camera itself.  

.  

2. Place the cursor over the camera. Zoom out of if you need to in order to see the
camera.  
 
Do not drag the camera by the blue handle in the ce
be dragging and adjusting the a

3. Drag the camera to the interior of the room, as shown
 

 
4. A blue point appears w

line links the first point 
 

here the camera was just located and a blue trajectory 
with the new camera location.  

 
 
The trajectory is the line along which the camera will move.  
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You'll also notice that the keyframe button is yellow
at this point on the timeline. 

, indicating a saved keyframe 

 

 
5. Drag the Scrubber another three ticks to the right.  

 

6. Drag the camera so that it is on the left side of the mirrored sphere wireframe.  
The time reading is 00:00:03.00.  

 

 
7. Drag the Scrubber another three ticks to the right.  

 
The time reading is 00:00:04.05.  

8. Drag the camera so that it is on the far side (top) of the sphere wireframe, as 
shown.  
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9. Drag the S
 

crubber another three ticks to the right.  

ere wireframe.  
The time reading is 00:00:06.00.  

10. Drag the camera so that it is on the right side of the sph
 

 
11. Drag the Scrubber

00:00:07.05.  
 another three ticks to the right. The time reading is 

t it crosses to the left of the path as shown.   12. Drag the camera so tha
 

 
13. Drag the scrubber the final three ticks to the right to the end of the timeline.  

 
The time reading is 00:00:09.00.  

14. Drag the camera well beyond the wireframe to the left of the building, as shown.  
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Congratulations! You have just created a camera trajectory to animate this 

 
on. To ensure that you do not 
ext steps of this tutorial, you can 

deactivate this function. 

camera.  

You’ll no longer need the Bryce’s Auto-key functi
inadvertently create a new keyframe during the n

15. Click the triangle to the right of the Animation palette.  
16. Deselect Auto-Key from the list.  

 

 

Lesson 29: Pointing the Camera  
Check to see how the camera moves by playing the sequence.  

 
To play the sequence:  

• Click the Play button on the Animation palette. 
 

 
 
The camera moves along the blue trajectory while the Time scrubber moves from 
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left to right. Notice that throughout the animation, the camera faces in one 
dire
 

 the animation in the Manual Tutorial 

To point the camera:  
1. Toggle back to the Selection Palette by clicking the Toggle in the lower right 

2. l.  
ose the Sphere P on the list that appears.  

l sphere in the merged scene. Make a note of the 
; you will find it in a different pop-up menu in the next couple of 

ction. 

You can find a sample wireframe render of
folder, titled BooleanLessonWire1.mov. 

hand  
corner of the Bryce window. 
Click and hold the Select Sphere too

3. Cho
 
This should select the pedesta
sphere’s name
steps.  
 

 
4. Click the camera to select it.  

A).  

 
The camera’s wireframe turns red and the blue trajectory line appears.  

5. Click the Object Attributes button (
6. Click the Linking tab.  
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7. Click the box titled ‘None’ under Track Object Name.  
 

 
8. Select the name of the pedestal sphere.  
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9. Click the OK icon to leave the Camera’s Object Attributes dialog box.  

om 
ere.  

 
The camera snaps to the right to point at the sphere and a gray line extends fr
the camera to the sph
 

 
10. Toggle back to the Animation palette.  
11. Click the Play button. The camera moves along the trajectory, facing the sphere 

nual Tutorial 

.  
2. Click the 

ll the while keeping the sphere at the 
center of the scene window.  

3. 

Lesson 30: Making Camera Adjustments  
The height of the camera fly-through is below the mirrored sphere and below the open 
arch on the left side of 
the buildin  H  drag 
the
trajectory to reshape it. 

for the entire duration of the sequence.  
 
You can find a sample wireframe render of the animation in the Ma
folder, titled BooleanLessonWire2.mov.  

To view the scene from camera view:  
1. Switch to Camera View

Play button to watch the wireframe animation.  
 
The camera flies through the space, a

Save your scene, call it Animation-Rough Cam.  

g. owever, the camera trajectory may have some kinks in it. You can
 points of the camera 
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To adjust the height:  
1. Switch to the From Right view.  

 

 
2. Pre   select all objects in the scene. 
3. Click th ol so you see the entire camera path.  

 

ss Cmd/Ctrl+A to
e Zoom Out to

 
4. From the Select Options menu, choose Select Camera. 
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5. Drag the point
 

 on the right up so that it is level with the sphere.  

 
Drag the other points u6. p, except for the first and last.  

ould look like this figure. Note how the first and last points are 
lower than the others which we just moved up. 
 

 
Your scene sh

 
 
Next, you’ll adjust the camera’s height so that it is level with the sphere as it 
circles around it. 
 
To continue adjusting, you will need to look at the scene from a different 
perspective.  

7. Switch to From Front view.  
8. Zoom out if needed.  
9. Drag the endpoint of the camera trajectory up so that it extends from the sphere 

through the Boolean sphere and beyond the building.  
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e to see the same view as the image Note that you might need to Zoom out her
above. The dotted line of the sphere is the location of the open area of the arch. 
 Click the Play button.  10.
 
Watch the camera’s movement through the sequence. The camera ends up at 
the position you set at the previous step.  
 

 
 
Now that the camera is back on the trajectory, notice that the gray line betwee
the camera and the sphere provides a guide fo

n 
r that straight line of sight. You 

Your 
trajectory should look like the  
one shown.  

can use the guide for other placements of your trajectory.  
11. Drag the previous key point up so that it is aligned with that gray line. 
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12. Switch to Right view. 
13. Look at the animation path compared to the height of the door. In our exam

the point just inside the door is too 
ple, 

high which means the camera will pass 
through the top of the door. 
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14. Click on the point and move it down slightly. Move the first point down a little as 
well. 
 

 
 Switch to Front view. 15.

arch opening. 16. Look at the animation path that goes through the 
 

 
17. If you think the path is too high and the top may cut off part of the animation, grab 

 doesn't move 
down with it as it will adjust itself when you play the animation. 
the last point and drag it down some. Don't worry if the camera
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18. Switch back to Camera view.  
19. Click the Play button to see your animation.  

 of 

To see
To disp

1. 

3. 

Lesson 31: Smoothing the Camera's Trajectory  
To smooth the Camera’s trajectory, you will adjust the points and work with the shape
the curve using the tangents of each point.  

 the tangents, you will need to make them visible. 
lay the trajectory options:  

Switch to Director’s View.   
2. Click the Object Attributes button to access the Camera and 2D Options 

dialog.   
Click the Animation tab.  

4. Under Trajectory Options, click the button for Show Always and Show 
Tangents. 
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5. Exit the Camera and 2D Projection dialog box by clicking the OK icon.  
 
The camera trajectory now has green lines extending from each point.  
 

 
To smooth the trajectory:  

Smoothing the trajectory is easiest when you work in Top View so switch t
View.  
 

1. o Top 

 
2. Toggle to the Selection Palette.  

Click the Select Families button.  3. 
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4. Choose the Walls family.  
 

 
5. Hold down the Shift key and select Pedestal from the Families list. If the 

Pedestal family is not listed, choose Family 3 from the menu. 
 

 
6. Click the Solo Mode button. 

 

 
 
There is now a much clearer view of your camera trajectory and the tangents 
extending from each point.  
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Any kinks in the path result from a lengthy tangent interfering with a neighboring 
point. Shortening the tangent will smooth out the trajectory line.  

7. Click the camera to select it. The points appear.  
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8. Place the cursor over the point with the longest trajectory. The cursor chang
crossed arrows. 

es to 

 

 
9. Press the T key (for tangent), the 

and drag to the right. The tangent lines shorten.  
 

cursor changes to a double arrow, then click 
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10. Reposition any other points to smooth out the trajectory line.  
 

 
11. Click the Solo Mode button.  
12. Switch back to Camera View

15.

It’s tim  with the scene file 
you have been working with, or use the An tion-Smooth Cam scene file from the 
Manual Tutorial folder. 

ene to a 
smaller image.  
To create a test render:  

1. Choose File > Document Setup.  
2. In the dialog box, change the render resolution to 1:0.25. The document size will 

stay at the same size, but the rendered size will be smaller (saves time). 

.  
13. Toggle back to the Animation Palette.  
14. Click the Play button to view the animation.   

 Save your scene.   

Lesson 32: Test Render  
e to set up a test render of your animation sequence. Continue

ima

To create a rough animation, you need to change the render size of your sc
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3. Click the OK icon to exit the dialog box.  
4. Click the Render button to test render your scene.  
5. Choose File > Render Animation. The Render Animation dialog comes up 

where you can choose the settings for this test render.  
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6. In the Output Module
output 
 

 section, click on the arrow next to Format and choose an 
format. 

 
ime Movie, click the Edit button. A 7. If you selected to save as a QuickT

Compression Options dialog box appears. 
 

 
8. Disable the option for Keyframe e

 
very 10 frames then click OK.  

 
9. Click the Set button. A Save dialog box a

the render, Bryce 

ppears, showing the location and name 
of your movie.  

10. Choose the location and name of your movie.  
11. Click Save.  
12. Click the OK icon to exit the Render Animation dialog box.  

 
Your scene begins rendering each frame. At the end of 
automatically launches the movie player application.  
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13. Click the Play button to watch your animation.  
14. Pay attention to where the camera goes and looks at. If you don't like something, 

go back into Bryce, move the appropriate

F atio

p

ve

 points and re-render the animation. 
15. Once you are happy with the animation, switch back to Bryce and save your 

scene file.  
16. Congratulations! You’ve created yo

the movie player application befor
ur first Bryce movie! Make sure that you exit 

e you continue the tutorial.  

ine Tuning Your Anim n 
To finish your animation, you will convert your trajectory to a path. In the beginning, you 
used key frames to set  
the position of the camera. This trajectory
the camera over the  

 is good for creating the physical location of 

sequence. However, the points along the ath tend to correspond to places, and not 
necessarily events, or  

locity. 
Converting to a path will allow you to set up two key frames, one for the beginning and 

he velocity without worrying about the the other for the end, and you can adjust t
placement of a keyframe at that spot. 

• Lesson 33: Converting the Trajectory to a Path 
• Lesson 34: Creating Keyframes from the Beginning & End of the Path 
• Lesson 35: Velocity Adjustment 
• Lesson 36: Another Test Render 
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L
To

m the
pe as

esson 33: Converting the Trajectory to a Path  
 work on the timing and velocity of your sequence, you will need to convert your 

trajectory into a single path object. 
To convert from Trajectory to path:  

1. Switch to Top View.  
2. Select your camera by clicking it.  
3. Choose  froObjects > Create Path

occupying the same space and sha
 menu. A new path object appears, 
 the camera trajectory.  

 

 
4. Select the camera again.  
5. Click the triangle on the Selection Palette a

ion there
nd choose Camera to select the 

camera (Notice that there is an opt  for selecting paths as well). 
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The Camera and its trajectory line are selected. 

6. Click the Object Attributes button (A).  
7. Click the Linking tab.  
8. For Object Parent name, select Path 1 from the pop-up menu of your objects.  

 

 
9. Click the button next to Constrain 

 
to Path.  

 
10. Click the OK icon to leave the dialog box. The blue trajectory line disappears.  

 
The trajectory line went away when the camera was constrained to the path. All 
of the key-framed motion information for the camera went away with the 
trajectory.  
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The location information of the trajectory is preserved in the path, which is 
present in your scene.  

11. Click the Time/Selection Toggle to switch to the Animation Palette.  
12. Click the Play button.  

 
The scrubber moves, but the camera does not. You’ll re-set the key frames for 
camera motion for the beginning and end of the sequence.  

Lesson 34: Creating Keyframes from the Beginning & 
End of the Path  
To create key frames:  

1. Click the Time First Keyframe but
 

ton on the Animation Palette.  

 
 
The scrubber moves to the beginning of the sequence (time 00:00:00.0).  

2. Click the Add Keyframe button.  
 

 
3. Click the Last Keyframe button.  

 

 
 
The scrubber moves to the end of the sequence (time 00:00:09.0).  

4. Click the camera to select it.  
5. Click the Object Attributes button.  
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6. Type the number 100 in the Position box.  
 

 
7. Click the OK icon. Your camera should now be located at the end of the path.  
8. Click the Add Keyframe button.  
9. Check your animation, by clicking

 
 the Play button.  

Your camera should now move smo

The last thing you will do with your animation 

To

d Motio
the upp
 of the a

othly along the path.  
 
You now have very smooth camera movement over a complex path, using only 
two key frames.  

Lesson 35: Velocity Adjustment  
in this tutorial is adjust the camera’s 

velocity along the path. To do this, you will work in Bryce’s Advanced Motion Lab.  
Your camera should be selected.  

 adjust the velocity: 
1. Click the Advanced Motion Lab button. 

 
On the bottom half of the Advance n Lab, the objects and their timelines 
are displayed. The round button at er right of the timelines is the current 
time display. Because of the length nimation, you can’t see the entire 
timeline for this sequence.  
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2. Drag the round Current Time display marker to the left. The numbers and 

timeline bars scroll off to the right. 
 

 
3. Continue dragging left until the marker is at the left end of the timeline.  
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4. Drag the Scale tool to the right. (
 

It is located under the preview window.)  

 
 
The space between numbers decreases, and after a bit, the entire timeline is 
displayed.  
 

 
5. Release the mouse button.  The word Ca

a anim
mera is displayed in red.   

6. Click the word Camera. The camer ation settings are expanded under the 
Camera name. 
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7. Click the word Path Position. Additionally,

), a diag
n and

 in the Velocity Controls section (also 
known as the Time Mapping Curve onal line has appeared.  Next to the 
window to the right is a camera ico  a light icon.  
 

 
8. Click the camera icon.  

 
The numbers and timeline bars scroll off to

ay in the right window changes to show your 
e.   

 the right.  
 
A green light appears and the displ
scene from the camera’s perspectiv
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See how the animation preview and the 

matio
Velocity area work together.  

9. Click the Play button under the ani n preview window.  
 

 
 
The animation plays, while crosshairs ma

y curves

 click th

rk the current time along the Velocity 

 to put a little variety in the camera 

line.  
 
You’ll use one of the preset Velocit
motion.  

10. From the Velocity Controls section, e slight S-shaped curve that matches 
the one shown. 
 

 
11. Click the Play button.  

 
The animation begins slowly, moves fast
toward the end. 

er for a time and then slows down 
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When the velocity curve is flatter, camera

rner to

L en
Before your test render, double-check your render settings. To render:  

om th
 ensure 

log. 

om th
ange the his test file to Render 2.  

th” to

r Anima s 

F
Co  see the
For your final render, you may render at a larger s
Vo ght rays
ar
Co  scene, 
camera trajectory, converted the trajectory to a pa
on that path. You have walked through a fair porti

 motion is slower. When the curve is 
steeper, the motion is swifter.  

12. Click the arrow in the lower right co  leave the Advanced Motion Lab and 
return to your scene.  

13. Save your scene file. 

esson 36: Another Test R der  

1. Choose File > Document Setup fr e menu. 
that you are rendering at the smallest 2. In the Document Setup dialog box,

ratio: 1:0.25.  
3. Click on the OK icon to exit the dia
4. Switch back to Camera View.  
5. Select File > Render Animation fr e menu.  

 name of t6. In the Render Animation dialog, ch
7. Click the Set button.  
8. In the Save dialog box, add “test pa  the name.  

tion dialog box. Your animation begin
9. Click Save.  
10. Click the OK icon to exit the Rende

rendering. 

inal Comments  
mpare the two test animations. Do you  difference in movement?  

ize, or, for fun, try creating a 
lumetric World to add drama to those li  that enter the building through the 

ches.  
ngratulations! You have now created a set up your animation, created the 

th, and adjusted the camera’s velocity 
on of the power of creating and 

animating Bryce scenes. 
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A
The appendices contain information that is helpful
co oting. 

ppendices 
 for quick reference to shortcut 

mmands, known issues, and troublesho
• Appendix A - Shortcut Commands 
• Appendix B - Acronyms 
• Appendix C - Known Issues 
• Appendix D - Troubleshooting 
• Appendix E - Links 
• Appendix F - Credits 

Appendix A - Shortcut Com
ions with
iate sec

wa  go thro
s us

rtcut 

mands 
Shortcuts are a quick way to access funct in Bryce. These shortcuts are 
provided within the manual in the appropr tion, but the following pages provide a 

y to find the shortcuts without having to ugh the manual page by page. 
The commands for Macintosh and Window ers have been split into separate pages. 
Click on the links below to access the sho

• Macintosh Shortcut Commands 
• 

commands for your operating system. 

Menus 
• Palettes & Labs 
• Object Creation & Selection 
• Object Translation 
• Object Scaling 
• Rendering 
• Dialogs 

• Windows Shortcut Commands 
• Menus 
• Palettes & Labs 
• Object Creation & Selection 
• Object Translation 
• Object Scaling 
• Rendering 
• Dialogs 
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M andsacintosh Shortcut Comm  

Menus - Macintosh 

Menu Item Command Keys 

File 
Ne Commaw Document nd+N 
Do nt Setup Commacume nd+Option+N 
An Commaimation Setup nd+Shift+N 
Open Command+O 
Save Command+S 
Save As Command+Shift+S 
Revert to Saved Command+Option+S 
Render Command+R 
Clear and Render Command+Option+R 
Render Animation Command+Shift+R 
Print Command+P 
Edit 
Undo Command+Z 
Redo Command+Shift+Z 
Cut Command+X 
Copy Command+C 
Paste Command+V 
Cl Option+ear > 
Copy Material Command+Option+C 
Pa Commaste Material nd+Option+V 
Co Option+py Matrix C 
Paste Matrix Option+V 
Duplicate Command+D 
Replicate Option+D 
Multi-Replicate Option+Shift+D 
Random Replicate Option+R 
Select All Command+A 
Invert Selection Command+Shift+A 
Load Sky only when Merging Option, then choose File > Merge 
Object 
Edit Object Command+E 
Attributes Command+Option+E 
Co Optionvert Boolean to Mesh n+Shift+C 
Ed Commit Material and+M 
Ed Commit 2D Pictures and+Option+M 
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Ed Option+it 3D Textures M 
Show Objects As Box Command+B 
Sh Commow Objects As Mesh and+L 
Group Objects Command+G 
UnGroup Objects Command+U 
Create Path Option+P 
Fly-around Command+Y 
M Commotion Lab and+T 
Sk Commy Lab and+K 

Palettes & Labs - Macintosh 

Item Command Keys 

Palettes 
Cr Ctrl+eate 1 
Edit Ctrl+2 
Sky Ctrl+3 
To S ggle Time/Selection 
Labs 
Materials Lab Command+M 
Picture Library Command+Alt+M 
Deep Texture Editor Option+M 
Sky Lab Command+K 
Motion Lab Command+T 
Object Editor Command+E 
- Edit Mesh, Edit Torus, Terrain Editor, Light Lab, or Tree Lab 
Time Line 
Sh Option+ow Selected Path as Ribbon P 
Play or Pause / 
Ne > xt Ticker Mark in Timeline 
Previous Ticker Mark in timeline < 
Ne Shiftxt Key Frame +> 
Pr Shift+< evious Key Frame 
M [ ove to Start of Animation 
M ] ove to End of Animation 
- N t the end oext two items will move the Scrubber pas f the current Timeline 
Move to next Ticker Mark Period (.) 
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Go Comm back to previous Ticker Mark a (,) 
Not available for Macs Delete All Animation Frames at once 

Move Palettes 
M Spaceove Palette bar+drag palette 
Reset Palettes Option+Spacebar+click on a palette 
Advanced Display Palette 
Marker M 
Tu Ctrl+Alrn Anti-aliased Wireframes and Depth 
Cueing On or Off t+click Depth Cue Tool 

Reset Pan T Option+ool click on Pan Tool 
Fl Option+oating Nano-Editor Spacebar+drag in window 
Zo Plus (+)om In  
Zo Minus (om Out -) 

Comma
around 

nd+Spacebar + drag a marquee Zoom Into a Specific Area an area of your scene 
Comma
mouse l

nd+Option+Spacebar + drag the Zoom In Using the Mouse eft in your scene 

Zoom Comma
mouse r

nd+Option+Spacebar + drag the 
ight in your scene  Out Using the Mouse 

Camera Views 
Director's View ~ 
Ca 1 mera View 
Top 2 
Right 3 
Front 4 
Saved Views #1 through #5 5 through 9 
Reset Views Option + click on the Select Views control 
Delete Saved Camera Views Option+click on a filled Memory Dot 
Reset Camera Banking Option+click on Banking control 
Re Optioset Field of View n+click on Field of View control 
Re Shiftset Camera Origin Point +click on Camera Origin Point 
Re Optioset Views n+click on Select Views control 
Fly-around View 
Start Fly-around Command+Y 
Zo Comom In in Fly-around View mand + drag mouse up 
Zoom Out in Fly-around View Command + drag mouse down 
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Note: When dragging the mouse up or down to zoom i
l 

n or out, do not click in the scene, just 
move the mouse while pressing Command/Ctr
Sl Shift ow Down Fly-around View 
Pa Spacebause/Unpause Fly-around r 
St Return op Fly-around 
Camera Controls 
Co Option+nstrain Trackball to Y-axis drag on Trackball 
Co Controlnstrain Trackball to X-axis +drag on Trackball 
Render Controls 

Tu Select Orn Off Anti-Aliasing for an object bject, click on the  button, press 
Control+Shift+click on checkmark 

Tu Select Object, click on the  button, press rn On Anti-Aliasing for an object Shift+click on checkmark 

O  Macinbject Creation & Selection - tosh 

Item Command Keys 

Creating Objects 
Vo Option+lume Water Plane Click Water Plane 
Vo Option+lume Ground Plane Click Ground Plane 
Vo Option+Click Cloud Plane lume Cloud Plan 
Lo Optioad Preset Tree n+Click Tree 
Sa Ctrl+ve Preset Tree Click Tree 
Ne Shiftgative Metaball +Click Metaball 
Sp Ctrl+here with X=20.48, Y=10.24, Z=20.48 Click Sphere 
Sp Shifthere with X=20.48, Y=40.96, Z=20.48 +Click Sphere 
Cy Ctrl+Cllinder with X=20.48, Y=5.12, Z=20.48 ick Cylinder 
Cy Shiftlinder with X=20.48, Y=40.96, Z=10.24 +Click Cylinder 
Cu Ctrl+be with X=4.12, Y=5.12, Z=20.48 Click Cube 
Cu Shiftbe with X=10.24, Y=40.96, Z=20.48 +Click Cube 
Pyram Ctrl+Clid with X=20.48, Y=5.12, Z=20.48 ick Pyramid 
Py Shiftramid with X=10.24, Y=40.96, Z=20.48 +Click Pyramid 
Co
ho Ctrl+ne with X=10.24, Y=10.24, Z=40.96, 

rizontal Click Cone 

Co Shiftne with X=10.24, Y=40.96, Z=20.48 +Click Cone 
2D Ctrl+ Disk Horizontal Click 2D Disk Vertical 
2D Ctrl+ Face Horizontal Click 2D Face Vertical 
Set Object Attributes (non-metaballs) 
Se P t current object to Positive 
Se N t current object to Negative 
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Set current object to Intersect I (i) 
Note: the commands above will set a metaball's attributes but they will not affect its actions, 
it will still act as a positive object. 
Selecting Objects 
Multi-selection, Add object to current 
selection Shift+Click on object(s) 

Select obscured objects Ctrl+Click on object, select from list 
Tab through objects in scene Tab key 
Remove object from selection Shift+Click on object 
Se ct 
an ready 
se

Shift
lect all objects behind cursor (will desele
y object behind the cursor that is al +Click on front object 
lected) 

Add object to current selection from Ctrl+Cl
Shift+C

ick on object, when list comes up,  list lick on object in list to add 

Re Ctrl+
Shift

Click on object, when list comes up, move obscured object from selection +Click on object in list to deselect 

Inve  Selec
around 

t object then Shift+Drag Marquee rt selection in small area area 

Object Translation - Macintosh 

Item Command Keys 

Sun & Moon 

Pl

Hold
the S
Control+Option and, in the working window, 
click wh
yello

 down Control+Option and double-click 
un Control. Continue holding down 

ace Sun with Precision ere you want to position the sun. A 
w asterisk will show up where you click 

indicating where you placed the sun. 
Hold down Control+Option and double-click 
the Sun Control. Continue holding down 
Control+Option, press Shift, and, in the 

Place Moon with Precision working window, click where you want to 
position the sun. A blue asterisk will show up 
wher
the m

e you click indicating where you placed 
oon. 

Translating Objects Select object first ... 
Slow down translation Option+drag on Reposition control 

X+Drag object or Left-click-hold on object, 
press Control+Alt, then drag object Constrain direction to X-axis 

Y+Drag object or Left-click-hold on object, 
press Option, then drag object Constrain direction to Y-axis 

Constrain direction to Z-axis Z+Drag object or Left-click-hold on object, 
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press Command, then drag object 
Move positive on X-axis by 10.24 BU Shift+Right 
Move negative on X-axis by 10.24 BU Shift+Left 
Move posi ive on Y-axis by 10.24 BU t Shift+Page Up 
Move negative on Y-axis by 10.24 BU Shift+Page Down 
Move positive on Z-axis by 10.24 BU Shift+Up 
Move negative on Z-axis by 10.24 BU Shift+Down 
Move positive on Y-axis by 5.12 BU Page Up 
M Page Doove negative on Y-azis by 5.12 BU wn 
M Right orove positive on X-axis by 5.12 BU  ' 
Move negative on X-axis by 5.12 BU Left 
Move positive on Z-axis by 5.12 BU Up 
Move negative on Z-axis by 5.12 BU Down 
Move positive on X-axis by 2.56 BU Shift+Option+Up 
Move negative on X-axis by 2.56 BU Shift+Option+Down or Shift+Option+5 
M Shift+ove positive on Y-axis by 2.56 BU Option+Page Up 
M Shift+Oove negative on Y-axis by 2.56 BU ption+Page Down 
Move positive on Z-axis by 2.56 BU Shift+Option+Right 
M Shiftove negative on Z-axis by 2.56 BU +Option+Left 
Move positive on X-axis by 0.08 BU Option+Right or Option+' 
Move negative on X-axis by 0.08 BU Option+Left 
Move positive on Y-axis by 0.08 BU Option+Page Up or Shift+Option+1 
Move negative on Y-axis by 0.08 BU Option+Page Down 
Move positive on Z-axis by 0.08 BU Option+Up or Shift+Option+7 
Move negative on Z-axis by 0.08 BU Option+Down or Shift+Option+9 

Object Scaling - Macintosh 

Item Command Keys 

Scaling Objects Interactively Select object first ... 

Increase by 50% on selected side e
Shift+drag right on control point once for 
ach increase 

Decrease by 50% on selected side e
Shift+drag left on control point once for 
ach increase 

Increase by 50% from center o
Shift+Option+drag right on control point 
nce for each increase 

Decrease by 50% from center o
Shift+Option+drag left on control point 
nce for each increase 

Scale from center Option+drag on control point 
Scale from opposite side Command+drag on control point 

Scale from specific side C
Drag on control point then press 

ontrol+Option 
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Scaling Objects by Keyboard Select object first ... 
Double object size * (Shift+8) 
Halve object size / 
Re  turn object to original (unity) size =

Rendering - Macintosh 

Menu Item  Command Keys  

Render  Command+R  
Clear and Render  Command+Option+R  
Render Animation  Not available on Mac 
Resume Render  Command+R  

Turn off AA for single object or group  Select object or group, press  button, press 
Ctrl+Shift+Alt, and click on OK icon  

Turn on AA for single object or group  Select object or group, press  button, press 
Shift, and click on OK icon  

Dialogs - Macintosh 

These are commands that work inside a specific dialog or lab field. 

Item Command Keys 

Object Attributes/Multi Replicate/Sky Lab - Text Field Modifiers 
Add 1 to value Up Arrow 
Subtract 1 from value Down Arrow 
Add 0.01 to value Option+Alt+Up Arrow 
Subtract 0.01 from value Option+Alt+Down Arrow 
Ad Shift+Ud 10 to value p Arrow 
Subtract 10 from value Shift+Down Arrow 
Random Replicate - Text Field Modifiers 
Add 1 to value Up Arrow 
Subtract 1 from value Down Arrow 
Edit Mesh 

Export Rocks/Imported Meshes Select mesh, Command+E or click on  
button, then Command+D 

Terrain Editor 
Access Deep Texture Editor from Terrain 

itor 
Shift+click on Picture button or 

Ed Command+Option+O 
Command+O or  

Access Picture Library from Terrain Editor Control+click on Picture button 

New Blank Terrain Command+N 
Revert to Terrain active when TE was opened Command+Shift+N or  
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Control+click New button 

ErodeTerrain Command+Shift+E 
Raise Terrain Command+Shift+X 
Lower Terrain Command+X 
Max Brush Level (white) Command+L 
Min Brush Level (black) Command+Shift+L 
Reset Clipping Bracket Command+Shift+A 
Flip/Invert Terrain Command+I 
Re Option+click on Gradient Bar set Gradient Bar 
Flip Gradient Colors Command+F 
Co Commapy Terrain Grayscale to Clipboard nd+C 
Paste Terrain Grayscale to Terrain Canvas Command+V 
Un Commanddo one step +Z 
Deep Texture Editor 
Clear Texture Command+N 
Terrain Exporter 
Preview Pan Spacebar+Drag 
Preview Zoom Command+Drag 
Preview Adjust Contrast Command+Option+Drag 
Preview Adjust Brightness Command+Option+Shift+Drag 
Advanced Motion Lab 
To Option+clggle Hierarchy for Object ick Object Name 
An Shift+clickimation Options Dialog for Object  Object or Attribute Name 
To Commandggle Hierarchy for all Animated Objects +Q 
To
ob Not availaggle Hierarchy for Selected Object (if 

ject contains a sub-hierarchy) ble on Mac 

Sh Commandow All/Show Animated +A 
To Home p of List 
Bo End ttom of List 

Windows Shortcut Commands 

Menus - Windows 

Menu Item Command Keys PC 

File 

Ne Ctrl+
key on n

N or Set NumLock, then Ctrl+ decimal w Document umpad 
Do Ctrl+cument Setup Alt+N 
Anim Ctrl+Shation Setup ift+N 
Open Ctrl+ O or Set NumLock, then Ctrl+ divide 
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key (/) on numpad 
Sa Ctrl+ve S 
Save As Ctrl+Shift+S 
Revert to Saved Ctrl+Alt+S 
Render Ctrl+R 
Clear and Render Ctrl+Alt+R 
Render Animation Alt+Shift+R 
Print Ctrl+P 
Edit 
Undo Ctrl+Z 
Redo Ctrl+Shift+Z 
Cu Ctrl+X t 
Co Ctrl+C py 
Paste Ctrl+V 
Clear Alt+> 
Copy Material Ctrl+Alt+C 
Pa Ctrl+Alste Material t+V 
Copy Matrix Alt+C 
Paste Matrix Alt+V 
Duplicate Ctrl+D 
Replicate Alt+D 
Multi-Replicate Alt+Shift+D 
Random Replicate Alt+R 

Ctrl+
nump

A or Set NumLock, then Ctrl+1 key on Select All ad 
In Ctrl+vert Selection Shift+A 
Load Sky only when Merging Alt, then choose File > Merge 
Object 
Edit Object Ctrl+E 
Attributes Ctrl+Alt+E 
Co Alt+Shift+C nvert Boolean to Mesh 
Edit Material Ctrl+M 
Edit 2D Pictures Ctrl+Alt+M 
Ed Alt+Mit 3D Textures  
Sh Ctrl+B ow Objects As Box 
Sh Ctrl+ow Objects As Mesh L 
Group Objects Ctrl+G 
UnGroup Objects Ctrl+U 
Create Path Alt+P 
Fly-around Ctrl+Y 
M Ctrl+T otion Lab 
Sky Lab Ctrl+K 
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Palettes & Labs - Windows 

Item Command Keys 

Palettes 
Create Ctrl+1 
Edit Ctrl+2 
Sky Ctrl+3 
To S ggle Time/Selection 
Labs 
M Ctrl+aterials Lab M 

Pi Ctrl+Alt+M or Ctrl+A
numpcture Library lt+ minus key on 

 ad

De Alt+M or Set Num
on nu

Lock, then Alt+ minus key 
mpad ep Texture Editor 

Sk Ctrl+K or S
on nuy Lab et NumLock, then Ctrl+ plus key 

mpad 
M Ctrl+T otion Lab 
Ob Ctrl+ject Editor E 
- E  Lab, or Tdit Mesh, Edit Torus, Terrain Editor, Light ree Lab 
Time Line 
Sh Alt+Pow Selected Path as Ribbon  
Pl / ay or Pause 
Ne > xt Ticker Mark in Timeline 
Pr < evious Ticker Mark in timeline 
Ne Shift+> xt Key Frame 
Previous Key Frame Shift+< 
Move to Start of Animation [ 
Move to End of Animation ] 
- Next two items will move the Scrubber past the end of the current Timeline 
Move to next Ticker Mark Period (.) 
Go back to previous Ticker Mark Comma (,) 

De Ctrl+S
button 

hift+Alt+click on Remove Keyframe lete All Animation Frames at once 

Move Palettes 
M Spacebaove Palette r+drag palette 
Reset Palettes Alt+Spacebar+click on a palette 
Advanced Display Palette 
Marker M 
Turn Anti-aliased Wireframes and Depth Ctrl+Alt+click Depth Cue Tool Cueing On or Off 
Re Alt+clicset Pan Tool k on Pan Tool 
Floating Nano-Editor Alt+Spacebar+drag in window 
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Zo Plus (+)om In  
Zo Minus (om Out -) or Shift+0 (on numpad) 

Zo Ctrl+Sp
area o

acebar + drag a marquee around an 
f your scene om Into a Specific Area 

Zo Ctrl+
your 

Alt+Spacebar + drag the mouse left in om In Using the Mouse scene 

Zo Ctrl+
your om Out Using the Mouse Alt+Spacebar + drag the mouse right in 

scene 
Camera Views 
Di ~ rector's View 
Ca 1 mera View 
To 2 p 
Ri 3 ght 
Fr 4 ont 
Sa 5 througved Views #1 through #5 h 9 
Re Alt + clset Views ick on the Select Views control 
De Alt+cliclete Saved Camera Views k on a filled Memory Dot 
Re Alt+clicset Camera Banking k on Banking control 
Re Alt+clicset Field of View k on Field of View control 
Re Shift+clset Camera Origin Point ick on Camera Origin Point 
Re Alt+clicset Views k on Select Views control 
Fly-around View 
St Ctrl+Y art Fly-around 
Zo Ctrl +om In in Fly-around View  drag mouse up 
Zo Ctrl +om Out in Fly-around View  drag mouse down 
No o zoom
m l 

te: When dragging the mouse up or down t  in or out, do not click in the scene, just 
ove the mouse while pressing Command/Ctr

Sl Shift ow Down Fly-around View 
Pa Spacebause/Unpause Fly-around r 
St Enter op Fly-around 
Camera Controls 
Co Alt+dranstrain Trackball to Y-axis g on Trackball 
Constrain T Ctrl+drarackball to X-axis g on Trackball 
Render Controls 

Tu Select Orn Off Anti-Aliasing for an object bject, click on the  button, press 
Ctrl+Shift+click on checkmark 

Tu Select Object, click on the  button, press rn On Anti-Aliasing for an object Shift+click on checkmark 
 

©2007 DAZ 3D, Inc.  1423 



Bryce 6 Artist Guide 

Object Creation & Selection - Windows 

Item Command Keys 

Creating Objects 
Volume Water Plane Ctrl+Click Water Plane 
Volume Ground Plane Ctrl+Click Ground Plane 
Volume Cloud Plan Ctrl+Click Cloud Plane 
Lo Alt+Cad Preset Tree lick Tree 
Save Preset Tree Ctrl+Click Tree 
Negative Metaball Shift+Click Metaball 
Sphere with X=20.48, Y=10.24, Z=20.48 Ctrl+Click Sphere 
Sphere with X=20.48, Y=40.96, Z=20.48 Shift+Click Sphere 
Cylinder with X=20.48, Y=5.12, Z=20.48 Ctrl+Click Cylinder 
Cylinder with X=20.48, Y=40.96, Z=10.24 Shift+Click Cylinder 
Cube with X=4.12, Y=5.12, Z=20.48 Ctrl+Click Cube 
Cube with X=10.24, Y=40.96, Z=20.48 Shift+Click Cube 
Py Ctrl+ramid with X=20.48, Y=5.12, Z=20.48 Click Pyramid 
Pyramid with X=10.24, Y=40.96, Z=20.48 Shift+Click Pyramid 
Cone with X=10.24, Y=10.24, Z=40.96, Ctrl+Click Cone horizontal 
Cone with X=10.24, Y=40.96, Z=20.48 Shift+Click Cone 
2D Ctrl+ Disk Horizontal Click 2D Disk Vertical 
2D Ctrl+Cl Face Horizontal ick 2D Face Vertical 
Set Object Attributes (non-metaballs) 
Set current object to Positive P 
Se N t current object to Negative 

I (i) o
nump

r Set NumLock, then press 9 (on 
ad) Set current object to Intersect 

Note: the commands above will set a metaball
ll still act as

's attri
wi  a positive object. 

butes but they will not affect its actions, 

Selecting Objects 
M
se Shift+ulti-selection, Add object to current Click on object(s) lection 
Se Ctrl+lect obscured objects Click on object, select from list 
Ta Tab kb through objects in scene ey 
Remove object from selection Shift+Click on object 
Select all objects behind cursor (will deselect 
any object behind the cursor that is already Shift+Click on front object 
selected) 

Ctrl+
Shift+Add object to current selection from list Click on object, when list comes up, 

Click on object in list to add 
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Ctrl+Cl
Shift

ick on object, when list comes up, 
+Click on object in list to deselect Remove obscured object from selection 

Selec
around 

t object then Shift+Drag Marquee Invert selection in small area area 

Object Translation - Windows 

Item Command Keys 

Sun & Moon 

Pl

Hold
Control
in the
to positi
show
you p

 down Ctrl+Alt and double-click the Sun 
. Continue holding down Ctrl+Alt and, 

 working window, click where you want 
on the sun. A yellow asterisk will ace Sun with Precision 

 up where you click indicating where 
laced the sun. 

Place Moon with Precision 

Hold
Cont
press
wher
asteri
indic

 down Ctrl+Alt and double-click the Sun 
rol. Continue holding down Ctrl+Alt, 
 Shift, and, in the working window, click 
e you want to position the sun. A blue 
sk will show up where you click 
ating where you placed the moon. 

Translating Objects Select object first ... 
Sl Alt+drag on Reposition control ow down translation 

Co X+D
press Ctnstrain direction to X-axis rag object or Left-click-hold on object, 

rl+Alt, then drag object 

Co Y+Drag
press A

 object or Left-click-hold on object, nstrain direction to Y-axis lt, then drag object 
Z+Dr
press

ag object or Left-click-hold on object, Constrain direction to Z-axis  Ctrl, then drag object 
M Shift+ove positive on X-axis by 10.24 BU Right 
Move negative on X-axis by 10.24 BU Shift+Left 
M Shift+Pove positive on Y-axis by 10.24 BU age Up 
M Shift+Pove negative on Y-axis by 10.24 BU age Down or Shift+' 
Move positive on Z-axis by 10.24 BU Shift+Up 
M Shift+ove negative on Z-axis by 10.24 BU Down 
M Page ove positive on Y-axis by 5.12 BU Up 
M Page Doove negative on Y-azis by 5.12 BU wn 
M Rightove positive on X-axis by 5.12 BU  or ' 
M Left ove negative on X-axis by 5.12 BU 
M Up ove positive on Z-axis by 5.12 BU 
M Down ove negative on Z-axis by 5.12 BU 
M Shift+Aove positive on X-axis by 2.56 BU lt+Up 
Move negative on X-axis by 2.56 BU Shift+Alt+Down or Shift+Alt+5 
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M Shiftove positive on Y-axis by 2.56 BU +Alt+Page Up 
M Shift+Aove negative on Y-axis by 2.56 BU lt+Page Down 
Move positive on Z-axis by 2.56 BU Shift+Alt+Right 
M Shiftove negative on Z-axis by 2.56 BU +Alt+Left 
M Alt+Rove positive on X-axis by 0.08 BU ight or Alt+' 
Move negative on X-axis by 0.08 BU Alt+Left 
Move positive on Y-axis by 0.08 BU Alt+Page Up or Shift+Alt+1 
Move negative on Y-axis by 0.08 BU Alt+Page Down 
Move positive on Z-axis by 0.08 BU Alt+Up or Shift+Alt+7 
Move negative on Z-axis by 0.08 BU Alt+Down or Shift+Alt+9 

Object Scaling - Windows 

Item Command Keys 

Sc Select obaling Objects Interactively ject first ... 

In Shift+d
each in

rag right on control point once for 
crease crease by 50% on selected side 

De hift+d
ach increase by 50% on selected side S rag left on control point once for 

ce rease 

Increase by 50% from center Shift+A
r each

lt+drag right on control point once 
fo  increase 

De t+A
for each increase crease by 50% from center Shif lt+drag left on control point once 

Sc Alt+draale from center g on control point 

Sc Click on control point then press Ctrl and ale from opposite side drag 

Scale from specific side a
Click on control point then press Ctrl+Alt 
nd drag 

Scaling Objects by Keyboard Select object first ... 
Double object size * (Shift+8) 
Halve object size / 
Return object to original (unity) size = 

Rendering - Windows 

Menu Item  Command Keys  

Render  Ctrl+R  
Clear and Render  Ctrl+Alt+R  
Render Animation  Alt+Shift+R  
Resume Render  Ctrl+R  
Turn off AA for single object or group  Select object or group, press  button, press 
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Ctrl+Shift+Alt, and click on OK icon  
Select object or group, press  button, press Turn on AA for single object or group  Shift, and click on OK icon  

Dialogs - Windows 

These are commands that work inside a specifi

Item 

c dialog or lab field. 

Command Keys 

Object Attributes/Multi Replicate/Sky Lab - Text Field Modifiers 
Add 1 to value Up Arrow 
Subtract 1 from value Down Arrow 
Add 0.01 to value Ctrl+Alt+Up Arrow 
Subtract 0.01 from value Ctrl+Alt+Down Arrow 
Add 10 to value Shift+Up Arrow 
Subtract 10 from value Shift+Down Arrow 
Random Replicate - Text Field Modifiers 
Add 1 to value Up Arrow 
Subtract 1 from value Down Arrow 
Edit Mesh 

Select mesh, Ctrl+E or click on  button, then Export Rocks/Imported Meshes Ctrl+D 
Terrain Editor 
Access Deep Texture Editor from Terrain Shift+click on Picture button or Ctrl+Alt+O Editor 

Ctrl+O or  
Access Picture Library from Terrain Editor Ctrl+click on Picture button 

New Blank Terrain Ctrl+N 
Ctrl+Shift+N or  

Revert to Terrain active when TE was opened Ctrl+click New button 

ErodeTerrain Ctrl+Shift+E 
Raise Terrain Ctrl+Shift+X 
Lower Terrain Ctrl+X 
Max Brush Level (white) Ctrl+L 
Min Brush Level (black) Ctrl+Shift+L 
Re Ctrl+set Clipping Bracket Shift+A 
Fl Ctrl+I ip/Invert Terrain 
Re Alt+click on Gradient Bar set Gradient Bar 
Flip Gradient Colors Ctrl+F 
Copy Terrain Grayscale to Clipboard Ctrl+C 
Paste Terrain Grayscale to Terrain Canvas Ctrl+V 
Undo one step Ctrl+Z 
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Deep Texture Editor 
Cl Ctrl+ear Texture N 
Terrain Exporter 
Preview Pan Spacebar+Drag 
Preview Zoom Ctrl+Drag 
Preview Adjust Contrast Ctrl+Alt+Drag 
Preview Adjust Brightness Ctrl+Alt+Shift+Drag 
Advanced Motion Lab 
Toggle Hierarchy for Object Alt+click Object Name 
Animation Options Dialog for Object Shift+click Object or Attribute Name 
Toggle Hierarchy for all Animated Objects Ctrl+Q 
To
ob

Ctrl+H 
close

ggle Hierarchy for Selected Object (if (will only open sub-hierarchy, will not 
ject contains a sub-hierarchy)  it) 

Sh Ctrl+A ow All/Show Animated 
To Homep of List  
Bottom of List End 

Appendix B - Acronyms 

AM
BU

DT

G2H - grayscale-to-height map 
HD
IB
LO
M
M

PSP - Paint Shop Pro 

AA - Anti-Aliasing  
L - Advanced Motion Lab  
 - Bryce Unit 

DOF - Depth of Field 
DS - DAZ Studio 

E - Deep Texture Editor 
FOV - Field of View 

RI - High Dynamic Range Image 
L - Image Based Lighting 
D - Level of Detail  

at Lab or MatLab - Materials Lab 
RD - Maximum Ray Depth 

PS - Photoshop 

SymLat - Symmetrical Lattice 
TE - Terrain Editor  
TIR - Total Internal Reflection 
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Appendix C - Known Issue
e or j

ures E

s 
This page lists the known issues with Bryc
cu

ust helpful information about how things 
rrently work. 
1. Alpha Channel replacement in Pict ditor 
2. Animation Preview in OpenGL Mode 
3. Apply Gradient to Light 
4. Bryce 4 Animations do not work in Bryce 6 
5. Bryce 4 OBPs crash Bryce 6 
6. Camera Grouping 
7. Cannot add Long Descriptions to Older Presets 
8. Crash when accessing Library with no Presets 
9. Cutting Trees crashes Bryce 
10. Deleting Leo or Moon Texture 
11. Display or Hide Palettes 
12. Exporting Objects 
13. File Size Doubled 
14. Hidden Body Parts in DS Animations 
15. Image Based Lighting 
16. Imported objects grouped by Material 
17. Importing objects with Bump Maps 
18. Lab Keyframes not added to Main Timeline 
19. Leaf Textures not saved 
20. Location changes in DS not reflected in Bryce 
21. Manual Rotation on Y-axis 
22. Memory Dots not Saving IBL Info 
23. Memory Issues 
24. Moon Brightness 
25. Photoshop Plug-in Support 
26. Real-Time 3D Preview for Filters 
27. Reflection Mapping 
28. Reset Clamps option missing 
29. Screen Refreshing 
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30. Spray Rendering from Render Mode 
31. Sun/Moon Rings 
32. Terrain Gradients 
33. Tick Marker in IBL Tab disappears 
34. Tree Lab Branches per Segment 
35. Volumetric Object Intersection 

PC Specific Issues: 
1. Windows Vista and AVI files 

Mac Specific Issues: 
1. 16-Bit Textures imported into Terrain Editor 
2. Batch Rendering 
3. Bryce 6 Scene files saved with Bryce 5 extension 
4. CPU Usage 
5. Gradient Color Picker 
6. Loading files with no extension 
7. Numeric Edit Boxes 
8. Permission Issues 
9. Save versus Save As 
10. Universal Binary Support 

Alpha Channel replacement in 
a chann
 to eithe

, 6, and

nGL
When previewing an animation from DAZ Studi

e anim
 is to

Affected versions: Mac/PC Bryce 6/6.1. 

Pictures Editor 
Loading image in Pictures Editor with alph el to replace another image does not 
replace the alpha channel. Workaround is r load the alpha map separately or 
load into a blank slot.  
Affected versions: Mac/PC Bryce 4, 5, 5.5  6.1. 

Animation Preview in Ope  Mode 
o and in an OpenGL Display Mode, the 

OpenGL display cannot properly display th ation and the objects and figures will 
look like they are "exploding." Workaround  preview an animation in Wireframe 
Mode. 
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A
aded 

ea
l.  

Affected versions: Bryce 5, 5.5, 6, and 6.1.  

t wor
rk co

nd is to open the animation file in Bryc , select File > Animation Setup, set 
the Duration settings to 0 (make a note of the c

on Se
hould

 6 
e 6 cr
 OBP
into B
ed int

C
Ca rted m

ons t
ry pre

access to the longer titles and descriptions by default. To take advantage of the longer 
title and description fields, export the older preset
Af

pply Gradient to Light 
On the PC, gradients (.grd) can only be lo that were saved from Photoshop 5.5 or 

rlier.  
On Macs, .grd files cannot be loaded at al

Bryce 4 Animations do no k in Bryce 6 
Animations created in Bryce 4 may not wo rrectly if at all in Bryce 6. The 
workarou e 6

urrent Duration settings on paper first), 
tup again, re-enter the Duration settings, click on the OK icon, select File > Animati

and click on the OK icon. The animation s  now play correctly in Bryce 6. 
Affected versions: Mac/PC Bryce 6/6.1. 

Bryce 4 OBPs crash Bryce
Some Bryce 4 OBP files will cause a Bryc ash when selecting the object in the 
Objects Library. Workaround is to load the  in the  Bryce 5/5.5 Objects Library, 
export out as a new OBP file, then import ryce 6.x.  
No
library. 

te: The object does not have to be load o the scene in Bryce 5/5.5, just into the 

Affected versions: Mac/PC Bryce 6/6.1. 

amera Grouping 
mera can be incorporated into a conve esh group.  

Affected version: Mac/PC Bryce 6.  
Fixed in: Bryce 6.1. 

Cannot add long Descripti o older Presets 
Because of the changes made to the libra view sizes, older presets do not have 

 from Bryce 6.1, and then re-import.  
fected versions: Mac/PC Bryce 6.1. 
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C rar
Ru  will c

 install a

r sce
Af

ure 
If you delete Leo in the Pictures Editor, he'll come
fir ith the m
ar
Af  for the t

D
Since the palettes are no longer hidden in Bryce s
th tions no

s are 
rsions: 
Affec
es. Af

W
ral tex
 are not
  
tion in B

rash when accessing Lib y with no Presets 
nning Bryce without the default presets ause Bryce to crash since the locations 

are hard-coded into Bryce. Make sure you ll the preset executables that come 
with Bryce.  
Affected versions: All. 

Cutting Trees crashes Bryce 
If you try to cut some Bryce trees from you ne using Cmd/Ctrl+X, Bryce will crash.  

fected versions: Mac/PC Bryce 6.1. 

Deleting Leo or Moon Text
 back and any textures you load in the 

st slot, will be replaced by Leo. Same w oon texture since both these images 
e hard-coded into Bryce.  
fected versions: All for Leo, Bryce 6/6.1 he moon only. 

isplay or Hide Palettes 
o that mousing over them makes 

em visible, some of the display/hide func  longer work.  
See below for the listing of which function affected:  

• Ctrl+4 - Control palette. Affected ve Bryce 4, 5, 5.5, 6, and 6.1.  
• Ctrl+6 - Advanced Display palette. ted versions: Bryce 4, 5, 5.5, 6, and 6.1.  
• Ctrl+Tab - Display or Hide all palett fected versions: PC Bryce 5, 5.5, 6, and 

6.1. 
 

Exporting Objects 
hen exporting objects:  
1. Alpha Effects (i.e., using a procedu ture to drive the value of the 

 exported.  transparency or reflection channel)
2. Reflection values are not exported.
3. 256x256 pixel image texture resolu ryce 6, 512x512 pixel image texture 

resolution in Bryce 6.1.  
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4. Mac exports .PCT image textures which 
revio
 textu
 are a
of the

F
file ma
hanges

nim
W to Bry
re till ob

 "Rev

 effect

6.1.  
.  

he Sky Library and to Memory Dots, however: 
mory D
lthough

D
nd the 

may not work with all applications.  
5. When exporting objects that were p usly imported (i.e., Poser figures via 

Poser import or DS integration), the re maps are exported correctly albeit at 
512x512 pixels, but the alpha maps pplied upside down. The workaround is 
to use the original textures instead  exported ones from Bryce when 
importing into another program.  

Affected versions: Mac/PC Bryce 6/6.1. 

ile Size Doubled 
Loading and immediately saving a scene y cause the file size to double. There is 
currently no workaround except to make c  to the scene first before saving.  
Affected versions: Mac/PC Bryce 6/6.1. 

Hidden Body Parts in DS A ations 
hen importing DAZ Studio animations in ce, any hidden object/body part will 
appear in Bryce. Hidden body parts for s jects do not import into Bryce.  

Affected versions: Mac/PC Bryce 6/6.1. 

Image Based Lighting 
1. HDRI illumination stops working on ert to Save."  

 
Affected version: Mac/PC Bryce 6. 
 
Fixed in: Bryce 6.1 

2. Specularity and Metallicity have no  when IBL is used as the only light 
source.  
 
Affected version: Mac/PC Bryce 6, 

3. HDRI settings cannot be keyframed
 
Affected versions: Mac/PC Bryce 6/6.1. 

4. HDRI information can be saved to t
• If you save an HDRI to a Me ot, then save the scene file, the 

Memory Dot will be cleared a  the HDRI will still be applied in the 
scene.  

• If you save an HDRI to a Memory 
Memory Dot will be cleared a

ot, then change the sky setting, the 
HDRI info will not be saved with the 

scene. 
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• If you save an HDRI to a Memory
 sav

ryce 
ky Lib
 the s

.1. 

Im  by 
io or
eeds

Br /invis

Af

Im mp M
don't loa

va

 to M
When animating keyframes in the different labs

timeline. There is no workaround at present.  

Le iles.  
, and 

L t ref
tudio 
ed in 

Th ssue.

 Dot, then select the top Memory Dot to 
switch to the default sky, and e the scene, when you reopen the file, 
Bryce will crash. 

• Affected versions: Mac/PC B 6.1. 
5. When saving an HDRI sky to the S rary, the Y-setting will change to 90 no 

matter what setting was saved with ky.  
 
Affected versions: Mac/PC Bryce 6

ported objects grouped Material 
When you import an object from DAZ Stud  Poser, the object is grouped by material 
not by body part. If a particular body part n  to be deleted so as not to show in 

yce, set the affected body part to hidden ible in Poser/DS before 
exporting/importing.  

fected versions: Mac/PC Bryce 6/6.1. 

porting objects with Bu aps 
D|S integration imports and .OBJ imports d bump maps correctly and the 

lues will need to be manually tweaked. 
Affected versions: Mac/PC Bryce 6/6.1 

Lab Keyframes not added ain Timeline 
, applying keyframes to all timelines 

does not apply the keyframes to the main 
Affected versions: All. 

Leaf Textures Not Saved 
af textures are not saved in .bto (tree) f

Affected versions: Mac/PC Bryce 5, 5.5, 6 6.1. 

ocation changes in DS no lected in Bryce 
When importing an animation from DAZ S
in

then changing the location of the objects 
 Bryce, the position changes are not sav Bryce since the animation information is 

saved in the matching .daz file. The same goes
are not carried over into Bryce. 

 for location changes in DS that are not 

ere is currently no workaround for this i   
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Af

 
W e Y-a
X tion a

L i
Sk  Dot

Fi

y usa
creas

matio
e and c

st

M
M any u
wo

rt 
rrectly. S

as the KPT3 filters provided with Bryce 3/4. 
Af , and 6.

R
es, pyra
lied. 

, 6, and

fected versions: Mac/PC Bryce 6/6.1. 

Manual Rotation on Y-axis
hen you manually rotate an object on th xis, Bryce will automatically change the 
and Z-axis values to match the new rota nd reset the Y-rotation to 0.  

Affected versions: All. 

Memory Dots not saving IB nfo 
y Memory Dots: Saving skies to Memory s not saving IBL information.  

Affected versions: Mac/PC Bryce 6.  
xed in: Bryce 6.1. 

Memory Issues 
Du
save and close the application. This can in

ring extended use of Bryce, the memor ge by Bryce is not released unless you 
e the length of time it takes to perform 

operations, render still images, render ani ns, and render over the network. It is 
recommended that before you render, sav lose Bryce, then reopen the file to 

art the render. 
Affected versions: All 

oon Brightness 
oon Brightness is currently too soft for m sers. At the moment there is no 
rkaround.  

Affected versions: All. 

Photoshop Plug-in Suppo
Photoshop plug-in support not working co ome older filters may still work, such 

fected versions: Mac/PC Bryce 5, 5.5, 6 1.  

eflection Mapping 
Reflection mapping does not work for cub mids, 2d faces, and 2d discs. For 
these primitives, only the base color is app
Affected versions: Mac/PC Bryce 4, 5, 5.5  6.1. 
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Reset Clamps option missing 
rmat, th
. 
, and 6.

that hap
w. Whe
rking

de
ame 
a.  

 will 
se en re
op  to g
th

Gradients applied to a terrain in the Terrain Edi
 Diffu
nts ca

applied to other terrains, except for the Blue an
can be saved to the library, but when you apply it 
.M into the 
the thumbnail, but when applied,  is th
is 
Af nd 6.

When exporting a terrain in MetaStream fo
from the Terrain Export Lab Options menu

e Reset Clamps option is missing 

Affected versions: Mac/PC Bryce 5, 5.5, 6 1 

Screen Refreshing 
There are some screen refreshing issues pen when other programs, dialogs, 
etc. are opened in front of the Bryce windo n Bryce is brought back to the front, a 
forced refresh is required to update the wo  window.  
Affected versions: Mac/PC Bryce 6.1. 

Spray Rendering from Ren r Mode 
While in Render Mode, returning to Wirefr mode after using the Spray Render tool 
will currently lose your spray rendered are
Affected versions: Bryce 5.5, 6, and 6.1. 

Sun/Moon Rings 
In the Sky Lab, the Secondary Ring option not stay deselected. If you disable the 

condary ring option, exit the Sky Lab, th -enter the Sky Lab, the Secondary Ring 
tion will be enabled again. The only way et rid of the secondary ring is to disable 
e Halo Rings option.  

Affected versions: Bryce 5, 5.5, 6, and 6.1.  

Terrain Gradients 
tor cannot be saved to the Materials 

Library on PCs. The gradient colors in the se channel will be replaced by the 
original diffuse color. On Macs, the gradie

AT files from a Mac can be imported 

n 
d White striped gradient. This gradient 

be saved to the Materials Library and 

to a terrain, Bryce crashes. The saved 
PC version, the gradient can be seen in 

 the gradient
applied.  

rown out and the original diffuse color 

fected versions: PC Bryce 4, 5, 5.5, 6, a 1. Mac Bryce 6 and 6.1. 
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T app
Th ker on the IBL Roller Ball disappears
will not reappear until you apply a new sky, the

gm
In ranc
hang the Tree Lab up indefinitely or produce an
Af

tio
In ers w
Af , 6, an

16-Bit Textures imported into Terrain Editor 

ain Edito

 exte
ba s do no ce 6 will 

d scen
extension in the folder where the files are 

h Br

 

ick Marker in IBL Tab dis ears 
e Tick Mar  when you move the Roller Ball and 

n re-enter the Sky Lab.  
Affected versions: Mac/PC Bryce 6.1. 

Tree Lab Branches per Se ent 
 the Tree Lab, increasing the minimum b hes per segment to more than 4 may 

 out of memory error message.  
fected versions: Mac/PC Bryce 6/6.1. 

Volumetric Object Intersec n 
tersection of two volumetric objects rend ith artifacts.  
fected versions: Mac/PC Bryce 4, 5, 5.5 d 6.1. 

Mac Only Issues 

Mac 16-bit TIF files imported into the Terr r need to be saved or converted to 
PC Byte Order.  
Affected version: Mac Bryce 6 and 6.1. 

Batch Rendering 

Mac Bryce scene files must have the .BR6 nsion (must be in all caps) in order for 
t have the extension, Brytch rendering to work correctly. If the file

render the default scene for the first queue e file, then render the remaining 
scenes correctly. You must add the .BR6 
saved, not when saving the scene file.  
Affected versions: Mac Bryce 6 and 6.1. 

Bryce 6 Scene files saved wit yce 5 extension 

B6 scene files saved with .br5 extension. 
Affected version: Mac 10.4 Bryce 6.  
Fixed in: Bryce 6.1. 

©2007 DAZ 3D, Inc.  1437 



Bryce 6 Artist Guide 

C

 about 80% while idling. On multi-processor 
M eturns

rk in Ma

Fixed in: Mac Bryce 6.1 

n 

ile resul
nsion. 

cluding
. 

P

 that M
Ap air Perm
Af

S

e "
d 6.1.  

PU Usage 

CPU usage on single processors still uses
acs after a few minutes of inaction, B6 r  to near 0%.  

Affected versions: Bryce 4, 5, 5.5, and 6. 

Gradient Color Picker 

Gradient Color picker currently doesn't wo c Bryce 6. 
Affected versions: Mac Bryce 6. 

Loading files with no extensio

Double-clicking on a Mac Bryce 6 scene f ts in Bryce loading the default scene if 
the scene file does not have the .BR6 exte
Affected version: Mac Bryce 6.  
Fixed in: Mac Bryce 6.1. 

Numeric Edit Boxes 

Numeric Edit boxes only display 6 digits in  the decimal.  
Affected versions: Bryce 5, 5.5, 6, and 6.1

ermission Issues 

Before installing B6/6.1, it's recommended ac users run Disk Utilities (in the 
plications > Utilities folder) and run Rep issions. 
fected versions: Mac Bryce 6 and 6.1. 

ave versus Save As 

The "Save" menu item works the same as th Save As..." item.  
Affected version: Mac OS10.4 Bryce 6 an
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Universal Binary Support 

Currently no Universal Binary support. B6 works u
slo

W  animat

Af dows 

ooti
ter or
solution

hows as

 have se
p on the

s 6.1.12

overed 
pa

There are two ways to access the palettes in Windows Vista. 
e palett

nder Mactel's Rosetta but with a 
wdown in performance.  

Affected versions: Mac Bryce 6 
Fixed in: Mac Bryce 6.1. 

PC Only Issues 

Windows Vista and AVI files 

hen using Windows Vista and saving an ion as an AVI file, the AVI file can only 
be played in the Windows Media Player.  

fected versions: PC Bryce 6/6.1 on Win Vi

ng 

sta only. 

Appendix D - Troublesh
List of possible problems you may encoun  questions you may have about Bryce. 

s and may not apply to your situation. 

 Bryce 6.0. How do I know I installed 

en the new splash screen plus, if you 
 mouse, press Cmd/Ctrl then let up 

.6 or later. 

by the top bar, how do I get to the 

Please note that these are only proposed 
Problem: 
I installed Bryce 6.1 but the program still s
Bryce 6.1? 
Solution: 

hen you installed BryW ce 6.1, you should
choose Help > About Bryce 6.0, don't let u
on the mouse. The version will be listed a
Problem: 
In Windows Vista, the palette names are c

lettes? 
Solution: 

1. Use the shortcut keys to bring up th es: 
• Create palette - Ctrl+1 
• Edit palette - Ctrl+2 
• Sky & Fog palette - Ctrl+3 
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2. Change compatibility mode for Bryce: 
nd choo
ble 
 them

a. Click on the Bryce 6.x icon a se Properties from the menu 
b. Click on the Compatibility ta
c. Check the boxes to "Disable es" and "Disable desktop composition" 

 

 
d. Click on OK 

 
(thanks to sgaske26 for this) 

e to 

Po
the O
ns an

Problem: 
Loading scene takes an extremely long tim open without any obvious reason or 
Bryce crashes when opening scene. 

ssible Solution:  
Check the display options to see if any of 
change to one of the default display opt

penGL options are selected. If they are, 
io d try opening the scene again. 
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Check to see if you have enough swap space a
su  need

ailable. 

hen sav

es to
characters, including period and extension. Eith

A material preset may be causing the problem. 
applied some materials, try removing the mater
th
Pr

 parts
missing

and b
 When

to each other, they may effectively "cancel" eac
ther. So
 back u

r version
her m

re
Pr

work? 
So
Use the Network Render and enable Use Tile Optimization.  

In Bryce 5.5, when I saved scene files, some of

's a m
ard co
 drop

r impl
e OS, e

vailable on your C: drive or other drives, 
fficient memory to open the scene. You  at least double the file size in memory 

av
Problem: 
Bryce crashes with an unexpected error w ing a scene. 
Possible Solution #1: 
Check the filename of any imported textur  see if any of the filenames are over 32 

er rename the texture before importing 
or rename it in the Picture Editor.  
Possible Solution #2: 

If the crash started happening after you 
ials one at a time until you find the one 

at crashes Bryce.  
oblem: 

A bunch of Bryce trees are in a scene and  of the trees are missing - OR - a 
metaball object with lots of metaballs has  areas.  
Possible Solution:  
Bryce trees are made of metaball objects ecause of this they inherited some of the 
problems the Bryce 5/5.5 metaballs have.  the meta objects are placed too close 

h other out. Try moving the trees or 
metaballs a little further apart from each o metimes it only takes a tiny amount of 
movement to get the missing parts to show p. Bryce 6 fixes this problem but trees 
and metaballs in scenes saved with earlie s of Bryce cannot inherit the Bryce 6 
fix. If using a Bryce 5 scene in Bryce 6, eit ove the trees/metaballs further apart or 

create the scene entirely in Bryce 6. 
oblem: 

How do I render a single image over a net
lution: 

Problem: 
 the textures would be lost. Why did this 

happen and has it been fixed in Bryce 6? 
Solution: 
"Yes, it's been sorted out. As you know, it emory issue. Well, the problem in 5.5 
was that there was a memory maximum h
on memory got to a certain point, it started

ded into B5.5 that once a scene's draw 
ping textures to try to conserve on its 

m
Bryce competing for memory needed by th

emory usage. This was obviously a poo ementation to solve this problem of 
tc.  
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"In Bryce 6, we've improved this as much as we
llows

pe o do t
m has
h less fr
eTalk

After I've imported an object into Bryce via the D
objec

 in DS
e the 
g DS 

I imported an object into Bryce vi  link a
ne
So
In change
between the two programs is created in the scene

. In orde
ryce.
 from DS

When I load TIF images into the Pictures Editor, t d or the 
alpha channel isn't loaded. 

No ame wa
differen
 name

erials
wi mbna

Th  have
etting

"Thumbnail Preview Options - Materials Library
ke to th

 could by implementing a 'smart' 
memory management system where B6 a  your scenes to take up a certain 

rcentage of memory before it will start t his. ... Unfortunately, depending on the 
scene and the amount of RAM your syste , you may still encounter this on 
occasion, but from our testing, this is muc equent now." 
posted by Steve Kondris on the DAZ Bryc  Forum.  
Problem: 

S link, then go back into DS to modify 
the object, when I go back into Bryce, the t goes back to its original location and 
size. Why is this happening? 
Solution: 
In order to incorporate the changes made

he new object. You can usually us
, Bryce deletes the old object so it can 
Coimport t py/Paste Matrix command to copy the 

old settings to the new object. See "Editin Objects" for more on this. 
Problem: 

a the DS
ed, the entire object was deleted. 

nd when I tried to delete a part I didn't 

lution: 
 order to allow Bryce to incorporate any s made to an object within DS, a link 

 file. This link keeps the entire object 
together so that it matches the DS version r to delete parts of the group, you'll 
need to Break the Link between DS and B  Just remember that you cannot break 
the link if the file is an animation imported . 
Problem: 

he image is either corrupte

Solution: 
t all paint programs save TIF files the s y. Try opening the image in your paint 

program and resaving the TIF file using a t compression method or 
uncompressed. Save the file under a new  just in case it doesn't work. 
Question: 
When I select a material preset in the Mat  Library, the material in the preview 

ndow looks different than the preset thu il. Why? 
Answer: 

is is because the preset thumbnail may  been added with the neutral sky 
deselected so that the current scene sky s s would affect the material. Refer to 

" for examples showing the difference 
using a neutral sky or a sky preset can ma e preview. 
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Appendix E - Links 
List of programs and sites referenced in the manu

ked by 

al or that may be useful in your 
personal art program. 
All listed programs are copyright/trademar the respective owners. 

• Programs 
• Adobe Acrobat 
• Canvas 
• Grouper 
• MeTaL Fixer 
• Paint Shop Pro 
• Photoshop 
• Poser 
• SnagIt 

• Websites 
• 3D Lapidary - site that provides 3D gemstones for use in renders 
• Robin Wood - site providing a series r and intermediate Bryce 

tutorials 

Th e in mak
 Picker i

etwork 
Lighting feature. 

mage-B
 availab

ings wo
ctions, a

 of beginne

Appendix G - Credits 
anks to the following for their assistanc ing this manual a quality resource: 
• Dan Whiteside - For the Mac Color mages and assistance with the 

Mac/PC Shortcuts and Known Issues. 
• H.R.H. Wernli - For writing up the N

of the Image-Based 
Rendering section and for clarification 

• David Brinnen - For writing up the I ased Lighting section. 
• Clay Hagebusch - For always being le for a quick instant message to 

answer my questions about how th rked on the Macintosh systems. 
• And to those who contributed corre dditions, and new content ideas: 

• Dan Whiteside 
• Barbara McMillen 
• Lise Lebel 
• Jonathan Allen Cummings 
• H.R.H Wernli 
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G
# 

terpre
translated to your 2D screen! Pretend yo

our c
per (P
jection 

fers to a
 There
 3D s
eler, a

 excha

A 
ress an
es, deg
 whi

ues o
solvin
esolu
age to

annel
ICT/B
s in th
e visib
orres
bsenc

the luminance values of any 2D PICT or 
ce, m

or sp
ual in
t obje
urce.

lossary 

2D Projection: Your 3D scene must be in ted as a 2D projection; that's how it is 
ur 3D scene is a drawing on a (2D) 

piece of paper, which is in front of y amera lens; you have control over the 
right/left up/down position of the pa an controls), and over the scale of the 
drawing (Zoom/Scale tools). 2D Pro values are an important factor in 
defining a View for your scene. 

3D Transformation:
rotation, and position of any object.

 This is a term that re ny operation relating to the size, 
 a

pace, such as deformations, sweeps, 
re in fact other types of 3D 

transformations that are possible in
and lathing; but Bryce is not a mod nd supports only the basic three: size, 
rotation, and position. 

3DMF: 3D MetaFile format from Apple for nging 3D geometry between 
applications. 

Absolute Coordinates: Values which exp  absolute location, rotation, or size, 
whether they are location coordinat rees of rotation, or units of measure. 

Additive Mode: A color blending algorithm ch adds the brightness value of colors 
other. from one item to the brightness val f an

Algorithm: A finite step-by-step problem- g procedure. 
Aliasing: A visual artifact caused by low r tion sampling that can cause hard edges 

or areas of high frequency in an im  look jagged (often referred to as 
"jaggies"). See "anti-aliasing." 

Alpha Channel: A separate grayscale ch  accompanying any PICT/BMP file that 
can determine which areas of the P
which will not. Typically, white area

MP will be visible in the final image and 
e alpha channel describe the areas in 

the corresponding image that will b le, while black areas in the alpha 
channel describe the areas in the c ponding image that will not be visible. 
Also referred to as a mask. In the a e of an alpha channel, Bryce can use 

3D solid texture as alpha information. 
Altitude: A measurement of height. In Bry any textures will change their behavior 

based on altitude. 
Ambient: Light that has no point of origin ecific direction, and is presumed to strike 

every point on every object with eq
environmental light, it tends to affec

tensity. Since it is not affected by other 
cts in shadow, and can make objects 

visible even with no specific light so  
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Amplitude: In Bryce, this refers to the intensity
 harder,
ns. 
aliasi
oth an
he wi
ight r

palette a
ically update your changes into y

B 
is; kind 
n is tilte
w you
 of sc

Bi reen i
lor, w

 w
he ter
cribe a system where there are two possible 

alse, an
 as N
 of obje
 whe

m "po
bjects
ensions
tem o
are crea

Bu  chan
ffectin
t's sur
aphic
sed int

C 

 of the cloud definition. Increasing the 
amplitude will make cloud contours  while decreasing it will result in softer 
edged, more diffuse cloud formatio

Anti-aliasing: The process of eliminating ng by higher resolution sampling, so that 
hard but jagged edges appear smo d clean. 

Aspect Ratio: The relationship between t dth and height of your document, 
expressed in pixels as a width to he atio. 

Auto-update: A feature in the Sky & Fog 
automat

nd Nano-preview which will 
our rendered scene or Nano-preview, 

respectively. 

Banking: Camera rotation around its Z ax of a left/right tilt. Also known as roll, it 
creates the illusion that your horizo d. 

Ba
scenes. Just drag and drop a group

tch Rendering: A process that will allo  to automate the rendering of multiple 
ene files on the Bryce application icon, 

and Bryce will do the rest. 
tmap: Literally, a "map of bits." Your sc s comprised of pixels, and each one of 

those pixels expresses a level of co hether it is one bit (black and white) or 
24-bit (millions of colors). Your image,
pixel-by-pixel map of color, hence t

hen rendered, can be thought of as a 
m "Bitmap". 

Boolean: A fancy word that is used to des
states: On/Off, Yes/No, 0/1, True/F d so on. With respect to Bryce 
rendering, a Boolean attribute such egative or Intersect will determine 
whether a particular part of a group cts will be Rendered/Not Rendered. 

Boolean Rendering: A rendering process rein either the space taken up by 
"negative" objects is subtracted fro sitive" objects, yielding an object with 
portions removed; or two or more o  are combined to form a composite 
object combining the mass and dim  of all contributing objects. 

Bryce Units of Measure: An arbitrary sys f measurement for 3D objects in Bryce 
3D. Most Bryce objects when they ted are a default size of 
2048x2048x2048 Bryce units. 

mp Mapping: A process that interprets ges in an object's surface luminance or 
color values and, without actually a
them as perturbations on the objec

g the object's geometry, expresses 
face. 

Button: Term used to indicate text or a gr  to be clicked on in order to access a 
palette, tool, or additional options. U erchangeably with "icon." 
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Camera: A metaphorical "tool" for viewing areas i
 a 2 d

Ca g object
lative
izing or
 than
lor st
genta
rth in

Conversion: an objec
 palet

Co of con
d the

D 
De rmat

ends, and more. Bryce 3D does not support 
can c
 Impo
te the
 to the c
able in t

e, t
both are
ssing

Di t is evenly reflected from an o
se is 
f your w

tion is 

toCa

E 
fter it

ng textur

n a scene. The metaphor refers to the 
conical projection of the scene onto imensional plane along a specific 
direction. 

mera Space: A method for representin s in 3D space. It uses a set of 
Cartesian coordinates which are re  to your camera. 

Center Scaling: The ability to perform res  rotating operations on an object 
based on the object's center, rather  an alternate point, such as its base. 

CMYK Color: A well known subtractive co andard widely used in the print industry. 
CMY color models blend Cyan, Ma , and Yellow to approximate colors for 
print; almost always used with a fou
impurities. 

 The process of changing 

k, black (K), to compensate for ink 

t of one type into an object of another 
type. Use the little arrow in the Edit te. 

nvert Boolean to Mesh: The process verting a boolean group into a mesh 
that can be exported from Bryce an n imported back into Bryce or into 
another 3D program. 

formation: A special form of 3D transfo ion which will deform an object's 
geometry, creating bulges, twists, b
this kind of transformation; but you ertainly import deformed objects from 
other modeling applications via the rt DXF and 3DMF feature in Bryce. 

Depth Cueing: The effect we use to crea  appearance that wireframes far away 
are dimmer than wireframes closer amera. This effect is adjustable. 

Derivative Objects: Most primitives avail
derivative o

he Create palette also have a few 
bjects as well. For instanc

Ellipsoid and a Squashed Sphere; 
he Sphere is accompanied by an 

 considered to be Spheres by Bryce, 
but they have had some post-proce

ffuse: Light tha
 applied to change their sizes. 
bject's surface, visible regardless of the 

angle from which it is viewed. Diffu associated with matte objects. 
Document Resolution: The actual size o

pixels. When your Render Resolu
same. 

orking document area, expressed in 
set to 1:1, the Render resolution is the 

DXF: Originally developed for use with Au d®, at one time, this was the most 
common 3D file exchange format. 

Edit: Any action performed on an object a
resizing, rotating, copying, assigni

s initial creation. Includes moving, 
es, pasting, and more. 
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F 
gning a 
ts of o
ily nam
e, structure, material, or other, can be easily 

Fi ibe the r

Fr r of tim
ea. 

G 
G o a ligh

olors, te

G  more
G  surface

t obj
s that in
s hei

ation,
 effec

H 

e, Light
e, Satu

I 

aracteri
or, Diffu

t to widt

Family: A kind of logical association, assi Family attribute to a set of objects 
allows you to select and display se bjects based on an assignable 

e. This way, objects which share wireframe color and associated fam
some characteristic such as distanc
seen, selected, soloed, and so on. 

eld of View: Field of View values descr ange, from 1 to 180°, which your 
camera is allowed to take in. 

equency: A measurement of the numbe es certain textural characteristics 
repeat themselves within a fixed ar

el: A texture or picture which is applied t t and treated as a transparency or 
slide, enabling the light to project c xtures, or images onto objects in your 
scene. 

radient: A smooth progression of two or  colors. 
radient Lights: A light object that colors s differently depending on the 

distance of the surface from the ligh ect. 
Grayscale-to-Height Mapping: A proces terprets a grayscale range from black 

to white and expresses that range a ght, from low to high. Also referred to as 
"G2H" Mapping. 

Group: Grouping, a kind of spatial associ  allows a set of objects to be treated as 
one. To achieve Boolean rendering ts, objects must be grouped. 

HDRI:  
HLS color: An alternative color model: Hu ness, and Saturation. 
HSV color: An alternative color model: Hu ration, and Value. 

Icon: See "Button." 
Illumination: In Bryce, any property or ch stic related to how an object responds 

to light. This includes Ambient, Col se, Reflectivity, Refraction, Specular, 
and Transparency. 

Image Based Lighting:  
Image Resolution: Since Bryce renders bitmaps at 72dpi, the only image resolution 

you need to determine is the heigh h ratio of your image. 
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Location: An object's position in 3D space. Syn

M 
M  input o

scale-To

M hich ref
t can als
er se, bu
lectio
red im

M extura
s effec
cts 

rials Gri
extu

 in the
e var

M  Edit 
omma
 you a
tes, h

o simp
ertai

Used in
tone ob

faces have been diagonally split, or trian

finite Plane: A two dimensional surface extends infinitely along the X and Z axes. 
Bryce 3D's Ground, Cloud, and Wa lanes are all infinite planes, though they 
exhibit different textural properties re placed in the scene at different 
altitudes. 

Landing: Dropping an object straight dow o the object directly beneath it. Usually 
used to "land" an object on the grou

Link to View: A Bryce feature which locks
This way you can use the sun con
lose that position if you move the

un's position to the camera position. 
t your sun position, and you will not 

. 
onymous with position and offset. 

apping: The process of interpreting data f one kind and expressing it as 
another. See Bump Mapping, Gray -Height Mapping, Pict Mapping, and 
Texture Mapping. 

arquee Selection: Marquee is a noun w ers to a tool, in many applications, 
o be used to refer to the selection which will create a selection area; i

itself. Bryce has no marquee tool p t you can click and drag in the 
wireframe window to marquee a se n (here the term is used as a verb), and 
you can click and drag in the rende age to marquee a selection for discrete 
rendering. 

aterial: In Bryce, the sum of up to four t l elements, either 3D procedural or 2D 
t picture-based, used to drive variou channels, plus post processing, used 

as a surface property for Bryce obje
Materials Channel: The rows in the Mate

can be driven independently or by T
d, grouped as Light, Effect, and Color; 

re Components. 
Materials Grid: The gameboard-like area  Materials Lab where Texture 

Components drive parameters in th ious Channels in the Grid to make a 
Material. 

atrix: The term is used only in the Bryce m
nds, you are copying and pasting an 

enu, for the Copy/Paste Matrix 
commands. When you use these c
object's position, rotation, and size; re not copying size, rotation, or position 
alone, but the matrix of all coordina ence the name. 

Memory Dots: This feature, available in the Cont
the Sky & Fog palette, allows you t

rol palette for use with Views, and in 
ly click on a Memory Dot to save the 

state of the parameters to which it p ns. 
Mesh: Sometimes known as polyhedron.  reference to imported geometry as 

well as Bryce's internally created S jects. Similar to Polygon, but polygonal 
gulated. 
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Metaballs: Spheres that blend into each other b
re the
that a
s and B

N 
version 

Na ject or sc

Ne
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Ne necte
ding 
ctions

Ne  mode
e am

he comp
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O 
O  objec

lative 
O imports 

st sor
ion optio
 type;
jects 
 mesh
ynon

t pass
ns of

 spac

cene
oard

 Vie
 orthogr

ased on proximity. The closer two 
Metaballs are to each other, the mo ir shape merges together. Metaballs 
can be used to create fluid shapes re otherwise time-consuming or even 

oolean operations. impossible to create using primitive

Nano-Editor: The Nano Editor is a small of your wireframe window, which you 
can use to edit your scene quickly. 

no-Preview: A small preview of an ob
the top of the Control Palette. 

twork Render Client: A computer connected to a TCP

ene. The Nano-preview window is at 

/IP network that receives and 
ds the rendered sections back to the renders sections of an image, and en

network render server. 
twork Render Server: A computer con d to a TCP/IP network that controls the 

other machines on the network, sen them sections to be rendered and 
reassembling all of the rendered se  into the final image or animation. 

twork Rendering: A special rendering  that sends sections of a render to 
multiple computers. This reduces th ount of time required to render a 
complex scene without sacrificing t lexity of the scene or the quality of 
the final rendered image or animati

bject Space: A method for representing ts in 3D space. It uses a set of 
toCartesian coordinates which are re  a given object. 

bject Type: Though Bryce creates and many kinds of objects, for the purpose 
of selections and conversions it mu t these objects into types. These types 
can be clearly seen in the Convers n and in the Edit palette. Cubes and 
their derivatives are all of the Cube  Cloud, Water, and Ground planes are 
all of the Infinite Plane type; Pict ob and 2D Faces are all of the 2D Face 
type; all imported objects are of the  type. 

Offset: An object's position in 3D space. S ymous with position and location. 
Opacity: The degree to which light canno  through an object. In Bryce, the term 

primarily refers to the opaque portio  alpha-channels. 
OpenGL:  
Orientation: An object's orientation in 3D e, expressed in degrees; synonymous 

with rotation. 
Orthogonal: A special projection of your s  which has no perspective distortion. 

Kind of a perspective-free drafting b  view, used for precise alignments. All 
Views with the exception of the Camera w are Orthogonal. The term can be 
used interchangeably with the term aphic. 
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Output Resolution: Available in the Export Rend
 image e

P 
Pa t are pe
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Plop-Render: ent

 to "plop
his featu

Po uilt from multiple-sided (in Bryce, we use 4 
 there

Pr  of lig

Pr s a cu
 such 

Pr  are t
disks

Pr are objects that require special constructions 
cedu
tion o
ns. 

R 
Ra ally in
Ra ys stri

l to the
antifie

Ra t are 
ses is
ays ar

Ray e by w
ne in 

er dialog, you can set the print 
resolution of the resulting rendered xpressed in dots per inch. 

rallel Light: A light which cast rays tha rfectly parallel to one another. 
Patch Rendering: A technique you can u yce: select a specific area, or patch, of 

your image for further rendering. U examine areas for detail before doing 
a final render, or for re-rendering sp
avoiding having to re-render your 

ct Mapping: A process that interprets 
surface of a 3-dimensional object, a

tch: Camera rotation around its X axi

reas after making a change, thereby 
age. 
nsional Pict and expresses it as the 
g to a specified algorithm. 
 tilt forward or back. 

 Name for Bryce's way of repres
rendered image. Selections appear

ing a marquee selection of your 
" forward, with attendant drop 

shadows and rendering controls. T re can be enabled, disabled, or 
hidden, as you wish. 

lygon: All 3D objects in Bryce 3D are b
sides) geometric surfaces, and are fore inherently polygonal in nature. 

imary Rays: The quantity of virtual rays ht that are initially "shot" into the Bryce 
scene. 

imitive: A basic geometric form, such a be or sphere, used as a basis for 
constructing compound 3D objects as buildings, rocket ships, or snowmen. 

imitives: Like primary colors, Primitives he primary objects in Bryce. Spheres, 
cubes, cylinders, pyramids, cones, , squares, and tori are all primitives. 

ocedural Objects: Procedural objects 
or "procedures" to create them. Pro res can include operations such as 
assignment of materials, randomiza f internal parameters, or assignment of 
light properties. For example, terrai

dial Light: A light which casts rays equ  all directions. 
y Hits: The total number of times all ra ke objects in your scene. Note: The total 

otal of Primary and Shadow rays of Ray Hits and Misses is not equa  t
d in the Render Report. because secondary rays are not qu

y Misses: The total number of rays tha fired, but strike no objects in your scene. 
Note: The total of Ray Hits and Mis  not equal to the total of Primary and 
Shadow rays because secondary r e not quantified in the Render Report. 

tracing: An image synthesis techniqu
from a virtual camera into a 3D sce

hich a virtual beam of light is projected 
order to evaluate shading and visibility. 
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Relative Coordinates: Values which express loc  
 

Re  a 2-dim  
ensiona

Re dered im
on. The  
 your D
py of y

 last 3D 
te it a bi
Multi-rep

ind of a 
n is tilte
 expre

S 
bject o

ace. 
ryce wo

he file tha
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Se  light ray
condar

nsparent/refracted) to continue through the 
 to six ti
your sce

Sh ary virtu
 not to c
location, and this is a shadow ray. 

cted, or otherwise affected to some 
degree by every object it strikes. Fo ance, if it hits your sky, then a blue sky 
color ends up on that portion of you al "film", your image. In this way, a final 
color is determined for each pixel in  image. 

Reflectivity: The degree to which an obje nces light back from its surfaces. 
Refraction: As a light wave passes from a ough another medium such as water or 

thick glass, it seems to bend or turn certain degree. This phenomenon is 
known as refraction, and the degre hich light bends or turns in these 

channel in the Materials Lab. 
ation, orientation, or size relative to the

ensional bitmapped image from all the
l wireframe scene 
age, expressed in pixels, or as a 

 implication here is that your rendered

situations is controlled by the Refra

current location, orientation or size.
nder: The complex process of building

information contained in your 3-dim
nder Resolution: The size of your ren

multiple of your Document Resoluti
image can be larger or smaller than ocument Resolution. 

Replicate: While Duplicate will create a co our selected object, Replicate will 
create a copy of the object and the transformations applied. If you create 
an object, move it up a bit and rota t, selecting Replicate will create a 
copy, move it and rotate it for you; licate will do the same with multiple 
copies in one step. 

Roll: Camera rotation around its Z axis; k left/right tilt. Also known as banking, it 
creates the illusion that your horizo d. 

Rotation: An object's rotation in 3D space,
orientation. 

ssed in degrees; synonymous with 

Sc
though Size implies an absolute sp

ale: Values that express the space an o ccupies; synonymous with Size, 

Scene: a) The complete content of your B
projection of your 3D scene; c) T
information regarding your lands

rld; b) The two-dimensional screen 
t Bryce saves, containing all 

condary Rays: When a primary virtual  strikes an object, if that object is 
reflective or transparent, another se
bounced, if reflective, or bent, if tra

y ray is fired from that location (either 

scene. This process is repeated up mes, to find a home for the ray, and 
therefore a final color for a pixel in ne. Secondary rays are not quantified 
in the Render Report. 

adow Rays: Once a primary or second al light ray has found a final resting 
place, it must determine whether or
do so, another ray is fired from that 

reate a shadow behind the object. To 
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ze: Values that express the space an ob ccupies; synonymous with Scale, 
though Scale implies a relative size

y Dome: A secondary environmental a t light, used to create a color cast in a 
scene where there is little visible gl t. 

oothing: Imported objects consist of p dral faces, which, when rendered, 
appear quite chunky. This is not, in  cases, desirable. Use the smoothing 
command to eliminate this chunkin ou can set a threshold angle for 
smoothing as well. 

ap To: A special form of 3D Transform changes the selected object's position 
based on the Snap To. command y lect. These commands are located in 
the Edit palette, in the Alignment O  menu. 

lid Texture: A three-dimensional math cal description of an object's textural 
characteristics. Often referred to as edural texture. 

ecular: The "highlight" of any object wi hiny surface; light that reflects non-
uniformly in specific directions dependi
highlight" refers to the point where 

 "Specular 
lar reflection is most pronounced. 

otlight: A light which casts rays in a co aped spread; often used top create the 
classic "Hollywood spotlight" effect.

uare Spotlight: Similar to the Spotligh sts rays in a pyramid-shaped spread; 
think of it as a slide projector. 

mmetrical Lattice: A procedural Bryce in object which has another Terrain 
mirrored at the base. 

rrain: An object used in Bryce as the b mountains, islands, plateaus, and 
other landscape objects. 

rrain Canvas: The area in the Terrain E  onto which you paint and apply effects. 
Terrain data can be rendered at ma vels of detail, from 16x16 to 4096x4096. 
This resolution does not refer to the frame that is used to represent the 
terrain, but instead to the grayscale ed to determine the internal level of 
detail used to generate the terrain. ins with lower resolutions will appear 
chunky, and will render very quickly ese for terrains that are far in the 
background or where detail is not s ortant. Terrains with higher resolutions 
will show increasing levels of detail will take much longer to render; use 
these for foreground terrains, or in ses where detail is important. 

rrain Resolution: Terrain geometry ca endered at several levels of detail. At 
very low settings, you may see geo c "facets" in your terrains, even with 
"smooth surfaces" selected. In this crease your terrain resolution. Low 
resolution rendering is often best fo s in the far background, where detail is 
not so important. 
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Texture Component: A part of an object' erial. Texture Components, which can 
either be a 2D Picture or 3D Textur

xture Mapping: A process of applying  to a surface without actually affecting 
the object's geometry. Values from xture can determine or affect any 
surface characteristic, including color, flectivity, transparency, or bumpiness. 

rus: A Bryce primitive that looks like a . 
 to transmit light through its surfaces. 

Tr
flexibility 

iangulation: The process of splitting up etric faces into triangles for greater 

ity: The state a Bryce object is in when t created, or just after the Unity button 
e" of fixed size in an invisible 3D grid, 

lus 2D Projection pan and scale 

has been pressed; positioned withi
with no rotation applied. 

View: The sum of camera position in 3D s
values 

Wireframe: A mesh representation of a 3 . 
bjects can be displayed at various 
set discreetly for static, selected, 
o relevance to document, render, 

3D space. It uses a fixed, or 
an coordinates. 

ireframe Resolution: Your onscreen w
levels of detail; this display resoluti
and moving wireframes. This resolu
output resolution. 

orld Space: A method for representing 
absolute, set of arbitrarily determin

Yaw: Camera rotation around its Y axis; k ing to look right or left. 
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3D Transformation tool ................................1224 
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3ds ...................................................................45 
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Noise..........................................................645 
Noise Palette .............................................674 
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modify ......................................................1122 
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use...........................................................1130 

Add Keyframe button ...................................1405 
d Polygons.........................................922, 924 
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Adjust Fog ......................................................863 
Ad
Adjust Triangulation .......................................922 

just Fog Density .........................................865 
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Align Z............................................................186 

gned .......................................191, 1140, 1305 
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ha channel131, 437, 441
478, 479, 480, 482, 561, 566, 568, 572, 574, 
577, 582, 585, 590, 599, 602, 607, 609, 612, 
625, 746, 750, 753, 1430, 1439 
creating......................................437, 441, 445 

Alpha channel determines .....................561, 568 
Diffusion.............................................561, 568 
ha channel increase .........................574, 577 

Alpha Channel replacement ........................1430 
ha channel use .........................................612 

Alpha Effects................................................1432 
ha Output ..................................................672 

Alpha Scaling .................................................625 
ine Valleys ................................................970 
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Altering .........................................................1007 
Filtering ....................................................1007 
Filtering Graph .........................................1007 

Alternate VCR Mode ..............................324, 325 
Although Volumetric World.............................867 
Alt

Alt

Am

 
Am  

1, 802, 928 

Am
Am

Am
Am

50, 252, 711, 833, 887 

An

An

, 1190, 1193, 1195, 1197, 1199, 1203, 

.........................................1204 

An

An

itude . 258, 262, 445, 643, 686, 737, 756, 808, 
812 

Altitude Mask..........................................441, 445 
Enable........................................................445 
select..................................................441, 445 
itude Minus Slope ......................................734 

Altitude-Slope.................................................734 
bience ..... 230, 539, 557, 558, 561, 570, 571, 
572, 597, 625, 635, 636, 802 
drive ...........................................................539 
sum ............................................................570 

Ambience Using .............................................572 
Setting........................................................572 

Ambient 241, 242, 561, 633, 671, 764, 766, 769, 
771, 773, 777, 802, 821, 822, 928 
Set..................... 764, 766, 769, 771, 773, 777
bient Color ...... 230, 557, 570, 571, 572, 635,
636, 639, 67
set ......................................................570, 571 
bient Color Swatch....................................230 
bient Color Using ......................................572 
Setting........................................................572 
bient Light .......................................886, 1206 
erica ..............................................................8 

American Plum...................................1090, 1096 
AML........................................................97, 1428 

open.............................................................97 
Amount ...... 764, 766, 771, 773, 777, 1035, 1061 

change .......................................................771 
Drag ...................................... 771, 1035, 1061 
enable ......................................................1061 

Amplitude .............. 240, 2
end.............................................................711 

Anchor ............................................................199 
Anchor-Based Aligning.. 180, 183, 186, 189, 199 
Anchor-Based Alignment ...... 180, 183, 186, 189 

gular Map...........................................872, 873 
Animatable .........................................1107, 1148 

imatable Properties..................................1107 
Animated Objects...............................1419, 1427 

Animating ..308, 309, 338, 553, 887, 1074, 1187, 
1189
1204, 1205, 1206, 1411, 1434 
Between Materials...................................1193 
Bryce .......................................................1411 
Camera......................................................338 
Clouds ............
Environmental Effects .............................1205 
keyframes................................................1434 
Lights .......................................................1074 
Material Channel Values .........................1189 
Materials ............................................308, 553 
Skies..........................................................309 
Sky...................................................887, 1203 
Sun ..........................................................1206 
Sun/Moon Position ..................................1206 
Terrain Clipping .......................................1199 
Terrain Filtering .......................................1197 
Terrain Geometry ....................................1195 
Terrains .....................................................309 
Texture ....................................................1190 
Transformations...............................308, 1187 
imating Materials .......................................553 

Animation ..16, 36, 85, 539, 886, 887, 888, 1025, 
1026, 1107, 1109, 1114, 1115, 1133, 1134, 
1135, 1137, 1140, 1180, 1203, 1204, 1205, 
1206, 1207, 1242, 1250, 1252, 1253, 1254, 
1379, 1381, 1385, 1394, 1414, 1422, 1431 
back .........................................................1385 
Current Time Indicator.............................1379 
Importing..................................................1207 
Play button...............................................1385 
right..........................................................1381 

Animation Controls16, 17, 539, 553, 1025, 1074, 
1111, 1118, 1177, 1179, 1185, 1189, 1190, 
1194, 1195, 1197, 1199, 1201, 1207 
Animation Palette ........................................16 

Animation Duration ......................................1118 
Scaling.....................................................1118 

Animation Options........................................1130 
imation Options Dialog ..................1419, 1427 
Object ............................................1419, 1427 

Animation Palette....16, 1130, 1330, 1379, 1394, 
1403, 1405 
Animation Controls ......................................16 
back .........................................................1394 
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Time First Keyframe button .....................1405 
Animation Preview .............................1128, 1430 
An

An

An 7 
An , 

An

An
An
An
An
An

An
Ap
Ap
Ap
Ap

Ap

Ap
Ap

Skies..........................................................534 

Ar

At

Au

Au

Au

 
Au .........710, 722 
Au

imation Preview Area...............................1169 
Animation Preview button ............................1190 

imation Preview Controls ...............1123, 1128 
Use...........................................................1123 

Animation Range..................... 1113, 1116, 1148 
end.................................................1113, 1116 
Setting......................................................1113 
shorten.....................................................1113 

Animation Range Handle .............................1118 
Animation Setup..... 36, 1109, 1110, 1114, 1116, 

1118, 1129, 1379, 1413, 1420, 1431 
imation Setup button................................116
imation Setup dialog .... 36, 1109, 1110, 1114
1116, 1118, 1129, 1167 
open.........................................................1167 
imations via Studio Link...........................1215 
Importing..................................................1215 
other Random Star Field............................764 
other site ....................................................451 
other Test Render....................................1411 
ti-aliased wireframes..................................286 
ti-Aliasing ... 31, 328, 392, 397, 399, 400, 421, 
428, 437, 467, 1428 
during.........................................................392 
including.....................................................428 
ti-aliasing Off..............................................467 
ple ..............................................................435 
ple Computer ...............................8, 435, 1209 
ple's Make QTVR Panorama tool ....435, 1208 
plication CD ...................................................5 
insert ..............................................................5 
plications..............................................5, 1438 
installing.........................................................5 
ply Global Phase........................................761 
ply Gradient .....................................140, 1431 
Light .........................................................1431 

Applying........ 532, 534, 535, 536, 619, 620, 899, 
1004, 1009, 1010, 1015, 1024, 1195, 1197, 
1322, 1325, 1434 
2D ......................................................619, 620 
Changes ..................................................1024 
Filter Changes .........................................1010 
Filter Presets............................................1009 

Gradient.....................................................899 
Jetstream.................................................1325 
keyframes................................................1434 
Materials ....................................................532 
Mounds....................................................1195 

Terrain Editor.............................................899 
Texture ....................................................1322 
Textures.............................................535, 536 

Architectural .............................1322, 1330, 1334 
Areas..............................................................474 

ms.............................................................1316 
Reposition tool.........................................1316 

Arrow..................................................1419, 1427 
Artizen............................................................879 
Aspect Ratio...........................................31, 1311 

change.........................................................31 
Assigning .............................................671, 1367 

Boolean Properies...................................1367 
Output Types.............................................671 
mosphere.....19, 227, 232, 234, 235, 237, 238, 
773, 841, 843, 845, 849, 852, 853, 856, 857, 
863, 865, 867, 869, 873, 888, 1205 
Change ......................................................773 

Atmosphere Off..............................................227 
changes .....................................................227 

Atmospherics .................................................873 
Attraction........................................................128 

Level ..........................................................128 
Attribute Name...................................1419, 1427 
Attributes..........................................................85 
Austrian Pine......................................1090, 1096 

to LOD .......................................................291 
Selecting....................................................291 
to Rotate ....................................................936 
stop............................................................936 

Auto Update ...........................................219, 328 
toCad® ........................................................45 

Auto-Key .308, 886, 887, 888, 1121, 1122, 1130, 
1177, 1179, 1185, 1187, 1189, 1190, 1193, 
1195, 1197, 1199, 1203, 1204, 1205, 1206, 
1379 
Choose ....................................................1121
to-Phased .................................
to-Record.......................................1121, 1136 
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use ...........................................................1121 
Au
Au ...................................................1025 
Au
Av

Av

AX

B6

Ba

Director's View.................................334, 1350 

Ba

Ba

Ba

53, 856, 857, 863, 865 

Ba

 
.................................................61 

Ble
Ble

Ble

to-Record Mode .......................................1121 
toRotate
to-Rotate ....................................................938 
ailable Time Area .....................................1113 
called........................................................1113 
erage..........................................................747 

AVI file ..........................................................1439 
+b ......................................................729, 730 

Azimuth ................................. 258, 262, 808, 812 
B 

/6.1 ...........................................................1438 
installing...................................................1438 
ck ... 5, 91, 150, 186, 328, 331, 333, 334, 335, 
341, 435, 1168, 1177, 1180, 1208, 1316, 
1348, 1350, 1363, 1385, 1388, 1394, 1399, 
1411 
Animation.................................................1385
Animation Palette.....................................1394 
Bryce........................................................1399 
Camera ............................................334, 138

 A

8 Bezier...........................................................1136 
Camera View .... 435, 1168, 1208, 1394, 1411 
Director’s View...............................1348, 1363 

Easy Install ....................................................5 
Selection Palette......................................1385 
wireframe .......................................1316, 1350 
wireframes ...................................................91 
Z-axis .........................................................150 

Back View.......................................................328 
Background ............................................873, 878 

ckground Color ................................920, 1014 
Background Contents...................................1014 

set ............................................................1014 
Background Paper .........................................276 
Background Paper button ..............................276 

ckground Textures .....................................276 
Background URL..........................................1249 
Bald Cypress......................................1090, 1096 

nded.................................................685, 1361 
Rotate tool ...............................................1361 

Banking ..................................................368, 378 
Controls .....................................................368 
Drag ...........................................................368 
value ..........................................................378 

Base Density..........542, 561, 588, 589, 590, 591 
Base Density channel ....................................590 
Base Density controls ....................................561 
Base Density set ............................................589 

100.............................................................589 
Base Density Using........................................590 

Texture ......................................................590 
Base Height ...........849, 8

Drag...................................................849, 857 
sic ....................................................575, 1072 

Basic Noise ....................................................992 
Basic Random Replication...............................77 
Basic Shading ................................................635 
Basic Tools ....................................................992 
Batch Rendering ..................................465, 1437 
Beginning .....................................................1405 
Between Materials .......................................1193 

nimating.................................................1193 
Between Sun..................................................818 

Switching ...................................................818 

like ...........................................................1136 
Bit Dithering ...................................................427 
Bitmap............................400, 431, 466, 467, 928 

Switch ................................................466, 467
Bitmap file .......
Black ..............................................................746 
Black Walnut ......................................1090, 1096 
Black/white.....................................................996 
Blend.582, 643, 743, 756, 863, 865, 1010, 1022, 

1205 
choose .....................................................1022 
Depending .................................................743 
Diffuse .......................................................643 
Filtering....................................................1010 
Filtering Graph.........................................1010 
Pictures....................................................1022 
nd Altitude.................................................751 
nd Fog...............................................863, 865 
Leave.........................................................863 

Blend Haze ............................................863, 865 
nd Maximum .....................................753, 754 

Blend Minimum ..............................................753 
Blend Modes ..........................................652, 743 

choose ...............................................652, 743 
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Blend Orientation ...........................................752 
Blend Random ...............................................753 
Blend Slope............................................751, 752 
Blend Transparency ...............................582, 632 
Blend V1.........................................................750 
Blend v2 .........................................................750 
Blob Maker ...........................................999, 1003 
Blue ............................. 575, 681, 682, 746, 1436 

except ......................................................1436 
Blue/purple .....................................................791 
Blue-ish ..................................................230, 802 
Blur .........................................................642, 991 

Sampling....................................................642 
Terrain Canvas ..........................................991 

Blur Width.......................................................879 
Enter ..........................................................879 

Blurry Reflections ...................................403, 408 
Blurry Transmissions..............................403, 409 
BMP............................. 41, 43, 50, 508, 928, 940 
BMP file ............................................................82 
BMP Sequence ..........................................55, 61 
Boolean .. 47, 48, 87, 91, 495, 1212, 1233, 1234, 

1267, 1295, 1297, 1298, 1330, 1340, 1343, 

Bo

Bo

Bo
Bo

Bo

Branch Start Angle.......................................1085 

Br 9 
Br 5 
Br 5 

9 
Br
Br
Br
Br
Br

73, 879, 887, 915, 922, 928, 934, 937, 

1344, 1348, 1350, 1364, 1367, 1388 
building ....................................................1267 
compounding ...........................................1297 
convert .........................................................87 
create.............................................1267, 1295 
creating ........................................................91 
cuts ..........................................................1364 
make ........................................................1350 
see ...........................................................1297 
shows.......................................................1267 

Boolean Attributes........................................1233 
Boolean Intersection ....................................1301 

olean Operations .....................................1297 
Boolean Properies........................................1367 

Assigning .................................................1367 
olean Roof ...............................................1350 

Boolean Subtraction.....................................1300 
Boolean Union..............................................1298 

grouping...................................................1298 
th Speed ....................................................830 
ttom....... 183, 328, 331, 333, 341, 1177, 1180 

Bottom View ...................................................328 

Boundary..........................................................77 
Enter ............................................................77 

Boundary - Enter..............................................77 
Box...............................................................1243 

x button....................................................1243 
Bracket...........................................................889 
Branch Angles..............................................1085 
Branch End Angle........................................1085 

drag .........................................................1085 

drag .........................................................1085 
Branch Texture ............................................1088 

anch Thickness ...............Br .........................1080 
Branch/Trunk .....................473, 651, 1078, 1088 
Branches............................................1082, 1083 
Branches per Segment ................................1083 
Br

DS............................................................1223 
eak..............................1222, 1223, 1258, 1439 

Link ................................................1222, 1258 
Break DAZ|Studio Link...........................94, 1222 
Br
Broadcast-quality .........................................1110 

ight Red ......................................................816 

Brush Behaviors....907, 951, 952, 955, 957, 958, 
960 
Modifying ...................................................951 
ush Control .................................................93
ush Control Tools ...............................940, 94
ush Library..................508, 939, 940, 943, 94
access .......................................................93
ush Palette .................................................508 
ush Presets Library ..............29, 508, 939, 940 
ush Tool..............................508, 940, 943, 945 
ushes..........................................508, 512, 513 
yce...1, 2, 3, 5, 7, 8, 11, 13, 17, 21, 22, 25, 29, 
31, 38, 39, 41, 43, 45, 47, 48, 55, 63, 66, 67, 
68, 71, 77, 82, 87, 94, 98, 99, 102, 103, 104, 
113, 119, 122, 131, 140, 176, 197, 199, 222, 
228, 236, 243, 269, 273, 275, 286, 288, 291, 
296, 308, 310, 312, 322, 323, 325, 329, 331, 
333, 334, 335, 337, 339, 344, 346, 376, 392, 
397, 400, 401, 413, 415, 424, 426, 427, 430, 
437, 447, 455, 459, 460, 462, 465, 467, 474, 
489, 491, 494, 495, 508, 530, 532, 548, 553, 
561, 597, 607, 609, 611, 612, 676, 692, 781, 
784, 796, 834, 835, 849, 856, 857, 867, 869, 
872, 8
939, 940, 943, 1014, 1020, 1025, 1042, 1053, 
1058, 1061, 1073, 1076, 1077, 1094, 1103, 
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1106, 1107, 1109, 1110, 1111, 1121, 1122, 
1123, 1130, 1176, 1177, 1204, 1207, 1212, 
1214, 1215, 1218, 1219, 1222, 1223, 1224, 
1237, 1241, 1249, 1267, 1285, 1286, 1294, 
1297, 1304, 1306, 1311, 1325, 1330, 1334, 
1340, 1343, 1348, 1358, 1379, 1399, 1411, 
1431, 1432, 1433, 1434, 1435, 1436, 1437, 
1438, 1439, 1443 
animating .................................................1411 
back .........................................................1399 
bunch .......................................................1439 
cause .......................................................1431 
center .........................................................873 
closing......................................68, 1215, 1223 
contains .................................................47, 48 
controls ....................................................1340 
copy .......................................................38, 55 
corner.......................................................1379 
double-clicking .............................................38 
ending ..............................................222, 1073 
filter ..........................................................1219 
hide ............................................................103 
indicates...................................................1215 
Installing.........................................................5 
Managing .......................................................7 
return........... 494, 495, 937, 1214, 1215, 1219 
Running ...................................................1432 
Saving......................................................1223 

Br

Br
Br

Br
Br
Br

Br

Br
Br

Br

Br
Br
Br
Br
Br
BS

Bunch
Bryce .......................................................1439 

set ............................................................1343 
transfer...........................................1214, 1224 
use ...........................................................1435 
version/build.................................................99 

Bryce application............................................465 
files.............................................................465 

Bryce button .......................................1214, 1215 
Return ............................................1214, 1215 

Bryce Classic .........................................970, 979 
except ........................................................979 
yce Classic fractal.......................................984 
work ...........................................................984 
yce Color Picker ...........................................28 
yce Content ....................................................5 
install..............................................................5 
yce file.......................................................1223 
yce JPEG......................................................43 
yce Lens Radius .........................................413 

Bryce Lightning ..........................................55, 63 
running.........................................................63 
yce Menu Bar ...............................................11 

Bryce Presets.................................................516 
Navigate ....................................................516 
yce Setup icon................................................5 
yce Trees..............................................77, 495 
replicating ....................................................77 

Bryce Units.........................................1306, 1428 
yce window142, 154, 155, 157, 165, 166, 175, 
176, 180, 183, 186, 189, 191, 193, 194, 196, 
199, 201, 202, 204, 206, 207, 209, 211, 212, 
214, 228, 237, 238, 241, 242, 243, 245, 248, 
250, 252, 253, 256, 257, 258, 261, 262, 265, 
266, 269, 275, 334, 405, 471, 495, 500, 504, 
534, 646, 649, 650, 651, 764, 766, 769, 771, 
777, 781, 783, 784, 788, 791, 793, 796, 801, 
802, 804, 806, 807, 808, 810, 812, 814, 815, 
816, 818, 821, 822, 823, 825, 827, 828, 829, 
830, 832, 833, 834, 835, 836, 841, 843, 845, 
849, 852, 853, 856, 857, 863, 865, 867, 869, 
873, 1326, 1330, 1350, 1385, 1436 
corner ..........................269, 1326, 1330, 1385 

Bryce Working Window...784, 1045, 1047, 1051, 
1053 
yce’s .........................................................1374 
yce’s Advanced Motion Lab .....................1406 
yce’s Auto-key..........................................1381 
yce6 Links.txt................................................98 
yster..........................................................1443 
P................................................................424 

Bto........................................................122, 1434 
BU 76, 77, 111, 112, 113, 116, 367, 1417, 1425, 

1428 
Bubble Ridges..............................................1003 
Building ......................................652, 1267, 1369 

Boolean ...................................................1267 
Grouping..................................................1369 
Textures.....................................................652 

Building’s......................................................1340 
creating....................................................1340 

Bump.....578, 599, 670, 673, 743, 745, 747, 749, 
753, 754, 928 

Bump Height ..558, 561, 578, 595, 599, 625, 673 
Bump Maps..................................................1434 
Bump Output..................................................673 

.................................................1103, 1439 
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BU 6 
Bu .................395 

Ca
Ca

Ca

Ca

era View 306, 328, 329, 331, 333, 334, 335, 

s.........................................................77, 130
tton/checkmark .........................

BVH file ........................................................1215 
C 
CAD................................................................931 
Called .... 331, 539, 755, 1033, 1110, 1113, 1114 

Available Time Area.................................1113 
Combination...............................................755 
Current Time Indicator .............................1114 
Half Angle ................................................1033 
Materials Grid ............................................539 
Orthogonal Projection................................331 
Scrubber ........................................1110, 1114 

Camera... 12, 154, 165, 175, 306, 329, 331, 333, 
334, 335, 338, 341, 346, 349, 351, 353, 356, 
358, 359, 364, 368, 372, 373, 374, 376, 378, 
380, 381, 385, 386, 389, 390, 415, 773, 814, 
835, 1180, 1182, 1184, 1185, 1312, 1378, 
1385, 1388, 1394, 1403, 1406 
access......................................................1184 
Aiming........................................................390 
Animating...................................................338 
back .................................................334, 1388 
change ...............................................381, 390 
Director ........................... 364, 368, 415, 1378 
drag............................................................368 
enter...........................................................386 
Exit ...........................................................1394 
Link Sun.....................................................814 
manipulate .................................................335 
Pointing....................................................1385 
position............................ 338, 381, 390, 1312 
repositioning ..............................................335 
represents..................................................390 
Select .............. 335, 356, 358, 359, 372, 1180 
swapping....................................................368 
unlock.........................................................359 
use .............................................................341 
Using............................................................12 

Camera Adjustments....................................1388 
Making .....................................................1388 

Camera Axes .........................................364, 368 
choose .......................................................364 

Camera Axes Control Options ...............351, 364 
Camera Axes Controls ...................................381 

Use ............................................................381 
Camera Controls.....12, 280, 331, 346, 353, 381, 

1182, 1414, 1422 
use.............................................................381 

Camera Grouping ........................................1431 
Camera icon...........................................338, 339 

mera Memory Dots............................329, 344 
mera Modes ..............................................346 

Camera Motion ............................................1176 
Camera Options menu.364, 366, 367, 415, 1378 

mera Orbits..............................................1185 
Creating ...................................................1185 
mera Origin Point ..............................385, 389 
display .......................................................385 
position ......................................................389 

Camera Perspective Toggle ..346, 349, 351, 353 
Camera Position ..........................358, 359, 1179 

Locking ......................................................358 
Unlocking...................................................359 

Camera Position Controls............................1179 
Camera Preview Positions...........................1169 

Saving......................................................1169 
Camera Space......154, 165, 170, 171, 173, 175, 

338, 1305 
Resize tool.................................................154 
Rotation tool ..............................................175 
transformations........................................1305 

era Trackball.............................12, 368, 374 Cam
Cam

337, 338, 339, 346, 349, 351, 353, 364, 368, 
376, 378, 380, 381, 386, 435, 1122, 1168, 
1177, 1179, 1182, 1208, 1356, 1378, 1385, 
1394, 1411, 1414, 1422 
back ...................435, 1168, 1208, 1394, 1411 
Change ..........................334, 381, 1177, 1179 
move..........................................................368 
position ......................................................376 
rotate .........................................................378 
show ..........................................................328 
switch...............................................338, 1385 
values ........................................................378 

Camera wireframe ....356, 357, 381, 1177, 1179, 
1185 
drag .......................................381, 1177, 1179 
Hiding ........................................................356 
Unhide .......................................................357 
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Camera/view ....................................................69 
Camera’s ... 1378, 1381, 1388, 1394, 1406, 1411 

adjust .............................................1381, 1406 
smooth .....................................................1394 
Watch.......................................................1388 

Camera’s Object Attributes dialog ...............1385 
Ca
Ca

Ca

.....................................834 
Ca

Ce

 
Ce  

6 
Ce 9 
Ce .......624 
Ce
Ch
Ch
Ch

Ch

mera’s wireframe .....................................1385 
mera's Field .......................................372, 373 
Displaying ..................................................372 
hide ............................................................373 
Hiding.........................................................373 
View ...................................................372, 373 

Camera's Trajectory................ 1180, 1381, 1394 
Displaying ................................................1180 
Setting......................................................1381 
Smoothing................................................1394 
merascene...............................................1312 

Can’t .....................................................368, 1406 
Cancel ..........................................5, 63, 493, 513 

DS..................................................................5 
Cancel icon ......................................50, 663, 928 

clicking .........................................................50 
Cannot add long Descriptions......................1431 

older Presets............................................1431 
Canvas .............................................................66 
Caps Lock ....................................................1210 
Carve............................................................1348 
Cast Shadows ................... 640, 834, 1035, 1038 

Enable...................
tegories..............................................532, 548 

Category Folder .............................................494 
Deleting......................................................494 

Cauliflower Hills..............................................970 
Cause...........................................................1431 

Bryce........................................................1431 
CD-ROM.........................................................4, 5 
Celestial................. 764, 766, 767, 769, 771, 777 

Enable............... 764, 766, 767, 769, 771, 777 
nter... 128, 153, 180, 183, 186, 325, 349, 386, 
415, 539, 873, 896, 1047, 1282, 1284, 1312, 
1316 
Bryce..........................................................873 
change .......................................................349 
Clipping Bracket.........................................896 
Gradient ...................................................1047 

Materials Lab.............................................539 
Metaball .....................................................128 
object/point ................................................415 
Resize tool.......................................153, 1316 
Selection............................................349, 386 
Selection Mode..........................................349 
Trackball ..................................................1312 
VCR Controls.............................................325 

Center Scene.................................................364 
Selecting....................................................364
nter Selection ............................................366
Selecting....................................................36
nter To Selection .......................................34
ntered Transforms..............................
nterpoints.................................................1367 
ange Gradient Transparency ..................1053 
ange Transition Point ..............................1051 
ange Your Viewpoint ...............................1371 
Scene ......................................................1371 
anges....31, 50, 113, 116, 224, 225, 227, 269, 
288, 290, 334, 346, 349, 351, 353, 381, 386, 
390, 486, 659, 662, 663, 769, 771, 773, 788, 
887, 914, 918, 946, 948, 949, 1004, 1008, 
1010, 1024, 1035, 1051, 1158, 1159, 1160, 
1177, 1179, 1237, 1238, 1267, 1316, 1344, 
1355, 1361, 1367, 1374, 1433 
3D Preview ..............................................1010 
90 1433 
Amount ......................................................771 
Applying...................................................1024 
Aspect Ratio ................................................31 
Atmosphere ...............................................773 
Atmosphere Off .........................................227 
Camera......................................................381 
Camera View.................334, 381, 1177, 1179 
Camera's ...................................................390 
Center........................................................349 
Cloud .........................................................887 
Color Blending...........................................659 
Custom Sky ...............................................225 
Darker Sky.................................................225 
Default Gray ............................................1367 
Director’s View.........................................1367 
Director's View...................................353, 381 
Disk Intensity .............................................788 
Display Mode.............................................662 
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File .............................................................914 
Filtering ....................................................1008 
Fly-around..................................................334 
Free Camera Mode....................................353 
Intensity .....................................................769 
Line Color ..................................................269 
Marker Options ..........................................269 
object’s.....................................................1344 
Offset .......................................................1237 
Origin ...............................................386, 1238 
Paintbrush..................................................946 
Paintbrush Flow .........................................948 
Paintbrush Level ........................................949 
Pan...........................................................1160 
Pen...........................................................1004 
Preset Category Folders............................486 
Previewer Display Mode............................918 
Print Resolution ...........................................50 
Selected Resolution.................................1267 
Shadow's Ambience ................................1035 
Shadows Off button ...................................288 
Shadows On button ...................................288 
Soft Sky .....................................................224 
Solo..........................................................1374 
Stars Amount .............................................771 
terrain’s ....................................................1316 
Trackball Mode ..........................................346 
Transition Point........................................1051 
Tripod Mode...............................................351 
Underground Off icon ................................290 
Underground On icon ................................290 
Undoing .....................................................663 
Wall ..........................................................1361 
Y-axis .......................................................1355 
Y-size.................................................113, 116 
Zoom In..........................................1158, 1159 
Zoom Out.................................................1159 

Channel/mask ................................................602 
Characteristics .....................................197, 1076 
Check ...................................... 1015, 1219, 1334 

Do ............................................................1219 
Nano-Preview window .............................1334 
Terrain Resolution ...................................101
oose 3D Tra
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Ch
Ch
Ch
Ch
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Ch
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Choose Objects

Color Model ...............................................676 
s ........................................................677 

nsformations ........................1224 

oose Bryce ..............................................1219 
oose Camera.............................................364 
Director ......................................................364 
oose Center Scene ...................................364 
oose Center Selection...............................366 
oose Cumulus ...........................................248 
oose Default ....................................435, 1208 
oose Director’s ........................................1334 
oose Edit ..69, 70, 71, 72, 77, 82, 1223, 1369, 
1373 
oose Eye-Level Camera............................367 
oose File.....36, 38, 39, 41, 43, 45, 47, 50, 55, 
61, 63, 65, 66, 68, 87, 428, 435, 1109, 1110, 
1114, 1116, 1118, 1129, 1208, 1311, 1312, 
1379, 1399, 1411 
oose File menu........................................1208 
oose Image................................................879 
oose None.....................................1245, 1248 

....85, 87, 91, 93, 94, 890, 1222, 
1295, 1403 

Choose Remove Shear ...............................1237 
Choose Single Frame ..................................1224 
Choosing.39, 197, 201, 223, 341, 364, 652, 676, 

677, 680, 692, 706, 715, 722, 727, 743, 897, 
908, 911, 912, 913, 914, 931, 984, 1022, 
1121, 1177, 1184, 1215, 1348, 1356, 1361, 
1364, 1385, 1394 
2D Disperse...............................................201 
Auto-Key..................................................1121 
Blend .......................................................1022 
Blend Mode .......................................652, 743 
Camera Axes.............................................364 
Color Blending Mode.........................652, 680 
Color Gradient ...........................................897 

Color
Director’s View.........................................1348 
Edit ................................................1361, 1364 
Edit Current Camera ...............................1184 
Export ................................................914, 931 
File...........................................................1215 
Filter...........................................................727 
From Top .................................................1356 
Keep Gradient ...........................................913 
Noise Mode ...............................692, 706, 715 
Noise Type ........................................692, 715 
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Orthogonal View ..............................341, 1177 
Phase Noise Mode ....................................722 
Reset Sky ..................................................223 
Save.............................................................39 
Set Preview Size........................................908 
Smooth.......................................................912 
Snap...........................................................197 
Solid ...........................................................911 
Sphere .....................................................1385 
Tile .............................................................984 
Walls ........................................................1394 
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ose File ........................................................41 
amp Maximum ............................................931 

Clamp Minimum .............................................931 
reset ............

amps ...........................................................931 
Classic Fractal................................................970 
Clay Hagebusch...................................773, 1443 
Clear.................................. 50, 70, 285, 393, 466 

use .............................................................466 
ear Texture .....................................1419, 1427 

Clicking... 50, 131, 228, 232, 234, 235, 237, 238, 
241, 242, 243, 245, 248, 250, 252, 253, 256, 
257, 258, 261, 262, 265, 266, 294, 333, 405, 
428, 532, 607, 609, 649, 650, 651, 764, 766, 
769, 771, 777, 781, 783, 784, 788, 791, 793, 
796, 801, 802, 804, 806, 807, 808, 810, 812,
814, 815, 816, 818, 821, 822, 823, 825, 827, 
828, 829, 830, 832, 833, 834, 835, 836, 841, 
843, 845, 849, 852, 853, 856, 857, 863, 865, 
867, 869, 873, 967, 979, 984, 1090, 1096, 
1136, 1214, 1215, 1218, 1316, 1330, 1355, 
1379, 1385, 1394, 1405 
Cancel icon ..................................................50 
Close icon ..........................................607, 609 
Create button .....................................650, 651 
Default button ................................1090, 1096 
Display Mode tool ......................................294 
Display Modes icon....................................294 
Fractal button.....................................979, 984 
Invert button...............................................131 
Launch DAZ|Studio button.. 1214, 1215, 1218 
Load button................................................131 
Materials Presets icon ...............................532 
Object Attributes button ...........................1355 
OK icon ....................... 428, 1316, 1330, 1394 
Play button...............................................1405 

Progress Panel ............................................50 
Return......................................................1215 
Select Views...............................
Sky....228, 232, 234, 235, 237, 238, 241, 242, 

243, 245, 248, 250, 252, 253, 256, 257, 
258, 261, 262, 265, 266, 405, 649, 764, 
766, 769, 771, 777, 781, 783, 784, 788, 
791, 793, 796, 801, 802, 804, 806, 807, 
808, 810, 812, 814, 815, 816, 818, 821, 
822, 823, 825, 827, 828, 829, 830, 832, 
833, 834, 835, 836, 841, 843, 845, 849, 
852, 853, 856, 857, 863, 865, 867, 869, 
873 

Toggle............................................1379, 1385 
Undo button...............................................967 

Client IP Address .............................................55 
enter ............................................................55 

Client List ...................................................55, 63 
Clip...........................................36, 732, 739, 893 

levels .........................................................732 
like .............................................................739 
Terrains .....................................................893 
ip aX+b .......................................................732 
ipboard..................................1012, 1419, 1427 
Copy Terrain Grayscale ................1419, 1427 

Clipping Bracket...........893, 894, 896, 911, 1199 
center.........................................................896 
Move..........................................................896 
reset...........................................................896 
ipping Controls............................................893 

Clipping Range ..............................................894 
Setting .......................................................894 

Close button.......................................................5 
select .............................................................5 

..............................................607, 609 
clicking...............................................607, 609 

Close Poser .................................................1224 
Closed Eye icon...........................................1147 
Closing ......5, 68, 495, 500, 521, 525, 545, 1214, 

1215, 1223, 1224 
Bryce .......................................68, 1215, 1223 
DS..................................................1214, 1215 
MTL file....................................................1224 

Cloud.....118, 240, 395, 829, 830, 834, 835, 887, 
1204 
Adding .......................................................240 
Animating.................................................1204 
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changing ....................................................887 
Drag ...........................................................829 
Linking........................................................835 

Cloud Altitude.........................................236, 240 
Cloud Amplitude.............................................252 
Cloud Color ............................................240, 887 
Cloud Cover ..... 19, 22, 241, 242, 243, 245, 250, 

252, 649, 821, 822, 823, 825, 827, 828, 829, 
830, 832, 833, 834, 835, 836, 887, 1176, 
1204 
Setting........................................................830 
Sky Lab......................................241, 242, 243 
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oud Coverage .............................240, 248, 830 
Cloud Direction.....................................887, 1204 
Clou
Cloud Height ..................................245, 253, 832 

Setting........................................................832 
Cloud Motion ................................827, 887, 1204 

Setting........................................................827 
oud Plane....................................................118 
Creating .....................................................118 
oud Plane tool.............................................118 
Left-click-hold.............................................118 

Cloud Shadows ......................................228, 834 
enable ................................................228, 834 

Cloud Slab......................................................118 
create.........................................................118 

oud Speed ..........................................827, 830 
reset ...........................................................830 
Setting........................................................827 

Cloud Turbulence...........................................828 
Setting........................................................828 

Clumpiness ..................................................1212 
CMY Color Picker.............................................28 
Coconut Palm.....................................1090, 1096 
Collapse .......................................................1144 

Hierarchy .................................................1144 
Collapse All Hierarchies ...............................1144 
Collapse All Timelines..................................1144 
Collapse Selection .........................................286 
Collision Detection .......................................2, 77 

lor25, 225, 236, 269, 539, 557, 580, 594, 595, 
599, 670, 671, 675, 677, 678, 732, 743, 745, 
755, 796, 863, 865, 897, 928, 1035, 1038, 
1040, 1042, 1043, 1045, 1047, 1050, 1053, 
1058 

Adding .......................................................897 
affect..........................................................743 
Choosing ...................................................677 
enable......................................................1045 
Gradient...................................................1047 
Haze ..........................................................236 
Mapping.....................................................897 
Marker Pen................................................269 
Mixing ........................................................678 
need.........................................................1050 
remov
Stratus .......................................................225 
sun/moon...................................................796 
lor Adjustments..........................................920 

Color Blending .......................................659, 756 
change.......................................................659 

Color Blending Modes ...................652, 675, 680 
choose ...............................................652, 680 

Color Channels ..............................................557 
Color Components.........................................594 
Color Gradient................................................897 

choose .......................................................897 
lor Mapping........................................889, 897
controls ......................................................88
lor Model....................................................67
Choosing ...................................................67
lor Node.........................................1047, 1050 
drag .........................................................1047 
remaining.................................................1050 
Select.......................................................1050 
lor Output...................................671, 675, 676 
component.................................................676 
lor Palettes ..................................................25 
lor Palettes Pickers .....................................25 

Co
Color Perspective button ...............................869 

lor Perspective...................................773, 869 

Color Perspective Disabled ...........................869 
Color Picker .............................................28, 675 
Color Picker button ........................................897 

Use ............................................................897 
Color Slider Picker ...........................................25 
Color Sliders ....................................................25 
Color Swatches....................................920, 1047 
Color Using ....................................................581 
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Y-axis.......................................................1136 
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nstrain Trackball ............................1414, 1422 

........................................1414, 1422 
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lor Wheel .....................................................25 
use ...............................................................25 
lor/Grayscale .....................................897, 900 
lors dialog ....................................25, 675, 678 
opens ...........................................................25 

Combination . 506, 688, 691, 711, 713, 724, 755, 
756 
called..........................................................755 
right ............................................................506 
mbination component ................755, 756, 759 
mbination Component window .652, 662, 664, 
756, 758, 759 

Combination Load button...............................131 
Combination Window .....................................652 
Combine.........................................22, 746, 1297 

Intersecting ..............................................1297 
Combined Image window...............................479 
Combined window..........................................479 

mets ...........................................................777
Enable........................................................777
mmand.....................................................1417
mmand Keys.. 1413, 1414, 1416, 1417, 1418
1419, 
mmand Keys PC......................................1420 
mmon Ash .....................................1090, 1096 

Common Holly....................................1090, 1096 
Common Juniper................................1090, 1096 
Common Lime....................................1090, 1096 
Compact/DVD ....................................................7 

mpatibility.................................................1439 
Compatible .........................................................4 
Complexity......................................................823 

Increasing ..................................................823 
Complexity. ....................................................760 

level............................................................
mponent 1, 18, 22, 88, 91, 471, 474, 536, 53
541, 542, 543, 548, 561, 566, 575, 594, 595, 
597, 600, 602, 609, 610, 611, 612, 613, 614, 
625, 645, 647, 648, 651, 652, 659, 660, 661, 
662, 663, 664, 669, 670, 671, 672, 673, 674, 
675, 676, 677, 678, 680, 681, 683, 684, 685, 
687, 688, 691, 692, 693, 705, 708, 710, 711, 
713, 724, 727, 743, 745, 746, 747, 748, 749, 
750, 751, 752, 753, 754, 755, 756, 758, 759, 
760, 761, 825, 869, 1070, 1076, 1190, 1193, 
1295 

Color Output ..............................................676 
Component Elements ....................................674 
Component Indicator ......22, 688, 691, 711, 713, 

724, 756 
Co
Component Windows.....................539, 652, 674 
Components according..................................751 
Components contribute..................................675 
Components create........................................670 
Components need..........................................760 
Components share.........................................745 

mponents vs ..............................................66

Booleans..................................................1297 
mpression....................................................43 
mpression Options dialog........................1399 
mpuServe® GIF ..........................................41 
ncludes ....................................................1334 
beginner’s ................................................1334 
ne ..............................................................110 
Creating .....................................................110 

Cone tool........................................................110 
Configure button ..............................................55 
Confirm dialog........................................493, 513 
Congratulations........................1381, 1399, 1411 
Coniferous....................................................1103 
Consequently, you’ll.......................................872 
Constrain..................................1136, 1258, 1403 

Enable .....................................................1258 
Path .........................................................1403 
X-axis.......................................................1136 

Z-axis.......................................................1136 
Constrain Proportions button ...........................31 

Enable .........................................................31 
Constrain Rotation ...........................................77 

Co
X-axis.............................................1414, 1422 
Y-axis.....
nstrain/unconstrain..................................1258 
nsult...........................................437, 441, 445 
Help file......................................437, 441, 445 

Contains...................................47, 48, 889, 1297 
Bryce .....................................................47, 48 
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Gradient Strip.............................................889 
Intersecting ..............................................1297 
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Display Text Area ......................................245 
Lens Radius...............................................413 
ntrol Thumbnails ........................................218 
Using..........................................................218 

Controls Palette........ 232, 234, 237, 1179, 1312, 
1348, 1371, 1378 
Text Display Area ......................232, 234, 237 
View Options menu..................................1348 

Convert Boolean ....... 87, 291, 1267, 1413, 1420 
Mesh ..................... 87, 291, 1267, 1413, 1420 

Convert Boolean Group .....................................2 
Mesh ..............................................................2 

Convert Boolean Icon...................................1267 
Convert Maps...............................................1219 

select........................................................1219 
Convert Selection To......................................214 
Convert Selection To tool...............................214 
Convert tool ....................................................214 
Converted Meshes ...........................................47 
Converting........................... 87, 879, 1343, 1403 

Boolean........................................................87 
HDRIs using HDRShop .............................879 
Pyramid....................................................1343 
Trajectory.................................................1403 

Coordinates menu..............................1236, 1237 
Copy.......................... 38, 55, 69, 70, 1015, 1153 

Bryce......................................................38, 55 
Key Event ................................................1153 

Copy button............................................479, 544 
Copy Material ........................ 70, 71, 1413, 1420 
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Co

Noise .........................................................756 
object’s ....................................................1340 
Phase ........................................................758 
Pictures Editor ...........................................481 
previewer ...................................................922 
Sun Position Controls................................818 
Terrain Canvas.908, 910, 911, 912, 913, 914, 

931 
Terrain Canvas Frame ..............................897 
Working window ........................296, 322, 357 
Zoom Area.................................................903 

Corresponding .............................................1127 
storyboard................................................1127 

Covering.........................................................662 
Deep Texture Editor ..................................662 

CPU .............................................392, 426, 1438 
CPU Usage ..................................................1438 
Crash ...........................................................1432 
Crayon .............................................................25 

displays........................................................25 
Crayon Picker ..................................................25 
Create 1D.......................................................710 
Create button ........104, 471, 495, 530, 650, 651, 

1316, 1330, 1334 
clicking...............................................650, 651 

Create Cube icon.........................................1356 
Create Objects .................................................82 
Create Objects Within View .............................82 
Create Palette .14, 16, 89, 471, 530, 1223, 1316, 

1330, 1334, 1340, 1356 

ntent...........................................................5, 7 
install..............................................................5 
Managing .......................................................7 
ntent CD ........................................................5 
insert ..............................................................5 
ntinue.............................................................5 
ntrast/brightness ........................................732 
show...........................................................732 

Control.. 102, 245, 306, 338, 368, 413, 873, 889, 
1340, 1432 
Banking......................................................368 
Bryce........................................................1340 
Color Mapping ...........................................889 

Co

py Matrix........................71, 1223, 1413, 1420 
Copy Terrain Grayscale.....................1419, 1427 

Clipboard .......................................1419, 1427 
Copy/Paste ................................................69, 72 
Copy/Paste Matrix..............................1223, 1439 

use...........................................................1439 
CopyLibFiles.command .....................................5 

pyright/trademarked ................................1443 
Corner ...269, 296, 322, 357, 481, 535, 756, 758, 

818, 897, 903, 908, 910, 911, 912, 913, 914, 
922, 931, 1004, 1282, 1326, 1330, 1340, 
1379, 1385 
Bryce .......................................................1379 
Bryce window ..............269, 1326, 1330, 1385 
Deep Texture Editor ..................................535 
Filter Area ................................................1004 
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Create Path ....................... 94, 1403, 1413, 1420 
Creating.... 91, 99, 102, 106, 107, 108, 109, 110, 

111, 112, 113, 116, 118, 119, 120, 123, 131, 
135, 136, 137, 138, 139, 140, 435, 437, 441, 
445, 471, 530, 541, 542, 650, 651, 692, 715, 
1014, 1026, 1067, 1068, 1105, 1185, 1208, 
1209, 1214, 1215, 1218, 1249, 1257, 1267, 
1276, 1295, 1311, 1316, 1330, 1340, 1350, 
1356, 1405, 1411, 1416, 1424 
16-bit Pictures..........................................1014 
2D Disc ......................................................111 
2D Face .....................................................112 
2D Picts......................................................131 
Alpha Channels .........................437, 441, 445 
Boolean....................................91, 1267, 1295 
building’s..................................................1340 
Camera Orbits .........................................1185 
Cloud Plane ...............................................118 
Cloud Slab .................................................118 
Cone ..........................................................110 
Cube ..........................................................108 
Cylinder......................................................107 
display................................................650, 651 
Ground Plane.............................................113 
Ground Slab...............................................113 
Group.......................................................1350 
HTML .......................................................1249 
Interior......................................................1330 
Keyframes................................................1405 
Landscapes .............................................1026 
Light Source...................................1067, 1068 
Link ..........................................................1257 
Negative Boolean ....................................1330 
New Document ........................................1311 
New Surface Material ................................541 
New Volume Material.................................542 
Noise..........................................................692 
Objects...........................................1416, 1424 
Parallel Light ..............................................139 
Phase.........................................................715 
Pict Object .................................................131 
Pyramid............................................109, 1340 
QuickTime VR Panorama........................1209 
QuickTime VR Panoramas ..............435, 1208 
Radial Light................................................135 
Round Parallel Light ..................................137 

Sphere .......................................................106 
Spotlight.....................................................136 
Square Spotlight ........................................138 
Squashed Cone.........................................110 
Squashed Cube.........................................108 
Squashed Cylinder ....................................107 
Squashed Pyramid ....................................109 
Squashed Sphere......................................106 
Stone Object..............................................123 
Stones .......................................................123 
Stretched Cone..........................................110 
Stretched Cube..........................................108 
Stretched Cylinder.....................................107 
Stretched Pyramid.....................................109 
Stretched Sphere ......................................106 
Surface Visible Light................................1067 
Symmetrical Lattices .................................120 
Terrains .....................................................119 
Torus .........................................................107 
Vaulted Roof............................................1340 
Volume Visible Light................................1068 
Volumetric World .....................................1411 
Walls........................................................1356 
Water Plane...............................................116 
Water Slab.................................................116 

Crop button ....................................................904 
Cross Ridges ...............................................1002 
Cross Ridges tool.........................................1002 
Crosshairs....................................................1406 
Cube ....................................................108, 1356 

Creating .....................................................108 
Cube - Replicated ............................................77 
Cube tool........................................................108 
Cube’s..........................................................1358 

point.........................................................1358 
Cubic Environment.........................................879 
Cumulus241, 242, 649, 821, 822, 823, 825, 827, 

828, 829, 830, 834, 835, 836 
Cumulus - Original .........................................823 
Cumulus Cloud Color.....................................248 
Cumulus Clouds...241, 243, 248, 821, 836, 1326 

Activate......................................................821 
Adding .......................................................241 
deselect ...................................................1326 

Current ...................................................36, 1114 
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Current - As......................................................36 
Current Selection ...........................500, 525, 545 
Current Time ........................... 1114, 1195, 1406 

adjusting ..................................................1195 
Setting......................................................1114 

Current Time Bar..................... 1154, 1155, 1167 
dragging...................................................1155 
move ..............................................1154, 1167 

Current Time Indicator ....... 886, 887, 888, 1025, 
1109, 1110, 1113, 1114, 1115, 1116, 1118, 
1122, 1177, 1179, 1189, 1190, 1195, 1197, 
1199, 1201, 1203, 1205, 1206, 1379 
Animation.................................................1379 
called........................................................1114 
Drag ...............................................1113, 1114 
leave ........................................................1122 
Move 886, 887, 888, 1113, 1114, 1115, 1122, 

1177, 1179, 1189, 1190, 1195, 1197, 
1199, 1203, 1205, 1206 

Current View ..........................................328, 334 
Currently, Bryce .....................................873, 879 
Currently, Mac Bryce......................................465 
Curve................... 1158, 1159, 1160, 1162, 1163 

Panning....................................................1160 
Curve Editor View ........................................1161 

Resetting..................................................1161 
Curves dialog .................................................441 
Custom DPI......................................................65 

set ................................................................65 
Custom Field ..................................766, 769, 771 

Enable........................................................766 
Custom Sky............................................225, 226 

changes .....................................................225 
Customer Service...............................................8 
Customer-service ...............................................8 
Customizing ...................................................767 

Star Fields..................................................767 
Cuts ....................................... 69, 70, 1364, 1432 

Boolean....................................................1364 
Trees crashes Bryce................................1432 

Cylinder ..........................................................107 
Creating .....................................................107 

Cylinder tool ...................................................107 
Cylindrical.......................................................618 
CYMK...............................................................25 

D 
D|S ...............................................................1434 
Dampen .........................................................996 
Darker Sky .............................................225, 226 

changes .....................................................225 
Date Palm ..........................................1090, 1096 
Day.................................................................265 
Day/Night ...............................258, 262, 265, 812 
Day/Night Toggle ...................................261, 810 
Day/Night Toggle button ................................818 
Daytime........................................................1325 
DAZ................................................................7, 8 

functions ........................................................8 
Registering ....................................................8 

DAZ 3D ..............................................................8 
DAZ Arcana Tutorials ......................................98 
DAZ BryceTalk Forum .................................1439 

Steve Kondris ..........................................1439 
DAZ Customer Service ......................................8 
DAZ Customer Service representatives ............8 
Daz file .........................................94, 1215, 1434 
DAZ Productions..........................................1443 
DAZ Products.....................................................8 

Registering ....................................................8 
DAZ Support ......................................................8 
DAZ|Studio....2, 5, 71, 94, 140, 157, 1207, 1428, 

1430, 1433, 1434 
importing..................................................1433 

DAZ3D.com .....................................................98 
links .............................................................98 

Ddf ...................................................................45 
Debevec website............................................879 
Decal Colors ..................................................625 
Declination .....................................................767 

0° 767 
Decreased Complexity...................................823 
Decreases......................................................946 

Paintbrush .................................................946 
Deep Sky .......................................................767 
Deep Texture Editor..29, 89, 506, 535, 541, 542, 

561, 597, 600, 645, 646, 647, 648, 649, 650, 
651, 652, 659, 662, 663, 671, 672, 673, 674, 
676, 677, 678, 680, 688, 691, 692, 693, 701, 
703, 705, 706, 711, 713, 715, 716, 718, 720, 
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722, 724, 727, 743, 823, 825, 1190, 1414, 
1419, 1422, 1427, 1428 
access. 89, 506, 646, 647, 648, 649, 650, 651 
corner.........................................................535 
covering .....................................................662 
Display ..... 652, 671, 672, 673, 674, 676, 677, 

678, 680, 688, 691, 692, 693, 701, 703, 
705, 706, 711, 713, 715, 716, 718, 720, 
722, 724, 727, 743 

enter...........................................................600 
open.....................................................89, 561 
right ............................................................662 
selected .....................................................649 

Default ......... 77, 82, 399, 435, 1208, 1311, 1361 
Reset............................................................82 
select..........................................................399 

Default Brush .................................................945 
Reverting ...................................................945 
Select .........................................................945 

Default button.....................................1090, 1096 
clicking ...........................................1090, 1096 

Default Display Modes ...................................294 
Default Family ..............................................1350 
Default Gray .................................................1367 

changes ...................................................1367 
Default Mixed .................................................294 
Default Random Star Field.............................764 
Default Rendered ...................................273, 294 

select..........................................................273 
Default State ....................................................82 

Launch .........................................................82 
Default Terrain ...............................................924 
Default Wireframe ..........................272, 294, 296 

Select .................................................272, 296 
Default.br6........................................................82 
Defining ........................................................1061 

Range ......................................................1061 
Definition ......................................................1237 
Definition Coordinates..................................1307 
Definition transformations ............................1307 
Defocused ......................................................872 
Delete All ........................................................480 
Delete All Animation Frames..............1414, 1422 
Delete button..........................................480, 513 
Delete Colors ...............................................1050 

Delete Key Frame..............................1121, 1123 
modify ......................................................1123 

Delete Key Frame button.............................1123 
Delete Original ...............................................517 
Delete Saved Camera Views.............1414, 1422 
Delete Transparency Node..........................1057 
Deleting.........480, 493, 494, 495, 513, 517, 609, 

1050, 1057, 1123, 1152, 1163, 1432 
Category Folder.........................................494 
Key Event ................................................1152 
Key Frames .............................................1123 
Leo...........................................................1432 
Pictures......................................................480 
Point ........................................................1163 
Presets ......................................................513 
Sub-Category File .....................................495 

Dem .........................................................45, 915 
forms............................................................45 

Demo ...........................................................1378 
Demo Marker ...............................................1378 
Demo Marker icon........................................1378 
Density ..636, 841, 843, 845, 852, 853, 856, 857, 

867 
Drag...........................................843, 853, 867 

Density/amount ..............................................232 
set..............................................................232 

Depending......................................................743 
Blend .........................................................743 

Depth ...........................403, 413, 415, 419, 1428 
Field.................................403, 413, 415, 1428 
Field Examples..........................................419 

Depth Cue......................................................286 
left-click-hold..............................................286 

Depth Cue icon ..............................................286 
Depth Cueing On ...............................1414, 1422 
Desaturated ...........................................479, 575 
Description .....................................495, 500, 504 
Deselect ..61, 82, 269, 322, 328, 910, 928, 1275, 

1326, 1350, 1364, 1369, 1374, 1416, 1424 
Cumulus Clouds ......................................1326 
dot..............................................................928 
Marker Pen tool .........................................269 
objects .....................................................1374 

Deselect All ..................................82, 1275, 1373 
Deselect Alternate VCR Mode...............322, 323 
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Deselect Auto Rotate .....................................936 
Deselect Auto-Key .......................................1381 
Deselect Constrain Rotation ............................77 

Y-axis ...........................................................77 
Deselect Display Hierarchy..........................1144 
Deselect Random Character..........................979 
Deselect Random Extent ...............................979 
Deselect Random Position.............................979 
Deselect Storyboard.....................................1126 
Deselect Tile North.........................................984 
Deselected ... 319, 322, 328, 495, 500, 521, 525, 

532, 545, 928, 984, 1224, 1275, 1334, 1436, 
1439 

Deselecting ......................................82, 873, 979 
Gamma Correction ....................................873 

Deselections...................................................310 
Deselects..........................................................82 
Desert Rock .......................................1322, 1330 
Desireable ....................................................1237 
Desktop ..............................................................5 
Destination Directory..........................................5 
Destination Image ..........................................879 
Detail ....................................................291, 1428 

Level ................................................291, 1428 
Device Independent Bitmap.............................41 
Dfx ....................................................................45 
Dialogs ...............................................1419, 1427 
DIB ...................................................41, 508, 940 
Difference.......................................709, 730, 755 

like..............................................................730 
Diffuse .. 561, 599, 613, 633, 643, 671, 672, 899, 

900, 1436 
blends ........................................................643 
drive ...........................................................671 

Diffuse Channel..............................................899 
Diffuse Color 557, 558, 561, 567, 568, 577, 580, 

585, 595, 599, 611, 633, 635, 636, 643, 671 
set ......................................................567, 595 

Diffuse, Ambient.............................................594 
Diffusion 557, 558, 561, 566, 567, 568, 570, 579, 

597, 625, 635, 636, 928 
alpha channel determines .................561, 568 
set ......................................................561, 568 

Diffusion Color................................................928 
Diffusion Using ...............................................568 

Setting .......................................................568 
Diffusion, Ambience...............................557, 558 
Dimension ......................692, 701, 703, 705, 720 
Direct 3D ..........................................................45 
Direction.........................................701, 718, 829 

Setting .......................................................829 
Director’s View......368, 1312, 1348, 1356, 1363, 

1367, 1378, 1394 
back ...............................................1348, 1363 
Change ....................................................1367 
choosing ..................................................1348 
position ......................................................368 
produces....................................................368 
swap ..........................................................368 
Switch ......................................................1394 

Director's .39, 331, 334, 364, 368, 386, 415, 873, 
1179, 1378 
Camera............................364, 368, 415, 1378 
Choose Camera ........................................364 
Swapping...................................................368 

Director's Camera ..................................386, 415 
Origin .........................................................386 

Director's Chair icon.......................................338 
Director's View ......306, 328, 333, 334, 335, 337, 

338, 339, 346, 349, 351, 353, 356, 358, 359, 
372, 373, 376, 378, 380, 381, 385, 386, 390, 
1122, 1168, 1179, 1183, 1184, 1185, 1278, 
1282, 1350, 1414, 1422 
back .................................................334, 1350 
Change ..............................................353, 381 
generates...................................................339 
position ......................................................376 
power.........................................................339 
render ........................................................339 
rotate .........................................................378 
show ..........................................................328 
switch.......339, 356, 358, 359, 372, 373, 1185 
values ........................................................378 

Disable ........285, 359, 373, 793, 815, 873, 1242, 
1436, 1439 
Halo Rings ...............................................1436 
Locked .......................................................359 
Locked button..........................................1242 
Plop-Render ..............................................285 
Render HDRI Image..................................873 
Show FOV .................................................373 
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Sun/Moon Size ..........................................793 
Sunlight......................................................815 
Use HDRI Image........................................873 

Disable Blend Haze........................................865 
Disable Sun Light ...........................................873 
Disable Sun Light button................................815 
Disc ................................................................111 
Disc tool..........................................................111 
Disk ..........................................................50, 633 

Render .........................................................50 
Disk dialog......................................50, 435, 1208 

Render .......................................50, 435, 1208 
Disk Intensity..........................................788, 791 

changes .....................................................788 
Drag ...........................................................788 

Disk Size ................................................784, 793 
set ..............................................................784 

Disk Space .....................................................516 
Recovering.................................................516 

Disk Utilities..................................................1438 
Displaced Max........................................710, 722 
Display...... 16, 25, 102, 228, 232, 234, 235, 237, 

238, 241, 242, 243, 245, 248, 250, 252, 253, 
256, 257, 258, 261, 262, 265, 266, 280, 296, 
357, 372, 385, 405, 431, 435, 602, 649, 650, 
651, 652, 671, 672, 673, 674, 676, 677, 678, 
680, 688, 691, 692, 693, 701, 703, 705, 706, 
711, 713, 715, 716, 718, 720, 722, 724, 727, 
743, 756, 758, 764, 766, 769, 771, 777, 781, 
783, 784, 788, 791, 793, 796, 801, 802, 804, 
806, 807, 808, 810, 812, 814, 815, 816, 818, 
821, 822, 823, 825, 827, 828, 829, 830, 832, 
833, 834, 835, 836, 841, 843, 845, 849, 852, 
853, 856, 857, 863, 865, 867, 869, 873, 888, 
889, 1130, 1176, 1180, 1204, 1205, 1210, 
1233, 1238, 1240, 1241, 1242, 1243, 1244, 
1245, 1248, 1249, 1250, 1252, 1253, 1254, 
1258, 1263, 1316, 1326, 1328, 1330, 1378, 
1432 
2D ..............................................................435 
Camera's Field...........................................372 
Camera's Origin Point................................385 
Camera's Trajectory ................................1180 
Crayon .........................................................25 
Create ................................................650, 651 
Deep Texture Editor. 652, 671, 672, 673, 674, 

676, 677, 678, 680, 688, 691, 692, 693, 
701, 703, 705, 706, 711, 713, 715, 716, 
718, 720, 722, 724, 727, 743 

Document Setup dialog .............................431 
Edit ..........................................................1316 
Filtering..............................................724, 727 
Filtering Palette..........................................652 
grayscale ...................................................889 
Materials Lab...........................................1263 
Nano-Edit button .......................................280 
Noise .........................................................688 
Noise Editor ......652, 691, 692, 693, 701, 703, 

705, 706, 722, 756 
Noise Palette .............................................652 
Object Attributes dialog ......1233, 1238, 1240, 

1241, 1242, 1243, 1244, 1245, 1248, 
1249, 1250, 1252, 1253, 1254, 1258, 
1328, 1330 

Phase ........................................................711 
Phase Editor .....652, 713, 715, 716, 718, 720, 

722, 758 
Phase Palette ............................................652 
Pictures Editor ...........................................602 
Selection....................................................357 
Selection Palette .....................................1330 
Sky....228, 232, 234, 235, 237, 238, 241, 242, 

243, 245, 248, 250, 252, 253, 256, 257, 
258, 261, 262, 265, 266, 405, 649, 764, 
766, 769, 771, 777, 781, 783, 784, 788, 
791, 793, 796, 801, 802, 804, 806, 807, 
808, 810, 812, 814, 815, 816, 818, 821, 
822, 823, 825, 827, 828, 829, 830, 832, 
833, 834, 835, 836, 841, 843, 845, 849, 
852, 853, 856, 857, 863, 865, 867, 869, 
873, 1176, 1204, 1205, 1326 

Sky Lab dialog...........................................888 
Spectrum .....................................................25 
submenu......................................................16 
Submenus ...................................................16 
three-dimensional......................................889 
Timeline Options menu ...........................1130 
Torus .......................................................1210 
wireframes.................................................296 

Display - Select ................................................36 
Display Clipping Bracket button...................1199 
Display Mode tool ..........272, 273, 294, 296, 467 

clicking.......................................................294 
Display Modes ...................................11, 36, 662 

change.......................................................662 
Display Modes button ........................1316, 1322 
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Display Modes icon ........................................294 
clicking .......................................................294 

Display Origin Point........................................385 
Display Property Timelines ..........................1143 
Display Quality Attributes .............................1242 
Display Text Area...........................................245 

Control .......................................................245 
Display/hide..................................................1432 
Displaying Objects .......................................1147 
Distance .........................................................643 
Distance Blur..................................................641 
Distance Mask........................................441, 445 

Enable........................................................441 
use .............................................................441 

Distance Mask Render...................................441 
Distance Origin.......................................693, 716 
Distance Render ............................................441 

Select .........................................................441 
Distance Squared...................................693, 716 
Document.....................................................1208 
Document Aspect Ratio ...................................31 
Document Presets............................................35 
Document Resolution.................................31, 35 
Document Setup 428, 431, 435, 463, 464, 1208, 

1399, 1411, 1413, 1420 
Document Setup dialog........ 31, 431, 435, 1208, 

1311, 1411 
Display .......................................................431 

DOF......................................................413, 1428 
focus ..........................................................413 

Dogwaffle .......................................................609 
Dot..................................................................928 

deselect .....................................................928 
Double ................................................1418, 1426 
Double-clicking.............................38, 1184, 1438 

Bryce............................................................38 
Mac Bryce................................................1438 
Trackball ..................................................1184 

Douglas Fir .........................................1090, 1096 
Down ......................................... 197, 1294, 1374 
Down Arrow........................................1419, 1427 
Dpi ..................................................50, 61, 65, 66 

accommodate ..............................................65 
set ..............................................50, 61, 65, 66 

Drawing ........................................................1010 

grayscale .................................................1010 
Drive.......................................................539, 671 

Ambience...................................................539 
Diffuse .......................................................671 

Drop ...............................................................659 
DS ...5, 48, 71, 94, 140, 1207, 1214, 1215, 1218, 

1219, 1222, 1223, 1428, 1432, 1434, 1439 
break........................................................1223 
cancel ............................................................5 
closing ...........................................1214, 1215 
exiting ..............................................140, 1223 
launching .................................................1223 
link ...........................................................1223 
matches ...................................................1439 
returning ..................................................1223 

DS Animations .............................................1433 
DS file ..........................................................1222 

affecting ...................................................1222 
DTE........................89, 535, 645, 659, 825, 1428 

Quick Tour .................................................645 
Duplicate ..............72, 76, 128, 1343, 1361, 1364 

90 76 
Metaball .....................................................128 
Walls........................................................1361 

Duration ...................36, 1109, 1118, 1379, 1431 
switches...................................................1109 

Duration - Shows .............................................36 
During ....................................................392, 873 

anti-aliasing ...............................................392 
IBL .............................................................873 

Dxf....................................................2, 424, 1212 
importing........................................................2 

E 
Earth Map ......................................................684 
Earth-Based Star Field ..........................766, 767 
Earth's ............................766, 767, 769, 791, 869 

see.............................................................767 
Earthshine......................................................781 

Drag...........................................................781 
East................................................................984 
Eastwest ........................................................687 
Easy Install.........................................................5 

back ...............................................................5 
Edge.....................................................903, 1118 
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timeline.....................................................1118 
Zoom Area .................................................903 

Edge Softness 17, 561, 588, 590, 637, 781, 783, 
833, 1031, 1074 

Edge Softness controls ..................................590 
Edge Softness set ..........................................637 

100.............................................................637 
Edit . 16, 55, 69, 70, 71, 81, 82, 94, 99, 102, 142, 

154, 155, 157, 165, 166, 175, 176, 180, 183, 
186, 189, 191, 193, 194, 196, 197, 199, 201, 
202, 204, 206, 207, 209, 211, 212, 214, 532, 
548, 646, 649, 873, 890, 893, 937, 955, 1070, 
1074, 1076, 1104, 1136, 1148, 1155, 1185, 
1223, 1224, 1237, 1274, 1275, 1316, 1322, 
1330, 1334, 1340, 1343, 1361, 1364 
3D Preview ................................................937 
choosing ........................................1361, 1364 
display......................................................1316 
figure/object .............................................1223 
Motion Paths............................................1136 
Objects Imported via Studio Link.............1223 
Surface.....................................................1070 
Symmetrical Lattice ...................................893 
Time Mapping Curves..............................1155 
timeline...............................................16, 1148 
Transformation Attributes ........................1237 
Trees........................................................1076 
Visible Light Materials..............................1070 
Volume.....................................................1070 

Edit 2D Pict Textures .....................................142 
Edit 2D Pictures .................. 89, 470, 1413, 1420 
Edit 3D Solid Textures ...........................142, 646 
Edit 3d Textures .................. 89, 649, 1413, 1420 
Edit Attributes.......................... 1298, 1300, 1301 
Edit button .... 142, 154, 155, 157, 165, 166, 175, 

176, 180, 183, 186, 189, 191, 193, 194, 196, 
199, 201, 202, 204, 206, 207, 209, 211, 212, 
214, 473, 500, 646, 651, 784, 823, 825, 890, 
1043, 1045, 1053, 1088, 1104, 1330, 1334, 
1361, 1399 

Edit Current Camera ............................364, 1184 
choosing ..................................................1184 

Edit Gradient Dialog ...... 1043, 1045, 1051, 1053 
Edit Material ........................ 88, 142, 1413, 1420 
Edit Material tool ........... 142, 214, 500, 548, 646 

use .............................................................142 
Edit Menu .........................................................11 

Edit Mesh .................85, 1414, 1419, 1422, 1427 
Edit Mesh dialog ....48, 85, 123, 214, 1212, 1264 

opens.........................................................214 
Edit Object .................85, 890, 1075, 1413, 1420 
Edit Object Icon............................................1264 
Edit Palette......14, 85, 89, 500, 646, 1224, 1316, 

1330, 1334, 1340, 1343, 1344, 1361 
right..........................................................1343 

Edit Rendering ...............................................437 
Edit Terrain tool..............................................890 
Edit Terrain/Object .........................................214 
Edit Terrain/Object tool ..................................214 

use.............................................................214 
Edit Torus.....................................85, 1414, 1422 
Edit Torus dialog..................................214, 1264 
Editing Motion Paths....................................1180 
Editing Tools ......................................1015, 1316 
Editing Tools dialog .......................................650 
Editor button.................................................1316 
Editor Settings..................................................22 

Adjusting......................................................22 
Editors..........................................................1125 
Effect Anti-Aliasing.........................................403 
Effect Art AA ..................................................403 
Elev ..................................................................45 
Elevation .......650, 951, 952, 955, 964, 965, 967, 

969, 998, 1012, 1025, 1026, 1195 
Painting......................................................952 

Email ..................................................................8 
E-mail ...........................................................1249 
Emboss ........................................................1000 

grayscale .................................................1000 
EMF .................................................41, 508, 940 
Enable.....31, 228, 356, 358, 372, 385, 405, 437, 

441, 445, 457, 764, 766, 767, 769, 771, 777, 
781, 783, 784, 788, 791, 793, 796, 801, 834, 
835, 836, 841, 843, 845, 849, 852, 853, 856, 
857, 863, 865, 867, 873, 1045, 1061, 1067, 
1068, 1129, 1133, 1134, 1135, 1180, 1242, 
1243, 1244, 1245, 1258, 1298, 1300, 1301, 
1328, 1348 
Altitude Mask.............................................445 
Amount ....................................................1061 
Cast Shadows ...........................................834 
Celestial.............764, 766, 767, 769, 771, 777 
Cloud Shadows .................................228, 834 
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Color ........................................................1045 
Comets.......................................................777 
Constrain .................................................1258 
Constrain Proportions button.......................31 
Custom Field..............................................766 
Distance Mask ...........................................441 
Fixed Cloud Plane .....................................835 
Fog.................... 841, 843, 845, 849, 863, 865 
Gradient ...................................................1061 
Halo Rings .................................................796 
Haze.......................... 852, 853, 856, 857, 863 
Hidden button ..........................................1242 
Infinite ......................................................1068 
Infinite Light .............................................1067 
Intersecting checkbox....................1298, 1301 
Invisible......................................................356 
Locked .......................................................358 
Locked button ..........................................1242 
Maximum Ray Depth .................................457 
Moon Phase...............................781, 783, 784 
Negative...................................................1348 
Negative checkbox ..................................1300 
Object Mask...............................................437 
Play ..........................................................1129 
Positive ....................................................1328 
Propagate ................................................1245 
Random .............................................769, 771 
Random Field ....................................764, 777 
Secondary Ring .........................................796 
Shadows ....................................................457 
Show..............................................1133, 1243 
Show Always ...........................................1135 
Show FOV .................................................372 
Show Only ...............................................1134 
Show Origin Handle...................................385 
Show Origin Handle button......................1244 
Show When Selected ..............................1180 
Soft Shadows.....................................405, 801 
Spherical Clouds........................................836 
Star ........................... 764, 766, 769, 771, 777 
Sun/Moon Shadows...........................405, 801 
Sun/Moon Size ..........................................793 
Sun/Moon Visible.............. 788, 791, 793, 796 
Texture.......................................................784 

Use HDRI Image .......................................873 
Visible Object.................................1067, 1068 
Volumetric World .......................................867 

Enable Image...................................................82 
Enable Report Render Time ............................31 
Enable Shadows....................................449, 454 
Enable/disable Anchor-Based Aligning .........199 
Enabling/disabling............................................15 

Nano-Preview..............................................15 
End....55, 61, 170, 171, 173, 222, 334, 463, 688, 

711, 1073, 1113, 1116, 1203, 1379, 1405, 
1406, 1414, 1422 
Amplitude...................................................711 
Animation Range...........................1113, 1116 
Bryce ...............................................222, 1073 
Fly-around .................................................334 
Move..............................................1414, 1422 
Noise Frequency .......................................688 
Path .........................................................1405 
Render Options menu ...............................463 
Timeline ...............................1203, 1379, 1406 
X-axis.........................................................170 
Y-axis.........................................................171 
Z-axis.........................................................173 

Enhanced Metafile ...........................................41 
Enlarge...........................................................903 

Zoom Area.................................................903 
Enter .55, 77, 119, 325, 386, 413, 415, 508, 544, 

545, 600, 602, 879, 915, 940, 943, 979, 984, 
1015, 1020, 1061, 1168, 1238, 1249 
Advanced Motion Lab..............................1168 
Blur Width ..................................................879 
Boundary .....................................................77 
Camera......................................................386 
Client IP Address.........................................55 
Deep Texture Editor ..................................600 
Light Lab..................................................1061 
Materials Lab.....................544, 545, 600, 602 
Object Attributes dialog ...........................1238 
Render Options dialog.......................413, 415 
Solo Mode .................................................325 
Terrain Editor....119, 508, 915, 940, 943, 979, 

984, 1015, 1020 
URL .........................................................1249 

Enter key..........................................................22 
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Press............................................................22 
Enter Position...............................................1312 
Entire Duration ...........................................55, 61 
Environmental Effects ..........................888, 1205 

Animating.................................................1205 
Equalize..........................................................997 
Erlik ..............................................................1443 
Erode Terrains ...............................................958 
Erode tool ...............................................967, 988 

use .............................................................967 
Eroded............................................967, 988, 991 
Eroded button...................... 967, 988, 991, 1316 
ErodeTerrain ......................................1419, 1427 
Erosion ...................................................309, 958 
Es 90, 315 
Esc key...............................................1127, 1350 

Press..............................................1127, 1350 
Escape key...................................272, 273, 1316 

hit 1316 
press ..................................................272, 273 

Escher ............................................................922 
Every ............................................................1379 
Example - Cone .................................1172, 1174 
Except ..........................................222, 979, 1436 

Blue..........................................................1436 
Bryce Classic .............................................979 
IBL..............................................................222 

Existing...................................................964, 999 
Terrain Canvas ..................................964, 999 

Existing Scene .............................................1373 
Merging....................................................1373 

Exit . 140, 873, 899, 979, 984, 1201, 1223, 1316, 
1394, 1436 
Camera ....................................................1394 
DS....................................................140, 1223 
Materials Lab .............................................899 
Sky Lab............................................873, 1436 
Terrain Editor ........ 899, 979, 984, 1201, 1316 

Exit DS ...............................................1219, 1223 
Expand All Hierarchies.................................1144 
Expand All Timelines..........................1143, 1148 
Expand/collapse.....................................25, 1144 

Hierarchy List...........................................1144 
Explains..................................................631, 634 

Surface Material Shading Modes ..............631 

Volume Material Shading ..........................634 
Export button..................................................489 
Export dialog ................................................1219 
Export Image..........................45, 435, 934, 1209 
Export Object .....................47, 48, 87, 915, 1267 
Export Options dialog ..................................1224 
Export Range dialog ....................................1224 
Export Rocks/Imported Meshes.........1419, 1427 
Export Terrain dialog .......................................47 
Export Terrain Lab .........914, 915, 916, 922, 928 

Features ....................................................916 
Exporting.....489, 516, 517, 914, 915, 931, 1020, 

1209, 1219, 1224, 1432 
8-bit..........................................................1020 
Choose ..............................................914, 931 
MetaStream...............................................931 
Objects ....................................................1432 
QuickTime VR Panoramas......................1209 
Terrain .......................................................914 

Exporting Terrains............................................47 
Exporting/importing......................................1434 
Extension ...........................................1437, 1438 
Eye icon .......................................................1147 
Eye Level Camera .........................................351 
Eye-Level Camera .........................................367 

Selecting....................................................367 
F 
Falloff ...........................................................1061 
Falloff - Determines........................................873 
Falloff - Linear ..............................................1061 
Falloff - None ...............................................1061 
Falloff - Ranged ...........................................1061 
Falloff - Squared ..........................................1061 
Families Icon................................................1254 
Families list ..................................................1394 
Families tool...................................................312 
Family ..............................312, 1254, 1361, 1394 
Family button ...........................1350, 1361, 1367 

Object Control Palette .............................1367 
Family dialog..................1254, 1350, 1356, 1367 

access .....................................................1356 
FAQs..................................................................8 
Fast Preview ........................328, 394, 424, 1027 
Fast Preview button .......................................394 
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Fast Preview Mode ........................................394 
Fast Render ...................................................467 
Fast Render w/Textures Off ...........................467 
Fast Slope ......................................................752 
Fast, Textures Off ..........................................467 
Features .........................................................916 

Export Terrain Lab .....................................916 
Field..................... 367, 380, 403, 413, 415, 1428 

Depth .............................. 403, 413, 415, 1428 
set ..............................................................380 
View .........................................367, 380, 1428 

Field Examples...............................................419 
Depth .........................................................419 

Figure/animation ..........................................1223 
modify ......................................................1223 

Figure/object ................................................1223 
editing ......................................................1223 

File Manager ........................................879, 1267 
File menu....................................................11, 67 
File Open dialog ........................ 122, 1219, 1224 
Filename...........................................................45 
Files.. 38, 39, 41, 45, 47, 48, 50, 55, 63, 82, 431, 

435, 464, 465, 879, 914, 915, 1014, 1215, 
1219, 1224, 1267, 1413, 1420, 1431, 1438 
Bryce application .......................................465 
Change ......................................................914 
choosing ..................................................1215 
Loading ....................................................1438 
pathname.....................................................45 

Fill Canvas......................................................904 
Scale Zoom Area .......................................904 

Filling ....................................................904, 1334 
Lake .........................................................1334 
Terrain Canvas ..........................................904 

Filter . 670, 724, 727, 759, 825, 879, 1004, 1007, 
1008, 1009, 1010, 1197, 1219 
Adjust .................................. 1007, 1009, 1010 
alter ..........................................................1007 
blend ........................................................1010 
Bryce........................................................1219 
changes ...................................................1008 
Choosing....................................................727 
display................................................724, 727 
Palette........................................................724 

Filter Area.....................................................1004 

corner ......................................................1004 
Filter button ....................................652, 724, 825 
Filter Changes....................................1008, 1010 

Applying...................................................1010 
Undoing ...................................................1008 

Filtering Equation...........................................727 
Filtering Graph .........................1007, 1010, 1197 

Altering ....................................................1007 
Blending...................................................1010 
use...........................................................1197 

Filtering Palette ......................................652, 674 
display .......................................................652 

Filtering Presets ...........................................1009 
Applying...................................................1009 

Filtering Tab .................................................1010 
Filtering Works .............................................1004 
Final Comments...........................................1411 
Fine Art AA.....................................................401 
Fine Art Anti-Aliasing .....................................401 
Finished Terrain ...........................................1325 
Fir Tree ..............................................1090, 1096 
Firewall.............................................................55 
First Frame button........................................1167 
Fit 905 
Fixed Cloud Plane..........................................835 

Enable .......................................................835 
use.............................................................835 
Using .........................................................835 

FlashPix Bitmap...............................................41 
Flat Preview ...........................................935, 936 
Flat Shading...................................................635 
Flip .........................................................155, 984 

Objects ......................................................155 
Z-axis.........................................................984 

Flip Gradient Colors...........................1419, 1427 
Flip/Invert Terrain...............................1419, 1427 
Floating ..............................................1414, 1422 

Nano-Editor ...................................1414, 1422 
Flow ...............................................................948 
Fly-around................................................96, 334 

changes .....................................................334 
end.............................................................334 
pause.........................................................334 
resume.......................................................334 
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save ...........................................................334 
slow............................................................334 

Fly-around View ........................ 334, 1414, 1422 
switch.........................................................334 
use .............................................................334 

Fly-around View icon......................................334 
Focal Length ..................................413, 415, 419 

set ......................................................413, 415 
Focus..............................................................413 

DOF ...........................................................413 
Fog . 99, 102, 218, 219, 220, 222, 228, 232, 234, 

235, 237, 238, 241, 242, 243, 245, 248, 250, 
252, 253, 256, 257, 258, 260, 261, 262, 265, 
266, 309, 405, 504, 534, 570, 571, 649, 764, 
766, 769, 771, 773, 777, 781, 783, 784, 788, 
791, 793, 796, 801, 802, 804, 806, 807, 808, 
810, 812, 814, 815, 816, 818, 821, 822, 823, 
825, 827, 828, 829, 830, 832, 833, 834, 835, 
836, 841, 843, 845, 849, 852, 853, 856, 857, 
863, 865, 867, 869, 873, 886, 887, 1122, 
1176, 1203, 1204, 1205, 1206, 1325, 1326 
Enable............... 841, 843, 845, 849, 863, 865 
Re-enabling ...............................................873 

Fog Base Height ............................................849 
Fog button .... 228, 237, 238, 241, 242, 243, 245, 

248, 250, 252, 253, 256, 257, 258, 261, 262, 
265, 266, 405, 649, 764, 766, 769, 771, 777, 
781, 783, 784, 788, 791, 793, 796, 801, 802, 
804, 806, 807, 808, 810, 812, 814, 815, 816, 
818, 821, 822, 823, 825, 827, 828, 829, 830, 
832, 833, 834, 835, 836, 841, 843, 845, 849, 
852, 853, 856, 857, 863, 865, 867, 869, 873 

Fog Color................................................235, 841 
Fog Density ................... 232, 234, 843, 845, 849 
Fog Options menu..................................223, 248 
Fog Palette..... 15, 218, 219, 221, 222, 240, 248, 

260, 265, 504, 802, 804, 806, 810, 816, 818, 
830, 832, 833 

Fog Presets Library................................29, 1325 
Fog Settings .................................222, 887, 1203 
Fog Thickness....................... 232, 234, 843, 845 
Fog thickness/height ......................................234 
Fog, Haze.............................................395, 1205 
Foliage..........................................473, 651, 1104 
Foliage Distribution ......................................1103 
Foliage Scale ...............................................1099 
Foliage Shape ..............................................1096 
Foliage Texture ............................................1104 

Following........................................................296 
OpenGL.....................................................296 

Format..................................................879, 1399 
Format menu..................................................928 
Forms...............................................................45 

DEM.............................................................45 
FOV..............................................380, 872, 1428 

set..............................................................380 
FPI ...................................................41, 508, 940 
FPix..................................................................41 
FPS ....................................36, 1110, 1114, 1379 
Fps Bryce.....................................................1114 
FPX ..................................................41, 508, 940 
Fract Stone ....................................693, 716, 735 
Fractal ....................693, 716, 969, 970, 979, 984 

generate ....................................................984 
Select.........................................................969 

Fractal button .........................................979, 984 
clicking...............................................979, 984 

Fractal menu..................................................979 
Fractal tool .....................................................969 

use.............................................................969 
Fractal Types .................................................970 
Frame.........................36, 131, 1109, 1114, 1379 
Frame Count ................................36, 1114, 1130 
Frame Positions ...........................................1154 

Saving......................................................1154 
Frame Rate ..................................................1110 

Setting .....................................................1110 
Free........................................................353, 386 
Free Camera..................................................346 
Free Camera Mode........................................353 

change.......................................................353 
Frequency ..............250, 539, 688, 703, 720, 833 

Setting .......................................................833 
From Front .....................1334, 1344, 1356, 1388 

Switch ......................................................1388 
From Right .........................................1356, 1388 

Switch ......................................................1388 
From Top .....................................................1356 

choosing ..................................................1356 
Front..186, 328, 331, 333, 335, 341, 1177, 1180, 

1388 
Switch ......................................................1388 

Front View....................................328, 333, 1364 
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Switch ......................................................1364 
Full..................................................................636 
Full Render.......................... 328, 394, 424, 1027 
Full Scene ......................................................328 
Full Shading ...................................................636 
Fuzzy..............................................................633 
Fuzzy Factor ..................................561, 588, 591 
Fuzzy Factor control...............................561, 591 
G 
G2H......................................................119, 1428 
Galaxies .........................................................767 
Gamma...........................................................873 
Gamma Correction.................................427, 873 

deselecting.................................................873 
Gaussian ............................... 441, 445, 731, 993 
Gaussian Blur.................................................879 
Gaussian Edges.............................................993 
Gaussian Edges tool ......................................994 
GB ......................................................................4 
Gels ....................................................1070, 1072 

Visible Light .............................................1070 
General......... 85, 376, 378, 380, 385, 386, 1185, 

1233, 1234, 1237, 1238, 1240, 1241, 1242, 
1243, 1244 

General 3D.............................................451, 585 
General Render Options ................................424 
General Tab .................................................1234 
General, Linking ...............................................85 
Generate ............................. 119, 339, 984, 1249 

Director's View...........................................339 
fractal .........................................................984 
grayscale ...................................................119 
HTML .......................................................1249 

Geometric.....................................................1258 
Geometric Path ......................................94, 1258 
Geometric Path Linking................................1258 
Get............................................. 28, 55, 479, 922 

Green Status................................................55 
RGB ...........................................................479 
Tessellating Progress dialog .....................922 
Windows Color Picker..................................28 

Giant Sequoia ....................................1090, 1096 
GIF ...................................................41, 508, 940 
Gigantic ........................................................1025 

Global Changes .............................................755 
Global Colors .................................................756 
Global Filtering.......................................759, 761 
Global Noise Filter .........................................756 
Global Phase .................................................758 

adjust .........................................................758 
Glow Intensity ........................................788, 791 

Drag...........................................................791 
Grace .............................................................879 
Gradient 897, 899, 900, 1042, 1043, 1045, 1047, 

1050, 1051, 1053, 1058, 1061 
activate ....................................................1061 
Add Colors...............................................1047 
Applying.....................................................899 
center.......................................................1047 
Colors ......................................................1047 
Drag...........................................................897 
enable......................................................1061 
Modifying .................................................1043 
Removing ..................................................900 
Saving......................................................1061 

Gradient Bar...................................893, 897, 901 
Gradient Bar Modifiers...................................901 
Gradient Box ................................................1050 
Gradient Color....................................1045, 1438 

modify ......................................................1045 
Gradient Color Picker ..................................1438 
Gradient Control...........................................1045 
Gradient Lights.............................................1042 
Gradient Preview ...........1043, 1045, 1047, 1053 
Gradient Range............................................1058 
Gradient Strip.................................................889 

contains .....................................................889 
Gravity..........................................................1092 

drag .........................................................1092 
Gray Levels....................................................953 
Gray Scale .......................................................25 
Grayscale......119, 441, 445, 474, 508, 566, 568, 

572, 574, 889, 897, 934, 935, 940, 948, 949, 
950, 964, 1000, 1001, 1010, 1014, 1020, 
1195 
displays......................................................889 
drawing ....................................................1010 
emboss ....................................................1000 
generate ....................................................119 
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like..............................................................474 
return..........................................................897 
set ..............................................................949 

Grayscale bar.........................................266, 816 
Grayscale components ..................................749 
Grayscale representations .............................441 
Grayscale-to-height................... 119, 1012, 1428 
Grd ............................................ 140, 1043, 1431 
Green .............................................681, 682, 746 
Green Status ....................................................55 
Greyed............................................624, 928, 979 
Grid...................... 191, 424, 922, 924, 926, 1276 

Align...........................................................191 
objects........................................................191 
selecting.....................................................922 
Snap...........................................................191 

Grid Selector ..................................................950 
Grid Selector icon...........................................950 
Grid Triangulation...................................922, 924 
Ground ........................ 113, 116, 194, 196, 1224 

Snap...................................................194, 196 
Ground Plane .........................................113, 116 

Creating .....................................................113 
Left-click-hold.............................................113 
Use.............................................................113 

Ground Plane tool ..........................................113 
Ground Slab ...................................................113 

create.........................................................113 
Group ....... 129, 316, 323, 421, 423, 1152, 1260, 

1267, 1295, 1298, 1328, 1330, 1350, 1355, 
1369 
Boolean Union .........................................1298 
Building ....................................................1369 
Creating ...................................................1350 
Metaballls...................................................129 
Moving .....................................................1152 
Objects.....................................................1295 
select........................................................1355 
vs Linking.................................................1260 

Group button ...... 1328, 1330, 1350, 1361, 1367, 
1369 

Group Icon ...................................................1266 
Group Objects ................... 91, 1295, 1413, 1420 
Group’s.........................................................1369 
Grouped Building .........................................1371 

Grouper............................................................45 
Groups. ........................................................1254 
H 
Half Angle ....................................................1033 

called .......................................................1033 
Halo Rings ...........................................796, 1436 

disable .....................................................1436 
Enable .......................................................796 

Halves ............................................................893 
Symmetrical Lattices .................................893 

Handling.........................................................928 
Image Maps...............................................928 

Hang ............................................................1437 
Tree Lab ..................................................1437 

Hardness........................................................947 
Harsh Transitions.........................................1008 

Softening .................................................1008 
Haze......227, 236, 237, 238, 245, 773, 832, 852, 

853, 856, 857, 863, 873, 1326 
Adjust.........................................................773 
color...........................................................236 
Enable .......................852, 853, 856, 857, 863 
increase ...................................................1326 
locate .......................................................1326 
Set .............................................................773 
Sun ............................................................863 

Haze Base Height ..........................................857 
Haze button....................................................863 
Haze Color .............................................238, 852 
Haze Density..........................237, 853, 856, 863 
Haze density/intensity....................................237 
Haze Thickness .............................................856 
HDR ...............................................872, 873, 879 
HDR file..................................................873, 879 

type............................................................879 
HDRI ..........2, 19, 41, 872, 873, 878, 1428, 1433 

add...............................................................19 
IBL .............................................................873 
level ...........................................................873 
look ............................................................873 
render ........................................................872 
rotate .........................................................873 
save .........................................................1433 
show ..........................................................873 
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HDRI Disabled ...............................................878 
HDRI Effect ....................................................873 
HDRI Enabled ................................................878 
HDRIs using HDRShop..................................879 

Converting .................................................879 
HDRShop .......................................................879 
Height Noise...................................................993 
Height Picker tool ...........................................953 
Heightfield ........................................................45 
Heightfields ......................................................45 
Help ........................................................99, 1439 
Help file ..........................................437, 441, 445 
Help Menu..................................................11, 99 
Hf 45 
Hidden..........................................................1242 
Hidden Body Parts .......................................1433 
Hidden button...............................................1242 

Enable......................................................1242 
Hidden Line ............................................294, 296 
Hidden/invisible ............................................1434 

part...........................................................1434 
Hide ...... 102, 103, 285, 373, 788, 791, 793, 796, 

1432 
Bryce..........................................................103 
Camera's Field...........................................373 
Plop-Render...............................................285 
sun/moon .......................... 788, 791, 793, 796 

Hide Interface.................................................103 
Hide Palettes........................................102, 1432 
Hide Property Timelines...............................1144 
Hide Selection ................................................285 
Hide Trajectory.............................................1250 
Hide/display..................................................1147 
Hiding .....................................................356, 373 

Camera Wireframe ....................................356 
Camera's Field...........................................373 

Hierarchical Structure...................................1261 
Hierarchies ...........................................308, 1144 

collapse....................................................1144 
Viewing ....................................................1144 

Hierarchy Area .............. 1144, 1154, 1155, 1187 
Hierarchy List ................ 1144, 1148, 1233, 1262 

expand/collapse.......................................1144 
Hierarchy List Area........ 1143, 1144, 1147, 1148 
High Dynamic Range Image ................873, 1428 

uses ...........................................................873 
Higher Refraction...........................................585 
High-resolution...............................................904 
Hills ................................................................970 

Rolling........................................................970 
Hit1316 

Escape key..............................................1316 
HLS ........................................218, 676, 681, 682 

switch.........................................................218 
HLS Color Picker .............................................28 
Horizon...........................................................265 
Horizon Color .................................................225 
Horizon Illusion ..............................................793 
Horizontal.....................................................1010 
Horizontal Add .............................................1010 
Hornbeam ..........................................1090, 1096 
Horse Chestnut ..................................1090, 1096 
Hot Pink .....................................816, 1035, 1038 
Hotspot.........................................................1249 
Hotspots.........................................................435 
Hours ...........................................................1114 
HSB..................................................................25 
HSV Color Picker .............................................28 
Htm ..................................................................50 
HTML .....................................................50, 1249 

create.......................................................1249 
generate ..................................................1249 

HTML dialog.................................................1249 
HTML file......................................................1249 
Hue ........................................................676, 681 
I 
IBL. 2, 19, 222, 872, 873, 879, 1428, 1433, 1435 

Adjust.................................................873, 879 
during.........................................................873 
except ........................................................222 
HDRI..........................................................873 
saving ......................................................1435 
use.............................................................873 

IBL Examples.................................................878 
IBL info.........................................................1435 

saving ......................................................1435 
IBL Roller Ball ..............................................1437 

Tick Marker..............................................1437 
IBL Tab disappears......................................1437 
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IBL-enabled....................................................873 
IMac®.................................................................4 
Image ...........................................472, 647, 1070 

Using........................................................1070 
Image Based Lighting ............... 873, 1428, 1433 
Image button ........... 472, 473, 1070, 1088, 1104 
Image Gels...................................................1070 
Image Map Controls.......................................916 
Image Maps ...................................................928 

Handling.....................................................928 
Image Palettes .................................................25 
Image With Scene Open/Save.........................41 
Image-Based Lighting ..............................2, 1443 
Import button ........................................512, 1043 
Import Gradient ............................................1043 
Import Object............... 45, 87, 1219, 1224, 1267 
Import Studio Animation dialog ....................1215 
Import/export 16-bit grayscale......................1014 
Imported Animations ....................................1218 

Updating ..................................................1218 
Imported Mesh Object....................................214 
Imported Meshes .............................................48 
Imported objects grouped ............................1434 
Importing 2, 512, 1207, 1214, 1215, 1219, 1224, 

1433, 1434 
Animations ...............................................1207 
Animations via Studio Link ......................1215 
DAZ|Studio...............................................1433 
DXF................................................................2 
objects......................................................1434 
Poser/DAZ|Studio ..........................................2 
Static Objects via Poser Export ...............1224 
Static Objects via Studio Export ..............1219 
Static Objects via Studio Link ..................1214 

Inches.............................................50, 435, 1208 
Include......................................................25, 428 

anti-aliasing................................................428 
System.........................................................25 

Increase/decrease..........................701, 825, 907 
Increased Turbulence ....................................823 
Increases.... 413, 583, 585, 823, 873, 946, 1326, 

1418, 1426 
Complexity .................................................823 
Haze.........................................................1326 
Paintbrush..................................................946 

Rays ..........................................................413 
Reflection...................................................583 
Refraction ..................................................585 
specularity .................................................873 
Turbulence.................................................823 

Increasing/decreasing....................145, 147, 150 
Increments ....145, 147, 150, 162, 163, 164, 170, 

171, 173 
Indicates.......................................................1215 

Bryce .......................................................1215 
Indicator .........................................................756 
Infinite ..........................................................1068 

enable......................................................1068 
Infinite Light..................................................1067 

enable......................................................1067 
Infinite Planes icon.......................................1334 

Selection Palette .....................................1334 
Infinite Planes Preset Materials Library .........118 
Insert ..................................................................5 

Application CD...............................................5 
Content CD....................................................5 

Inside .....................................488, 491, 493, 494 
Library................................................488, 493 
Preset Folder .....................................491, 494 

Install button.......................................................5 
Installed............................5, 104, 488, 664, 1438 

Application .....................................................5 
B6/6.1 ......................................................1438 
Bryce .............................................................5 
Bryce Content................................................5 
Content ..........................................................5 

Intensity599, 672, 764, 766, 769, 777, 796, 1029 
Adjust.........................................764, 766, 777 
Changing ...................................................769 
Drag...................................................769, 777 

Interchangeable .............................................368 
Interface Max/Min ..........................................275 
Interface Max/Min tool ...................................275 

Use ............................................................275 
Interferences ..........................................685, 686 
Interior..........................................................1330 

Creating ...................................................1330 
Internet...............................................................8 
Interpol ...........................................................686 
Intersect .........................1297, 1328, 1416, 1424 
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combining ................................................1297 
contains ...................................................1297 
object .............................................1416, 1424 

Intersecting checkbox ........................1298, 1301 
Enable............................................1298, 1301 

Invert ..............................................................965 
Invert button ...................................131, 482, 965 

clicking .......................................................131 
Invert Selection ............................82, 1413, 1420 
Invisible ..........................................................356 

Enable........................................................356 
Invisible Nodes.............................................1219 
IP 55, 63 

shows...........................................................55 
Irregular ..........................................................707 
Issues.................................................................3 
It’s.................... 191, 193, 708, 1258, 1367, 1399 
Italian Cypress ...................................1090, 1096 
Its wireframe.................................................1348 
J 
Jaggies ...........................................................397 
Japanese Maple.................................1090, 1096 
Jetstream......................................................1325 

applying ...................................................1325 
Joshua Tree .......................................1090, 1096 
JP2 ...................................................41, 508, 940 
JPE...................................................41, 508, 940 
JPEG....................................... 41, 43, 928, 1249 

level..........................................................1249 
JPEG file ......................................................1249 

name........................................................1249 
JPEG/JIFF Image.............................................41 
JPEG-2000 JP2 File.........................................41 
JPG ..................................... 41, 43, 50, 508, 940 
K 
Keep Gradient ................................................913 

Choose.......................................................913 
Key Event ................................ 1151, 1152, 1153 

Copying....................................................1153 
Deleting....................................................1152 
Moving .....................................................1151 

Key Frames............................. 1122, 1123, 1187 
Adding......................................................1122 
Deleting....................................................1123 

Keyboard..................................1276, 1418, 1426 
Resize Using ...........................................1276 

Keyframe............................................1381, 1399 
Keyframe button...........................................1381 
Keyframe Materials ............................................2 
Keyframed....................................................1433 
Keyframes................................1123, 1405, 1434 

animating .................................................1434 
applying ...................................................1434 
Creating ...................................................1405 

Known Issues...........................................3, 1443 
KPT3 ............................................................1435 
L 
Lab Keyframes.............................................1434 
Labs ...........................................915, 1414, 1422 
Ladybird .........................................................120 
Lake ...................................................1330, 1334 

Filling .......................................................1334 
Land .........................................................77, 197 

Snap ....................................................77, 197 
Land Object button.............................1316, 1374 
Land Object Icon..........................................1274 
Land Objects..........................................77, 1274 
Land Selection .............................................1274 

like ...........................................................1274 
Landscape .........................................1026, 1328 

Creating ...................................................1026 
Preparing .................................................1328 

Last Frame button..............................1138, 1167 
Last Keyframe button...................................1405 
Last Minute Notes..............................................5 

Read ..............................................................5 
Launch ...................................................82, 1223 

Default State................................................82 
DS............................................................1223 
Previous State .............................................82 

Launch DAZ|Studio........................................140 
Launch DAZ|Studio button........140, 1214, 1215, 

1218 
clicking.................................1214, 1215, 1218 

Launch DS ...........1214, 1215, 1218, 1219, 1223 
Launch Poser...............................................1224 
Layer/channel ........................................441, 445 
Leaf Textures Not Saved .............................1434 
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Leaves....................................... 863, 1101, 1122 
Blend Fog ..................................................863 
Current Time Indicator .............................1122 
Number ....................................................1101 

Lebanon .............................................1090, 1096 
Left View.........................................................328 
Legal.................................................................35 
Legal Pad .......................................................276 
Lens Radius ...................................413, 415, 419 

control ........................................................413 
set ......................................................413, 415 

Leo ...................................... 131, 471, 620, 1432 
Deleting....................................................1432 

Level tool ............................... 953, 955, 958, 960 
Levels . 128, 291, 424, 732, 760, 873, 949, 1249, 

1428 
Attraction....................................................128 
Clip.............................................................732 
complexity. .................................................760 
Detail................................................291, 1428 
HDRI ..........................................................873 
JPEG........................................................1249 
Optimization...............................................424 

Library ................................. 475, 488, 493, 1432 
accessing.................................................1432 
Inside .................................................488, 493 

Light........ 214, 633, 681, 682, 1047, 1073, 1074, 
1374, 1431 
Adjusting ..................................................1374 
Animating.................................................1074 
Apply Gradient .........................................1431 
Positioning ...............................................1074 
Range ......................................................1047 

Light Falloff...................................................1061 
Light Gels ...........................................................7 
Light Lab......... 17, 89, 214, 472, 647, 872, 1027, 

1029, 1031, 1035, 1038, 1040, 1042, 1043, 
1045, 1047, 1051, 1053, 1058, 1061, 1067, 
1068, 1070, 1072, 1074, 1264, 1414, 1422 
Accessing ................................................1027 
enter.........................................................1061 

Light Material................................................1061 
adding ......................................................1061 

Light Object ..................................................1061 
adding ......................................................1061 

Light Preview ...............................................1027 
Light Probe.....................................................873 
Light Sensitive................................................636 
Light Settings ...............................................1073 

Saving......................................................1073 
Light Source.......................................1067, 1068 

Create............................................1067, 1068 
Light wireframes...........................................1074 
Light’s Tracking icon ....................................1374 
Lightness................................................676, 682 
Light-sensitive ................................................633 
LightWave™ ....................................................45 
Like349, 474, 617, 626, 710, 728, 730, 739, 767, 

806, 997, 1136, 1274 
3D ..............................................................626 
Bezier ......................................................1136 
Clip ............................................................739 
Difference ..................................................730 
Equalize.....................................................997 
grayscale ...................................................474 
Land Selection.........................................1274 
Noise Editor ...............................................710 
Posterize....................................................728 
trackball .............................................767, 806 
Trackball Mode..........................................349 
World Space..............................................617 

Like Fog Density ............................................845 
Limiting...........................................................451 

TIR.............................................................451 
Line Color.......................................................269 

change.......................................................269 
Line Thickness bar.........................................269 
Linear .........................................................2, 873 

set..............................................................873 
Linear Falloff ................................................1061 
Linear Interpol ........................................683, 684 
Linear Interpolation ........................................686 
Linear Sine.............................693, 716, 732, 739 
Link ...85, 98, 814, 835, 1172, 1174, 1184, 1222, 

1223, 1245, 1248, 1257, 1258, 1260, 1385, 
1403, 1439, 1443 
Breaking ........................................1222, 1258 
Clouds .......................................................835 
Creating ...................................................1257 
DAZ3D.com.................................................98 
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DS............................................................1223 
Objects.....................................................1245 
Studio.......................................................1222 
Sun.............................................................814 

Link Clouds ..........................................835, 1176 
View button ......................................835, 1176 

Link icon ...........................................................94 
Link Sun .................................................220, 814 

Camera ......................................................814 
View ...........................................................220 
View button ................................................814 

Linking Tab...................................................1249 
Links Menu.................................................11, 98 
Linksmenu.htm.................................................98 
Lit WireFrame.........................................294, 296 
Load ...... 478, 602, 607, 1012, 1015, 1020, 1438 

8-bit ..........................................................1015 
files...........................................................1438 
New 2D Texture.........................................602 
Pictures....................................................1012 

Load button ......... 131, 476, 478, 602, 607, 1070 
clicking .......................................................131 

Load dialog.....................................475, 476, 478 
Load Image dialog..........................................602 
Load New Picture...........................................475 
Load Preset Tree ...............................1416, 1424 
Load Sky ............................................1413, 1420 
Locate.................................................1326, 1330 

Haze.........................................................1326 
Rotation tool.............................................1330 

Location............... 1047, 1050, 1051, 1053, 1057 
adjust .......................................................1050 

Location changes .........................................1434 
Location/angle................................................296 
Locked..........................................358, 359, 1242 

Camera Position ........................................358 
Disable.......................................................359 
Enable........................................................358 

Locked button...............................................1242 
Disable.....................................................1242 
Enable......................................................1242 

LOD..............................................................1428 
Loopywolf .....................................................1443 
Low.................................................................426 

Low Dynamic Range button...........................879 
Lower Terrain.....................................1419, 1427 
Luminance .............................................863, 865 
Lwo ..................................................................45 
Lws...................................................................45 
M 
Mac .......3, 45, 65, 218, 312, 508, 873, 899, 940, 

1042, 1414, 1419, 1431, 1436, 1438 
Mac 16-bit TIF..............................................1437 
Mac Bryce ......................1436, 1437, 1438, 1439 

Double-clicking ........................................1438 
Mac Color Pickers..................................25, 1443 

For ...........................................................1443 
Mac Intel ............................................................2 
Mac OS..............................................................4 
Mac OS Color Pickers .....................................25 
Mac OS10.4 Bryce.......................................1438 
Mac PICT .......................................................928 
Mac/PC Shortcuts ........................................1443 
Mac® OS ...........................................................4 
MacBook® Pro...................................................4 
Macintosh..1152, 1413, 1414, 1416, 1417, 1418, 

1419, 1443 
Macintosh®....................................................4, 5 
Macintosh® Intel ................................................4 
Macintosh® Pro .................................................4 
Mactel's Rosetta ..........................................1439 
Magnifying Glass icon......................................25 
Main Timeline...............................................1434 

added.......................................................1434 
Main View ......................................................331 
Main Working Window .......................................2 
Make Circular.....................................1137, 1254 
Make One Shot ..................................1137, 1254 
Make Pendulum.................................1137, 1254 
Make Repeat......................................1137, 1254 
Making ........219, 788, 791, 793, 796, 947, 1350, 

1363, 1388 
Boolean ...................................................1350 
Camera Adjustments...............................1388 
Paintbrush .................................................947 
Sky.............................................................219 
sun/moon...........................788, 791, 793, 796 
Walls Taller..............................................1363 

Managing ...........................................................7 
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Bryce..............................................................7 
Content ..........................................................7 

Manipulate......................................................335 
Camera ......................................................335 

Manual................................................................3 
Manual Rotation .............................................938 
Manual Rotation on Y-axis ...........................1435 
Manual Tutorial ..................................1385, 1399 
Map_d ..........................................................1224 
Mapping..................................................623, 897 

Color ..........................................................897 
Mode Modifiers ..........................................623 

Mapping Mode ...............................................614 
Mapping Mode Options ..................................614 

access........................................................614 
Marker ............................................................269 

place ..........................................................269 
Marker Options...............................................269 

Changing ...................................................269 
Marker Palette................................................269 
Marker Pen.....................................................269 

color ...........................................................269 
Size............................................................269 

Marker Pen tool..............................................269 
deselect .....................................................269 

Mask Render Mode........................................437 
Masking..........................................437, 441, 445 

Modes ........................................................437 
Massive ........................................................1025 
MAT..............................................................1436 
Mat Lab ........................................................1428 
Matches........................... 386, 1238, 1358, 1439 

DS............................................................1439 
Position ............................................386, 1238 
pyramid’s .................................................1358 

Material....... 308, 500, 532, 544, 553, 561, 1263, 
1434 
Animating...........................................308, 553 
Applying .....................................................532 
Understanding ...........................................561 

Material Animations......................................1194 
Previewing ...............................................1194 

Material button .......................... 651, 1088, 1104 
Material Channel Values..............597, 599, 1189 

Animating.................................................1189 

Material Components.....................................669 
Material Grid ..........................539, 543, 594, 595 

called .........................................................539 
Material Icon ................................................1263 
Material Mode Toggle ....................................539 
Material Options.............................................602 
Material Presets .............................................551 
Material Preview ..........................539, 602, 1263 
Material Preview Area..........................545, 1194 

Using .........................................................545 
Material Preview window .......532, 539, 544, 548 
Material Quick-Select.....................................551 
Material Structure...........................................553 
Materials ......................................................1263 
Materials Editor ........................................89, 928 
Materials Lab ....1, 18, 22, 88, 89, 142, 308, 395, 

471, 532, 535, 536, 539, 541, 542, 544, 545, 
548, 585, 594, 595, 597, 600, 602, 611, 612, 
614, 646, 647, 648, 651, 652, 664, 872, 899, 
1070, 1072, 1088, 1104, 1107, 1111, 1125, 
1189, 1190, 1194, 1263, 1267, 1414, 1422, 
1428 
access .....................................................1104 
center.........................................................539 
display .....................................................1263 
enter ..................................544, 545, 600, 602 
Exit.............................................................899 
Quick Tour .................................................539 

Materials Library70, 82, 395, 500, 525, 548, 551, 
899, 1436, 1439 
Access .......................................................548 
open...........................................................525 

Materials Library on PCs .............................1436 
Materials Preset Library......500, 532, 548, 1061, 

1104, 1190, 1322, 1330, 1334 
Saving......................................................1061 
Using .........................................................548 

Materials Presets icon ...........................532, 551 
clicking.......................................................532 
holding .......................................................551 

MatLab .................................................536, 1428 
Matrix ...............................................................71 
Max ..............................................................1077 
Max Brush Level ................................1419, 1427 
Max Quality ......................................................43 
Max Recommended.......................................275 



Bryce 6 Artist Guide 

©2007 DAZ 3D, Inc.  1489 

set ..............................................................275 
Maximum........... 708, 748, 754, 960, 1079, 1080 
Maximum Ray Depth.... 449, 454, 457, 459, 460, 

462, 1428 
enables ......................................................457 
introduced ..................................................460 
set ......................................................449, 454 

Maximum Recommended ................................35 
Maximum TIR Depth ......................................451 
Maximum90............................................710, 722 
MB..............................................................4, 516 

onboard..........................................................4 
MB RAM min ......................................................4 
Memory Dot...... 12, 222, 223, 1073, 1154, 1169, 

1414, 1422, 1433, 1435 
setting ........................................................222 
use ...............................................................12 

Memory Dotsto...............................................329 
use .............................................................329 

Memory Issues.............................................1435 
Menu Bar................................................11, 1075 
Menu icon.............................. 952, 955, 958, 960 

Terrain Canvas ................. 952, 955, 958, 960 
Menu item.....................................................1438 
Menus.................................................1413, 1420 
Merging ............................. 39, 1373, 1413, 1420 

Existing Scene .........................................1373 
Mesh.............. 2, 87, 291, 315, 1267, 1413, 1420 

Convert Boolean ... 87, 291, 1267, 1413, 1420 
Convert Boolean Group.................................2 

Mesh Editor ..................................................1212 
Mesh Previewer .............................................917 
Mesh Previewer Inspection............................917 
Meta .............................................................1439 
Metaball................... 128, 129, 1416, 1424, 1439 

center .........................................................128 
Duplicating .................................................128 
set ..................................................1416, 1424 

Metaballls .......................................................129 
Grouping ....................................................129 

Metaballs ..... 2, 105, 128, 129, 1267, 1286, 1439 
MetaCreations................................................931 
MeTaL Fixer .....................................................45 
Metallicity............. 545, 558, 561, 577, 625, 1433 
Metamorphised ..............................................970 

MetaStream .........................................931, 1436 
Exporting ...................................................931 

MetaStream Files...........................................931 
Select.........................................................931 

MHz....................................................................4 
Midsized.........................................................996 
Milky Way.......................................................767 
Min ...............................................................1077 
Min Brush Level .................................1419, 1427 
Min/Max .......................................................1077 

right..........................................................1077 
Min/Max Sliders ...........................................1077 
Minimal...........................................................424 
Minimize Bryce.............................................1020 
Minimum ................................708, 748, 753, 958 

use.............................................................958 
Minimum & Maximum ..................................1080 
Minimum90 ............................................709, 722 
Mirrored Ball...................................................879 
Misc......................................................575, 1072 
Mixing.............................................................678 

Colors ........................................................678 
Mjt470 ..........................................................1443 
Mode AB ........................................561, 611, 614 
Mode ABC......................................561, 612, 614 
Mode Modifiers ......................................623, 639 

Mapping.....................................................623 
Shading .....................................................639 

Modes ............................437, 561, 611, 706, 722 
Masking .....................................................437 

Modify ..119, 951, 1043, 1045, 1122, 1123, 1223 
Add Key Frame........................................1122 
Brush Behavior ..........................................951 
Delete Key Frame ...................................1123 
figure/animation.......................................1223 
Gradients .................................................1043 
Gradient's Colors.....................................1045 
Terrain .......................................................119 

Modify Gradient Colors ................................1045 
Monkey Puzzle...................................1090, 1096 
Moon .......19, 228, 253, 260, 261, 405, 764, 766, 

769, 771, 773, 777, 781, 783, 784, 788, 791, 
793, 796, 801, 802, 804, 810, 814, 815, 816, 
818, 886, 1206 
Positioning .................................260, 261, 810 
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Moon Brightness ..................................781, 1435 
Moon Manually.......................................261, 810 

Positioning .........................................261, 810 
Moon Numerically ..................................262, 812 

Positioning .........................................262, 812 
Moon Phase ...................................781, 783, 784 

Enable........................................781, 783, 784 
Moon Shadow ................................................781 
Moon Texture .......................................784, 1432 
Mordor ............................................................970 
More Irregular.........................................707, 722 
Morphs .........................................................1224 
Mosaic ............................................................998 

Preset Materials Library.............................998 
Most Sky...............................................887, 1203 
Motion.....................................................291, 829 
Motion Blur .....................................................441 
Motion Lab .............. 97, 1413, 1414, 1420, 1422 
Motion Lab button ........................................1107 
Motion Path Attributes..................................1252 
Motion Path Display Options........................1250 
Motion Path Geometry Options....................1254 
Motion Path Modifiers ..................................1137 
Motion Paths ....... 1107, 1133, 1134, 1135, 1136 

Editing......................................................1136 
show.........................................................1133 
state .........................................................1133 

Mounds.............................. 309, 996, 1001, 1195 
applying ...................................................1195 

Mountain Ash .....................................1090, 1096 
Mouse.................................................1414, 1422 

Zoom In Using ...............................1414, 1422 
Zoom Out Using.............................1414, 1422 

MOV .................................................................50 
Move..... 99, 368, 886, 887, 888, 896, 903, 1113, 

1114, 1115, 1122, 1138, 1151, 1152, 1154, 
1167, 1177, 1179, 1185, 1189, 1190, 1195, 
1197, 1199, 1203, 1205, 1206, 1355, 1414, 
1422, 1437, 1439 
Camera View .............................................368 
Clipping Bracket.........................................896 
Current Time Bar ...........................1154, 1167 
Current Time Indicator ... 886, 887, 888, 1113, 

1114, 1115, 1122, 1177, 1179, 1189, 
1190, 1195, 1197, 1199, 1203, 1205, 1206 

End.................................................1414, 1422 

Group.......................................................1152 
Key Event ................................................1151 
Origin Point..............................................1185 
Palettes........................................................99 
Path .........................................................1138 
Roller Ball ................................................1437 
Roof .........................................................1355 
Scrubber ........................................1414, 1422 
Start ...............................................1414, 1422 
trees/metaballs ........................................1439 
Zoom Area.................................................903 

Move Palettes ....................................1414, 1422 
Move/resize............................................904, 905 
Movie Preview Window................................1126 

Using .......................................................1126 
MRD.............................................460, 462, 1428 
MTL................................................................914 
Mud Cracks....................................................970 
MultiFractal ....................................693, 708, 716 
Multi-Fractal ...................................................722 
Multiply...................................................709, 747 
Multi-Processor ..................................................2 
Multi-processor Macs...................................1438 
Multi-Replicate ...............................2, 1413, 1420 
Multi-resolution...............................................931 
Multi-selection ....................................1416, 1424 
N 
Nails .............................................................1214 
Nano ..............................................................328 

setting ........................................................328 
Nano Editor On/Off ........................................280 
Nano Preview.................................................227 
Nano-Edit button............................................280 

Display.......................................................280 
Nano-Edit Mode.............................................280 

Use ............................................................280 
Nano-Editor................280, 304, 305, 1414, 1422 

Floating..........................................1414, 1422 
Nano-Editor Off ......................................304, 305 
Nano-Editor On......................................304, 305 
Nano-Editor window.......................................280 
Nano-Preview .......2, 12, 15, 328, 381, 435, 873, 

1127, 1194, 1201, 1207, 1208, 1297 
enabling/disabling........................................15 



Bryce 6 Artist Guide 

©2007 DAZ 3D, Inc.  1491 

Keep.................................................435, 1208 
Using............................................................12 

Nano-Preview window........ 98, 328, 1126, 1322, 
1330, 1334 
Check.......................................................1334 
Watch.......................................................1330 

Nature.............................................................869 
Nebulae..........................................................767 
Need...................... 623, 1050, 1381, 1388, 1439 

Break........................................................1439 
Bryce’s Auto-key......................................1381 
Color ........................................................1050 
seamlessly .................................................623 
Zoom........................................................1388 

Negative ... 1233, 1234, 1297, 1328, 1330, 1348, 
1416, 1424 
Enable......................................................1348 
object .............................................1416, 1424 
set ............................................................1233 
shape .......................................................1328 

Negative Boolean.................... 1234, 1328, 1330 
create.......................................................1330 
Transfer Material......................................1234 
use ...........................................................1328 

Negative checkbox.......................................1300 
Enable......................................................1300 

Negative Metaball ..................... 129, 1416, 1424 
Network ............................................................55 

Render .........................................................55 
Network Render ...........................55, 1439, 1443 

Use...........................................................1439 
Network Render Manager ..........................55, 63 

use ...............................................................63 
Network Render Settings dialog ................55, 63 
Network Renderer ..............................................2 
Network Rendering Works ...............................55 
Neutral................................................1328, 1348 
Neutral Ground.......................................500, 525 
New ............................... 25, 508, 940, 943, 1014 

selecting.......................................................25 
New 2D Texture .............................................602 

Loading ......................................................602 
New Blank Terrain..............................1419, 1427 
New Brush......................................................940 

Adding........................................................940 

New Brush Library .............................................2 
New button.....................................................964 
New Document ............31, 82, 1311, 1413, 1420 

Creating ...................................................1311 
New file dialog..............................................1014 
New Image.....................................................879 
New Surface Material ....................................541 

Creating .....................................................541 
New Terrain ...................................................964 

Starting ......................................................964 
New Volume Material.....................................542 

Creating .....................................................542 
Next....................................................................5 
Next button.........................................................5 
Next Frame button .......................................1167 
Next Key Frame.................................1414, 1422 
Next Ticker Mark................................1414, 1422 
Nff ....................................................................45 
Night...............................................................265 
No Texture .....................................................276 
Node ......................435, 1051, 1053, 1056, 1057 
Noise.....645, 670, 687, 688, 691, 692, 710, 724, 

756, 825 
access .......................................................645 
Adjust.........................................................825 
affects ........................................................724 
corner ........................................................756 
Creating .....................................................692 
display .......................................................688 

Noise button...........................652, 688, 691, 825 
Noise Dimensions..........................................692 
Noise Editor ..652, 687, 691, 692, 693, 701, 703, 

705, 706, 710, 716, 722, 756 
display ......652, 691, 692, 693, 701, 703, 705, 

706, 722, 756 
like .............................................................710 

Noise Frequency....................................688, 703 
end.............................................................688 

Noise Mode....................................692, 706, 715 
choose .......................................................706 
choosing ............................................692, 715 

Noise Octaves........................................705, 722 
Noise Orientation ...........................................701 
Noise Palette..................................652, 674, 688 

access .......................................................674 
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display........................................................652 
Noise Preview ................................................692 
Noise Slider ....................................................652 

Dragging ....................................................652 
Noise tool .......................................................995 
Noise Type .....................................692, 693, 715 

Choose...............................................692, 715 
Non-anchor-based .........................................199 
Non-Anchor-Based Aligning...........................199 
Non-Boolean ................................................1233 
None.......................... 681, 724, 727, 1014, 1258 

selecting...................................................1014 
set ..............................................................724 

Non-metaballs ....................................1416, 1424 
Norfolk Island Pine .............................1090, 1096 
Normal..................................... 31, 426, 631, 632 
Normal AA..............................................400, 405 
Normal Anti-Aliasing.......................................400 
Normal Render...............................................467 
North.......................................................873, 984 
North Pole ......................................................767 
North Star .......................................................767 
Norway Maple ....................................1090, 1096 
Norway Spruce...................................1090, 1096 
NOT................................................................873 
Not Align.............................................1140, 1253 
Nudging....................... 256, 261, 806, 810, 1294 

Objects.....................................................1294 
Sun Control....................... 256, 261, 806, 810 

Number............................ 447, 1082, 1101, 1148 
drag..........................................................1101 
Leaves .....................................................1101 
Optics.........................................................447 
Segments.................................................1082 
timelines...................................................1148 

Number 10....................................................1101 
Numeric Edit.................................................1438 
Numeric Edit Boxes......................................1438 
Numerically...........................................306, 1276 

Panning......................................................306 
Resizing ...................................................1276 

NumLock ..............................................31, 38, 81 
set ....................................................31, 38, 81 

Numpad................. 31, 38, 81, 1420, 1422, 1424 

Ctrl+1 key ....................................................81 
Nutshell ..................................................872, 873 
O 
OBJ ........45, 47, 48, 914, 928, 1212, 1219, 1434 

MTL file......................................................928 
Selecting....................................................914 

OBJ file ..........................................45, 914, 1224 
Object......85, 88, 89, 90, 91, 94, 96, 97, 98, 154, 

155, 165, 170, 171, 173, 175, 191, 334, 470, 
495, 532, 649, 1075, 1107, 1140, 1170, 1184, 
1245, 1248, 1267, 1275, 1286, 1294, 1295, 
1374, 1416, 1417, 1418, 1419, 1424, 1425, 
1426, 1427, 1432, 1434 
Aligning....................................................1140 
Animation Options Dialog..............1419, 1427 
Creating .........................................1416, 1424 
deselect ...................................................1374 
Exporting .................................................1432 
Flipping ......................................................155 
Grid............................................................191 
Grouping..................................................1295 
Importing..................................................1434 
Intersect.........................................1416, 1424 
Linking .....................................................1245 
Negative ........................................1416, 1424 
Nudging ...................................................1294 
Object Presets Library...............................495 
Positive ..........................................1416, 1424 
Scaling...........................................1418, 1426 
Selecting..............................1275, 1416, 1424 
Set Link Camera......................................1184 
Skewing ...................................................1286 
Toggle Hierarchy ...........................1419, 1427 
Tracking.........................................1170, 1248 
Translating.....................................1417, 1425 

Object Atrributes ............................................984 
Object Attributes button 1328, 1340, 1348, 1350, 

1355, 1385, 1394, 1403, 1405 
clicking.....................................................1355 

Object Attributes dialog.....85, 94, 157, 170, 173, 
176, 197, 421, 423, 984, 1133, 1134, 1135, 
1137, 1140, 1172, 1174, 1233, 1234, 1236, 
1237, 1238, 1240, 1241, 1242, 1243, 1244, 
1245, 1248, 1249, 1250, 1252, 1253, 1254, 
1258, 1260, 1276, 1292, 1298, 1300, 1301, 
1328, 1330, 1348 
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Display . 1233, 1238, 1240, 1241, 1242, 1243, 
1244, 1245, 1248, 1249, 1250, 1252, 
1253, 1254, 1258, 1328, 1330 

Enter ........................................................1238 
use ...........................................................1348 

Object Attributes/Multi Replicate/Sky Lab...1419, 
1427 

Object Control Palette ............. 1316, 1350, 1367 
Family button ...........................................1367 

Object Creation ..................................1416, 1424 
Object Cubic...................................................620 
Object Editor ......................................1414, 1422 
Object Front ...................................................620 
Object Hierarchies........................................1262 

Viewing ....................................................1262 
Object Mask ...................................................437 

Enable........................................................437 
select..........................................................437 

Object Movies ................................................435 
Object Name ................................................1233 
Object Origin Points .....................................1244 
Object Parent ...............................................1403 
Object Parent Name.....................................1245 
Object Parent Name menu...........................1258 
Object Scaling ....................................1418, 1426 
Object Selected................................................85 
Object Side.....................................................620 
Object Space 154, 165, 170, 171, 173, 175, 615, 

1190, 1237, 1304, 1307 
Object Top......................................................619 
Object Translation ..............................1417, 1425 
Object/body ..................................................1433 
Object/group...........................................421, 423 
Object/point ....................................................415 

center .........................................................415 
Object’s Boolean ..................... 1298, 1300, 1301 
Objects Imported via Studio Link .................1223 

Editing......................................................1223 
Objects Interactively................ 1183, 1418, 1426 

Scaling ...........................................1418, 1426 
Set Link Camera ......................................1183 

Objects Library . 2, 104, 123, 495, 513, 521, 530, 
1431 
access........................................................530 
open...........................................................521 

Objects Menu.....11, 470, 649, 1298, 1300, 1301 
Objects Presets Library .......................495, 1061 

objects .......................................................495 
Saving......................................................1061 

Objects, Materials ..................................512, 513 
Objects/groups.............................................1267 
Object—Terrain............................................1330 
Obp ..............................................494, 513, 1431 
OBP file........................................495, 513, 1431 
OBPs crash Bryce........................................1431 
Octaves..........................................705, 706, 722 
Off ..............................................424, 1414, 1422 
Offset ...................................76, 176, 1058, 1237 

change.....................................................1237 
Offset button ................................................1058 

dragging...................................................1058 
OK.......5, 65, 66, 386, 424, 483, 873, 879, 1014, 

1045, 1047, 1051, 1053, 1224, 1236, 1238, 
1399, 1439 

OK button.....................................................1356 
OK icon .50, 55, 61, 77, 131, 258, 262, 276, 306, 

346, 349, 351, 353, 356, 358, 359, 372, 373, 
376, 378, 380, 385, 386, 397, 399, 400, 401, 
403, 405, 408, 409, 411, 413, 415, 421, 423, 
428, 430, 431, 435, 449, 451, 454, 455, 457, 
459, 464, 481, 495, 500, 504, 506, 508, 512, 
513, 530, 532, 534, 535, 536, 541, 542, 548, 
602, 607, 609, 652, 664, 678, 764, 766, 769, 
771, 773, 777, 781, 783, 784, 788, 791, 793, 
796, 801, 802, 804, 808, 812, 816, 823, 825, 
836, 863, 865, 867, 915, 928, 931, 943, 945, 
984, 1035, 1038, 1040, 1043, 1045, 1047, 
1051, 1053, 1070, 1072, 1088, 1104, 1109, 
1110, 1116, 1118, 1129, 1133, 1134, 1135, 
1140, 1172, 1174, 1176, 1180, 1184, 1185, 
1189, 1190, 1195, 1197, 1199, 1204, 1205, 
1208, 1210, 1215, 1233, 1234, 1237, 1238, 
1240, 1241, 1242, 1243, 1244, 1245, 1249, 
1254, 1258, 1311, 1312, 1316, 1322, 1325, 
1328, 1330, 1334, 1344, 1348, 1350, 1367, 
1385, 1394, 1399, 1403, 1405, 1411, 1419, 
1426, 1431 
clicking.........................428, 1316, 1330, 1394 

Older Presets ...............................................1431 
Cannot add long Descriptions .................1431 

Onboard .............................................................4 
MB .................................................................4 

One-dimensional............................................715 
Online...........................................................8, 25 
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Online Forums....................................................8 
Online Help ........................................................8 

see .................................................................8 
Online Manual ....................................................8 
Opacity ...............................................1053, 1056 
Open... 25, 38, 39, 41, 45, 89, 97, 131, 140, 214, 

470, 475, 476, 484, 491, 494, 495, 508, 512, 
521, 525, 536, 561, 602, 607, 784, 873, 879, 
890, 940, 964, 988, 1012, 1015, 1043, 1167, 
1168, 1219, 1224, 1267, 1312 
Advanced Motion Lab........................97, 1168 
AML..............................................................97 
Animation Setup dialog............................1167 
Colors dialog................................................25 
Deep Texture Editor.............................89, 561 
Edit Mesh dialog ........................................214 
Materials Library ........................................525 
Objects Library...........................................521 
Pictures Editor .............................................89 
Pictures Library..........................................470 
Presets.......................................491, 494, 495 
Terrain Editor .....................................890, 964 
Textures Library.........................................536 
Tree Lab ....................................................214 

Open Bryce ............................. 1015, 1219, 1224 
Open button .................................................1373 
Open dialog...... 39, 45, 484, 512, 607, 873, 988, 

1012, 1015, 1267, 1373 
Open File....................................................38, 41 
Open File dialog . 38, 39, 41, 140, 508, 784, 940, 

1090, 1096 
Open HDRShop .............................................879 
Open Image .....................................................41 
Open List button.............................................484 
Open Photoshop ..........................................1014 
OpenGL..... 2, 4, 11, 294, 296, 1215, 1430, 1439 

following.....................................................296 
OpenGL 1.1........................................................4 

supporting ......................................................4 
OpenGL Display Mode.........................296, 1430 
OpenGL Mode......................................296, 1430 

select..........................................................296 
OpenGL® .......................................................296 
Operations......................................................967 

Undoing .....................................................967 
Opposite Side...............................................1280 

Optics....405, 408, 409, 447, 451, 539, 559, 595, 
672 
number ......................................................447 

Optics Channels.............................................559 
Optics Options ...............................................447 
Optimization Options .....................................424 
Optimizations .................................................424 

Levels ........................................................424 
Options menu.................................................931 
Orange ...........................................................746 
Orbiting ............................................................94 

Sun ..............................................................94 
Orient .............................................................687 
Orientation .......................738, 1172, 1174, 1248 
Orientation Control.........................................873 
Origin .................................349, 386, 1237, 1238 

change.............................................386, 1238 
Director's Camera......................................386 
right..........................................................1237 
set....................................................386, 1238 

Origin Fields.................................................1238 
Origin Handle ...............................................1185 

Drag.........................................................1185 
Origin Point ................................386, 1185, 1238 

move........................................................1185 
Original...........................................................823 
Orion ..............................................................767 
Orthogonal .....................................................390 
Orthogonal Projection ....................................331 

called .........................................................331 
Orthogonal Views..331, 334, 335, 337, 341, 346, 

349, 351, 353, 356, 358, 359, 372, 373, 381, 
385, 1177, 1183, 1184, 1185 
choose .............................................341, 1177 
switch.....................................341, 1183, 1184 
Using .......................................................1177 

Orthogonality..................................................331 
OS..........................................................25, 1439 
Others. ...........................................................760 
Out 

Zooming...................................................1159 
Output ....................................................652, 670 
Output Mode ....................................................55 
Output Module .................................55, 61, 1399 
Output Size ....................................50, 435, 1208 
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Output Types..................................................671 
Assigning ...................................................671 

P 
PackageName....................................................7 
Page Down.........................................1417, 1425 
Page Setup ................................................65, 66 
Page Setup dialog............................................65 
Paint .......................................................952, 955 

Elevations ..................................................952 
Paint Effect .............................................951, 955 
Paint Shop Pro .......................... 609, 1014, 1428 
Paintbrush ..................... 907, 946, 947, 948, 949 

change .......................................................946 
decreases ..................................................946 
increases ...................................................946 
makes ........................................................947 

Paintbrush Controls........................................950 
Paintbrush Flow .............................................948 

change .......................................................948 
Paintbrush Flow Control.................................948 
Paintbrush Hardness Control .........................947 
Paintbrush Level ............................................949 

change .......................................................949 
Paintbrush Level Control................................949 
Paintbrush Size Control .................................946 
Painter ....................................................609, 988 
Palettes ............................... 99, 724, 1414, 1422 

Filtering ......................................................724 
Moving .........................................................99 

Pan ...................................... 305, 306, 331, 1160 
change .....................................................1160 
Curve .......................................................1160 
Numerically ................................................306 

Pan button....................................................1168 
Pan Tool .........................................................304 

Using..........................................................304 
Pan tool button .......................................304, 305 
Panorama............................ 431, 435, 879, 1208 

select..........................................................431 
Panorama Projection..............................430, 431 
Panoramic ............................................435, 1208 

switch...............................................435, 1208 
Panoramic Projection .....................................431 
Panoramic Transform dialog..........................879 

Panoramic Transformations...........................879 
Paper Grid......................................................276 
Parallel ...........................................................745 
Parallel Light tool ...........................................139 
Parallel Lights ................................................139 

create.........................................................139 
Parametric..............................................616, 626 
Parametric Scaled..........................................617 
Parent-child........................................1144, 1245 
Part ....................................................1367, 1434 

hidden/invisible ........................................1434 
Wall..........................................................1367 

Paste..........................70, 609, 1012, 1015, 1020 
Paste button...................................131, 479, 544 
Paste Material ..............................71, 1413, 1420 
Paste Matrix .......................71, 1223, 1413, 1420 
Paste Over Original .......................................516 
Paste Terrain Grayscale ....................1419, 1427 

Terrain Canvas..............................1419, 1427 
Pasting Materials ...........................................544 
Pasting Pictures.............................................479 
Patch Rendering ............................................466 
Path..............317, 1138, 1140, 1403, 1405, 1411 

Constrain .................................................1403 
End ..........................................................1405 
Moving .....................................................1138 

Path Position................................................1406 
Pathname.........................................................45 

file ................................................................45 
Pause...................................63, 334, 1414, 1422 

Fly-around .................................................334 
Pause/Unpause Fly-around ...............1414, 1422 
PC .....31, 38, 45, 81, 218, 873, 915, 1042, 1123, 

1431, 1436 
PC Bryce............................................1432, 1436 
PC Bryce 6/6.1 on Windows Vista ...............1439 
PC Byte Order..............................................1437 
PCs ..........................................................65, 899 
PCT..............................................508, 940, 1432 
PDF..................................................................66 
Pedestal .......................................................1394 
Pedestal Merger...........................................1373 
Pen...............................................................1004 

changes ...................................................1004 
Pendulum.....................................................1137 
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Pentium® Processor ..........................................4 
Performs.........................................................687 

spline..........................................................687 
Perlin Hills ......................................................970 
Permission Issues ........................................1438 
Perspective ....................................437, 441, 445 
Perspective Camera.......................................495 
Perspective Projection ...................................430 

select..........................................................430 
Perspective Render........................................431 
Perspective Toggle ........................334, 338, 339 
Perspective-free .................... 331, 333, 335, 341 

view....................................................333, 341 
Perturbed........................................................685 
Pf 1358 
Pgm..................................................................45 
Phase ... 670, 710, 711, 713, 715, 720, 724, 758, 

825 
Adjust .........................................................825 
corner.........................................................758 
Creating .....................................................715 
display........................................................711 
set ..............................................................720 

Phase Amplitude ............................................710 
Phase button ..................................711, 713, 825 
Phase Dimensions .........................................715 
Phase Editor. 645, 652, 710, 713, 715, 716, 718, 

720, 722, 758 
Display ..... 652, 713, 715, 716, 718, 720, 722, 

758 
Phase Frequency ...........................................720 
Phase Noise Modes .......................................722 

choose .......................................................722 
Phase Noise Octaves.....................................722 
Phase Noise Orientation ................................718 
Phase Noise Type..........................................716 
Phase Palette................ 645, 652, 674, 710, 711 

display........................................................652 
Phase Preview ...............................................715 
Phase Slider...................................................652 

Dragging ....................................................652 
Photoshop .... 43, 441, 483, 609, 928, 988, 1014, 

1428, 1435 
Photoshop 5.5 ....................................1042, 1431 
Photoshop Plug-in Support ..........................1435 

Photoshop® .....................................................41 
PIC ...................................................41, 508, 940 
Pickers .............................................................25 
PICT.............................................41, 43, 82, 131 

save .............................................................82 
Pict file ...........................................................626 

allowing......................................................626 
Pict Interpolation ............................................626 
Pict Interpolation deselected..........................626 
Pict Object......................................................131 

create.........................................................131 
Pict Object tool.......................................131, 471 
PICT/BMP........................................................82 
Picture button...............................650, 988, 1012 

Press Shift+click ........................................650 
Picture Lists ...................................................484 
Picture Load dialog ......................................1070 
Picture Thumbnails ........................................474 
Pictures .480, 481, 988, 1012, 1015, 1020, 1022, 

1070 
Blending...................................................1022 
Deleting .....................................................480 
Loading....................................................1012 
Renaming ..................................................481 

Pictures dialog ...............................................131 
Access .......................................................131 

Pictures Editor.89, 142, 471, 472, 473, 479, 480, 
481, 597, 602, 607, 609, 784, 988, 1070, 
1088, 1104, 1430, 1432, 1439 
2D picts......................................................142 
access .........................................89, 471, 472 
corner ........................................................481 
displays......................................................602 
open.............................................................89 

Pictures Library ........470, 484, 1070, 1414, 1422 
open...........................................................470 

Pink button .............................471, 647, 648, 651 
Pinky_Nail ....................................................1214 
Pinky_Skin ...................................................1214 
Pitch ...............................................................378 
Pixelated ................................................626, 998 
Pixels .............................................50, 435, 1208 
Place ..............................................262, 269, 812 

Marker .......................................................269 
Sun ....................................................262, 812 
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Place Moon ........................................1417, 1425 
Place Sun...........................................1417, 1425 
Plain Black Background .................................525 
Plane ..................................................1328, 1334 
Plane/slab.....................................................1267 
Planes/slabs.................................................1267 
Planetary ......................................................1025 
Play ..............................................................1129 

Enable......................................................1129 
Play - Provides .................................................36 
Play button 1138, 1167, 1177, 1179, 1194, 1201, 

1207, 1385, 1388, 1394, 1399, 1403, 1405, 
1406 
Animation.................................................1385 
clicking .....................................................1405 
press ........................................................1138 

Play Mode ..............................................36, 1130 
Pleiades..........................................................767 
Plop Render .......................................15, 50, 424 

turning........................................................424 
Plop-Render ...................................285, 286, 466 

disable........................................................285 
hide ............................................................285 
rid 286 

Plop-Render Mode .........................................393 
Plugin .................................................................5 
Plug-In Folder.................................................483 

Selecting ....................................................483 
PNG..................................................41, 508, 940 
PNG Options ................................................1014 
PNT ........................................................508, 940 
Point397, 400, 401, 403, 419, 1162, 1163, 1358, 

1385 
Adding......................................................1162 
Camera ....................................................1385 
cube’s.......................................................1358 
Deleting....................................................1163 
Quality............................... 397, 400, 401, 403 
Sphere .......................................................419 

Polaris ............................................................767 
Polygon Count Slider .....................................916 
Polygonal Mesh Previewer.............................916 
Popup...............................................25, 585, 609 
Popup list......................................................1242 
Popup menu.......................... 16, 25, 36, 91, 142 

Popups.............................................................16 
Portable Greyscale Map ..................................45 
Portion........................260, 788, 810, 1116, 1379 

Sun Position trackball........................260, 810 
sun/moon...................................................788 
Timeline .........................................1116, 1379 

Poser.45, 48, 140, 157, 1207, 1214, 1224, 1432, 
1434 

Poser file ......................................................1215 
Poser/DAZ|Studio ..............................................2 

importing........................................................2 
Poser/DS............................................1215, 1434 
Position Camera Manually.............................381 
Position Camera Numerically ........................376 
Position Control..............................................767 

push...........................................................767 
Position Fields..............................................1240 
Position Origin Point Manually.......................389 
Position Origin Point Numerically ..................386 
Positioning ....256, 257, 258, 260, 261, 262, 333, 

338, 368, 376, 381, 386, 389, 390, 806, 807, 
808, 810, 812, 1074, 1237, 1238, 1240, 1258, 
1312, 1405 
Camera............................338, 381, 390, 1312 
Camera View.............................................376 
Camera's Origin Point ...............................389 
Director’s View...........................................368 
Director's View...........................................376 
Lights .......................................................1074 
match...............................................386, 1238 
Moon..........................................260, 261, 810 
Moon Manually ..................................261, 810 
Moon Numerically..............................262, 812 
Select Views..............................................333 
Sun ............................................257, 806, 807 
Sun Manually.....................................256, 806 
Sun Numerically ........................................808 
sun/moon...........................................262, 812 
Sun/Moon Numerically ..............................258 

Positive .....1297, 1298, 1300, 1301, 1328, 1416, 
1424 
Enable .....................................................1328 
object .............................................1416, 1424 
requires....................................................1328 
set..............................1298, 1300, 1301, 1328 
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Positive Boolean ..........................................1328 
Positive button..............................................1328 
Positive Metaball ............................................129 
Possible Solution..........................................1439 
Posterize ................................................728, 997 
Posterize button .............................................998 
Post-Processing Options................................427 

Setting........................................................427 
Postwork...........................................................66 
Power .............................................................339 

Director's View...........................................339 
Power Macintosh®.............................................4 
Practical Application...........................................3 
Precision............ 257, 261, 807, 810, 1417, 1425 
Preferences......................................................82 
Preferences dialog ...........................................82 
Premium.........................................................403 

select..........................................................403 
Premium AA ...................................................405 
Premium Quality.................... 405, 408, 409, 411 
Premium Quality Mode. 405, 408, 409, 411, 413, 

415 
Preset Brush Library ........................................29 
Preset Brushes...............................538, 939, 943 
Preset Category Folders ................................486 

Changing ...................................................486 
Preset Folder..........................................491, 494 

Inside .................................................491, 494 
Preset Libraries ................... 7, 29, 486, 488, 489 

Using..............................................................7 
Preset Materials Library ........ 29, 575, 998, 1193 

Mosaic........................................................998 
Preset Name ..................................495, 500, 504 
Preset Object Library .......................29, 104, 530 

access........................................................104 
use .......................................................29, 104 

Preset Objects................................................530 
Adding........................................................530 

Preset Skies Library .........................29, 504, 534 
access........................................................534 

Preset Textures Library....................................29 
Preset Views ................................................1312 
Presets ................ 5, 7, 491, 494, 495, 513, 1432 

Deleting......................................................513 
Open ..........................................491, 494, 495 

Presets Object Library dialog.........................495 
Preview ...328, 545, 660, 662, 1004, 1010, 1025, 

1027, 1194, 1201, 1207 
drag ...........................................................545 
Material Animations.................................1194 
Sky Animations........................................1207 
Terrain Animations ..................................1201 
Textures.....................................................662 

Preview Adjust Brightness .................1419, 1427 
Preview Adjust Contrast ....................1419, 1427 
Preview Animation button .......1126, 1127, 1189, 

1194, 1201, 1207 
Preview Animation popup menu......................98 
Preview Area.......1143, 1144, 1147, 1148, 1154, 

1168, 1169 
right......................................1143, 1144, 1148 
rotate .......................................................1168 

Preview Area Controls .................................1167 
Preview Display Controls.............................1168 
Preview Modes ..............................................918 
Preview Options menu.......................1126, 1127 
Preview Pan.......................................1419, 1427 
Preview Render .............................394, 424, 467 

Select.........................................................394 
Preview VCR Controls .................................1167 
Preview Window ..........................329, 500, 1210 
Preview Zoom....................................1419, 1427 
Previewer ...............................917, 918, 920, 922 

corner ........................................................922 
right............................................................918 

Previewer Color Options................................920 
Previewer Display Modes ..............................918 

change.......................................................918 
Previewing Animations ..........................98, 1148 
Previewing Options......................................1129 

Setting .....................................................1129 
Previous Frame button ................................1167 
Previous Installation Detected ...........................5 
Previous Key Frame ..........................1414, 1422 
Previous State..................................................82 

Launch.........................................................82 
Previous Ticker Mark .........................1414, 1422 
Pre-Visualizing .............................................1378 

Sequence ................................................1378 
Primitives vs...................................................105 
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Print ............................................................66, 67 
Software Program........................................66 

Print dialog .......................................................66 
Print Resolution..............................50, 435, 1208 

Change ........................................................50 
Priority ............................................................426 
Prj45 
Procedural ................... 105, 472, 647, 754, 1072 

Using........................................................1072 
Procedural Blend............................................754 
Procedural button.................................647, 1072 
Professional .....................................................66 
Program Folder ..................................................5 

Select .............................................................5 
Progress dialog ............................................1267 
Progress Panel.................................................50 

clicking .........................................................50 
Projection .......................................437, 441, 445 
Projection Types ............................................430 
Propagate.....................................................1245 

Enable......................................................1245 
Properties...........................................1107, 1439 
Property Timelines .......................................1148 
Providing ......................................................1130 
PS.................................................................1428 
PSD........................................... 41, 43, 508, 940 
PSP ..............................................................1428 
Purple .............................................................746 
Push ...............................................................767 

Position Control .........................................767 
Pyramid ........................... 109, 1340, 1343, 1348 

Converting ...............................................1343 
Creating ...........................................109, 1340 
Select .......................................................1348 

Pyramid icon ................................................1340 
Pyramid tool ...................................................109 
Q 
QTVR ...................................................435, 1209 
QTVR Panorama..................................435, 1208 
Quality ........... 397, 399, 400, 401, 403, 561, 867 

Drag ...........................................................867 
point .................................. 397, 400, 401, 403 

Quality Assurance Manager.........................1443 
Quality -The....................................................873 

Quality/Speed ................................561, 588, 592 
Detail .........................................................592 
Quality .......................................................592 
Speed ........................................................592 

Quality/Speed controls...........................561, 592 
Quantity............................................................77 
Quantity - Enter................................................77 
Quantize.........................................................728 
Quick Tour ...........................539, 645, 889, 1078 

DTE ...........................................................645 
Materials Lab.............................................539 
TE ..............................................................889 
Tree Lab ..................................................1078 

Quick-Select...................................................551 
QuickTime..................................................8, 467 
QuickTime Movie .........................................1399 
QuickTime VR......................50, 435, 1208, 1209 

rendering .....................................................50 
QuickTime VR file ............................................45 
QuickTime VR Panoramas 431, 435, 1208, 1209 

creating..................................435, 1208, 1209 
Exporting .................................................1209 
render ........................................................431 

QuickTime™ VR ............................................430 
Quit ..................................................67, 68, 1215 
R 
RA ..................................................................767 
Radial Light ....................................................135 
Radial Light Intensity ...................................1029 
Radial Light tool .............................................135 
Radiance........................................................879 
Radiance Image Maps...................................879 
Radius..................................................796, 1210 
Rainbows .....................................................1205 
Raise Edges.................................................1000 
Raise Terrain .....................................1419, 1427 
Raise/Lower ...................................................990 
RAM .............................................................1439 
Random .................619, 764, 767, 769, 771, 777 

Enable ...............................................769, 771 
Random Character.........................................979 
Random Extent ..............................................979 
Random Field.........................................764, 777 

Enable ...............................................764, 777 
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Random Field button..............................764, 777 
Random Generators...............................979, 984 
Random Noise ...............................................716 
Random Position............................................979 
Random Replicate2, 77, 1413, 1419, 1420, 1427 
Random Replication.........................................77 
Random Star Field .................................764, 766 

selecting.....................................................764 
Randomize Amount...... 201, 202, 204, 206, 207, 

209, 211, 212 
Randomize Buttons........................................661 
Randomize Sky button ...................................223 
Randomize tool .... 201, 202, 204, 206, 207, 209, 

211, 212 
Randomizing ..................................223, 661, 684 

Sky Settings...............................................223 
Textures.....................................................661 

Randomness ................................................1094 
drag..........................................................1094 

Range...................................... 1047, 1058, 1061 
define .......................................................1061 
Light .........................................................1047 

Range High ......................................................36 
Working........................................................36 

Range Low .......................................................36 
Working........................................................36 

Ranged.........................................................1061 
Selecting ..................................................1061 

Ranged Falloff ..............................................1061 
Rate..............................................................1106 
Rays ...............................................401, 403, 413 

increase .....................................................413 
Rayshade .......................................................915 
Read...................................................................5 

Bryce 6.0 Last Minute Notes .........................5 
Last Minute Notes..........................................5 
Software License Agreement ........................5 

Ready...............................................................55 
Realtime Linking.............................................937 
Real-time Linking ...........................................937 
Real-time Linking .........................................1025 
Receive Shadows ..................................636, 640 
Recent Files .....................................................67 
Recorded Area .............................................1128 
Recording Key Events..................................1114 

Recovering.....................................................516 
Disk Space ................................................516 

Red ................................................................681 
Red Oak.............................................1090, 1096 
Red, Green ....................................................575 
Redo ........................................................69, 967 
Redraw/render .............................................1127 
Re-enabling....................................................873 

Fog ............................................................873 
Reference Section .............................................3 
Reflected......................................................1434 
Reflection ......408, 449, 460, 558, 559, 561, 577, 

583, 585, 625, 872, 1334 
increase .....................................................583 
Select Waves...........................................1334 
Waves......................................................1334 

Reflection Map.....................................618, 1435 
Reflection Using.............................................585 

Setting .......................................................585 
Reflections + Transmissions..........................447 
Reflections and/or Transmissions..................457 
Reflections Disabled ......................................449 
Reflections Enabled.......................................449 
Refraction......447, 455, 539, 559, 561, 579, 580, 

585, 595 
increase .....................................................585 

Refraction Index.....................................451, 585 
Various Substances ..................................451 

Refractions Disabled......................................455 
Refractions Enabled.......................................455 
Regards .......................................................1254 

transformations........................................1254 
Registering.........................................................8 

DAZ Products ................................................8 
Regular ..........................................................400 
Reimport ......................................................1218 
Relative Coordinates ...................................1308 
Release Notes ...................................................8 
Relief Noise..................................................1000 
Remaining....................................................1050 

Color Nodes.............................................1050 
Remap .......................................441, 1004, 1155 
Remapped ...................................................1155 
Remapping...................................................1155 
Remaps........................................................1155 
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Remember....................................................1224 
Remove................................................900, 1050 

Color ........................................................1050 
Gradient .....................................................900 

Remove Keyframe button ............................1123 
Remove Shear .............................................1237 
Rename button...............................................481 
Rename Pict dialog ........................................481 
Renaming.......................................................481 

Pictures......................................................481 
Render 50, 55, 61, 273, 285, 339, 393, 397, 400, 

401, 403, 431, 435, 464, 525, 872, 873, 878, 
1067, 1068, 1208, 1411, 1413, 1419, 1420, 
1426 
Director's View...........................................339 
Disk ..............................................................50 
Disk dialog .................................50, 435, 1208 
HDRI ..........................................................872 
Network........................................................55 
QuickTime VR..............................................50 
QuickTime VR Panorama..........................431 
Wireframe ..................................................273 
wireframe view.............................................61 

render a wireframe view...................................61 
Render Against Neutral........................873, 1027 
Render All.......................................................392 
Render All button ...................................285, 392 
Render Animation ...... 55, 61, 1399, 1411, 1413, 

1419, 1420, 1426 
Render Animation dialog....... 55, 61, 1399, 1411 
Render button .... 285, 301, 331, 435, 466, 1208, 

1209, 1316, 1322, 1325, 1330, 1334, 1350, 
1363, 1367, 1399 
press ..........................................................331 

Render Controls ..... 13, 284, 286, 394, 395, 399, 
413, 415, 424, 426, 427, 428, 430, 431, 435, 
437, 441, 445, 449, 451, 454, 455, 457, 459, 
463, 467, 1414, 1422 

Render HDRI Image.......................................873 
disable........................................................873 

Render Image ................................................878 
Render Mode ...............................................1436 
Render on Network ..........................................55 
Render Options .... 394, 395, 397, 399, 400, 401, 

403, 405, 408, 409, 411, 413, 415, 424, 427, 
430, 431, 437, 441, 445, 449, 451, 454, 455, 
457, 459 

selecting ....................................................431 
Render Options dialog ..399, 400, 401, 403, 413, 

415, 424, 426, 427, 430, 431, 437, 441, 445, 
873 
entering..............................................413, 415 

Render Options menu....................403, 430, 463 
end.............................................................463 

Render Priority ...............................................426 
Render Progress..............................................50 
Render Quality ...............................................397 
Render Reporting...........................................428 
Render Resolution ...................................31, 464 

Select...........................................................31 
Render Settings ...............................................31 
Render Time ..................................................867 
Render To Disk ....................................435, 1208 
Render View button .....................................1167 
Render Wireframe View...................................61 
Render With Neutral Ground .........500, 525, 545 
Render With Neutral Sky495, 500, 521, 525, 545 
Render With Textures............................395, 424 
Rendered Boolean.......................................1350 
Rendered Preview .........................................936 
Repair Permissions......................................1438 
Repeat Tiling..........................................623, 624 
Replace..........................................476, 478, 607 

2D ..............................................................607 
RGB...........................................................476 

Replace Current 2D Texture Using Copy/Paste
...................................................................609 

Replace Current 2D Texture Using Load Button
...................................................................607 

Replace Picture..............................................476 
Replicating .................................................72, 77 

Bryce Trees .................................................77 
Report Render Time ......................................428 
Reposition Interactively................................1295 
Reposition tool ......170, 171, 173, 175, 176, 197, 

1316, 1330, 1334, 1344 
arms.........................................................1316 
Use ........................................197, 1316, 1334 
Y-axis.......................................................1344 

Repositioning .........165, 170, 171, 173, 176, 335 
Camera......................................................335 
X-Axis ........................................................170 
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Y-Axis.........................................................171 
Z-Axis.........................................................173 

Represent.................................................31, 390 
Camera's....................................................390 
Document Resolution ..................................31 

Representations ...........................................1155 
Requires.......................................................1328 

Positive ....................................................1328 
Resaving ......................................................1439 

TIF file ......................................................1439 
Reselect ...................................................29, 928 
Reset 31, 38, 39, 82, 830, 896, 931, 1008, 1161, 

1236, 1435 
Clamp Minimum.........................................931 
Clipping Bracket.........................................896 
Cloud Speed ..............................................830 
Curve Editor View....................................1161 
Defaults........................................................82 
Undo/Redo.......................................31, 38, 39 
Unity.........................................................1236 
Y-rotation .................................................1435 

Reset All Palettes...........................................102 
Reset button.........................................823, 1168 
Reset Camera Banking ......................1414, 1422 
Reset Camera Origin Point ................1414, 1422 
Reset Clamps.......................................931, 1436 
Reset Clamps option....................................1436 
Reset Clipping Bracket.......................1419, 1427 
Reset Cloud Speed ........................................830 
Reset Control .................................................663 
Reset Field .........................................1414, 1422 

View ...............................................1414, 1422 
Reset Gradient Bar ............................1419, 1427 
Reset Object ................................................1285 

Unity Size/Rotation ..................................1285 
Reset Palettes..................... 82, 102, 1414, 1422 
Reset Pan Tool ..................................1414, 1422 
Reset Sky...............................................221, 223 

choosing ....................................................223 
Reset to Unity...............................................1236 
Reset Views ...................... 333, 344, 1414, 1422 
Resize 145, 147, 150, 153, 165, 175, 903, 1276, 

1292 
Numerically ..............................................1276 
X-Axis.........................................................145 

Y-Axis ........................................................147 
Z-Axis ........................................................150 
Zoom Area.................................................903 

Resize tool ....145, 147, 150, 153, 154, 155, 157, 
984, 1276, 1286, 1316, 1330, 1340, 1344, 
1363, 1364 
Camera Space...........................................154 
center...............................................153, 1316 
Resize Using ...........................................1276 
Use ..........................................................1330 
X-axis...............................................145, 1364 
Y-axis.....................................147, 1340, 1364 
Z-axis...............................................150, 1364 

Resize Using................................................1276 
Keyboard .................................................1276 
Resize Tool..............................................1276 

Resolution ............................................291, 1311 
Resolution tool ...............................................291 
Respect..........................................................166 

World Space..............................................166 
Rest................................................................905 

Terrain Canvas..........................................905 
Restore ........................................................1285 
Resume....................................................61, 334 

Fly-around .................................................334 
Resume Render.........273, 393, 466, 1419, 1426 
Resume Render button..................................285 
Return .........272, 273, 494, 495, 897, 937, 1214, 

1215, 1219, 1223, 1316, 1330 
Bryce ...........494, 495, 937, 1214, 1215, 1219 
Bryce button ..................................1214, 1215 
clicking.....................................................1215 
DS............................................................1223 
grayscale ...................................................897 
Wireframe......................272, 273, 1316, 1330 

Return/Enter...................................................334 
Revert ....41, 945, 1413, 1419, 1420, 1427, 1433 

Default Brush.............................................945 
Save ..............................................1420, 1433 
Saved ................................................41, 1413 
Terrain ...........................................1419, 1427 

RGB 25, 476, 479, 575, 576, 594, 676, 681, 682, 
773, 869 
get..............................................................479 
replace.......................................................476 
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want ...........................................................479 
RGB Color Picker.............................................28 
RGB Image ....................................................475 
RGB Image window ...............................476, 479 
RGB window ..................................................479 
RGM...............................................................915 
Ribbon........................... 1133, 1252, 1414, 1422 
Ridged Multifractal .........................................970 
Riggs ............................................................1443 
Right ..... 180, 183, 186, 189, 214, 228, 322, 328, 

331, 333, 334, 335, 341, 506, 662, 895, 899, 
918, 1077, 1143, 1144, 1148, 1177, 1180, 
1199, 1237, 1294, 1343, 1378, 1381, 1388, 
1406 
Align tool ........................... 180, 183, 186, 189 
Animation.................................................1381 
Combination...............................................506 
Deep Texture Editor...................................662 
Edit Palette ..............................................1343 
Edit Terrain/Object tool ..............................214 
Min/Max ...................................................1077 
Origin .......................................................1237 
Preview Area ...................... 1143, 1144, 1148 
previewer ...................................................918 
Select Views icon.......................................334 
Selection Palette........................................322 
Switch ......................................................1388 
Terrain Canvas ........................895, 899, 1199 
timelines...................................................1406 
Working Window......................................1378 

Right Ascension .............................................767 
Right View ..............................................328, 333 
Right-click+hold..............................................269 

Marker Pen tool .........................................269 
Rings ..........................................................1, 796 

Saturn ............................................................1 
Rip To Screen ................................................937 
RND........................................................693, 716 
RND Continuous .. 693, 707, 708, 709, 710, 716, 

728, 729, 730, 731, 737, 741 
RND Discrete .........................................693, 716 
RND Linear ....................................693, 708, 716 
RND Lines......................................693, 716, 731 
RND Saw................................................693, 716 
Robin ..............................................................451 

Robin Wood ...................................................585 
Rock, Imported Mesh.......................................85 
Rocks ...............................................................48 
Rocky .................................................1322, 1330 
Roller Ball.........................................2, 873, 1437 

move........................................................1437 
Rotate ........................................................873 

Rolling ............................................368, 378, 970 
Hills............................................................970 

Roof ...................................................1348, 1355 
Moving .....................................................1355 

Rosetta...........................................................426 
Rotate ...162, 163, 164, 166, 175, 378, 431, 873, 

1168, 1237, 1241, 1312 
Camera View.............................................378 
Director's View...........................................378 
HDRI..........................................................873 
Preview Area ...........................................1168 
Roller Ball ..................................................873 
X-Axis ........................................................162 
Y-Axis ........................................................163 
Z-Axis ........................................................164 

Rotate Camera Numerically...........................378 
Rotate Fields................................................1241 
Rotate Interactively ......................................1292 
Rotate Numerically.......................................1292 
Rotate tool..162, 163, 164, 165, 166, 1292, 1361 

X-axis.........................................................162 
Y-axis.........................................................163 
Z-axis.........................................................164 

Rotation..................................................708, 722 
Rotation Control .............................................629 
Rotation tool...............165, 166, 175, 1185, 1330 

Camera Space...........................................175 
Locate......................................................1330 

Round Edges .................................................994 
Round Hills.....................................................970 
Round Parallel Light tool................................137 
Round Parallel Lights.....................................137 

create.........................................................137 
Rounded Dunes.............................................970 
Run ........................................................63, 1432 

Bryce .......................................................1432 
Bryce Lightning............................................63 

Russian Olive.....................................1090, 1096 
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S 
Sample Scenes ..................................................5 
Sampling ........................................................642 

Blur.............................................................642 
Sampling Blur.................................................642 
Saturation.......................................676, 681, 682 
Saturn.................................................................1 

rings ...............................................................1 
Save . 39, 41, 43, 45, 47, 48, 50, 55, 61, 82, 123, 

222, 334, 435, 484, 489, 517, 664, 914, 915, 
931, 1061, 1073, 1105, 1154, 1169, 1209, 
1219, 1223, 1224, 1267, 1399, 1411, 1413, 
1420, 1433, 1435, 1438 
Bryce........................................................1223 
Camera Preview Positions ......................1169 
choose .........................................................39 
Fly-around..................................................334 
Frame Positions.......................................1154 
Gradients .................................................1061 
HDRI ........................................................1433 
IBL............................................................1435 
IBL info.....................................................1435 
Light Settings ...........................................1073 
Materials Presets Library.........................1061 
Objects Presets Library ...........................1061 
PICT.............................................................82 
Revert ........................... 41, 1413, 1420, 1433 
Sky.............................................................222 
Textures.....................................................664 
Tree............................................................123 
Tree Lab Settings ....................................1105 
Tree Presets ..............................................123 

Save As........... 41, 879, 1215, 1413, 1420, 1438 
Save As dialog ....... 43, 45, 47, 48, 50, 914, 931, 

1267 
Save button ............................... 435, 1208, 1267 
Save dialog ...... 41, 435, 484, 1208, 1212, 1399, 

1411 
Save Image As...........................................43, 45 
Save List button .............................................484 
Save Preset Tree ...............................1416, 1424 
Save versus Save As ...................................1438 
Saved Views ......................................1414, 1422 
Saw Wave ......................................................728 
Sawtooth ........................................................998 

Sawtooth waveform .......................................998 
SawWave.......................................................728 
Scale .904, 1099, 1118, 1280, 1282, 1283, 1284, 

1286, 1379, 1418, 1426 
Animation Duration..................................1118 
drag .........................................................1099 
Objects ..........................................1418, 1426 
Objects Interactively ......................1418, 1426 
timeline ..........................................1118, 1379 
Zoom Area.................................................904 

Scale - Select...................................................36 
Scale Along..................................................1278 

Single Axis...............................................1278 
Scale Animation button................................1118 
Scale button .................................................1109 
Scale Control .................................................627 
Scale Indicator .............................................1118 
Scale Object.................................................1278 
Scale Pict Size ...............................................624 
Scale Terrain..................................................905 

Zoom Area.................................................905 
Scale Translation .............................................76 

selecting ......................................................76 
Scale Zoom Area ...........................................904 

Fill Canvas.................................................904 
Scaling tool ....................1224, 1286, 1379, 1406 

Drag.........................................................1406 
use...........................................................1379 

Scene.......324, 530, 534, 873, 1027, 1215, 1371 
Change Your Viewpoint...........................1371 

Scene Files ........................................................7 
Scene files saved.........................................1437 
Scene Open/Save............................................82 
Sci-fi ...............................................................998 
Scotts Pine.........................................1090, 1096 
Screen............................................................937 

Rip .............................................................937 
Screen Refreshing .......................................1436 
Screen-resolution VR...........................435, 1208 

setting ..............................................435, 1208 
Screensaver...................................................430 
Scrubber ..............1110, 1114, 1381, 1414, 1422 

called .............................................1110, 1114 
Drag.........................................................1381 
move..............................................1414, 1422 
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Seagrape............................................1090, 1096 
Seamlessly.............................................430, 623 
Search button...................................................55 
Search/replace .............................................1224 
Secondary Ring....................................796, 1436 

enable ........................................................796 
Segment.............................................1082, 1083 

Number ....................................................1082 
Select . 5, 25, 31, 36, 76, 77, 272, 273, 291, 296, 

310, 312, 315, 316, 317, 335, 356, 358, 359, 
364, 366, 367, 372, 394, 399, 400, 401, 403, 
430, 431, 437, 441, 445, 483, 649, 764, 836, 
910, 914, 922, 924, 931, 945, 969, 984, 1014, 
1033, 1050, 1061, 1130, 1134, 1180, 1210, 
1219, 1238, 1275, 1348, 1355, 1367, 1416, 
1424 
Add Polygons.....................................922, 924 
Altitude Mask .....................................441, 445 
Auto LOD ...................................................291 
Camera ........... 335, 356, 358, 359, 372, 1180 
Center Scene.............................................364 
Center Selection ........................................366 
Close button...................................................5 
Color Node...............................................1050 
Convert Maps ..........................................1219 
Deep Texture Editor...................................649 
Default........................................................399 
Default Brush .............................................945 
Default Render...........................................273 
Default Wireframe..............................272, 296 
Distance Rendered ....................................441 
Eye-Level Camera .....................................367 
fractal .........................................................969 
Grid ............................................................922 
Group.......................................................1355 
MetaStream file..........................................931 
New..............................................................25 
None ........................................................1014 
OBJ............................................................914 
Object Mask...............................................437 
Objects................................ 1275, 1416, 1424 
OpenGL Mode ...........................................296 
Panorama ..................................................431 
Perspective Projection...............................430 
Plug-In Folder ............................................483 
Premium ....................................................403 

Preview Render.........................................394 
Program Folder..............................................5 
Pyramid ...................................................1348 
Random Star Field ....................................764 
Ranged ....................................................1061 
Regular ......................................................400 
Render Options .........................................431 
Render Resolution.......................................31 
Scale Translation.........................................76 
Show Origin Handle ................................1238 
Spherical Clouds .......................................836 
Spotlight...................................................1033 
Super .........................................................401 
Tile East.....................................................984 
Torus .......................................................1210 
Visible Brush..............................................910 
Wall..........................................................1367 

Select All ..81, 311, 321, 1275, 1369, 1413, 1420 
Type...........................................................311 

Select All button...............................................55 
Select All Groups ...........................................316 
Select All Meshes ..........................................315 
Select All Paths..............................................317 
Select Blend Transparency............................602 
Select By Type...............................................322 
Select Camera .............................314, 357, 1388 
Select Camera View ......................................381 
Select Clamp Maximum.................................931 
Select Clamp Minimum..................................931 
Select Cloud Types........................................220 
Select Color ...................................................276 
Select Cubes icon..............................1358, 1363 

Selection Palette ...........................1358, 1363 
Select Edit........................................................70 
Select Families button .................................1394 
Select Families icon.....................................1361 

Selection Palette .....................................1361 
Select File ....................................31, 1373, 1411 
Select Group..................................................316 
Select Inverse ................................................319 
Select Keep Gradient.....................................899 
Select Meshes ...............................................315 
Select None ...................................................322 
Select Objects dialog ...................................1224 
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Select Options menu....................................1388 
Select Paths ...................................................317 
Select Plug-ins Folder ....................................483 
Select Pyramid icon .....................................1350 
Select Sphere icon .......................................1350 

Selection Palette......................................1350 
Select Sphere tool........................................1385 
Select Storyboard.........................................1127 
Select Terrain.....................................1316, 1322 
Select Views. 333, 334, 339, 344, 346, 349, 351, 

353, 1414, 1422 
clicking .......................................................333 
drag............................................................333 
position.......................................................333 

Select Views icon ...................................334, 344 
right ............................................................334 

Select Visible Brush .......................................910 
Select Web Links ...........................................318 
Select World Space......................................1286 
Selected Object............. 1414, 1419, 1422, 1427 

Toggle Hierarchy ...........................1419, 1427 
Selected Object Types ...................................323 

Step Sequentially Through Objects ...........323 
Selected Resolution .............................291, 1267 

change .....................................................1267 
Selecting Objects .........................................1297 
Selection....... 99, 284, 322, 349, 357, 386, 1233, 

1242, 1254, 1297, 1416, 1424 
Center ................................................349, 386 
display........................................................357 
Zoom..........................................................284 

Selection Mode ..............................................349 
Center ........................................................349 

Selection Palette .... 16, 314, 315, 316, 317, 318, 
319, 321, 322, 323, 324, 325, 1330, 1334, 
1350, 1358, 1361, 1363, 1364, 1374, 1379, 
1385, 1394, 1403 
back .........................................................1385 
display......................................................1330 
Infinite Planes icon...................................1334 
right ............................................................322 
Select Cubes icon..........................1358, 1363 
Select Families icon.................................1361 
Select Sphere icon...................................1350 
Solo Mode button.....................................1374 

Selection’s................................1298, 1300, 1301 
Selector..........................................................645 
Self Shadows.................................................641 
Semi-transparent .................................228, 1067 
Sequencer......................1107, 1147, 1148, 1167 
Sequencer Area...........................................1154 
Service Pack ......................................................4 
Services .............................................................8 
Set 31, 38, 50, 55, 61, 65, 66, 81, 222, 228, 232, 

266, 275, 291, 328, 337, 380, 386, 413, 415, 
427, 435, 449, 454, 561, 566, 567, 568, 570, 
571, 572, 573, 574, 576, 577, 585, 595, 720, 
724, 764, 766, 767, 769, 771, 773, 777, 784, 
788, 791, 816, 827, 828, 829, 830, 832, 833, 
873, 894, 895, 922, 949, 950, 1014, 1031, 
1080, 1106, 1109, 1110, 1113, 1114, 1116, 
1118, 1129, 1199, 1208, 1233, 1238, 1240, 
1241, 1267, 1298, 1300, 1301, 1328, 1343, 
1381, 1416, 1424 
Ambience Using ........................................572 
Ambient .............764, 766, 769, 771, 773, 777 
Ambient Color....................................570, 571 
Ambient Color Using .................................572 
Animation Range.....................................1113 
Background Contents..............................1014 
Bryce .......................................................1343 
Camera Trajectory...................................1381 
Clipping Range..........................................894 
Cloud Cover...............................................830 
Cloud Height..............................................832 
Cloud Motion .............................................827 
Cloud Speed..............................................827 
Cloud Turbulence ......................................828 
Current Time............................................1114 
Custom DPI .................................................65 
density/amount ..........................................232 
Diffuse Color......................................567, 595 
Diffusion.............................................561, 568 
Diffusion Using ..........................................568 
Direction ....................................................829 
Disk Size....................................................784 
dpi..............................................50, 61, 65, 66 
Field...........................................................380 
Focal Length......................................413, 415 
FOV ...........................................................380 
Frame Rate..............................................1110 
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Frequency..................................................833 
grayscale ...................................................949 
Haze...........................................................773 
Lens Radius.......................................413, 415 
Linear .........................................................873 
Max Recommended...................................275 
Maximum Ray Depth .........................449, 454 
Memory Dots .............................................222 
metaball's.......................................1416, 1424 
Metallicity Using.........................................577 
Nano ..........................................................328 
Negative...................................................1233 
None ..........................................................724 
NumLock..........................................31, 38, 81 
object’s................................ 1238, 1240, 1241 
Origin ...............................................386, 1238 
Phase.........................................................720 
Positive ..................... 1298, 1300, 1301, 1328 
Post-Processing Options ...........................427 
Previewing Options..................................1129 
Reflection Using.........................................585 
screen-resolution VR .......................435, 1208 
Shadow......................................................228 
sharpness/softness..................................1031 
Specular Color ...........................................573 
Specular Color Using.................................574 
Specular Halo Using ..................................576 
Specularity .........................................573, 574 
Specularity Using.......................................574 
Star Field Position......................................767 
Star Intensity..............................................773 
Sun Color...........................................266, 816 
Sun/Moon ..................................................816 
Sun/Moon Disk Intensity ............................788 
Sun/Moon Glow Intensity...........................791 
Terrain........................................................950 
Terrain Clipping Bracket ..........................1199 
Terrain Solid ..............................................895 
Timeline Scale .........................................1118 
Up ......................................... 337, 1109, 1116 

Set As Unity .......................................1236, 1237 
Set button...........................................1399, 1411 
Set Field .........................................................380 

View Numerically .......................................380 

Set Focal Length Automatically .....................413 
Set Focal Length Manually ............................415 
Set Link Camera ................................1183, 1184 

Object ......................................................1184 
Object Interactively..................................1183 

Set NumLock ...........................1420, 1422, 1424 
Set Object Attributes..........................1416, 1424 
Set Preview Size....................................908, 935 

Choose ......................................................908 
Set To Current Selection ...............................413 
Set To Current Selection button ....................413 
Set Track Object ..........................................1174 
Set Track Object Interactively......................1172 
Set Up ................................................................3 
Settings ............................................................63 
SGI.........................................................508, 940 
Shaded Color .................................................920 
Shaded Preview.............................................920 
Shaded Tessellation Examples .....................926 
Shading..........................................582, 639, 918 

Mode Modifiers ..........................................639 
Shadow Ambience.............................1035, 1038 

change.....................................................1035 
Shadow Color ..............................................1035 
Shadow Control .............................................228 
Shadows ................228, 230, 288, 405, 457, 459 

Enabling.....................................................457 
set..............................................................228 
Use ............................................................228 

Shadows Disabled .........................................457 
Shadows Enabled..........................................457 
Shadows Off button .......................................288 

change.......................................................288 
Shadows On button .......................................288 

change.......................................................288 
Shadows On/Off.............................................288 
Shape.......................................1090, 1096, 1328 

Negative ..................................................1328 
Sharpness......................................................781 
Sharpness/softness .....................................1031 

set............................................................1031 
Shattered Hills................................................970 
Shorten ........................................................1113 

Animation Range.....................................1113 
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Show ......... 55, 328, 732, 873, 1133, 1243, 1267 
Boolean....................................................1267 
Camera's View...........................................328 
contrast/brightness ....................................732 
Director's View...........................................328 
Enable............................................1133, 1243 
HDRI ..........................................................873 
IP 55 
Motion Path..............................................1133 

Show All/Show Animated...................1419, 1427 
Show Always................. 1135, 1180, 1250, 1394 

Enable......................................................1135 
Show FOV..............................................372, 373 

Disable.......................................................373 
Enable........................................................372 

Show Handles ..............................................1252 
Show Object As Box ....................90, 1413, 1420 
Show Object As Lattice ....................................91 
Show Objects As Mesh......................1413, 1420 
Show Only....................................................1134 

Enable......................................................1134 
Show Origin Handle .................. 385, 1238, 1244 

enable ........................................................385 
selected ...................................................1238 

Show Origin Handle button ................1185, 1244 
Enable......................................................1244 

Show Selected Path...........................1414, 1422 
Show Tangents ..................................1252, 1394 
Show When Selected.............. 1134, 1180, 1250 

enable ......................................................1180 
Silver Maple .......................................1090, 1096 
Simple Black Background ..............................878 
Sin ..................................................................729 
Since Bryce ....... 71, 517, 633, 1136, 1182, 1297 
Since Geometric Paths ....................................94 
Since Stones ..................................................123 
Since TIR........................................................451 
Sine Wave......................................................729 
Single Axis....................................................1278 

Scale Along..............................................1278 
Single Object..........................................421, 423 

Turn AA Off................................................421 
Turn AA On................................................423 

Sinusoidal.......................................................617 

Size ..........................269, 946, 1224, 1237, 1241 
Marker Pen................................................269 

Size Doubled................................................1433 
Size Fields ...................................................1241 
Size menu ......................................................928 
Size/resolution ...............................................928 
Skewing .......................................................1286 

Objects ....................................................1286 
Skies ....................309, 504, 512, 513, 534, 1176 

Animating...................................................309 
Applying.....................................................534 

Skin ..............................................................1214 
Sky ......15, 29, 99, 102, 218, 219, 220, 221, 222, 

223, 228, 232, 234, 235, 237, 238, 240, 241, 
242, 243, 245, 248, 250, 252, 253, 256, 257, 
258, 260, 261, 262, 265, 266, 309, 405, 504, 
534, 570, 571, 649, 764, 766, 769, 771, 777, 
781, 783, 784, 788, 791, 793, 796, 801, 802, 
804, 806, 807, 808, 810, 812, 814, 815, 816, 
818, 821, 822, 823, 825, 827, 828, 829, 830, 
832, 833, 834, 835, 836, 841, 843, 845, 849, 
852, 853, 856, 857, 863, 865, 867, 869, 873, 
886, 887, 1122, 1176, 1203, 1204, 1205, 
1206, 1325, 1326 
Adjusting..................................................1326 
Animating.........................................887, 1203 
clicking......228, 232, 234, 235, 237, 238, 241, 

242, 243, 245, 248, 250, 252, 253, 256, 
257, 258, 261, 262, 265, 266, 405, 649, 
764, 766, 769, 771, 777, 781, 783, 784, 
788, 791, 793, 796, 801, 802, 804, 806, 
807, 808, 810, 812, 814, 815, 816, 818, 
821, 822, 823, 825, 827, 828, 829, 830, 
832, 833, 834, 835, 836, 841, 843, 845, 
849, 852, 853, 856, 857, 863, 865, 867, 
869, 873 

Display......228, 232, 234, 235, 237, 238, 241, 
242, 243, 245, 248, 250, 252, 253, 256, 
257, 258, 261, 262, 265, 266, 405, 649, 
764, 766, 769, 771, 777, 781, 783, 784, 
788, 791, 793, 796, 801, 802, 804, 806, 
807, 808, 810, 812, 814, 815, 816, 818, 
821, 822, 823, 825, 827, 828, 829, 830, 
832, 833, 834, 835, 836, 841, 843, 845, 
849, 852, 853, 856, 857, 863, 865, 867, 
869, 873, 1176, 1204, 1205, 1326 

make..........................................................219 
Saving........................................................222 

Sky & Fog ....................................................1439 
Sky Animations ............................................1207 
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Previewing ...............................................1207 
Sky Color........................................................225 
Sky Dome..... 242, 253, 265, 764, 766, 769, 771, 

773, 777, 804, 822 
use .............................................................265 

Sky Dome Blue ..............................................804 
Sky Dome Color .....................................253, 804 
Sky Dome Peach ...........................................804 
Sky DomeColor ......................................253, 804 
Sky Integration ...............................................638 
Sky Lab .... 2, 19, 22, 89, 97, 221, 222, 228, 230, 

232, 234, 235, 237, 238, 241, 242, 243, 245, 
248, 250, 252, 253, 258, 260, 262, 265, 266, 
405, 504, 649, 764, 766, 769, 771, 773, 777, 
781, 783, 784, 788, 791, 793, 796, 801, 802, 
804, 806, 808, 810, 812, 814, 815, 816, 818, 
821, 822, 823, 825, 827, 828, 829, 830, 832, 
833, 834, 835, 836, 841, 843, 845, 849, 852, 
853, 856, 857, 863, 865, 867, 869, 873, 879, 
887, 1111, 1203, 1207, 1413, 1414, 1420, 
1422, 1436, 1437 
access..................................................97, 221 
Cloud Cover...............................241, 242, 243 
exit ...................................................873, 1436 

Sky Lab button ..... 221, 258, 262, 405, 649, 764, 
766, 769, 771, 777, 781, 783, 784, 788, 791, 
793, 796, 801, 802, 804, 806, 808, 810, 812, 
814, 815, 816, 818, 821, 822, 823, 825, 827, 
828, 829, 830, 832, 833, 834, 835, 836, 841, 
843, 845, 849, 852, 853, 856, 857, 863, 865, 
867, 869, 873, 887, 1176, 1204, 1205 

Sky Lab dialog.... 309, 504, 534, 887, 888, 1176, 
1203, 1204, 1205 
display........................................................888 

Sky Lab Preview ..........................................1207 
Sky Library ...............................................2, 1433 
Sky Memory Dots...............................1326, 1435 
Sky Mode Comparison...................................226 
Sky Modes............................. 224, 225, 226, 227 
Sky Only .........................................................328 
Sky Preset ....................................................1325 

Adding......................................................1325 
Sky Presets Library ................................222, 504 

use .............................................................222 
Sky Preview ...........................................773, 873 
Sky Settings ...................................................223 

Randomizing..............................................223 
Slick Rock.......................................................970 

Slope......................................................686, 735 
Slope Noise....................................................992 
Slow ...........................................334, 1417, 1425 

Fly-around .................................................334 
Slow Down Fly-around View..............1414, 1422 
Smidge...........................................................984 
Smooth.......................................912, 1008, 1394 

Camera’s .................................................1394 
Camera's Trajectory ................................1394 
Choose ......................................................912 

Smooth button..........................1008, 1212, 1316 
press........................................................1008 

Smooth Clip ...................................................739 
Smooth Clip aX+b..........................................739 
Smooth Shaded .....................................294, 296 
SMPTE...............................................1109, 1114 
SMPTE Time..........................................36, 1130 
Smudge Tool..................................................879 

use.............................................................879 
SnagIt...............................................................66 
Snap.................................77, 191, 194, 196, 197 

activate ......................................................197 
choose .......................................................197 
Grid............................................................191 
Ground...............................................194, 196 
Land.....................................................77, 197 
use.............................................................197 
World Center .............................................194 

Snap To Ground ..........................................1224 
Snap Together ...............................................193 
Snapshot Tool..................................................66 

use...............................................................66 
Snow ..............................................................687 
Snow Puddles ........................................724, 741 
Soft Shadows.............403, 405, 801, 1035, 1038 

Drag.........................................................1038 
Enable ...............................................405, 801 

Soft Sky..........................................224, 225, 226 
changes .....................................................224 

Softening......................................................1008 
Harsh Transitions ....................................1008 

Softness .................................................781, 783 
Drag...........................................................783 

Software License Agreement.............................5 



Bryce 6 Artist Guide 

©2007 DAZ 3D, Inc.  1510 

Read ..............................................................5 
Software Program ............................................66 

Printing.........................................................66 
Solid .......................................................895, 911 

Choose.......................................................911 
Solid When Boolean Rendering...................1212 
Solo ....................................................1297, 1374 

change .....................................................1374 
Solo Mode ......................... 322, 325, 1364, 1374 

entering......................................................325 
Solo Mode button .. 325, 1364, 1367, 1374, 1394 

Selection Palette......................................1374 
Source Generators.................................968, 992 
South ..............................................................984 
Space Bar.........................................................99 

press ............................................................99 
Spacebar ...... 305, 334, 495, 500, 521, 525, 662, 

955, 1160 
Press........................................334, 662, 1160 
Using..........................................................305 

Spacebar+Drag..... 917, 1414, 1419, 1422, 1427 
Sparse RND Paths.................................693, 716 
Spatial Options...............................154, 165, 175 
Special Effects ...............................................995 
Specific Area ......................................1414, 1422 

Zoom Into.......................................1414, 1422 
Specific Side ......................................1278, 1283 
Spectrum..........................................................25 

display..........................................................25 
Specular .........................................561, 575, 594 
Specular Color .............. 557, 573, 574, 635, 636 

adding ........................................................573 
Setting........................................................573 

Specular Color Using .....................................574 
Setting........................................................574 

Specular Halo........ 557, 561, 575, 576, 594, 671 
Specular Halo Using ......................................576 

Setting........................................................576 
Specularity.... 557, 558, 561, 573, 574, 579, 599, 

625, 635, 636, 671, 872, 873, 1433 
increase .....................................................873 
set ......................................................573, 574 
think ...........................................................573 

Specularity Lesson.........................................575 
Specularity Using ...........................................574 

Setting .......................................................574 
Speeding......................467, 760, 761, 827, 1204 

Adjust.......................................................1204 
Up Filtering ................................................761 
Up Noise....................................................760 
Up Phase...................................................761 
Up Renders ...............................................467 

Sphere .............105, 106, 419, 1344, 1348, 1385 
Choose ....................................................1385 
Creating .....................................................106 
point...........................................................419 
Use ..........................................................1348 

Sphere - Replicated .........................................77 
Sphere To ......................................................310 
Sphere tool.....................................................106 
Sphere’s.............................................1348, 1385 
Sphere’s wireframe......................................1348 
Spherical ................................................243, 617 
Spherical Clouds....................................243, 836 

Enable .......................................................836 
Selecting....................................................836 

Spikes ............................................................995 
Spiral............................................................1103 
Spline .............................................................687 

performs ....................................................687 
Spline Interpol ................................................683 
Spotlight Spread ..........................................1033 
Spotlight tool ..................................................136 
Spotlights .............................................136, 1033 

create.........................................................136 
Select.......................................................1033 
Spread .....................................................1033 

Spray Rendering..........................................1436 
Spray Rendering From Render Mode............273 
Spray Rendering From Wireframe.................272 
Spray Rendering tool ...................272, 273, 1436 

Advanced Display..............................272, 273 
Press .........................................................272 

Spread .........................................................1033 
Spotlight...................................................1033 

Square .......................2, 35, 633, 705, 873, 1061 
Square Edges ................................................994 
Square Edges tool .......................................1000 
Square Lines..........................................693, 716 
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Square Spotlight tool......................................138 
Square Spotlights...........................................138 

create.........................................................138 
Squared Falloff .............................................1061 
Squashed Cone .............................................110 

create.........................................................110 
Squashed Cube .............................................108 

create.........................................................108 
Squashed Cylinder.........................................107 

create.........................................................107 
Squashed Pyramid.........................................109 

create.........................................................109 
Squashed Sphere ..........................................106 

create.........................................................106 
SR2 ..............................................................1224 
Stacked, Staggered......................................1103 
Standard.........................................................707 
Standard Daylight...........................................226 
Stands ..........................................................1350 

Ungroup ...................................................1350 
Star................................ 764, 766, 769, 771, 777 

Enable....................... 764, 766, 769, 771, 777 
Star Field Amount ..........................................771 
Star Field Glow...............................................773 
Star Field Intensity .........................................769 
Star Field Position ..........................................767 

set ..............................................................767 
Star Field Position Control .....................767, 777 
Star Fields ......................................764, 766, 767 

add.....................................................764, 766 
Customizing ...............................................767 

Star Intensity ..................................................773 
set ..............................................................773 

Stars Amount .................................................771 
changing ....................................................771 

Start......................... 55, 61, 96, 964, 1414, 1422 
Move ..............................................1414, 1422 
New Terrain ...............................................964 
wireframe .....................................................96 

Start Fly-around .................................1414, 1422 
State .............................................................1133 

Motion Path..............................................1133 
Static ..............................................................291 
Static Objects via Poser Export ...................1224 

Importing..................................................1224 
Static Objects via Studio Export ..................1219 

Importing..................................................1219 
Static Objects via Studio Link ......................1214 

Importing..................................................1214 
Status.........................................................55, 63 
Step Sequentially Through all Objects...........324 
Step Sequentially Through Families ..............325 
Step Sequentially Through Object Types ......322 
Step Sequentially Through Objects ...............323 

Selected Object Types ..............................323 
Steve Lareau................................................1443 
Stone Cliff ..............................................693, 716 
Stone Object ..................................................123 

create.........................................................123 
Stone Object tool ...........................................123 
Stone-like .......................................................123 
Stones..................................................123, 1212 

Creating .....................................................123 
Stones Preset Materials Library.....................123 
Stop................................................................936 

Auto Rotate................................................936 
Stop button.....................1167, 1194, 1201, 1207 

press........................................................1167 
Stop Fly-around .................................1414, 1422 
Storyboard ...............98, 1127, 1194, 1201, 1207 

Additional Features .................................1127 
corresponding..........................................1127 

Storyboard Preview .....................................1127 
Using .......................................................1127 

Stratus...225, 242, 649, 822, 823, 825, 827, 828, 
829, 830, 834, 835, 836 
color...........................................................225 

Stratus Clouds .......................242, 243, 822, 836 
Activate......................................................822 
Adding .......................................................242 

Streak Paper ..................................................276 
Stretched Cone..............................................110 

create.........................................................110 
Stretched Cube..............................................108 

create.........................................................108 
Stretched Cylinder .........................................107 

create.........................................................107 
Stretched Pyramid .........................................109 

create.........................................................109 
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Stretched Sphere ...........................................106 
create.........................................................106 

Structure.........................................................670 
Stucco Noise ..........................................693, 716 
Studio .......................................................5, 1222 

link............................................................1222 
Sub-Category File ..........................................495 

Deleting......................................................495 
Subcontours ...................................................999 
Submenu..........................................................16 

display..........................................................16 
Submenus ........................................................16 

Displaying ....................................................16 
Subplateaus .................................................1001 
Subtract ..........................................................749 
Sugar Maple.......................................1090, 1096 
Sum................................................................570 

Ambience...................................................570 
Sun ... 19, 94, 227, 228, 253, 257, 260, 262, 405, 

764, 766, 767, 769, 771, 773, 777, 781, 783, 
784, 788, 791, 793, 796, 801, 802, 804, 806, 
807, 810, 812, 814, 815, 816, 863, 865, 886, 
1205, 1206 
animate ....................................................1206 
Haze...........................................................863 
Linking........................................................814 
orbiting .........................................................94 
place ..................................................262, 812 
Positioning .................................257, 806, 807 

Sun & Moon .......................................1417, 1425 
Sun button......................................................865 
Sun Color ...............................................266, 816 

set ......................................................266, 816 
Sun Color Swatch ..........................................816 

Left-click-hold.............................................816 
Sun Controls 256, 257, 258, 261, 262, 806, 808, 

810, 812, 1417, 1425 
nudging ............................. 256, 261, 806, 810 
Use.....................................................806, 810 

Sun Glow Color ..............................................225 
Sun Manually .........................................256, 806 

Positioning .........................................256, 806 
Sun Numerically .............................................808 

Positioning .................................................808 
Sun Position .........................................886, 1206 

Sun Position Controls ...256, 257, 261, 806, 810, 
818 
corner ........................................................818 

Sun Position trackball ............................260, 810 
portion................................................260, 810 

Sun/Moon......260, 262, 265, 788, 791, 793, 796, 
810, 812, 816 
color...........................................................796 
hide....................................788, 791, 793, 796 
make..................................788, 791, 793, 796 
portion........................................................788 
position ..............................................262, 812 
set..............................................................816 

Sun/Moon Color .............................................816 
Sun/Moon Control ..................................265, 818 
Sun/Moon Disk Intensity ................................788 

set..............................................................788 
Sun/Moon Glow Intensity...............................791 

set..............................................................791 
Sun/Moon Numerically...................................258 

Positioning .................................................258 
Sun/Moon Position.......................................1206 

Animating.................................................1206 
Sun/Moon Rings ..................................796, 1436 

use.............................................................796 
Sun/Moon Shadows.......405, 773, 801, 802, 804 

Enable ...............................................405, 801 
Sun/Moon Size.......................................784, 793 

disable .......................................................793 
Enable .......................................................793 

Sun/Moon Visible ...................788, 791, 793, 796 
Enable ...............................788, 791, 793, 796 

Sun/moonlight ....................................................1 
Sunlight ..........241, 242, 815, 821, 822, 873, 878 

Disabling....................................................815 
tints ....................................................241, 821 

Sunrise/Sunset...............................................265 
Sunset/sunrise ...............................................265 
Super .............................................................401 

select .........................................................401 
Superfine..........................................................31 
Supporting..........................................................4 

OpenGL 1.1 ...................................................4 
Surface.......................113, 116, 118, 1067, 1070 

editing ......................................................1070 
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Surface Material Channels...................566, 1070 
Surface Material Shading Modes...................631 

explains......................................................631 
Surface Visible Lights.........................1067, 1070 

create.......................................................1067 
Swap Views button.......................................1168 
Swapping........................................................368 

Camera ......................................................368 
Director’s View...........................................368 
Director's....................................................368 

Sweet Gum ........................................1090, 1096 
Switch... 218, 334, 338, 339, 341, 356, 358, 359, 

372, 373, 431, 435, 466, 467, 542, 545, 818, 
955, 1109, 1183, 1184, 1185, 1193, 1208, 
1328, 1364, 1367, 1378, 1385, 1388, 1394, 
1403 
Between Sun .............................................818 
Bitmap................................................466, 467 
Camera View ...................................338, 1385 
Director’s View.........................................1394 
Director's View. 339, 356, 358, 359, 372, 373, 

1185 
Duration ...................................................1109 
Fly-around View.........................................334 
From Front ...............................................1388 
From Right ...............................................1388 
Front.........................................................1388 
Front View................................................1364 
HLS............................................................218 
Orthogonal View ................... 341, 1183, 1184 
Panoramic........................................435, 1208 
Right.........................................................1388 
Texture.....................................................1193 
Top.............................................................431 
Top View......... 1364, 1367, 1378, 1394, 1403 
Unpaint Effect ............................................955 
Volume.......................................................542 
Wireframe ................................467, 545, 1328 

Symlat ...... 47, 85, 120, 214, 508, 650, 940, 943, 
1015, 1020, 1264, 1428 

SymLats ...........................................................47 
Symmetric Tiling.............................................623 
Symmetrical Lattice......................120, 893, 1428 

Creating .....................................................120 
editing ........................................................893 
halves.........................................................893 

Symmetrical Lattice tool.........................120, 650 
Symmetrical Tiling..........................................623 
System .............................................................25 

include .........................................................25 
System Requirements .......................................4 
T 
T3d...................................................................45 
Tab key ........................................................1275 

press........................................................1275 
Tahiti ..................................................................1 
Take ...............................................................435 

360° ...........................................................435 
Targa................................................................41 
Target...........................................................1172 

drag .........................................................1172 
Target Object Name menu ..........................1174 
Taurus............................................................767 
TCP/IP .............................................................55 
TE ............119, 538, 889, 890, 1419, 1427, 1428 

Accessing ..................................................890 
Quick Tour .................................................889 

Tech Support ...................................................98 
Technical Support ..............................................8 
Techno ...................................................693, 716 
Terrain.29, 47, 77, 119, 120, 309, 893, 897, 914, 

950, 953, 984, 1010, 1316, 1322, 1328, 1330, 
1419, 1427 
Adjusting..................................................1316 
Animating...................................................309 
Clipping......................................................893 
Creating .....................................................119 
Exporting ...................................................914 
modify ........................................................119 
Revert ............................................1419, 1427 
set..............................................................950 
Tiling ..........................................................984 

Terrain Animations.......................................1201 
Previewing ...............................................1201 

Terrain Canvas .....508, 894, 895, 897, 899, 901, 
903, 904, 905, 907, 908, 910, 911, 912, 913, 
914, 931, 937, 950, 952, 953, 955, 958, 960, 
964, 965, 988, 990, 991, 992, 993, 997, 998, 
999, 1004, 1010, 1015, 1020, 1022, 1024, 
1199, 1201, 1316, 1419, 1427 
blurs...........................................................991 
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corner........ 908, 910, 911, 912, 913, 914, 931 
existing...............................................964, 999 
fill 904 
Menu icon ......................... 952, 955, 958, 960 
Paste Terrain Grayscale................1419, 1427 
rest .............................................................905 
right ..........................................895, 899, 1199 

Terrain Canvas Frame ...................................897 
corner.........................................................897 

Terrain Canvas tool....... 901, 904, 905, 907, 952 
Terrain Clipping............................................1199 

Animating.................................................1199 
Terrain Clipping Bracket...............................1199 

setting ......................................................1199 
Terrain Editing..............................................1026 
Terrain Editior...............................................1264 
Terrain Editor . 1, 21, 85, 89, 119, 120, 214, 309, 

508, 538, 650, 889, 890, 897, 899, 900, 907, 
913, 915, 937, 939, 940, 943, 964, 965, 967, 
979, 984, 988, 1014, 1015, 1020, 1025, 1107, 
1111, 1195, 1197, 1199, 1201, 1316, 1414, 
1419, 1422, 1427, 1428, 1436, 1437 
applying .....................................................899 
enter119, 508, 915, 940, 943, 979, 984, 1015, 

1020 
Exit ........................ 899, 979, 984, 1201, 1316 
open...................................................890, 964 
use .................................................................1 

Terrain Editor's Clipping Controls ..................893 
Terrain Export Lab Options menu................1436 
Terrain Exporter .................................1419, 1427 
Terrain Filtering ............................................1197 

Animating.................................................1197 
Terrain Geometry .........................................1195 

Animating.................................................1195 
Terrain Gradients .........................................1436 
Terrain icon ..................................................1330 

hold ..........................................................1330 
Terrain Objects.......................... 119, 1316, 1330 
Terrain Resolution........................................1015 

check........................................................1015 
Terrain Solid...................................................895 

Setting........................................................895 
Terrain tool .............................................119, 650 
Terrain/symlat ................................................650 
Terrain’s .............................................1316, 1330 

change.....................................................1316 
keep.........................................................1330 

Tessellating Progress dialog..........................922 
get..............................................................922 

Tessellation Examples...................................924 
Test Render .................................................1399 
Text Display Area....13, 228, 232, 234, 237, 250, 

252, 467, 1114, 1330 
Control Palette...........................232, 234, 237 
watch .......................................................1114 

Text Field Modifiers............................1419, 1427 
Texture Component ...............................539, 597 
Texture Component Window .................597, 600 
Texture Editor ..............................................2, 82 
Texture Gel ..................................................1072 
Texture Mapping Modes ................................614 
Texture Position .............................................629 
Texture Rotation ............................................629 
Texture Scale.................................................627 
Texture Source Editor button.........................600 
Textured Preview...........................................920 
Textured Shaded ...................................294, 296 
Textured With Wireframe Overlay .................918 
Textures 506, 512, 513, 535, 536, 568, 572, 574, 

576, 577, 581, 582, 585, 590, 597, 611, 626, 
652, 661, 662, 664, 674, 784, 918, 1190, 
1193, 1322 
Animating.................................................1190 
Applying...................................535, 536, 1322 
Base Density Using ...................................590 
Building......................................................652 
Color Using................................................581 
enabling .....................................................784 
Previewing .................................................662 
Randomizing..............................................661 
Saving........................................................664 
switching..................................................1193 
Transforming .............................................626 
use.............................................................597 
Using .........................................................582 

Textures Library .....506, 535, 536, 597, 600, 664 
access .......................................................600 
open...........................................................536 

Textures Off ...........................................395, 467 
Textures On ...........................................395, 424 
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Textures On/Off..............................................395 
Textures On/Off button...................................395 
Textures Preset Library....................................29 
Tga ...................................................................41 
The Advanced Display Palette.........................15 
The Advanced Motion Lab ...............................17 
The Create Palette ...........................................14 
The Edit Palette................................................14 
The Light Lab ...................................................17 
The Materials Lab ......................................18, 88 
The Menu Bar ..................................................11 
The Preset Libraries.........................................29 
The QTVR Panorama ....................................435 
The Selection Palette .......................................16 
The Sky ............................................................15 
The Sky Lab .....................................................19 
The Terrain Editor ............................................21 
The Text Display Area......................................13 
The Tree Lab....................................................21 
These timelines ............................................1148 
They’re .........................................................1026 
Thickness ..... 843, 845, 849, 853, 856, 857, 863, 

865 
Drag ...................................................845, 856 

Think.........................................................31, 573 
Document Resolution ..................................31 
Specularity .................................................573 

Three-dimensional .................... 1, 626, 715, 889 
displays......................................................889 

Thumbnail Preview Options .........................1439 
Tick Marker...................................................1437 

IBL Roller Ball ..........................................1437 
Ticker Mark.................... 1130, 1379, 1414, 1422 
TIF ........................... 41, 43, 508, 928, 940, 1439 
TIF file ..........................................................1439 

resaving ...................................................1439 
TIFF..................................................41, 43, 1014 
Tile East .........................................................984 

selecting.....................................................984 
Tile North........................................................984 
Tile Optimization ..............................................55 
Tiling...............................................................984 

choose .......................................................984 
Terrains......................................................984 

Tiling South ....................................................984 

Time .............................................99, 1113, 1385 
Time Display ................................................1130 
Time Dots.....................................................1115 
Time First Keyframe button .........................1405 

Animation Palette ....................................1405 
Time Line ...........................................1414, 1422 
Time Mapping Areas....................................1147 
Time Mapping Curve Editor .........................1163 
Time Mapping Curves...1155, 1158, 1159, 1160, 

1406 
Editing......................................................1155 

Time Mapping Editor.....1155, 1158, 1159, 1160, 
1161, 1162, 1163, 1167 

Time Random ........................................693, 716 
Time Scrubber .............................................1379 
Time Selection Palette.................................1242 

Use ..........................................................1242 
Time Working...............................................1379 
Time/Selection .............................................1330 
Time/Selection Palette.....................................16 

use...............................................................16 
Time/Selection Palette Toggle.........16, 322, 357 
Time/Selection Toggle ...........................99, 1403 
Time-Based Animation ................................1106 
Timeline ........16, 308, 338, 886, 887, 888, 1025, 

1107, 1109, 1111, 1113, 1114, 1115, 1116, 
1118, 1121, 1122, 1130, 1148, 1151, 1152, 
1153, 1155, 1177, 1179, 1187, 1189, 1190, 
1193, 1195, 1197, 1199, 1203, 1205, 1206, 
1215, 1379, 1381, 1406, 1414, 1422, 1434 
adjusting ..................................................1109 
edge.........................................................1118 
edit.....................................................16, 1148 
end.......................................1203, 1379, 1406 
portion............................................1116, 1379 
scale ..............................................1118, 1379 
Sequence ................................................1379 

Timeline Options menu..........................36, 1130 
displays....................................................1130 

Timeline Scale .............................................1118 
Setting .....................................................1118 

Timeline The ................................................1113 
Timeline tool.................................................1215 
Timelines...1111, 1143, 1144, 1148, 1152, 1406, 

1434 
number ....................................................1148 
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right ..........................................................1406 
see ...........................................................1148 

Tints........................................................241, 821 
Sunlight ..............................................241, 821 

TIP................................... 645, 1348, 1355, 1356 
Tips...............................................................2, 13 
TIR................................................447, 451, 1428 

limiting........................................................451 
Toggle ................................................1379, 1385 

clicking ...........................................1379, 1385 
Toggle button ...............................................1350 
Toggle Hierarchy................................1419, 1427 

Object.............................................1419, 1427 
Selected Object .............................1419, 1427 

Toggle Time/Selection .......................1414, 1422 
Tool Tips...........................................................13 
Toolbars .........................................................102 
Tools.......................................... 535, 1214, 1215 
Top ...................... 183, 331, 333, 341, 431, 1177 

switch.........................................................431 
Top View ........ 328, 333, 435, 1208, 1356, 1364, 

1367, 1378, 1394, 1403 
Switch ............. 1364, 1367, 1378, 1394, 1403 

Top, Bottom..................................335, 341, 1177 
Top, Left .............................................1177, 1180 
Torus 77, 85, 105, 107, 214, 500, 525, 545, 641, 

1210, 1264, 1286, 1312 
Creating .....................................................107 
display......................................................1210 
Select .......................................................1210 

Torus Editor..................................................1210 
Torus tool .......................................................107 
Torus Z-size ...................................................214 
Total Internal Reflection .......................451, 1428 
Track Object Name ....... 1172, 1174, 1248, 1385 
Track Object Name menu ............................1184 
Trackball306, 346, 349, 351, 353, 364, 374, 376, 

378, 380, 381, 386, 431, 767, 773, 806, 1179, 
1182, 1184, 1185, 1312, 1371 
center .......................................................1312 
double-clicking .........................................1184 
drag..................................................767, 1371 
like......................................................767, 806 
Use.................................... 346, 349, 351, 353 
Using..........................................................374 

Trackball Mode ......................................346, 349 
change.......................................................346 
like .............................................................349 

Trackball's Tripod...........................................367 
Tracking ...............1074, 1170, 1182, 1248, 1262 

Icon..........................................................1262 
Objects ..........................................1170, 1248 

Tracking button ............................................1183 
Tracking icon............................1172, 1262, 1374 

drag .........................................................1172 
Tracking Objects ..........................................1262 
Trademark Information ......................................8 
Trajectory .....................................................1403 

Converting ...............................................1403 
Transfer..............................................1214, 1224 

Bryce .............................................1214, 1224 
Transfer Material..........................................1234 

Negative Boolean ....................................1234 
Transformation Attributes ............................1237 

Editing......................................................1237 
Transformation Tools...........................626, 1190 
Transformations ....105, 176, 214, 280, 308, 626, 

1107, 1187, 1237, 1245, 1254, 1260, 1304, 
1305, 1307, 1308 
Animating.........................................308, 1187 
Camera Space.........................................1305 
regards ....................................................1254 
type..........................................................1245 
World Space............................................1304 

Transformations you’ve ...............................1285 
Transforming..................................................626 

Textures.....................................................626 
Transition Node..............1051, 1053, 1056, 1057 
Transition Point ........................1050, 1051, 1057 

Changing .................................................1051 
Drag.........................................................1051 

Translating .........................................1417, 1425 
Objects ..........................................1417, 1425 

Transmaps ...................................................1224 
Transmissions................................409, 454, 462 
Transmissions Disabled.................................454 
Transmissions Enabled .................................454 
Transparency 131, 228, 395, 441, 445, 559, 561, 

579, 580, 581, 582, 585, 589, 602, 613, 625, 
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632, 633, 635, 636, 671, 1042, 1043, 1053, 
1056, 1057, 1219, 1224, 1432 

Transparency channel....................................582 
Transparency Color........................635, 636, 671 
Transparency control ...................................1053 
Transparency creates ............................582, 632 
Transparency Node................. 1053, 1056, 1057 
Transparency value........................................579 
Transparent....................................................561 
Transparent Color ......... 557, 580, 585, 589, 633 
Transparent Color Channel............580, 581, 589 

Transparent Color......................................589 
Transparent Color channel determines..........580 
Tree Lab. 21, 85, 89, 214, 473, 651, 1075, 1076, 

1077, 1078, 1088, 1104, 1105, 1264, 1414, 
1422, 1437 
access......................................................1075 
hang.........................................................1437 
opens .........................................................214 
Quick Tour ...............................................1078 

Tree Lab Branches per Segment.................1437 
Tree Lab Settings.........................................1105 

Saving......................................................1105 
Tree Library....................................................123 
Tree Object tool..............................................651 
Tree Presets...................................................123 

Saving........................................................123 
Tree Preview ................................................1078 
Tree Shape ..................................................1090 
Trees ............................................122, 123, 1076 

Editing......................................................1076 
name..........................................................123 
save ...........................................................123 

Trees crashes Bryce ....................................1432 
Cutting......................................................1432 

Trees/metaballs............................................1439 
move ........................................................1439 

Triangle icon.................. 495, 500, 521, 525, 530 
Triangles Discrete ..................................693, 716 
Tripod .............................................351, 353, 386 

Use.............................................................351 
Tripod Mode ...................................................351 

change .......................................................351 
Troubleshooting ...........................................1439 
True Ambience.......................................403, 411 

TrueSpace™....................................................45 
Trunk............................................................1088 
Trunk Thickness...........................................1079 
Trying ...........................................................1215 
Tulip Tree...........................................1090, 1096 
Turbulence ...................823, 828, 830, 887, 1204 

Adjust...............................................887, 1204 
Increasing ..................................................823 

Turbulent......................................................1334 
Turn AA Off ....................................................421 

Single Object .............................................421 
Turn AA On....................................................423 

Single Object .............................................423 
Turn Anti-aliased Wireframes ............1414, 1422 
Turn Off Anti-Aliasing.........................1414, 1422 
Turn On Anti-Aliasing.........................1414, 1422 
Turning...................................................424, 901 

Plop Render...............................................424 
Zoom Area.................................................901 

Turns Textures...............................................424 
Tutorials .................................................451, 585 
Tutorials/Manual Tutorials .......1312, 1325, 1373 
Type ...............98, 310, 311, 693, 716, 879, 1245 

HDR file .....................................................879 
Select All....................................................311 
transformations........................................1245 
URL .............................................................98 

U 
Unconstrain..................................................1258 
Under Moon Phase........................................784 
Under Trajectory Options.............................1394 
Underground..................................................290 
Underground Off button .................................290 
Underground Off icon ....................................290 

change.......................................................290 
Underground On button .................................290 
Underground On icon ....................................290 

change.......................................................290 
Underground On/Off ......................................290 
Understanding................................................561 

Material......................................................561 
Understanding Volume Material Channels 18, 88 
Undo button ...................................................967 

clicking.......................................................967 
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Undo Reposition Operations..........................176 
Undo Resize Operation..................................155 
Undo Rotate Operations ................................165 
Undo/Redo ...........................................31, 38, 39 

reset .................................................31, 38, 39 
Undoing........... 69, 70, 280, 663, 967, 969, 1008 

Changes ....................................................663 
Filter Changes .........................................1008 
Operations .................................................967 

Ungroup....................... 93, 129, 323, 1274, 1350 
stands ......................................................1350 

Ungroup button ............................................1361 
Ungroup Icon................................................1274 
Ungroup Objects ..........................93, 1413, 1420 
Ungrouping...................................................1214 
Unhide....................................................314, 357 

Camera Wireframe ....................................357 
Uniform.........................................................1040 
Uniform button....................................1088, 1104 
Uniform Color .......................... 1040, 1088, 1104 
Uniform Density..............................................637 
Uninstall..............................................................5 
Uninstall Bryce ...................................................5 
Uninstall button ..................................................5 
Uninstalled .........................................................5 
Uninstalling.........................................................5 
United States and/or ..........................................8 
Unity ..... 170, 171, 173, 1236, 1276, 1285, 1294, 

1306, 1418, 1426 
Reset........................................................1236 

Unity Size/Rotation.......................................1285 
Reset Object ............................................1285 

Unity Unit........................................170, 171, 173 
Universal Binary ...........................................1439 
Universal Binary Support .............................1439 
UNIX...................................................................4 
Unless Scale Pict Size ...................................624 
Unlocking........................................................359 

Camera ......................................................359 
Camera Position ........................................359 

Unpaint ...........................................................957 
Unpaint Effect.................................951, 955, 957 
Unreposition .........................................176, 1236 
Unrotate................................................165, 1236 
Unscale ................................................155, 1236 

Unsmooth.....................................................1212 
Unsmooth button..........................................1212 
Unsmoothed.................................123, 912, 1212 
Unsmoothing........................................123, 1212 
Update button ............................................55, 63 
Updated/fixed.....................................................2 
Updating.......................................................1218 

Imported Animations ...............................1218 
Use1, 12, 16, 25, 29, 63, 66, 104, 113, 142, 197, 

212, 214, 222, 228, 265, 275, 280, 322, 329, 
334, 341, 346, 349, 351, 353, 381, 441, 462, 
466, 597, 600, 636, 796, 806, 810, 835, 873, 
879, 897, 958, 967, 969, 1116, 1121, 1123, 
1130, 1197, 1237, 1242, 1316, 1328, 1330, 
1334, 1348, 1379, 1399, 1435, 1439 
2D Face .....................................................462 
3D Disperse Size/Rotate ...........................212 
3D Texture.................................................600 
Add Key Frame button ............................1130 
Additive......................................................636 
Animation Preview Controls ....................1123 
Animation-Smooth Cam ..........................1399 
Auto-Record ............................................1121 
Bryce .......................................................1435 
Camera......................................................341 
Camera Axes Controls ..............................381 
Camera Controls .......................................381 
Clear ..........................................................466 
Color Picker button....................................897 
Color Wheel.................................................25 
Copy/Paste Matrix ...................................1439 
Distance Mask...........................................441 
Edit Materials tool ......................................142 
Edit Terrain/Object tool..............................214 
Erode tool ..................................................967 
Filtering Graph.........................................1197 
Fix Cloud Plane .........................................835 
Fly-around View.........................................334 
fractal tool ..................................................969 
Ground Plane ............................................113 
High Dynamic Range Image .....................873 
IBL .............................................................873 
Interface Max/Min tool ...............................275 
Memory Dots ...............................................12 
Memory Dotsto ..........................................329 
Minimum....................................................958 
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Nano-Edit Mode.........................................280 
Negative Boolean ....................................1328 
Network Render.......................................1439 
Network Render Manager............................63 
Object Attributes dialog............................1348 
Preset Objects Library .........................29, 104 
Reposition tool ...................... 197, 1316, 1334 
Resize Tool..............................................1330 
Scale tool .................................................1379 
Shadows ....................................................228 
Sky Dome ..................................................265 
Sky Presets Library....................................222 
Smudge Tool .............................................879 
Snap...........................................................197 
Snapshot Tool..............................................66 
Sphere .....................................................1348 
Sun Controls ......................................806, 810 
Sun/Moon Rings ........................................796 
Terrain Editor's...............................................1 
Texture.......................................................597 
Time Selection Palette.............................1242 
Time/Selection Palette.................................16 
Trackball ........................... 346, 349, 351, 353 
Tripod.........................................................351 
VCR Controls.............................................322 
Working Area ...........................................1116 
World Space ............................................1237 

Use Gel ............................. 472, 647, 1070, 1072 
Use HDRI Image ............................................873 

disable........................................................873 
Enable........................................................873 

Use Shift.......................................................1275 
Use Tile Optimization .............................55, 1439 
Use/sell...........................................................879 
User................................................104, 488, 516 
User Color ........................................................25 
User Leaf......................................................1096 
User.obp file ...................................................516 
USGS ...............................................................45 
USGS DEM ......................................................45 
USGS SDTS ....................................................45 
Using .. 7, 12, 218, 304, 305, 374, 543, 545, 548, 

582, 600, 835, 901, 943, 1070, 1072, 1126, 
1127, 1177 
3D Texture .................................................600 

Camera........................................................12 
Control Thumbnails ...................................218 
Fixed Cloud Plane .....................................835 
Image.......................................................1070 
Material Preview Area ...............................545 
Materials Presets Library...........................548 
Movie Preview Window ...........................1126 
Nano-Preview..............................................12 
Orthogonal Views ....................................1177 
Pan Tool ....................................................304 
Preset Brushes..........................................943 
Preset Libraries .............................................7 
Procedural ...............................................1072 
Spacebar ...................................................305 
Storyboard Preview .................................1127 
Texture ......................................................582 
Trackball ....................................................374 
View Control ................................................12 
Zoom Area.................................................901 

Using Blend Slope .........................................751 
Using Color Swatches .....................................22 
Using Controls .................................................22 
Using Definition............................................1237 
Using Director's View...................................1179 
Using Drag .....................................................659 
Using Fields .....................................................22 
Using IBL .......................................................873 
Using Knobs.....................................................22 
Using Preset Brushes ....................................538 
Using Presets...............................................1163 
Utilities .........................................................1438 
UV ................................................................1267 
V 
V1879 
Value Channels..............................................558 
Value Components ........................................595 
Value, Optics..................................................599 
Various Substances.......................................451 

Refraction Index ........................................451 
Vaulted Roof ................................................1340 

Creating ...................................................1340 
VCR Controls .......................322, 323, 325, 1167 

center.........................................................325 
use.............................................................322 
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Velocity.........................................................1406 
Velocity Adjustment......................................1406 
Velocity Controls ..........................................1406 
VendorName ......................................................7 
Version/build ....................................................99 

Bryce............................................................99 
Vertical .........................................................1010 
Vertical Add..................................................1010 
Vertical Cross.................................................879 
VideoScape..............................................45, 915 
View button ..................................814, 835, 1176 

Link Clouds ......................................835, 1176 
Link Sun.....................................................814 

View Control . 12, 338, 339, 341, 390, 431, 1177, 
1179, 1180 
Using............................................................12 

View Control icon .................. 337, 338, 339, 341 
View Control menu.................... 334, 1177, 1344 
View Controls Options....................................381 
View Numerically............................................380 

Set Field.....................................................380 
View Options ..................................................333 
View Options menu ......... 334, 1334, 1348, 1356 

Control Palette .........................................1348 
Viewing..... 5, 220, 328, 331, 333, 335, 337, 338, 

341, 367, 372, 373, 380, 1144, 1214, 1215, 
1262, 1414, 1422, 1428 
Camera Field .....................................372, 373 
Field .........................................367, 380, 1428 
Hierarchies...............................................1144 
Link Sun.....................................................220 
Object Hierarchies ...................................1262 
perspective-free .................................333, 341 
Reset Field.....................................1414, 1422 
Your Scene ........................................335, 337 

Viewport .......................................................1356 
Views Memory Dot ...............................435, 1208 
Visible Brush ..................................................910 

Select .........................................................910 
Visible Light..................................................1070 

Gel ...........................................................1070 
Visible Light Materials ..................................1070 

Editing......................................................1070 
Visible Object .....................................1067, 1068 

enable ............................................1067, 1068 

Visible World ..........................................266, 816 
Volume......18, 88, 113, 116, 118, 539, 542, 561, 

594, 595, 599, 643, 1068, 1070 
editing ......................................................1070 
switch.........................................................542 

Volume Blend.................................................643 
Volume Blend-Altitude ...................................643 
Volume Blend-Distance .................................643 
Volume Channels...........................................561 
Volume Cloud Plan ............................1416, 1424 
Volume Color .................................557, 589, 643 
Volume Color Channel...................................589 

Volume Color.....................................588, 589 
Volume Color channel controls......................589 
Volume Ground Plane .......................1416, 1424 
Volume Material ...........................588, 642, 1070 
Volume Material Channels...................588, 1070 

Base Density .............................................588 
Edge Softness ...........................................588 
Fuzzy Factor..............................................588 
Quality/Speed............................................588 
Volume Color.............................................588 
Volume Materials.......................................588 

Volume Material Shading...............................634 
explains .....................................................634 

Volume Material Shading Modes...................634 
Volume Visible Light ..........................1068, 1070 

create.......................................................1068 
Volume Water Plane..........................1416, 1424 
Volumetric Object Intersection.....................1437 
Volumetric World........................867, 1205, 1411 

creating....................................................1411 
Enable .......................................................867 

Voronoi D2-D1 .......................................693, 716 
Voronoi D2sq-D1sq ...............................693, 716 
Voronoi D3-D2 .......................................693, 716 
Voronoi D3sq-D2sq ...............................693, 716 
Voronoi D4-D3 .......................................693, 716 
Voronoi D4sq-D3sq ...............................693, 716 
Voronoi Distance1..................................693, 716 
Voronoi Distance2..................................693, 716 
Voronoi Distance3..................................693, 716 
Voronoi Distance4..................................693, 716 
Voronoi DistSq1.....................................693, 716 
Voronoi DistSq2.....................................693, 716 
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Voronoi DistSq3 .....................................693, 716 
Voronoi DistSq4 .............................693, 716, 734 
Voronoi ID1 ............................................693, 716 
Voronoi ID2 ....................................693, 716, 738 
Voronoi ID3 ............................................693, 716 
Voronoi ID4 ............................................693, 716 
Vortex .............................................................760 
Vortex Noise...........................................693, 716 
VR Movie........................................................435 
VRML1 .............................................................45 
Vs Linking.....................................................1260 

Grouping ..................................................1260 
Vsa ...................................................................45 
W 
Warped Ridges ..............................................970 
Warped Slickrock ...........................................970 
Warped Zorch ................................................970 
Watch .............................. 322, 1114, 1330, 1388 

camera’s ..................................................1388 
Nano-Preview window .............................1330 
Select By Type...........................................322 
Text Display Area ....................................1114 

Water Plane ...................................................116 
Creating .....................................................116 

Water Plane icon..........................................1334 
Water Plane tool.............................................116 

Left-click-hold.............................................116 
Water Slab......................................................116 

create.........................................................116 
Waters ..........................................................1334 
Waters Preset Materials Library.....................116 
Wavefront .........................................................45 
Wavefront OBJ.............................................1224 
Wavefront Object .........................................1219 
Waves ..........................................................1334 

Reflection.................................................1334 
WCS Elev.........................................................45 
Weathered Dikes............................................970 
Web Link ..............................................318, 1249 
Weeping .............................................1090, 1096 

Willow.............................................1090, 1096 
Weird Gradient .......................................693, 716 
Weird Value............................................693, 716 
Wernli ...........................................................1443 

West...............................................................984 
What's New........................................................2 
White............................................................1436 
White Cedar .......................................1090, 1096 
White Oak ..........................................1090, 1096 
White Pine..........................................1090, 1096 
Willow.................................................1090, 1096 

Weeping ........................................1090, 1096 
Win Color Pickers ............................................28 
Windows .......28, 1420, 1422, 1424, 1425, 1426, 

1427 
Windows Bitmap ........................................41, 43 
Windows Color Picker......................................28 

get................................................................28 
Windows Media Player ................................1439 
Windows NT®....................................................4 
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